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Preface

This book is aimed at the reader whowishes to gain aworking knowledge of time series
and forecasting methods as applied in economics, engineering, and the natural and
social sciences. Unlike our more advanced book, Time Series: Theory and Methods,
Brockwell and Davis (1991), this one requires only a knowledge of basic calculus,
matrix algebra and elementary statistics at the level, for example, of Mendenhall et al.
(1990). It is intended for upper-level undergraduate students and beginning graduate
students.

The emphasis is on methods and the analysis of data sets. The professional version
of the time series package ITSM2000, for Windows-based PC, enables the reader to
reproduce most of the calculations in the text (and to analyze further data sets of the
reader’s own choosing). It is available for download, together with most of the data
sets used in the book, from http://extras.springer.com. Appendix E contains a detailed
introduction to the package.

Very little prior familiarity with computing is required in order to use the computer
package. The book can also be used in conjunction with other computer packages for
handling time series. Chapter 14 of the book by Venables and Ripley (2003) describes
how to perform many of the calculations using S and R. The package ITSMR of Weigt
(2015) can be used in R to reproduce many of the features of ITSM2000. The package
Yuima, also for R, can be used for simulation and estimation of the Lévy-driven
CARMA processes discussed in Section 11.5 (see Iacus and Mercuri (2015)). Both
of these packages can be downloaded from https://cran.rproject.org/web/packages.

There are numerous problems at the end of each chapter, many of which involve
use of the programs to study the data sets provided.

Tomake the underlying theory accessible to awider audience, we have stated some
of the key mathematical results without proof, but have attempted to ensure that the
logical structure of the development is otherwise complete. (References to proofs are
provided for the interested reader.)

There is sufficient material here for a full-year introduction to univariate and
multivariate time series and forecasting. Chapters 1 through 6 have been used for sev-
eral years in introductory one-semester courses in univariate time series at Columbia
University, Colorado State University, and Royal Melbourne Institute of Technology.
The chapter on spectral analysis can be excluded without loss of continuity by readers
who are so inclined.

In view of the explosion of interest in financial time series in recent decades, the
third edition includes a new chapter (Chapter 7) specifically devoted to this topic. Some
of the basic tools required for an understanding of continuous-time financial time series
models (Brownian motion, Lévy processes, and Itô calculus) have also been added as
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viii Preface

Appendix D, and a new Section 11.5 provides an introduction to continuous parameter
ARMA (or CARMA) processes.

The diskette containing the student version of the package ITSM2000 is no longer
included with the book since the professional version (which places no limit on the
length of the series to be studied) can now be downloaded from http://extras.springer.
com as indicated above. A tutorial for the use of the package is provided as Appendix E
and a searchable file, ITSM_HELP.pdf, giving more detailed instructions, is included
with the package.

We are greatly indebted to the readers of the first and second editions of the book
and especially to Matthew Calder, coauthor of the computer package ITSM2000 and
to Anthony Brockwell, both of whommade many valuable comments and suggestions.
We also wish to thank Colorado State University, Columbia University, the National
Science Foundation, Springer-Verlag, and our families for their continuing support
during the preparation of this third edition.

Fort Collins, CO, USA Peter J. Brockwell
New York, NY, USA Richard A. Davis
April, 2016
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1 Introduction

1.1 Examples of Time Series
1.2 Objectives of Time Series Analysis
1.3 Some Simple Time Series Models
1.4 Stationary Models and the Autocorrelation Function
1.5 Estimation and Elimination of Trend and Seasonal Components
1.6 Testing the Estimated Noise Sequence

In this chapter we introduce some basic ideas of time series analysis and stochastic
processes. Of particular importance are the concepts of stationarity and the autocovari-
ance and sample autocovariance functions. Some standard techniques are described
for the estimation and removal of trend and seasonality (of known period) from
an observed time series. These are illustrated with reference to the data sets in
Section 1.1. The calculations in all the examples can be carried out using the time
series package ITSM, the professional version of which is available at http://extras.
springer.com. The data sets are contained in files with names ending in .TSM. For
example, the Australian red wine sales are filed as WINE.TSM. Most of the topics
covered in this chapter will be developed more fully in later sections of the book. The
reader who is not already familiar with random variables and random vectors should
first read Appendix A, where a concise account of the required background is given.

1.1 Examples of Time Series

A time series is a set of observations xt, each one being recorded at a specific time t.
A discrete-time time series (the type to which this book is primarily devoted) is one
in which the set T0 of times at which observations are made is a discrete set, as is the
case, for example, when observations are made at fixed time intervals. Continuous-
time time series are obtained when observations are recorded continuously over some
time interval, e.g., when T0 = [0, 1].

© Springer International Publishing Switzerland 2016
P.J. Brockwell, R.A. Davis, Introduction to Time Series and Forecasting,
Springer Texts in Statistics, DOI 10.1007/978-3-319-29854-2_1
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Figure 1-1
The Australian red wine

sales, Jan. 1980–Oct. 1991

(t
ho

us
an

d s
)

1980 1982 1984 1986 1988 1990 1992

0.
5

1.
0

1.
5

2.
0

2.
5

3.
0

Example 1.1.1 Australian Red Wine Sales; WINE.TSM

Figure 1-1 shows the monthly sales (in kiloliters) of red wine by Australian winemak-
ers from January 1980 through October 1991. In this case the set T0 consists of the
142 times {(Jan. 1980), (Feb. 1980), …,(Oct. 1991)}. Given a set of n observations
made at uniformly spaced time intervals, it is often convenient to rescale the time axis
in such a way that T0 becomes the set of integers {1, 2, . . . , n}. In the present example
this amounts to measuring time in months with (Jan. 1980) as month 1. Then T0 is the
set {1, 2, . . . , 142}. It appears from the graph that the sales have an upward trend and
a seasonal pattern with a peak in July and a trough in January. To plot the data using
ITSM, run the program by double-clicking on the ITSM icon and then select the option
File>Project>Open>Univariate, click OK, and select the file WINE.TSM.
The graph of the data will then appear on your screen.

�

Example 1.1.2 All-Star Baseball Games, 1933–1995

Figure 1-2 shows the results of the all-star games by plotting xt, where

xt =
⎧
⎨

⎩

1 if the National League won in year t,

−1 if the American League won in year t.

This is a series with only two possible values, ±1. It also has some missing values,
since no game was played in 1945, and two games were scheduled for each of the
years 1959–1962.

�

Example 1.1.3 Accidental Deaths, U.S.A., 1973–1978; DEATHS.TSM

Like the red wine sales, the monthly accidental death figures show a strong seasonal
pattern, with the maximum for each year occurring in July and the minimum for each
year occurring in February. The presence of a trend in Figure 1-3 is much less apparent
than in the wine sales. In Section 1.5 we shall consider the problem of representing
the data as the sum of a trend, a seasonal component, and a residual term.

�
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Figure 1-2
Results of the
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Figure 1-3
The monthly accidental
deaths data, 1973–1978
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Example 1.1.4 A Signal Detection Problem; SIGNAL.TSM

Figure 1-4 shows simulated values of the series

Xt = cos
( t

10

)
+ Nt, t = 1, 2, . . . , 200,

where {Nt} is a sequence of independent normal random variables, with mean 0
and variance 0.25. Such a series is often referred to as signal plus noise, the signal
being the smooth function, St = cos( t

10) in this case. Given only the data Xt, how
can we determine the unknown signal component? There are many approaches to
this general problem under varying assumptions about the signal and the noise. One
simple approach is to smooth the data by expressing Xt as a sum of sine waves of
various frequencies (see Section 4.2) and eliminating the high-frequency components.
If we do this to the values of {Xt} shown in Figure 1-4 and retain only the lowest 3.5%
of the frequency components, we obtain the estimate of the signal also shown as the
red dashed line in Figure 1-4. The waveform of the signal is quite close to that of the
true signal in this case, although its amplitude is somewhat smaller.

�
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Figure 1-4
The series {Xt} of
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Figure 1-5
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Example 1.1.5 Population of the U.S.A., 1790–1990; USPOP.TSM

The population of the U.S.A., measured at 10-year intervals, is shown in Figure 1-5.
The graph suggests the possibility of fitting a quadratic or exponential trend to the
data. We shall explore this further in Section 1.3.

�

Example 1.1.6 Number of Strikes Per Year in the U.S.A., 1951–1980; STRIKES.TSM

The annual numbers of strikes in the U.S.A. for the years 1951–1980 are shown in
Figure 1-6. They appear to fluctuate erratically about a slowly changing level.

�
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Figure 1-6
Strikes in the

U.S.A., 1951–1980
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1.2 Objectives of Time Series Analysis

The examples considered in Section 1.1 are an extremely small sample from the
multitude of time series encountered in the fields of engineering, science, sociology,
and economics. Our purpose in this book is to study techniques for drawing inferences
from such series. Before we can do this, however, it is necessary to set up a hypothetical
probability model to represent the data. After an appropriate family of models has
been chosen, it is then possible to estimate parameters, check for goodness of fit to
the data, and possibly to use the fitted model to enhance our understanding of the
mechanism generating the series. Once a satisfactory model has been developed, it
may be used in a variety of ways depending on the particular field of application.

The model may be used simply to provide a compact description of the data. We
may, for example, be able to represent the accidental deaths data of Example 1.1.3 as
the sum of a specified trend, and seasonal and random terms. For the interpretation
of economic statistics such as unemployment figures, it is important to recognize
the presence of seasonal components and to remove them so as not to confuse
them with long-term trends. This process is known as seasonal adjustment. Other
applications of time series models include separation (or filtering) of noise from signals
as in Example 1.1.4, prediction of future values of a series such as the red wine
sales in Example 1.1.1 or the population data in Example 1.1.5, testing hypotheses
such as global warming using recorded temperature data, predicting one series from
observations of another, e.g., predicting future sales using advertising expenditure data,
and controlling future values of a series by adjusting parameters. Time series models
are also useful in simulation studies. For example, the performance of a reservoir
depends heavily on the random daily inputs of water to the system. If these are modeled
as a time series, then we can use the fitted model to simulate a large number of
independent sequences of daily inputs. Knowing the size and mode of operation
of the reservoir, we can determine the fraction of the simulated input sequences that
cause the reservoir to run out of water in a given time period. This fraction will then be
an estimate of the probability of emptiness of the reservoir at some time in the given
period.
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1.3 Some Simple Time Series Models

An important part of the analysis of a time series is the selection of a suitable proba-
bility model (or class of models) for the data. To allow for the possibly unpredictable
nature of future observations it is natural to suppose that each observation xt is a
realized value of a certain random variable Xt.

Definition 1.3.1 A time series model for the observed data {xt} is a specification of the joint
distributions (or possibly only the means and covariances) of a sequence of random
variables {Xt} of which {xt} is postulated to be a realization.

Remark. We shall frequently use the term time series to mean both the data and the
process of which it is a realization. �

A complete probabilistic time series model for the sequence of random variables
{X1,X2, . . .} would specify all of the joint distributions of the random vectors
(X1, . . . ,Xn)

′, n = 1, 2, . . ., or equivalently all of the probabilities

P[X1 ≤ x1, . . . ,Xn ≤ xn], −∞ < x1, . . . , xn < ∞, n = 1, 2, . . . .

Such a specification is rarely used in time series analysis (unless the data are generated
by some well-understood simple mechanism), since in general it will contain far too
many parameters to be estimated from the available data. Instead we specify only the
first- and second-order moments of the joint distributions, i.e., the expected values
EXt and the expected products E(Xt+hXt), t = 1, 2, . . ., h = 0, 1, 2, . . ., focusing
on properties of the sequence {Xt} that depend only on these. Such properties of {Xt}
are referred to as second-order properties. In the particular case where all the joint
distributions are multivariate normal, the second-order properties of {Xt} completely
determine the joint distributions and hence give a complete probabilistic characteri-
zation of the sequence. In general we shall lose a certain amount of information by
looking at time series “through second-order spectacles”; however, as we shall see
in Chapter 2, the theory of minimum mean squared error linear prediction depends
only on the second-order properties, thus providing further justification for the use
of the second-order characterization of time series models.

Figure 1-7 shows one of many possible realizations of {St, t = 1, . . . , 200}, where
{St} is a sequence of random variables specified in Example 1.3.3 below. In most
practical problems involving time series we see only one realization. For example,
there is only one available realization of Fort Collins’s annual rainfall for the years
1900–1996, but we imagine it to be one of the many sequences that might have
occurred. In the following examples we introduce some simple time series models.
One of our goals will be to expand this repertoire so as to have at our disposal a broad
range of models with which to try to match the observed behavior of given data sets.

1.3.1 Some Zero-Mean Models

Example 1.3.1 iid Noise

Perhaps the simplest model for a time series is one inwhich there is no trend or seasonal
component and in which the observations are simply independent and identically
distributed (iid) random variables with zero mean. We refer to such a sequence
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of random variables X1,X2, . . . as iid noise. By definition we can write, for any
positive integer n and real numbers x1, . . . , xn,

P[X1 ≤ x1, . . . ,Xn ≤ xn] = P[X1 ≤ x1] · · · P[Xn ≤ xn] = F(x1) · · · F(xn),
where F(·) is the cumulative distribution function (see Section A.1) of each of
the identically distributed random variables X1,X2, . . . . In this model there is no
dependence between observations. In particular, for all h ≥ 1 and all x, x1, . . . , xn,

P[Xn+h ≤ x|X1 = x1, . . . ,Xn = xn] = P[Xn+h ≤ x],
showing that knowledge of X1, . . . ,Xn is of no value for predicting the behavior of
Xn+h. Given the values of X1, . . . ,Xn, the function f that minimizes the mean squared
error E

[
(Xn+h−f (X1, . . . ,Xn))

2
]
is in fact identically zero (see Problem 1.2). Although

this means that iid noise is a rather uninteresting process for forecasters, it plays an
important role as a building block for more complicated time series models.

�

Example 1.3.2 A Binary Process

As an example of iid noise, consider the sequence of iid random variables {Xt, t =
1, 2, . . . , } with

P[Xt = 1] = p, P[Xt = −1] = 1 − p,

where p = 1
2 . The time series obtained by tossing a penny repeatedly and scoring +1

for each head and −1 for each tail is usually modeled as a realization of this process.
A priori we might well consider the same process as a model for the all-star baseball
games in Example 1.1.2. However, even a cursory inspection of the results from 1963–
1982, which show the National League winning 19 of 20 games, casts serious doubt
on the hypothesis P[Xt = 1] = 1

2 .
�

Example 1.3.3 Random Walk

The random walk {St, t = 0, 1, 2, . . .} (starting at zero) is obtained by cumulatively
summing (or “integrating”) iid random variables. Thus a random walk with zero mean
is obtained by defining S0 = 0 and

St = X1 + X2 + · · · + Xt, for t = 1, 2, . . . ,

where {Xt} is iid noise. If {Xt} is the binary process of Example 1.3.2, then {St, t =
0, 1, 2, . . . , } is called a simple symmetric random walk. This walk can be viewed
as the location of a pedestrian who starts at position zero at time zero and at each
integer time tosses a fair coin, stepping one unit to the right each time a head appears
and one unit to the left for each tail. A realization of length 200 of a simple symmetric
random walk is shown in Figure 1-7. Notice that the outcomes of the coin tosses can
be recovered from {St, t = 0, 1, . . .} by differencing. Thus the result of the tth toss can
be found from St − St−1 = Xt.

�

1.3.2 Models with Trend and Seasonality

In several of the time series examples of Section 1.1 there is a clear trend in the data.
An increasing trend is apparent in both the Australian red wine sales (Figure 1-1) and
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Figure 1-7
One realization of a sim-
ple random walk {St, t =
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the population of the U.S.A. (Figure 1-5). In both cases a zero-mean model for the data
is clearly inappropriate. The graph of the population data, which contains no apparent
periodic component, suggests trying a model of the form

Xt = mt + Yt,

where mt is a slowly changing function known as the trend component and Yt has
zero mean. A useful technique for estimating mt is the method of least squares (some
other methods are considered in Section 1.5).

In the least squares procedure we attempt to fit a parametric family of functions,
e.g.,

mt = a0 + a1t + a2t
2, (1.3.1)

to the data {x1, . . . , xn} by choosing the parameters, in this illustration a0, a1, and a2, to
minimize

∑n
t=1(xt −mt)

2. This method of curve fitting is called least squares regres-
sion and can be carried out using the program ITSM and selecting the Regression
option.

Example 1.3.4 Population of the U.S.A., 1790–1990

To fit a function of the form (1.3.1) to the population data shown in Figure 1-5 we
relabel the time axis so that t = 1 corresponds to 1790 and t = 21 corresponds
to 1990. Run ITSM, select File>Project>Open>Univariate, and open the
file USPOP.TSM. Then select Regression>Specify, choose Polynomial
Regression with order equal to 2, and click OK. Finally, selecting the option
Regression>Estimation>Least Squares, gives the following estimated
parameter values in the model (1.3.1):

â0 = 6.9579 × 106,

â1 = −2.1599 × 106,

and

â2 = 6.5063 × 105.
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Figure 1-8
Population of the U.S.A.

showing the quadratic trend
fitted by least squares
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A graph of the fitted function is shown with the original data in Figure 1-8. The
estimated values of the noise process Yt, 1 ≤ t ≤ 21, are the residuals obtained by
subtraction of m̂t = â0 + â1t + â2t2 from xt.

The estimated trend component m̂t furnishes us with a natural predictor of future
values of Xt. For example, if we estimate the noise Y22 by its mean value, i.e., zero,
then (1.3.1) gives the estimated U.S. population for the year 2000 as

m̂22 = 6.9579 × 106 − 2.1599 × 106 × 22 + 6.5063 × 105 × 222 = 274.35 × 106.

However, if the residuals {Yt} are highly correlated, we may be able to use their values
to give a better estimate of Y22 and hence of the population X22 in the year 2000.

�

Example 1.3.5 Level of Lake Huron 1875–1972; LAKE.DAT

A graph of the level in feet of Lake Huron (reduced by 570) in the years 1875–1972
is displayed in Figure 1-9. Since the lake level appears to decline at a roughly linear
rate, ITSM was used to fit a model of the form

Xt = a0 + a1t + Yt, t = 1, . . . , 98 (1.3.2)

(with the time axis relabeled as in Example 1.3.4). The least squares estimates of the
parameter values are

â0 = 10.202 and â1 = −0.0242.

(The resulting least squares line, â0+â1t, is also displayed in Figure 1-9.) The estimates
of the noise, Yt, in the model (1.3.2) are the residuals obtained by subtracting the
least squares line from xt and are plotted in Figure 1-10. There are two interesting
features of the graph of the residuals. The first is the absence of any discernible trend.
The second is the smoothness of the graph. (In particular, there are long stretches of
residuals that have the same sign. This would be very unlikely to occur if the residuals
were observations of iid noise with zero mean.) Smoothness of the graph of a time
series is generally indicative of the existence of some form of dependence among the
observations.

Such dependence can be used to advantage in forecasting future values of the
series. If we were to assume the validity of the fitted model with iid residuals {Yt}, then
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Figure 1-9
Level of Lake Huron
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the minimum mean squared error predictor of the next residual (Y99) would be zero
(by Problem 1.2). However, Figure 1-10 strongly suggests that Y99 will be positive.

How then do we quantify dependence, and how do we construct models
for forecasting that incorporate dependence of a particular type? To deal with
these questions, Section 1.4 introduces the autocorrelation function as a measure
of dependence, and stationary processes as a family of useful models exhibiting a
wide variety of dependence structures.

�
Harmonic Regression

Many time series are influenced by seasonally varying factors such as the weather,
the effect of which can be modeled by a periodic component with fixed known period.
For example, the accidental deaths series (Figure 1-3) shows a repeating annual pattern
with peaks in July and troughs in February, strongly suggesting a seasonal factor with
period 12. In order to represent such a seasonal effect, allowing for noise but assuming
no trend, we can use the simple model,
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Xt = st + Yt,

where st is a periodic function of t with period d (st−d = st). A convenient choice for
st is a sum of harmonics (or sine waves) given by

st = a0 +
k∑

j=1

(aj cos(λjt)+ bj sin(λjt)), (1.3.3)

where a0, a1, . . . , ak and b1, . . . , bk are unknown parameters and λ1, . . . , λk are fixed
frequencies, each being some integer multiple of 2π/d. To carry out harmonic regres-
sion using ITSM, select Regression>Specify, and check the two boxes,
Include intercept term and Harmonic Regression. Then specify the
number of harmonics [k in equation (1.3.3)] and enter k integer-valued Fourier indices
f1, . . . , fk. For a sine wave with period d, set f1 = n/d, where n is the number of
observations in the time series. (If n/d is not an integer, you will need to delete a few
observations from the beginning of the series to make it so.) The other k − 1 Fourier
indices should be positive integer multiples of the first, corresponding to harmonics
of the fundamental sine wave with period d. Thus to fit a single sine wave with
period 365 to 365 daily observations we would choose k= 1 and f1 = 1. To fit a linear
combination of sinewaves with periods 365/j, j= 1, . . . , 4, wewould choose k= 4 and
fj = j, j= 1, . . . , 4. Once k and the frequencies f1, . . . , fk have been specified, click
OK and then select Regression>Estimation>Least Squares to obtain the
required coefficients. To see how well the fitted function matches the data, select
Regression>Show fit.

Example 1.3.6 Accidental Deaths

To fit a sum of two harmonics with periods 12 months and 6 months to the monthly
accidental deaths data x1, . . . , xn with n = 72, we choose k = 2, f1 = n/12 = 6, and
f2 = n/6 = 12. Using ITSM as described above, we obtain the fitted function shown
in Figure 1-11. As can be seen from the figure, the periodic character of the series is
captured reasonably well by this fitted function. In practice, it is worth experimenting
with several different combinations of harmonics in order to find a satisfactory estimate
of the seasonal component. The program ITSM also allows fitting a linear combination

Figure 1-11
The estimated harmonic

component of the
accidental deaths
data from ITSM
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of harmonics and polynomial trend by checking both Harmonic Regression
and Polynomial Regression in the Regression>Specificationdialog
box. Other methods for dealing with seasonal variation in the presence of trend are
described in Section 1.5.

�

1.3.3 A General Approach to Time Series Modeling

The examples of the previous section illustrate a general approach to time series
analysis that will form the basis for much of what is done in this book. Before
introducing the ideas of dependence and stationarity, we outline this approach to
provide the reader with an overview of the way in which the various ideas of this
chapter fit together.

• Plot the series and examine the main features of the graph, checking in particular
whether there is

(a) a trend,
(b) a seasonal component,
(c) any apparent sharp changes in behavior,
(d) any outlying observations.

• Remove the trend and seasonal components to get stationary residuals (as defined
in Section 1.4). To achieve this goal it may sometimes be necessary to apply
a preliminary transformation to the data. For example, if the magnitude of the
fluctuations appears to grow roughly linearly with the level of the series, then
the transformed series {lnX1, . . . , lnXn} will have fluctuations of more constant
magnitude. See, for example, Figures 1-1 and 1-17. (If some of the data are
negative, add a positive constant to each of the data values to ensure that all
values are positive before taking logarithms.) There are several ways in which
trend and seasonality can be removed (see Section 1.5), some involving estimating
the components and subtracting them from the data, and others depending on
differencing the data, i.e., replacing the original series {Xt} by {Yt := Xt − Xt−d}
for some positive integer d. Whichever method is used, the aim is to produce a
stationary series, whose values we shall refer to as residuals.

• Choose a model to fit the residuals, making use of various sample statistics
including the sample autocorrelation function to be defined in Section 1.4.

• Forecasting will be achieved by forecasting the residuals and then inverting the
transformations described above to arrive at forecasts of the original series {Xt}.

• An extremely useful alternative approach touched on only briefly in this book is to
express the series in terms of its Fourier components, which are sinusoidal waves
of different frequencies (cf. Example 1.1.4). This approach is especially important
in engineering applications such as signal processing and structural design. It is
important, for example, to ensure that the resonant frequency of a structure does
not coincide with a frequency at which the loading forces on the structure have a
particularly large component.
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1.4 Stationary Models and the Autocorrelation Function

Loosely speaking, a time series {Xt, t= 0,±1, . . .} is said to be stationary if it has sta-
tistical properties similar to those of the “time-shifted” series {Xt+h, t = 0,±1, . . .},
for each integer h. Restricting attention to those properties that depend only on the
first- and second-order moments of {Xt}, we can make this idea precise with the
following definitions.

Definition 1.4.1 Let {Xt} be a time series with E(X2
t ) < ∞. Themean function of {Xt} is

μX(t) = E(Xt).

The covariance function of {Xt} is
γX(r, s) = Cov(Xr,Xs) = E[(Xr − μX(r))(Xs − μX(s))]

for all integers r and s.

Definition 1.4.2 {Xt} is (weakly) stationary if
(i) μX(t) is independent of t,

and

(ii) γX(t + h, t) is independent of t for each h.

Remark 1. Strict stationarity of a time series {Xt, t = 0,±1, . . .} is defined by the
condition that (X1, . . . ,Xn) and (X1+h, . . . ,Xn+h) have the same joint distributions for
all integers h and n > 0. It is easy to check that if {Xt} is strictly stationary and EX2

t <∞ for all t, then {Xt} is also weakly stationary (Problem 1.3). Whenever we use the
term stationary we shall mean weakly stationary as in Definition 1.4.2, unless we
specifically indicate otherwise. �

Remark 2. In view of condition (ii), whenever we use the term covariance function
with reference to a stationary time series {Xt} we shall mean the function γX of one
variable, defined by

γX(h) := γX(h, 0) = γX(t + h, t).

The function γX(·) will be referred to as the autocovariance function and γX(h) as its
value at lag h. �

Definition 1.4.3 Let {Xt} be a stationary time series. The autocovariance function (ACVF) of
{Xt} at lag h is

γX(h) = Cov(Xt+h,Xt).

The autocorrelation function (ACF) of {Xt} at lag h is

ρX(h) ≡ γX(h)

γX(0)
= Cor(Xt+h,Xt).
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In the following examples we shall frequently use the easily verified linearity prop-
erty of covariances, that if EX2 < ∞, EY2 < ∞, EZ2 < ∞ and a, b, and c are any
real constants, then

Cov(aX + bY + c,Z) = aCov(X,Z)+ bCov(Y,Z).

Example 1.4.1 iid Noise

If {Xt} is iid noise and E(X2
t ) = σ 2 < ∞, then the first requirement of Def-

inition 1.4.2 is obviously satisfied, since E(Xt) = 0 for all t. By the assumed
independence,

γX(t + h, t) =
⎧
⎨

⎩

σ 2, if h = 0,

0, if h �= 0,

which does not depend on t. Hence iid noise with finite second moment is stationary.
We shall use the notation

{Xt} ∼ IID
(
0, σ 2)

to indicate that the random variables Xt are independent and identically distributed
random variables, each with mean 0 and variance σ 2.

�

Example 1.4.2 White Noise

If {Xt} is a sequence of uncorrelated random variables, each with zero mean and
variance σ 2, then clearly {Xt} is stationary with the same covariance function as the
iid noise in Example 1.4.1. Such a sequence is referred to as white noise (with mean
0 and variance σ 2). This is indicated by the notation

{Xt} ∼ WN
(
0, σ 2

)
.

Clearly, every IID
(
0, σ 2

)
sequence is WN

(
0, σ 2

)
but not conversely (see Problem 1.8

and the ARCH(1) process of Section 11.3).
�

Example 1.4.3 The Random Walk

If {St} is the random walk defined in Example 1.3.3 with {Xt} as in Example 1.4.1,
then ESt = 0, E(S2

t ) = tσ 2 < ∞ for all t, and, for h ≥ 0,

γS(t + h, t) = Cov(St+h, St)

= Cov(St + Xt+1 + · · · + Xt+h, St)

= Cov(St, St)

= tσ 2.

Since γS(t + h, t) depends on t, the series {St} is not stationary.
�
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Example 1.4.4 First-Order Moving Average or MA(1) Process

Consider the series defined by the equation

Xt = Zt + θZt−1, t = 0,±1, . . . , (1.4.1)

where {Zt} ∼ WN
(
0, σ 2

)
and θ is a real-valued constant. From (1.4.1) we see that

EXt = 0, EX2
t = σ 2(1 + θ2) < ∞, and

γX(t + h, t) =

⎧
⎪⎪⎨

⎪⎪⎩

σ 2
(
1 + θ2

)
, if h = 0,

σ 2θ, if h = ±1,

0, if |h| > 1.

Thus the requirements of Definition 1.4.2 are satisfied, and {Xt} is stationary. The
autocorrelation function of {Xt} is

ρX(h) =

⎧
⎪⎪⎨

⎪⎪⎩

1, if h = 0,

θ/
(
1 + θ2

)
, if h = ±1,

0, if |h| > 1.

(1.4.2)

�

Example 1.4.5 First-Order Autoregression or AR(1) Process

Let us assume now that {Xt} is a stationary series satisfying the equations

Xt = φXt−1 + Zt, t = 0,±1, . . . , (1.4.3)

where {Zt} ∼ WN(0, σ 2), |φ| < 1, and Zt is uncorrelated with Xs for each s < t. (We
shall show in Section 2.2 that there is in fact exactly one such solution of (1.4.3).) By
taking expectations on each side of (1.4.3) and using the fact that EZt = 0, we see at
once that

EXt = 0.

To find the autocorrelation function of {Xt} we multiply each side of (1.4.3) by Xt−h

(h > 0) and then take expectations to get

γX(h) = Cov(Xt,Xt−h)

= Cov(φXt−1,Xt−h)+ Cov(Zt,Xt−h)

= φγX(h − 1)+ 0 = · · · = φhγX (0).

Observing that γ (h) = γ (−h) and using Definition 1.4.3, we find that

ρX(h) = γX(h)

γX(0)
= φ|h|, h = 0,±1, . . . .

It follows from the linearity of the covariance function in each of its arguments and
the fact that Zt is uncorrelated with Xt−1 that

γX(0) = Cov(Xt,Xt) = Cov(φXt−1 + Zt, φXt−1 + Zt) = φ2γX(0)+ σ 2

and hence that γX(0) = σ 2/
(
1 − φ2

)
.

�
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1.4.1 The Sample Autocorrelation Function

Although we have just seen how to compute the autocorrelation function for a few
simple time series models, in practical problems we do not start with a model, but
with observed data {x1, x2, . . . , xn}. To assess the degree of dependence in the data
and to select a model for the data that reflects this, one of the important tools we use
is the sample autocorrelation function (sample ACF) of the data. If we believe that
the data are realized values of a stationary time series {Xt}, then the sample ACF will
provide us with an estimate of the ACF of {Xt}. This estimate may suggest which of
the many possible stationary time series models is a suitable candidate for representing
the dependence in the data. For example, a sample ACF that is close to zero for all
nonzero lags suggests that an appropriate model for the data might be iid noise. The
following definitions are natural sample analogues of those for the autocovariance and
autocorrelation functions given earlier for stationary time series models.

Definition 1.4.4 Let x1, . . . , xn be observations of a time series. The sample mean of x1, . . . , xn is

x̄ = 1

n

n∑

t=1

xt.

The sample autocovariance function is

γ̂ (h) := n−1
n−|h|∑

t=1

(xt+|h| − x̄)(xt − x̄), −n < h < n.

The sample autocorrelation function is

ρ̂(h) = γ̂ (h)

γ̂ (0)
, −n < h < n.

Remark 3. For h ≥ 0, γ̂ (h) is approximately equal to the sample covariance of the n−
h pairs of observations (x1, x1+h), (x2, x2+h), . . . , (xn−h, xn). The difference arises from
use of the divisor n instead of n − h and the subtraction of the overall mean, x̄, from
each factor of the summands. Use of the divisor n ensures that the sample covariance
matrix �̂n := [γ̂ (i − j)]ni,j=1 is nonnegative definite (see Section 2.4.2).

Remark 4. Like the sample covariance matrix defined in Remark 3, the sample
correlation matrix R̂n := [ρ̂(i − j)]ni,j=1 is nonnegative definite. Each of its diagonal
elements is equal to 1, since ρ̂(0) = 1. �

Example 1.4.6 Figure 1-12 shows a simulated sequence of 200 iid normal random variables with
mean 0 and variance 1 (called an IID N(0, 1) sequence). Figure 1-13 shows the
corresponding sample autocorrelation function at lags 0, 1, . . . , 40. Since ρ(h) = 0 for
h > 0, one would also expect the corresponding sample autocorrelations to be near 0. It
can be shown, in fact, that for iid noise with finite variance, the sample autocorrelations
ρ̂(h), h > 0, are approximately IID N(0, 1/n) for n large (see Brockwell and
Davis (1991) p. 222). Hence, approximately 95% of the sample autocorrelations
should fall between the bounds ±1.96/

√
n (since 1.96 is the 0.975 quantile of the
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Figure 1-12
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standard normal distribution). Therefore, in Figure 1-13 we would expect roughly
40(0.05) = 2 values to fall outside the bounds. To simulate IID N(0, 1) noise in
ITSM, select File>Project>New>Univariate then Model>Simulate. In
the resulting dialog box, enter 200 for the required Number of Observations.
(The remaining entries in the dialog box can be left as they are, since the model
assumed by ITSM, until you enter another, is IID N(0, 1) noise. If you wish to
reproduce exactly the same sequence at a later date, record the Random Number
Seed for later use. By specifying different values for the random number seed you can
generate independent realizations of your time series.) Click on OK and you will see the
graph of your simulated series. To see its sample autocorrelation function together with
the autocorrelation function of the model that generated it, click on the third yellow
button at the top of the screen and you will see the two graphs superimposed (with the
latter in red.) The horizontal lines on the graph are the bounds ±1.96/

√
n.

�



18 Chapter 1 Introduction

Figure 1-14
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Remark 5. The sample autocovariance and autocorrelation functions can be com-
puted for any data set {x1, . . . , xn} and are not restricted to observations from a
stationary time series. For data containing a trend, |ρ̂(h)| will exhibit slow decay as
h increases, and for data with a substantial deterministic periodic component, |ρ̂(h)|
will exhibit similar behavior with the same periodicity. (See the sample ACF of the
Australian red wine sales in Figure 1-14 and Problem 1.9.) Thus ρ̂(·) can be useful as
an indicator of nonstationarity (see also Section 6.1). �

1.4.2 A Model for the Lake Huron Data

As noted earlier, an iid noise model for the residuals { y1, . . . , y98} obtained by fitting
a straight line to the Lake Huron data in Example 1.3.5 appears to be inappropriate.
This conclusion is confirmed by the sample ACF of the residuals (Figure 1-15), which
has three of the first 40 values well outside the bounds ±1.96/

√
98.

The roughly geometric decay of the first few sample autocorrelations (with
ρ̂(h + 1)/ρ̂(h) ≈ 0.7) suggests that an AR(1) series (with φ ≈ 0.7) might pro-
vide a reasonable model for these residuals. (The form of the ACF for an AR(1) process
was computed in Example 1.4.5.)

To explore the appropriateness of such a model, consider the points ( y1, y2),
( y2, y3), . . . , ( y97, y98) plotted in Figure 1-16. The graph does indeed suggest a linear
relationship between yt and yt−1. Using simple least squares estimation to fit a straight
line of the form yt = ayt−1, we obtain the model

Yt = 0.791Yt−1 + Zt, (1.4.4)

where {Zt} is iid noise with variance∑98
t=2(yt −0.791yt−1)

2/97 = 0.5024. The sample
ACF of the estimated noise sequence zt = yt − 0.791yt−1, t = 2, . . . , 98, is slightly
outside the bounds ±1.96/

√
97 at lag 1 (ρ̂(1) = 0.216), but it is inside the bounds for

all other lags up to 40. This check that the estimated noise sequence is consistent with
the iid assumption of (1.4.3) reinforces our belief in the fitted model. More goodness
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Figure 1-15
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Figure 1-16
Scatter plot of (yt−1, yt),
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of fit tests for iid noise sequences are described in Section 1.6. The estimated noise
sequence {zt} in this example passes them all, providing further support for the model
(1.4.3).

A better fit to the residuals in equation (1.3.2) is provided by the second-order
autoregression

Yt = φ1Yt−1 + φ2Yt−2 + Zt, (1.4.5)

where {Zt} is iid noise with variance σ 2. This is analogous to a linear model in which Yt

is regressed on the previous two values Yt−1 and Yt−2 of the time series. The least
squares estimates of the parameters φ1 and φ2, found by minimizing

∑98
t=3( yt −

φ1yt−1 − φ2yt−2)
2, are φ̂1 = 1.002 and φ̂2 = −0.2834. The estimate of σ 2 is

σ̂ 2 = ∑98
t=3(yt−φ̂1yt−1−φ̂2yt−2)

2/96 = 0.4460, which is approximately 11% smaller
than the estimate of the noise variance for the AR(1) model (1.4.3). The improved fit
is indicated by the sample ACF of the estimated residuals, yt − φ̂1yt−1 − φ̂2yt−2, which
falls well within the bounds ±1.96/

√
96 for all lags up to 40.
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1.5 Estimation and Elimination of Trend and Seasonal Components
The first step in the analysis of any time series is to plot the data. If there are any
apparent discontinuities in the series, such as a sudden change of level, it may be
advisable to analyze the series by first breaking it into homogeneous segments. If
there are outlying observations, they should be studied carefully to check whether
there is any justification for discarding them (as for example if an observation has
been incorrectly recorded). Inspection of a graph may also suggest the possibility
of representing the data as a realization of the process (the classical decomposition
model)

Xt = mt + st + Yt, (1.5.1)

where mt is a slowly changing function known as a trend component, st is a function
with known period d referred to as a seasonal component, and Yt is a random noise
component that is stationary in the sense of Definition 1.4.2. If the seasonal and noise
fluctuations appear to increase with the level of the process, then a preliminary trans-
formation of the data is often used to make the transformed data more compatible
with the model (1.5.1). Compare, for example, the red wine sales in Figure 1-1 with
the transformed data, Figure 1-17, obtained by applying a logarithmic transformation.
The transformed data do not exhibit the increasing fluctuation with increasing level
that was apparent in the original data. This suggests that the model (1.5.1) is more
appropriate for the transformed than for the original series. In this section we shall
assume that the model (1.5.1) is appropriate (possibly after a preliminary transforma-
tion of the data) and examine some techniques for estimating the components mt, st,
and Yt in the model.

Our aim is to estimate and extract the deterministic components mt and st in the
hope that the residual or noise component Yt will turn out to be a stationary time series.
We can then use the theory of such processes to find a satisfactory probabilistic model
for the process Yt, to analyze its properties, and to use it in conjunction with mt and st
for purposes of prediction and simulation of {Xt}.

Another approach, developed extensively by Box and Jenkins (1976), is to apply
differencing operators repeatedly to the series {Xt} until the differenced observations
resemble a realization of some stationary time series {Wt}. We can then use the theory

Figure 1-17
The natural logarithms

of the red wine data 1980 1982 1984 1986 1988 1990 1992
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of stationary processes for the modeling, analysis, and prediction of {Wt} and hence
of the original process. The various stages of this procedure will be discussed in detail
in Chapters 5 and 6.

The two approaches to trend and seasonality removal, (1) by estimation ofmt and st
in (1.5.1) and (2) by differencing the series {Xt}, will now be illustrated with reference
to the data introduced in Section 1.1.

1.5.1 Estimation and Elimination of Trend in the Absence of Seasonality

In the absence of a seasonal component the model (1.5.1) becomes the following.

Nonseasonal Model with Trend:

Xt = mt + Yt, t = 1, . . . , n, (1.5.2)

where EYt = 0.

(If EYt �= 0, then we can replace mt and Yt in (1.5.2) with mt + EYt and Yt − EYt,
respectively.)

Method 1: Trend Estimation
Moving average and spectral smoothing are essentially nonparametric methods for
trend (or signal) estimation and not for model building. Special smoothing filters can
also be designed to remove periodic components as described under Method S1 below.
The choice of smoothing filter requires a certain amount of subjective judgment, and
it is recommended that a variety of filters be tried in order to get a good idea of the
underlying trend. Exponential smoothing, since it is based on a moving average of past
values only, is often used for forecasting, the smoothed value at the present time being
used as the forecast of the next value.

To construct a model for the data (with no seasonality) there are two
general approaches, both available in ITSM. One is to fit a polynomial trend
(by least squares) as described in Method 1(d) below, then to subtract the fitted trend
from the data and to find an appropriate stationary time series model for the residuals.
The other is to eliminate the trend by differencing as described in Method 2 and then to
find an appropriate stationary model for the differenced series. The latter method has
the advantage that it usually requires the estimation of fewer parameters and does not
rest on the assumption of a trend that remains fixed throughout the observation period.
The study of the residuals (or of the differenced series) is taken up in Section 1.6.

(a) Smoothing with a finite moving average filter. Let q be a nonnegative integer
and consider the two-sided moving average

Wt = (2q + 1)−1
q∑

j=−q

Xt−j (1.5.3)

of the process {Xt} defined by (1.5.2). Then for q + 1 ≤ t ≤ n − q,

Wt = (2q + 1)−1
q∑

j=−q

mt−j + (2q + 1)−1
q∑

j=−q

Yt−j ≈ mt, (1.5.4)

assuming that mt is approximately linear over the interval [t − q, t + q] and that the
average of the error terms over this interval is close to zero (see Problem 1.11).
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Figure 1-18
Simple 5-term moving

average m̂t of the strike data
from Figure 1-6

(t
ho

us
an

ds
)

1950 1960 1970 1980

3.
5

4.
0

4.
5

5.
0

5.
5

6.
0

The moving average thus provides us with the estimates

m̂t = (2q + 1)−1
q∑

j=−q

Xt−j, q + 1 ≤ t ≤ n − q. (1.5.5)

Since Xt is not observed for t ≤ 0 or t > n, we cannot use (1.5.5) for t ≤ q or
t > n − q. The program ITSM deals with this problem by defining Xt := X1 for
t < 1 and Xt := Xn for t > n.

Example 1.5.1 The result of applying the moving-average filter (1.5.5) with q = 2 to the strike data
of Figure 1-6 is shown in Figure 1-18. The estimated noise terms Ŷt = Xt − m̂t are
shown in Figure 1-19. As expected, they show no apparent trend. To apply this filter
using ITSM, open the project STRIKES.TSM, select Smooth>Moving Average,
specify 2 for the filter order, and enter the weights 1,1,1 for Theta(0), Theta(1),
and Theta(2) (these are automatically normalized so that the sum of the weights is
one). Then click OK.

�
It is useful to think of {m̂t} in (1.5.5) as a process obtained from {Xt} by application

of a linear operator or linear filter m̂t = ∑∞
j=−∞ ajXt−j with weights aj = (2q +

1)−1,−q ≤ j ≤ q. This particular filter is a low-pass filter in the sense that it takes the
data {Xt} and removes from it the rapidly fluctuating (or high frequency) component
{Ŷt} to leave the slowly varying estimated trend term {m̂t} (see Figure 1-20).

The particular filter (1.5.5) is only one of many that could be used for smoothing.
For large q, provided that (2q + 1)−1

∑q
j=−q Yt−j ≈ 0, it not only will attenuate noise

but at the same time will allow linear trend functions mt = c0 + c1t to pass without
distortion (see Problem 1.11). However, we must beware of choosing q to be too large,
since if mt is not linear, the filtered process, although smooth, will not be a good
estimate of mt. By clever choice of the weights {aj} it is possible (see Problems 1.12–
1.14 and Section 4.3) to design a filter that will not only be effective in attenuating
noise in the data, but that will also allow a larger class of trend functions (for example
all polynomials of degree less than or equal to 3) to pass through without distortion.
The Spencer 15-point moving average is a filter that passes polynomials of degree 3
without distortion. Its weights are

aj = 0, | j| > 7,
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Figure 1-19
Residuals Ŷt = Xt − m̂t after

subtracting the
5-term moving average from
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Figure 1-20
Smoothing with a low-pass

linear filter

Linear Filter
{xt} {m̂ t= Σ ajxt-j}

with

aj = a−j, | j| ≤ 7,

and

[a0, a1, . . . , a7] = 1

320
[74, 67, 46, 21, 3,−5,−6,−3]. (1.5.6)

Applied to the process (1.5.2) with mt = c0 + c1t + c2t2 + c3t3, it gives

7∑

j=−7

ajXt−j =
7∑

j=−7

ajmt−j +
7∑

j=−7

ajYt−j ≈
7∑

j=−7

ajmt−j = mt,

where the last step depends on the assumed form of mt (Problem 1.12). Further details
regarding this and other smoothing filters can be found in Kendall and Stuart (1976,
Chapter 46).

(b) Exponential smoothing. For any fixed α ∈ [0, 1], the one-sided moving
averages m̂t, t = 1, . . . , n, defined by the recursions

m̂t = αXt + (1 − α)m̂t−1, t = 2, . . . , n, (1.5.7)

and

m̂1 = X1 (1.5.8)

can be computed using ITSM by selecting Smooth>Exponential and specifying
the value of α. Application of (1.5.7) and (1.5.8) is often referred to as exponential
smoothing, since the recursions imply that for t ≥ 2, m̂t = ∑t−2

j=0 α(1 − α)jXt−j +
(1 − α)t−1X1, a weighted moving average of Xt,Xt−1, . . . , with weights decreasing
exponentially (except for the last one).

(c) Smoothing by elimination of high-frequency components. The option
Smooth>FFT in the program ITSM allows us to smooth an arbitrary series



24 Chapter 1 Introduction

Figure 1-21
Exponentially smoothed
strike data with α = 0.4
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Figure 1-22
Strike data smoothed
by elimination of high

frequencies with f = 0.4
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by elimination of the high-frequency components of its Fourier series expansion
(see Section 4.2). This option was used in Example 1.1.4, where we chose to retain
the fraction f = 0.035 of the frequency components of the series in order to estimate
the underlying signal. (The choice f = 1 would have left the series unchanged.)

Example 1.5.2 In Figures 1-21 and 1-22 we show the results of smoothing the strike data by ex-
ponential smoothing with parameter α = 0.4 [see (1.5.7)] and by high-frequency
elimination with f = 0.4, i.e., by eliminating a fraction 0.6 of the Fourier components
at the top of the frequency range. These should be compared with the simple 5-term
moving average smoothing shown in Figure 1-18. Experimentation with different
smoothing parameters can easily be carried out using the program ITSM. The expo-
nentially smoothed value of the last observation is frequently used to forecast the next
data value. The program automatically selects an optimal value of α for this purpose
if α is specified as −1 in the exponential smoothing dialog box.

�
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(d) Polynomial fitting. In Section 1.3.2 we showed how a trend of the form
mt = a0 + a1t + a2t2 can be fitted to the data {x1, . . . , xn} by choosing the parameters
a0, a1, and a2 to minimize the sum of squares,

∑n
t=1(xt − mt)

2 (see Example 1.3.4).
The method of least squares estimation can also be used to estimate higher-order
polynomial trends in the same way. The Regression option of ITSM allows least
squares fitting of polynomial trends of order up to 10 (together with up to four
harmonic terms; see Example 1.3.6). It also allows generalized least squares estimation
(see Section 6.6), in which correlation between the residuals is taken into account.

1.5.1.1 Method 2: Trend Elimination by Differencing
Instead of attempting to remove the noise by smoothing as in Method 1, we now
attempt to eliminate the trend term by differencing. We define the lag-1 difference
operator ∇ by

∇Xt = Xt − Xt−1 = (1 − B)Xt, (1.5.9)

where B is the backward shift operator,

BXt = Xt−1. (1.5.10)

Powers of the operators B and ∇ are defined in the obvious way, i.e., B j(Xt) = Xt−j

and ∇ j(Xt) = ∇(∇ j−1(Xt)), j ≥ 1, with ∇0(Xt) = Xt. Polynomials in B and ∇ are
manipulated in precisely the same way as polynomial functions of real variables. For
example,

∇2Xt = ∇(∇(Xt)) = (1 − B)(1 − B)Xt = (1 − 2B + B2)Xt

= Xt − 2Xt−1 + Xt−2.

If the operator ∇ is applied to a linear trend function mt = c0 + c1t, then we obtain the
constant function ∇mt = mt − mt−1 = c0 + c1t − (c0 + c1(t − 1)) = c1. In the same
way any polynomial trend of degree k can be reduced to a constant by application of
the operator ∇k (Problem 1.10). For example, if Xt = mt + Yt, where mt = ∑k

j=0 cjt
j

and Yt is stationary with mean zero, application of ∇k gives

∇kXt = k!ck + ∇kYt,

a stationary process with mean k!ck. These considerations suggest the possibility,
given any sequence {xt} of data, of applying the operator ∇ repeatedly until we find
a sequence

{∇kxt
}
that can plausibly be modeled as a realization of a stationary

process. It is often found in practice that the order k of differencing required is quite
small, frequently one or two. (This relies on the fact that many functions can be
well approximated, on an interval of finite length, by a polynomial of reasonably low
degree.)

Example 1.5.3 Applying the operator ∇ to the population values {xt, t = 1, . . . , 20} of Figure 1-5, we
find that two differencing operations are sufficient to produce a series with no apparent
trend. (To do the differencing in ITSM, select Transform>Difference, enter the
value 1 for the differencing lag, and click OK.) This replaces the original series {xt}
by the once-differenced series {xt − xt−1}. Repetition of these steps gives the twice-
differenced series ∇2xt = xt − 2xt−1 + xt−2, plotted in Figure 1-23. Notice that the
magnitude of the fluctuations in ∇2xt increases with the value of xt. This effect can be
suppressed by first taking natural logarithms, yt = ln xt, and then applying the operator
∇2 to the series {yt}. (See also Figures 1-1 and 1-17.)

�
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Figure 1-23
The twice-differenced series
derived from the population

data of Figure 1-5
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1.5.2 Estimation and Elimination of Both Trend and Seasonality

The methods described for the estimation and elimination of trend can be adapted in
a natural way to eliminate both trend and seasonality in the general model, specified
as follows.

Classical Decomposition Model

Xt = mt + st + Yt, t = 1, . . . , n, (1.5.11)

where EYt = 0, st+d = st, and
∑d

j=1 sj = 0.

We shall illustrate these methods with reference to the accidental deaths data of
Example 1.1.3, for which the period d of the seasonal component is clearly 12.

1.5.2.1 Method S1: Estimation of Trend and Seasonal Components
The method we are about to describe is used in the Transform>Classicaloption
of ITSM.

Suppose we have observations {x1, . . . , xn}. The trend is first estimated by app-
lying a moving average filter specially chosen to eliminate the seasonal component
and to dampen the noise. If the period d is even, say d = 2q, then we use

m̂t = (0.5xt−q + xt−q+1 + · · · + xt+q−1 + 0.5xt+q)/d, q < t ≤ n − q. (1.5.12)

If the period is odd, say d = 2q + 1, then we use the simple moving average (1.5.5).
The second step is to estimate the seasonal component. For each k = 1, . . . , d,

we compute the average wk of the deviations {(xk+jd − m̂k+jd), q < k + jd ≤ n − q}.
Since these average deviations do not necessarily sum to zero, we estimate the seasonal
component sk as

ŝk = wk − d−1
d∑

i=1

wi, k = 1, . . . , d, (1.5.13)

and ŝk = ŝk−d, k > d.
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Figure 1-24
The deseasonalized
accidental deaths
data from ITSM
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The deseasonalized data is then defined to be the original series with the estimated
seasonal component removed, i.e.,

dt = xt − ŝt, t = 1, . . . , n. (1.5.14)

Finally, we reestimate the trend from the deseasonalized data {dt} using one of
the methods already described. The program ITSM allows you to fit a least squares
polynomial trend m̂ to the deseasonalized series. In terms of this reestimated trend and
the estimated seasonal component, the estimated noise series is then given by

Ŷt = xt − m̂t − ŝt, t = 1, . . . , n.

The reestimation of the trend is done in order to have a parametric form for the trend
that can be extrapolated for the purposes of prediction and simulation.

Example 1.5.4 Figure 1-24 shows the deseasonalized accidental deaths data obtained from ITSM
by reading in the series DEATHS.TSM, selecting Transform>Classical, check-
ing only the boxmarked Seasonal Fit, entering 12 for the period, and clicking OK.
The estimated seasonal component ŝt, shown in Figure 1-25, is obtained by selecting
Transform>Show Classical Fit. (Except for having a mean of zero, this
estimate is very similar to the harmonic regression function with frequencies 2π/12
and 2π/6 displayed in Figure 1-11.) The graph of the deseasonalized data suggests
the presence of an additional quadratic trend function. In order to fit such a trend
to the deseasonalized data, select Transform>Undo Classical to retrieve the
original data and then select Transform>Classical and check the boxes marked
Seasonal Fit and Polynomial Trend, entering 12 for the period and select-
ing Quadratic for the trend. Then click OK and you will obtain the trend function

m̂t = 9952 − 71.82t + 0.8260t2, 1 ≤ t ≤ 72.

At this point the data stored in ITSM consists of the estimated noise

Ŷt = xt − m̂t − ŝt, t = 1, . . . , 72,

obtained by subtracting the estimated seasonal and trend components from the original
data.

�
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Figure 1-25
The estimated seasonal

component of the
accidental deaths data from

ITSM
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1.5.2.2 Method S2: Elimination of Trend and Seasonal Components
by Differencing

The technique of differencing that we applied earlier to nonseasonal data can be
adapted to deal with seasonality of period d by introducing the lag-d differencing
operator ∇d defined by

∇dXt = Xt − Xt−d = (1 − Bd)Xt. (1.5.15)

(This operator should not be confused with the operator ∇d = (1−B)d defined earlier.)
Applying the operator ∇d to the model

Xt = mt + st + Yt,

where {st} has period d, we obtain

∇dXt = mt − mt−d + Yt − Yt−d,

which gives a decomposition of the difference ∇dXt into a trend component (mt−mt−d)

and a noise term (Yt − Yt−d). The trend, mt − mt−d, can then be eliminated using the
methods already described, in particular by applying a power of the operator ∇.

Example 1.5.5 Figure 1-26 shows the result of applying the operator ∇12 to the accidental deaths
data. The graph is obtained from ITSM by opening DEATHS.TSM, selecting Trans-
form>Difference, entering lag 12, and clicking OK. The seasonal component
evident in Figure 1-3 is absent from the graph of ∇12xt, 13 ≤ t ≤ 72. However,
there still appears to be a nondecreasing trend. If we now apply the operator ∇ to
{∇12xt} by again selecting Transform>Difference, this time with lag one, we
obtain the graph of∇∇12xt, 14 ≤ t ≤ 72, shown in Figure 1-27, which has no apparent
trend or seasonal component. In Chapter 5 we show that this doubly differenced series
can in fact be well represented by a stationary time series model.

�
In this section we have discussed a variety of methods for estimating and/or

removing trend and seasonality. The particular method chosen for any given data
set will depend on a number of factors including whether or not estimates of the
components of the series are required and whether or not it appears that the data contain
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Figure 1-26
The differenced series

{∇12xt, t = 13, . . . ,72}
derived from the monthly

accidental deaths
{xt, t = 1, . . . ,72}

(t
ho

us
an

ds
)

1974 1975 1976 1977 1978 1979

−1
.0

− 0
.5

0.
0

0.
5

Figure 1-27
The differenced series
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a seasonal component that does not vary with time. The program ITSM allows two
options under the Transformmenu:

1. “classical decomposition,” in which trend and/or seasonal components are esti-
mated and subtracted from the data to generate a noise sequence, and

2. “differencing,” in which trend and/or seasonal components are removed from the
data by repeated differencing at one or more lags in order to generate a noise
sequence.

A third option is to use the Regressionmenu, possibly after applying a Box–Cox
transformation. Using this option we can (see Example 1.3.6)

3. fit a sum of harmonics and a polynomial trend to generate a noise sequence that
consists of the residuals from the regression.
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In the next section we shall examine some techniques for deciding whether or not the
noise sequence so generated differs significantly from iid noise. If the noise sequence
does have sample autocorrelations significantly different from zero, then we can take
advantage of this serial dependence to forecast future noise values in terms of past
values by modeling the noise as a stationary time series.

1.6 Testing the Estimated Noise Sequence

The objective of the data transformations described in Section 1.5 is to produce a
series with no apparent deviations from stationarity, and in particular with no apparent
trend or seasonality. Assuming that this has been done, the next step is to model the
estimated noise sequence (i.e., the residuals obtained either by differencing the data
or by estimating and subtracting the trend and seasonal components). If there is no
dependence among between these residuals, then we can regard them as observations
of independent random variables, and there is no further modeling to be done except to
estimate their mean and variance. However, if there is significant dependence among
the residuals, then we need to look for a more complex stationary time series model
for the noise that accounts for the dependence. This will be to our advantage, since
dependence means in particular that past observations of the noise sequence can assist
in predicting future values.

In this section we examine some simple tests for checking the hypothesis that
the residuals from Section 1.5 are observed values of independent and identically
distributed random variables. If they are, then our work is done. If not, then we must
use the theory of stationary processes to be developed in later chapters to find a more
appropriate model.

(a) The sample autocorrelation function. For large n, the sample autocorrela-
tions of an iid sequence Y1, . . . ,Yn with finite variance are approximately iid with
distribution N(0, 1/n) (see Brockwell and Davis (1991) p. 222). Hence, if y1, . . . , yn
is a realization of such an iid sequence, about 95% of the sample autocorrelations
should fall between the bounds ±1.96/

√
n. If we compute the sample autocorrelations

up to lag 40 and find that more than two or three values fall outside the bounds, or
that one value falls far outside the bounds, we therefore reject the iid hypothesis. The
bounds ±1.96/

√
n are automatically plotted when the sample autocorrelation function

is computed by the program ITSM.
(b) The portmanteau test. Instead of checking to see whether each sample

autocorrelation ρ̂( j) falls inside the bounds defined in (a) above, it is also possible
to consider the single statistic

Q = n
h∑

j=1

ρ̂2( j ).

If Y1, . . . ,Yn is a finite-variance iid sequence, then by the same result used in (a), Q
is approximately distributed as the sum of squares of the independent N(0, 1) random
variables,

√
nρ̂( j ), j = 1, . . . , h, i.e., as chi-squared with h degrees of freedom. A

large value of Q suggests that the sample autocorrelations of the data are too large for
the data to be a sample from an iid sequence. We therefore reject the iid hypothesis
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at level α if Q > χ2
1−α(h), where χ

2
1−α(h) is the 1 − α quantile of the chi-squared

distribution with h degrees of freedom. The program ITSM conducts a refinement of
this test, formulated by Ljung and Box (1978), in which Q is replaced by

QLB = n(n + 2)
h∑

j=1

ρ̂2( j )/(n − j),

whose distribution is better approximated by the chi-squared distribution with h
degrees of freedom.

Another portmanteau test, formulated by McLeod and Li (1983), can be used as
a further test for the iid hypothesis, since if the data are iid, then the squared data are
also iid. It is based on the same statistic used for the Ljung–Box test, except that the
sample autocorrelations of the data are replaced by the sample autocorrelations of the
squared data, ρ̂WW(h), giving

QML = n(n + 2)
h∑

k=1

ρ̂2
WW(k)/(n − k).

The hypothesis of iid data is then rejected at level α if the observed value of QML is
larger than the 1 − α quantile of the χ2(h) distribution.

(c) The turning point test. If y1, . . . , yn is a sequence of observations, we say
that there is a turning point at time i, 1 < i < n, if yi−1 < yi and yi > yi+1 or if
yi−1 > yi and yi < yi+1. If T is the number of turning points of an iid sequence of
length n, then, since the probability of a turning point at time i is 2

3 , the expected value
of T is

μT = E(T) = 2(n − 2)/3.

It can also be shown for an iid sequence that the variance of T is

σ 2
T = Var(T) = (16n − 29)/90.

A large value of T − μT indicates that the series is fluctuating more rapidly than
expected for an iid sequence. On the other hand, a value of T − μT much smaller
than zero indicates a positive correlation between neighboring observations. For an iid
sequence with n large, it can be shown that

T is approximately N
(
μT, σ

2
T

)
.

This means we can carry out a test of the iid hypothesis, rejecting it at level α if
|T − μT |/σT > �1−α/2, where �1−α/2 is the 1 − α/2 quantile of the standard normal
distribution. (A commonly used value of α is 0.05, for which the corresponding value
of �1−α/2 is 1.96.)

(d) The difference-sign test. For this test we count the number S of values of i
such that yi > yi−1, i = 2, . . . , n, or equivalently the number of times the differenced
series yi − yi−1 is positive. For an iid sequence it is clear that

μS = ES = 1

2
(n − 1).

It can also be shown, under the same assumption, that

σ 2
S = Var(S) = (n + 1)/12,

and that for large n,

S is approximately N
(
μS, σ

2
S

)
.
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A large positive (or negative) value of S − μS indicates the presence of an increasing
(or decreasing) trend in the data. We therefore reject the assumption of no trend in the
data if |S − μS|/σS > �1−α/2.

The difference-sign test must be used with caution. A set of observations exhibit-
ing a strong cyclic component will pass the difference-sign test for randomness, since
roughly half of the observations will be points of increase.

(e) The rank test. The rank test is particularly useful for detecting a linear trend
in the data. Define P to be the number of pairs (i, j) such that yj > yi and j > i,
i = 1, . . . , n − 1. There is a total of

(n
2

) = 1
2n(n − 1) pairs (i, j) such that j > i. For

an iid sequence {Y1, . . . ,Yn}, each event {Yj > Yi} has probability 1
2 , and the mean

of P is therefore

μP = 1

4
n(n − 1).

It can also be shown for an iid sequence that the variance of P is

σ 2
P = n(n − 1)(2n + 5)/72

and that for large n,

P is approximately N
(
μP, σ

2
P

)

(see Kendall and Stuart 1976). A large positive (negative) value of P−μP indicates the
presence of an increasing (decreasing) trend in the data. The assumption that {yj} is a
sample from an iid sequence is therefore rejected at level α = 0.05 if |P − μP|/σP >
�1−α/2 = 1.96.

( f ) Fitting an autoregressive model. A further test that can be carried out using
the program ITSM is to fit an autoregressive model to the data using the Yule–Walker
algorithm (discussed in Section 5.1.1) and choosing the order which minimizes the
AICC statistic (see Section 5.5). A selected order equal to zero suggests that the data
is white noise.

(g) Checking for normality. If the noise process is Gaussian, i.e., if all of its
joint distributions are normal, then stronger conclusions can be drawn when a model
is fitted to the data. The following test enables us to check whether it is reasonable
to assume that observations from an iid sequence are also Gaussian.

Let Y(1) < Y(2) < · · · < Y(n) be the order statistics of a random sample Y1, . . . ,Yn

from the distribution N(μ, σ 2). If X(1) < X(2) < · · · < X(n) are the order statistics
from a N(0, 1) sample of size n, then

EY( j ) = μ+ σmj,

where mj = EX( j ), j = 1, . . . , n. The graph of the points
(
m1,Y(1)

)
, . . . ,

(
mn,Y(n)

)

is called a Gaussian qq plot) and can be displayed in ITSM by clicking on the yellow
button labeled QQ. If the normal assumption is correct, the Gaussian qq plot should
be approximately linear. Consequently, the squared correlation of the points (mi,Y(i)),
i = 1, . . . , n, should be near 1. The assumption of normality is therefore rejected if the
squared correlation R2 is sufficiently small. If we approximate mi by�−1((i−0.5)/n)
(see Mage 1982 for some alternative approximations), then R2 reduces to

R2 =
(∑n

i=1(Y(i) − Y)�−1
(
i−0.5
n

))2

∑n
i=1(Y(i) − Y)2

∑n
i=1

(
�−1

(
i−0.5
n

))2
,

where Y = n−1(Y1 + · · · + Yn). Percentage points for the distribution of R2, assuming
normality of the sample values, are given by Shapiro and Francia (1972) for sample
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Figure 1-28
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sizes n < 100. For n = 200, P(R2 < 0.987) = 0.05 and P(R2 < 0.989) = 0.10. For
larger values of n the Jarque-Bera test (Jarque and Bera, 1980) for normality can be
used (see Section 5.3.3).

Example 1.6.1 If we did not know in advance how the signal plus noise data of Example 1.1.4 were
generated, we might suspect that they came from an iid sequence. We can check this
hypothesis with the aid of the tests (a)–(f) introduced above.

(a) The sample autocorrelation function (Figure 1-28) is obtained from ITSM by
opening the project SIGNAL.TSMand clicking on the second yellow button at the
top of the ITSM window. Observing that 25% of the autocorrelations are
outside the bounds ±1.96/

√
200, we reject the hypothesis that the series is iid.

The remaining tests (b), (c), (d), (e), and (f) are performed by choosing the
option Statistics>Residual Analysis>Tests of Randomness.
(Since no model has been fitted to the data, the residuals are the same as the data
themselves.)

(b) The sample value of the Ljung–Box statistic QLB with h = 20 is 51.84. Since the
corresponding p-value (displayed by ITSM) is 0.00012 < 0.05, we reject the iid
hypothesis at level 0.05. The p-value for theMcLeod–Li statisticQML is 0.717. The
McLeod–Li statistic does therefore not provide sufficient evidence to reject the iid
hypothesis at level 0.05.

(c) The sample value of the turning-point statistic T is 138, and the asymptotic distri-
bution under the iid hypothesis (with sample size n = 200) is N(132, 35.3). Thus
|T−μT |/σT = 1.01, corresponding to a computed p-value of 0.312. On the basis of
the value of T there is therefore not sufficient evidence to reject the iid hypothesis
at level 0.05.

(d) The sample value of the difference-sign statistic S is 101, and the asymptotic
distribution under the iid hypothesis (with sample size n = 200) is N(99.5, 16.7).
Thus |S−μS|/σS = 0.38, corresponding to a computed p-value of 0.714. On the
basis of the value of S there is therefore not sufficient evidence to reject the iid
hypothesis at level 0.05.
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(e) The sample value of the rank statistic P is 10,310, and the asymptotic distribu-
tion under the iid hypothesis (with n=200) is N

(
9950, 2.239×105

)
. The statistic

|P − μP|/σP, is therefore equal to 0.76, corresponding to a p-value of 0.447. On
the basis of the value of P there is therefore not sufficient evidence to reject the
iid hypothesis at level 0.05.

(f) The minimum-AICC Yule–Walker autoregressive model for the data is of
order seven, supporting the evidence provided by the sample ACF and Ljung–Box
tests against the iid hypothesis.

Thus, although not all of the tests detect significant deviation from iid behavior, the
sample autocorrelation, the Ljung–Box statistic, and the fitted autoregression provide
strong evidence against it, causing us to reject it (correctly) in this example.

�
The general strategy in applying the tests described in this section is to check them

all and to proceed with caution if any of them suggests a serious deviation from the iid
hypothesis. (Remember that as you increase the number of tests, the probability that
at least one rejects the null hypothesis when it is true increases. You should therefore
not necessarily reject the null hypothesis on the basis of one test result only.)

Problems

1.1 Let X and Y be two random variables with E(Y) = μ and EY2 < ∞.
a. Show that the constant c that minimizes E(Y − c)2 is c = μ.

b. Deduce that the random variable f (X) that minimizes E
[
(Y − f (X))2|X] is

f (X) = E[Y|X].
c. Deduce that the random variable f (X) that minimizes E(Y − f (X))2 is also

f (X) = E[Y|X].

1.2 (Generalization of Problem 1.1.) Suppose that X1,X2, . . . is a sequence of ran-
dom variables with E(X2

t ) < ∞ and E(Xt) = μ.
a. Show that the random variable f (X1, . . . ,Xn) that minimizes the conditional

mean squared error, E
[
(Xn+1 − f (X1, . . . ,Xn))

2|X1, . . . ,Xn

]
, is

f (X1, . . . ,Xn) = E[Xn+1|X1, . . . ,Xn].
b. Deduce that the random variable f (X1, . . . ,Xn) that minimizes the uncondi-

tional mean squared error, E
[
(Xn+1 − f (X1, . . . ,Xn))

2
]
, is also

f (X1, . . . ,Xn) = E[Xn+1|X1, . . . ,Xn].
c. If X1,X2, . . . is iid with E(X2

i ) < ∞ and EXi = μ, where μ is known, what
is the minimum mean squared error predictor of Xn+1 in terms of X1, . . . ,Xn?

d. Under the conditions of part (c) show that the best linear unbiased estimator
of μ in terms of X1, . . . ,Xn is X̄ = 1

n(X1 +· · ·+Xn). (μ̂ said to be an unbiased
estimator of μ if Eμ̂ = μ for all μ.)

e. Under the conditions of part (c) show that X̄ is the best linear predictor of
Xn+1 that is unbiased for μ.

f. If X1,X2, . . . is iid with E
(
X2
i

)
< ∞ and EXi = μ, and if S0 = 0, Sn =

X1+· · ·+Xn, n = 1, 2, . . ., what is the minimummean squared error predictor
of Sn+1 in terms of S1, . . . , Sn?
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1.3 Show that a strictly stationary process with E(X2
i ) < ∞ is weakly stationary.

1.4 Let {Zt} be a sequence of independent normal random variables, each with
mean 0 and variance σ 2, and let a, b, and c be constants. Which, if any, of the
following processes are stationary? For each stationary process specify the mean
and autocovariance function.
a. Xt = a + bZt + cZt−2

b. Xt = Z1 cos(ct)+ Z2 sin(ct)

c. Xt = Zt cos(ct)+ Zt−1 sin(ct)

d. Xt = a + bZ0

e. Xt = Z0 cos(ct)

f. Xt = ZtZt−1

1.5 Let {Xt} be the moving-average process of order 2 given by

Xt = Zt + θZt−2,

where {Zt} is WN(0, 1).
a. Find the autocovariance and autocorrelation functions for this process when
θ = 0.8.

b. Compute the variance of the sample mean (X1+X2+X3+X4)/4when θ = 0.8.

c. Repeat (b) when θ = −0.8 and compare your answer with the result obtained
in (b).

1.6 Let {Xt} be the AR(1) process defined in Example 1.4.5.
a. Compute the variance of the sample mean (X1+X2+X3+X4)/4when φ = 0.9

and σ 2 = 1.

b. Repeat (a) when φ = −0.9 and compare your answer with the result obtained
in (a).

1.7 If {Xt} and {Yt} are uncorrelated stationary sequences, i.e., if Xr and Ys are uncor-
related for every r and s, show that {Xt + Yt} is stationary with autocovariance
function equal to the sum of the autocovariance functions of {Xt} and {Yt}.

1.8 Let {Zt} be IID N(0, 1) noise and define

Xt =
⎧
⎨

⎩

Zt, if t is even,

(Z2
t−1 − 1)/

√
2, if t is odd.

a. Show that {Xt} is WN(0, 1) but not iid(0, 1) noise.

b. Find E(Xn+1|X1, . . . ,Xn) for n odd and n even and compare the results.

1.9 Let {x1, . . . , xn} be observed values of a time series at times 1, . . . , n, and let
ρ̂(h) be the sample ACF at lag h as in Definition 1.4.4.
a. If xt = a + bt, where a and b are constants and b �= 0, show that for each

fixed h ≥ 1,

ρ̂(h) → 1 as n → ∞.
b. If xt = c cos(ωt), where c and ω are constants (c �= 0 and ω ∈ (−π, π ]),

show that for each fixed h,

ρ̂(h) → cos(ωh) as n → ∞.
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1.10 Ifmt = ∑p
k=0 ckt

k, t = 0,±1, . . . , show that ∇mt is a polynomial of degree p−1
in t and hence that ∇p+1mt = 0.

1.11 Consider the simple moving-average filter with weights aj = (2q+ 1)−1, −q ≤
j ≤ q.
a. If mt = c0 + c1t, show that

∑q
j=−q ajmt−j = mt.

b. If Zt, t = 0,±1,±2, . . . , are independent random variables with mean 0
and variance σ 2, show that the moving average At = ∑q

j=−q ajZt−j is “small”
for large q in the sense that EAt = 0 and Var(At) = σ 2/(2q + 1).

1.12 a. Show that a linear filter {aj} passes an arbitrary polynomial of degree kwithout
distortion, i.e., that

mt =
∑

j

ajmt−j

for all kth-degree polynomials mt = c0 + c1t + · · · + cktk, if and only if
⎧
⎪⎨

⎪⎩

∑

j
aj = 1 and

∑

j
jraj = 0, for r = 1, . . . , k.

b. Deduce that the Spencer 15-point moving-average filter {aj} defined by (1.5.6)
passes arbitrary third-degree polynomial trends without distortion.

1.13 Find a filter of the form 1 + αB + βB2 + γB3 (i.e., find α, β, and γ ) that
passes linear trends without distortion and that eliminates arbitrary seasonal
components of period 2.

1.14 Show that the filter with coefficients [a−2, a−1, a0, a1, a2] = 1
9 [−1, 4, 3, 4,−1]

passes third-degree polynomials and eliminates seasonal components with pe-
riod 3.

1.15 Let {Yt} be a stationary process with mean zero and let a and b be constants.
a. If Xt = a+bt+st+Yt, where st is a seasonal component with period 12, show

that ∇∇12Xt = (1−B)(1−B12)Xt is stationary and express its autocovariance
function in terms of that of {Yt}.

b. If Xt = (a + bt)st + Yt, where st is a seasonal component with period 12,
show that ∇2

12Xt = (1 − B12)2Xt is stationary and express its autocovariance
function in terms of that of {Yt}.

1.16 (Using ITSM to smooth the strikes data.) Double-click on the ITSM icon,
select File>Project>Open>Univariate, click OK, and open the file
STRIKES. TSM. The graph of the data will then appear on your screen. For
smoothing select either Smooth>MovingAve,Smooth>Exponential, or
Smooth>FFT. Try using each of these to reproduce the results shown in
Figures 1-18, 1-21, and 1-22.

1.17 (Using ITSM to plot the deaths data.) In ITSM select File>Project>Open>
Univariate, click OK, and open the project DEATHS.TSM. The graph of
the data will then appear on your screen. To see a histogram of the data, click
on the sixth yellow button at the top of the ITSM window. To see the sample
autocorrelation function, click on the second yellow button. The presence of a
strong seasonal component with period 12 is evident in the graph of the data and
in the sample autocorrelation function.
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1.18 (Using ITSM to analyze the deaths data.) Open the file DEATHS.TSM, select
Transform>Classical, check the boxmarked Seasonal Fit, and enter
12 for the period. Make sure that the box labeled Polynomial Fit is not
checked, and click, OK. You will then see the graph (Figure 1-24) of the
deseasonalized data. This graph suggests the presence of an additional quadratic
trend function. To fit such a trend, select Transform>Undo Classical to
retrieve the original data. Then select Transform>Classicaland check the
boxes marked Seasonal Fit andPolynomial Trend, entering 12 for the
period and Quadratic for the trend. Click OK to obtain the trend function

m̂t = 9952 − 71.82t + 0.8260t2, 1 ≤ t ≤ 72.

At this point the data stored in ITSM consists of the estimated noise

Ŷt = xt − m̂t − ŝt, t = 1, . . . , 72,

obtained by subtracting the estimated seasonal and trend components
from the original data. The sample autocorrelation function can be plotted
by clicking on the second yellow button at the top of the ITSM window.
Further tests for dependence can be carried out by selecting the options
Statistics>Residual Analysis>Tests of Randomness. These
show clearly the substantial dependence in the series {Yt}.

To forecast the data without allowing for this dependence, select the
option Forecasting>ARMA. Specify 24 for the number of values to be
forecast, and the program will compute forecasts based on the assumption
that the estimated seasonal and trend components are true values and that {Yt}
is a white noise sequence with zero mean. (This is the default model assumed
by ITSM until a more complicated stationary model is estimated or specified.)
The original data are plotted with the forecasts appended. Later we shall see
how to improve on these forecasts by taking into account the dependence in the
series {Yt}.

1.19 Use a text editor to construct and save a text file named TEST.TSM, which
consists of a single column of 30 numbers, {x1, . . . , x30}, defined by

x1, . . . , x10 : 486, 474, 434, 441, 435, 401, 414, 414, 386, 405;
x11, . . . , x20 : 411, 389, 414, 426, 410, 441, 459, 449, 486, 510;
x21, . . . , x30 : 506, 549, 579, 581, 630, 666, 674, 729, 771, 785.

This series is in fact the sum of a quadratic trend and a period-three seasonal
component. Use the program ITSM to apply the filter in Problem 1.14 to this
time series and discuss the results.

(Once the data have been typed, they can be imported directly into ITSM
by highlighting the data to be imported, using the Windows command Select
and Copy and then, in ITSM, selecting the option File>Project>New>
Univariate, clicking on OK and selecting File>Import Clipboard.)



2 Stationary Processes

2.1 Basic Properties
2.2 Linear Processes
2.3 Introduction to ARMA Processes
2.4 Properties of the Sample Mean and Autocorrelation Function
2.5 Forecasting Stationary Time Series
2.6 The Wold Decomposition

A key role in time series analysis is played by processes whose properties, or some
of them, do not vary with time. If we wish to make predictions, then clearly we
must assume that something does not vary with time. In extrapolating deterministic
functions it is common practice to assume that either the function itself or one of its
derivatives is constant. The assumption of a constant first derivative leads to linear
extrapolation as a means of prediction. In time series analysis our goal is to predict
a series that typically is not deterministic but contains a random component. If this
random component is stationary, in the sense of Definition 1.4.2, then we can develop
powerful techniques to forecast its future values. These techniques will be developed
and discussed in this and subsequent chapters.

2.1 Basic Properties

In Section 1.4 we introduced the concept of stationarity and defined the autocovari-
ance function (ACVF) of a stationary time series {Xt} as

γ (h) = Cov(Xt+h, Xt), h = 0,±1,±2, . . . .

The autocorrelation function (ACF) of {Xt} was defined similarly as the function ρ(·)
whose value at lag h is

ρ(h) = γ (h)

γ (0)
.
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The ACVF and ACF provide a useful measure of the degree of dependence among
the values of a time series at different times and for this reason play an important role
when we consider the prediction of future values of the series in terms of the past and
present values. They can be estimated from observations of X1, . . . , Xn by computing
the sample ACVF and ACF as described in Section 1.4.1.

The role of the autocorrelation function in prediction is illustrated by the following
simple example. Suppose that {Xt} is a stationary Gaussian time series (see Defi-
nition A.3.2) and that we have observed Xn. We would like to find the function of
Xn that gives us the best predictor of Xn+h, the value of the series after another h
time units have elapsed. To define the problem we must first say what we mean by
“best.” A natural and computationally convenient definition is to specify our required
predictor to be the function ofXn withminimummean squared error. In this illustration,
and indeed throughout the remainder of this book, we shall use this as our criterion
for “best.” Now by Proposition A.3.1 the conditional distribution of Xn+h given that
Xn = xn is

N
(
μ+ ρ(h)(xn − μ), σ 2

(
1 − ρ(h)2)),

where μ and σ 2 are the mean and variance of {Xt}. It was shown in Problem 1.1 that
the value of the constant c that minimizes E(Xn+h − c)2 is c = E(Xn+h) and that the
function m of Xn that minimizes E(Xn+h − m(Xn))

2 is the conditional mean

m(Xn) = E(Xn+h|Xn) = μ+ ρ(h)(Xn − μ). (2.1.1)

The corresponding mean squared error is

E(Xn+h − m(Xn))
2 = σ 2(1 − ρ(h)2). (2.1.2)

This calculation shows that at least for stationary Gaussian time series, prediction of
Xn+h in terms of Xn is more accurate as |ρ(h)| becomes closer to 1, and in the limit as
ρ(h) → ±1 the best predictor approaches μ± (Xn − μ) and the corresponding mean
squared error approaches 0.

In the preceding calculation the assumption of joint normality of Xn+h and Xn

played a crucial role. For time series with nonnormal joint distributions the correspond-
ing calculations are in general much more complicated. However, if instead of looking
for the best function of Xn for predicting Xn+h, we look for the best linear predictor,
i.e., the best predictor of the form �(Xn) = aXn + b, then our problem becomes that of
finding a and b to minimize E(Xn+h − aXn − b)2. An elementary calculation (Problem
2.1), shows that the best predictor of this form is

�(Xn) = μ+ ρ(h)(Xn − μ) (2.1.3)

with corresponding mean squared error

E(Xn+h − �(Xn))
2 = σ 2(1 − ρ(h)2). (2.1.4)

Comparison with (2.1.1) and (2.1.3) shows that for Gaussian processes, �(Xn) and
m(Xn) are the same. In general, of course, m(Xn) will give smaller mean squared
error than �(Xn), since it is the best of a larger class of predictors (see Problem 1.8).
However, the fact that the best linear predictor depends only on the mean and ACF of
the series {Xt} means that it can be calculated without more detailed knowledge of the
joint distributions. This is extremely important in practice because of the difficulty of
estimating all of the joint distributions and because of the difficulty of computing the
required conditional expectations even if the distributions were known.



2.1 Basic Properties 41

As we shall see later in this chapter, similar conclusions apply when we consider
the more general problem of predicting Xn+h as a function not only of Xn, but also of
Xn−1,Xn−2, . . . . Before pursuing this question we need to examine in more detail the
properties of the autocovariance and autocorrelation functions of a stationary time
series.

Basic Properties of γ(·):
γ (0) ≥ 0,

|γ (h)| ≤ γ (0) for all h,
and γ (·) is even, i.e.,

γ (h) = γ (−h) for all h.

Proof The first property is simply the statement that Var(Xt) ≥ 0, the second is an immediate
consequence of the fact that correlations are less than or equal to 1 in absolute value
(or the Cauchy–Schwarz inequality), and the third is established by observing that

γ (h) = Cov(Xt+h,Xt) = Cov(Xt,Xt+h) = γ (−h). �

Autocovariance functions have another fundamental property, namely that of
nonnegative definiteness.

Definition 2.1.1 A real-valued function κ defined on the integers is nonnegative definite if
n∑

i, j=1

aiκ(i − j)aj ≥ 0 (2.1.5)

for all positive integers n and vectors a = (a1, . . . , an)′ with real-valued compo-
nents ai.

Theorem 2.1.1 A real-valued function defined on the integers is the autocovariance function of a
stationary time series if and only if it is even and nonnegative definite.

Proof To show that the autocovariance function γ (·) of any stationary time series {Xt} is
nonnegative definite, let a be any n×1 vector with real components a1, . . . , an and let
Xn = (Xn, . . . , X1)

′. Then by equation (A.2.5) and the nonnegativity of variances,

Var(a′Xn) = a′�na =
n∑

i, j=1

aiγ (i− j)aj ≥ 0,

where �n is the covariance matrix of the random vector Xn. The last inequality,
however, is precisely the statement that γ (·) is nonnegative definite. The converse
result, that there exists a stationary time series with autocovariance function κ if
κ is even, real-valued, and nonnegative definite, is more difficult to establish (see
Brockwell and Davis (1991), Theorem 1.5.1 for a proof). A slightly stronger statement
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can be made, namely, that under the specified conditions there exists a stationary
Gaussian time series {Xt} with mean 0 and autocovariance function κ(·). �

Remark 1. An autocorrelation function ρ(·) has all the properties of an autocovari-
ance function and satisfies the additional condition ρ(0) = 1. In particular, we can say
that ρ(·) is the autocorrelation function of a stationary process if and only if ρ(·) is an
ACVF with ρ(0) = 1. �

Remark 2. To verify that a given function is nonnegative definite it is often simpler
to find a stationary process that has the given function as its ACVF than to verify the
conditions (2.1.5) directly. For example, the function κ(h) = cos(ωh) is nonnegative
definite, since (see Problem 2.2) it is the ACVF of the stationary process

Xt = A cos(ωt)+ B sin(ωt),

where A and B are uncorrelated random variables, both with mean 0 and variance 1.
Another illustration is provided by the following example. �

Example 2.1.1 We shall show now that the function defined on the integers by

κ(h) =

⎧
⎪⎨

⎪⎩

1, if h = 0,

ρ, if h = ±1,

0, otherwise,

is the ACVF of a stationary time series if and only if |ρ| ≤ 1
2 . Inspection of the ACVF

of the MA(1) process of Example 1.4.4 shows that κ is the ACVF of such a process if
we can find real θ and nonnegative σ 2 such that

σ 2(1 + θ2) = 1

and

σ 2θ = ρ.

If |ρ| ≤ 1
2 , these equations give solutions θ = (2ρ)−1

(
1 ± √

1 − 4ρ2
)
and σ 2 =

(
1 + θ2

)−1
. However, if |ρ| > 1

2 , there is no real solution for θ and hence no MA(1)
process with ACVF κ . To show that there is no stationary process with ACVF κ ,
we need to show that κ is not nonnegative definite. We shall do this directly from the
definition (2.1.5). First, if ρ > 1

2 , K = [κ(i − j)]ni, j=1, and a is the n-component vector
a = (1,−1, 1,−1, . . .)′, then

a′Ka = n − 2(n − 1)ρ < 0 for n > 2ρ/(2ρ − 1),

showing that κ(·) is not nonnegative definite and therefore, by Theorem 2.1.1, is not
an autocovariance function. If ρ < − 1

2 , the same argument with a = (1, 1, 1, 1, . . .)′
again shows that κ(·) is not nonnegative definite.

�
If {Xt} is a (weakly) stationary time series, then the vector (X1, . . . , Xn)

′ and the
time-shifted vector (X1+h, . . . , Xn+h)

′ have the same mean vectors and covariance
matrices for every integer h and positive integer n. A strictly stationary sequence is
one in which the joint distributions of these two vectors (and not just the means and
covariances) are the same. The precise definition is given below.
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Definition 2.1.2 {Xt} is a strictly stationary time series if

(X1, . . . , Xn)
′ d= (X1+h, . . . ,Xn+h)

′

for all integers h and n ≥ 1. (Here
d= is used to indicate that the two random vectors

have the same joint distribution function.)

For reference, we record some of the elementary properties of strictly stationary
time series.

Properties of a Strictly Stationary Time Series {Xt}:

a. The random variables Xt are identically distributed.

b. (Xt,Xt+h)
′ d= (X1,X1+h)

′ for all integers t and h.

c. {Xt} is weakly stationary if E(X2
t ) < ∞ for all t.

d. Weak stationarity does not imply strict stationarity.

e. An iid sequence is strictly stationary.

Proof Properties (a) and (b) follow at once from Definition 2.1.2. If EX2
t < ∞, then by

(a) and (b) EXt is independent of t and Cov(Xt,Xt+h) = Cov(X1,X1+h), which is
also independent of t, proving (c). For (d) see Problem 1.8. If {Xt} is an iid sequence
of random variables with common distribution function F, then the joint distribution
function of (X1+h, . . . , Xn+h)

′ evaluated at (x1, . . . , xn)′ is F(x1) · · ·F(xn), which is
independent of h. �

One of the simplest ways to construct a time series {Xt} that is strictly stationary
(and hence stationary if EX2

t < ∞) is to “filter” an iid sequence of random variables.
Let {Zt} be an iid sequence, which by (e) is strictly stationary, and define

Xt = g(Zt,Zt−1, . . . ,Zt−q) (2.1.6)

for some real-valued function g(·, . . . , ·). Then {Xt} is strictly stationary, since

(Zt+h, . . . ,Zt+h−q)
′ d= (Zt, . . . ,Zt−q)

′ for all integers h. It follows also from the
defining equation (2.1.6) that {Xt} is q-dependent, i.e., that Xs and Xt are independent
whenever |t − s| > q. (An iid sequence is 0-dependent.) In the same way, adopting
a second-order viewpoint, we say that a stationary time series is q-correlated if
γ (h) = 0 whenever |h| > q. A white noise sequence is then 0-correlated, while
the MA(1) process of Example 1.4.4 is 1-correlated. The moving-average process of
order q defined below is q-correlated, and perhaps surprisingly, the converse is also
true (Proposition 2.1.1).

The MA(q) Process:

{Xt} is amoving-average process of order q if

Xt = Zt + θ1Zt−1 + · · · + θqZt−q, (2.1.7)

where {Zt} ∼ WN
(
0, σ 2

)
and θ1, . . . , θq are constants.
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It is a simple matter to check that (2.1.7) defines a stationary time series that is strictly
stationary if {Zt} is iid noise. In the latter case, (2.1.7) is a special case of (2.1.6) with
g a linear function.

The importance of MA(q) processes derives from the fact that every q-correlated
process is an MA(q) process. This is the content of the following proposition, whose
proof can be found in Brockwell and Davis (1991), Section 3.2. The extension of this
result to the case q = ∞ is essentially Wold’s decomposition (see Section 2.6).

Proposition 2.1.1 If {Xt} is a stationary q-correlated time series with mean 0, then it can be represented
as the MA(q) process in (2.1.7).

2.2 Linear Processes

The class of linear time series models, which includes the class of autoregressive
moving-average (ARMA) models, provides a general framework for studying
stationary processes. In fact, every second-order stationary process is either a linear
process or can be transformed to a linear process by subtracting a deterministic com-
ponent. This result is known as Wold’s decomposition and is discussed in Section 2.6.

Definition 2.2.1 The time series {Xt} is a linear process if it has the representation

Xt =
∞∑

j=−∞
ψjZt−j, (2.2.1)

for all t, where {Zt} ∼ WN
(
0, σ 2

)
and {ψj} is a sequence of constants with∑∞

j=−∞ |ψj| < ∞.

In terms of the backward shift operator B, (2.2.1) can be written more compactly as

Xt = ψ(B)Zt, (2.2.2)

where ψ(B) = ∑∞
j=−∞ψjB j. A linear process is called amoving average orMA(∞)

if ψj = 0 for all j < 0, i.e., if

Xt =
∞∑

j=0

ψjZt−j.

Remark 1. The condition
∑∞

j=−∞ |ψj| < ∞ ensures that the infinite sum in (2.2.1)
converges (with probability one), since E|Zt| ≤ σ and

E|Xt| ≤
∞∑

j=−∞

(|ψj|E|Zt−j|
) ≤

⎛

⎝
∞∑

j=−∞
|ψj|

⎞

⎠ σ < ∞.

It also ensures that
∑∞

j=−∞ψ
2
j < ∞ and hence (see Appendix C, Example C.1.1) that

the series in (2.2.1) converges in mean square, i.e., that Xt is the mean square limit
of the partial sums

∑n
j=−n ψjZt−j. The condition

∑n
j=−n |ψj| < ∞ also ensures

convergence in both senses of the more general series (2.2.3) considered in
Proposition 2.2.1 below. In Section 11.4 we consider a more general class of linear
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processes, the fractionally integrated ARMA processes, for which the coefficients are
not absolutely summable but only square summable. �

The operator ψ(B) can be thought of as a linear filter, which when applied to
the white noise “input” series {Zt} produces the “output” {Xt} (see Section 4.3). As
established in the following proposition, a linear filter, when applied to any stationary
input series, produces a stationary output series.

Proposition 2.2.1 Let {Yt} be a stationary time series with mean 0 and covariance function γY . If∑∞
j=−∞ |ψj| < ∞, then the time series

Xt =
∞∑

j=−∞
ψjYt−j = ψ(B)Yt (2.2.3)

is stationary with mean 0 and autocovariance function

γX(h) =
∞∑

j=−∞

∞∑

k=−∞
ψjψkγY(h + k − j). (2.2.4)

In the special case where {Xt} is the linear process (2.2.1),

γX(h) =
∞∑

j=−∞
ψjψj+hσ

2. (2.2.5)

Proof The argument used in Remark 1, with σ replaced by
√
γY(0), shows that the series in

(2.2.3) is convergent. Since EYt = 0, we have

E(Xt) = E

⎛

⎝
∞∑

j=−∞
ψjYt−j

⎞

⎠ =
∞∑

j=−∞
ψjE(Yt−j) = 0

and

E(Xt+hXt) = E

⎡

⎣

⎛

⎝
∞∑

j=−∞
ψjYt+h−j

⎞

⎠

( ∞∑

k=−∞
ψkYt−k

)⎤

⎦

=
∞∑

j=−∞

∞∑

k=−∞
ψjψkE(Yt+h−jYt−k)

=
∞∑

j=−∞

∞∑

k=−∞
ψjψkγY(h − j + k),

which shows that {Xt} is stationary with covariance function (2.2.4). (The interchange
of summation and expectation operations in the above calculations can be justified by
the absolute summability of ψj.) Finally, if {Yt} is the white noise sequence {Zt} in
(2.2.1), then γY(h − j + k) = σ 2 if k = j − h and 0 otherwise, from which (2.2.5)
follows. �

Remark 2. The absolute convergence of (2.2.3) implies (Problem 2.6) that filters of
the form α(B) = ∑∞

j=−∞ αjB j and β(B) = ∑∞
j=−∞ βjB j with absolutely summable

coefficients can be applied successively to a stationary series {Yt} to generate a new
stationary series
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Wt =
∞∑

j=−∞
ψjYt−j,

where

ψj =
∞∑

k=−∞
αkβj−k =

∞∑

k=−∞
βkαj−k. (2.2.6)

These relations can be expressed in the equivalent form

Wt = ψ(B)Yt,

where

ψ(B) = α(B)β(B) = β(B)α(B), (2.2.7)

and the products are defined by (2.2.6) or equivalently by multiplying the series∑∞
j=−∞ αjB

j and
∑∞

j=−∞ βjB
j term by term and collecting powers of B. It is clear

from (2.2.6) and (2.2.7) that the order of application of the filters α(B) and β(B) is
immaterial. �

Example 2.2.1 An AR(1) Process

In Example 1.4.5, an AR(1) process was defined as a stationary solution {Xt} of the
equations

Xt − φXt−1 = Zt, (2.2.8)

where {Zt} ∼ WN(0, σ 2), |φ| < 1, and Zt is uncorrelated with Xs for each s < t. To
show that such a solution exists and is the unique stationary solution of (2.2.8), we
consider the linear process defined by

Xt =
∞∑

j=0

φ jZt−j. (2.2.9)

(The coefficients φ j for j ≥ 0 are absolutely summable, since |φ| < 1.) It is easy to
verify directly that the process (2.2.9) is a solution of (2.2.8), and by Proposition 2.2.1
it is also stationary with mean 0 and ACVF

γX(h) =
∞∑

j=0

φ jφ j+hσ 2 = σ 2φh

1 − φ2
,

for h ≥ 0.
To show that (2.2.9) is the only stationary solution of (2.2.8) let {Yt} be any

stationary solution. Then, iterating (2.2.8), we obtain

Yt = φYt−1 + Zt

= Zt + φZt−1 + φ2Yt−2

= · · ·
= Zt + φZt−1 + · · · + φkZt−k + φk+1Yt−k−1.

If {Yt} is stationary, then EY2
t is finite and independent of t, so that

E(Yt −
k∑

j=0

φ jZt−j)
2 = φ2k+2E(Yt−k−1)

2

→ 0 as k → ∞.
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This implies that Yt is equal to the mean square limit
∑∞

j=0 φ
jZt−j and hence that the

process defined by (2.2.9) is the unique stationary solution of equation (2.2.8).
It the case |φ| > 1, the series in (2.2.9) does not converge. However, we can rewrite

(2.2.8) in the form

Xt = −φ−1Zt+1 + φ−1Xt+1. (2.2.10)

Iterating (2.2.10) gives

Xt = −φ−1Zt+1 − φ−2Zt+2 + φ−2Xt+2

= · · ·
= −φ−1Zt+1 − · · · − φ−k−1Zt+k+1 + φ−k−1Xt+k+1,

which shows, by the same arguments used above, that

Xt = −
∞∑

j=1

φ−jZt+j (2.2.11)

is the unique stationary solution of (2.2.8). This solution should not be confused with
the nonstationary solution {Xt} of (2.2.8) obtained when X0 is any specified random
variable that is uncorrelated with {Zt}.

The solution (2.2.11) is frequently regarded as unnatural, since Xt as defined by
(2.2.11) is correlated with future values of Zs, contrasting with the solution (2.2.9),
which has the property that Xt is uncorrelated with Zs for all s > t. It is customary
therefore in modeling stationary time series to restrict attention to AR(1) processes
with |φ| < 1. Then Xt has the representation (2.2.8) in terms of {Zs, s ≤ t}, and we
say that {Xt} is a causal or future-independent function of {Zt}, or more concisely that
{Xt} is a causal autoregressive process. It should be noted that every AR(1) process with
|φ| > 1 can be reexpressed as an AR(1) process with |φ| < 1 and a new white noise
sequence (Problem 3.8). From a second-order point of view, therefore, nothing is lost
by eliminating AR(1) processes with |φ| > 1 from consideration.

If φ = ±1, there is no stationary solution of (2.2.8) (see Problem 2.8).
�

Remark 3. It is worth remarking that when |φ| < 1 the unique stationary solution
(2.2.9) can be found immediately with the aid of (2.2.7). To do this let φ(B) = 1−φB
and π(B) = ∑∞

j=0 φ
jB j. Then

ψ(B) := φ(B)π(B) = 1.

Applying the operator π(B) to both sides of (2.2.8), we obtain

Xt = π(B)Zt =
∞∑

j=0

φ jZt−j

as claimed. �

2.3 Introduction to ARMA Processes

In this section we introduce, through an example, some of the key properties of an
important class of linear processes known as ARMA (autoregressive moving average)
processes. These are defined by linear difference equations with constant coefficients.



48 Chapter 2 Stationary Processes

As our example we shall consider the ARMA(1,1) process. Higher-order ARMA
processes will be discussed in Chapter 3.

Definition 2.3.1 The time series {Xt} is an ARMA(1, 1) process if it is stationary and satisfies (for
every t)

Xt − φXt−1 = Zt + θZt−1, (2.3.1)

where {Zt} ∼ WN
(
0, σ 2

)
and φ + θ �= 0.

Using the backward shift operator B, (2.3.1) can be written more concisely as

φ(B)Xt = θ(B)Zt, (2.3.2)

where φ(B) and θ(B) are the linear filters

φ(B) = 1 − φB and θ(B) = 1 + θB,
respectively.

We first investigate the range of values of φ and θ for which a stationary solution
of (2.3.1) exists. If |φ| < 1, let χ(z) denote the power series expansion of 1/φ(z),
i.e.,

∑∞
j=0 φ

jz j, which has absolutely summable coefficients. Then from (2.2.7) we
conclude that χ(B)φ(B) = 1. Applying χ(B) to each side of (2.3.2) therefore gives

Xt = χ(B)θ(B)Zt = ψ(B)Zt,

where

ψ(B) =
∞∑

j=0

ψjB
j = (

1 + φB + φ2B2 + · · · ) (1 + θB) .

By multiplying out the right-hand side or using (2.2.6), we find that

ψ0 = 1 and ψj = (φ + θ)φ j−1 for j ≥ 1.

As in Example 2.2.1, we conclude that the MA(∞) process

Xt = Zt + (φ + θ)
∞∑

j=1

φ j−1Zt−j (2.3.3)

is the unique stationary solution of (2.3.1).
Now suppose that |φ| > 1. We first represent 1/φ(z) as a series of powers of zwith

absolutely summable coefficients by expanding in powers of z−1, giving (Problem 2.7)

1

φ(z)
= −

∞∑

j=1

φ−jz−j.

Then we can apply the same argument as in the case where |φ| < 1 to obtain the
unique stationary solution of (2.3.1). We let χ(B) = −∑∞

j=1 φ
−jB−j and apply χ(B)

to each side of (2.3.2) to obtain

Xt = χ(B)θ(B)Zt = −θφ−1Zt − (θ + φ)
∞∑

j=1

φ−j−1Zt+j. (2.3.4)
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If φ = ±1, there is no stationary solution of (2.3.1). Consequently, there is no
such thing as an ARMA(1,1) process with φ = ±1 according to our definition.

We can now summarize our findings about the existence and nature of the sta-
tionary solutions of the ARMA(1,1) recursions (2.3.2) as follows:

• A stationary solution of the ARMA(1,1) equations exists if and only if φ �= ±1.

• If |φ| < 1, then the unique stationary solution is given by (2.3.3). In this case we
say that {Xt} is causal or a causal function of {Zt}, since Xt can be expressed in
terms of the current and past values Zs, s ≤ t.

• If |φ| > 1, then the unique stationary solution is given by (2.3.4). The solution is
noncausal, since Xt is then a function of Zs, s ≥ t.

Just as causality means that Xt is expressible in terms of Zs, s ≤ t, the dual concept
of invertibility means that Zt is expressible in terms of Xs, s ≤ t. We show now that
the ARMA(1,1) process defined by (2.3.1) is invertible if |θ | < 1. To demonstrate
this, let ξ(z) denote the power series expansion of 1/θ(z), i.e.,

∑∞
j=0(−θ)jz j, which has

absolutely summable coefficients. From (2.2.6) it therefore follows that ξ(B)θ(B) = 1,
and applying ξ(B) to each side of (2.3.2) gives

Zt = ξ(B)φ(B)Xt = π(B)Xt,

where

π(B) =
∞∑

j=0

πjB
j = (

1 − θB + (−θ)2B2 + · · · ) (1 − φB) .

By multiplying out the right-hand side or using (2.2.6), we find that

Zt = Xt − (φ + θ)
∞∑

j=1

(−θ) j−1Xt−j. (2.3.5)

Thus the ARMA(1,1) process is invertible, since Zt can be expressed in terms of the
present and past values of the process Xs, s ≤ t. An argument like the one used to
show noncausality when |φ| > 1 shows that the ARMA(1,1) process is noninvertible
when |θ | > 1, since then

Zt = −φθ−1Xt + (θ + φ)
∞∑

j=1

(−θ)−j−1Xt+j. (2.3.6)

We summarize these results as follows:

• If |θ | < 1, then the ARMA(1,1) process is invertible, and Zt is expressed in terms
of Xs, s ≤ t, by (2.3.5).

• If |θ | > 1, then the ARMA(1,1) process is noninvertible, and Zt is expressed in
terms of Xs, s ≥ t, by (2.3.6).

Remark 1. In the cases θ = ±1, the ARMA(1,1) process is invertible in the more
general sense that Zt is a mean square limit of finite linear combinations of Xs, s ≤ t,
although it cannot be expressed explicitly as an infinite linear combination of Xs, s ≤
t (see Section 4.4 of Brockwell and Davis (1991)). In this book the term invertible
will always be used in the more restricted sense that Zt = ∑∞

j=0 πjXt−j, where∑∞
j=0 |πj| < ∞. �
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Remark 2. If the ARMA(1,1) process {Xt} is noncausal or noninvertible with |θ | > 1,
then it is possible to find a new white noise sequence {Wt} such that {Xt} is a causal
and noninvertible ARMA(1,1) process relative to {Wt} (Problem 4.10). Therefore,
from a second-order point of view, nothing is lost by restricting attention to causal
and invertible ARMA(1,1) models. This last sentence is also valid for higher-order
ARMA models. �

2.4 Properties of the Sample Mean and Autocorrelation Function

A stationary process {Xt} is characterized, at least from a second-order point of view,
by its mean μ and its autocovariance function γ (·). The estimation of μ, γ (·), and the
autocorrelation function ρ(·) = γ (·)/γ (0) from observations X1, . . . ,Xn therefore
plays a crucial role in problems of inference and in particular in the problem of
constructing an appropriate model for the data. In this section we examine some of
the properties of the sample estimates x̄ and ρ̂(·) of μ and ρ(·), respectively.

2.4.1 Estimation of μ

The moment estimator of the mean μ of a stationary process is the sample mean

X̄n = n−1(X1 + X2 + · · · + Xn). (2.4.1)

It is an unbiased estimator of μ, since

E(X̄n) = n−1(EX1 + · · · + EXn) = μ.

The mean squared error of X̄n is

E(X̄n − μ)2 = Var(X̄n)

= n−2
n∑

i=1

n∑

j=1

Cov(Xi,Xj)

= n−2
n∑

i−j=−n

(n − |i − j|)γ (i − j)

= n−1
n∑

h=−n

(

1 − |h|
n

)

γ (h). (2.4.2)

Now if γ (h) → 0 as h → ∞, the right-hand side of (2.4.2) converges to zero,
so that X̄n converges in mean square to μ. If

∑∞
h=−∞ |γ (h)| < ∞, then (2.4.2)

gives limn→∞ nVar(X̄n) = ∑
|h|<∞ γ (h). We record these results in the following

proposition.

Proposition 2.4.1 If {Xt} is a stationary time series with mean μ and autocovariance function γ (·),
then as n → ∞,

Var(X̄n) = E(X̄n − μ)2 → 0 if γ (n) → 0,

nE(X̄n − μ)2 →
∑

|h|<∞
γ (h) if

∞∑

h=−∞
|γ (h)| < ∞.
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To make inferences about μ using the sample mean X̄n, it is necessary to know the
distribution or an approximation to the distribution of X̄n. If the time series is Gaussian
(see Definition A.3.2), then by Remark 2 of Section A.3 and (2.4.2),

n1/2(X̄n − μ) ∼ N

⎛

⎝0,
∑

|h|<n

(

1 − |h|
n

)

γ (h)

⎞

⎠ .

It is easy to construct exact confidence bounds for μ using this result if γ (·) is
known, and approximate confidence bounds if it is necessary to estimate γ (·) from
the observations.

For many time series, in particular for linear and ARMA models, X̄n is approxi-
mately normal with mean μ and variance n−1 ∑

|h|<∞ γ (h) for large n (see Brockwell
and Davis (1991), p. 219). An approximate 95% confidence interval for μ is then

(
X̄n − 1.96v1/2/

√
n, X̄n + 1.96v1/2/

√
n
)
, (2.4.3)

where v = ∑
|h|<∞ γ (h). Of course, v is not generally known, so it must be estimated

from the data. The estimator computed in the program ITSM is v̂ = ∑
|h|<√

n

(
1 −

|h|/√n
)
γ̂ (h). For ARMA processes this is a good approximation to v for large n.

Example 2.4.1 An AR(1) Model

Let {Xt} be an AR(1) process with mean μ, defined by the equations

Xt − μ = φ(Xt−1 − μ)+ Zt,

where |φ| < 1 and {Zt} ∼ WN
(
0, σ 2

)
. From Example 2.2.1 we have γ (h) =

φ|h|σ 2/(1−φ2) and hence v = (
1+2

∑∞
h=1 φ

h
)
σ 2/

(
1−φ2

) = σ 2/(1−φ)2. Approx-
imate 95% confidence bounds for μ are therefore given by x̄n ± 1.96σn−1/2/(1 − φ).
Since φ and σ are unknown in practice, they must be replaced in these bounds by
estimated values.

�

2.4.2 Estimation of γ(·) and ρ(·)
Recall from Section 1.4.1 that the sample autocovariance and autocorrelation functions
are defined by

γ̂ (h) = n−1
n−|h|∑

t=1

(
Xt+|h| − X̄n

)(
Xt − X̄n

)
(2.4.4)

and

ρ̂(h) = γ̂ (h)

γ̂ (0)
. (2.4.5)

Both the estimators γ̂ (h) and ρ̂(h) are biased even if the factor n−1 in (2.4.4) is replaced
by (n − h)−1. Nevertheless, under general assumptions they are nearly unbiased for
large sample sizes. The sample ACVF has the desirable property that for each k ≥ 1
the k-dimensional sample covariance matrix
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�̂k =

⎡

⎢
⎢
⎢
⎣

γ̂ (0) γ̂ (1) · · · γ̂ (k − 1)
γ̂ (1) γ̂ (0) · · · γ̂ (k − 2)
...

... · · · ...

γ̂ (k − 1) γ̂ (k − 2) · · · γ̂ (0)

⎤

⎥
⎥
⎥
⎦

(2.4.6)

is nonnegative definite. To see this, first note that if �̂m is nonnegative definite, then
�̂k is nonnegative definite for all k < m. So assume k ≥ n and write

�̂k = n−1TT ′,

where T is the k × 2k matrix

T =

⎡

⎢
⎢
⎢
⎣

0 · · · 0 0 Y1 Y2 · · · Yk

0 · · · 0 Y1 Y2 · · · Yk 0
...

...

0 Y1 Y2 · · · Yk 0 · · · 0

⎤

⎥
⎥
⎥
⎦
,

Yi = Xi − X̄n, i = 1, . . . , n, and Yi = 0 for i = n + 1, . . . , k. Then for any real k × 1
vector a we have

a′�̂ka = n−1(a′T)(T ′a) ≥ 0, (2.4.7)

and consequently the sample autocovariance matrix �̂k and sample autocorrelation
matrix

R̂k = �̂k/γ (0) (2.4.8)

are nonnegative definite. Sometimes the factor n−1 is replaced by (n − h)−1 in the
definition of γ̂ (h), but the resulting covariance and correlation matrices �̂n and R̂n

may not then be nonnegative definite. We shall therefore use the definitions (2.4.4)
and (2.4.5) of γ̂ (h) and ρ̂(h).

Remark 1. The matrices �̂k and R̂k are in fact nonsingular if there is at least one
nonzero Yi, or equivalently if γ̂ (0) > 0. To establish this result, suppose that γ̂ (0) > 0
and �̂k is singular. Then there is equality in (2.4.7) for some nonzero vector a, implying
that a′T = 0 and hence that the rank of T is less than k. Let Yi be the first nonzero
value of Y1,Y2, . . . ,Yk, and consider the k × k submatrix of T consisting of columns
(i + 1) through (i + k). Since this matrix is lower right triangular with each diagonal
element equal to Yi, its determinant has absolute value |Yi|k �= 0. Consequently, the
submatrix is nonsingular, and T must have rank k, a contradiction. �

Without further information beyond the observed data X1, . . . , Xn, it is impos-
sible to give reasonable estimates of γ (h) and ρ(h) for h ≥ n. Even for h slightly
smaller than n, the estimates γ̂ (h) and ρ̂(h) are unreliable, since there are so few pairs
(Xt+h, Xt) available (only one if h = n − 1). A useful guide is provided by Jenkins
(1976), p. 33 who suggest that n should be at least about 50 and h ≤ n/4.

The sample ACF plays an important role in the selection of suitable models for
the data. We have already seen in Example 1.4.6 and Section 1.6 how the sample ACF
can be used to test for iid noise. For systematic inference concerning ρ(h), we need
the sampling distribution of the estimator ρ̂(h). Although the distribution of ρ̂(h) is
intractable for samples from even the simplest time series models, it can usually be
well approximated by a normal distribution for large sample sizes. For linear models
and in particular for ARMAmodels (see Theorem 7.2.2 of Brockwell and Davis (1991)
for exact conditions) ρ̂k = (ρ̂(1), . . . , ρ̂(k))′ is approximately distributed for large n
as N(ρk, n

−1W), i.e.,
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ρ̂ ≈ N
(
ρ, n−1W

)
, (2.4.9)

where ρ = (ρ(1), . . . , ρ(k))′, and W is the covariance matrix whose (i, j) element
is given by Bartlett’s formula

wij =
∞∑

k=−∞

{
ρ(k + i)ρ(k + j)+ ρ(k − i)ρ(k + j)+ 2ρ(i)ρ( j)ρ2(k)

− 2ρ(i)ρ(k)ρ(k + j)− 2ρ( j)ρ(k)ρ(k + i)
}
.

Simple algebra shows that

wij =
∞∑

k=1

{ρ(k + i)+ ρ(k − i)− 2ρ(i)ρ(k)}
× {ρ(k + j)+ ρ(k − j)− 2ρ( j)ρ(k)}, (2.4.10)

which is a more convenient form of wij for computational purposes.

Example 2.4.2 iid Noise

If {Xt} ∼ IID
(
0, σ 2

)
, then ρ(h) = 0 for |h| > 0, so from (2.4.10) we obtain

wij =
⎧
⎨

⎩

1 if i = j,

0 otherwise.

For large n, therefore, ρ̂(1), . . . , ρ̂(h) are approximately independent and identically
distributed normal random variables with mean 0 and variance n−1. This result is the
basis for the test that data are generated from iid noise using the sample ACF described
in Section 1.6. (See also Example 1.4.6.)

�

Example 2.4.3 An MA(1) Process

If {Xt} is the MA(1) process of Example 1.4.4, i.e., if

Xt = Zt + θZt−1, t = 0,±1, . . . ,

where {Zt} ∼ WN(0, σ 2), then from (2.4.10)

wii =
⎧
⎨

⎩

1 − 3ρ2(1)+ 4ρ4(1), if i = 1,

1 + 2ρ2(1), if i > 1,

is the approximate variance of n−1/2(ρ̂(i) − ρ(i)) for large n. In Figure 2-1 we have
plotted the sample autocorrelation function ρ̂(k), k = 0, . . . , 40, for 200 observations
from the MA(1) model

Xt = Zt − .8Zt−1, (2.4.11)

where {Zt} is a sequence of iid N(0, 1) random variables. Here ρ(1) = −0.8/1.64 =
−0.4878 and ρ(h) = 0 for h > 1. The lag-one sample ACF is found to be ρ̂(1) =
−0.4333=−6.128n−1/2 , which would cause us (in the absence of our prior knowledge
of {Xt}) to reject the hypothesis that the data are a sample from an iid noise sequence.
The fact that |ρ̂(h)|≤1.96n−1/2 for h=2, . . . , 40 strongly suggests that the data are
from a model in which observations are uncorrelated past lag 1. Figure 2-1 shows
the bounds±1.96n−1/2(1+ 2ρ2(1))1/2, indicating the compatibility of the data with
the model (2.4.11). Since, however, ρ(1) is not normally known in advance, the
autocorrelations ρ̂(2), . . . , ρ̂(40)would in practice have been compared with the more
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Figure 2-1
The sample autocorrelation

function of n = 200
observations of the MA(1)
process in Example 2.4.3,

showing the bounds
±1.96n−1/2(1+2ρ̂2(1))1/2 Lag 

A
C

F

0 10 20 30 40

−0
.4

−0
.2

0.
0

0.
2

0.
4

0.
6

0.
8

1.
0

stringent bounds ±1.96n−1/2 or with the bounds ±1.96n−1/2(1+2ρ̂2(1))1/2 in order
to check the hypothesis that the data are generated by a moving-average process
of order 1. Finally, it is worth noting that the lag-one correlation −0.4878 is well
inside the 95% confidence bounds for ρ(1) given by ρ̂(1)± 1.96n−1/2(1 − 3ρ̂2(1)+
4ρ̂4(1))1/2 = −0.4333 ± 0.1053. This further supports the compatibility of the data
with the model Xt = Zt − 0.8Zt−1.

�

Example 2.4.4 An AR(1) Process

For the AR(1) process of Example 2.2.1,

Xt = φXt−1 + Zt,

where {Zt} is iid noise and |φ| < 1, we have, from (2.4.10) with ρ(h) = φ|h|,

wii =
i∑

k=1

φ2i
(
φ−k − φk

)2 +
∞∑

k=i+1

φ2k
(
φ−i − φi

)2

= (
1 − φ2i

)(
1 + φ2

)(
1 − φ2

)−1 − 2iφ2i, (2.4.12)

i = 1, 2, . . . . In Figure 2-2 we have plotted the sample ACF of the Lake Huron
residuals y1, . . . , y98 from Figure 1-10 together with 95% confidence bounds for
ρ(i), i = 1, . . . , 40, assuming that data are generated from the AR(1) model

Yt = 0.791Yt−1 + Zt (2.4.13)

[see equation (1.4.3)]. The confidence bounds are computed from ρ̂(i) ± 1.96n−1/2

w1/2
ii , where wii is given in (2.4.12) with φ = 0.791. The model ACF, ρ(i) =
(0.791)i, is also plotted in Figure 2-2. Notice that the model ACF just touches
the confidence bounds at lags 2–4. This suggests some incompatibility of the data with
the model (2.4.13). A much better fit to the residuals is provided by the second-order
autoregression defined by (1.4.4).

�
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Figure 2-2
The sample autocorrelation
function of the Lake Huron

residuals of Figure 1-10
showing the bounds

ρ̂(i)±1.96n−1/2w1/2
ii and

the model ACF
ρ(i) = (0.791)i Lag
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2.5 Forecasting Stationary Time Series

We now consider the problem of predicting the values Xn+h, h > 0, of a stationary
time series with known mean μ and autocovariance function γ in terms of the
values {Xn, . . . , X1}, up to time n. Our goal is to find the linear combination of
1,Xn,Xn−1, . . . , X1, that forecasts Xn+h with minimum mean squared error. The best
linear predictor in terms of 1,Xn, . . . , X1 will be denoted by PnXn+h and clearly has
the form

PnXn+h = a0 + a1Xn + · · · + anX1. (2.5.1)

It remains only to determine the coefficients a0, a1, . . . , an, by finding the values that
minimize

S(a0, . . . , an) = E(Xn+h − a0 − a1Xn − · · · − anX1)
2. (2.5.2)

(We already know from Problem 1.1 that P0Y = E(Y).) Since S is a quadratic function
of a0, . . . , an and is bounded below by zero, it is clear that there is at least one value of
(a0, . . . , an) that minimizes S and that theminimum (a0, . . . , an) satisfies the equations

∂S(a0, . . . , an)

∂aj
= 0, j = 0, . . . , n. (2.5.3)

Evaluation of the derivatives in equation (2.5.3) gives the equivalent equations

E

[

Xn+h − a0 −
n∑

i=1
aiXn+1−i

]

= 0, (2.5.4)

E

[

(Xn+h − a0 −
n∑

i=1
aiXn+1−i)Xn+1−j

]

= 0, j = 1, . . . , n. (2.5.5)

These equations can be written more neatly in vector notation as

a0 = μ

(

1 −
n∑

i=1

ai

)

(2.5.6)
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and

�nan = γn(h), (2.5.7)

where

an = (a1, . . . , an)
′, �n = [

γ (i − j)
]n
i, j=1 ,

and

γn(h) = (γ (h), γ (h+ 1), . . . , γ (h + n − 1))′.

Hence,

PnXn+h = μ+
n∑

i=1

ai(Xn+1−i − μ), (2.5.8)

where an satisfies (2.5.7). From (2.5.8) the expected value of the prediction error
Xn+h − PnXn+h is zero, and the mean square prediction error is therefore

E(Xn+h − PnXn+h)
2 = γ (0)− 2

n∑

i=1

aiγ (h + i − 1)+
n∑

i=1

n∑

j=1

aiγ (i − j)aj

= γ (0)− a′
nγn(h), (2.5.9)

where the last line follows from (2.5.7).

Remark 1. To show that equations (2.5.4) and (2.5.5) determine PnXn+h uniquely,
let

{
a(1)j , j = 0, . . . , n

}
and

{
a(2)j , j = 0, . . . , n

}
be two solutions and let Z be the

difference between the corresponding predictors, i.e.,

Z = a(1)0 − a(2)0 +
n∑

j=1

(
a(1)j − a(2)j

)
Xn+1−j.

Then

Z2 = Z

⎛

⎝a(1)0 − a(2)0 +
n∑

j=1

(
a(1)j − a(2)j

)
Xn+1−j

⎞

⎠ .

But from (2.5.4) and (2.5.5) we have EZ = 0 and E(Z Xn+1−j) = 0 for j = 1, . . . , n.
Consequently, E(Z2) = 0 and hence Z = 0. �

Properties of PnXn+h:

1. PnXn+h = μ+∑n
i=1 ai(Xn+1−i−μ), where an = (a1, . . . , an)′ satisfies (2.5.7).

2. E(Xn+h − PnXn+h)
2 = γ (0)− a′

nγn(h), where γn(h) = (γ (h), . . . , γ (h+ n−
1))′.

3. E(Xn+h − PnXn+h) = 0.
4. E[(Xn+h − PnXn+h)Xj] = 0, j = 1, . . . , n.

Remark 2. Notice that properties 3 and 4 are exactly equivalent to (2.5.4) and (2.5.5).
They can be written more succinctly in the form
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E[(Error)× (PredictorVariable)] = 0. (2.5.10)

The equations (2.5.10), one for each predictor variable, therefore uniquely determine
PnXn+h. �

Example 2.5.1 One-Step Prediction of an AR(1) Series

Consider now the stationary time series defined in Example 2.2.1 by the equations

Xt = φXt−1 + Zt, t = 0,±1, . . . ,

where |φ| < 1 and {Zt} ∼ WN
(
0, σ 2

)
. From (2.5.7) and (2.5.8), the best linear

predictor of Xn+1 in terms of {1,Xn, . . . , X1} is (for n ≥ 1)

PnXn+1 = a′
nXn,

where Xn = (Xn, . . . ,X1)
′ and

⎡

⎢
⎢
⎢
⎣

1 φ φ2 · · · φn−1

φ 1 φ · · · φn−2

...
...

...
...

...

φn−1 φn−2 φn−3 · · · 1

⎤

⎥
⎥
⎥
⎦

⎡

⎢
⎢
⎢
⎣

a1

a2
...

an

⎤

⎥
⎥
⎥
⎦

=

⎡

⎢
⎢
⎢
⎣

φ

φ2

...

φn

⎤

⎥
⎥
⎥
⎦
. (2.5.11)

A solution of (2.5.11) is clearly

an = (φ, 0, . . . , 0)′,

and hence the best linear predictor of Xn+1 in terms of {X1, . . . , Xn} is
PnXn+1 = a′

nXn = φXn,

with mean squared error

E(Xn+1 − PnXn+1)
2 = γ (0)− a′

nγn(1) = σ 2

1 − φ2
− φγ (1) = σ 2.

A simpler approach to this problem is to guess, by inspection of the equation defining
Xn+1, that the best predictor is φXn. Then to verify this conjecture, it suffices to check
(2.5.10) for each of the predictor variables 1,Xn, . . . , X1. The prediction error of the
predictor φXn is clearly Xn+1 − φXn = Zn+1. But E(Zn+1Y) = 0 for Y = 1 and for
Y = Xj, j = 1, . . . , n. Hence, by (2.5.10), φXn is the required best linear predictor
in terms of 1, X1, . . . , Xn.

�

2.5.1 Prediction of Second-Order Random Variables

Suppose now that Y and Wn, …, W1 are any random variables with finite second
moments and that the means μ = EY , μi = EWi and covariances Cov(Y,Y),
Cov(Y,Wi), and Cov(Wi,Wj) are all known. It is convenient to introduce the random
vector W = (Wn, . . . ,W1)

′, the corresponding vector of means μW = (μn, . . . , μ1)
′,

the vector of covariances

γ = Cov(Y,W) = (Cov(Y,Wn),Cov(Y,Wn−1), . . . ,Cov(Y,W1))
′,

and the covariance matrix

� = Cov(W,W) = [
Cov(Wn+1−i,Wn+1−j)

]n
i, j=1 .
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Then by the same arguments used in the calculation of PnXn+h, the best linear predictor
of Y in terms of {1,Wn, . . . ,W1} is found to be

P(Y|W) = μY + a′(W − μW), (2.5.12)

where a = (a1, . . . , an)′ is any solution of

�a = γ. (2.5.13)

The mean squared error of the predictor is

E
[
(Y − P(Y|W))2] = Var(Y)− a′γ. (2.5.14)

Example 2.5.2 Estimation of a Missing Value

Consider again the stationary series defined in Example 2.2.1 by the equations

Xt = φXt−1 + Zt, t = 0,±1, . . . ,

where |φ| < 1 and {Zt} ∼ WN
(
0, σ 2

)
. Suppose that we observe the series at times 1

and 3 and wish to use these observations to find the linear combination of 1,X1, and X3

that estimates X2 with minimum mean squared error. The solution to this problem can
be obtained directly from (2.5.12) and (2.5.13) by setting Y = X2 and W = (X1,X3)

′.
This gives the equations

[
1 φ2

φ2 1

]

a =
[
φ

φ

]

,

with solution

a = 1

1 + φ2

[
φ

φ

]

.

The best estimator of X2 is thus

P(X2|W) = φ

1 + φ2
(X1 + X3) ,

with mean squared error

E[(X2 − P(X2|W))2] = σ 2

1 − φ2
− a′

⎡

⎢
⎢
⎢
⎣

φσ 2

1 − φ2

φσ 2

1 − φ2

⎤

⎥
⎥
⎥
⎦

= σ 2

1 + φ2
.

�

2.5.2 The Prediction Operator P(·|W)

For any given W = (Wn, . . . ,W1)
′ and Y with finite second moments, we have seen

how to compute the best linear predictor P(Y|W) of Y in terms of 1, Wn, . . . ,W1

from (2.5.12) and (2.5.13). The function P(·|W), which converts Y into P(Y|W),
is called a prediction operator. (The operator Pn defined by equations (2.5.7) and
(2.5.8) is an example with W = (Xn,Xn−1, . . . , X1)

′.) Prediction operators have a
number of useful properties that can sometimes be used to simplify the calculation of
best linear predictors. We list some of these below.
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Properties of the Prediction Operator P( ·| W):
Suppose that EU2 < ∞, EV2 < ∞, � = Cov(W,W), and β, α1, . . . , αn are
constants.

1. P(U|W) = EU + a′(W − EW), where �a = Cov(U,W).
2. E[(U − P(U|W))W] = 0 and E[U − P(U|W)] = 0.
3. E[(U − P(U|W))2] = Var(U)− a′Cov(U,W).
4. P(α1U + α2V + β|W) = α1P(U|W)+ α2P(V|W)+ β.
5. P

(∑n
i=1 αiWi + β|W) = ∑n

i=1 αiWi + β.
6. P(U|W) = EU if Cov(U,W) = 0.
7. P(U|W) = P(P(U|W,V)|W) if V is a random vector such that the compo-

nents of E(VV′) are all finite.

Example 2.5.3 One-Step Prediction of an AR(p) Series

Suppose now that {Xt} is a stationary time series satisfying the equations

Xt = φ1Xt−1 + · · · + φpXt−p + Zt, t = 0,±1, . . . ,

where {Zt} ∼ WN
(
0, σ 2

)
and Zt is uncorrelated with Xs for each s < t. Then if

n > p, we can apply the prediction operator Pn to each side of the defining equations,
using properties (4), (5), and (6) to get

PnXn+1 = φ1Xn + · · · + φpXn+1−p.

�

Example 2.5.4 An AR(1) Series with Nonzero Mean

The time series {Yt} is said to be an AR(1) process with mean μ if {Xt = Yt − μ} is a
zero-mean AR(1) process. Defining {Xt} as in Example 2.5.1 and letting Yt = Xt +μ,
we see that Yt satisfies the equation

Yt − μ = φ(Yt−1 − μ)+ Zt. (2.5.15)

If PnYn+h is the best linear predictor of Yn+h in terms of {1,Yn, . . . ,Y1}, then appli-
cation of Pn to (2.5.15) with t = n + 1, n + 2, . . . gives the recursions

PnYn+h − μ = φ(PnYn+h−1 − μ), h = 1, 2, . . . .

Noting that PnYn = Yn, we can solve these equations recursively for PnYn+h,
h = 1, 2, . . ., to obtain

PnYn+h = μ+ φh(Yn − μ). (2.5.16)

The corresponding mean squared error is [from (2.5.14)]

E(Yn+h − PnYn+h)
2 = γ (0)[1 − a′

nρn(h)]. (2.5.17)

From Example 2.2.1 we know that γ (0) = σ 2/
(
1−φ2

)
and ρ(h) = φh, h ≥ 0. Hence,

substituting an = (
φh, 0, . . . , 0

)′
[from (2.5.16)] into (2.5.17) gives

E(Yn+h − PnYn+h)
2 = σ 2(1 − φ2h)/

(
1 − φ2). (2.5.18)

�
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Remark 3. In general, if {Yt} is a stationary time series with mean μ and if {Xt} is
the zero-mean series defined by Xt = Yt − μ, then since the collection of all linear
combinations of 1,Yn, . . . ,Y1 is the same as the collection of all linear combinations of
1, Xn, . . . , X1, the linear predictor of any random variableW in terms of 1, Yn, . . . , Y1

is the same as the linear predictor in terms of 1,Xn, . . . ,X1. Denoting this predictor by
PnW and applying Pn to the equation Yn+h = Xn+h + μ gives

PnYn+h = μ+ PnXn+h. (2.5.19)

Thus the best linear predictor of Yn+h can be determined by finding the best linear
predictor of Xn+h and then adding μ. Note from (2.5.8) that since E(Xt) = 0, PnXn+h

is the same as the best linear predictor of Xn+h in terms of Xn, . . . ,X1 only. �

2.5.3 The Durbin–Levinson Algorithm

In view of Remark 3 above, we can restrict attention from now on to zero-mean
stationary time series, making the necessary adjustments for the mean if we wish to
predict a stationary series with nonzero mean. If {Xt} is a zero-mean stationary series
with autocovariance function γ (·), then in principle the equations (2.5.12) and (2.5.13)
completely solve the problem of determining the best linear predictor PnXn+h of Xn+h

in terms of {Xn, . . . , X1}. However, the direct approach requires the determination
of a solution of a system of n linear equations, which for large n may be difficult
and time-consuming. In cases where the process is defined by a system of linear
equations (as in Examples 2.5.2 and 2.5.3) we have seen how the linearity of Pn can
be used to great advantage. For more general stationary processes it would be helpful
if the one-step predictor PnXn+1 based on n previous observations could be used to
simplify the calculation of Pn+1Xn+2, the one-step predictor based on n + 1 previous
observations. Prediction algorithms that utilize this idea are said to be recursive. Two
important examples are the Durbin–Levinson algorithm, discussed in this section, and
the innovations algorithm, discussed in Section 2.5.4 below.

We know from (2.5.12) and (2.5.13) that if the matrix �n is nonsingular, then

PnXn+1 = φ′
nXn = φn1Xn + · · · + φnnX1,

where

φn = �−1
n γn,

γn = (γ (1), . . . , γ (n))′, and the corresponding mean squared error is

vn := E(Xn+1 − PnXn+1)
2 = γ (0)− φ′

nγn.

A useful sufficient condition for nonsingularity of all the autocovariance matrices
�1, �2, . . . is γ (0) > 0 and γ (h) → 0 as h → ∞. (For a proof of this result see
Brockwell and Davis (1991), Proposition 5.1.1.)
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The Durbin–Levinson Algorithm:
The coefficients φn1, . . . , φnn can be computed recursively from the equations

φnn =
⎡

⎣γ (n)−
n−1∑

j=1

φn−1, jγ (n− j)

⎤

⎦ v−1
n−1, (2.5.20)

⎡

⎢
⎣

φn1
...

φn,n−1

⎤

⎥
⎦ =

⎡

⎢
⎣

φn−1,1
...

φn−1,n−1

⎤

⎥
⎦ − φnn

⎡

⎢
⎣

φn−1,n−1
...

φn−1,1

⎤

⎥
⎦ (2.5.21)

and

vn = vn−1
[
1 − φ2

nn

]
, (2.5.22)

where φ11 = γ (1)/γ (0) and v0 = γ (0).

Proofs 1 The definition of φ11 ensures that the equation

Rnφn = ρn (2.5.23)

(where ρn = (ρ(1), . . . , ρ(n))′) is satisfied for n = 1. The first step in the proof is to
show that φn, defined recursively by (2.5.20) and (2.5.21), satisfies (2.5.23) for all n.
Suppose this is true for n = k. Then, partitioning Rk+1 and defining

ρ
(r)
k := (ρ(k), ρ(k − 1), . . . , ρ(1))′

and

φ
(r)
k := (φkk, φk,k−1, . . . , φk1)

′,

we see that the recursions imply

Rk+1φk+1 =
[
Rk ρ

(r)
k

ρ
(r)
k

′ 1

][
φk − φk+1,k+1φ

(r)
k

φk+1,k+1

]

=
[

ρk − φk+1,k+1ρ
(r)
k + φk+1,k+1ρ

(r)
k

ρ
(r)
k

′φk − φk+1,k+1ρ
(r)
k

′φ(r)k + φk+1,k+1

]

= ρk+1,

as required. Here we have used the fact that if Rkφk = ρk, then Rkφ
(r)
k = ρ

(r)
k . This is

easily checked by writing out the component equations in reverse order. Since (2.5.23)
is satisfied for n = 1, it follows by induction that the coefficient vectors φn defined
recursively by (2.5.20) and (2.5.21) satisfy (2.5.23) for all n.

It remains only to establish that the mean squared errors

vn := E(Xn+1 − φ′
nXn)

2

satisfy v0 = γ (0) and (2.5.22). The fact that v0 = γ (0) is an immediate consequence
of the definition P0X1 := E(X1) = 0. Since we have shown that φ′

nXn is the best linear
predictor of Xn+1, we can write, from (2.5.9) and (2.5.21),

vn = γ (0)− φ′
nγn = γ (0)− φ′

n−1γn−1 + φnnφ(r)′n−1γn−1 − φnnγ (n).
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Applying (2.5.9) again gives

vn = vn−1 + φnn
(
φ
(r)′
n−1γn−1 − γ (n)

)
,

and hence, by (2.5.20),

vn = vn−1 − φ2
nn(γ (0)− φ′

n−1γn−1) = vn−1
(
1 − φ2

nn

)
. �

Remark 4. Under the conditions of the proposition, the function defined by α(0) =
1 and α(n) = φnn, n = 1, 2, . . ., is known as the partial autocorrelation function
(PACF) of {Xt}, discussed further in Section 3.2. Equation (2.5.22) shows the relation
between α(n) and the reduction in the one-step mean squared error as the number of
predictors is increased from n − 1 to n. �

2.5.4 The Innovations Algorithm

The recursive algorithm to be discussed in this section is applicable to all series with
finite second moments, regardless of whether they are stationary or not. Its application,
however, can be simplified in certain special cases.

Suppose then that {Xt} is a zero-mean series with E|Xt|2 < ∞ for each t and

E(Xi Xj) = κ(i, j). (2.5.24)

We denote the best one-step linear predictors and their mean squared errors by

X̂n =
⎧
⎨

⎩

0, if n = 1,

Pn−1Xn, if n = 2, 3, . . . ,
and

vn = E(Xn+1 − PnXn+1)
2.

We shall also introduce the innovations, or one-step prediction errors,

Un = Xn − X̂n.

In terms of the vectors Un = (U1, . . . ,Un)
′ and Xn = (X1, . . . ,Xn)

′ the last equations
can be written as

Un = AnXn, (2.5.25)

where An has the form

An =

⎡

⎢
⎢
⎢
⎢
⎢
⎣

1 0 0 · · · 0
a11 1 0 · · · 0
a22 a21 1 · · · 0
...

...
...

. . . 0
an−1,n−1 an−1,n−2 an−1,n−3 · · · 1

⎤

⎥
⎥
⎥
⎥
⎥
⎦

.

(If {Xt} is stationary, then aij = −aj with aj as in (2.5.7) with h = 1.) This implies that
An is nonsingular, with inverse Cn of the form

Cn =

⎡

⎢
⎢
⎢
⎢
⎢
⎣

1 0 0 · · · 0
θ11 1 0 · · · 0
θ22 θ21 1 · · · 0
...

...
...

. . . 0
θn−1,n−1 θn−1,n−2 θn−1,n−3 · · · 1

⎤

⎥
⎥
⎥
⎥
⎥
⎦

.
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The vector of one-step predictors X̂n := (X1,P1X2, . . . , Pn−1Xn)
′ can therefore be

expressed as

X̂n = Xn − Un = CnUn − Un = �n

(
Xn − X̂n

)
, (2.5.26)

where

�n =

⎡

⎢
⎢
⎢
⎢
⎢
⎣

0 0 0 · · · 0
θ11 0 0 · · · 0
θ22 θ21 0 · · · 0
...

...
...

. . . 0
θn−1,n−1 θn−1,n−2 θn−1,n−3 · · · 0

⎤

⎥
⎥
⎥
⎥
⎥
⎦

and Xn itself satisfies

Xn = Cn

(
Xn − X̂n

)
. (2.5.27)

Equation (2.5.26) can be rewritten as

X̂n+1 =

⎧
⎪⎨

⎪⎩

0, if n = 0,
n∑

j=1
θnj

(
Xn+1−j − X̂n+1−j

)
, if n = 1, 2, . . . ,

(2.5.28)

from which the one-step predictors X̂1, X̂2, . . . can be computed recursively once
the coefficients θij have been determined. The following algorithm generates these

coefficients and the mean squared errors vi = E
(
Xi+1 − X̂i+1

)2
, starting from the

covariances κ(i, j).

The Innovations Algorithm:
The coefficients θn1, . . . , θnn can be computed recursively from the equations

v0 = κ(1, 1),

θn,n−k = v−1
k

⎛

⎝κ(n + 1, k + 1)−
k−1∑

j=0

θk,k−jθn,n−jvj

⎞

⎠ , 0 ≤ k < n,

and

vn = κ(n + 1, n + 1)−
n−1∑

j=0

θ2
n,n−jvj.

(It is a trivial matter to solve first for v0, then successively for θ11, v1; θ22,
θ21, v2; θ33, θ32, θ31, v3; . . . .)

Proof See Brockwell and Davis (1991), Proposition 5.2.2. �

Remark 5. While the Durbin–Levinson recursion gives the coefficients of Xn, . . . ,X1

in the representation X̂n+1 = ∑n
j=1 φnjXn+1−j, the innovations algorithm gives the

coefficients of
(
Xn − X̂n

)
, . . . ,

(
X1 − X̂1

)
, in the alternative expansion X̂n+1 =

∑n
j=1 θnj

(
Xn+1−j − X̂n+1−j

)
. The latter expansion has a number of advantages deriving

from the fact that the innovations are uncorrelated (see Problem 2.20). It can also be
greatly simplified in the case of ARMA(p, q) series, as we shall see in Section 3.3.
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An immediate consequence of (2.5.28) is the innovations representation of Xn+1 itself.
Thus (defining θn0 := 1),

Xn+1 = Xn+1 − X̂n+1 + X̂n+1 =
n∑

j=0

θnj

(
Xn+1−j − X̂n+1−j

)
, n = 0, 1, 2, . . . .

�

Example 2.5.5 Recursive Prediction of an MA(1)

If {Xt} is the time series defined by

Xt = Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2

)
,

then κ(i, j) = 0 for |i−j| > 1, κ(i, i) = σ 2
(
1+θ2

)
, and κ(i, i+1) = θσ 2. Application

of the innovations algorithm leads at once to the recursions

θnj = 0, 2 ≤ j ≤ n,

θn1 = v−1
n−1θσ

2,

v0 = (1 + θ2)σ 2,

and

vn = [
1 + θ2 − v−1

n−1θ
2σ 2] σ 2.

For the particular case

Xt = Zt − 0.9Zt−1, {Zt} ∼ WN(0, 1),

the mean squared errors vn of X̂n+1 and coefficients θnj, 1 ≤ j ≤ n, in the innovations
representation

X̂n+1 =
n∑

j=1

θnj

(
Xn+1−j − X̂n+1−j

)
= θn1

(
Xn − X̂n

)

are found from the recursions to be as follows:

v0 = 1.8100,
θ11 = −0.4972, v1 = 1.3625,
θ21 = −0.6606, θ22 = 0, v2 = 1.2155,
θ31 = −0.7404, θ32 = 0, θ33 = 0, v3 = 1.1436,
θ41 = −0.7870, θ42 = 0, θ43 = 0, θ44 = 0, v4 = 1.1017.

If we apply the Durbin–Levinson algorithm to the same problem, we find that the
mean squared errors vn of X̂n+1 and coefficients φnj, 1 ≤ j ≤ n, in the representation

X̂n+1 =
n∑

j=1

φnjXn+1−j

are as follows:

v0 = 1.8100,
φ11 = −0.4972, v1 = 1.3625,
φ21 = −0.6606, φ22 = −0.3285, v2 = 1.2155,
φ31 = −0.7404, φ32 = −0.4892, φ33 = −0.2433, v3 = 1.1436,
φ41 = −0.7870, φ42 = −0.5828, φ43 = −0.3850, φ44 = −0.1914, v4 = 1.1017.
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Notice that as n increases, vn approaches the white noise variance and θn1 approaches θ .
These results hold for any MA(1) process with |θ | < 1. The innovations algorithm
is particularly well suited to forecasting MA(q) processes, since for them θnj = 0
for n − j > q. For AR(p) processes the Durbin–Levinson algorithm is usually more
convenient, since φnj = 0 for n − j > p.

�

2.5.5 Recursive Calculation of the h-Step Predictors

For h-step prediction we use the result

Pn(Xn+k − Pn+k−1Xn+k) = 0, k ≥ 1. (2.5.29)

This follows from (2.5.10) and the fact that

E[(Xn+k − Pn+k−1Xn+k − 0)Xn+j−1] = 0, j = 1, . . . , n.

Hence,

PnXn+h = PnPn+h−1Xn+h

= PnX̂n+h

= Pn

( n+h−1∑

j=1

θn+h−1, j

(
Xn+h−j − X̂n+h−j

))

.

Applying (2.5.29) again and using the linearity of Pn we find that

PnXn+h =
n+h−1∑

j=h

θn+h−1,j

(
Xn+h−j − X̂n+h−j

)
, (2.5.30)

where the coefficients θnj are determined as before by the innovations algorithm.
Moreover, the mean squared error can be expressed as

E(Xn+h − PnXn+h)
2 = EX2

n+h − E(PnXn+h)
2

= κ(n + h, n + h)−
n+h−1∑

j=h

θ2
n+h−1, jvn+h−j−1. (2.5.31)

2.5.6 Prediction of a Stationary Process in Terms of Infinitely
Many Past Values

It is often useful, when many past observations Xm, . . . , X0,X1, . . . , Xn (m < 0)
are available, to evaluate the best linear predictor of Xn+h in terms of 1,Xm, . . . , X0,

. . . , Xn. This predictor, which we shall denote by Pm,nXn+h, can easily be evaluated
by the methods described above. If |m| is large, this predictor can be approximated by
the sometimes more easily calculated mean square limit

P̃nXn+h = lim
m→−∞Pm,nXn+h.

We shall refer to P̃n as the prediction operator based on the infinite past, {Xt,

−∞ < t ≤ n}. Analogously we shall refer to Pn as the prediction operator based
on the finite past, {X1, . . . ,Xn}. (Mean square convergence of random variables is
discussed in Appendix C.)
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2.5.7 Determination of P̃nXn+h

If {Xn} is a zero-mean stationary process with autocovariance function γ (·) then, just as
PnXn+h is characterized by equation (2.5.10), P̃nXn+h is characterized by the equations

E
[(

Xn+h − P̃nXn+h

)
Xn+1−i

]
= 0, i = 1, 2, . . . .

If we can find a solution to these equations, it will necessarily be the uniquely defined
predictor P̃nXn+h. An approach to this problem that is often effective is to assume that
P̃nXn+h can be expressed in the form

P̃nXn+h =
∞∑

j=1

αjXn+1−j,

in which case the preceding equations reduce to

E

⎡

⎣

⎛

⎝Xn+h −
∞∑

j=1

αjXn+1−j

⎞

⎠Xn+1−i

⎤

⎦ = 0, i = 1, 2, . . . ,

or equivalently,
∞∑

j=1

γ (i− j)αj = γ (h + i − 1), i = 1, 2, . . . .

This is an infinite set of linear equations for the unknown coefficients αi that determine
P̃nXn+h, provided that the resulting series converges.

Properties of P̃n:
Suppose that EU2 < ∞, EV2 < ∞, a, b, and c are constants, and � =
Cov(W,W).

1. E[(U − P̃n(U))Xj] = 0, j ≤ n.
2. P̃n(aU + bV + c) = aP̃n(U)+ bP̃n(V)+ c.
3. P̃n(U) = U if U is a limit of linear combinations of Xj, j ≤ n.
4. P̃n(U) = EU if Cov(U, Xj) = 0 for all j ≤ n.

These properties can sometimes be used to simplify the calculation of
P̃nXn+h, notably when the process {Xt} is an ARMA process.

Example 2.5.6 Consider the causal invertible ARMA(1,1) process {Xt} defined by

Xt − φXt−1 = Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2).

We know from (2.3.3) and (2.3.5) that we have the representations

Xn+1 = Zn+1 + (φ + θ)
∞∑

j=1

φ j−1Zn+1−j

and

Zn+1 = Xn+1 − (φ + θ)
∞∑

j=1

(−θ) j−1Xn+1−j.
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Applying the operator P̃n to the second equation and using the properties of P̃n gives

P̃nXn+1 = (φ + θ)
∞∑

j=1

(−θ) j−1Xn+1−j.

Applying the operator P̃n to the first equation and using the properties of P̃n gives

P̃nXn+1 = (φ + θ)
∞∑

j=1

φ j−1Zn+1−j.

Hence,

Xn+1 − P̃nXn+1 = Zn+1,

and so the mean squared error of the predictor P̃nXn+1 is EZ2
n+1 = σ 2.

�

2.6 The Wold Decomposition
Consider the stationary process

Xt = A cos(ωt)+ B sin(ωt),

where ω ∈ (0, π) is constant and A,B are uncorrelated random variables with mean 0
and variance σ 2. Notice that

Xn = (2 cosω)Xn−1 − Xn−2 = P̃n−1Xn, n = 0,±1, . . . ,

so that Xn − P̃n−1Xn = 0 for all n. Processes with the latter property are said to be
deterministic.

The Wold Decomposition:
If {Xt} is a nondeterministic stationary time series, then

Xt =
∞∑

j=0

ψjZt−j + Vt, (2.6.1)

where

1. ψ0 = 1 and
∑∞

j=0 ψ
2
j < ∞,

2. {Zt} ∼ WN
(
0, σ 2

)
,

3. Cov(Zs,Vt) = 0 for all s and t,
4. Zt = P̃tZt for all t,
5. Vt = P̃sVt for all s and t, and
6. {Vt} is deterministic.

Here as in Section 2.5, P̃tY denotes the best predictor of Y in terms of linear com-
binations, or limits of linear combinations of 1,Xs,−∞ < s ≤ t. The sequences
{Zt}, {ψj}, and {Vt} are unique and can be written explicitly as Zt = Xt − P̃t−1Xt,
ψj = E(XtZt−j)/E

(
Z2
t

)
, and Vt = Xt −∑∞

j=0ψjZt−j. (See Brockwell and Davis (1991),
p. 188.) For most of the zero-mean stationary time series dealt with in this book
(in particular for all ARMA processes) the deterministic component Vt is 0 for all
t, and the series is then said to be purely nondeterministic.
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Example 2.6.1 If Xt = Ut + Y , where {Ut} ∼ WN
(
0, ν2

)
, E(UtY) = 0 for all t, and Y has mean

0 and variance τ 2, then P̃t−1Xt = Y , since Y is the mean square limit as s → ∞ of
[Xt−1 + · · · + Xt−s]/s, and E[(Xt − Y)Xs] = 0 for all s ≤ t − 1. Hence the sequences
in the Wold decomposition of {Xt} are given by Zt = Ut, ψ0 = 1, ψj = 0 for j > 0,
and Vt = Y .

�

Problems

2.1 Suppose that X1,X2, . . ., is a stationary time series with mean μ and ACF ρ(·).
Show that the best predictor of Xn+h of the form aXn +b is obtained by choosing
a = ρ(h) and b = μ(1 − ρ(h)).

2.2 Show that the process

Xt = A cos(ωt)+ B sin(ωt), t = 0,±1, . . .

(where A and B are uncorrelated random variables with mean 0 and variance 1
and ω is a fixed frequency in the interval [0, π ]), is stationary and find its mean
and autocovariance function. Deduce that the function κ(h) = cos(ωh), h =
0,±1, . . ., is nonnegative definite.

2.3 a. Find the ACVF of the time series Xt = Zt + 0.3Zt−1 − 0.4Zt−2, where {Zt} ∼
WN(0, 1).

b. Find the ACVF of the time series Yt = Z̃t − 1.2Z̃t−1 − 1.6Z̃t−2, where {Z̃t} ∼
WN(0, 0.25). Compare with the answer found in (a).

2.4 It is clear that the function κ(h) = 1, h = 0,±1, . . . , is an autocovariance func-
tion, since it is the autocovariance function of the process Xt = Z, t = 0,±1, . . .,
where Z is a random variable with mean 0 and variance 1. By identifying
appropriate sequences of random variables, show that the following functions
are also autocovariance functions:

a. κ(h) = (−1)|h|

b. κ(h) = 1 + cos

(
πh

2

)

+ cos

(
πh

4

)

c. κ(h) =

⎧
⎪⎪⎨

⎪⎪⎩

1, if h = 0,

0.4, if h = ±1,

0, otherwise.

2.5 Suppose that {Xt, t = 0,±1, . . .} is stationary and that |θ | < 1. Show that for
each fixed n the sequence

Sm =
m∑

j=1

θ jXn−j

is convergent absolutely and in mean square (see Appendix C) as m → ∞.

2.6 Verify the equations (2.2.6).
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2.7 Show, using the geometric series 1/(1 − x) = ∑∞
j=0 x

j for |x| < 1, that 1/(1−
φz) = −∑∞

j=1 φ
−jz−j for |φ| > 1 and |z| ≥ 1.

2.8 Show that the autoregressive equations

Xt = φ1Xt−1 + Zt, t = 0,±1, . . . ,

where {Zt} ∼ WN
(
0, σ 2

)
and |φ| = 1, have no stationary solution. HINT:

Suppose there does exist a stationary solution {Xt} and use the autoregressive
equation to derive an expression for the variance of Xt − φn+1

1 Xt−n−1 that con-
tradicts the stationarity assumption.

2.9 Let {Yt} be the AR(1) plus noise time series defined by

Yt = Xt + Wt,

where {Wt} ∼ WN
(
0, σ 2

w

)
, {Xt} is the AR(1) process of Example 2.2.1, i.e.,

Xt − φXt−1 = Zt, {Zt} ∼ WN
(
0, σ 2

z

)
,

and E(WsZt) = 0 for all s and t.
a. Show that {Yt} is stationary and find its autocovariance function.
b. Show that the time series Ut := Yt − φYt−1 is 1-correlated and hence, by

Proposition 2.1.1, is an MA(1) process.
c. Conclude from (b) that {Yt} is an ARMA(1,1) process and express the

three parameters of this model in terms of φ, σ 2
w, and σ

2
z .

2.10 Use the program ITSM to compute the coefficients ψj and πj, j = 1, . . . , 5, in
the expansions

Xt =
∞∑

j=0

ψjZt−j

and

Zt =
∞∑

j=0

πjXt−j

for the ARMA(1,1) process defined by the equations

Xt − 0.5Xt−1 = Zt + 0.5Zt−1, {Zt} ∼ WN
(
0, σ 2) .

(Select File>Project>New>Univariate, then Model>Specify.
In the resulting dialog box enter 1 for the AR and MA orders, specify
φ(1) = θ(1) = 0.5, and click OK. Finally, select Model>AR/MA
Infinity>Default lag and the values of ψj and πj will appear on the
screen.) Check the results with those obtained in Section 2.3.

2.11 Suppose that in a sample of size 100 from anAR(1) process with meanμ, φ = .6,
and σ 2 = 2 we obtain x̄100 = 0.271. Construct an approximate 95% confidence
interval for μ. Are the data compatible with the hypothesis that μ = 0?

2.12 Suppose that in a sample of size 100 from an MA(1) process with mean μ,
θ = −0.6, and σ 2 = 1 we obtain x̄100 = 0.157. Construct an approximate
95% confidence interval for μ. Are the data compatible with the hypothesis that
μ = 0?

2.13 Suppose that in a sample of size 100, we obtain ρ̂(1) = 0.438 and ρ̂(2) = 0.145.
a. Assuming that the data were generated from an AR(1) model, construct

approximate 95% confidence intervals for both ρ(1) and ρ(2). Based on these
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two confidence intervals, are the data consistent with an AR(1) model with
φ = 0.8?

b. Assuming that the data were generated from an MA(1) model, construct
approximate 95% confidence intervals for both ρ(1) and ρ(2). Based on these
two confidence intervals, are the data consistent with an MA(1) model with
θ = 0.6?

2.14 Let {Xt} be the process defined in Problem 2.2.
a. Find P1X2 and its mean squared error.
b. Find P2X3 and its mean squared error.
c. Find P̃nXn+1 and its mean squared error.

2.15 Suppose that {Xt, t = 0,±1, . . .} is a stationary process satisfying the equations

Xt = φ1Xt−1 + · · · + φpXt−p + Zt,

where {Zt} ∼ WN
(
0, σ 2

)
and Zt is uncorrelated with Xs for each s < t. Show

that the best linear predictor PnXn+1 of Xn+1 in terms of 1,X1, . . . ,Xn, assuming
n > p, is

PnXn+1 = φ1Xn + · · · + φpXn+1−p.

What is the mean squared error of PnXn+1?
2.16 Use the program ITSM to plot the sample ACF and PACF up to lag 40 of the

sunspot series Dt, t = 1, 100, contained in the ITSM file SUNSPOTS.TSM.
(Open the project SUNSPOTS.TSMand click on the second yellow button at the
top of the screen to see the graphs. Repeated clicking on this button will toggle
between graphs of the sample ACF, sample PACF, and both. To see the numerical
values, right-click on the graph and select Info.) Fit an AR(2) model to the
mean-corrected data by selecting Model>Estimation>Preliminary and
click Yes to subtract the sample mean from the data. In the dialog box that
follows, enter 2 for the AR order and make sure that theMA order is zero and that
the Yule-Walker algorithm is selected without AICCminimization. Click OK
and you will obtain a model of the form

Xt = φ1Xt−1 + φ2Xt−2 + Zt, where {Zt} ∼ WN
(
0, σ 2) ,

for the mean-corrected series Xt = Dt−46.93. Record the values of the estimated
parameters φ1, φ2, and σ 2. Compare the model and sample ACF and PACF by
selecting the third yellow button at the top of the screen. Print the graphs by
right-clicking and selecting Print.

2.17 Without exiting from ITSM, use the model found in the preceding problem to
compute forecasts of the next ten values of the sunspot series. (Select Fore-
casting>ARMA,make sure that the number of forecasts is set to 10 and the box
Add the mean to the forecasts is checked, and then click OK. You
will see a graph of the original data with the ten forecasts appended. Right-click
on the graph and then on Info to get the numerical values of the forecasts. Print
the graph as described in Problem 2.16.) The details of the calculations will be
taken up in Chapter 3 when we discuss ARMA models in detail.

2.18 Let {Xt} be the stationary process defined by the equations

Xt = Zt − θZt−1, t = 0,±1, . . . ,

where |θ | < 1 and {Zt} ∼ WN
(
0, σ 2

)
. Show that the best linear predictor P̃nXn+1

of Xn+1 based on {Xj,−∞ < j ≤ n} is
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P̃nXn+1 = −
∞∑

j=1

θ jXn+1−j.

What is the mean squared error of the predictor P̃nXn+1?
2.19 If {Xt} is defined as in Problem 2.18 and θ = 1, find the best linear predictor

PnXn+1 of Xn+1 in terms of X1, . . . , Xn. What is the corresponding mean squared
error?

2.20 In the innovations algorithm, show that for each n ≥ 2, the innovation Xn − X̂n

is uncorrelated with X1, . . . , Xn−1. Conclude that Xn − X̂n is uncorrelated with
the innovations X1 − X̂1, . . . , Xn−1 − X̂n−1.

2.21 Let X1, X2, X4, X5 be observations from the MA(1) model

Xt = Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2) .

a. Find the best linear estimate of the missing value X3 in terms of X1 and X2.
b. Find the best linear estimate of the missing value X3 in terms of X4 and X5.
c. Find the best linear estimate of the missing value X3 in terms of X1,X2,X4,

and X5.
d. Compute the mean squared errors for each of the estimates in (a)–(c).

2.22 Repeat parts (a)–(d) of Problem 2.21 assuming now that the observations X1, X2,
X4, X5 are from the causal AR(1) model

Xt = φXt−1 + Zt, {Zt} ∼ WN
(
0, σ 2) .



3 ARMA Models

3.1 ARMA( p, q) Processes
3.2 The ACF and PACF of an ARMA( p, q) Process
3.3 Forecasting ARMA Processes

In this chapter we introduce an important parametric family of stationary time
series, the autoregressive moving-average, or ARMA, processes. For a large class of
autocovariance functions γ (·) it is possible to find an ARMA process {Xt} with ACVF
γX(·) such that γ (·) is well approximated by γX(·). In particular, for any positive integer
K, there exists an ARMA process {Xt} such that γX(h) = γ (h) for h = 0, 1, . . . ,K.
For this (and other) reasons, the family of ARMA processes plays a key role in the
modeling of time series data. The linear structure of ARMA processes also leads to a
substantial simplification of the general methods for linear prediction discussed earlier
in Section 2.5.

3.1 ARMA( p, q) Processes

In Section 2.3 we introduced an ARMA(1,1) process and discussed some of its key
properties. These included existence and uniqueness of stationary solutions of the
defining equations and the concepts of causality and invertibility. In this section we
extend these notions to the general ARMA( p, q) process.
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Definition 3.1.1 {Xt} is an ARMA(p, q) process if {Xt} is stationary and if for every t,
Xt − φ1Xt−1 − · · · − φpXt−p = Zt + θ1Zt−1 + · · · + θqZt−q, (3.1.1)

where {Zt} ∼ WN
(
0, σ 2

)
and the polynomials

(
1 − φ1z − . . . − φpzp

)
and

(
1+

θ1z + . . .+ θqzq
)
have no common factors.

The process {Xt} is said to be an ARMA(p, q) process with mean μ if {Xt − μ}
is an ARMA(p, q) process.

It is convenient to use the more concise form of (3.1.1)

φ(B)Xt = θ(B)Zt, (3.1.2)

where φ(·) and θ(·) are the pth and qth-degree polynomials

φ(z) = 1 − φ1z − · · · − φpz p
and

θ(z) = 1 + θ1z + · · · + θqz q,
and B is the backward shift operator (B jXt = Xt−j, B jZt = Zt−j, j = 0,±1, . . .).
The time series {Xt} is said to be an autoregressive process of order p (or AR( p)) if
θ(z) ≡ 1, and amoving-average process of order q (or MA(q)) if φ(z) ≡ 1.

An important part of Definition 3.1.1 is the requirement that {Xt} be stationary.
In Section 2.3 we showed, for the ARMA(1,1) equations (2.3.1), that a stationary
solution exists (and is unique) if and only if φ1 �= ±1. The latter is equivalent to
the condition that the autoregressive polynomial φ(z) = 1 − φ1z �= 0 for z = ±1. The
analogous condition for the general ARMA( p, q) process is φ(z) = 1 − φ1z − · · · −
φpz p �= 0 for all complex z with |z| = 1. (Complex z is used here, since the zeros of a
polynomial of degree p > 1 may be either real or complex. The region defined by the
set of complex z such that |z| = 1 is referred to as the unit circle.) If φ(z) �= 0 for all z
on the unit circle, then there exists δ > 0 such that

1

φ(z)
=

∞∑

j=−∞
χjz

j for 1 − δ < |z| < 1 + δ,

and
∑∞

j=−∞ |χj| < ∞. We can then define 1/φ(B) as the linear filter with absolutely
summable coefficients

1

φ(B)
=

∞∑

j=−∞
χjB

j.

Applying the operator χ(B) := 1/φ(B) to both sides of (3.1.2), we obtain

Xt = χ(B)φ(B)Xt = χ(B)θ(B)Zt = ψ(B)Zt =
∞∑

j=−∞
ψjZt−j, (3.1.3)

where ψ(z) = χ(z)θ(z) = ∑∞
j=−∞ ψjz j. Using the argument given in Section 2.3 for

the ARMA(1,1) process, it follows that ψ(B)Zt is the unique stationary solution of
(3.1.1).
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Existence and Uniqueness:

A stationary solution {Xt} of equation (3.1.1) exists (and is also the unique sta-
tionary solution) if and only if

φ(z) = 1 − φ1z − · · · − φpz p �= 0 for all |z| = 1. (3.1.4)

In Section 2.3 we saw that the ARMA(1,1) process is causal, i.e., that Xt can be
expressed in terms of Zs, s ≤ t, if and only if |φ1| < 1. For a general ARMA( p, q)
process the analogous condition is that φ(z) �= 0 for |z| ≤ 1, i.e., the zeros of the
autoregressive polynomial must all be greater than 1 in absolute value.

Causality:

An ARMA( p, q) process {Xt} is causal, or a causal function of {Zt}, if there
exist constants {ψj} such that

∑∞
j=0 |ψj| < ∞ and

Xt =
∞∑

j=0

ψjZt−j for all t. (3.1.5)

Causality is equivalent to the condition

φ(z) = 1 − φ1z − · · · − φpz p �= 0 for all |z| ≤ 1. (3.1.6)

The proof of the equivalence between causality and (3.1.6) follows from elemen-
tary properties of power series. From (3.1.3) we see that {Xt} is causal if and only if
χ(z) := 1/φ(z) = ∑∞

j=0 χjz
j (assuming that φ(z) and θ(z) have no common factors).

But this, in turn, is equivalent to (3.1.6).
The sequence {ψj} in (3.1.5) is determined by the relation ψ(z) = ∑∞

j=0 ψjz j =
θ(z)/φ(z), or equivalently by the identity

(
1 − φ1z − · · · − φpz p

)
(ψ0 + ψ1z + · · · ) = 1 + θ1z + · · · + θqz q.

Equating coefficients of z j, j = 0, 1, . . ., we find that

1 = ψ0,

θ1 = ψ1 − ψ0φ1,

θ2 = ψ2 − ψ1φ1 − ψ0φ2,

...

or equivalently,

ψj −
p∑

k=1

φkψj−k = θj, j = 0, 1, . . . , (3.1.7)

where θ0 := 1, θj := 0 for j > q, and ψj := 0 for j < 0.
Invertibility, which allows Zt to be expressed in terms of Xs, s ≤ t, has a similar

characterization in terms of the moving-average polynomial.
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Invertibility:

An ARMA( p, q) process {Xt} is invertible if there exist constants {πj} such that∑∞
j=0 |πj| < ∞ and

Zt =
∞∑

j=0

πj Xt−j for all t.

Invertibility is equivalent to the condition

θ(z) = 1 + θ1z + · · · + θqz q �= 0 for all |z| ≤ 1.

Interchanging the roles of the AR and MA polynomials, we find from (3.1.7) that
the sequence {πj} is determined by the equations

πj +
q∑

k=1

θkπj−k = −φj, j = 0, 1, . . . , (3.1.8)

where φ0 := −1, φj := 0 for j > p, and πj := 0 for j < 0.

Example 3.1.1 An ARMA(1,1) Process Consider the ARMA(1,1) process {Xt} satisfying the equa-
tions

Xt − 0.5Xt−1 = Zt + 0.4Zt−1, {Zt} ∼ WN
(
0, σ 2

)
. (3.1.9)

Since the autoregressive polynomial φ(z) = 1 − 0.5z has a zero at z = 2, which is
located outside the unit circle, we conclude from (3.1.4) and (3.1.6) that there exists
a unique ARMA process satisfying (3.1.9) that is also causal. The coefficients {ψj} in
the MA(∞) representation of {Xt} are found directly from (3.1.7):

ψ0 = 1,

ψ1 = 0.4 + 0.5,

ψ2 = 0.5(0.4 + 0.5),

ψj = 0.5 j−1(0.4 + 0.5), j = 1, 2, . . . .

The MA polynomial θ(z) = 1 + 0.4z has a zero at z = −1/0.4 = −2.5, which is also
located outside the unit circle. This implies that {Xt} is invertible with coefficients {πj}
given by [see (3.1.8)]

π0 = 1,

π1 = −(0.4 + 0.5),

π2 = −(0.4 + 0.5)(−0.4),

πj = −(0.4 + 0.5)(−0.4) j−1, j = 1, 2, . . . .

(A direct derivation of these formulas for {ψj} and {πj}was given in Section 2.3 without
appealing to the recursions (3.1.7) and (3.1.8).)

�

Example 3.1.2 An AR(2) Process

Let {Xt} be the AR(2) process
Xt = 0.7Xt−1 − 0.1Xt−2 + Zt, {Zt} ∼ WN

(
0, σ 2

)
.
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The autoregressive polynomial for this process has the factorization φ(z) = 1−0.7z+
0.1z2 = (1 − 0.5z)(1 − 0.2z), and is therefore zero at z = 2 and z = 5. Since these
zeros lie outside the unit circle, we conclude that {Xt} is a causal AR(2) process with
coefficients {ψj} given by

ψ0 = 1,

ψ1 = 0.7,

ψ2 = 0.72 − 0.1,

ψj = 0.7ψj−1 − 0.1ψj−2, j = 2, 3, . . . .

While it is a simple matter to calculate ψj numerically for any j, it is possible also
to give an explicit solution of these difference equations using the theory of linear
difference equations (see Brockwell and Davis (1991), Section 3.6).

�
The option Model>Specifyof the program ITSMallows the entry of any causal

ARMA( p, q) model with p < 28 and q < 28. This option contains a causality check
and will immediately let you know if the entered model is noncausal. (A causal model
can be obtained by setting all the AR coefficients equal to 0.001.) Once a causal model
has been entered, the coefficients ψj in theMA(∞) representation of the process can be
computed by selecting Model>AR/MA Infinity. This option will also compute
the AR(∞) coefficients πj, provided that the model is invertible.

Example 3.1.3 An ARMA(2,1) Process

Consider the ARMA(2,1) process defined by the equations

Xt − 0.75Xt−1 + 0.5625Xt−2 = Zt + 1.25Zt−1, {Zt} ∼ WN
(
0, σ 2).

The AR polynomial φ(z) = 1 − 0.75z + 0.5625z2 has zeros at z = 2
(
1 ± i

√
3
)
/3,

which lie outside the unit circle. The process is therefore causal. On the other hand,
the MA polynomial θ(z) = 1 + 1.25z has a zero at z = −0.8, and hence {Xt} is not
invertible.

�

Remark 1. It should be noted that causality and invertibility are properties not of {Xt}
alone, but rather of the relationship between the two processes {Xt} and {Zt} appearing
in the defining ARMA equations (3.1.1). �

Remark 2. If {Xt} is an ARMA process defined by φ(B)Xt = θ(B)Zt, where θ(z) �= 0
if |z| = 1, then it is always possible (see Brockwell and Davis (1991), p. 127) to find
polynomials φ̃(z) and θ̃ (z) and awhite noise sequence {Wt} such that φ̃(B)Xt = θ̃ (B)Wt

and θ̃ (z) and φ̃(z) are nonzero for |z| ≤ 1. However, if the original white noise sequence
{Zt} is iid, then the new white noise sequence will not be iid unless {Zt} is Gaussian.

�
In view of Remark 2, we will focus our attention principally on causal and

invertible ARMA processes.

3.2 The ACF and PACF of an ARMA(p, q) Process

In this section we discuss three methods for computing the autocovariance function
γ (·) of a causal ARMA process {Xt}. The autocorrelation function is readily found
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from the ACVF on dividing by γ(0). The partial autocorrelation function (PACF) is
also found from the function γ(·).

3.2.1 Calculation of the ACVF

First we determine the ACVF γ (·) of the causal ARMA(p, q) process defined by

φ(B)Xt = θ(B)Zt, {Zt} ∼ WN
(
0, σ 2), (3.2.1)

where φ(z) = 1 − φ1z − · · · − φpz p and θ(z) = 1 + θ1z + · · · + θqz q. The causality
assumption implies that

Xt =
∞∑

j=0

ψjZt−j, (3.2.2)

where
∑∞

j=0ψjz j = θ(z)/φ(z), |z| ≤ 1. The calculation of the sequence {ψj} was
discussed in Section 3.1.

First Method. From Proposition 2.2.1 and the representation (3.2.2), we obtain

γ (h) = E(Xt+hXt) = σ 2
∞∑

j=0

ψjψj+|h|. (3.2.3)

Example 3.2.1 The ARMA(1,1) Process

Substituting from (2.3.3) into (3.2.3), we find that the ACVF of the process defined by

Xt − φXt−1 = Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2) , (3.2.4)

with |φ| < 1 is given by

γ (0) = σ 2
∞∑

j=0

ψ2
j

= σ 2

⎡

⎣1 + (θ + φ)2
∞∑

j=0

φ2j

⎤

⎦

= σ 2

[

1 + (θ + φ)2
1 − φ2

]

,

γ (1) = σ 2
∞∑

j=0

ψj+1ψj

= σ 2

⎡

⎣θ + φ + (θ + φ)2φ
∞∑

j=0

φ2j

⎤

⎦

= σ 2

[

θ + φ + (θ + φ)2φ
1 − φ2

]

,

and

γ (h) = φh−1γ (1), h ≥ 2.

�
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Example 3.2.2 The MA(q) Process

For the process

Xt = Zt + θ1Zt−1 + · · · + θqZt−q, {Zt} ∼ WN
(
0, σ 2) ,

Equation (3.2.3) immediately gives the result

γ (h) =

⎧
⎪⎪⎨

⎪⎪⎩

σ 2
q−|h|∑

j=0
θjθj+|h|, if |h| ≤ q,

0, if |h| > q,

where θ0 is defined to be 1. The ACVF of the MA(q) process thus has the distinctive
feature of vanishing at lags greater than q. Data for which the sample ACVF is
small for lags greater than q therefore suggest that an appropriate model might be a
moving average of order q (or less). Recall from Proposition 2.1.1 that every zero-mean
stationary process with correlations vanishing at lags greater than q can be represented
as a moving-average process of order q or less.

�
Second Method. If we multiply each side of the equations

Xt − φ1Xt−1 − · · · − φp Xt−p = Zt + θ1Zt−1 + · · · + θqZt−q,

by Xt−k, k = 0, 1, 2, . . . , and take expectations on each side, we find that

γ (k)−φ1γ (k−1)−· · ·−φpγ (k−p) = σ 2
∞∑

j=0

θk+jψj, 0 ≤ k < m, (3.2.5)

and

γ (k)− φ1γ (k − 1)− · · · − φpγ (k − p) = 0, k ≥ m, (3.2.6)

where m = max(p, q + 1), ψj := 0 for j < 0, θ0 := 1, and θj := 0 for j /∈ {0, . . . , q}.
In calculating the right-hand side of (3.2.5) we have made use of the expansion (3.2.2).
Equations (3.2.6) are a set of homogeneous linear difference equations with constant
coefficients, for which the solution is well known (see, e.g., Brockwell and Davis
(1991), Section 3.6) to be of the form

γ (h) = α1ξ
−h
1 + α2ξ

−h
2 + · · · + αpξ−h

p , h ≥ m − p, (3.2.7)

where ξ1, . . . , ξp are the roots (assumed to be distinct) of the equation φ(z) = 0, and
α1, . . . , αp are arbitrary constants. (For further details, and for the treatment of the
case where the roots are not distinct, see Brockwell and Davis (1991), Section 3.6.)
Of course, we are looking for the solution of (3.2.6) that also satisfies (3.2.5). We
therefore substitute the solution (3.2.7) into (3.2.5) to obtain a set ofm linear equations
that then uniquely determine the constants α1, . . . , αp and the m − p autocovariances
γ (h), 0 ≤ h < m − p.

Example 3.2.3 The ARMA(1,1) Process

For the causal ARMA(1,1) process defined in Example 3.2.1, equations (3.2.5) are

γ (0)− φγ (1) = σ 2(1 + θ(θ + φ)) (3.2.8)

and

γ (1)− φγ (0) = σ 2θ. (3.2.9)
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Equation (3.2.6) takes the form

γ (k)− φγ (k − 1) = 0, k ≥ 2. (3.2.10)

The solution of (3.2.10) is

γ (h) = αφh, h ≥ 1.

Substituting this expression for γ (h) into the two preceding equations (3.2.8) and
(3.2.9) gives two linear equations for α and the unknown autocovariance γ (0). These
equations are easily solved, giving the autocovariances already found for this process
in Example 3.2.1.

�

Example 3.2.4 The General AR(2) Process

For the causal AR(2) process defined by
(
1 − ξ−1

1 B
)(

1 − ξ−1
2 B

)
Xt = Zt, |ξ1|, |ξ2| > 1, ξ1 �= ξ2,

we easily find from (3.2.7) and (3.2.5) using the relations

φ1 = ξ−1
1 + ξ−1

2

and

φ2 = −ξ−1
1 ξ−1

2

that

γ (h) = σ 2ξ 2
1 ξ

2
2

(ξ1ξ2 − 1)(ξ2 − ξ1)

[
(ξ 2

1 − 1)−1ξ 1−h
1 − (ξ 2

2 − 1)−1ξ 1−h
2

]
. (3.2.11)

Figures 3-1, 3-2, 3-3, and 3-4 illustrate some of the possible forms of γ (·) for different
values of ξ1 and ξ2. Notice that in the case of complex conjugate roots ξ1 = reiθ and
ξ2 = re−iθ , 0 < θ < π , we can write (3.2.11) in the more illuminating form

γ (h) = σ 2r4 · r−h sin(hθ + ψ)
(r2 − 1)(r4 − 2r2 cos 2θ + 1) sin θ

, (3.2.12)

Figure 3-1
The model ACF of the AR(2)
series of Example 3.2.4 with

ξ1 = 2 and ξ2 = 5 Lag
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Figure 3-2
The model ACF of the AR(2)

series of Example 3.2.4
with ξ1=10/9 and ξ2=2 Lag 
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Figure 3-3
The model ACF of the AR(2)
series of Example 3.2.4 with

ξ1 = −10/9 and ξ2 = 2 Lag
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where

tanψ = r2 + 1

r2 − 1
tan θ (3.2.13)

and cosψ has the same sign as cos θ . Thus in this case γ (·) has the form of a damped
sinusoidal function with damping factor r−1 and period 2π/θ . If the roots are close
to the unit circle, then r is close to 1, the damping is slow, and we obtain a nearly
sinusoidal autocovariance function.

�
Third Method. The autocovariances can also be found by solving the first p + 1
equations of (3.2.5) and (3.2.6) for γ (0) . . . , γ ( p) and then using the subsequent
equations to solve successively for γ ( p + 1), γ ( p + 2), . . . . This is an especially
convenient method for numerical determination of the autocovariances γ (h) and is
used in the option Model>ACF/PACF>Model of the program ITSM.
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Figure 3-4
The model ACF of the AR(2)
series of Example 3.2.4 with

ξ1 = 2(1+ i
√
3)/3 and

ξ2 = 2(1 − i
√
3)/3 Lag 
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Example 3.2.5 Consider again the causal ARMA(1,1) process of Example 3.2.1. To apply the third
method we simply solve (3.2.8) and (3.2.9) for γ (0) and γ (1). Then γ (2), γ (3), . . .
can be found successively from (3.2.10). It is easy to check that this procedure gives
the same results as those obtained in Examples 3.2.1 and 3.2.3.

�

3.2.2 The Autocorrelation Function

Recall that the ACF of an ARMA process {Xt} is the function ρ(·) found immediately
from the ACVF γ (·) as

ρ(h) = γ (h)

γ (0)
.

Likewise, for any set of observations {x1, . . . , xn}, the sample ACF ρ̂(·) is computed as

ρ̂(h) = γ̂ (h)

γ̂ (0)
.

The Sample ACF of an MA(q) Series. Given observations {x1, . . . , xn} of a time
series, one approach to the fitting of a model to the data is to match the sample ACF
of the data with the ACF of the model. In particular, if the sample ACF ρ̂(h) is sig-
nificantly different from zero for 0 ≤ h ≤ q and negligible for h > q, Example
3.2.2 suggests that an MA(q) model might provide a good representation of the data.
In order to apply this criterion we need to take into account the random variation
expected in the sample autocorrelation function before we can classify ACF values
as “negligible.” To resolve this problem we can use Bartlett’s formula (Section 2.4),
which implies that for a large sample of size n from an MA(q) process, the sample
ACF values at lags h greater than q are approximately normally distributed with
means 0 and variances whh/n = (

1 + 2ρ2(1) + · · · + 2ρ2(q)
)
/n. This means

that if the sample is from an MA(q) process and if h > q, then ρ̂(h) should fall
between the bounds ±1.96

√
whh/n with probability approximately 0.95. In practice

we frequently use the more stringent values ±1.96/
√
n as the bounds between which

sample autocovariances are considered “negligible.” A more effective and systematic
approach to the problem ofmodel selection, which also applies to ARMA(p, q) models
with p > 0 and q > 0, will be discussed in Section 5.5.
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3.2.3 The Partial Autocorrelation Function

The partial autocorrelation function (PACF) of an ARMA process {Xt} is the
function α(·) defined by the equations

α(0) = 1

and

α(h) = φhh, h ≥ 1,

where φhh is the last component of

φh = �−1
h γ h, (3.2.14)

�h = [
γ (i − j)

]h
i, j=1, and γ h = [

γ (1), γ (2), . . . , γ (h)
]′
.

For any set of observations {x1, . . . , xn} with xi �= xj for some i and j, the sample
PACF α̂(h) is given by

α̂(0) = 1

and

α̂(h) = φ̂hh, h ≥ 1,

where φ̂hh is the last component of

φ̂h = �̂−1
h γ̂ h. (3.2.15)

We show in the next example that the PACF of a causal AR(p) process is zero for
lags greater than p. Both sample and model partial autocorrelation functions can be
computed numerically using the program ITSM. Algebraic calculation of the PACF is
quite complicated except when q is zero or p and q are both small.

It can be shown (Brockwell and Davis (1991), p. 171) that φhh is the correlation
between the prediction errors Xh −P(Xh|X1, . . . ,Xh−1) and X0 −P(X0|X1, . . . ,Xh−1).

Example 3.2.6 The PACF of an AR(p) Process

For the causal AR(p) process defined by

Xt − φ1Xt−1 − · · · − φpXt−p = Zt, {Zt} ∼ WN
(
0, σ 2

)
,

we know (Problem 2.15) that for h ≥ p the best linear predictor of Xh+1 in terms of
1,X1, . . . , Xh is

X̂h+1 = φ1Xh + φ2Xh−1 + · · · + φpXh+1−p.

Since the coefficient φhh of X1 is φp if h = p and 0 if h > p, we conclude that the
PACF α(·) of the process {Xt} has the properties

α(p) = φp

and

α(h) = 0 for h > p.

For h < p the values of α(h) can easily be computed from (3.2.14). For any
specified ARMA model the PACF can be evaluated numerically using the option
Model>ACF/PACF>Model of the program ITSM.

�
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Example 3.2.7 The PACF of an MA(1) Process

For theMA(1) process, it can be shown from (3.2.14) (see Problem 3.12) that the PACF
at lag h is

α(h) = φhh = −(−θ)h/(1 + θ2 + · · · + θ2h
)
.

�
The Sample PACF of an AR(p) Series. If {Xt} is an AR( p) series, then the sample
PACF based on observations {x1, . . . , xn} should reflect (with sampling variation) the
properties of the PACF itself. In particular, if the sample PACF α̂(h) is significantly
different from zero for 0 ≤ h ≤ p and negligible for h > p, Example 3.2.6 suggests
that an AR( p) model might provide a good representation of the data. To decide what
is meant by “negligible” we can use the result that for an AR( p) process the sample
PACF values at lags greater than p are approximately independent N(0, 1/n) random
variables. This means that roughly 95% of the sample PACF values beyond lag p
should fall within the bounds ±1.96/

√
n. If we observe a sample PACF satisfying

|α̂(h)| > 1.96/
√
n for 0 ≤ h ≤ p and |α̂(h)| < 1.96/

√
n for h > p, this suggests

an AR( p)model for the data. For a more systematic approach to model selection, see
Section 5.5.

3.2.4 Examples

Example 3.2.8 The time series plotted in Figure 3-5 consists of 57 consecutive daily overshorts from
an underground gasoline tank at a filling station in Colorado. If yt is the measured
amount of fuel in the tank at the end of the tth day and at is the measured amount sold
minus the amount delivered during the course of the tth day, then the overshort at the
end of day t is defined as xt = yt − yt−1 + at. Due to the error in measuring the current
amount of fuel in the tank, the amount sold, and the amount delivered to the station, we
view yt, at, and xt as observed values from some set of random variables Yt,At, and Xt

for t = 1, . . . , 57. (In the absence of any measurement error and any leak in the tank,
each xt would be zero.) The data and their ACF are plotted in Figures 3-5 and 3-6. To
check the plausibility of an MA(1) model, the bounds ±1.96

(
1 + 2ρ̂2(1)

)1/2
/n1/2 are

also plotted in Figure 3-6. Since ρ̂(h) is well within these bounds for h > 1, the data

Figure 3-5
Time series of the overshorts

in Example 3.2.8
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Figure 3-6
The sample ACF of the data
in Figure 3-5 showing the
bounds ±1.96n−1/2 (1 +
2ρ̂2(1)

)1/2 assuming an
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appear to be compatible with the model

Xt = μ+ Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2). (3.2.16)

The mean μmay be estimated by the sample mean x̄57 = −4.035, and the parameters
θ, σ 2 may be estimated by equating the sample ACVF with the model ACVF at lags
0 and 1, and solving the resulting equations for θ and σ 2. This estimation procedure
is known as the method of moments, and in this case gives the equations

(1 + θ2)σ 2 = γ̂ (0) = 3415.72,

θσ 2 = γ̂ (1) = −1719.95.

Using the approximate solution θ = −1 and σ 2 = 1708, we obtain the noninvertible
MA(1) model

Xt = −4.035 + Zt − Zt−1, {Zt} ∼ WN(0, 1708).

Typically, in time series modeling we have little or no knowledge of the underlying
physical mechanism generating the data, and the choice of a suitable class of models
is entirely data driven. For the time series of overshorts, the data, through the graph
of the ACF, lead us to the MA(1) model. Alternatively, we can attempt to model
the mechanism generating the time series of overshorts using a structural model. As
we will see, the structural model formulation leads us again to the MA(1) model. In
the structural model setup, write Yt, the observed amount of fuel in the tank at time t, as

Yt = y∗
t + Ut, (3.2.17)

where y∗
t is the true (or actual) amount of fuel in the tank at time t (not to be confused

with yt above) and Ut is the resulting measurement error. The variable y∗
t is an ide-

alized quantity that in principle cannot be observed even with the most sophisticated
measurement devices. Similarly, we assume that

At = a∗
t + Vt, (3.2.18)

where a∗
t is the actual amount of fuel sold minus the actual amount delivered during

day t, and Vt is the associated measurement error. We further assume that {Ut} ∼
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WN
(
0, σ 2

U

)
, {Vt} ∼ WN

(
0, σ 2

V

)
, and that the two sequences {Ut} and {Vt} are uncor-

related with one another (E(UtVs) = 0 for all s and t). If the change of level per day
due to leakage is μ gallons (μ < 0 indicates leakage), then

y∗
t = μ+ y∗

t−1 − a∗
t . (3.2.19)

This equation relates the actual amounts of fuel in the tank at the end of days t and
t−1, adjusted for the actual amounts that have been sold and delivered during the day.
Using (3.2.17)–(3.2.19), the model for the time series of overshorts is given by

Xt = Yt − Yt−1 + At = μ+ Ut − Ut−1 + Vt.

This model is stationary and 1-correlated, since

EXt = E(μ+ Ut − Ut−1 + Vt) = μ

and

γ (h) = E[(Xt+h − μ)(Xt − μ)]
= E[(Ut+h − Ut+h−1 + Vt+h)(Ut − Ut−1 + Vt)]

=

⎧
⎪⎪⎨

⎪⎪⎩

2σ 2
U + σ 2

V , if h = 0,

−σ 2
U, if |h| = 1,

0, otherwise.

It follows from Proposition 2.1.1 that {Xt} is the MA(1) model (3.2.16) with

ρ(1) = θ1

1 + θ2
1

= −σ 2
U

2σ 2
U + σ 2

V

.

From this equation we see that the measurement error associated with the adjustment
{At} is zero (i.e., σ 2

V = 0) if and only if ρ(1) = −0.5 or, equivalently, if and only
if θ1 = −1. From the analysis above, the moment estimator of θ1 for the overshort
data is in fact −1, so that we conclude that there is relatively little measurement error
associated with the amount of fuel sold and delivered.

We shall return to a more general discussion of structural models in Chapter 8.
�

Example 3.2.9 The Sunspot Numbers

Figure 3-7 shows the sample PACF of the sunspot numbers S1, . . . , S100 (for the years
1770–1869) as obtained from ITSM by opening the project SUNSPOTS.TSM and
clicking on the second yellow button at the top of the screen. The graph also shows the
bounds ±1.96/

√
100. The fact that all of the PACF values beyond lag 2 fall within

the bounds suggests the possible suitability of an AR(2) model for the mean-corrected
data set Xt = St − 46.93. One simple way to estimate the parameters φ1, φ2, and σ 2

of such a model is to require that the ACVF of the model at lags 0, 1, and 2 should
match the sample ACVF at those lags. Substituting the sample ACVF values

γ̂ (0) = 1382.2, γ̂ (1) = 1114.4, γ̂ (2) = 591.73,

for γ (0), γ (1), and γ (2) in the first three equations of (3.2.5) and (3.2.6) and solving
for φ1, φ2, and σ 2 gives the fitted model

Xt − 1.318Xt−1 + 0.634Xt−2 = Zt, {Zt} ∼ WN(0, 289.2). (3.2.20)

(This method of model fitting is called Yule–Walker estimation and will be discussed
more fully in Section 5.1.1.)

�
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Figure 3-7
The sample PACF of the
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3.3 Forecasting ARMA Processes

The innovations algorithm (see Section 2.5.4) provided us with a recursive method for
forecasting second-order zero-mean processes that are not necessarily stationary. For
the causal ARMA process

φ(B)Xt = θ(B)Zt, {Zt} ∼ WN
(
0, σ 2),

it is possible to simplify the application of the algorithm drastically. The idea is to apply
it not to the process {Xt} itself, but to the transformed process [cf. Ansley (1979)]

⎧
⎨

⎩

Wt = σ−1Xt, t = 1, . . . ,m,

Wt = σ−1φ(B)Xt, t > m,
(3.3.1)

where

m = max(p, q). (3.3.2)

For notational convenience we define θ0 := 1 and θj := 0 for j > q. We shall also
assume that p ≥ 1 and q ≥ 1. (There is no loss of generality in these assumptions,
since in the analysis that follows we may take any of the coefficients φi and θi to be
zero.)

The autocovariance function γX(·) of {Xt} can easily be computed using any of the
methods described in Section 3.2.1. The autocovariances κ(i, j) = E(WiWj), i, j ≥ 1,
are then found from

κ(i, j) =

⎧
⎪⎪⎪⎪⎪⎪⎪⎪⎨

⎪⎪⎪⎪⎪⎪⎪⎪⎩

σ−2γX(i − j), 1 ≤ i, j ≤ m

σ−2

[

γX(i − j)−
p∑

r=1
φrγX(r − |i − j|)

]

, min(i, j) ≤ m < max(i, j) ≤ 2m,

q∑

r=0
θrθr+|i−j|, min(i, j) > m,

0, otherwise.

(3.3.3)
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Applying the innovations algorithm to the process {Wt} we obtain
⎧
⎪⎪⎪⎨

⎪⎪⎪⎩

Ŵn+1 =
n∑

j=1
θnj(Wn+1−j − Ŵn+1−j), 1 ≤ n < m,

Ŵn+1 =
q∑

j=1
θnj(Wn+1−j − Ŵn+1−j), n ≥ m,

(3.3.4)

where the coefficients θnj and the mean squared errors rn = E
(
Wn+1 − Ŵn+1

)2
are

found recursively from the innovations algorithm with κ defined as in (3.3.3). The
notable feature of the predictors (3.3.4) is the vanishing of θnj when both n ≥ m and
j > q. This is a consequence of the innovations algorithm and the fact that κ(r, s) = 0
if r > m and |r − s| > q.

Observe now that the equations (3.3.1) allow each Xn, n ≥ 1, to be written as a
linear combination ofWj, 1 ≤ j ≤ n, and, conversely, eachWn, n ≥ 1, to be written as
a linear combination of Xj, 1 ≤ j ≤ n. This means that the best linear predictor of any
random variable Y in terms of {1, X1, . . . , Xn} is the same as the best linear predictor
of Y in terms of {1,W1, . . . ,Wn}. We shall denote this predictor by PnY . In particular,
the one-step predictors of Wn+1 and Xn+1 are given by

Ŵn+1 = PnWn+1

and

X̂n+1 = PnXn+1.

Using the linearity of Pn and the equations (3.3.1) we see that
⎧
⎨

⎩

Ŵt = σ−1X̂t, t = 1, . . . ,m,

Ŵt = σ−1
[
X̂t − φ1Xt−1 − · · · − φpXt−p

]
, t > m,

(3.3.5)

which, together with (3.3.1), shows that

Xt − X̂t = σ
[
Wt − Ŵt

]
for all t ≥ 1. (3.3.6)

Replacing
(
Wj − Ŵj

)
by σ−1

(
Xj − X̂j

)
in (3.3.3) and then substituting into (3.3.4),

we finally obtain

X̂n+1 =

⎧
⎪⎪⎪⎪⎨

⎪⎪⎪⎪⎩

n∑

j=1

θnj

(
Xn+1−j − X̂n+1−j

)
, 1 ≤ n < m,

φ1Xn + · · · + φpXn+1−p +
q∑

j=1

θnj

(
Xn+1−j − X̂n+1−j

)
, n ≥ m,

(3.3.7)

and

E
(
Xn+1 − X̂n+1

)2 = σ 2E
(
Wn+1 − Ŵn+1

)2 = σ 2rn, (3.3.8)

where θnj and rn are found from the innovations algorithm with κ as in (3.3.3).
Equations (3.3.7) determine the one-step predictors X̂2, X̂3, . . . recursively.

Remark 1. It can be shown (see Brockwell and Davis (1991), Problem 5.6) that if
{Xt} is invertible, then as n → ∞,

E
(
Xn − X̂n − Zn

)2 → 0,

θnj → θj, j = 1, . . . , q,
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and

rn → 1.

Algebraic calculation of the coefficients θnj and rn is not feasible except for very simple
models, such as those considered in the following examples. However, numerical
implementation of the recursions is quite straightforward and is used to compute
predictors in the program ITSM. �

Example 3.3.1 Prediction of an AR(p) Process

Applying (3.3.7) to the ARMA(p, 0) process, we see at once that

X̂n+1 = φ1Xn + · · · + φpXn+1−p, n ≥ p.

�

Example 3.3.2 Prediction of an MA(q) Process

Applying (3.3.7) to the ARMA(1, q) process with φ1 = 0 gives

X̂n+1 =
min(n,q)∑

j=1

θnj

(
Xn+1−j − X̂n+1−j

)
, n ≥ 1,

where the coefficients θnj are found by applying the innovations algorithm to the co-
variances κ(i, j) defined in (3.3.3). Since in this case the processes {Xt} and {σ−1Wt}
are identical, these covariances are simply

κ(i, j) = σ−2γX(i − j) =
q−|i−j|∑

r=0

θrθr+|i−j|.

�
Example 3.3.3 Prediction of an ARMA(1,1) Process

If

Xt − φXt−1 = Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2),

and |φ| < 1, then equations (3.3.7) reduce to the single equation

X̂n+1 = φXn + θn1(Xn − X̂n), n ≥ 1.

To compute θn1 we use Example 3.2.1 to obtain γX(0)=σ 2(1 + 2θφ + θ2)/
(
1 − φ2

)
.

Substituting in (3.3.3) then gives, for i, j ≥ 1,

κ(i, j) =

⎧
⎪⎪⎪⎪⎪⎨

⎪⎪⎪⎪⎪⎩

(
1 + 2θφ + θ2

)
/
(
1 − φ2

)
, i = j = 1,

1 + θ2, i = j ≥ 2,

θ, |i − j| = 1, i ≥ 1,

0, otherwise.

With these values of κ(i, j), the recursions of the innovations algorithm reduce to

r0 = (
1 + 2θφ + θ2)/

(
1 − φ2),

θn1 = θ/rn−1, (3.3.9)

rn = 1 + θ2 − θ2/rn−1,

which can be solved quite explicitly (see Problem 3.13).
�



90 Chapter 3 ARMA Models

Example 3.3.4 Numerical Prediction of an ARMA(2,3) Process

In this example we illustrate the steps involved in numerical prediction of an
ARMA(2,3) process. Of course, these steps are shown for illustration only.
The calculations are all carried out automatically by ITSM in the course of computing
predictors for any specified data set and ARMAmodel. The process we shall consider
is the ARMA process defined by the equations

Xt − Xt−1 + 0.24Xt−2 = Zt + 0.4Zt−1 + 0.2Zt−2 + 0.1Zt−3, (3.3.10)

where {Zt} ∼ WN(0, 1). Ten values of X1, . . . ,X10 simulated by the program ITSM
are shown in Table 3.1. (These were produced using the option Model>Specify
to specify the order and parameters of the model and then Model>Simulate to
generate the series from the specified model.)

The first step is to compute the covariances γX(h), h = 0, 1, 2, which are easily
found from equations (3.2.5) with k = 0, 1, 2 to be

γX(0) = 7.17133, γX(1) = 6.44139, and γX(2) = 5.0603.

From (3.3.3) we find that the symmetric matrix K = [κ(i, j)]i, j=1,2,... is given by

K =

⎡

⎢
⎢
⎢
⎢
⎢
⎢
⎢
⎢
⎢
⎢
⎢
⎢
⎢
⎣

7.1713
6.4414 7.1713
5.0603 6.4414 7.1713

0.10 0.34 0.816 1.21
0 0.10 0.34 0.50 1.21
0 0 0.10 0.24 0.50 1.21
· 0 0 0.10 0.24 0.50 1.21
· · 0 0 0.10 0.24 0.50 1.21
· · · · · · · · ·

⎤

⎥
⎥
⎥
⎥
⎥
⎥
⎥
⎥
⎥
⎥
⎥
⎥
⎥
⎦

.

The next step is to solve the recursions of the innovations algorithm for θnj and rn
using these values for κ(i, j). Then

Table 3.1 X̂n+1 for the ARMA(2,3) Process of Example 3.3.4

n Xn+1 rn θn1 θn2 θn3 X̂n+1

0 1.704 7.1713 0
1 0.527 1.3856 0.8982 1.5305
2 1.041 1.0057 1.3685 0.7056 −0.1710
3 0.942 1.0019 0.4008 0.1806 0.0139 1.2428
4 0.555 1.0019 0.3998 0.2020 0.0732 0.7443
5 −1.002 1.0005 0.3992 0.1995 0.0994 0.3138
6 −0.585 1.0000 0.4000 0.1997 0.0998 −1.7293
7 0.010 1.0000 0.4000 0.2000 0.0998 −0.1688
8 −0.638 1.0000 0.4000 0.2000 0.0999 0.3193
9 0.525 1.0000 0.4000 0.2000 0.1000 −0.8731
10 1.0000 0.4000 0.2000 0.1000 1.0638
11 1.0000 0.4000 0.2000 0.1000
12 1.0000 0.4000 0.2000 0.1000
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X̂n+1 =

⎧
⎪⎪⎪⎪⎨

⎪⎪⎪⎪⎩

n∑

j=1

θnj

(
Xn+1−j − X̂n+1−j

)
, n = 1, 2,

Xn − 0.24Xn−1 +
3∑

j=1
θnj

(
Xn+1−j − X̂n+1−j

)
, n = 3, 4, . . . ,

and

E
(
Xn+1 − X̂n+1

)2 = σ 2rn = rn.

The results are shown in Table 3.1.
�

3.3.1 h-Step Prediction of an ARMA(p,q) Process

As in Section 2.5, we use PnY to denote the best linear predictor of Y in terms of
X1, . . . ,Xn (which, as pointed out after (3.3.4), is the same as the best linear predictor
of Y in terms ofW1, . . . ,Wn). Then from (2.5.30) we have

PnWn+h =
n+h−1∑

j=h

θn+h−1, j

(
Wn+h−j − Ŵn+h−j

)
= σ 2

n+h−1∑

j=h

θn+h−1, j

(
Xn+h−j − X̂n+h−j

)
.

Using this result and applying the operator Pn to each side of equation (3.3.1), we
conclude that the h-step predictors PnXn+h satisfy

PnXn+h =

⎧
⎪⎪⎪⎪⎪⎨

⎪⎪⎪⎪⎪⎩

n+h−1∑

j=h

θn+h−1, j

(
Xn+h−j − X̂n+h−j

)
, 1 ≤ h ≤ m − n,

p∑

i=1

φiPnXn+h−i +
n+h−1∑

j=h

θn+h−1, j

(
Xn+h−j − X̂n+h−j

)
, h > m − n.

(3.3.11)

If, as is almost always the case, n > m = max(p, q), then for all h ≥ 1,

PnXn+h =
p∑

i=1

φiPnXn+h−i +
q∑

j=h

θn+h−1, j

(
Xn+h−j − X̂n+h−j

)
. (3.3.12)

Once the predictors X̂1, . . . X̂n have been computed from (3.3.7), it is a straightforward
calculation, with n fixed, to determine the predictors PnXn+1,PnXn+2,PnXn+3, . . .

recursively from (3.3.12) (or (3.3.11) if n ≤ m). The calculations are performed
automatically in the Forecasting>ARMA option of the program ITSM.

Example 3.3.5 h-Step Prediction of an ARMA(2,3) Process

To compute h-step predictors, h = 1, . . . , 10, for the data of Example 3.3.4 and
the model (3.3.10), open the project E334.TSM in ITSM and enter the model using the
option Model>Specify. Then select Forecasting>ARMA and specify 10 for the
number of forecasts required. You will notice that the white noise variance is au-
tomatically set by ITSM to an estimate based on the sample. To retain the model
value of 1, you must reset the white noise variance to this value. Then click OK and
you will see a graph of the original series with the ten predicted values appended.
If you right-click on the graph and select Info, you will see the numerical results
shown in the following table as well as prediction bounds based on the assumption
that the series is Gaussian. (Prediction bounds are discussed in the last paragraph of
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this chapter.) The mean squared errors are calculated as described below. Notice how
the predictors converge fairly rapidly to the mean of the process (i.e., zero) as the lead
time h increases. Correspondingly, the one-step mean squared error increases from
the white noise variance (i.e., 1) at h = 1 to the variance of Xt (i.e., 7.1713), which is
virtually reached at h = 10.

�

The Mean Squared Error of PnXn+h

The mean squared error of PnXn+h is easily computed by ITSM from the formula

σ 2
n (h) := E(Xn+h − PnXn+h)

2 =
h−1∑

j=0

(
j∑

r=0

χrθn+h−r−1, j−r

)2

vn+h−j−1,

(3.3.13)

where the coefficients χj are computed recursively from the equations χ0 = 1 and

χj =
min(p, j)∑

k=1

φkχj−k, j = 1, 2, . . . . (3.3.14)

Example 3.3.6 h-Step Prediction of an ARMA(2,3) Process

We now illustrate the use of (3.3.12) and (3.3.13) for the h-step predictors and their
mean squared errors by manually reproducing the output of ITSM shown in Table 3.2.
From (3.3.12) and Table 3.1 we obtain

P10X12 =
2∑

i=1

φiP10X12−i +
3∑

j=2

θ11, j

(
X12−j − X̂12−j

)

= φ1X̂11 + φ2X10 + 0.2
(
X10 − X̂10

)
+ 0.1

(
X9 − X̂9

)

= 1.1217

and

Table 3.2 h-step predictors for
the ARMA(2,3)
Series of Example 3.3.4

h P10X10+h
√
MSE

1 1.0638 1.0000
2 1.1217 1.7205
3 1.0062 2.1931
4 0.7370 2.4643
5 0.4955 2.5902
6 0.3186 2.6434
7 0.1997 2.6648
8 0.1232 2.6730
9 0.0753 2.6761
10 0.0457 2.6773
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P10X13 =
2∑

i=1

φiP10X13−i +
3∑

j=3

θ12, j

(
X13−j − X̂13−j

)

= φ1P10X12 + φ2X̂11 + 0.1
(
X10 − X̂10

)

= 1.0062.

For k > 13, P10Xk is easily found recursively from

P10Xk = φ1P10Xk−1 + φ2P10Xk−2.

To find the mean squared errors we use (3.3.13) with χ0 = 1, χ1 = φ1 = 1, and
χ2 = φ1χ1 + φ2 = 0.76. Using the values of θnj and vj(= rj) in Table 3.1, we obtain

σ 2
10(2) = E(X12 − P10X12)

2 = 2.960

and

σ 2
10(3) = E(X13 − P10X13)

2 = 4.810,

in accordance with the results shown in Table 3.2.
�

Large-Sample Approximations
Assuming as usual that the ARMA(p, q) process defined by φ(B)Xt = θ(B)Zt, {Zt} ∼
WN

(
0, σ 2

)
, is causal and invertible, we have the representations

Xn+h =
∞∑

j=0

ψjZn+h−j (3.3.15)

and

Zn+h = Xn+h +
∞∑

j=1

πjXn+h−j, (3.3.16)

where {ψj} and {πj} are uniquely determined by equations (3.1.7) and (3.1.8), respec-
tively. Let P̃nY denote the best (i.e., minimum mean squared error) approximation to
Y that is a linear combination or limit of linear combinations of Xt, −∞ < t ≤ n,
or equivalently [by (3.3.15) and (3.3.16)] of Zt, −∞ < t ≤ n. The properties
of the operator P̃n were discussed in Section 2.5.6. Applying P̃n to each side of
equations (3.3.15) and (3.3.16) gives

P̃nXn+h =
∞∑

j=h

ψjZn+h−j (3.3.17)

and

P̃nXn+h = −
∞∑

j=1

πjP̃nXn+h−j. (3.3.18)

For h = 1 the jth term on the right of (3.3.18) is just Xn+1−j. Once P̃nXn+1 has
been evaluated, P̃nXn+2 can then be computed from (3.3.18). The predictors P̃nXn+3,
P̃nXn+4, . . . can then be computed successively in the same way. Subtracting (3.3.17)
from (3.3.15) gives the h-step prediction error as
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Xn+h − P̃nXn+h =
h−1∑

j=0

ψjZn+h−j,

from which we see that the mean squared error is

σ̃ 2(h) = σ 2
h−1∑

j=0

ψ2
j . (3.3.19)

The predictors obtained in this way have the form

P̃nXn+h =
∞∑

j=0

cjXn−j. (3.3.20)

In practice, of course, we have only observations X1, . . . ,Xn available, so we must
truncate the series (3.3.20) after n terms. The resulting predictor is a useful approx-
imation to PnXn+h if n is large and the coefficients cj converge to zero rapidly as j
increases. It can be shown that the mean squared error (3.3.19) of P̃nXn+h can also be
obtained by letting n → ∞ in the expression (3.3.13) for the mean squared error of
PnXn+h, so that σ̃ 2(h) is an easily calculated approximation to σ 2

n (h) for large n.

Prediction Bounds for Gaussian Processes
If the ARMA process {Xt} is driven by Gaussian white noise (i.e., if {Zt} ∼
IID N

(
0, σ 2

)
), then for each h ≥ 1 the prediction error Xn+h − PnXn+h is normally

distributed with mean 0 and variance σ 2
n (h) given by (3.3.19).

Consequently, if�1−α/2 denotes the (1−α/2) quantile of the standard normal dis-
tribution function, it follows that Xn+h lies between the bounds PnXn+h ±�1−α/2σn(h)
with probability (1 −α). These bounds are therefore called (1 −α) prediction bounds
for Xn+h.

Problems

3.1 Determine which of the following ARMA processes are causal and which of
them are invertible. (In each case {Zt} denotes white noise.)
(a) Xt + 0.2Xt−1 − 0.48Xt−2 = Zt.

(b) Xt + 1.9Xt−1 + 0.88Xt−2 = Zt + 0.2Zt−1 + 0.7Zt−2.

(c) Xt + 0.6Xt−1 = Zt + 1.2Zt−1.

(d) Xt + 1.8Xt−1 + 0.81Xt−2 = Zt.

(e) Xt + 1.6Xt−1 = Zt − 0.4Zt−1 + 0.04Zt−2.

3.2 For those processes in Problem 3.1 that are causal, compute and graph their
ACF and PACF using the program ITSM.

3.3 For those processes in Problem 3.1 that are causal, compute the first six co-
efficients ψ0, ψ1, . . . , ψ5 in the causal representation Xt = ∑∞

j=0ψjZt−j of {Xt}.
3.4 Compute the ACF and PACF of the AR(2) process

Xt = 0.8Xt−2 + Zt, {Zt} ∼ WN
(
0, σ 2).
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3.5 Let {Yt} be the ARMA plus noise time series defined by

Yt = Xt + Wt,

where {Wt} ∼ WN
(
0, σ 2

w

)
, {Xt} is the ARMA(p, q) process satisfying

φ(B)Xt = θ(B)Zt, {Zt} ∼ WN
(
0, σ 2

z

)
,

and E(WsZt) = 0 for all s and t.
(a) Show that {Yt} is stationary and find its autocovariance function in terms of

σ 2
W and the ACVF of {Xt}.

(b) Show that the process Ut := φ(B)Yt is r-correlated, where r = max(p, q)
and hence, by Proposition 2.1.1, is an MA(r) process. Conclude that {Yt} is
an ARMA(p, r) process.

3.6 Show that the two MA(1) processes

Xt = Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2)

Yt = Z̃t + 1

θ
Z̃t−1, {Z̃t} ∼ WN

(
0, σ 2θ2

)
,

where 0 < |θ | < 1, have the same autocovariance functions.

3.7 Suppose that {Xt} is the noninvertible MA(1) process

Xt = Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2),

where |θ | > 1. Define a new process {Wt} as

Wt =
∞∑

j=0

(−θ)−jXt−j

and show that {Wt} ∼ WN
(
0, σ 2

W

)
. Express σ 2

W in terms of θ and σ 2 and show
that {Xt} has the invertible representation (in terms of {Wt})

Xt = Wt + 1

θ
Wt−1.

3.8 Let {Xt} denote the unique stationary solution of the autoregressive equations

Xt = φXt−1 + Zt, t = 0,±1, . . . ,

where {Zt} ∼ WN
(
0, σ 2

)
and |φ| > 1. Then Xt is given by the expression

(2.2.11). Define the new sequence

Wt = Xt − 1

φ
Xt−1,

show that {Wt} ∼ WN
(
0, σ 2

W

)
, and express σ 2

W in terms of σ 2 and φ. These
calculations show that {Xt} is the (unique stationary) solution of the causal AR
equations

Xt = 1

φ
Xt−1 + Wt, t = 0,±1, . . . .

3.9 (a) Calculate the autocovariance function γ (·) of the stationary time series

Yt = μ+ Zt + θ1Zt−1 + θ12Zt−12, {Zt} ∼ WN
(
0, σ 2).
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(b) Use the program ITSM to compute the sample mean and sample autocovari-
ances γ̂ (h), 0 ≤ h ≤ 20, of {∇∇12Xt}, where {Xt, t = 1, . . . , 72} is the
accidental deaths series DEATHS.TSM of Example 1.1.3.

(c) By equating γ̂ (1), γ̂ (11), and γ̂ (12) from part (b) to γ (1), γ (11), and γ (12),
respectively, from part (a), find a model of the form defined in (a) to represent
{∇∇12Xt}.

3.10 By matching the autocovariances and sample autocovariances at lags 0 and 1, fit
a model of the form

Xt − μ = φ(Xt−1 − μ)+ Zt, {Zt} ∼ WN
(
0, σ 2

)
,

to the data STRIKES.TSM of Example 1.1.6. Use the fitted model to compute
the best predictor of the number of strikes in 1981. Estimate the mean squared
error of your predictor and construct 95% prediction bounds for the number of
strikes in 1981 assuming that {Zt} ∼ iid N

(
0, σ 2

)
.

3.11 Show that the value at lag 2 of the partial ACF of the MA(1) process

Xt = Zt + θZt−1, t = 0,±1, . . . ,

where {Zt} ∼ WN
(
0, σ 2

)
, is

α(2) = −θ2/
(
1 + θ2 + θ4) .

3.12 For the MA(1) process of Problem 3.11, the best linear predictor of Xn+1 based
on X1, . . . ,Xn is

X̂n+1 = φn,1Xn + · · · + φn,nX1,

where φn = (
φn1, . . . , φnn

)′
satisfies Rnφn = ρn [equation (2.5.23)]. By sub-

stituting the appropriate correlations into Rn and ρn and solving the resulting
equations (starting with the last and working up), show that for 1 ≤ j < n,
φn,n−j = (−θ)−j

(
1 + θ2 + · · · + θ2j

)
φnn and hence that the PACF α(n) := φnn =

−(−θ)n/(1 + θ2 + · · · + θ2n
)
.

3.13 The coefficients θnj and one-step mean squared errors vn = rnσ 2 for the general
causal ARMA(1,1) process in Example 3.3.3 can be found as follows:
(a) Show that if yn := rn/(rn − 1), then the last of equation (3.3.9) can be

rewritten in the form

yn = θ−2yn−1 + 1, n ≥ 1.

(b) Deduce that yn=θ−2ny0+∑n
j=1 θ

−2( j−1) and hence determine rn and
θn1, n= 1, 2, . . . .

(c) Evaluate the limits as n → ∞ of rn and θn1 in the two cases |θ | < 1 and
|θ | ≥ 1.



4 Spectral Analysis

4.1 Spectral Densities
4.2 The Periodogram
4.3 Time-Invariant Linear Filters
4.4 The Spectral Density of an ARMA Process

This chapter can be omitted without any loss of continuity. The reader with no back-
ground in Fourier or complex analysis should go straight to Chapter 5. The spectral
representation of a stationary time series {Xt} essentially decomposes {Xt} into a sum of
sinusoidal components with uncorrelated random coefficients. In conjunction with this
decomposition there is a corresponding decomposition into sinusoids of the autoco-
variance function of {Xt}. The spectral decomposition is thus an analogue for stationary
processes of the more familiar Fourier representation of deterministic functions. The
analysis of stationary processes by means of their spectral representation is often
referred to as the “frequency domain analysis” of time series or “spectral analysis.”
It is equivalent to “time domain” analysis based on the autocovariance function, but
provides an alternative way of viewing the process, which for some applications may
be more illuminating. For example, in the design of a structure subject to a randomly
fluctuating load, it is important to be aware of the presence in the loading force of a
large sinusoidal component with a particular frequency to ensure that this is not a
resonant frequency of the structure. The spectral point of view is also particularly
useful in the analysis of multivariate stationary processes and in the analysis of
linear filters. In Section 4.1 we introduce the spectral density of a stationary process
{Xt}, which specifies the frequency decomposition of the autocovariance function,
and the closely related spectral representation (or frequency decomposition) of the
process {Xt} itself. Section 4.2 deals with the periodogram, a sample-based function

© Springer International Publishing Switzerland 2016
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from which we obtain estimators of the spectral density. In Section 4.3 we discuss
time-invariant linear filters from a spectral point of view and in Section 4.4 we use the
results to derive the spectral density of an arbitrary ARMA process.

4.1 Spectral Densities

Suppose that {Xt} is a zero-mean stationary time series with autocovariance function
γ (·) satisfying ∑∞

h=−∞ |γ (h)| < ∞. The spectral density of {Xt} is the function f (·)
defined by

f (λ) = 1

2π

∞∑

h=−∞
e−ihλγ (h), −∞ < λ < ∞, (4.1.1)

where eiλ = cos(λ) + i sin(λ) and i = √−1. The summability of |γ (·)| implies that
the series in (4.1.1) converges absolutely (since

∣
∣eihλ

∣
∣2 = cos2(hλ) + sin2(hλ) = 1).

Since cos and sin have period 2π , so also does f , and it suffices to confine attention
to the values of f , on the interval (−π, π ].

Basic Properties of f :

(a) f is even, i.e., f (λ) = f (−λ), (4.1.2)

(b) f (λ) ≥ 0 for all λ ∈ (−π, π ], and (4.1.3)

(c) γ (k) =
∫ π

−π
eikλf (λ) dλ =

∫ π

−π
cos(kλ)f (λ) dλ. (4.1.4)

Proof Since sin(·) is an odd function and cos(·) and γ (·) are even functions, we have

f (λ) = 1

2π

∞∑

h=−∞
(cos(hλ)− i sin(hλ))γ (h)

= 1

2π

∞∑

h=−∞
cos(−hλ)γ (h)+ 0

= f (−λ).
For each positive integer N define

fN(λ) = 1

2πN
E

(
∣
∣
∣

N∑

r=1

Xre
−irλ

∣
∣
∣
2
)

= 1

2πN
E

(
N∑

r=1

Xre
−irλ

N∑

s=1

Xse
isλ

)

= 1

2πN

∑

|h|<N
(N − |h|)e−ihλγ (h).
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Clearly, the function fN is nonnegative for each N, and since fN(λ) → 1
2π

∑∞
h=−∞

e−ihλγ (h) = f (λ) asN → ∞, f must also be nonnegative. This proves (4.1.3). Turning
to (4.1.4),

∫ π

−π
eikλf (λ) dλ =

∫ π

−π
1

2π

∞∑

h=−∞
ei(k−h)λγ (h) dλ

= 1

2π

∞∑

h=−∞
γ (h)

∫ π

−π
ei(k−h)λ dλ

= γ (k),

since the only nonzero summand in the second line is the one for which h = k (see
Problem 4.1). �

Equation (4.1.4) expresses the autocovariances of a stationary time series with
absolutely summable ACVF as the Fourier coefficients of the nonnegative even func-
tion on (−π, π ] defined by (4.1.1). However, even if

∑∞
h=−∞ |γ (h)| = ∞, there may

exist a corresponding spectral density defined as follows.

Definition 4.1.1 A function f is the spectral density of a stationary time series {Xt} with ACVF
γ (·) if

(i) f (λ) ≥ 0 for all λ ∈ (−π, π ], and

(ii) γ (h) =
∫ π

−π
eihλf (λ) dλ for all integers h.

Remark 1. Spectral densities are essentially unique. That is, if f and g are two
spectral densities corresponding to the autocovariance function γ (·), i.e., γ (h) =∫ π
−π e

ihλf (λ) dλ = ∫ π
−π e

ihλg(λ) dλ for all integers h, then f and g have the same Fourier
coefficients and hence are equal (see, for example, Brockwell and Davis (1991),
Section 2.8). �

The following proposition characterizes spectral densities.

Proposition 4.1.1 A real-valued function f defined on (−π, π ] is the spectral density of a real-valued
stationary process if and only if

(i) f (λ) = f (−λ),
(ii) f (λ) ≥ 0, and
(iii)

∫ π
−π f (λ) dλ < ∞.

Proof If γ (·) is absolutely summable, then (i)–(iii) follow from the basic properties of f ,
(4.1.2)–(4.1.4). For the argument in the general case, see Brockwell and Davis (1991),
Section 4.3.

Conversely, suppose f satisfies (i)–(iii). Then it is easy to check, using (i), that the
function defined by

γ (h) =
∫ π

−π
eihλf (λ) dλ



100 Chapter 4 Spectral Analysis

is even. Moreover, if ar ∈ R, r = 1, . . . , n, then
n∑

r,s=1

arγ (r − s)as =
∫ π

−π

n∑

r,s=1

arase
iλ(r−s)f (λ) dλ

=
∫ π

−π

∣
∣
∣
∣
∣

n∑

r=1

are
iλr

∣
∣
∣
∣
∣

2

f (λ) dλ

≥ 0,

so that γ (·) is also nonnegative definite and therefore, by Theorem 2.1.1, is an
autocovariance function. �

Corollary 4.1.1 An absolutely summable function γ (·) is the autocovariance function of a stationary
time series if and only if it is even and

f (λ) = 1

2π

∞∑

h=−∞
e−ihλγ (h) ≥ 0, for all λ ∈ (−π, π ], (4.1.5)

in which case f (·) is the spectral density of γ (·).

Proof We have already established the necessity of (4.1.5). Now suppose (4.1.5) holds.
Applying Proposition 4.1.1 (the assumptions are easily checked) we conclude that f
is the spectral density of some autocovariance function. But this ACVF must be γ (·),
since γ (k) = ∫ π

−π e
ikλ f (λ) dλ for all integers k. �

Example 4.1.1 Using Corollary 4.1.1, it is a simple matter to show that the function defined by

κ(h) =

⎧
⎪⎨

⎪⎩

1, if h = 0,

ρ, if h = ±1,

0, otherwise,

is the ACVF of a stationary time series if and only if |ρ| ≤ 1
2 (see Example 2.1.1).

Since κ(·) is even and nonzero only at lags 0,±1, it follows from the corollary that κ
is an ACVF if and only if the function

f (λ) = 1

2π

∞∑

h=−∞
e−ihλγ (h) = 1

2π
[1 + 2ρ cos λ]

is nonnegative for all λ ∈ (−π, π ]. But this occurs if and only if |ρ| ≤ 1
2 .

�
As illustrated in the previous example, Corollary 4.1.1 provides us with a powerful

tool for checking whether or not an absolutely summable function on the integers is
an autocovariance function. It is much simpler and much more informative than direct
verification of nonnegative definiteness as required in Theorem 2.1.1.

Not all autocovariance functions have a spectral density. For example, the sta-
tionary time series

Xt = A cos(ωt)+ B sin(ωt), (4.1.6)

where A and B are uncorrelated random variables with mean 0 and variance 1, has
ACVF γ (h) = cos(ωh) (Problem 2.2), which is not expressible as

∫ π
−π e

ihλf (λ)dλ,
with f a function on (−π, π ]. Nevertheless, γ (·) can be written as the Fourier
transform of the discrete distribution function
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F(λ) =

⎧
⎪⎪⎨

⎪⎪⎩

0 if λ < −ω,
0.5 if − ω ≤ λ < ω,
1.0 if λ ≥ ω,

i.e.,

cos(ωh) =
∫

(−π,π]
eihλdF(λ),

where the integral is as defined in Section A.1. As the following theorem states
(see Brockwell and Davis (1991), p. 117), every ACVF is the Fourier transform of
a (generalized) distribution function on [−π, π ]. This representation is called the
spectral representation of the ACVF.

Theorem 4.1.1 (Spectral Representation of the ACVF) A function γ ( · ) defined on the integers is
the ACVF of a stationary time series if and only if there exists a right-continuous,
nondecreasing, bounded function F on [−π, π ] with F(−π) = 0 such that

γ (h) =
∫

(−π,π]
eihλdF(λ) (4.1.7)

for all integers h. (For real-valued time series, F is symmetric in the sense that∫

(a,b] dF(x) = ∫

[−b,−a) dF(x) for all a and b such that 0 < a < b.)

Remark 2. The function F is a generalized distribution function on [−π, π ] in the
sense that G(λ) = F(λ)/F(π) is a probability distribution function on [−π, π ]. Note
that since F(π) = γ (0) =Var(X1), the ACF of {Xt} has spectral representation

ρ(h) =
∫

(−π,π]
eihλdG(λ).

The function F in (4.1.7) is called the spectral distribution function of γ (·). If F(λ)
can be expressed as F(λ) = ∫ λ

−π f (y) dy for all λ ∈ [−π, π ], then f is the spectral
density function and the time series is said to have a continuous spectrum. If F is a
discrete distribution function (i.e., if G is a discrete probability distribution function),
then the time series is said to have a discrete spectrum. The time series (4.1.6) has a
discrete spectrum. �

Example 4.1.2 Linear Combination of Sinusoids

Consider now the process obtained by adding uncorrelated processes of the type
defined in (4.1.6), i.e.,

Xt =
k∑

j=1

(Aj cos(ωjt)+ Bj sin(ωjt)), 0 < ω1 < · · · < ωk < π, (4.1.8)

where A1,B1, . . . ,Ak,Bk are uncorrelated random variables with E(Aj) = E(Bj) = 0
and Var(Aj) = Var(Bj) = σ 2

j , j = 1, . . . , k. By Problem 4.5, the ACVF of this time

series is γ (h) = ∑k
j=1 σ

2
j cos(ωjh) and its spectral distribution function is F(λ) =

∑k
j=1 σ

2
j Fj(λ), where

Fj(λ) =

⎧
⎪⎪⎨

⎪⎪⎩

0 if λ < −ωj,

0.5 if − ωj ≤ λ < ωj,

1.0 if λ ≥ ωj.
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Figure 4-1
A sample path of size

100 from the time series
in Example 4.1.2 0 20 40 60 80 100

−6
− 4

− 2
0

2
4

6

Figure 4-2
The spectral distribution
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A sample path of this time series with k = 2, ω1 = π/4, ω2 = π/6, σ 2
1 = 9, and

σ 2
2 = 1 is plotted in Figure 4-1. Not surprisingly, the sample path closely approximates

a sinusoid with frequency ω1 = π/4 (and period 2π/ω1 = 8). The general features of
this sample path could have been deduced from the spectral distribution function (see
Figure 4-2), which places 90% of its total mass at the frequencies ±π/4. This means
that 90% of the variance of Xt is contributed by the term A1 cos(ω1t) + B1 cos(ω1t),
which is a sinusoid with period 8.

�
The remarkable feature of Example 4.1.2 is that every zero-mean stationary pro-

cess can be expressed as a superposition of uncorrelated sinusoids with frequencies
ω ∈ [0, π ]. In general, however, a stationary process is a superposition of infinitely
many sinusoids rather than a finite number as in (4.1.8). The required generalization
of (4.1.8) that allows for this is called a stochastic integral, written as

Xt =
∫

(−π,π]
eihλdZ(λ), (4.1.9)



4.1 Spectral Densities 103

where {Z(λ), −π < λ ≤ π} is a complex-valued process with orthogonal (or un-
correlated) increments. The representation (4.1.9) of a zero-mean stationary process
{Xt} is called the spectral representation of the process and should be compared with
the corresponding spectral representation (4.1.7) of the autocovariance function γ (·).
The underlying technical aspects of stochastic integration are beyond the scope of this
book; however, in the simple case of the process (4.1.8) it is not difficult to see that it
can be reexpressed in the form (4.1.9) by choosing

dZ(λ) =

⎧
⎪⎪⎪⎪⎪⎨

⎪⎪⎪⎪⎪⎩

Aj + iBj

2
, if λ = −ωj and j ∈ {1, . . . , k},

Aj − iBj

2
, if λ = ωj and j ∈ {1, . . . , k},

0, otherwise.

For this example it is also clear that

E(dZ(λ)dZ(λ)) =

⎧
⎪⎨

⎪⎩

σ 2
j

2
, if λ = ±ωj,

0, otherwise.

In general, the connection between dZ(λ) and the spectral distribution function of the
process can be expressed symbolically as

E(dZ(λ)dZ(λ)) =
{
F(λ)− F(λ−), for a discrete spectrum,

f (λ)dλ, for a continuous spectrum.
(4.1.10)

These relations show that a large jump in the spectral distribution function (or a large
peak in the spectral density) at frequency ±ω indicates the presence in the time series
of strong sinusoidal components with frequencies at (or near) ω radians per unit time.
The period of a sinusoid with frequency ω radians per unit time is 2π/ω.

Example 4.1.3 White Noise

If {Xt} ∼ WN
(
0, σ 2

)
, then γ (0) = σ 2 and γ (h) = 0 for all |h| > 0. This process has

a flat spectral density (see Problem 4.2)

f (λ) = σ 2

2π
, −π ≤ λ ≤ π.

A process with this spectral density is called white noise, since each frequency in the
spectrum contributes equally to the variance of the process.

�

Example 4.1.4 The Spectral Density of an AR(1) Process

If {Xt} is a causal AR(1) process satisfying the equation,

Xt = φXt−1 + Zt,

where {Zt} ∼ WN
(
0, σ 2

)
, then from (4.1.1), {Xt} has spectral density

f (λ) = σ 2

2π
(
1 − φ2

)

(

1 +
∞∑

h=1

φh
(
e−ihλ + eihλ

)
)
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Figure 4-3
The spectral density
f(λ), 0 ≤ λ ≤ π , of

Xt = 0.7Xt−1 + Zt, where
{Zt} ∼ WN
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Figure 4-4
The spectral density
f(λ), 0 ≤ λ ≤ π , of

Xt = −0.7Xt−1 + Zt, where
{Zt} ∼ WN

(
0, σ2
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= σ 2

2π
(
1 − φ2

)

(

1 + φeiλ

1 − φeiλ + φe−iλ

1 − φe−iλ

)

= σ 2

2π

(
1 − 2φ cos λ+ φ2)−1

.

Graphs of f (λ), 0 ≤ λ ≤ π , are displayed in Figures 4-3 and 4-4 for φ = 0.7 and
φ = −0.7. Observe that for φ = 0.7 the density is large for low frequencies and small
for high frequencies. This is not unexpected, since when φ = 0.7 the process has a
positive ACF with a large value at lag one (see Figure 4-5), making the series smooth
with relatively few high-frequency components. On the other hand, for φ = −0.7 the
ACF has a large negative value at lag one (see Figure 4-6), producing a series that
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Figure 4-5
The ACF of the AR(1)

process Xt = 0.7Xt−1 + Zt Lag
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Figure 4-6
The ACF of the AR(1)

process Xt = −0.7Xt−1 + Zt Lag
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fluctuates rapidly about its mean value. In this case the series has a large contribution
from high-frequency components as reflected by the size of the spectral density near
frequency π .

�

Example 4.1.5 Spectral Density of an MA(1) Process

If
Xt = Zt + θZt−1,

where {Zt} ∼ WN
(
0, σ 2

)
, then from (4.1.1),

f (λ) = σ 2

2π

(
1 + θ2 + θ (e−iλ + eiλ

)) = σ 2

2π

(
1 + 2θ cos λ+ θ2) .

This function is shown in Figures 4-7 and 4-8 for the values θ = 0.9 and
θ = −0.9. Interpretations of the graphs analogous to those in Example 4.1.4 can
again be made.

�
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Figure 4-7
The spectral density
f(λ), 0 ≤ λ ≤ π , of

Xt = Zt + 0.9Zt−1 where
{Zt} ∼ WN
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Figure 4-8
The spectral density
f(λ), 0 ≤ λ ≤ π , of

Xt = Zt − 0.9Zt−1 where
{Zt} ∼ WN
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4.2 The Periodogram

If {Xt} is a stationary time series {Xt} with ACVF γ (·) and spectral density f (·), then
just as the sample ACVF γ̂ (·) of the observations {x1, . . . , xn} can be regarded as a
sample analogue of γ (·), so also can the periodogram In(·) of the observations be
regarded as a sample analogue of 2π f (·).

To introduce the periodogram, we consider the vector of complex numbers

x =

⎡

⎢
⎢
⎢
⎣

x1

x2
...

xn

⎤

⎥
⎥
⎥
⎦

∈ C
n,
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whereCn denotes the set of all column vectors with complex-valued components. Now
let ωk = 2πk/n, where k is any integer between −(n − 1)/2 and n/2 (inclusive), i.e.,

ωk = 2πk

n
, k = −

[
n − 1

2

]

, . . . ,
[n

2

]
, (4.2.1)

where [ y] denotes the largest integer less than or equal to y. We shall refer to the set Fn

of these values as the Fourier frequencies associated with sample size n, noting that
Fn is a subset of the interval (−π, π ]. Correspondingly, we introduce the n vectors

ek = 1√
n

⎡

⎢
⎢
⎢
⎣

eiωk

e2iωk

...

eniωk

⎤

⎥
⎥
⎥
⎦
, k = −

[
n − 1

2

]

, . . . ,
[n

2

]
. (4.2.2)

Now e1, . . . , en are orthonormal in the sense that

ej∗ek =
⎧
⎨

⎩

1, if j = k,

0, if j �= k,
(4.2.3)

where ej∗ denotes the row vector whose kth component is the complex conjugate of
the kth component of ej (see Problem 4.3). This implies that {e1, . . . , en} is a basis for
C

n, so that any x ∈ C
n can be expressed as the sum of n components,

x =
[n/2]∑

k=−[(n−1)/2]
akek. (4.2.4)

The coefficients ak are easily found by multiplying (4.2.4) on the left by ek∗ and using
(4.2.3). Thus,

ak = ek∗x = 1√
n

n∑

t=1

xte
−itωk . (4.2.5)

The sequence {ak} is called the discrete Fourier transform of the sequence
{x1, . . . , xn}.

Remark 1. The tth component of (4.2.4) can be written as

xt =
[n/2]∑

k=−[(n−1)/2]
ak[cos(ωkt)+ i sin(ωkt)], t = 1, . . . , n, (4.2.6)

showing that (4.2.4) is just a way of representing xt as a linear combination of sine
waves with frequencies ωk ∈ Fn. �

Definition 4.2.1 The periodogram of {x1, . . . , xn} is the function

In(λ) = 1

n

∣
∣
∣
∣
∣

n∑

t=1

xte
−itλ

∣
∣
∣
∣
∣

2

. (4.2.7)

Remark 2. If λ is one of the Fourier frequencies ωk, then In(ωk) = |ak|2, and so from
(4.2.4) and (4.2.3) we find at once that the squared length of x is
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n∑

t=1

|xt|2 = x∗x =
[n/2]∑

k=−[(n−1)/2]
|ak|2 =

[n/2]∑

k=−[(n−1)/2]
In(ωk).

The value of the periodogram at frequency ωk is thus the contribution to this sum of
squares from the “frequency ωk” term akek in (4.2.4). �

The next proposition shows that In(λ) can be regarded as a sample analogue of
2π f (λ). Recall that if

∑∞
h=−∞ |γ (h)| < ∞, then

2π f (λ) =
∞∑

h=−∞
γ (h)e−ihλ, λ ∈ (−π, π ]. (4.2.8)

Proposition 4.2.1 If x1, . . . , xn are any real numbers and ωk is any of the nonzero Fourier frequencies
2πk/n in (−π, π ], then

In(ωk) =
∑

|h|<n
γ̂ (h)e−ihωk, (4.2.9)

where γ̂ (h) is the sample ACVF of x1, . . . , xn.

Proof Since
∑n

t=1 e
−itωk = 0 if ωk �= 0, we can subtract the sample mean x̄ from xt in the

defining equation (4.2.7) of In(ωk). Hence,

In(ωk) = n−1
n∑

s=1

n∑

t=1

(xs − x̄)(xt − x̄)e−i(s−t)ωk

=
∑

|h|<n
γ̂ (h)e−ihωk . �

In view of the similarity between (4.2.8) and (4.2.9), a natural estimate of the
spectral density f (λ) is In(λ)/(2π). For a very large class of stationary time series
{Xt}with strictly positive spectral density, it can be shown that for any fixed frequencies
λ1, . . . , λm such that 0 < λ1 < · · · < λm < π , the joint distribution function
Fn(x1, . . . , xm) of the periodogram values (In(λ1), . . . , In(λm)) converges, as n → ∞,
to F(x1, . . . , xm), where

F(x1, . . . , xm) =

⎧
⎪⎨

⎪⎩

m∏

i=1

(

1 − exp

{ −xi
2π f (λi)

})

, if x1, . . . , xm > 0,

0, otherwise.

(4.2.10)

Thus for large n the periodogram ordinates (In(λ1), . . . , In(λm)) are approximately
distributed as independent exponential random variables with means 2π f (λ1), …,
2π f (λm), respectively. In particular, for each fixed λ ∈ (0, π) and ε > 0,

P[|In(λ)− 2π f (λ)| > ε] → p > 0, as n → ∞,
so the probability of an estimation error larger than ε cannot be made arbitrarily small
by choosing a sufficiently large sample size n. Thus, In(λ) is not a consistent estimator
of 2π f (λ).

Since for large n the periodogram ordinates at fixed frequencies are approximately
independent with variances changing only slightly over small frequency intervals, we
might hope to construct a consistent estimator of f (λ) by averaging the periodogram
estimates in a small frequency interval containing λ, provided that we can choose the
interval in such a way that its width decreases to zero while at the same time the number
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of Fourier frequencies in the interval increases to ∞ as n → ∞. This can indeed be
done, since the number of Fourier frequencies in any fixed frequency interval increases
approximately linearly with n. Consider, for example, the estimator

f̃ (λ) = 1

2π

∑

|j|≤m

(2m + 1)−1In(g(n, λ)+ 2π j/n), (4.2.11)

where m = √
n and g(n, λ) is the multiple of 2π/n closest to λ. The number of

periodogram ordinates being averaged is approximately 2
√
n, and the width of the

frequency interval over which the average is taken is approximately 4π/
√
n. It can be

shown (see Brockwell and Davis (1991), Section 11.4) that this estimator is consistent
for the spectral density f . The argument in fact establishes the consistency of a whole
class of estimators defined as follows.

Definition 4.2.2 A discrete spectral average estimator of the spectral density f (λ) has the form

f̂ (λ) = 1

2π

∑

| j|≤mn

Wn( j)In( g(n, λ)+ 2π j/n), (4.2.12)

where the bandwidths mn satisfy

mn → ∞ and mn/n → 0 as n → ∞, (4.2.13)

and the weight functionsWn(·) satisfy
Wn( j) = Wn(−j),Wn( j) ≥ 0 for all j, (4.2.14)
∑

| j|≤mn

Wn( j) = 1, (4.2.15)

and
∑

| j|≤mn

W2
n ( j) → 0 as n → ∞. (4.2.16)

Remark 3. The conditions imposed on the sequences {mn} and {Wn(·)} ensure
consistency of f̂ (λ) for f (λ) for a very large class of stationary processes
(see Brockwell and Davis (1991), Theorem 10.4.1) including all the ARMA
processes considered in this book. The conditions (4.2.13) simply mean that the
number of terms in the weighted average (4.2.12) goes to ∞ as n → ∞ while
at the same time the width of the frequency interval over which the average
is taken goes to zero. The conditions on {Wn(·)} ensure that the mean and
variance of f̂ (λ) converge as n → ∞ to f (λ) and 0, respectively. Under the
conditions of Brockwell and Davis (1991), Theorem 10.4.1, it can be shown, in
fact, that

lim
n→∞E f̂ (λ) = f (λ)

and

lim
n→∞

⎛

⎝
∑

| j|≤mn

W2
n ( j)

⎞

⎠

−1

Cov( f̂ (λ), f̂ (ν)) =

⎧
⎪⎨

⎪⎩

2f 2(λ) if λ = ν = 0 or π,

f 2(λ) if 0 < λ = ν < π,

0 if λ �= ν.

�
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Figure 4-9
The spectral density
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Example 4.2.1 For the simple moving average estimator with mn = √
n and Wn( j) = (2mn + 1)−1,

| j | ≤ mn, Remark 3 gives

(
2
√
n + 1

)
Var

(
f̂ (λ)

)
→

{
2f 2(λ) if λ = 0 or π,

f 2(λ) if 0 < λ < π.
�

In practice, when the sample size n is a fixed finite number, the choice of m and
{W(·)} involves a compromise between achieving small bias and small variance for
the estimator f̂ (λ). A weight function that assigns roughly equal weights to a broad
band of frequencies will produce an estimate of f (λ) that, although smooth, may have
a large bias, since the estimate of f (λ) depends on the values of In at frequencies distant
from λ. On the other hand, a weight function that assigns most of its weight to a narrow
frequency band centered at zero will give an estimator with relatively small bias, but
with a larger variance. In practice it is advisable to experiment with a range of weight
functions and to select the one that appears to strike a satisfactory balance between
bias and variance.

The option Spectrum>Smoothed Periodogram in the program ITSM
allows the user to apply up to 50 successive discrete spectral average filters with
weights W( j) = 1/(2m + 1), j = −m,−m + 1, . . . ,m, to the periodogram. The
value of m for each filter can be specified arbitrarily, and the weights of the filter
corresponding to the combined effect (the convolution of the component filters) is
displayed by the program. The program computes the corresponding discrete spectral
average estimators f̂ (λ), 0 ≤ λ ≤ π .

Example 4.2.2 The Sunspot Numbers, 1770–1869

Figure 4-9 displays a plot of (2π)−1 times the periodogram of the annual sunspot
numbers (obtained by opening the project SUNSPOTS.TSM in ITSM and selecting
Spectrum>Periodogram). Figure 4-10 shows the result of applying the discrete
spectral weights

{
1
3 ,

1
3 ,

1
3

}
(corresponding to m = 1,W( j ) = 1/(2m + 1), | j | ≤ m).

It is obtained from ITSM by selecting Spectrum>Smoothed Periodogram,
entering 1 for the number of Daniell filters, 1 for the order m, and clicking on Apply.
As expected, with such a small value of m, not much smoothing of the periodogram
occurs. If we change the number of Daniell filters to 2 and set the order of the first
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Figure 4-10
The spectral density

estimate, f̂(λ), 0 < λ ≤ π ,
of the sunspot numbers,
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Figure 4-11
The spectral density

estimate, f̂(λ), 0 < λ ≤ π ,
of the sunspot numbers,
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filter to 1 and the order of the second filter to 2, we obtain a combined filter with a
more dispersed set of weights, W(0) = W(1) = 3

15 , W(2) = 2
15 , W(3) = 1

15 .
Clicking on Applywill then give the smoother spectral estimate shown in Figure 4-11.
When you are satisfied with the smoothed estimate click OK, and the dialog box will
close. All three spectral density estimates show a well-defined peak at the frequency
ω10 = 2π/10 radians per year, in keeping with the suggestion from the graph of the
data itself that the sunspot series contains an approximate cycle with period around 10
or 11 years.

�

4.3 Time-Invariant Linear Filters

In Section 1.5 we saw the utility of time-invariant linear filters for smoothing the data,
estimating the trend, eliminating the seasonal and/or trend components of the data, etc.
A linear process is the output of a time-invariant linear filter (TLF) applied to a white
noise input series. More generally, we say that the process {Yt} is the output of a linear
filter C = {ct,k, t, k = 0 ± 1, . . .} applied to an input process {Xt} if
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Yt =
∞∑

k=−∞
ct, kXk, t = 0,±1, . . . . (4.3.1)

The filter is said to be time-invariant if the weights ct,t−k are independent of t, i.e., if

ct,t−k = ψk.

In this case,

Yt =
∞∑

k=−∞
ψkXt−k

and

Yt−s =
∞∑

k=−∞
ψkXt−s−k,

so that the time-shifted process {Yt−s, t = 0,±1, . . .} is obtained from {Xt−s, t =
0,±1, . . .} by application of the same linear filter � = {ψj, j = 0,±1, . . .}. The
TLF ψ is said to be causal if

ψj = 0 for j < 0,

since then Yt is expressible in terms only of Xs, s ≤ t.

Example 4.3.1 The filter defined by

Yt = aX−t, t = 0,±1, . . . ,

is linear but not time-invariant, since ct, t−k = 0 except when 2t = k. Thus, ct, t−k

depends on the value of t.
�

Example 4.3.2 The Simple Moving Average

The filter

Yt = (2q + 1)−1
∑

| j |≤q

Xt−j

is a TLF with ψj = (2q + 1)−1, j = −q, . . . , q, and ψj = 0 otherwise.
�

Spectral methods are particularly valuable in describing the behavior of time-
invariant linear filters as well as in designing filters for particular purposes such as
the suppression of high-frequency components. The following proposition shows how
the spectral density of the output of a TLF is related to the spectral density of the
input—a fundamental result in the study of time-invariant linear filters.

Proposition 4.3.1 Let {Xt} be a stationary time series with mean zero and spectral density fX(λ).
Suppose that � = {ψj, j = 0,±1, . . .} is an absolutely summable TLF (i.e.,∑∞

j=−∞ |ψj| < ∞). Then the time series

Yt =
∞∑

j=−∞
ψjXt−j

is stationary with mean zero and spectral density

fY(λ) = ∣
∣�

(
e−iλ

)∣
∣2 fX(λ) = �

(
e−iλ

)
�
(
eiλ
)
fX(λ),
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where �(e−iλ) = ∑∞
j=−∞ ψje−ijλ. (The function �

(
e−i·) is called the transfer

function of the filter, and the squared modulus
∣
∣�

(
e−i·)∣∣2 is referred to as the power

transfer function of the filter.)

Proof Applying Proposition 2.2.1, we see that {Yt} is stationary with mean 0 and ACVF

γY(h) =
∞∑

j,k=−∞
ψjψkγX(h + k − j). (4.3.2)

Since {Xt} has spectral density fX(λ), we have

γX(h + k − j) =
∫ π

−π
ei(h−j+k)λfX(λ) dλ, (4.3.3)

which, when substituted into (4.3.2), gives

γY(h) =
∞∑

j, k=−∞
ψjψk

∫ π

−π
ei(h−j+k)λ fX(λ) dλ

=
∫ π

−π

⎛

⎝
∞∑

j=−∞
ψje

−ijλ

⎞

⎠

( ∞∑

k=−∞
ψke

ikλ

)

eihλ fX(λ) dλ

=
∫ π

−π
eihλ

∣
∣
∣
∣
∣
∣

∞∑

j=−∞
ψje

−ijλ

∣
∣
∣
∣
∣
∣

2

fX(λ) dλ.

The last expression immediately identifies the spectral density function of {Yt} as
fY(λ) = ∣

∣ψ
(
e−iλ

)∣
∣2fX(λ) = ψ

(
e−iλ

)
ψ
(
eiλ
)
fX(λ). �

Remark 4. Proposition 4.3.1 allows us to analyze the net effect of applying one or
more filters in succession. For example, if the input process {Xt} with spectral density
fX is operated on sequentially by two absolutely summable TLFs �1 and �2, then
the net effect is the same as that of a TLF with transfer function ψ1

(
e−iλ

)
�2

(
e−iλ

)
and

the spectral density of the output process

Wt = ψ1(B)ψ2(B) Xt

is
∣
∣ψ1

(
e−iλ

)
ψ2
(
e−iλ

)∣
∣2 fX(λ). (See also Remark 2 of Section 2.2.) �

As we saw in Section 1.5, differencing at lag s is one method for removing a
seasonal component with period s from a time series. The transfer function for this
filter is 1 − e−isλ, which is zero for all frequencies that are integer multiples of 2π/s
radians per unit time. Consequently, this filter has the desired effect of removing all
components with period s.

The simple moving-average filter in Example 4.3.2 has transfer function

ψ
(
e−iλ

) = Dq(λ),
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Figure 4-12
The transfer function
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where Dq(λ) is the Dirichlet kernel

Dq(λ) = (2q + 1)−1
∑

| j|≤q

e−ijλ =
⎧
⎨

⎩

sin[(q + 0.5)λ]
(2q + 1) sin(λ/2)

, if λ �= 0,

1, if λ = 0.

A graph of Dq is given in Figure 4-12. Notice that |Dq(λ)| is near 1 in a neighborhood
of 0 and tapers off to 0 for large frequencies. This is an example of a low-pass filter.
The ideal low-pass filter would have a transfer function of the form

ψ(e−iλ) =

⎧
⎪⎨

⎪⎩

1, if |λ| ≤ ωc,

0, if |λ| > ωc,

where ωc is a predetermined cutoff value. To determine the corresponding linear filter,
we expand �

(
e−iλ

)
as a Fourier series,

ψ
(
e−iλ

) =
∞∑

j=−∞
ψje

−ijλ, (4.3.4)

with coefficients

ψj = 1

2π

∫ ωc

−ωc
eijλ dλ =

⎧
⎪⎨

⎪⎩

ωc

π
, if j = 0,

sin(jωc)

jπ
, if |j| > 0.

We can approximate the ideal low-pass filter by truncating the series in (4.3.4) at some
large value q, which may depend on the length of the observed input series. In Fig-
ure 4-13 the transfer function of the ideal low-pass filter with wc=π/4 is plotted with
the approximations �(q)

(
e−iλ

)=∑q
j=−q ψje−ijλ for q=2 and q=10. As can be seen in

the figure, the approximations do not mirror � very well near the cutoff value ωc and
behave like damped sinusoids for frequencies greater than ωc. The poor approximation
in the neighborhood of ωc is typical of Fourier series approximations to functions with
discontinuities, an effect known as theGibbs phenomenon. Convergence factors may
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Figure 4-13
The transfer function for the

ideal low-pass filter and
truncated Fourier

approximations �(q) for
q = 2,10 Frequency

0.0 0.5 1.0 1.5 2.0 2.5 3.0

−0
.2

0.
0

0.
2

0.
4

0.
6

0.
8

1.
0

1.
2

Ideal low-pass
q = 2
q = 10

be employed to help mitigate the overshoot problem at ωc and to improve the overall
approximation of �(q)

(
e−i·) to �

(
e−i·) (see Bloomfield 2000).

4.4 The Spectral Density of an ARMA Process

In Section 4.1 the spectral density was computed for an MA(1) and for an AR(1)
process. As an application of Proposition 4.3.1, we can now easily derive the spectral
density of an arbitrary ARMA(p, q) process.

Spectral Density of an ARMA(p,q) Process: If {Xt} is a causal ARMA(p, q)
process satisfying φ(B)Xt = θ(B)Zt, then

fX(λ) = σ 2

2π

∣
∣θ
(
e−iλ

)∣
∣2

∣
∣φ
(
e−iλ

)∣
∣2
, −π ≤ λ ≤ π. (4.4.1)

Because the spectral density of an ARMA process is a ratio of trigonometric polyno-
mials, it is often called a rational spectral density.

Proof From (3.1.3), {Xt} is obtained from {Zt} by application of the TLF with transfer
function

ψ
(
e−iλ

) = θ
(
e−iλ

)

φ
(
e−iλ

) .

Since {Zt} has spectral density fZ(λ) = σ 2/(2π), the result now follows from
Proposition 4.3.1. �

For any specified values of the parameters φ1, . . . , φp, θ1, . . . , θq and σ 2, the
Spectrum>Model option of ITSM can be used to plot the model spectral density.
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Figure 4-14
The spectral density

fX(λ),0 ≤ λ ≤ π of the
AR(2) model (3.2.20) fitted

to the mean-corrected
sunspot series Frequency
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Example 4.4.1 The Spectral Density of an AR(2) Process

For an AR(2) process (4.4.1) becomes

fX(λ) = σ 2

2π
(
1 − φ1e−iλ − φ2e−2iλ

)(
1 − φ1eiλ − φ2e2iλ

)

= σ 2

2π
(
1 + φ2

1 + 2φ2 + φ2
2 + 2(φ1φ2 − φ1) cos λ− 4φ2 cos2 λ

) .

Figure 4-14 shows the spectral density, found from the Spectrum>Model option
of ITSM, for the model (3.2.20) fitted to the mean-corrected sunspot series. Notice
the well-defined peak in the model spectral density. The frequency at which this peak
occurs can be found by differentiating the denominator of the spectral density with
respect to cos λ and setting the derivative equal to zero. This gives

cos λ = φ1φ2 − φ1

4φ2
= 0.849.

The corresponding frequency is λ = 0.556 radians per year, or equivalently
c = λ/(2π) = 0.0885 cycles per year, and the corresponding period is therefore
1/0.0885 = 11.3 years. Themodel thus reflects the approximate cyclic behavior of the
data already pointed out in Example 4.2.2. The model spectral density in Figure 4-14
should be compared with the rescaled periodogram of the data and the nonparametric
spectral density estimates of Figures 4-9, 4-10, and 4-11.

�

Example 4.4.2 The ARMA(1,1) Process

In this case the expression (4.4.1) becomes

fX(λ) = σ 2(1 + θeiλ)(1 + θe−iλ)

2π(1 − φeiλ)(1 − φe−iλ)

= σ 2(1 + θ2 + 2θ cos λ)

2π(1 + φ2 − 2φ cos λ)
. �
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4.4.1 Rational Spectral Density Estimation

An alternative to the spectral density estimator of Definition 4.2.2 is the estimator
obtained by fitting anARMAmodel to the data and then computing the spectral density
of the fitted model. The spectral density shown in Figure 4-14 can be regarded as such
an estimate, obtained by fitting an AR(2) model to the mean-corrected sunspot data.

Provided that there is an ARMA model that fits the data satisfactorily, this proce-
dure has the advantage that it can be made systematic by selecting the model according
(for example) to the AICC criterion (see Section 5.5.2). For further information see
Brockwell and Davis (1991), Section 10.6.

Problems

4.1 Show that
∫ π

−π
ei(k−h)λ dλ =

{
2π, if k = h,

0, otherwise.

4.2 If {Zt} ∼ WN
(
0, σ 2

)
, apply Corollary 4.1.1 to compute the spectral density of

{Zt}.
4.3 Show that the vectors e1, . . . , en are orthonormal in the sense of (4.2.3).

4.4 Use Corollary 4.1.1 to establish whether or not the following function is the
autocovariance function of a stationary process {Xt}:

γ (h) =

⎧
⎪⎪⎪⎪⎨

⎪⎪⎪⎪⎩

1 if h = 0,

−0.5 if h = ±2,

−0.25 if h = ±3,

0 otherwise.

4.5 If {Xt} and {Yt} are uncorrelated stationary processes with autocovariance func-
tions γX(·) and γY(·) and spectral distribution functions FX(·) and FY(·), respec-
tively, show that the process {Zt = Xt + Yt} is stationary with autocovariance
function γZ = γX + γY and spectral distribution function FZ = FX + FY .

4.6 Let {Xt} be the process defined by

Xt = A cos(π t/3)+ B sin(π t/3)+ Yt,

where Yt = Zt + 2.5Zt−1, {Zt} ∼ WN
(
0, σ 2

)
, A and B are uncorrelated with

mean 0 and variance ν2, and Zt is uncorrelated with A and B for each t. Find
the autocovariance function and spectral distribution function of {Xt}.

4.7 Let {Xt} denote the sunspot series filed as SUNSPOTS.TSM and let {Yt} denote
the mean-corrected series Yt = Xt − 46.93, t = 1, . . . , 100. Use ITSM to find
the Yule–Walker AR(2) model

Yt = φ1Yt−1 + φ2Yt−2 + Zt, {Zt} ∼ WN
(
0, σ 2

)
,

i.e., find φ1, φ2, and σ 2. Use ITSM to plot the spectral density of the fitted model
and find the frequency at which it achieves its maximum value. What is the
corresponding period?
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4.8 (a) Use ITSM to compute and plot the spectral density of the stationary series
{Xt} satisfying

Xt − 0.99Xt−3 = Zt, {Zt} ∼ WN(0, 1).

(b) Does the spectral density suggest that the sample paths of {Xt} will exhibit
approximately oscillatory behavior? If so, then with what period?

(c) Use ITSM to simulate a realization of X1, . . . ,X60 and plot the realization.
Does the graph of the realization support the conclusion of part (b)? Save the
generated series as X.TSM by clicking on the window displaying the
graph, then on the red EXP button near the top of the screen. Select Time
Series and File in the resulting dialog box and click OK. You will then
be asked to provide the file name, X.TSM.

(d) Compute the spectral density of the filtered process

Yt = 1

3
(Xt−1 + Xt + Xt+1)

and compare the numerical values of the spectral densities of {Xt} and {Yt}
at frequency ω = 2π/3 radians per unit time. What effect would you expect
the filter to have on the oscillations of {Xt}?

(e) Open the project X.TSM and use the option Smooth>Moving Ave.
to apply the filter of part (d) to the realization generated in part (c). Comment
on the result.

4.9 The spectral density of a real-valued time series {Xt} is defined on [0, π ] by

f (λ) =
{

100, if π/6 − 0.01 < λ < π/6 + 0.01,

0, otherwise,

and on [−π, 0] by f (λ) = f (−λ).

(a) Evaluate the ACVF of {Xt} at lags 0 and 1.

(b) Find the spectral density of the process {Yt} defined by

Yt := ∇12Xt = Xt − Xt−12.

(c) What is the variance of Yt?

(d) Sketch the power transfer function of the filter ∇12 and use the sketch to
explain the effect of the filter on sinusoids with frequencies (i) near zero and
(ii) near π/6.

4.10 Suppose that {Xt} is the noncausal and noninvertible ARMA(1,1) process sat-
isfying

Xt − φXt−1 = Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2) ,

where |φ| > 1 and |θ | > 1. Define φ̃(B) = 1 − 1
φ
B and θ̃ (B) = 1 + 1

θ
B and let

{Wt} be the process given by

Wt := θ̃−1(B)φ̃(B)Xt.
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(a) Show that {Wt} has a constant spectral density function.

(b) Conclude that {Wt} ∼ WN
(
0, σ 2

w

)
. Give an explicit formula for σ 2

w in terms
of φ, θ, and σ 2.

(c) Deduce that φ̃(B)Xt = θ̃ (B)Wt, so that {Xt} is a causal and invertible
ARMA(1,1) process relative to the white noise sequence {Wt}.



5 Modeling and Forecasting
with ARMA Processes

5.1 Preliminary Estimation
5.2 Maximum Likelihood Estimation
5.3 Diagnostic Checking
5.4 Forecasting
5.5 Order Selection

The determination of an appropriate ARMA(p, q) model to represent an observed
stationary time series involves a number of interrelated problems. These include
the choice of p and q (order selection) and estimation of the mean, the coefficients
{φi, i = 1, . . . , p}, {θi, i = 1, . . . , q}, and the white noise variance σ 2. Final
selection of the model depends on a variety of goodness of fit tests, although it can
be systematized to a large degree by use of criteria such as minimization of the
AICC statistic as discussed in Section 5.5. (A useful option in the program ITSM
is Model>Estimation>Autofit, which automatically minimizes the AICC
statistic over all ARMA(p, q) processes with p and q in a specified range.)

This chapter is primarily devoted to the problem of estimating the parameters
φ = (φi, . . . , φp), θ = (θi, . . . , θq), and σ 2 when p and q are assumed to be known,
but the crucial issue of order selection is also considered. It will be assumed throughout
(unless the mean is believed a priori to be zero) that the data have been “mean-
corrected” by subtraction of the sample mean, so that it is appropriate to fit a zero-mean
ARMAmodel to the adjusted data x1, . . . , xn. If the model fitted to the mean-corrected
data is

φ(B)Xt = θ(B)Zt, {Zt} ∼ WN
(
0, σ 2

)
,

then the corresponding model for the original stationary series {Yt} is found on
replacing Xt for each t by Yt − y, where y = n−1 ∑n

j=1 yj is the sample mean of the
original data, treated as a fixed constant.

When p and q are known, good estimators of φ and θ can be found by imagining
the data to be observations of a stationary Gaussian time series and maximizing
the likelihood with respect to the p + q + 1 parameters φ1, . . . , φp, θ1, . . . , θq

© Springer International Publishing Switzerland 2016
P.J. Brockwell, R.A. Davis, Introduction to Time Series and Forecasting,
Springer Texts in Statistics, DOI 10.1007/978-3-319-29854-2_5
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and σ 2. The estimators obtained by this procedure are known as maximum likelihood
(or maximum Gaussian likelihood) estimators. Maximum likelihood estimation is
discussed in Section 5.2 and can be carried out in practice using the ITSM option
Model>Estimation>Max likelihood, after first specifying a preliminary
model to initialize the maximization algorithm. Maximization of the likelihood and
selection of the minimum AICC model over a specified range of p and q values can
also be carried out using the option Model>Estimation>Autofit.

Themaximization is nonlinear in the sense that the function to bemaximized is not
a quadratic function of the unknown parameters, so the estimators cannot be found by
solving a system of linear equations. They are found instead by searching numerically
for the maximum of the likelihood surface. The algorithm used in ITSM requires the
specification of initial parameter values with which to begin the search. The closer the
preliminary estimates are to the maximum likelihood estimates, the faster the search
will generally be.

To provide these initial values, a number of preliminary estimation algorithms
are available in the option Model>Estimation>Preliminary of ITSM. They
are described in Section 5.1. For pure autoregressive models the choice is between
Yule-Walker and Burg estimation, while for models with q > 0 it is between the
innovations and Hannan–Rissanen algorithms. It is also possible to begin the search
with an arbitrary causal ARMA model by using the option Model>Specify and
entering the desired parameter values. The initial values are chosen automatically in
the option Model>Estimation>Autofit.

Calculation of the exact Gaussian likelihood for an ARMA model (and in fact for
any second-order model) is greatly simplified by use of the innovations algorithm. In
Section 5.2 we take advantage of this simplification in discussing maximum likelihood
estimation and consider also the construction of confidence intervals for the estimated
coefficients.

Section 5.3 deals with goodness of fit tests for the chosen model and Section 5.4
with the use of the fitted model for forecasting. In Section 5.5we discuss the theoretical
basis for some of the criteria used for order selection.

For an overview of the general strategy for model-fitting see Section 6.2.

5.1 Preliminary Estimation

In this section we shall consider four techniques for preliminary estimation of the
parameters φ = (φ1, . . . , φp)

′, θ = (θ1, . . . , φp)
′, and σ 2 from observations x1,. . ., xn

of the causal ARMA(p, q) process defined by

φ(B)Xt = θ(B)Zt, {Zt} ∼ WN
(
0, σ 2). (5.1.1)

The Yule–Walker and Burg procedures apply to the fitting of pure autoregressive
models. (Although the former can be adapted to models with q > 0, its performance is
less efficient than when q = 0.) The innovation and Hannan–Rissanen algorithms are
used in ITSM to provide preliminary estimates of the ARMA parameters when q > 0.

For pure autoregressive models Burg’s algorithm usually gives higher likelihoods
than the Yule–Walker equations. For pure moving-average models the innovations
algorithm frequently gives slightly higher likelihoods than the Hannan–Rissanen
algorithm (we use only the first two steps of the latter for preliminary estimation). For
mixed models (i.e., those with p > 0 and q > 0) the Hannan–Rissanen algorithm is
usually more successful in finding causal models (which are required for initialization
of the likelihood maximization).
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5.1.1 Yule–Walker Estimation

For a pure autoregressive model the moving-average polynomial θ(z) is identically 1,
and the causality assumption in (5.1.1) allows us to write Xt in the form

Xt =
∞∑

j=0

ψjZt−j, (5.1.2)

where, from Section 3.1,ψ(z) = ∑∞
j=0 ψjz j = 1/φ(z). Multiplying each side of (5.1.1)

by Xt−j, j = 0, 1, 2, . . . , p, taking expectations, and using (5.1.2) to evaluate the right-
hand side of the first equation, we obtain the Yule–Walker equations

�pφ = γp (5.1.3)

and

σ 2 = γ (0)− φ′γp, (5.1.4)

where �p is the covariance matrix [γ (i − j)]pi, j=1 and γp = (γ (1), . . . , γ (p))′. These
equations can be used to determine γ (0), . . . , γ (p) from σ 2 and φ.

On the other hand, if we replace the covariances γ (j), j = 0, . . . , p, appearing
in (5.1.3) and (5.1.4) by the corresponding sample covariances γ̂ ( j), we obtain a set
of equations for the so-called Yule–Walker estimators φ̂ and σ̂ 2 of φ and σ 2, namely,

�̂pφ̂ = γ̂p (5.1.5)

and

σ̂ 2 = γ̂ (0)− φ̂′γ̂p, (5.1.6)

where �̂p = [
γ̂ (i − j)

]p
i, j=1 and γ̂p = (

γ̂ (1), . . . , γ̂ (p)
)′
.

If γ̂ (0) > 0, then �̂m is nonsingular for every m = 1, 2, . . . (see Brockwell and
Davis (1991), Problem 7.11), so we can rewrite equations (5.1.5) and (5.1.6) in the
following form:

Sample Yule–Walker Equations:

φ̂ =
(
φ̂1, . . . , φ̂p

)′ = R̂−1
p ρ̂p (5.1.7)

and

σ̂ 2 = γ̂ (0)
[
1 − ρ̂′

pR̂
−1
p ρ̂p

]
, (5.1.8)

where ρ̂p = (
ρ̂(1), . . . , ρ̂(p)

)′ = γ̂p/γ̂ (0).

With φ̂ as defined by (5.1.7), it can be shown that 1 − φ̂1z − · · · − φ̂pzp �= 0 for
|z| ≤ 1 (see Brockwell and Davis (1991), Problem 8.3). Hence the fitted model

Xt − φ̂1Xt−1 − · · · − φ̂pXt−p = Zt, {Zt} ∼ WN
(
0, σ̂ 2

)

is causal. The autocovariances γF(h), h = 0, . . . , p, of the fitted model therefore satisfy
the p + 1 linear equations

γF(h)− φ̂1γF(h − 1)− · · · − φ̂pγF(h − p) =
{

0, h = 1, . . . , p,

σ̂ 2, h = 0.
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However, from (5.1.5) and (5.1.6) we see that the solution of these equations is γF(h) =
γ̂ (h), h = 0, . . . , p, so that the autocovariances of the fitted model at lags 0, 1, . . . , p
coincide with the corresponding sample autocovariances.

The argument of the preceding paragraph shows that for every nonsingular
covariance matrix of the form �p+1 = [γ (i− j)]p+1

i, j=1 there is an AR(p) process whose
autocovariances at lags 0, . . . , p are γ (0), . . . , γ (p). (The required coefficients and
white noise variance are found from (5.1.7) and (5.1.8) on replacing ρ̂(j) by γ (j)/γ (0),
j = 0, . . . , p, and γ̂ (0) by γ (0).) There may not, however, be an MA(p) process with
this property. For example, if γ (0) = 1 and γ (1) = γ (−1) = β, the matrix �2 is a
nonsingular covariance matrix for all β ∈ (−1, 1). Consequently, there is an AR(1)
process with autocovariances 1 and β at lags 0 and 1 for all β ∈ (−1, 1). However,
there is an MA(1) process with autocovariances 1 and β at lags 0 and 1 if and only if
|β| ≤ 1

2 . (See Example 2.1.1).

It is often the case that moment estimators, i.e., estimators that (like φ̂) are obt-
ained by equating theoretical and sample moments, have much higher variances than
estimators obtained by alternative methods such as maximum likelihood. However,
the Yule–Walker estimators of the coefficients φ1, . . . , φp of an AR( p) process have
approximately the same distribution for large samples as the corresponding maximum
likelihood estimators. For a precise statement of this result see Brockwell and Davis
(1991), Section 8.10. For our purposes it suffices to note the following:

Large-Sample Distribution of Yule–Walker Estimators:
For a large sample from an AR( p) process,

φ̂ ≈ N
(
φ, n−1σ 2�−1

p

)
.

If we replace σ 2 and �p by their estimates σ̂ 2 and �̂p, we can use this result to find
large-sample confidence regions for φ and each of its components as in (5.1.12) and
(5.1.13) below.

Order Selection
In practice we do not know the true order of the model generating the data. In fact, it
will usually be the case that there is no true ARmodel, in which case our goal is simply
to find one that represents the data optimally in some sense. Two useful techniques for
selecting an appropriate AR model are given below. The second is more systematic
and extends beyond the narrow class of pure autoregressive models.

• Some guidance in the choice of order is provided by a large-sample result (see
Brockwell and Davis (1991), Section 8.10), which states that if {Xt} is the causal
AR( p) process defined by (5.1.1) with {Zt} ∼ iid

(
0, σ 2

)
and if we fit a model with

orderm > p using the Yule–Walker equations, i.e., if we fit a model with coefficient
vector

φ̂m = R̂−1
m ρ̂m, m > p,

then the last component, φ̂mm, of the vector φ̂m is approximately normally dis-
tributed with mean 0 and variance 1/n. Notice that φ̂mm is exactly the sample partial
autocorrelation at lag m as defined in Section 3.2.3.

Now, we already know from Example 3.2.6 that for an AR( p), process the partial
autocorrelations φmm, m > p, are zero. By the result of the previous paragraph,
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if an AR( p) model is appropriate for the data, then the values φ̂kk, k > p, should
be compatible with observations from the distribution N(0, 1/n). In particular, for
k > p, φ̂kk will fall between the bounds ±1.96n−1/2 with probability close to 0.95.
This suggests using as a preliminary estimator of p the smallest value m such that∣
∣φ̂kk

∣
∣ < 1.96n−1/2 for k > m.

The program ITSM plots the sample PACF
{
φ̂mm,m = 1, 2, . . .

}
together with the

bounds ±1.96/
√
n. From this graph it is easy to read off the preliminary estimator

of p defined above.

• Amore systematic approach to order selection is to find the values of p and φp that
minimize the AICC statistic (see Section 5.5.2 below)

AICC = −2 ln L(φp, S(φp)/n)+ 2(p + 1)n/(n − p − 2),

where L is the Gaussian likelihood defined in (5.2.9) and S is defined in (5.2.11).
The Preliminary Estimation dialog box of ITSM (opened by pressing the
blue PRE button) allows you to search for the minimum AICC Yule–Walker (or
Burg) models by checking Find AR model with min AICC. This causes
the program to fit autoregressions of orders 0, 1, . . . , 27 and to return the model
with smallest AICC value.

Definition 5.1.1 The fitted Yule–Walker AR(m) model is

Xt − φ̂m1Xt−1 − · · · − φ̂mmXt−m = Zt, {Zt} ∼ WN
(
0, v̂m

)
, (5.1.9)

where

φ̂m =
(
φ̂m1, . . . , φ̂mm

)′ = R̂−1
m ρ̂m (5.1.10)

and

v̂m = γ̂ (0)
[
1 − ρ̂′

mR̂
−1
m ρ̂m

]
. (5.1.11)

For both approaches to order selection we need to fit AR models of gradually
increasing order to our given data. The problem of solving the Yule–Walker equations
with gradually increasing orders has already been encountered in a slightly different
context in Section 2.5.3, where we derived a recursive scheme for solving the
equations (5.1.3) and (5.1.4) with p successively taking the values 1, 2, . . . . Here we
can use exactly the same scheme (the Durbin–Levinson algorithm) to solve the Yule–
Walker equations (5.1.5) and (5.1.6), the only difference being that the covariances
in (5.1.3) and (5.1.4) are replaced by their sample counterparts. This is the algorithm
used by ITSM to perform the necessary calculations.

Confidence Regions for the Coefficients

Under the assumption that the order p of the fitted model is the correct value, we can
use the asymptotic distribution of φ̂p to derive approximate large-sample confidence
regions for the true coefficient vector φp and for its individual components φpj. Thus,
if χ2

1−α(p) denotes the (1 − α) quantile of the chi-squared distribution with p degrees
of freedom, then for large sample-size n the region

{

φ ∈ Rp :
(
φ̂p − φ

)′
�̂p

(
φ̂p − φ

)
≤ n−1v̂pχ

2
1−α(p)

}

(5.1.12)
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contains φp with probability close to (1 − α). (This follows from Problem A.7 and
the fact that

√
n
(
φ̂p − φp

)
is approximately normally distributed with mean 0 and

covariance matrix v̂p�̂−1
p .) Similarly, if �1−α denotes the (1 − α) quantile of the

standard normal distribution and v̂jj is the jth diagonal element of v̂p�̂−1
p , then for large

n the interval bounded by

φ̂pj ±�1−α/2n−1/2v̂1/2
jj (5.1.13)

contains φpj with probability close to (1 − α).

Example 5.1.1 The Dow Jones Utilities Index, Aug. 28–Dec. 18, 1972; DOWJ.TSM

The very slowly decaying positive sample ACF of the time series contained in the
file DOWJ.TSM this time series suggests differencing at lag 1 before attempting to
fit a stationary model. One application of the operator (1 − B) produces a new series
{Yt} with no obvious deviations from stationarity. We shall therefore try fitting an AR
process to this new series

Yt = Dt − Dt−1

using the Yule–Walker equations. There are 77 values of Yt, which we shall denote
by Y1, . . . ,Y77. (We ignore the unequal spacing of the original data resulting from
the five-day working week.) The sample autocovariances of the series y1, . . . , y77 are
γ̂ (0) = 0.17992, γ̂ (1) = 0.07590, γ̂ (2) = 0.04885, etc.

Applying the Durbin–Levinson algorithm to fit successively higher-order autore-
gressive processes to the data, we obtain

φ̂11 = ρ̂(1) = 0.4219,

v̂1 = γ̂ (0)
[
1 − ρ̂2(1)

] = 0.1479,

φ̂22 =
[
γ̂ (2)− φ̂11γ̂ (1)

]
/v̂1 = 0.1138,

φ̂21 = φ̂11 − φ̂11φ̂22 = 0.3739,

v̂2 = v̂1

[
1 − φ̂2

22

]
= 0.1460.

The sample ACF and PACF of the data can be displayed by pressing the second
yellow button at the top of the ITSM window. They are shown in Figures 5-1 and 5-2,
respectively. Also plotted are the bounds ±1.96/

√
77. Since the PACF values at lags

greater than 1 all lie between the bounds, the first order-selection criterion described
above indicates that we should fit an AR(1) model to the data set {Yt}. Unless we wish
to assume that {Yt} is a zero-mean process, we should subtract the sample mean from
the data before attempting to fit a (zero-mean) AR(1) model. When the blue PRE
(preliminary estimation) button at the top of the ITSM window is pressed, you will be
given the option of subtracting the mean from the data. In this case (as in most) click
Yes to obtain the new series

Xt = Yt − 0.1336.

You will then see the Preliminary Estimation dialog box. Enter 1 for the AR
order, zero for the MA order, select Yule-Walker, and click OK. We have already
computed φ̂11 and v̂1 above using the Durbin–Levinson algorithm. The Yule–Walker
AR(1) model obtained by ITSM for {Xt} is therefore (not surprisingly)

Xt − 0.4219Xt−1 = Zt, {Zt} ∼ WN(0, 0.1479), (5.1.14)
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Figure 5-1
The sample ACF of

the differenced series
{Yt} in Example 5.1.1 Lag 
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Figure 5-2
The sample PACF of

the differenced series
{Yt} in Example 5.1.1 Lag
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and the corresponding model for {Yt} is

Yt − 0.1336 − 0.4219(Yt−1 − 0.1336) = Zt, {Zt} ∼ WN(0, 0.1479).

(5.1.15)

Assuming that our observed data really are generated by an AR process with
p = 1, (5.1.13) gives us approximate 95% confidence bounds for the autoregressive
coefficient φ,

0.4219 ± (1.96)(0.1479)1/2

(0.17992)1/2
√

77
= (0.2194, 0.6244).

Besides estimating the autoregressive coefficients, ITSM computes and prints out
the ratio of each coefficient to 1.96 times its estimated standard deviation. From these
numbers large-sample 95% confidence intervals for each of the coefficients are easily
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obtained. In this particular example there is just one coefficient estimate, φ̂1 = 0.4219,
with ratio of coefficient to 1.96×standard error equal to 2.0832. Hence the required
95% confidence bounds are 0.4219 ± 0.4219/2.0832 = (0.2194, 0.6244), as found
above.

A useful technique for preliminary autoregressive estimation that incorporates
automatic model selection (i.e., choice of p) is to minimize the AICC [see equa-
tion (5.5.4)] over all fitted autoregressions of orders 0 through 27. This is achieved
by selecting both Yule-Walker and Find AR model with min AICC in the
Preliminary Estimation dialog box. (The MA order must be set to zero, but
the AR order setting is immaterial.) Click OK, and the program will search through
all the Yule–Walker AR(p) models, p = 0, 1, . . . , 27, selecting the one with smallest
AICC value. The minimum-AICC Yule–Walker AR model turns out to be the one
defined by (5.1.14) with p = 1 and AICC value 74.541.

�

Yule–Walker Estimation with q > 0; Moment Estimators

The Yule–Walker estimates for the parameters in an AR(p) model are examples
of moment estimators: The autocovariances at lags 0, 1, . . . , p are replaced by the
corresponding sample estimates in the Yule–Walker equations (5.1.3), which are then
solved for the parameters φ = (φ1, . . . , φp)

′ and σ 2. The analogous procedure
for ARMA( p, q) models with q > 0 is easily formulated, but the corresponding
equations are nonlinear in the unknown coefficients, leading to possible nonexistence
and nonuniqueness of solutions for the required estimators.

From (3.2.5), the equations to be solved for φ1, . . . , φp, θ1, . . . , θq and σ 2 are

γ̂ (k)− φ1γ̂ (k − 1)− · · · − φpγ̂ (k − p) = σ 2
q∑

j=k

θjψj−k, 0 ≤ k ≤ p + q,

(5.1.16)

where ψj must first be expressed in terms of φ and θ using the identity ψ(z) =
θ(z)/φ(z) (θ0 := 1 and θj = ψj = 0 for j < 0).

Example 5.1.2 For the MA(1) model the equation (5.1.16) are equivalent to

γ̂ (0) = σ̂ 2
(

1 + θ̂2
1

)
, (5.1.17)

ρ̂(1) = θ̂1

1 + θ̂2
1

. (5.1.18)

If
∣
∣ρ̂(1)

∣
∣ > 0.5, there is no real solution, so we define θ̂1 = ρ̂(1)/

∣
∣ρ̂(1)

∣
∣. If

∣
∣ρ̂(1)

∣
∣ ≤

0.5, then the solution of (5.1.17)–(5.1.18) (with |θ̂ | ≤ 1) is

θ̂1 =
(

1 − (
1 − 4ρ̂2(1)

)1/2
)
/
(
2ρ̂(1)

)
,

σ̂ 2 = γ̂ (0)/
(

1 + θ̂2
1

)
.

For the overshort data of Example 3.2.8, ρ̂(1) = −0.5035 and γ̂ (0) = 3416, so the
fitted MA(1) model has parameters θ̂1 = −1.0 and σ̂ 2 = 1708.

�
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Relative Efficiency of Estimators
The performance of two competing estimators is often measured by computing their
asymptotic relative efficiency. In a general statistics estimation problem, suppose θ̂ (1)n

and θ̂ (2)n are two estimates of the parameter θ in the parameter space � based on the
observations X1, . . . ,Xn. If θ̂ (i)n is approximately N

(
θ, σ 2

i (θ)
)
for large n, i = 1, 2, then

the asymptotic efficiency of θ̂ (1)n relative to θ̂ (2)n is defined to be

e
(
θ, θ̂ (1), θ̂ (2)

)
= σ 2

2 (θ)

σ 2
1 (θ)

.

If e
(
θ, θ̂ (1), θ̂ (2)

) ≤ 1 for all θ ∈ �, then we say that θ̂ (2)n is a more efficient estimator

of θ than θ̂ (1)n (strictly more efficient if in addition, e
(
θ, θ̂ (1), θ̂ (2)

)
< 1 for some θ ∈

�). For the MA(1) process the moment estimator θ(1)n discussed in Example 5.1.2 is
approximately N

(
θ1, σ

2
1 (θ1)/n

)
with

σ 2
1

(
θ1) = (1 + θ2

1 + 4θ4
1 + θ6

1 + θ8
1

)
/
(
1 − θ2

1

)2

(see Brockwell and Davis (1991), p. 254). On the other hand, the innovations estimator
θ̂ (2)n discussed in the next section is distributed approximately as N

(
θ1, n−1

)
. Thus,

e
(
θ1, θ̂

(1), θ̂ (2)
) = σ−2

1 (θ1) ≤ 1 for all |θ1| < 1, with strict inequality when θ �= 1. In
particular,

e
(
θ1, θ̂

(1), θ̂ (2)
)

=

⎧
⎪⎨

⎪⎩

0.82, θ1 = 0.25,

0.37, θ1 = 0.50,

0.06, θ1 = 0.75,

demonstrating the superiority, at least in terms of asymptotic relative efficiency, of θ̂ (2)n

over θ̂ (1)n . On the other hand (Section 5.2), the maximum likelihood estimator θ̂ (3)n of
θ1 is approximately N(θ1, (1 − θ2

1 )/n). Hence,

e
(
θ1, θ̂

(2), θ̂ (3)
)

=

⎧
⎪⎨

⎪⎩

0.94, θ1 = 0.25,

0.75, θ1 = 0.50,

0.44, θ1 = 0.75.

While θ̂ (3)n is more efficient, θ̂ (2)n has reasonably good efficiency, except when |θ1| is
close to 1, and can serve as initial value for the nonlinear optimization procedure in
computing the maximum likelihood estimator.

While the method of moments is an effective procedure for fitting autoregressive
models, it does not perform as well for ARMA models with q > 0. From a computa-
tional point of view, it requires asmuch computing time as themore efficient estimators
based on either the innovations algorithm or the Hannan–Rissanen procedure and is
therefore rarely used except when q = 0.

5.1.2 Burg’s Algorithm

The Yule–Walker coefficients φ̂p1, . . . , φ̂pp are precisely the coefficients of the best
linear predictor of Xp+1 in terms of {Xp, . . . , X1} under the assumption that the ACF
of {Xt} coincides with the sample ACF at lags 1, . . . , p.

Burg’s algorithm estimates the PACF {φ11, φ22, . . .} by successively minimizing
sums of squares of forward and backward one-step prediction errors with respect to the
coefficients φii. Given observations {x1, . . . , xn} of a stationary zero-mean time series
{Xt} we define ui(t), t = i + 1, . . . , n, 0 ≤ i < n, to be the difference between
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xn+1+i−t and the best linear estimate of xn+1+i−t in terms of the preceding i observations.
Similarly, we define vi(t), t = i + 1, . . . , n, 0 ≤ i < n, to be the difference between
xn+1−t and the best linear estimate of xn+1−t in terms of the subsequent i observations.
Then it can be shown (see Problem 5.6) that the forward and backward prediction
errors {ui(t)} and {vi(t)} satisfy the recursions

u0(t) = v0(t) = xn+1−t,

ui(t) = ui−1(t − 1)− φiivi−1(t), (5.1.19)

and

vi(t) = vi−1(t)− φiiui−1(t − 1). (5.1.20)

Burg’s estimate φ(B)11 of φ11 is found by minimizing

σ 2
1 := 1

2(n − 1)

n∑

t=2

[
u2

1(t)+ v2
1(t)

]

with respect to φ11. This gives corresponding numerical values for u1(t) and v1(t) and
σ 2

1 that can then be substituted into (5.1.19) and (5.1.20) with i = 2. Then weminimize

σ 2
2 := 1

2(n − 2)

n∑

t=3

[
u2

2(t)+ v2
2(t)

]

with respect to φ22 to obtain the Burg estimate φ(B)22 of φ22 and corresponding values
of u2(t), v2(t), and σ 2

2 . This process can clearly be continued to obtain estimates φ(B)pp

and corresponding minimum values, σ (B)2p , p ≤ n − 1. Estimates of the coefficients
φpj, 1 ≤ j ≤ p − 1, in the best linear predictor

PpXp+1 = φp1Xp + · · · + φppX1

are then found by substituting the estimates φ(B)ii , i = 1, . . . , p, for φii in the recursions
(2.5.20)–(2.5.22). The resulting estimates of φpj, j = 1, . . . , p, are the coefficient
estimates of the Burg AR(p) model for the data {x1, . . . , xn}. The Burg estimate of the
white noise variance is the minimum value σ (B)2p found in the determination of φ(B)pp .
The calculation of the estimates of φpp and σ 2

p described above is equivalent (Problem
5.7) to solving the following recursions:

Burg’s Algorithm:

d(1) =
n∑

t=2

(u2
0(t − 1)+ v2

0(t)),

φ
(B)
ii = 2

d(i)

n∑

t=i+1

vi−1(t)ui−1(t − 1),

d(i + 1) =
(

1 − φ(B)2ii

)
d(i) − v2

i (i + 1)− u2
i (n),

σ
(B)2
i =

[(
1 − φ(B)2ii

)
d(i)

]
/[2(n − i)].
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The large-sample distribution of the estimated coefficients for the Burg estimators
of the coefficients of an AR(p) process is the same as for the Yule–Walker estimators,
namely, N

(
φ, n−1σ 2�−1

p

)
. Approximate large-sample confidence intervals for the

coefficients can be found as in Section 5.1.1 by substituting estimated values for σ 2

and �p.

Example 5.1.3 The Dow Jones Utilities Index

The fitting of AR models using Burg’s algorithm in the program ITSM is completely
analogous to the use of the Yule–Walker equations. Applying the same transformations
as in Example 5.1.1 to the Dow Jones Utilities Index and selecting Burg instead
of Yule-Walker in the Preliminary Estimation dialog box, we obtain the
minimum AICC Burg model

Xt − 0.4371Xt−1 = Zt, {Zt} ∼ WN(0, 0.1423), (5.1.21)

with AICC = 74.492. This is slightly different from the Yule–Walker AR(1) model
fitted in Example 5.1.1, and it has a larger likelihood L, i.e., a smaller value of
−2 ln L (see Section 5.2). Although the two methods give estimators with the same
large-sample distributions, for finite sample sizes the Burg model usually has smaller
estimated white noise variance and larger Gaussian likelihood. From the ratio of the
estimated coefficient to (1.96× standard error) displayed by ITSM,we obtain the 95%
confidence bounds for φ: 0.4371 ± 0.4371/2.1668 = (0.2354, 0.6388).

�

Example 5.1.4 The Lake Data

This series {Yt, t = 1, . . . , 98} has already been studied in Example 1.3.5. In this
example we shall consider the problem of fitting an AR process directly to the data
without first removing any trend component. A graph of the data was displayed in
Figure 1-9. The sample ACF and PACF are shown in Figures 5-3 and 5-4, respectively.

The sample PACF shown in Figure 5-4 strongly suggests fitting an AR(2) model
to the mean-corrected data Xt = Yt − 9.0041. After clicking on the blue preliminary
estimation button of ITSM select Yes to subtract the sample mean from {Yt}. Then

Figure 5-3
The sample ACF of the lake

data in Example 5.1.4 Lag
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Figure 5-4
The sample PACF of the

lake data in Example 5.1.4 Lag 
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specify 2 for the AR order, 0 for the MA order, and Burg for estimation. Click OK to
obtain the model

Xt − 1.0449Xt−1 + 0.2456Xt−2 = Zt, {Zt} ∼ WN(0, 0.4706),

with AICC value 213.55 and 95% confidence bounds

φ1 : 1.0449 ± 1.0449/5.5295 = (0.8559, 1.2339),

φ2 : −0.2456 ± 0.2456/1.2997 = (−0.4346,−0.0566).

Selecting the Yule–Walker method for estimation, we obtain the model

Xt − 1.0538Xt−1 + 0.2668Xt−2 = Zt, {Zt} ∼ WN(0, 0.4920),

with AICC value 213.57 and 95% confidence bounds

φ1 : 1.0538 ± 1.0538/5.5227 = (0.8630, 1.2446),

φ2 : −0.2668 ± 0.2668/1.3980 = (−0.4576,−0.0760).

We notice, as in Example 5.1.3, that the Burg model again has smaller white noise
variance and larger Gaussian likelihood than the Yule–Walker model.

If we determine the minimum AICC Yule–Walker and Burg models, we find that
they are both of order 2. Thus the order suggested by the sample PACF coincides again
with the order obtained by AICC minimization.

�

5.1.3 The Innovations Algorithm

Just as we can fit autoregressive models of orders 1, 2, . . . to the data {x1, . . . , xn} by
applying the Durbin–Levinson algorithm to the sample autocovariances, we can also
fit moving average models

Xt = Zt + θ̂m1Zt−1 + · · · + θ̂mmZt−m, {Zt} ∼ WN
(
0, v̂m

)
(5.1.22)

of orders m = 1, 2, . . . by means of the innovations algorithm (Section 2.5.4). The
estimated coefficient vectors θ̂m := (

θ̂m1, . . . , θ̂mm
)′

and white noise variances v̂m,
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m = 1, 2, . . ., are specified in the following definition. (The justification for using
estimators defined in this way is contained in Remark 1 following the definition.)

Definition 5.1.2 The fitted innovations MA(m) model is

Xt = Zt + θ̂m1Zt−1 + · · · + θ̂mmZt−m, {Zt} ∼ WN(0, v̂m),

where θ̂m and v̂m are obtained from the innovations algorithm with the ACVF
replaced by the sample ACVF.

Remark 1. It can be shown (see Brockwell and Davis 1988) that if {Xt} is an invertible
MA(q) process

Xt = Zt + θ1Zt−1 + · · · + θqZt−q, {Zt} ∼ IID
(
0, σ 2) ,

with EZ4
t < ∞, and if we define θ0 = 1 and θj = 0 for j > q, then the innovation

estimates have the following large-sample properties. If n → ∞ and m(n) is any
sequence of positive integers such that m(n) → ∞ but n−1/3m(n) → 0, then for each
positive integer k the joint distribution function of

n1/2
(
θ̂m1 − θ1, θ̂m2 − θ2, . . . , θ̂mk − θk

)′

converges to that of the multivariate normal distribution with mean 0 and covariance
matrix A = [aij]ki, j=1, where

aij =
min(i, j)∑

r=1

θi−rθj−r. (5.1.23)

This result enables us to find approximate large-sample confidence intervals for the
moving-average coefficients from the innovation estimates as described in the exam-
ples below. Moreover, the estimator v̂m is consistent for σ 2 in the sense that for every
ε > 0, P

(∣
∣v̂m − σ 2

∣
∣ > ε

) → 0 as m → ∞. �

Remark 2. Although the recursive fitting of moving-average models using the inno-
vations algorithm is closely analogous to the recursive fitting of autoregressive models
using the Durbin–Levinson algorithm, there is one important distinction. For an
AR(p) process the Yule–Walker and Burg estimators φ̂p are consistent estimators of
(φ1, . . . , φp)

′ as the sample size n → ∞. However, for anMA(q) process the estimator
θ̂q = (θq1, . . . , θqq)

′ is not consistent for (θ1, . . . , θq)
′. For consistency it is necessary

to use the estimators (θm1, . . . , θmq)
′ with m(n) satisfying the conditions of Remark 1.

The choice of m for any fixed sample size can be made by increasing m until the vector
(θm1, . . . , θmq)

′ stabilizes. It is found in practice that there is a large range of values of
m for which the fluctuations in θmj are small compared with the estimated asymptotic

standard deviation n−1/2
(∑j−1

i=0 θ̂
2
mi

)1/2
as found from (5.1.23) when the coefficients θj

are replaced by their estimated values θ̂mj. �

Order Selection
Three useful techniques for selecting an appropriate MA model are given below. The
third is more systematic and extends beyond the narrow class of pure moving-average
models.
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• We know from Section 3.2.2 that for an MA(q) process the autocorrelations ρ(m),
m > q, are zero. Moreover, we know from Bartlett’s formula (Section 2.4) that the
sample autocorrelation ρ̂(m), m > q, is approximately normally distributed with
mean ρ(m) = 0 and variance n−1

[
1 + 2ρ2(1)+ · · · + 2ρ2(q)

]
. This result enables

us to use the graph of ρ̂(m), m = 1, 2, . . . , both to decide whether or not a given
data set can be plausibly modeled by a moving-average process and also to obtain
a preliminary estimate of the order q as the smallest value of m such that ρ̂(k) is not
significantly different from zero for all k > m. For practical purposes “significantly
different from zero” is often interpreted as “larger than 1.96/

√
n in absolute value”

(cf. the corresponding approach to order selection for AR models based on the
sample PACF and described in Section 5.1.1).

• If in addition to examining ρ̂(m), m = 1, 2, . . ., we examine the coefficient vectors
θ̂m, m = 1, 2, . . . , we are able not only to assess the appropriateness of a moving-
average model and estimate its order q, but at the same time to obtain preliminary
estimates θ̂m1, . . . , θ̂mq of the coefficients. By inspecting the estimated coefficients
θ̂m1, . . . , θ̂mm for m = 1, 2, . . . and the ratio of each coefficient estimate θ̂mj to

1.96 times its approximate standard deviation σj = n−1/2
[∑j−1

i=0 θ̂
2
mi

]1/2
, we can

see which of the coefficient estimates are most significantly different from zero,
estimate the order of the model to be fitted as the largest lag j for which the ratio is
larger than 1 in absolute value, and at the same time read off estimated values for
each of the coefficients. A default value of m is set by the program, but it may be
altered manually. As m is increased the values θ̂m1, . . . , θ̂mm stabilize in the sense
that the fluctuations in each component are of order n−1/2, the asymptotic standard
deviation of θm1.

• As for autoregressive models, a more systematic approach to order selection for
moving-average models is to find the values of q and θ̂q = (

θ̂m1, . . . , θ̂mq
)′
that

minimize the AICC statistic

AICC = −2 ln L(θq, S(θq)/n)+ 2(q + 1)n/(n − q − 2),

where L is the Gaussian likelihood defined in (5.2.9) and S is defined in (5.2.11).
(See Section 5.5 for further details.)

Confidence Regions for the Coefficients
Asymptotic confidence regions for the coefficient vector θq and for its individual
components can be found with the aid of the large-sample distribution specified in
Remark 1. For example, approximate 95% confidence bounds for θj are given by

θ̂mj ± 1.96n−1/2

(
j−1∑

i=0

θ̂2
mi

)1/2

. (5.1.24)

Example 5.1.5 The Dow Jones Utilities Index

In Example 5.1.1 we fitted an AR(1) model to the differenced Dow Jones Utilities
Index. The sample ACF of the differenced data shown in Figure 5-1 suggests that
an MA(2) model might also provide a good fit to the data. To apply the innovation
technique for preliminary estimation, we proceed as in Example 5.1.1 to difference
the series DOWJ.TSM to obtain observations of the differenced series {Yt}. We then
select preliminary estimation by clicking on the blue PRE button and subtract the mean
of the differences to obtain observations of the differenced and mean-corrected series
{Xt}. In the Preliminary Estimation dialog box enter 0 for the AR order and
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2 for the MA order, and select Innovations as the estimation method. We must
then specify a value of m, which is set by default in this case to 17. If we accept the
default value, the program will compute θ̂17,1, . . . , θ̂17,17 and print out the first two
values as the estimates of θ1 and θ2, together with the ratios of the estimated values to
their estimated standard deviations. These are

MA COEFFICIENT
0.4269 0.2704

COEFFICIENT/(1.96*STANDARD ERROR)
1.9114 1.1133

The remaining parameter in the model is the white noise variance, for which two
estimates are given:

WN VARIANCE ESTIMATE = (RESID SS)/N
0.1470

INNOVATION WN VARIANCE ESTIMATE
0.1122

The first of these is the average of the squares of the rescaled one-step prediction errors
under the fitted MA(2) model, i.e., 1

77

∑77
j=1

(
Xj − X̂j

)2
/rj−1. The second value is the

innovation estimate, v̂17. (By default ITSM retains the first value. If you wish instead
to use the innovation estimate, you must change the white noise variance by selecting
Model>Specify and setting the white noise value to the desired value.) The fitted
model for Xt(= Yt − 0.1336) is thus

Xt = Zt + 0.4269Zt−1 + 0.2704Zt−2, {Zt} ∼ WN(0, 0.1470),

with AICC = 77.467.
To see all 17 estimated coefficients θ̂17, j, j = 1, . . . , 17, we repeat the preliminary

estimation, this time fitting an MA(17) model withm= 17. The coefficients and ratios
for the resulting model are found to be as follows:

MA COEFFICIENT
0.4269 0.2704 0.1183 0.1589 0.1355 0.1568 0.1284 −0.0060
0.0148 −0.0017 0.1974 −0.0463 0.2023 0.1285 −0.0213 −0.2575
0.0760

COEFFICIENT/(1.96*STANDARD ERROR)
1.9114 1.1133 0.4727 0.6314 0.5331 0.6127 0.4969 −0.0231
0.0568 −0.0064 0.7594 −0.1757 0.7667 0.4801 −0.0792 −0.9563
0.2760

The ratios indicate that the estimated coefficients most significantly different from zero
are the first and second, reinforcing our original intention of fitting anMA(2) model to
the data. Estimated coefficients θ̂mj for other values of m can be examined in the same
way, and it is found that the values obtained for m > 17 change only slightly from the
values tabulated above.

By fitting MA(q)models of orders 0, 1, 2, . . . , 26 using the innovations algorithm
with the default settings for m, we find that the minimum AICC model is the one with
q = 2 found above. Thus the model suggested by the sample ACF again coincides
with the more systematically chosen minimum AICC model.

�
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Innovations Algorithm Estimates when p > 0 and q > 0
The causality assumption (Section 3.1) ensures that

Xt =
∞∑

j=0

ψjZt−j,

where the coefficients ψj satisfy

ψj = θj +
min(j, p)∑

i=1

φiψj−i, j = 0, 1, . . . , (5.1.25)

and we define θ0 := 1 and θj := 0 for j > q. To estimate ψ1, . . . , ψp+q we can use
the innovation estimates θ̂m1, . . . , θ̂m,p+q, whose large-sample behavior is specified in
Remark 1. Replacing ψj by θ̂mj in (5.1.25) and solving the resulting equations

θ̂mj = θj +
min(j,p)∑

i=1

φiθ̂m,j−i, j = 1, . . . , p + q, (5.1.26)

for φ and θ, we obtain initial parameter estimates φ̂ and θ̂. To solve (5.1.26) we first
find φ from the last q equations:

⎡

⎢
⎢
⎢
⎣

θ̂m,q+1

θ̂m,q+2
...

θ̂m,q+p

⎤

⎥
⎥
⎥
⎦

=

⎡

⎢
⎢
⎢
⎣

θ̂mq θ̂m,q−1 · · · θ̂m,q+1−p

θ̂m,q+1 θ̂m,q · · · θ̂m,q+2−p
...

...
...

θ̂m,q+p−1 θ̂m,q+p−2 · · · θ̂m,q

⎤

⎥
⎥
⎥
⎦

⎡

⎢
⎢
⎢
⎣

φ1

φ2
...

φp

⎤

⎥
⎥
⎥
⎦
. (5.1.27)

Having solved (5.1.27) for φ̂ (which may not be causal), we can easily determine the
estimate of θ from

θ̂j = θ̂mj −
min(j, p)∑

i=1

φ̂iθ̂m, j−i, j = 1, . . . , q.

Finally, the white noise variance σ 2 is estimated by

σ̂ 2 = n−1
n∑

t=1

(
Xt − X̂t

)2
/rt−1,

where X̂t is the one-step predictor of Xt computed from the fitted coefficient vectors φ̂
and θ̂, and rt−1 is defined in (3.3.8).

The above calculations can all be carried out by selecting the ITSMoption Model>
Estimation>Preliminary. This option also computes, if p = q, the ratio of
each estimated coefficient to 1.96 times its estimated standard deviation. Approximate
95% confidence intervals can therefore easily be obtained in this case. If the fitted
model is noncausal, it cannot be used to initialize the search for the maximum
likelihood estimators, and so the autoregressive coefficients should be set to some
causal values (e.g., all equal to 0.001) using the Model>Specifyoption. If both the
innovation and Hannan–Rissanen algorithms give noncausal models, it is an indication
(but not a conclusive one) that the assumed values of p and q may not be appropriate
for the data.
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Order Selection for Mixed Models
For models with p > 0 and q > 0, the sample ACF and PACF are difficult to recognize
and are of far less value in order selection than in the special cases where p = 0 or
q = 0. A systematic approach, however, is still available through minimization of the
AICC statistic

AICC = −2 ln L(φp,θq, S(φp,θq)/n)+ 2(p + q + 1)n/(n − p − q − 2),

which is discussed in more detail in Section 5.5. For fixed p and q it is clear from the
definition that the AICC value is minimized by the parameter values that maximize the
likelihood. Hence, final decisions regarding the orders p and q that minimize AICC
must be based on maximum likelihood estimation as described in Section 5.2.

Example 5.1.6 The Lake Data

In Example 5.1.4 we fitted AR(2) models to the mean-corrected lake data using the
Yule–Walker equations and Burg’s algorithm. If instead we fit an ARMA(1,1) model
using the innovations method in the option Model>Estimation>Preliminary
of ITSM (with the default value m = 17), we obtain the model

Xt − 0.7234Xt−1 = Zt + 0.3596Zt−1, {Zt} ∼ WN(0, 0.4757),

for the mean-corrected series Xt = Yt − 9.0041. The ratio of the two coefficient
estimates φ̂ and θ̂ to 1.96 times their estimated standard deviations are given by ITSM
as 3.2064 and 1.8513, respectively. The corresponding 95% confidence intervals are
therefore

φ : 0.7234 ± 0.7234/3.2064 = (0.4978, 0.9490),

θ : 0.3596 ± 0.3596/1.8513 = (0.1654, 0.5538).

It is interesting to note that the value of AICC for this model is 212.89, which is
smaller than the corresponding values for the Burg and Yule–Walker AR(2) mod-
els in Example 5.1.4. This suggests that an ARMA(1,1) model may be superior to
a pure autoregressive model for these data. Preliminary estimation of a variety of
ARMA( p, q) models shows that the minimum AICC value does in fact occur when
p = q = 1. (Before committing ourselves to this model, however, we need
to compare AICC values for the corresponding maximum likelihood models. We shall
do this in Section 5.2.)

�

5.1.4 The Hannan–Rissanen Algorithm

The defining equations for a causal AR(p) model have the form of a linear regression
model with coefficient vector φ = (φ1, . . . , φp)

′. This suggests the use of simple
least squares regression for obtaining preliminary parameter estimates when q = 0.
Application of this technique when q > 0 is complicated by the fact that in
the general ARMA(p, q) equations Xt is regressed not only on Xt−1, . . . , Xt−p, but also
on the unobserved quantities Zt−1, . . . ,Zt−q. Nevertheless, it is still possible to apply
least squares regression to the estimation of φ and θ by first replacing the unobserved
quantities Zt−1, . . . ,Zt−q in (5.1.1) by estimated values Ẑt−1, . . . , Ẑt−q. The parameters
φ and θ are then estimated by regressing Xt onto Xt−1, . . . ,Xt−p, Ẑt−1, . . . , Ẑt−q. These
are the main steps in the Hannan–Rissanen estimation procedure, which we now
describe in more detail.
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Step 1.A high-order AR(m)model (withm > max( p, q)) is fitted to the data using the
Yule–Walker estimates of Section 5.1.1. If

(
φ̂m1, . . . , φ̂mm

)′
is the vector of estimated

coefficients, then the estimated residuals are computed from the equations

Ẑt = Xt − φ̂m1Xt−1 − · · · − φ̂mmXt−m, t = m + 1, . . . , n.

Step 2. Once the estimated residuals Ẑt, t = m + 1, . . . , n, have been computed as
in Step 1, the vector of parameters, β = (

φ′,θ′)′ is estimated by least squares linear

regression of Xt onto
(
Xt−1, . . . , Xt−p, Ẑt−1, . . . , Ẑt−q

)
, t = m + 1 + q, . . . , n, i.e., by

minimizing the sum of squares

S(β) =
n∑

t=m+1+q

(
Xt − φ1Xt−1 − · · · − φpXt−p − θ1Ẑt−1 − · · · − θqẐt−q

)2

with respect to β. This gives the Hannan–Rissanen estimator

β̂ = (Z ′Z)−1Z ′Xn,

where Xn = (Xm+1+q, . . . ,Xn)
′ and Z is the (n − m − q)× (p + q) matrix

Z =

⎡

⎢
⎢
⎢
⎣

Xm+q Xm+q−1 · · · Xm+q+1−p Ẑm+q Ẑm+q−1 · · · Ẑm+1

Xm+q+1 Xm+q · · · Xm+q+2−p Ẑm+q+1 Ẑm+q · · · Ẑm+2
...

... · · · ...
...

... · · · ...

Xn−1 Xn−2 · · · Xn−p Ẑn−1 Ẑn−2 · · · Ẑn−q

⎤

⎥
⎥
⎥
⎦
.

(If p = 0, Z contains only the last q columns.) The Hannan–Rissanen estimate of the
white noise variance is

σ̂ 2
HR =

S
(
β̂
)

n − m − q
.

Example 5.1.7 The Lake Data

In Example 5.1.6 an ARMA(1,1) model was fitted to the mean corrected lake data
using the innovations algorithm. We can fit an ARMA(1,1) model to these data using
the Hannan–Rissanen estimates by selecting Hannan-Rissanen in the Preliminary
Estimation dialog box of ITSM. The fitted model is

Xt − 0.6961Xt−1 = Zt + 0.3788Zt−1, {Zt} ∼ WN(0, 0.4774),

for the mean-corrected series Xt = Yt−9.0041. (Two estimates of the white noise vari-
ance are computed in ITSM for the Hannan–Rissanen procedure, σ̂ 2

HR and
∑n

j=1(Xt −
X̂t−1)

2/n. The latter is the one retained by the program.) The ratios of the two co-
efficient estimates to 1.96 times their standard deviation are 4.5289 and 1.3120,
respectively. The corresponding 95% confidence bounds for φ and θ are

φ : 0.6961 ± 0.6961/4.5289 = (0.5424, 0.8498),

θ : 0.3788 ± 0.3788/1.3120 = (0.0901, 0.6675).

Clearly, there is little difference between this model and the one fitted using the
innovations method in Example 5.1.6. (The AICC values are 213.18 for the current
model and 212.89 for the model fitted in Example 5.1.6.)

�
Hannan and Rissanen include a third step in their procedure to improve the

estimates.
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Step 3. Using the estimate β̂ = (
φ̂1, . . . , φ̂p, θ̂1, . . . , θ̂q

)′
from Step 2, set

Z̃t =

⎧
⎪⎪⎨

⎪⎪⎩

0, if t ≤ max(p, q),

Xt −
p∑

j=1
φ̂jXt−j −

q∑

j=1
θ̂jZ̃t−j, if t > max(p, q).

Now for t = 1, . . . , n put

Vt =

⎧
⎪⎨

⎪⎩

0, if t ≤ max(p, q),
p∑

j=1
φ̂jVt−j + Z̃t, if t > max(p, q),

and

Wt =

⎧
⎪⎨

⎪⎩

0, if t ≤ max(p, q),

−
p∑

j=1
θ̂jWt−j + Z̃t, if t > max(p, q).

(Observe that both Vt andWt satisfy the AR recursions φ̂(B)Vt = Z̃t and θ̂ (B)Wt = Z̃t

for t = 1, . . . , n.) If β̂† is the regression estimate of β found by regressing Z̃t on
(Vt−1, . . . ,Vt−p,Wt−1, . . . ,Wt−q), i.e., if β̂† minimizes

S†(β) =
n∑

t=max(p,q)+1

⎛

⎝Z̃t −
p∑

j=1

βjVt−j −
q∑

k=1

βk+pWt−k

⎞

⎠

2

,

then the improved estimate of β is β̃ = β̂† + β̂. The new estimator β̃ then has the
same asymptotic efficiency as the maximum likelihood estimator. In ITSM, however,
we eliminate Step 3, using the model produced by Step 2 as the initial model for the
calculation (by numerical maximization) of the maximum likelihood estimator itself.

5.2 Maximum Likelihood Estimation

Suppose that {Xt} is a Gaussian time series with mean zero and autocovariance function
κ(i, j) = E(XiXj). Let Xn = (X1, . . . ,Xn)

′ and let X̂n = (X̂1, . . . , X̂n)
′, where X̂1 = 0

and X̂j = E(Xj|X1, . . . ,Xj−1) = Pj−1Xj, j ≥ 2. Let �n denote the covariance matrix
�n = E(XnX′

n), and assume that �n is nonsingular.
The likelihood of Xn is

L(�n) = (2π)−n/2(det�n)
−1/2 exp

(

−1

2
X′

n�
−1
n Xn

)

. (5.2.1)

As we shall now show, the direct calculation of det�n and �−1
n can be avoided by

expressing this in terms of the one-step prediction errors Xj − X̂j and their variances
vj−1, j = 1, . . . , n, both of which are easily calculated recursively from the innovations
algorithm (Section 2.5.4).

Let θij, j = 1, . . . , i; i = 1, 2, . . ., denote the coefficients obtained when the
innovations algorithm is applied to the autocovariance function κ of {Xt}, and let Cn

be the n × n lower triangular matrix defined in Section 2.5.4. From (2.5.27) we have
the identity



140 Chapter 5 Modeling and Forecasting with ARMA Processes

Xn = Cn

(
Xn − X̂n

)
. (5.2.2)

We also know from Remark 5 of Section 2.5.4 that the components of Xn − X̂n are
uncorrelated. Consequently, by the definition of vj,Xn−X̂n has the diagonal covariance
matrix

Dn = diag{v0, . . . , vn−1}.
From (5.2.2) and (A.2.5) we conclude that

�n = CnDnC
′
n. (5.2.3)

From (5.2.2) and (5.2.3) we see that

X′
n�

−1
n Xn =

(
Xn − X̂n

)′
D−1

n

(
Xn − X̂n

)
=

n∑

j=1

(
Xj − X̂j

)2
/vj−1 (5.2.4)

and

det�n = (detCn)
2(detDn) = v0v1 · · · vn−1. (5.2.5)

The likelihood (5.2.1) of the vector Xn therefore reduces to

L(�n) = 1
√
(2π)nv0 · · · vn−1

exp

⎧
⎨

⎩
−1

2

n∑

j=1

(
Xj − X̂j

)2
/vj−1

⎫
⎬

⎭
. (5.2.6)

If �n is expressible in terms of a finite number of unknown parameters β1, . . . , βr
(as is the case when {Xt} is an ARMA( p, q) process), the maximum likelihood
estimators of the parameters are those values that maximize L for the given data
set. When X1,X2, . . . ,Xn are iid, it is known, under mild assumptions and for n
large, that maximum likelihood estimators are approximately normally distributed
with variances that are at least as small as those of other asymptotically normally
distributed estimators (see, e.g., Lehmann 1983).

Even if {Xt} is not Gaussian, it still makes sense to regard (5.2.6) as a mea-
sure of goodness of fit of the model to the data, and to choose the parameters
β1, . . . , βr in such a way as to maximize (5.2.6). We shall always refer to the estimators
β̂1, . . . , β̂r so obtained as “maximum likelihood” estimators, even when {Xt} is not
Gaussian. Regardless of the joint distribution of X1, . . . ,Xn, we shall refer to (5.2.1)
and its algebraic equivalent (5.2.6) as the “likelihood” (or “Gaussian likelihood”)
of X1, . . . ,Xn. A justification for using maximum Gaussian likelihood estimators of
ARMA coefficients is that the large-sample distribution of the estimators is the same
for {Zt} ∼ IID

(
0, σ 2

)
, regardless of whether or not {Zt} is Gaussian (see Brockwell

and Davis (1991), Section 10.8).
The likelihood for data from an ARMA( p, q) process is easily computed from the

innovations form of the likelihood (5.2.6) by evaluating the one-step predictors X̂i+1
and the corresponding mean squared errors vi. These can be found from the recursions
(Section 3.3)

X̂n+1 =

⎧
⎪⎪⎪⎨

⎪⎪⎪⎩

n∑

j=1
θnj

(
Xn+1−j − X̂n+1−j

)
, 1 ≤ n < m,

φ1Xn + · · · + φpXn+1−p +
q∑

j=1
θnj

(
Xn+1−j − X̂n+1−j

)
, n ≥ m,

(5.2.7)
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and

E
(
Xn+1 − X̂n+1

)2 = σ 2E
(
Wn+1 − Ŵn+1

)2 = σ 2rn, (5.2.8)

where θnj and rn are determined by the innovations algorithm with κ as in (3.3.3) and
m = max(p, q). Substituting in the general expression (5.2.6), we obtain the following:

The Gaussian Likelihood for an ARMA Process:

L
(
φ,θ, σ 2

) = 1
√(

2πσ 2
)n
r0 · · · rn−1

exp

⎧
⎪⎨

⎪⎩
− 1

2σ 2

n∑

j=1

(
Xj − X̂j

)2

rj−1

⎫
⎪⎬

⎪⎭
. (5.2.9)

Differentiating ln L
(
φ,θ, σ 2

)
partially with respect to σ 2 and noting that X̂j and rj

are independent of σ 2, we find that the maximum likelihood estimators φ̂, θ̂, and σ̂ 2

satisfy the following equations (Problem 5.8):

Maximum Likelihood Estimators:

σ̂ 2 = n−1S
(
φ̂, θ̂

)
, (5.2.10)

where

S
(
φ̂, θ̂

)
=

n∑

j=1

(
Xj − X̂j

)2
/rj−1, (5.2.11)

and φ̂, θ̂ are the values of φ, θ that minimize

�(φ,θ) = ln
(
n−1S(φ,θ)

) + n−1
n∑

j=1

ln rj−1. (5.2.12)

Minimization of �(φ,θ) must be done numerically. Initial values for φ and θ can
be obtained from ITSM using the methods described in Section 5.1. The program then
searches systematically for the values of φ and θ that minimize the reduced likelihood
(5.2.12) and computes the corresponding maximum likelihood estimate of σ 2 from
(5.2.10).

Least Squares Estimation for Mixed Models
The least squares estimates φ̃ and θ̃ of φ and θ are obtained byminimizing the function
S as defined in (5.2.11) rather than � as defined in (5.2.12), subject to the constraints
that the model be causal and invertible. The least squares estimate of σ 2 is

σ̃ 2 =
S
(
φ̃, θ̃

)

n − p − q
.

Order Selection
In Section 5.1 we introduced minimization of the AICC value as a major criterion for
the selection of the orders p and q. This criterion is applied as follows:
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AICC Criterion:
Choose p, q, φp, and θq to minimize

AICC = −2 ln L(φp,θq, S(φp,θq)/n)+ 2(p + q+ 1)n/(n − p − q− 2).

For any fixed p and q it is clear that the AICC is minimized when φp and θq are
the vectors that minimize −2 ln L(φp,θq, S(φp,θq)/n), i.e., the maximum likelihood
estimators. Final decisions with respect to order selection should therefore be made on
the basis of maximum likelihood estimators (rather than the preliminary estimators of
Section 5.1, which serve primarily as a guide). The AICC statistic and its justification
are discussed in detail in Section 5.5.

One of the options in the program ITSM is Model>Estimation>Autofit.
Selection of this option allows you to specify a range of values for both p and q, after
which the program will automatically fit maximum likelihood ARMA( p, q) values
for all p and q in the specified range, and select from these the model with smallest
AICC value. This may be slow if a large range is selected (the maximum range is from
0 through 27 for both p and q), and once the model has been determined, it should
be checked by preliminary estimation followed by maximum likelihood estimation
to minimize the risk of the fitted model corresponding to a local rather than a global
maximum of the likelihood. (For more details see Section E.3.1.)

Confidence Regions for the Coefficients
For large sample size the maximum likelihood estimator β̂ of β := (φ1, . . ., φp,
θ1, . . . , θq)′ is approximately normally distributed with mean β and covariance matrix[
n−1V(β)

]
which can be approximated by 2H−1(β), where H is the Hessian matrix

[
∂2�(β)/∂βi∂βj

]p+q

i,j=1. ITSM prints out the approximate standard deviations and corre-
lations of the coefficient estimators based on the Hessian matrix evaluated numerically
at β̂ unless this matrix is not positive definite, in which case ITSM instead computes
the theoretical asymptotic covariance matrix in Section 9.8 of Brockwell and Davis
(1991). The resulting covariances can be used to compute confidence bounds for the
parameters.

Large-Sample Distribution of Maximum Likelihood Estimators:

For a large sample from an ARMA(p, q) process,

β̂ ≈ N
(
β, n−1V(β)

)
.

The general form of V(β) can be found in Brockwell and Davis (1991), Section 9.8.
The following are several special cases.

Example 5.2.1 An AR(p)Model

The asymptotic covariance matrix in this case is the same as that for the Yule–Walker
estimates given by

V(φ) = σ 2�−1
p .

In the special cases p = 1 and p = 2, we have
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AR(1) :V(φ) = (
1 − φ2

1

)
,

AR(2) :V(φ) =
[

1 − φ2
2 −φ1(1 + φ2)

−φ1(1 + φ2) 1 − φ2
2

]

. �

Example 5.2.2 An MA(q)Model

Let �∗
q be the covariance matrix of Y1, . . . ,Yq, where {Yt} is the autoregressive process

with autoregressive polynomial θ(z), i.e.,

Yt + θ1Yt−1 + · · · + θqYt−q = Zt, {Zt} ∼ WN(0, 1).

Then it can be shown that

V(θ) = �∗−1
q .

Inspection of the results of Example 5.2.1 and replacement of φi by −θi yields
MA(1) :V(θ) = (

1 − θ2
1

)
,

MA(2) :V(θ) =
[

1 − θ2
2 θ1(1 − θ2)

θ1(1 − θ2) 1 − θ2
2

]

.

�

Example 5.2.3 An ARMA(1, 1)Model

For a causal and invertible ARMA(1,1) process with coefficients φ and θ .

V(φ, θ) = 1 + φθ
(φ + θ)2

[
(1 − φ2)(1 + φθ) −(1 − θ2)(1 − φ2)

−(1 − θ2)(1 − φ2) (1 − θ2)(1 + φθ)
]

.

�

Example 5.2.4 The Dow Jones Utilities Index

For the Burg and Yule–Walker AR(1) models derived for the differenced and mean-
corrected series in Examples 5.1.1 and 5.1.3, the Model>Estimation>
Preliminary option of ITSM gives −2 ln(L)= 70.330 for the Burg model and
−2 ln(L)= 70.378 for the Yule–Walker model. Since maximum likelihood estimation
attempts to minimize −2 ln L, the Burg estimate appears to be a slightly better initial
estimate of φ. We therefore retain the Burg AR(1) model and then select Model>
Estimation>Max Likelihood and click OK. The Burg coefficient estimates
provide initial parameter values to start the search for the minimizing values. The
model found on completion of the minimization is

Yt − 0.4471Yt−1 = Zt, {Zt} ∼ WN(0, 0.02117). (5.2.13)

This model is different again from the Burg and Yule–Walker models. It has
−2 ln(L) = 70.321, corresponding to a slightly higher likelihood. The standard
error (or estimated standard deviation) of the estimator φ̂ is found from the program to
be 0.1050. This is close to the estimated standard deviation

√
(1 − (0.4471)2)/77 =

0.1019, based on the large-sample approximation given in Example 5.2.1. Using
the value computed from ITSM, approximate 95% confidence bounds for φ are
0.4471 ± 1.96 × 0.1050 = (0.2413, 0.6529). These are quite close to the bounds
based on the Yule–Walker and Burg estimates found in Examples 5.1.1 and 5.1.3.
To find the minimum-AICC model for the series {Yt} using ITSM, choose the
option Model>Estimation>Autofit. Using the default range for both p and
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q, and clicking on Start, we quickly find that the minimum AICC ARMA( p, q)
model with p ≤ 5 and q ≤ 5 is the AR(1) model defined by (5.2.13). The
corresponding AICC value is 74.483. If we increase the upper limits for p and q,
we obtain the same result.

�

Example 5.2.5 The Lake Data

Using the option Model>Estimation>Autofit as in the previous example, we
find that the minimum-AICC ARMA( p, q) model for the mean-corrected lake data,
Xt = Yt − 9.0041, of Examples 5.1.6 and 5.1.7 is the ARMA(1,1) model

Xt − 0.7446Xt−1 = Zt + 0.3213Zt−1, {Zt} ∼ WN(0, 0.4750). (5.2.14)

The estimated standard deviations of the two coefficient estimates φ̂ and θ̂ are found
from ITSM to be 0.0773 and 0.1123, respectively. (The respective estimated standard
deviations based on the large-sample approximation given in Example 5.2.3 are 0.0788
and 0.1119.) The corresponding 95% confidence bounds are therefore

φ : 0.7446 ± 1.96 × 0.0773 = (0.5941, 0.8961),

θ : 0.3208 ± 1.96 × 0.1123 = (0.1007, 0.5409).

The value of AICC for this model is 212.77, improving on the values for the prelim-
inary models of Examples 5.1.4, 5.1.6, and 5.1.7.

�

5.3 Diagnostic Checking

Typically, the goodness of fit of a statistical model to a set of data is judged by
comparing the observed values with the corresponding predicted values obtained from
the fitted model. If the fitted model is appropriate, then the residuals should behave in
a manner that is consistent with the model.

When we fit an ARMA(p, q) model to a given series we determine the maximum
likelihood estimators φ̂, θ̂, and σ̂ 2 of the parameters φ, θ, and σ 2. In the course of this
procedure the predicted values X̂t

(
φ̂, θ̂

)
of Xt based on X1, . . . ,Xt−1 are computed for

the fitted model. The residuals are then defined, in the notation of Section 3.3, by

Ŵt =
(
Xt − X̂t

(
φ̂, θ̂

))
/
(
rt−1

(
φ̂, θ̂

))1/2
, t = 1, . . . , n. (5.3.1)

If we were to assume that the maximum likelihood ARMA(p, q) model is the true
process generating {Xt}, then we could say that

{
Ŵt

} ∼ WN
(
0, σ̂ 2

)
. However,

to check the appropriateness of an ARMA(p, q) model for the data we should
assume only that X1, . . . ,Xn are generated by an ARMA(p, q) process with unknown
parameters φ, θ, and σ 2, whose maximum likelihood estimators are φ̂, θ̂, and σ̂ 2,
respectively. Then it is not true that

{
Ŵt

}
is white noise. Nonetheless Ŵt, t = 1, . . . , n,

should have properties that are similar to those of the white noise sequence

Wt(φ,θ) = (Xt − X̂t (φ,θ)) /(rt−1(φ,θ))
1/2, t = 1, . . . , n.

Moreover,Wt(φ,θ) approximates the white noise term in the defining equation (5.1.1)
in the sense that E(Wt(φ,θ) − Zt)

2 → 0 as t → ∞ (Brockwell and Davis (1991),
Section 8.11). Consequently, the properties of the residuals

{
Ŵt

}
should reflect those

of the white noise sequence {Zt} generating the underlying ARMA(p, q) process. In
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particular, the sequence
{
Ŵt

}
should be approximately (1) uncorrelated if {Zt} ∼

WN
(
0, σ 2

)
, (2) independent if {Zt} ∼ IID

(
0, σ 2

)
, and (3) normally distributed if

Zt ∼ N
(
0, σ 2

)
.

The rescaled residuals R̂t, t = 1, . . . , n, are obtained by dividing the residuals

Ŵt, t = 1, . . . , n, by the estimate σ̂ =
√(∑n

t=1 Ŵ
2
t

)
/n of the white noise standard

deviation. Thus,

R̂t = Ŵt/σ̂ . (5.3.2)

If the fitted model is appropriate, the rescaled residuals should have properties similar
to those of a WN(0, 1) sequence or of an iid(0,1) sequence if we make the stronger
assumption that the white noise {Zt} driving the ARMA process is independent white
noise.

The following diagnostic checks are all based on the expected properties of the
residuals or rescaled residuals under the assumption that the fitted model is correct
and that {Zt} ∼ IID

(
0, σ 2

)
. They are the same tests introduced in Section 1.6.

5.3.1 The Graph of {R̂t, t = 1, . . . ,n}
If the fitted model is appropriate, then the graph of the rescaled residuals

{
R̂t, t =

1, . . . , n
}
should resemble that of a white noise sequence with variance one. While it is

difficult to identify the correlation structure of
{
R̂t

}
(or any time series for that matter)

from its graph, deviations of the mean from zero are sometimes clearly indicated by
a trend or cyclic component and nonconstancy of the variance by fluctuations in R̂t,
whose magnitude depends strongly on t.

The rescaled residuals obtained from the ARMA(1,1) model fitted to the mean-
corrected lake data in Example 5.2.5 are displayed in Figure 5-5. The graph gives no
indication of a nonzero mean or nonconstant variance, so on this basis there is no
reason to doubt the compatibility of R̂1, . . . , R̂n with unit-variance white noise.

Figure 5-5
The rescaled residuals after
fitting the ARMA(1,1) model
of Example 5.2.5 to the lake

data 0 20 40 60 80 100

− 1
0

1
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Figure 5-6
The sample ACF of
the residuals after

fitting the ARMA(1,1)
model of Example 5.2.5 to

the lake data Lag 
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The next step is to check that the sample autocorrelation function of
{
Ŵt

}
(or

equivalently of
{
R̂t

}
) behaves as it should under the assumption that the fitted model

is appropriate.

5.3.2 The Sample ACF of the Residuals

We know from Section 1.6 that for large n the sample autocorrelations of
an iid sequence Y1, . . . ,Yn with finite variance are approximately iid with distribution
N(0, 1/n). We can therefore test whether or not the observed residuals are consistent
with iid noise by examining the sample autocorrelations of the residuals and rejecting
the iid noise hypothesis if more than two or three out of 40 fall outside the bounds
±1.96/

√
n or if one falls far outside the bounds. (As indicated above, our estimated

residuals will not be precisely iid even if the true model generating the data is as
assumed. To correct for this the bounds ±1.96/

√
n should be modified to give a more

precise test as in Box and Pierce (1970) and Brockwell and Davis (1991), Section 9.4.)
The sample ACF and PACF of the residuals and the bounds ±1.96/

√
n can be viewed

by pressing the second green button (Plot ACF/PACF of residuals) at the
top of the ITSM window. Figure 5-6 shows the sample ACF of the residuals after
fitting the ARMA(1,1) of Example 5.2.5 to the lake data. As can be seen from the
graph, there is no cause to reject the fitted model on the basis of these autocorrelations.

5.3.3 Tests for Randomness of the Residuals

The tests (b), (c), (d), (e), and (f) of Section 1.6 can be carried out using the
program ITSM by selecting Statistics>Residual Analysis>Tests of
Randomness.
Applying these tests to the residuals from the ARMA(1,1) model for the mean-
corrected lake data (Example 5.2.5), and using the default value h = 22 suggested
for the portmanteau tests, we obtain the following results:
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RANDOMNESS TEST STATISTICS
LJUNG-BOX PORTM. = 10.23 CHISQUR(20) p=0.964
MCLEOD-LI PORTM. = 16.55 CHISQUR(22) p=0.788
TURNING POINTS = 69 ANORMAL(64.0, 4.14**2) p=0.227
DIFFERENCE-SIGN = 50 ANORMAL(48.5, 2.87**2) p=0.602
RANK TEST = 2083 ANORMAL(2376, 488.7**2) p=0.072
JARQUE-BERA=0.285 CHISQUR(2) p=0.867
ORDER OF MIN AICC YW MODEL FOR RESIDUALS = 0

This table shows the observed values of the statistics defined in Section 1.6, with each
followed by its large-sample distribution under the null hypothesis of iid residuals,
and the corresponding p-values. The observed values can thus be checked easily for
compatibility with their distributions under the null hypothesis. Since all of the p-
values are greater than 0.05, none of the test statistics leads us to reject the null
hypothesis at this level. The order of the minimum AICC autoregressive model for
the residuals also suggests the compatibility of the residuals with white noise.

A rough check for normality is provided by visual inspection of the histogram
of the rescaled residuals, obtained by selecting the third green button at the top of the
ITSM window. A Gaussian qq-plot of the residuals can also be plotted by selecting
Statistics > Residual Analysis > QQ-Plot (normal). No obvi-
ous deviation from normality is apparent in either the histogram or the qq-plot. The
Jarque-Bera statistic, n[m2

3/(6m
3
2)+(m4/m3

2−3)2/24], wheremr = ∑n
j=1(Yj−Ȳ)r/n, is

distributed asymptotically as χ2(2) if {Yt} ∼ IID N(μ, σ 2). This hypothesis is rejected
if the statistic is sufficiently large (at level α if the p-value of the test is less than α). In
this case the large p-value computed by ITSM provides no evidence for rejecting the
normality hypothesis.

5.4 Forecasting

Once a model has been fitted to the data, forecasting future values of the time series
can be carried out using the method described in Section 3.3. We illustrate this method
with one of the examples from Section 3.2.

Example 5.4.1 For the overshort data {Xt} of Example 3.2.8, selection of the options Model>
Estimation >Preliminary, the innovations algorithm, and then Model>
Estimation>Max likelihood, gives the maximum likelihood MA(1) model
for {Xt},

Xt + 4.035 = Zt − 0.818Zt−1, {Zt} ∼ WN(0, 2040.75). (5.4.1)

To predict the next 7 days of overshorts, we treat (5.4.1) as the true model for the data,
and use the results of Example 3.3.3 with φ = 0. From (3.3.11), the predictors are
given by

P57X57+h = −4.035 +
1∑

j=h

θ57+h−1,j

(
X57+h−j − X̂57+h−j

)

=
⎧
⎨

⎩

−4.035 + θ57,1

(
X57 − X̂57

)
, if h = 1,

−4.035, if h > 1,
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Table 5.1 Forecasts of the next seven observations
of the overshort data of Example 3.2.8
using model (5.4.1)

# XHAT SQRT(MSE) XHAT+MEAN

58 1.0097 45.1753 −3.0254
59 0.0000 58.3602 −4.0351
60 0.0000 58.3602 −4.0351
61 0.0000 58.3602 −4.0351
62 0.0000 58.3602 −4.0351
63 0.0000 58.3602 −4.0351
64 0.0000 58.3602 −4.0351

with mean squared error

E(X57+h − P57X57+h)
2 =

{
2040.75r57, if h = 1,

2040.75(1 + (−0.818)2), if h > 1,

where θ57,1 and r57 are computed recursively from (3.3.9) with θ = −0.818.
These calculations are performed with ITSM by fitting the maximum likeli-

hood model (5.4.1), selecting Forecasting>ARMA, and specifying the number of
forecasts required. The 1-step, 2-step, . . . , and 7-step forecasts of Xt are shown in
Table 5.1. Notice that the predictor of Xt for t ≥ 59 is equal to the sample mean, since
under the MA(1) model {Xt, t ≥ 59} is uncorrelated with {Xt, t ≤ 57}.

Assuming that the innovations {Zt} are normally distributed, an approximate 95%
prediction interval for X64 is given by

−4.0351 ± 1.96 × 58.3602 = (−118.42, 110.35).
�

Themean squared errors of prediction, as computed in Section 3.3 and the example
above, are based on the assumption that the fitted model is in fact the true model for
the data. As a result, they do not reflect the variability in the estimation of the model
parameters. To illustrate this point, suppose the data X1, . . . , Xn are generated from
the causal AR(1) model

Xt = φXt−1 + Zt, {Zt} ∼ iid
(
0, σ 2) .

If φ̂ is the maximum likelihood estimate of φ, based on X1, . . . ,Xn, then the one-step
ahead forecast of Xn+1 is φ̂Xn, which has mean squared error

E
(
Xn+1 − φ̂Xn

)2 = E
((
φ − φ̂

)
Xn + Zn+1

)2 = E((φ − φ̂)Xn)
2 + σ 2.

(5.4.2)

The second equality follows from the independence of Zn+1 and
(
φ̂,Xn

)′
. To evaluate

the first term in (5.4.2), first condition on Xn and then use the approximations

E

((
φ − φ̂

)2 |Xn

)

≈ E
(
φ − φ̂

)2 ≈ (
1 − φ2) /n,

where the second relation comes from the formula for the asymptotic variance of φ̂
given by σ 2�−1

1 = (
1 − φ2

)
(see Example 5.2.1). The one-step mean squared error is

then approximated by
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E
(
φ − φ̂

)2
EX2

n + σ 2 ≈ n−1 (1 − φ2) (1 − φ2)−1
σ 2 + σ 2 = n + 1

n
σ 2.

Thus, the error in parameter estimation contributes the term σ 2/n to the mean squared
error of prediction. If the sample size is large, this factor is negligible, and so for the
purpose of mean squared error computation, the estimated parameters can be treated
as the true model parameters. On the other hand, for small sample sizes, ignoring
parameter variability can lead to a severe underestimate of the actual mean squared
error of the forecast.

5.5 Order Selection

Once the data have been transformed (e.g., by some combination of Box–Cox and
differencing transformations or by removal of trend and seasonal components) to the
point where the transformed series {Xt} can potentially be fitted by a zero-mean ARMA
model, we are faced with the problem of selecting appropriate values for the orders p
and q.

It is not advantageous from a forecasting point of view to choose p and q arbi-
trarily large. Fitting a very high order model will generally result in a small estimated
white noise variance, but when the fitted model is used for forecasting, the mean
squared error of the forecasts will depend not only on the white noise variance of
the fitted model but also on errors arising from estimation of the parameters of the
model (see the paragraphs following Example 5.4.1). These will be larger for higher-
order models. For this reason we need to introduce a “penalty factor” to discourage
the fitting of models with too many parameters.

Many criteria based on such penalty factors have been proposed in the literature,
since the problem of model selection arises frequently in statistics, particularly in
regression analysis. We shall restrict attention here to a brief discussion of the FPE,
AIC, and BIC criteria of Akaike and a bias-corrected version of the AIC known as the
AICC.

5.5.1 The FPE Criterion

The FPE criterion was developed by Akaike (1969) to select the appropriate order of
an AR process to fit to a time series {X1, . . . , Xn}. Instead of trying to choose the order
p to make the estimated white noise variance as small as possible, the idea is to choose
the model for {Xt} in such a way as to minimize the one-step mean squared error when
the model fitted to {Xt} is used to predict an independent realization {Yt} of the same
process that generated {Xt}.

Suppose then that {X1, . . . , Xn} is a realization of an AR(p) process with coef-
ficients φ1, . . . , φp, p < n, and that {Y1, . . . ,Yn} is an independent realization of the
same process. If φ̂1, . . . , φ̂p, are the maximum likelihood estimators of the coefficients
based on {X1, . . . , Xn} and if we use these to compute the one-step predictor φ̂1Yn +
· · · + φ̂pYn+1−p of Yn+1, then the mean square prediction error is

E
(
Yn+1−φ̂1Yn− · · · −φ̂pYn+1−p

)2

= E
[
Yn+1 −φ1Yn− · · · −φpYn+1−p−

(
φ̂1 −φ1

)
Yn − · · · −

(
φ̂p −φp

)
Yn+1−p

]2

= σ 2 + E

[(
φ̂p − φp

)′ [
Yn+1−iYn+1−j

]p
i,j=1

(
φ̂p − φ

)]

,
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Table 5.2 σ̂ 2
p and FPEp for AR(p)

models fitted to the
lake data

p σ2p FPEp

0 1.7203 1.7203
1 0.5097 0.5202
2 0.4790 0.4989
3 0.4728 0.5027
4 0.4708 0.5109
5 0.4705 0.5211
6 0.4705 0.5318
7 0.4679 0.5399
8 0.4664 0.5493
9 0.4664 0.5607
10 0.4453 0.5465

where φ′
p = (φ1, . . . , φp)

′, φ̂′
p =

(
φ̂1, . . . , φ̂p

)′
, and σ 2 is the white noise variance

of the AR(p) model. Writing the last term in the preceding equation as the expecta-
tion of the conditional expectation given X1, . . . ,Xn, and using the independence of
{X1, . . . ,Xn} and {Y1, . . . ,Yn}, we obtain

E
(
Yn+1 − φ̂1Yn − · · · − φ̂pYn+1−p

)2 = σ 2 + E

[(
φ̂p − φp

)′
�p

(
φ̂p − φ

)]

,

where �p = E[YiYj]pi,j=1. We can approximate the last term by assuming that the

random variable n−1/2
(
φ̂p − φp

)
has its large-sample distribution N

(
0, σ 2�−1

p

)
as

given in Example 5.21. Using Problem 5.13, we then find that

E
(
Yn+1 − φ̂1Yn − · · · − φ̂pYn+1−p

)2 ≈ σ 2
(

1 + p

n

)
. (5.5.1)

If σ̂ 2 is the maximum likelihood estimator of σ 2, then for large n, nσ̂ 2/σ 2 is distributed
approximately as chi-squared with (n − p) degrees of freedom (see Brockwell and
Davis (1991), Section 8.9). We therefore replace σ 2 in (5.5.1) by the estimator
nσ̂ 2/(n − p) to get the estimated mean square prediction error of Yn+1,

FPEp = σ̂ 2n + p

n − p
. (5.5.2)

To apply the FPE criterion for autoregressive order selection we therefore choose the
value of p that minimizes FPEp as defined in (5.5.2).

Example 5.5.1 FPE-Based Selection of an AR Model for the Lake Data

In Example 5.1.4 we fitted AR(2) models to the mean-corrected lake data, the order 2
being suggested by the sample PACF shown in Figure 5-4. To use the FPE criterion to
select p, we have shown in Table 5.2 the values of FPE for values of p from 0 to 10.
These values were found using ITSM by fitting maximum likelihood AR models with
the option Model>Estimation>Max likelihood. Also shown in the table
are the values of the maximum likelihood estimates of σ 2 for the same values of p.
Whereas σ̂ 2

p decreases steadily with p, the values of FPEp have a clear minimum at
p = 2, confirming our earlier choice of p = 2 as the most appropriate for this data set.

�
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5.5.2 The AICC Criterion

A more generally applicable criterion for model selection than the FPE is the infor-
mation criterion of Akaike (1973), known as the AIC. This was designed to be an
approximately unbiased estimate of the Kullback–Leibler index of the fitted model
relative to the true model (defined below). Here we use a bias-corrected version of the
AIC, referred to as the AICC, suggested by Hurvich and Tsai (1989).

If X is an n-dimensional random vector whose probability density belongs to
the family {f (·;ψ),ψ ∈ �}, the Kullback–Leibler discrepancy between f (·;ψ) and
f (·; θ) is defined as

d(ψ |θ) = �(ψ |θ)−�(θ |θ),
where

�(ψ |θ) = Eθ (−2 ln f (X;ψ)) =
∫

Rn
−2 ln(f (x;ψ))f (x; θ) dx

is the Kullback–Leibler index of f (·;ψ) relative to f (·; θ). (Note that in general,
�(ψ |θ) �= �(θ |ψ).) By Jensen’s inequality (see, e.g., Mood et al., 1974),

d(ψ |θ) =
∫

Rn
−2 ln

(
f (x;ψ)
f (x; θ)

)

f (x; θ) dx

≥ −2 ln

(∫

Rn

f (x;ψ)
f (x; θ) f (x; θ) dx

)

= −2 ln

(∫

Rn
f (x;ψ) dx

)

= 0,

with equality holding if and only if f (x;ψ) = f (x; θ).
Given observations X1, . . . ,Xn of an ARMA process with unknown parameters

θ = (
β, σ 2

)
, the true model could be identified if it were possible to compute the

Kullback–Leibler discrepancy between all candidate models and the true model. Since
this is not possible, we estimate the Kullback–Leibler discrepancies and choose the
model whose estimated discrepancy (or index) is minimum. In order to do this, we
assume that the true model and the alternatives are all Gaussian. Then for any given
θ = (

β, σ 2
)
, f (·; θ) is the probability density of (Y1, . . . ,Yn)

′, where {Yt} is a Gaussian
ARMA(p, q) process with coefficient vector β and white noise variance σ 2. (The
dependence of θ on p and q is through the dimension of the autoregressive and moving-
average coefficients in β.)

Suppose, therefore, that our observations X1, . . . ,Xn are from a Gaussian ARMA
process with parameter vector θ = (

β, σ 2
)
and assume for the moment that the true

order is (p, q). Let θ̂ = (
β̂, σ̂ 2

)
be the maximum likelihood estimator of θ based on

X1, . . . , Xn and let Y1, . . . ,Yn be an independent realization of the true process (with
parameter θ). Then

−2 ln LY

(
β̂, σ̂ 2

)
= −2 ln LX

(
β̂, σ̂ 2

)
+ σ̂−2SY

(
β̂
)

− n,

where LX,LY, SX , and SY are defined as in (5.2.9) and (5.2.11). Hence,

Eθ (�(θ̂ |θ)) = Eβ,σ 2

(
−2 ln LY

(
β̂, σ̂ 2

))
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= Eβ,σ 2

(
−2 ln LX

(
β̂, σ̂ 2

))
+ Eβ,σ 2

⎛

⎝
SY

(
β̂
)

σ̂ 2

⎞

⎠ − n.

(5.5.3)

It can be shown using large-sample approximations (see Brockwell and Davis (1991),
Section 10.3 for details) that

Eβ,σ 2

⎛

⎝
SY

(
β̂
)

σ̂ 2

⎞

⎠ ≈ 2(p + q + 1)n

n − p − q − 2
,

from which we see that −2 ln LX

(
β̂, σ̂ 2

) + 2(p + q + 1)n/(n − p − q − 2) is an ap-
proximately unbiased estimator of the expected Kullback–Leibler index Eθ

(
�
(
θ̂ |θ))

in (5.5.3). Since the preceding calculations (and the maximum likelihood estimators
β̂ and σ̂ 2) are based on the assumption that the true order is (p, q), we therefore select
the values of p and q for our fitted model to be those that minimize AICC

(
β̂
)
, where

AICC(β) := −2 ln LX(β, SX(β)/n)+ 2(p+ q+ 1)n/(n− p− q− 2).

(5.5.4)

The AIC statistic, defined as

AIC(β) := −2 ln LX(β, SX(β)/n)+ 2(p + q + 1),

can be used in the same way. Both AICC
(
β, σ 2

)
and AIC

(
β, σ 2

)
can be defined

for arbitrary σ 2 by replacing SX(β)/n in the preceding definitions by σ 2. The value
SX(β)/n is used in (5.5.4), since AICC

(
β, σ 2

)
(like AIC

(
β, σ 2

)
) is minimized for any

given β by setting σ 2 = SX(β)/n.
For fitting autoregressive models, Monte Carlo studies (Jones 1975; Shibata 1976)

suggest that the AIC has a tendency to overestimate p. The penalty factors 2( p + q +
1)n/(n−p−q−2) and 2( p+q+1) for the AICC and AIC statistics are asymptotically
equivalent as n → ∞. The AICC statistic, however, has a more extreme penalty for
large-order models, which counteracts the overfitting tendency of the AIC. The BIC
is another criterion that attempts to correct the overfitting nature of the AIC. For a
zero-mean causal invertible ARMA( p, q) process, it is defined (Akaike 1978) to be

BIC = (n − p − q) ln
[
nσ̂ 2/(n − p − q)

] + n
(

1 + ln
√

2π
)

+(p + q) ln

[(
n∑

t=1

X2
t − nσ̂ 2

)

/(p + q)

]

, (5.5.5)

where σ̂ 2 is the maximum likelihood estimate of the white noise variance.
The BIC is a consistent order-selection criterion in the sense that if the data

{X1, . . . , Xn} are in fact observations of an ARMA(p, q) process, and if p̂ and q̂ are
the estimated orders found by minimizing the BIC, then p̂ → p and q̂ → q with
probability 1 as n → ∞ (Hannan 1980). This property is not shared by the AICC or
AIC. On the other hand, order selection by minimization of the AICC, AIC, or FPE
is asymptotically efficient for autoregressive processes, while order selection by BIC
minimization is not (Shibata 1980; Hurvich and Tsai 1989). Efficiency is a desirable
property defined in terms of the one-step mean square prediction error achieved by the
fitted model. For more details see Brockwell and Davis (1991), Section 10.3.
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In the modeling of real data there is rarely such a thing as the “true order.” For
the process Xt = ∑∞

j=0 ψjZt−j there may be many polynomials θ(z), φ(z) such that the
coefficients of zj in θ(z)/φ(z) closely approximate ψj for moderately small values of j.
Correspondingly, there may be many ARMA processes with properties similar to {Xt}.
This problem of identifiability becomes much more serious for multivariate processes.
The AICC criterion does, however, provide us with a rational criterion for choosing
among competing models. It has been suggested (Duong 1984) that models with AIC
values within c of the minimum value should be considered competitive (with c = 2
as a typical value). Selection from among the competitive models can then be based
on such factors as whiteness of the residuals (Section 5.3) and model simplicity.

We frequently need, particularly in analyzing seasonal data, to fit ARMA(p, q)
models in which all except m(≤ p + q) of the coefficients are constrained to be zero.
In such cases the definition (5.5.4) is replaced by

AICC(β) := −2 ln LX(β, SX(β)/n)+ 2(m + 1)n/(n − m − 2). (5.5.6)

Example 5.5.2 Models for the Lake Data

In Example 5.2.4 we found that the minimum-AICC ARMA(p, q) model for the mean-
corrected lake data is the ARMA(1,1) model (5.2.14). For this model ITSM gives the
values AICC = 212.77 and BIC = 216.86. A systematic check on ARMA( p, q) mod-
els for other values of p and q shows that the model (5.2.14) also minimizes the BIC
statistic. The minimum-AICC AR( p) model is found to be the AR(2) model satisfying

Xt − 1.0441Xt−1 + 0.2503Xt−2 = Zt, {Zt} ∼ WN(0, 0.4789),

with AICC = 213.54 and BIC = 217.63. Both the AR(2) and ARMA(1,1) models
pass the diagnostic checks of Section 5.3, and in view of the small difference between
the AICC values there is no strong reason to prefer one model or the other.

�

Problems

5.1 The sunspot numbers {Xt, t = 1, . . . , 100}, filed as SUNSPOTS.TSM, have
sample autocovariances γ̂ (0) = 1382.2, γ̂ (1) = 1114.4, γ̂ (2) = 591.73, and
γ̂ (3) = 96.216. Use these values to find the Yule–Walker estimates of φ1, φ2,
and σ 2 in the model

Yt = φ1Yt−1 + φ2Yt−2 + Zt, {Zt} ∼ WN
(
0, σ 2),

for the mean-corrected series Yt = Xt − 46.93, t = 1, . . . , 100. Assuming
that the data really are a realization of an AR(2) process, find 95% confidence
intervals for φ1 and φ2.

5.2 From the information given in the previous problem, use the Durbin–Levinson
algorithm to compute the sample partial autocorrelations φ̂11, φ̂22, and φ̂33 of the
sunspot series. Is the value of φ̂33 compatible with the hypothesis that the data
are generated by an AR(2) process? (Use significance level 0.05.)



154 Chapter 5 Modeling and Forecasting with ARMA Processes

5.3 Consider the AR(2) process {Xt} satisfying
Xt − φXt−1 − φ2Xt−2 = Zt, {Zt} ∼ WN

(
0, σ 2

)
.

a. For what values of φ is this a causal process?

b. The following sample moments were computed after observing X1,…,X200:

γ̂ (0) = 6.06, ρ̂(1) = 0.687.

Find estimates of φ and σ 2 by solving the Yule–Walker equations. (If you
find more than one solution, choose the one that is causal.)

5.4 Two hundred observations of a time series, X1, . . . , X200, gave the following
sample statistics:

sample mean: x200 = 3.82;
sample variance: γ̂ (0) = 1.15;
sample ACF: ρ̂(1) = 0.427;

ρ̂(2) = 0.475;
ρ̂(3) = 0.169.

a. Based on these sample statistics, is it reasonable to suppose that {Xt − μ} is
white noise?

b. Assuming that {Xt − μ} can be modeled as the AR(2) process

Xt − μ− φ1(Xt−1 − μ)− φ2(Xt−2 − μ) = Zt,

where {Zt} ∼ IID
(
0, σ 2

)
, find estimates of μ, φ1, φ2, and σ 2.

c. Would you conclude that μ = 0?

d. Construct 95% confidence intervals for φ1 and φ2.

e. Assuming that the data were generated from an AR(2) model, derive esti-
mates of the PACF for all lags h ≥ 1.

5.5 Use the program ITSM to simulate and file 20 realizations of length 200 of the
Gaussian MA(1) process

Xt = Zt + θZt−1, {Zt} ∼ WN(0, 1),

with θ = 0.6.
a. For each series find the moment estimate of θ as defined in Example 5.1.2.

b. For each series use the innovations algorithm in the ITSM option Model>
Estimation>Preliminary to find an estimate of θ . (Use the default
value of the parameter m.) As soon as you have found this preliminary
estimate for a particular series, select Model>Estimation>Max
likelihood to find the maximum likelihood estimate of θ for the series.

c. Compute the sample means and sample variances of your three sets of esti-
mates.

d. Use the asymptotic formulae given at the end of Section 5.1.1 (with n =
200) to compute the variances of the moment, innovation, and maximum
likelihood estimators ofθ. Compare with the corresponding sample variances
found in (c).

e. What do the results of (c) suggest concerning the relative merits of the three
estimators?
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5.6 Establish the recursions (5.1.19) and (5.1.20) for the forward and backward
prediction errors ui(t) and vi(t) in Burg’s algorithm.

5.7 Derive the recursions for the Burg estimates φ(B)ii and σ (B)2i .

5.8 From the innovation form of the likelihood (5.2.9) derive the equations (5.2.10),
(5.2.11), and (5.2.12) for the maximum likelihood estimators of the parameters
of an ARMA process.

5.9 Use equation (5.2.9) to show that for n > p, the likelihood of the observations
{X1, . . . , Xn} of the causal AR(p) process defined by

Xt = φ1Xt−1 + · · · + φpXt−p + Zt, {Zt} ∼ WN
(
0, σ 2) ,

is

L
(
φ, σ 2

) = (
2πσ 2

)−n/2
(detGp)

−1/2

× exp

⎧
⎨

⎩
− 1

2σ 2

⎡

⎣X′
pG

−1
p Xp +

n∑

t=p+1

(Xt − φ1Xt−1 − · · · − φpXt−p)
2

⎤

⎦

⎫
⎬

⎭
,

where Xp = (X1, . . . ,Xp)
′ and Gp = σ−2�p = σ−2E(XpX′

p).

5.10 Use the result of Problem 5.9 to derive a pair of linear equations for the least
squares estimates of φ1 and φ2 for a causal AR(2) process (with mean zero).
Compare your equations with those for the Yule–Walker estimates. (Assume that
the mean is known to be zero in writing down the latter equations, so that the
sample autocovariances are γ̂ (h) = 1

n

∑n−h
t=1 Xt+hXt for h ≥ 0.)

5.11 Given two observations x1 and x2 from the causal AR(1) process satisfying

Xt = φXt−1 + Zt, {Zt} ∼ WN
(
0, σ 2) ,

and assuming that |x1| �= |x2|, find the maximum likelihood estimates of φ
and σ 2.

5.12 Derive a cubic equation for the maximum likelihood estimate of the coefficient
φ of a causal AR(1) process based on the observations X1, . . . , Xn.

5.13 Use the result of Problem A.7 and the approximate large-sample normal distri-
bution of the maximum likelihood estimator φ̂p to establish the approximation
(5.5.1).



6 Nonstationary and Seasonal
Time Series Models

6.1 ARIMA Models for Nonstationary Time Series
6.2 Identification Techniques
6.3 Unit Roots in Time Series Models
6.4 Forecasting ARIMA Models
6.5 Seasonal ARIMA Models
6.6 Regression with ARMA Errors

In this chapter we shall examine the problem of finding an appropriate model for a
given set of observations {x1, . . . , xn} that are not necessarily generated by a stationary
time series. If the data (a) exhibit no apparent deviations from stationarity and (b) have
a rapidly decreasing autocovariance function, we attempt to fit an ARMAmodel to the
mean-corrected data using the techniques developed in Chapter 5. Otherwise, we look
first for a transformation of the data that generates a new series with the properties
(a) and (b). This can frequently be achieved by differencing, leading us to consider
the class of ARIMA (autoregressive integrated moving-average) models, defined in
Section 6.1. We have in fact already encountered ARIMA processes. The model fitted
in Example 5.1.1 to the Dow Jones Utilities Index was obtained by fitting an ARmodel
to the differenced data, thereby effectively fitting an ARIMA model to the original
series. In Section 6.1 we shall give a more systematic account of such models.

In Section 6.2 we discuss the problem of finding an appropriate transformation for
the data and identifying a satisfactory ARMA(p, q) model for the transformed data.
The latter can be handled using the techniques developed in Chapter 5. The sample
ACF and PACF and the preliminary estimators φ̂m and θ̂m of Section 5.1 can provide
useful guidance in this choice. However, our prime criterion for model selection will
be the AICC statistic discussed in Section 5.5.2. To apply this criterion we compute
maximum likelihood estimators of φ, θ, and σ 2 for a variety of competing p and q
values and choose the fitted model with smallest AICC value. Other techniques, in
particular those that use the R and S arrays of Gray et al. (1978), are discussed in
the survey of model identification by de Gooijer et al. (1985). If the fitted model is
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satisfactory, the residuals (see Section 5.3) should resemble white noise. Tests for this
were described in Section 5.3 and should be applied to the minimum AICC model
to make sure that the residuals are consistent with their expected behavior under the
model. If they are not, then competing models (models with AICC value close to the
minimum) should be checked until we find one that passes the goodness of fit tests. In
some cases a small difference in AICC value (say less than 2) between two satisfactory
models may be ignored in the interest of model simplicity. In Section 6.3 we consider
the problem of testing for a unit root of either the autoregressive or moving-average
polynomial. An autoregressive unit root suggests that the data require differencing, and
a moving-average unit root suggests that they have been overdifferenced. Section 6.4
considers the prediction of ARIMA processes, which can be carried out using an
extension of the techniques developed for ARMA processes in Sections 3.3 and 5.4.
In Section 6.5 we examine the fitting and prediction of seasonal ARIMA (SARIMA)
models, whose analysis, except for certain aspects of model identification, is quite
analogous to that of ARIMAprocesses. Finally, we consider the problem of regression,
allowing for dependence between successive residuals from the regression. Such
models are known as regression models with time series residuals and often occur
in practice as natural representations for data containing both trend and serially
dependent errors.

6.1 ARIMA Models for Nonstationary Time Series

We have already discussed the importance of the class of ARMAmodels for represent-
ing stationary series. A generalization of this class, which incorporates a wide range of
nonstationary series, is provided by the ARIMA processes, i.e., processes that reduce
to ARMA processes when differenced finitely many times.

Definition 6.1.1 If d is a nonnegative integer, then {Xt} is an ARIMA(p,d,q) process if Yt :=
(1 − B)dXt is a causal ARMA( p, q) process.

This definition means that {Xt} satisfies a difference equation of the form

φ∗(B)Xt ≡ φ(B)(1 − B)dXt = θ(B)Zt, {Zt} ∼ WN
(
0, σ 2) , (6.1.1)

where φ(z) and θ(z) are polynomials of degrees p and q, respectively, and φ(z) �= 0
for |z| ≤ 1. The polynomial φ∗(z) has a zero of order d at z = 1. The process {Xt} is
stationary if and only if d = 0, in which case it reduces to an ARMA(p, q) process.

Notice that if d ≥ 1, we can add an arbitrary polynomial trend of degree
(d − 1) to {Xt} without violating the difference equation (6.1.1). ARIMA models
are therefore useful for representing data with trend (see Sections 1.5 and 6.2). It
should be noted, however, that ARIMAprocesses can also be appropriate for modeling
series with no trend. Except when d = 0, the mean of {Xt} is not determined by
equation (6.1.1), and it can in particular be zero (as in Example 1.3.3). Since for d ≥ 1,
equation (6.1.1) determines the second-order properties of {(1−B)dXt} but not those of
{Xt} (Problem 6.1), estimation ofφ, θ, and σ 2 will be based on the observed differences
(1 − B)dXt. Additional assumptions are needed for prediction (see Section 6.4).

Example 6.1.1 {Xt} is an ARIMA(1,1,0) process if for some φ ∈ (−1, 1),

(1 − φB)(1 − B)Xt = Zt, {Zt} ∼ WN
(
0, σ 2

)
.
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Figure 6-1
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We can then write

Xt = X0 +
t∑

j=1

Yj, t ≥ 1,

where

Yt = (1 − B)Xt =
∞∑

j=0

φ jZt−j.

A realization of {X1, . . . ,X200} with X0 = 0, φ = 0.8, and σ 2 = 1 is shown in
Figure 6-1, with the corresponding sample autocorrelation and partial autocorrelation
functions in Figures 6-2 and 6-3, respectively.

�
A distinctive feature of the data that suggests the appropriateness of an ARIMA

model is the slowly decaying positive sample autocorrelation function in Figure 6-2.
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Figure 6-3
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Figure 6-4
199 observations of the

series Yt = ∇Xt with
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If, therefore, we were given only the data and wished to find an appropriate model, it
would be natural to apply the operator ∇ = 1−B repeatedly in the hope that for some
j, {∇ jXt} will have a rapidly decaying sample autocorrelation function compatible
with that of an ARMA process with no zeros of the autoregressive polynomial
near the unit circle. For this particular time series, one application of the operator
∇ produces the realization shown in Figure 6-4, whose sample ACF and PACF
(Figures 6-5 and 6-6) suggest an AR(1) [or possibly AR(2)] model for {∇Xt}. The
maximum likelihood estimates of φ and σ 2 obtained from ITSM under the assumption
that E(∇Xt) = 0 (found by not subtracting the mean after differencing the data) are
0.808 and 0.978, respectively, giving the model

(1 − 0.808B)(1 − B)Xt = Zt, {Zt} ∼ WN(0, 0.978), (6.1.2)

which bears a close resemblance to the true underlying process,

(1 − 0.8B)(1 − B)Xt = Zt, {Zt} ∼ WN(0, 1). (6.1.3)
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Figure 6-5
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Figure 6-6
The sample PACF of the
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Instead of differencing the series in Figure 6-1 we could proceed more directly by
attempting to fit an AR(2) process as suggested by the sample PACF of the original
series in Figure 6-3. Maximum likelihood estimation, carried out using ITSM after
fitting a preliminary model with Burg’s algorithm and assuming that EXt = 0, gives
the model

(1 − 1.808B + 0.811B2)Xt = (1 − 0.825B)(1 − 0.983B)Xt = Zt,

{Zt} ∼ WN(0, 0.970), (6.1.4)

which, although stationary, has coefficients closely resembling those of the true
nonstationary process (6.1.3). (To obtain the model (6.1.4), two optimizations were
carried out using the Model>Estimation>Max likelihood option of ITSM,
the first with the default settings and the second after setting the accuracy parameter
to 0.00001.) From a sample of finite length it will be extremely difficult to distinguish
between a nonstationary process such as (6.1.3), for which φ∗(1) = 0, and a process
such as (6.1.4), which has very similar coefficients but for which φ∗ has all of its
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Figure 6-7
200 observations of
the AR(2) process
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zeros outside the unit circle. In either case, however, if it is possible by differencing
to generate a series with rapidly decaying sample ACF, then the differenced data set
can be fitted by a low-order ARMA process whose autoregressive polynomial φ∗ has
zeros that are comfortably outside the unit circle. This means that the fitted parameters
will be well away from the boundary of the allowable parameter set. This is desirable
for numerical computation of parameter estimates and can be quite critical for some
methods of estimation. For example, if we apply the Yule–Walker equations to fit an
AR(2) model to the data in Figure 6-1, we obtain the model

(1 − 1.282B + 0.290B2)Xt = Zt, {Zt} ∼ WN(0, 6.435), (6.1.5)

which bears little resemblance to either the maximum likelihood model (6.1.4) or the
true model (6.1.3). In this case the matrix R̂2 appearing in (5.1.7) is nearly singular.

An obvious limitation in fitting an ARIMA(p, d, q) process {Xt} to data is that
{Xt} is permitted to be nonstationary only in a very special way, i.e., by allowing the
polynomial φ∗(B) in the representation φ∗(B)Xt = Zt to have a zero of multiplicity
d at the point 1 on the unit circle. Such models are appropriate when the sample ACF
is a slowly decaying positive function as in Figure 6-2, since sample autocorrelation
functions of this form are associated with models φ∗(B)Xt = θ(B)Zt in which φ∗ has a
zero either at or close to 1.

Sample autocorrelations with slowly decaying oscillatory behavior as in Fig-
ure 6-8 are associated with models φ∗(B)Xt = θ(B)Zt in which φ∗ has a zero close to
eiω for some ω ∈ (−π, π ] other than 0. Figure 6-8 is the sample ACF of the series of
200 observations in Figure 6-7, obtained from ITSM by simulating the AR(2) process

Xt − (2r−1 cosω)Xt−1 + r−2Xt−2 = Zt, {Zt} ∼ WN(0, 1), (6.1.6)

with r = 1.005 and ω = π/3, i.e.,

Xt − 0.9950Xt−1 + 0.9901Xt−2 = Zt, {Zt} ∼ WN(0, 1).

The autocorrelation function of the model (6.1.6) can be derived by noting that
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Figure 6-8
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1 − (
2r−1 cosω

)
B + r−2B2 = (

1 − r−1eiωB
) (

1 − r−1e−iωB
)

(6.1.7)

and using (3.2.12). This gives

ρ(h) = r−h sin(hω + ψ)
sinψ

, h ≥ 0, (6.1.8)

where

tanψ = r2 + 1

r2 − 1
tanω. (6.1.9)

It is clear from these equations that

ρ(h) → cos(hω) as r ↓ 1. (6.1.10)

With r = 1.005 and ω = π/3 as in the model generating Figure 6-7, the model
ACF (6.1.8) is a damped sine wave with damping ratio 1/1.005 and period 6. These
properties are reflected in the sample ACF shown in Figure 6-8. For values of r closer
to 1, the damping will be even slower as the model ACF approaches its limiting form
(6.1.10).

If we were simply given the data shown in Figure 6-7, with no indication of the
model from which it was generated, the slowly damped sinusoidal sample ACF with
period 6 would suggest trying to make the sample ACF decay more rapidly by applying
the operator (6.1.7) with r = 1 and ω = π/3, i.e.,

(
1 − B + B2

)
. If it happens, as in

this case, that the period 2π/ω is close to some integer s (in this case 6), then the
operator 1 − Bs can also be applied to produce a series with more rapidly decaying
autocorrelation function (see also Section 6.5). Figures 6-9 and 6-10 show the sample
autocorrelation functions obtained after applying the operators 1−B+B2 and 1−B6,
respectively, to the data shown in Figure 6-7. For either one of these two differenced
series, it is then not difficult to fit an ARMA model φ(B)Xt = θ(B)Zt for which the
zeros of φ are well outside the unit circle. Techniques for identifying and determining
such ARMA models have already been introduced in Chapter 5. For convenience we
shall collect these together in the following sections with a number of illustrative
examples.
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Figure 6-9
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Figure 6-10
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6.2 Identification Techniques

(a) Preliminary Transformations. The estimation methods of Chapter 5 enable us to
find, for given values of p and q, an ARMA( p, q) model to fit a given series of data.
For this procedure to be meaningful it must be at least plausible that the data are in
fact a realization of an ARMA process and in particular a realization of a stationary
process. If the data display characteristics suggesting nonstationarity (e.g., trend and
seasonality), then it may be necessary to make a transformation so as to produce a new
series that is more compatible with the assumption of stationarity.

Deviations from stationarity may be suggested by the graph of the series itself or
by the sample autocorrelation function or both.
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Figure 6-11
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Inspection of the graph of the series will occasionally reveal a strong dependence
of variability on the level of the series, in which case the data should first be
transformed to reduce or eliminate this dependence. For example, Figure 1-1 shows
the Australian monthly red wine sales from January 1980 through October 1991,
and Figure 1-17 shows how the increasing variability with sales level is reduced
by taking natural logarithms of the original series. The logarithmic transformation
Vt = lnUt used here is in fact appropriate whenever {Ut} is a series whose standard
deviation increases linearly with the mean. For a systematic account of a general class
of variance-stabilizing transformations, we refer the reader to Box and Cox (1964).
The defining equation for the general Box–Cox transformation fλ is

fλ(Ut) =
⎧
⎨

⎩

λ−1(Uλt − 1), Ut ≥ 0, λ > 0,

lnUt, Ut > 0, λ = 0,

and the program ITSM provides the option (Transform>Box-Cox) of applying fλ
(with 0 ≤ λ ≤ 1.5) prior to the elimination of trend and/or seasonality from the data.
In practice, if a Box–Cox transformation is necessary, it is often the case that either f0
or f0.5 is adequate.

Trend and seasonality are usually detected by inspecting the graph of the (possibly
transformed) series. However, they are also characterized by autocorrelation functions
that are slowly decaying and nearly periodic, respectively. The elimination of trend
and seasonality was discussed in Section 1.5, where we described two methods:

(i) “classical decomposition” of the series into a trend component, a seasonal
component, and a random residual component, and

(ii) differencing.

The program ITSM (in the Transform option) offers a choice between these tech-
niques. The results of applying methods (i) and (ii) to the transformed red wine data
Vt = lnUt in Figure 1-17 are shown in Figures 6-11 and 6-12, respectively. Figure 6-11
was obtained from ITSM by estimating and removing from {Vt} a linear trend
component and a seasonal component with period 12. Figure 6-12 was obtained by
applying the operator

(
1 − B12

)
to {Vt}. Neither of the two resulting series displays



166 Chapter 6 Nonstationary and Seasonal Time Series Models

Figure 6-12
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any apparent deviations from stationarity, nor do their sample autocorrelation func-
tions. The sample ACF and PACF of

{
(1 − B12

)
Vt

}
are shown in Figures 6-13 and

6-14, respectively.
After the elimination of trend and seasonality, it is still possible that the sample

autocorrelation function may appear to be that of a nonstationary (or nearly nonsta-
tionary) process, in which case further differencing may be carried out.

In Section 1.5 we also mentioned a third possible approach:

(iii) fitting a sum of harmonics and a polynomial trend to generate a noise sequence
that consists of the residuals from the regression.

In Section 6.6 we discuss the modifications to classical least squares regression
analysis that allow for dependence among the residuals from the regression. These
modifications are implemented in the ITSM option Regression>Estimation>
Generalized LS.

(b) Identification and Estimation. Let {Xt} be the mean-corrected transformed
series found as described in (a). The problem now is to find the most satisfactory
ARMA( p, q) model to represent {Xt}. If p and q were known in advance, this would
be a straightforward application of the estimation techniques described in Chapter 5.
However, this is usually not the case, so it becomes necessary also to identify
appropriate values for p and q.

It might appear at first sight that the higher the values chosen for p and q, the
better the resulting fitted model will be. However, as pointed out in Section 5.5,
estimation of too large a number of parameters introduces estimation errors that
adversely affect the use of the fitted model for prediction as illustrated in Section 5.4.
We therefore minimize one of the model selection criteria discussed in Section 5.5 in
order to choose the values of p and q. Each of these criteria includes a penalty term
to discourage the fitting of too many parameters. We shall base our choice of p and
q primarily on the minimization of the AICC statistic, defined as

AICC(φ,θ) = −2 ln L(φ,θ, S(φ,θ)/n) + 2(p + q + 1)n/(n − p − q − 2),

(6.2.1)
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Figure 6-13
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Figure 6-14
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where L(φ,θ, σ 2) is the likelihood of the data under the Gaussian ARMAmodel with
parameters

(
φ,θ, σ 2

)
, and S(φ,θ) is the residual sum of squares defined in (5.2.11).

Once a model has been found that minimizes the AICC value, it is then necessary to
check the model for goodness of fit (essentially by checking that the residuals are like
white noise) as discussed in Section 5.3.

For any fixed values of p and q, the maximum likelihood estimates of φ and
θ are the values that minimize the AICC. Hence, the minimum AICC model (over
any given range of p and q values) can be found by computing the maximum
likelihood estimators for each fixed p and q and choosing from these the maximum
likelihood model with the smallest value of AICC. This can be done with the program
ITSM by using the option Model>Estimation>Autofit. When this option
is selected and upper and lower bounds for p and q are specified, the program
fits maximum likelihood models for each pair ( p, q) in the range specified and
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selects the model with smallest AICC value. If some of the coefficient estimates are
small compared with their estimated standard deviations, maximum likelihood subset
models (with those coefficients set to zero) can also be explored.

The steps in model identification and estimation can be summarized as follows:

• After transforming the data (if necessary) to make the fitting of an ARMA(p, q)
model reasonable, examine the sample ACF and PACF to get some idea of potential
p and q values. Preliminary estimation using the ITSM option Model>Esti-
mation>Preliminary is also useful in this respect. Burg’s algorithm with
AICCminimization rapidly fits autoregressions of all orders up to 27 and selects the
one with minimum AICC value. For preliminary estimation of models with q > 0,
each pair (p, q) must be considered separately.

• Select the option Model>Estimation>Autofit of ITSM. Specify the
required limits for p and q, and the program will then use maximum likelihood
estimation to find the minimum AICC model with p and q in the range specified.

• Examination of the fitted coefficients and their standard errors may suggest that
some of them can be set to zero. If this is the case, then a subset model can be
fitted by clicking on the button Constrain optimization in the Maximum
Likelihood Estimation dialog box and setting the selected coefficients to
zero. Optimization will then give the maximum likelihood model with the chosen
coefficients constrained to be zero. The constrained model is assessed by comparing
its AICC value with those of the other candidate models.

• Check the candidate model(s) for goodness of fit as described in Section 5.3.
These tests can be performed by selecting the option Statistics>Residual
Analysis.

Example 6.2.1 The Australian Red Wine Data

Let {X1, . . . , X130} denote the series obtained from the red wine data of Example 1.1.1
after taking natural logarithms, differencing at lag 12, and subtracting the mean
(0.0681) of the differences. The data prior tomean correction are shown in Figure 6-12.
The sample PACF of {Xt}, shown in Figure 6-14, suggests that an AR(12) model
might be appropriate for this series. To explore this possibility we use the ITSM
option Model>Estimation>Preliminary with Burg’s algorithm and AICC
minimization. As anticipated, the fitted Burg models do indeed have minimum AICC
when p = 12. The fitted model is
(
1 − 0.245B − 0.069B2 − 0.012B3 − 0.021B4 − 0.200B5+0.025B6+0.004B7

− 0.133B8 + 0.010B9 − 0.095B10 + 0.118B11 + 0.384B12
)
Xt = Zt,

with {Zt} ∼ WN(0, 0.0135) and AICC value −158.77. Selecting the option Model>
Estimation>Max likelihood then gives the maximum likelihood AR(12)
model, which is very similar to the Burg model and has AICC value −158.87.
Inspection of the standard errors of the coefficient estimators suggests the possibility
of setting those at lags 2,3,4,6,7,9,10, and 11 equal to zero. If we do this by click-
ing on the Constrain optimization button in the Maximum Likelihood
Estimation dialog box and then reoptimize, we obtain the model,

(
1 − 0.270B − 0.224B5 − 0.149B8 + 0.099B11 + 0.353B12)Xt = Zt,

with {Zt} ∼ WN(0, 0.0138) and AICC value −172.49.
In order to check more general ARMA(p, q) models, select the option Model>

Estimation>Autofit and specify the minimum and maximum values of p and
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q to be zero and 15, respectively. (The sample ACF and PACF suggest that these limits
should be more than adequate to include the minimum AICCmodel.) In a few minutes
(depending on the speed of your computer) the program selects an ARMA(1,12)model
with AICC value −172.74, which is slightly better than the subset AR(12) model
just found. Inspection of the estimated standard deviations of the MA coefficients at
lags 1, 3, 4, 6, 7, 9, and 11 suggests setting them equal to zero and reestimating the
values of the remaining coefficients. If we do this by clicking on the Constrain
optimization button in the Maximum Likelihood Estimation dialog
box, setting the required coefficients to zero and then reoptimizing, we obtain the
model,

(1 − 0.286B)Xt =
(

1 + 0.127B2 + 0.183B5 + 0.177B8 + 0.181B10 − 0.554B12
)
Zt,

with {Zt} ∼ WN(0, 0.0120) and AICC value −184.09.
The subset ARMA(1,12) model easily passes all the goodness of fit tests

in the Statistics>Residual Analysis option. In view of this and its small
AICC value, we accept it as a plausible model for the transformed red wine series.

�

Example 6.2.2 The Lake Data

Let {Yt, t = 1, . . . , 99} denote the lake data of Example 1.3.5. We have seen already
in Example 5.2.5 that the ITSM option Model>Estimation>Autofit gives the
minimum-AICC model

Xt−0.7446Xt−1=Zt+0.3213Zt−1, {Zt} ∼ WN(0, 0.4750),

for the mean-corrected series Xt = Yt − 9.0041. The corresponding AICC value is
212.77. Since the model passes all the goodness of fit tests, we accept it as a reasonable
model for the data.

�

6.3 Unit Roots in Time Series Models

The unit root problem in time series arises when either the autoregressive or moving-
average polynomial of an ARMA model has a root on or near the unit circle. A
unit root in either of these polynomials has important implications for modeling.
For example, a root near 1 of the autoregressive polynomial suggests that the data
should be differenced before fitting an ARMA model, whereas a root near 1 of
the moving-average polynomial indicates that the data were overdifferenced. In this
section, we consider inference procedures for detecting the presence of a unit root in
the autoregressive and moving-average polynomials.

6.3.1 Unit Roots in Autoregressions

In Section 6.1 we discussed the use of differencing to transform a nonstationary time
series with a slowly decaying sample ACF and values near 1 at small lags into one
with a rapidly decreasing sample ACF. The degree of differencing of a time series {Xt}
was largely determined by applying the difference operator repeatedly until the sample
ACF of

{∇dXt

}
decays quickly. The differenced time series could then be modeled by

a low-order ARMA( p, q) process, and hence the resulting ARIMA( p, d, q) model
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for the original data has an autoregressive polynomial
(
1−φ1z−· · ·−φpzp

)
(1−z)d [see

(6.1.1)] with d roots on the unit circle. In this subsection we discuss a more systematic
approach to testing for the presence of a unit root of the autoregressive polynomial in
order to decide whether or not a time series should be differenced. This approach was
pioneered by Dickey and Fuller (1979).

Let X1, . . . , Xn be observations from the AR(1) model

Xt − μ = φ1(Xt−1 − μ)+ Zt, {Zt} ∼ WN
(
0, σ 2

)
, (6.3.1)

where |φ1| < 1 and μ = EXt. For large n, the maximum likelihood estimator φ̂1 of φ1

is approximately N
(
φ1,

(
1−φ2

1

)
/n
)
. For the unit root case, this normal approximation

is no longer applicable, even asymptotically, which precludes its use for testing the
unit root hypothesis H0 : φ1 = 1 vs. H1 : φ1 < 1. To construct a test of H0, write the
model (6.3.1) as

∇Xt = Xt − Xt−1 = φ∗
0 + φ∗

1Xt−1 + Zt, {Zt} ∼ WN
(
0, σ 2) , (6.3.2)

where φ∗
0 = μ(1 − φ1) and φ∗

1 = φ1 − 1. Now let φ̂∗
1 be the ordinary least squares

(OLS) estimator of φ∗
1 found by regressing ∇Xt on 1 and Xt−1. The estimated standard

error of φ̂∗
1 is

ŜE
(
φ̂∗

1

)
= S

(
n∑

t=2

(
Xt−1 − X̄

)2

)−1/2

,

where S2 = ∑n
t=2

(
∇Xt − φ̂∗

0 − φ̂∗
1Xt−1

)2
/(n − 3) and X̄ is the sample mean of

X1, . . . ,Xn−1. Dickey and Fuller derived the limit distribution as n → ∞ of the t-
ratio

τ̂μ := φ̂∗
1/ŜE

(
φ̂∗

1

)
(6.3.3)

under the unit root assumption φ∗
1 = 0, from which a test of the null hypothesis

H0 : φ1 = 1 can be constructed. The 0.01, 0.05, and 0.10 quantiles of the limit
distribution of τ̂μ (see Table 8.5.2 of Fuller 1976) are −3.43, −2.86, and −2.57,
respectively. The augmented Dickey–Fuller test then rejects the null hypothesis of a
unit root, at say, level 0.05 if τ̂μ < −2.86. Notice that the cutoff value for this test
statistic is much smaller than the standard cutoff value of −1.645 obtained from the
normal approximation to the t-distribution, so that the unit root hypothesis is less likely
to be rejected using the correct limit distribution.

The above procedure can be extended to the case where {Xt} follows the AR( p)
model with mean μ given by

Xt − μ = φ1 (Xt−1 − μ)+ · · · + φp
(
Xt−p − μ) + Zt, {Zt} ∼ WN

(
0, σ 2).

This model can be rewritten as (see Problem 6.2)

∇Xt = φ∗
0 + φ∗

1Xt−1 + φ∗
2∇Xt−1 + · · · + φ∗

p∇Xt−p+1 + Zt, (6.3.4)

where φ0 = μ
(
1 − φ1 − · · · − φp

)
, φ∗

1 = ∑p
i=1 φi − 1, and φ∗

j = −∑p
i=j φi, j =

2, . . . , p. If the autoregressive polynomial has a unit root at 1, then 0 = φ (1) = −φ∗
1 ,

and the differenced series {∇Xt} is an AR(p − 1) process. Consequently, testing the
hypothesis of a unit root at 1 of the autoregressive polynomial is equivalent to testing
φ∗

1 = 0. As in the AR(1) example, φ∗
1 can be estimated as the coefficient of Xt−1 in the

OLS regression of ∇Xt onto 1,Xt−1,∇Xt−1, . . . ,∇Xt−p+1. For large n the t-ratio

τ̂μ := φ̂∗
1/ŜE

(
φ̂∗

1

)
, (6.3.5)
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where ŜE
(
φ̂∗

1

)
is the estimated standard error of φ̂∗

1 , has the same limit distribution as

the test statistic in (6.3.3). The augmented Dickey–Fuller test in this case is applied in
exactly the same manner as for the AR(1) case using the test statistic (6.3.5) and the
cutoff values given above.

Example 6.3.1 Consider testing the time series of Example 6.1.1 (see Figure 6-1) for the presence
of a unit root in the autoregressive operator. The sample PACF in Figure 6-3 sug-
gests fitting an AR(2) or possibly an AR(3) model to the data. Regressing ∇Xt on
1,Xt−1,∇Xt−1,∇Xt−2 for t = 4, . . . , 200 using OLS gives

∇Xt =0.1503 − 0.0041Xt−1 + 0.9335∇Xt−1 − 0.1548∇Xt−2 + Zt,

(0.1135) (0.0028) (0.0707) (0.0708)

where {Zt} ∼ WN(0, 0.9639). The test statistic for testing the presence of a unit root is

τ̂μ = −0.0041

0.0028
= −1.464.

Since −1.464 > −2.57, the unit root hypothesis is not rejected at level 0.10. In
contrast, if we had mistakenly used the t-distribution with 193 degrees of freedom
as an approximation to τ̂μ, then we would have rejected the unit root hypothesis at
the 0.10 level (p-value is 0.074). The t-ratios for the other coefficients, φ∗

0 , φ
∗
2 , and

φ∗
3 , have an approximate t-distribution with 193 degrees of freedom. Based on these

t-ratios, the intercept should be 0, while the coefficient of ∇Xt−2 is barely significant.
The evidence is much stronger in favor of a unit root if the analysis is repeated without
a mean term. The fitted model without a mean term is

∇Xt =0.0012Xt−1 + 0.9395∇Xt−1 − 0.1585∇Xt−2 + Zt,

(0.0018) (0.0707) (0.0709)

where {Zt} ∼ WN(0, 0.9677). The 0.01, 0.05, and 0.10 cutoff values for the
corresponding test statistic when a mean term is excluded from the model are −2.58,
−1.95, and −1.62 (see Table 8.5.2 of Fuller 1976). In this example, the test statistic is

τ̂ = −0.0012

0.0018
= −0.667,

which is substantially larger than the 0.10 cutoff value of −1.62.
�

Further extensions of the above test to AR models with p = O
(
n1/3

)
and to

ARMA( p, q) models can be found in Said and Dickey (1984). However, as reported
in Schwert (1987) and Pantula (1991), this test must be used with caution if the
underlying model orders are not correctly specified.

6.3.2 Unit Roots in Moving Averages

A unit root in the moving-average polynomial can have a number of interpretations
depending on the modeling application. For example, let {Xt} be a causal and invertible
ARMA( p, q) process satisfying the equations

φ(B)Xt = θ(B)Zt, {Zt} ∼ WN
(
0, σ 2) .

Then the differenced series Yt := ∇Xt is a noninvertible ARMA( p, q + 1) process
with moving-average polynomial θ(z)(1 − z). Consequently, testing for a unit root in
the moving-average polynomial is equivalent to testing that the time series has been
overdifferenced.
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As a second application, it is possible to distinguish between the competing models

∇kXt = a + Vt

and

Xt = c0 + c1t + · · · + ckt
k + Wt,

where {Vt} and {Wt} are invertible ARMA processes. For the former model the
differenced series

{∇kXt

}
has no moving-average unit roots, while for the latter model

{∇kXt} has amultiple moving-average unit root of order k.We can therefore distinguish
between the twomodels by using the observed values of

{∇kXt

}
to test for the presence

of a moving-average unit root.
We confine our discussion of unit root tests to first-order moving-average models,

the general case being considerably more complicated and not fully resolved. Let
X1, . . . , Xn be observations from the MA(1) model

Xt = Zt + θZt−1, {Zt} ∼ IID
(
0, σ 2

)
.

Davis and Dunsmuir (1996) showed that under the assumption θ = −1, n(θ̂ +1) (θ̂ is
the maximum likelihood estimator) converges in distribution. A test of H0 : θ = −1
vs. H1 : θ > −1 can be fashioned on this limiting result by rejecting H0 when

θ̂ > −1 + cα/n,

where cα is the (1 − α) quantile of the limit distribution of n
(
θ̂ + 1

)
. (From

Table 3.2 of Davis et al. (1995), c0.01 = 11.93, c0.05 = 6.80, and c0.10 =
4.90.) In particular, if n = 50, then the null hypothesis is rejected at level 0.05 if
θ̂ > −1 + 6.80/50 = −0.864.

The likelihood ratio test can also be used for testing the unit root hypothesis. The

likelihood ratio for this problem is L(−1, S(−1)/n)/L
(
θ̂ , σ̂ 2

)
, where L

(
θ, σ 2

)
is the

Gaussian likelihood of the data based on anMA(1) model, S(−1) is the sum of squares
given by (5.2.11) when θ = −1, and θ̂ and σ̂ 2 are the maximum likelihood estimators
of θ and σ 2. The null hypothesis is rejected at level α if

λn := −2 ln

⎛

⎝
L(−1, S(−1)/n)

L
(
θ̂ , σ̂ 2

)

⎞

⎠ > cLR,α

where the cutoff value is chosen such that Pθ=−1[λn > cLR,α] = α. The limit
distribution of λn was derived by Davis et al. (1995), who also gave selected quantiles
of the limit. It was found that these quantiles provide a good approximation to their
finite-sample counterparts for time series of length n ≥ 50. The limiting quantiles for
λn under H0 are cLR,0.01 = 4.41, cLR,0.05 = 1.94, and cLR,0.10 = 1.00.

Example 6.3.2 For the overshort data {Xt} of Example 3.2.8, the maximum likelihood MA(1) model
for the mean corrected data {Yt = Xt + 4.035} was (see Example 5.4.1)

Yt = Zt − 0.818Zt−1, {Zt} ∼ WN(0, 2040.75).

In the structural formulation of this model given in Example 3.2.8, the moving-average
parameter θ was related to the measurement error variances σ 2

U and σ 2
V through the

equation

θ

1 + θ2
= −σ 2

U

2σ 2
U + σ 2

V

.



6.4 Forecasting ARIMA Models 173

(These error variances correspond to the daily measured amounts of fuel in the tank
and the daily measured adjustments due to sales and deliveries.) A value of θ = −1
indicates that there is no appreciable measurement error due to sales and deliveries
(i.e., σ 2

V = 0), and hence testing for a unit root in this case is equivalent to testing
that σ 2

U = 0. Assuming that the mean is known, the unit root hypothesis is rejected
at α = 0.05, since −0.818 > −1 + 6.80/57 = −0.881. The evidence against H0 is
stronger using the likelihood ratio statistic. Using ITSM and entering theMA(1) model
θ = −1 and σ 2 = 2203.12, we find that −2 ln L(−1, 2203.12) = 604.584, while
−2 ln L(θ̂ , σ̂ 2) = 597.267. Comparing the likelihood ratio statistic λn = 604.584 −
597.267 = 7.317 with the cutoff value cLR,0.01, we reject H0 at level α = 0.01 and
conclude that the measurement error associated with sales and deliveries is nonzero.

In the above example it was assumed that the mean was known. In practice, these
tests should be adjusted for the fact that the mean is also being estimated.

Tanaka (1990) proposed a locally best invariant unbiased (LBIU) test for the unit
root hypothesis. It was found that the LBIU test has slightly greater power than the
likelihood ratio test for alternatives close to θ = −1 but has less power for alternatives
further away from −1 (see Davis et al. 1995). The LBIU test has been extended to
cover more general models by Tanaka (1990) and Tam and Reinsel (1995). Similar
extensions to tests based on the maximum likelihood estimator and the likelihood ratio
statistic have been explored in Davis et al. (1996).

�

6.4 Forecasting ARIMA Models

In this section we demonstrate how the methods of Sections 3.3 and 5.4 can be
adapted to forecast the future values of an ARIMA(p, d, q) process {Xt}. (The required
numerical calculations can all be carried out using the program ITSM.)

If d ≥ 1, the first and second moments EXt and E(Xt+hXt) are not determined by
the difference equations (6.1.1). We cannot expect, therefore, to determine best linear
predictors for {Xt} without further assumptions.

For example, suppose that {Yt} is a causal ARMA( p, q) process and that X0 is any
random variable. Define

Xt = X0 +
t∑

j=1

Yj, t = 1, 2, . . . .

Then {Xt, t ≥ 0} is an ARIMA(p, 1, q) process with mean EXt = EX0 and autocovari-
ances E(Xt+hXt)− (EX0)

2 that depend on Var(X0) and Cov(X0,Yj), j = 1, 2, . . . . The
best linear predictor of Xn+1 based on {1,X0,X1, . . . ,Xn} is the same as the best linear
predictor in terms of the set {1,X0,Y1, . . . ,Yn}, since each linear combination of the
latter is a linear combination of the former and vice versa. Hence, using Pn to denote
best linear predictor in terms of either set and using the linearity of Pn, we can write

PnXn+1 = Pn(X0 + Y1 + · · · + Yn+1) = Pn(Xn + Yn+1) = Xn + PnYn+1.

To evaluate PnYn+1 it is necessary (see Section 2.5) to know E(X0Yj), j=1, . . . , n+1,
and EX2

0 . However, if we assume that X0 is uncorrelated with {Yt, t ≥ 1}, then
PnYn+1 is the same (Problem 6.5) as the best linear predictor Ŷn+1 of Yn+1 in terms of
{1,Y1, . . . ,Yn}, which can be calculated as described in Section 3.3. The assumption
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that X0 is uncorrelated with Y1,Y2, . . . is therefore sufficient to determine the best
linear predictor PnXn+1 in this case.

Turning now to the general case, we shall assume that our observed process {Xt}
satisfies the difference equations

(1 − B)dXt = Yt, t = 1, 2, . . . ,

where {Yt} is a causal ARMA(p, q) process, and that the random vector (X1−d, …, X0)

is uncorrelated with Yt, t > 0. The difference equations can be rewritten in the form

Xt = Yt −
d∑

j=1

(
d

j

)

(−1) jXt−j, t = 1, 2, . . . . (6.4.1)

It is convenient, by relabeling the time axis if necessary, to assume that we observe
X1−d,X2−d, . . . ,Xn. (The observed values of {Yt} are then Y1, . . . ,Yn.) As usual, we
shall use Pn to denote best linear prediction in terms of the observations up to time n
(in this case 1,X1−d, . . . ,Xn or equivalently 1,X1−d, . . . ,X0,Y1, . . . ,Yn).

Our goal is to compute the best linear predictors PnXn+h. This can be done by
applying the operator Pn to each side of (6.4.1) (with t = n+h) and using the linearity
of Pn to obtain

PnXn+h = PnYn+h −
d∑

j=1

(
d

j

)

(−1) jPnXn+h−j. (6.4.2)

Now the assumption that (X1−d, . . . , X0) is uncorrelated with Yt, t> 0, enables us to
identify PnYn+h with the best linear predictor of Yn+h in terms of {1,Y1, . . . ,Yn}, and
this can be calculated as described in Section 3.3. The predictor PnXn+1 is obtained
directly from (6.4.2) by noting that PnXn+1−j = Xn+1−j for each j ≥ 1. The predictor
PnXn+2 can then be found from (6.4.2) using the previously calculated value of
PnXn+1. The predictors PnXn+3, PnXn+4, . . . can be computed recursively in the same
way.

To find the mean squared error of prediction it is convenient to express PnYn+h in
terms of {Xj}. For n ≥ 0 we denote the one-step predictors by Ŷn+1 = PnYn+1 and
X̂n+1 = PnXn+1. Then from (6.4.1) and (6.4.2) we have

Xn+1 − X̂n+1 = Yn+1 − Ŷn+1, n ≥ 1,

and hence from (3.3.12), if n > m = max(p, q) and h ≥ 1, we can write

PnYn+h =
p∑

i=1

φiPnYn+h−i +
q∑

j=h

θn+h−1, j

(
Xn+h−j − X̂n+h−j

)
. (6.4.3)

Setting φ∗(z) = (1 − z)dφ(z) = 1 − φ∗
1z − · · · − φ∗

p+dz
p+d, we find from (6.4.2) and

(6.4.3) that

PnXn+h =
p+d∑

j=1

φ∗
j PnXn+h−j +

q∑

j=h

θn+h−1, j

(
Xn+h−j − X̂n+h−j

)
,

(6.4.4)

which is analogous to the h-step prediction formula (3.3.12) for an ARMA process.
As in (3.3.13), the mean squared error of the h-step predictor is



6.4 Forecasting ARIMA Models 175

σ 2
n (h) = E(Xn+h − PnXn+h)

2 =
h−1∑

j=0

(
j∑

r=0

χrθn+h−r−1, j−r

)2

vn+h−j−1,

(6.4.5)

where θn0 = 1,

χ(z) =
∞∑

r=0

χrz
r = (

1 − φ∗
1z − · · · − φ∗

p+dz
p+d

)−1
,

and

vn+h−j−1 = E
(
Xn+h−j − X̂n+h−j

)2 = E
(
Yn+h−j − Ŷn+h−j

)2
.

The coefficients χj can be found from the recursions (3.3.14) with φ∗
j replacing φj. For

large n we can approximate (6.4.5), provided that θ(·) is invertible, by

σ 2
n (h) =

h−1∑

j=0

ψ2
j σ

2, (6.4.6)

where

ψ(z) =
∞∑

j=0

ψjz
j = (φ∗(z))−1θ(z).

6.4.1 The Forecast Function

Inspection of equation (6.4.4) shows that for fixed n > m = max(p, q), the h-step
predictors

g(h) := PnXn+h,

satisfy the homogeneous linear difference equations

g(h)− φ∗
1g(h − 1)− · · · − φ∗

p+dg(h − p − d) = 0, h > q, (6.4.7)

where φ∗
1 , . . . , φ

∗
p+d are the coefficients of z, . . . , z

p+d in

φ∗(z) = (1 − z)dφ(z).

The solution of (6.4.7) is well known from the theory of linear difference equations
(see Brockwell and Davis (1991), Section 3.6). If we assume that the zeros of φ(z)
(denoted by ξ1, . . . , ξp) are all distinct, then the solution is

g(h) = a0 + a1h+ · · · + ad−1h
d−1 + b1ξ

−h
1 + · · · + bpξ

−h
p , h > q− p− d,

(6.4.8)

where the coefficients a0, . . . , ad−1 and b1, . . . , bp can be determined from the p + d
equations obtained by equating the right-hand side of (6.4.8) for q − p − d < h ≤ q
with the corresponding value of g(h) computed numerically (for h ≤ 0, PnXn+h =
Xn+h, and for 1 ≤ h ≤ q, PnXn+h can be computed from (6.4.4) as already described).
Once the constants ai and bi have been evaluated, the algebraic expression (6.4.8)
gives the predictors for all h > q − p − d. In the case q = 0, the values of g(h) in
the equations for a0, . . . , ad−1, b1, . . . , bp are simply the observed values g(h)=Xn+h,
−p − d ≤ h ≤ 0, and the expression (6.4.6) for the mean squared error is exact.
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The calculation of the forecast function is easily generalized to deal with more
complicated ARIMA processes. For example, if the observations X−13,X−12, . . . , Xn

are differenced at lags 12 and 1, and (1−B)
(
1−B12

)
Xt is modeled as a causal invertible

ARMA(p, q) process with mean μ and max(p, q) < n, then {Xt} satisfies an equation
of the form

φ(B)[(1 − B)(1 − B12)Xt − μ] = θ(B)Zt, {Zt} ∼ WN
(
0, σ 2

)
, (6.4.9)

and the forecast function g(h) = PnXn+h satisfies the analogue of (6.4.7), namely,

φ(B)(1 − B)(1 − B12)g(h) = φ(1)μ, h > q. (6.4.10)

To find the general solution of these inhomogeneous linear difference equations, it
suffices (see Brockwell and Davis (1991), Section 3.6) to find one particular solution
of (6.4.10) and then add to it the general solution of the same equations with the right-
hand side set equal to zero. A particular solution is easily found (by trial and error)
to be

g(h) = μh2

24
,

and the general solution is therefore

g(h) = μh2

24
+ a0 + a1h +

11∑

j=1

cje
ijπ/6 + b1ξ

−h
1 + · · · + bpξ

−h
p ,

h > q − p − 13. (6.4.11)

(The terms a0 and a1h correspond to the double root z = 1 of the equation φ(z)(1 −
z)(1− z12) = 0, and the subsequent terms to each of the other roots, which we assume
to be distinct.) For q − p − 13 < h ≤ 0, g(h) = Xn+h, and for 1 ≤ h ≤ q, the values
of g(h) = PnXn+h can be determined recursively from the equations

PnXn+h = μ+ PnXn−1 + PnXn−12 − PnXn−13 + PnYn+h,

where {Yt} is the ARMA process Yt = (1 − B)
(
1 − B12

)
Xt − μ. Substituting these

values of g(h) into (6.4.11), we obtain a set of p + 13 equations for the coefficients
ai, bj, and ck. Solving these equations then completes the determination of g(h).

The large-sample approximation to the mean squared error is again given by
(6.4.6), with ψj redefined as the coefficient of zj in the power series expansion of
θ(z)/

[
(1 − z)

(
1 − z12

)
φ(z)

]
.

Example 6.4.1 An ARIMA(1,1,0) Model

In Example 5.2.4 we found the maximum likelihood AR(1) model for the mean-
corrected differences Xt of the Dow Jones Utilities Index (August 28–December 18,
1972). The model was

Xt − 0.4471Xt−1 = Zt, {Zt} ∼ WN(0, 0.1455), (6.4.12)

where Xt = Dt − Dt−1 − 0.1336, t = 1, . . . , 77, and {Dt, t = 0, 1, 2, . . . , 77} is the
original series. The model for {Dt} is thus

(1 − 0.4471B)[(1 − B)Dt − 0.1336] = Zt, {Zt} ∼ WN(0, 0.1455).

The recursions for g(h) therefore take the form

(1−0.4471B)(1−B)g(h) = 0.5529×0.1336 = 0.07387, h > 0. (6.4.13)

A particular solution of these equations is g(h) = 0.1336h, so the general solution is

g(h) = 0.1336h + a + b(0.4471)h, h > −2. (6.4.14)
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Substituting g(−1) = D76 = 122 and g(0) = D77 = 121.23 in the equations with
h = −1 and h = 0, and solving for a and b gives

g(h) = 0.1366h + 120.50 + 0.7331(0.4471)h .

Setting h = 1 and h = 2 gives

P77D78 = 120.97 and P77D79 = 120.94.

From (6.4.5) we find that the corresponding mean squared errors are

σ 2
77(1) = v77 = σ 2 = 0.1455

and

σ 2
77(2) = v78 + φ∗

1
2v77 = σ 2

(
1 + 1.44712

) = 0.4502.

(Notice that the approximation (6.4.6) is exact in this case.) The predictors and their
mean squared errors are easily obtained from the program ITSM by opening the file
DOWJ.TSM, differencing at lag 1, fitting a preliminary AR(1) model to the mean-
corrected data with Burg’s algorithm, and selecting Model>Estimation>Max
likelihood to find the maximum likelihood AR(1) model. Predicted values and
their mean squared errors are then found using the option Forecasting>ARMA.

�

6.5 Seasonal ARIMA Models

We have already seen how differencing the series {Xt} at lag s is a convenient way
of eliminating a seasonal component of period s. If we fit an ARMA( p, q) model
φ(B)Yt = θ(B)Zt to the differenced series Yt = (1 − Bs)Xt, then the model for the
original series is φ(B) (1 − Bs)Xt = θ(B)Zt. This is a special case of the general
seasonal ARIMA (SARIMA) model defined as follows.

Definition 6.5.1 If d and D are nonnegative integers, then {Xt} is a seasonal ARIMA( p, d, q) ×
(P,D,Q)s process with period s if the differenced series Yt = (1−B)d(1−Bs)DXt
is a causal ARMA process defined by

φ(B)�
(
Bs)Yt = θ(B)�

(
Bs)Zt, {Zt} ∼ WN

(
0, σ 2

)
, (6.5.1)

where φ(z) = 1 − φ1z − · · · − φpzp, �(z) = 1 − �1z − · · · − �PzP, θ(z) =
1 + θ1z + · · · + θqzq, and �(z) = 1 +�1z + · · · +�QzQ.

Remark 1. Note that the process {Yt} is causal if and only if φ(z) �= 0 and �(z) �= 0
for |z| ≤ 1. In applications D is rarely more than one, and P and Q are typically less
than three. �

Remark 2. Equation (6.5.1) satisfied by the differenced process {Yt} can be rewritten
in the equivalent form

φ∗(B)Yt = θ∗(B)Zt, (6.5.2)

where φ∗(·), θ∗(·) are polynomials of degree p + s P and q + sQ, respectively, whose
coefficients can all be expressed in terms of φ1, . . . , φp, �1, . . . ,�P, θ1, . . . , θq, and
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�1, . . . ,�Q. Provided that p < s and q < s, the constraints on the coefficients of φ∗(·)
and θ∗(·) can all be expressed as multiplicative relations

φ∗
is+j = φ∗

isφ
∗
j , i = 1, 2, . . . ; j = 1, . . . , s − 1,

and

θ∗
is+j = θ∗

isθ
∗
j , i = 1, 2, . . . ; j = 1, . . . , s − 1.

In Section 1.5 we discussed the classical decomposition model incorporating trend,
seasonality, and random noise, namely, Xt = mt + st + Yt. In modeling real data
it might not be reasonable to assume, as in the classical decomposition model, that
the seasonal component st repeats itself precisely in the same way cycle after cycle.
Seasonal ARIMAmodels allow for randomness in the seasonal pattern from one cycle
to the next. �

Example 6.5.1 Suppose we have r years of monthly data, which we tabulate as follows:

Year/Month 1 2 … 12

1 Y1 Y2 … Y12

2 Y13 Y14 … Y24

3 Y25 Y26 … Y36
...

...
...

...

r Y1+12(r−1) Y2+12(r−1) … Y12+12(r−1)

Each column in this table may itself be viewed as a realization of a time series. Suppose
that each one of these twelve time series is generated by the same ARMA(P,Q)
model, or more specifically, that the series corresponding to the jth month, Yj+12t,

t = 0, . . . , r − 1, satisfies a difference equation of the form

Yj+12t = �1Yj+12(t−1) + · · · +�PYj+12(t−P) + Uj+12t

+�1Uj+12(t−1) + · · · +�QUj+12(t−Q), (6.5.3)

where

{Uj+12t, t = . . . ,−1, 0, 1, . . .} ∼ WN
(
0, σ 2

U

)
. (6.5.4)

Then since the same ARMA(P,Q) model is assumed to apply to each month, (6.5.3)
holds for each j = 1, . . . , 12. (Notice, however, that E(UtUt+h) is not necessarily
zero except when h is an integer multiple of 12.) We can thus write (6.5.3) in the
compact form

�
(
B12

)
Yt = �

(
B12

)
Ut, (6.5.5)

where�(z) = 1 −�1z− · · ·−�PzP,�(z) = 1 +�1z+ · · ·+�QzQ, and {Uj+12t, t =
. . . ,−1, 0, 1, . . .} ∼ WN

(
0, σ 2

U

)
for each j. We refer to the model (6.5.5) as the

between-year model.
�

Example 6.5.2 Suppose P = 0, Q = 1, and �1 = −0.4 in (6.5.5). Then the series for any particular
month is a moving-average of order 1. If E(UtUt+h)=0 for all h, i.e., if the white noise
sequences for different months are uncorrelated with each other, then the columns
themselves are uncorrelated. The correlation function for such a process is shown in
Figure 6-15.

�
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Figure 6-15
The ACF of the model
Xt = Ut − 0.4Ut−12

of Example 6.5.2 Lag
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Figure 6-16
The ACF of the model

Xt − 0.7Xt−12 = Ut
of Example 6.5.3 Lag
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Example 6.5.3 Suppose P = 1, Q = 0, and �1 = 0.7 in (6.5.5). In this case the 12 series (one for
each month) are AR(1) processes that are uncorrelated if the white noise sequences
for different months are uncorrelated. A graph of the autocorrelation function of this
process is shown in Figure 6-16.

�
In each of the Examples 6.5.1–6.5.3, the 12 series corresponding to the dif-

ferent months are uncorrelated. To incorporate dependence between these series
we allow the process {Ut} in (6.5.5) to follow an ARMA( p, q) model,

φ(B)Ut = θ(B)Zt, {Zt} ∼ WN
(
0, σ 2) . (6.5.6)

This assumption implies possible nonzero correlation not only between consecutive
values of Ut, but also within the 12 sequences {Uj+12t, t = . . . ,−1, 0, 1, . . .}, each of
which was assumed to be uncorrelated in the preceding examples. In this case (6.5.4)
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may no longer hold; however, the coefficients in (6.5.6) will frequently have values
such that E(UtUt+12j) is small for j = ±1,±2, . . . . Combining the two models (6.5.5)
and (6.5.6) and allowing for possible differencing leads directly to Definition 6.5.1 of
the general SARIMA model as given above.

The first steps in identifying SARIMA models for a (possibly transformed) data
set are to find d and D so as to make the differenced observations

Yt = (1 − B)d (1 − Bs)
D Xt

stationary in appearance (see Sections 6.1–6.3). Next we examine the sample ACF
and PACF of {Yt} at lags that are multiples of s for an indication of the orders P and
Q in the model (6.5.5). If ρ̂(·) is the sample ACF of {Yt}, then P and Q should be
chosen such that ρ̂(ks), k = 1, 2, . . ., is compatible with the ACF of an ARMA(P,Q)
process. The orders p and q are then selected by trying to match ρ̂(1), . . . , ρ̂(s − 1)
with the ACF of an ARMA( p, q) process. Ultimately, the AICC criterion (Section 5.5)
and the goodness of fit tests (Section 5.3) are used to select the best SARIMA model
from competing alternatives.

For given values of p, d, q, P, D, and Q, the parameters φ, θ , �, �, and σ 2 can
be found using the maximum likelihood procedure of Section 5.2. The differences
Yt = (1 − B)d

(
1 − Bs

)D
Xt constitute an ARMA( p + sP, q + sQ) process in which

some of the coefficients are zero and the rest are functions of the ( p + P + q + Q)-
dimensional vector β′ = (φ′,�′, θ ′,�′). For any fixed β the reduced likelihood �(β)
of the differences Yt+d+sD, . . . ,Yn is easily computed as described in Section 5.2. The
maximum likelihood estimator of β is the value that minimizes �(β), and the
maximum likelihood estimate of σ 2 is given by (5.2.10). The estimates can be found
using the program ITSMby specifying the required multiplicative relationships among
the coefficients as given in Remark 2 above.

A more direct approach to modeling the differenced series {Yt} is simply to fit a
subset ARMAmodel of the form (6.5.2) without making use of the multiplicative form
of φ∗(·) and θ∗(·) in (6.5.1).

Example 6.5.4 Monthly Accidental Deaths

In Figure 1-27 we showed the series
{
Yt = (

1−B12
)
(1−B)Xt

}
obtained by differencing

the accidental deaths series {Xt} once at lag 12 and once at lag 1. The sample ACF of
{Yt} is shown in Figure 6-17.

�
The values ρ̂(12) = −0.333, ρ̂(24) = −0.099, and ρ̂(36) = 0.013 suggest a

moving-average of order 1 for the between-year model (i.e., P = 0 and Q = 1).
Moreover, inspection of ρ̂(1), . . . , ρ̂(11) suggests that ρ(1) is the only short-term
correlation different from zero, so we also choose a moving-average of order 1 for
the between-month model (i.e., p = 0 and q = 1). Taking into account the sample
mean (28.831) of the differences {Yt}, we therefore arrive at the model

Yt = 28.831 + (1 + θ1B)(1 +�1B
12)Zt, {Zt} ∼ WN

(
0, σ 2) ,

(6.5.7)

for the series {Yt}. The maximum likelihood estimates of the parameters are obtained
from ITSM by opening the file DEATHS.TSM and proceeding as follows. After
differencing (at lags 1 and 12) and then mean-correcting the data, choose the option
Model>Specify. In the dialog box enter an MA(13) model with θ1 = −0.3,
θ12 = −0.3, θ13 = 0.09, and all other coefficients zero. (This corresponds to the initial



6.5 Seasonal ARIMA Models 181

Figure 6-17
The sample ACF of the
differenced accidental

deaths {∇∇12Xt} Lag
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guess Yt = (1 − 0.3B)
(
1 − 0.3B12

)
Zt.) Then choose Model>Estimation>Max

likelihood and click on the button Constrain optimization. Specify the
number of multiplicative relations (one in this case) in the box provided and define the
relationship by entering 1, 12, 13 to indicate that θ1 × θ12 = θ13. Click OK to return
to the Maximum Likelihood dialog box. Click OK again to obtain the parameter
estimates

θ̂1 = −0.478,

�1 = −0.591,

and

σ̂ 2 = 94, 255,

with AICC value 855.53. The corresponding fitted model for {Xt} is thus the SARIMA
(0, 1, 1) × (0, 1, 1)12 process

∇∇12Xt = 28.831 + (1 − 0.478B)
(
1 − 0.591B12) Zt, (6.5.8)

where {Zt} ∼ WN(0, 94390).
If we adopt the alternative approach of fitting a subset ARMA model to {Yt}

without seeking a multiplicative structure for the operators φ∗(B) and θ∗(B) in (6.5.2),
we begin by fitting a preliminary MA(13) model (as suggested by Figure 6-17) to
the series {Yt}. We then fit a maximum likelihood MA(13) model and examine the
standard errors of the coefficient estimators. This suggests setting the coefficients at
lags 2, 3, 8, 10, and 11 equal to zero, since these are all less than one standard error from
zero. To do this select Model>Estimation>Max likelihood and click on the
button Constrain optimization. Then highlight the coefficients to be set to
zero and click on the button Set to zero. Click OK to return to the Maximum
Likelihood Estimation dialog box and again to carry out the constrained
optimization. The coefficients that have been set to zero will be held at that value, and
the optimization will be with respect to the remaining coefficients. This gives a model
with substantially smaller AICC than the unconstrained MA(13) model. Examining
the standard errors again we see that the coefficients at lags 4, 5, and 7 are promising
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candidates to be set to zero, since each of them is less than one standard error from
zero. Setting these coefficients to zero in the same way and reoptimizing gives a further
reduction in AICC. Setting the coefficient at lag 9 to zero and reoptimizing again gives
a further reduction in AICC (to 855.61) and the fitted model

∇∇12Xt = 28.831 + Zt − 0.596Zt−1 − 0.407Zt−6 − 0.685Zt−12 + 0.460Zt−13,

{Zt} ∼ WN(0, 71240). (6.5.9)

The AICC value 855.61 is quite close to the value 855.53 for the model (6.5.8). The
residuals from the two models are also very similar, the randomness tests (with the
exception of the difference-sign test) yielding high p-values for both.

6.5.1 Forecasting SARIMA Processes

Forecasting SARIMAprocesses is completely analogous to the forecasting of ARIMA
processes discussed in Section 6.4. Expanding out the operator (1 − B)d

(
1 − Bs

)D
in

powers of B, rearranging the equation

(1 − B)d (1 − Bs)
D Xt = Yt,

and setting t = n + h gives the analogue

Xn+h = Yn+h +
d+Ds∑

j=1

ajXn+h−j (6.5.10)

of equation (6.4.2). Under the assumption that the first d+Ds observations X−d−Ds+1,

. . . ,X0 are uncorrelated with {Yt, t ≥ 1}, we can determine the best linear predictors
PnXn+h of Xn+h based on {1,X−d−Ds+1, . . . ,Xn} by applying Pn to each side of (6.5.10)
to obtain

PnXn+h = PnYn+h +
d+Ds∑

j=1

ajPnXn+h−j. (6.5.11)

The first term on the right is just the best linear predictor of the (possibly nonzero-
mean) ARMA process {Yt} in terms of {1,Y1, . . . ,Yn}, which can be calculated as
described in Section 3.3. The predictors PnXn+h can then be computed recursively for
h = 1, 2, . . . from (6.5.11), if we note that PnXn+1−j = Xn+1−j for each j ≥ 1.

An argument analogous to the one leading to (6.4.5) gives the prediction mean
squared error as

σ 2
n (h) = E(Xn+h − PnXn+h)

2 =
h−1∑

j=0

(
j∑

r=0

χrθn+h−r−1,j−r

)2

vn+h−j−1,

(6.5.12)

where θnj and vn are obtained by applying the innovations algorithm to the differenced
series {Yt} and

χ(z) =
∞∑

r=0

χrz
r =

[
φ(z)�

(
z s
)
(1 − z)d

(
1 − z s

)D
]−1

, |z| < 1.
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Table 6.1 Predicted values of the Accidental Deaths series for
t = 73, . . . ,78, the standard deviations σt of the
prediction errors, and the corresponding observed
values of Xt f r the same period

t 73 74 75 76 77 78

Model (6.5.8)
Predictors 8441 7704 8549 8885 9843 10279

σt 308 348 383 415 445 474
Model (6.5.9)

Predictors 8345 7619 8356 8742 9795 10179
σt 292 329 366 403 442 486

Observed values
Xt 7798 7406 8363 8460 9217 9316

For large n we can approximate (6.5.12), if θ(z)� (z s) is nonzero for all |z| ≤ 1, by

σ 2
n (h) =

h−1∑

j=0

ψ2
j σ

2, (6.5.13)

where

ψ(z) =
∞∑

j=0

ψj z
j = θ(z)� (z s)

φ(z)� (z s) (1 − z)d (1 − z s)D
, |z| < 1.

The required calculations can all be carried out with the aid of the program ITSM.
The mean squared errors are computed from the large-sample approximation (6.5.13)
if the fitted model is invertible. If the fitted model is not invertible, ITSM computes the
mean squared errors by converting the model to the equivalent (in terms of Gaussian
likelihood) invertible model and then using (6.5.13).

Example 6.5.5 Monthly Accidental Deaths

Continuing with Example 6.5.4, we next use ITSM to predict six future values of
the Accidental Deaths series using the fitted models (6.5.8) and (6.5.9). First fit the
desired model as described in Example 6.5.4 or enter the data and model directly
by opening the file DEATHS.TSM, differencing at lags 12 and 1, subtracting the
mean, and then entering the MA(13) coefficients and white noise variance using the
option Model>Specify. Select Forecasting>ARMA, and you will see the ARMA
Forecast dialog box. Enter 6 for the number of predicted values required. You will
notice that the default options in the dialog box are set to generate predictors of the
original series by reversing the transformations applied to the data. If for some reason
you wish to predict the transformed data, these check marks can be removed. If you
wish to include prediction bounds in the graph of the predictors, check the appropriate
box and specify the desired coefficient (e.g., 95%). Click OK, and you will see a
graph of the data with the six predicted values appended. For numerical values of
the predictors and prediction bounds, right-click on the graph and then on Info. The
prediction bounds are computed under the assumption that the white noise sequence in
the ARMAmodel for the transformed data is Gaussian. Table 6.1 shows the predictors
and standard deviations of the prediction errors under both models (6.5.8) and (6.5.9)
for the Accidental Deaths series.

�
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6.6 Regression with ARMA Errors

6.6.1 OLS and GLS Estimation

In standard linear regression, the errors (or deviations of the observations from the
regression function) are assumed to be independent and identically distributed. In
many applications of regression analysis, however, this assumption is clearly
violated, as can be seen by examination of the residuals from the fitted regression
and their sample autocorrelations. It is often more appropriate to assume that the
errors are observations of a zero-mean second-order stationary process. Since many
autocorrelation functions can be well approximated by the autocorrelation function of
a suitably chosen ARMA(p, q) process, it is of particular interest to consider the model

Yt = x′
tβ + Wt, t = 1, . . . , n, (6.6.1)

or in matrix notation,

Y = Xβ + W, (6.6.2)

where Y = (Y1, . . . ,Yn)
′ is the vector of observations at times t = 1, . . . , n, X

is the design matrix whose tth row, x′
t = (xt1, . . . , xtk), consists of the values of

the explanatory variables at time t, β = (β1, . . . ,βk)
′ is the vector of regression

coefficients, and the components of W = (W1, . . . ,Wn)
′ are values of a causal zero-

mean ARMA( p, q) process satisfying

φ(B)Wt = θ(B)Zt, {Zt} ∼ WN
(
0, σ 2) . (6.6.3)

The model (6.6.1) arises naturally in trend estimation for time series data. For
example, the explanatory variables xt1 = 1, xt2 = t, and xt3 = t2 can be used to
estimate a quadratic trend, and the variables xt1 = 1, xt2 = cos(ωt), and xt3 = sin(ωt)
can be used to estimate a sinusoidal trend with frequency ω. The columns of X are
not necessarily simple functions of t as in these two examples. Any specified column
of relevant variables, e.g., temperatures at times t = 1, . . . , n, can be included in the
design matrix X, in which case the regression is conditional on the observed values of
the variables included in the matrix.

The ordinary least squares (OLS) estimator of β is the value, β̂OLS, which
minimizes the sum of squares

(Y − Xβ)′(Y − Xβ) =
n∑

t=1

(
Yt − x′

tβ
)2
.

Equating to zero the partial derivatives with respect to each component of β and
assuming (as we shall) that X′X is nonsingular, we find that

β̂OLS = (X′X)−1X′Y. (6.6.4)

(If X′X is singular, β̂OLS is not uniquely determined but still satisfies (6.6.4) with
(X′X)−1 any generalized inverse of X′X.) The OLS estimate also maximizes the
likelihood of the observations when the errors W1, . . . ,Wn are iid and Gaussian. If
the design matrix X is nonrandom, then even when the errors are non-Gaussian and
dependent, the OLS estimator is unbiased (i.e., E

(
β̂OLS

) = β) and its covariance
matrix is

Cov(β̂OLS) = (
X′X

)−1
X′�nX

(
X′X

)−1
, (6.6.5)

where �n = E
(
WW′) is the covariance matrix ofW.
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The generalized least squares (GLS) estimator of β is the value β̂GLS that
minimizes the weighted sum of squares

(Y − Xβ)′ �−1
n (Y − Xβ) . (6.6.6)

Differentiating partially with respect to each component of β and setting the deriva-
tives equal to zero, we find that

β̂GLS = (
X′�−1

n X
)−1

X′�−1
n Y. (6.6.7)

If the design matrix X is nonrandom, the GLS estimator is unbiased and has covariance
matrix

Cov
(
β̂GLS

)
= (

X′�−1
n X

)−1
. (6.6.8)

It can be shown that the GLS estimator is the best linear unbiased estimator of β, i.e.,
for any k-dimensional vector c and for any unbiased estimator β̂ of β that is a linear
function of the observations Y1, . . . ,Yn,

Var
(
c′β̂GLS

)
≤ Var

(
c′β̂

)
.

In this sense the GLS estimator is therefore superior to the OLS estimator. However,
it can be computed only if φ and θ are known.

Let V(φ,θ) denote the matrix σ−2�n and let T(φ,θ) be any square root of V−1

(i.e., a matrix such that T ′T = V−1). Then we can multiply each side of (6.6.2) by T
to obtain

TY = TXβ + TW, (6.6.9)

a regression equation with coefficient vector β, data vector TY, design matrix TX, and
error vector TW. Since the latter has uncorrelated, zero-mean components, each with
variance σ 2, the best linear estimator of β in terms of TY (which is clearly the same
as the best linear estimator of β in terms of Y, i.e., β̂GLS) can be obtained by applying
OLS estimation to the transformed regression equation (6.6.9). This gives

β̂GLS = (
X′T ′TX

)−1
X′T ′TY, (6.6.10)

which is clearly the same as (6.6.7). Cochran and Orcutt (1949) pointed out that if {Wt}
is an AR( p) process satisfying

φ(B)Wt = Zt, {Zt} ∼ WN
(
0, σ 2

)
,

then application of φ(B) to each side of the regression equations (6.6.1) transforms
them into regression equations with uncorrelated, zero-mean, constant-variance errors,
so that ordinary least squares can again be used to compute best linear unbiased
estimates of the components of β in terms of Y∗

t = φ(B)Yt, t = p + 1, . . . , n. This
approach eliminates the need to compute the matrix T but suffers from the drawback
thatY∗ does not contain all the information inY. Cochrane and Orcutt’s transformation
can be improved, and at the same generalized to ARMA errors, as follows.

Instead of applying the operator φ(B) to each side of the regression equations
(6.6.1), we multiply each side of equation (6.6.2) by the matrix T(φ,θ) that maps {Wt}
into the residuals [see (5.3.1)] of {Wt} from the ARMAmodel (6.6.3). We have already
seen how to calculate these residuals using the innovations algorithm in Section 3.3.
To see that T is a square root of the matrix V as defined in the previous paragraph, we
simply recall that the residuals are uncorrelated with zero mean and variance σ 2, so
that

Cov(TW) = T�nT
′ = σ 2I,
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where I is the n × n identity matrix. Hence

T ′T = σ 2�−1
n = V−1.

GLS estimation ofβ can therefore be carried out by multiplying each side of (6.6.2) by
T and applying ordinary least squares to the transformed regression model. It remains
only to compute TY and TX.

Any data vector d = (d1, . . . , dn)′ can be left-multiplied by T simply by reading it
into ITSM, entering the model (6.6.3), and pressing the green button labeled RES,
which plots the residuals. (The calculations are performed using the innovations
algorithm as described in Section 3.3.) The GLS estimator β̂GLS is computed as
follows. The data vector Y is left-multiplied by T to generate the transformed data
vector Y∗, and each column of the design matrix X is left-multiplied by T to generate
the corresponding column of the transformed design matrix X∗. Then

β̂GLS =
(
X∗′

X∗
)−1

X∗′
Y∗. (6.6.11)

The calculations ofY∗, X∗, and hence of β̂GLS, are all carried out by the program ITSM
in the option Regression>Estimation>Generalized LS.

6.6.2 ML Estimation

If (as is usually the case) the parameters of the ARMA(p, q) model for the errors
are unknown, they can be estimated together with the regression coefficients by
maximizing the Gaussian likelihood

L
(
β, φ,θ, σ 2) = (2π)−n/2(det�n)

−1/2 exp

{

−1

2

(
Y − Xβ

)′
�−1
n

(
Y − Xβ

)
}

,

where �n

(
φ,θ, σ 2

)
is the covariance matrix of W = Y − Xβ. Since {Wt} is an

ARMA(p, q) process with parameters
(
φ,θ, σ 2

)
, the maximum likelihood estimators

β̂, φ̂, and θ̂ are found (as in Section 5.2) by minimizing

�(β, φ,θ) = ln
(
n−1S(β, φ,θ)

) + n−1
n∑

t=1

ln rt−1, (6.6.12)

where

S(β, φ,θ) =
n∑

t=1

(
Wt − Ŵt

)2
/rt−1,

Ŵt is the best one-step predictor ofWt, and rt−1σ
2 is its mean squared error. The func-

tion �(β, φ,θ) can be expressed in terms of the observations {Yt} and the parameters β,
φ, and θ using the innovations algorithm (see Section 3.3) and minimized numerically
to give the maximum likelihood estimators, β̂, φ̂, and θ̂. The maximum likelihood

estimator of σ 2 is then given, as in Section 5.2, by σ̂ 2 = S
(
β̂, φ̂, θ̂

)
/n.

An extension of an iterative scheme, proposed by Cochran and Orcutt (1949) for
the case q = 0, simplifies the minimization considerably. It is based on the observation
that for fixed φ and θ, the value of β that minimizes �(β, φ,θ) is β̂GLS(φ,θ), which
can be computed algebraically from (6.6.11) instead of by searching numerically for
the minimizing value. The scheme is as follows.

(i) Compute β̂OLS and the estimated residuals Yt − x′
tβ̂OLS, t = 1, . . . , n.
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(ii) Fit an ARMA(p.q) model by maximum Gaussian likelihood to the estimated
residuals.

(iii) For the fitted ARMA model compute the corresponding estimator β̂GLS from
(6.6.11).

(iv) Compute the residuals Yt − x′
tβ̂GLS, t = 1, . . . , n, and return to (ii), stopping

when the estimators have stabilized.

If {Wt} is a causal and invertible ARMA process, then under mild conditions on
the explanatory variables xt, the maximum likelihood estimates are asymptotically
multivariate normal (see Fuller 1976). In addition, the estimated regression coefficients
are asymptotically independent of the estimated ARMA parameters.

The large-sample covariance matrix of the ARMA parameter estimators, suitably
normalized, has a complicated form that involves both the regression variables xt and
the covariance function of {Wt}. It is therefore convenient to estimate the covariance
matrix as −H−1, where H is the Hessian matrix of the observed log-likelihood
evaluated at its maximum.

The OLS, GLS, and maximum likelihood estimators of the regression coefficients
all have the same asymptotic covariance matrix, so in this sense the dependence does
not play a major role. However, the asymptotic covariance of both the OLS and GLS
estimators can be very inaccurate if the appropriate covariance matrix �n is not used in
the expressions (6.6.5) and (6.6.8). This point is illustrated in the following examples.

Remark 1. The use of the innovations algorithm for GLS and ML estimation extends
to regression with ARIMA errors (see Example 6.6.3 below) and FARIMA errors
(FARIMA processes are defined in Section 10.5). �

Example 6.6.1 The Overshort Data

The analysis of the overshort data in Example 3.2.8 suggested the model

Yt = β + Wt,

where −β is interpreted as the daily leakage from the underground storage tank and
{Wt} is the MA(1) process

Wt = Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2) .

(Here k = 1 and xt1 = 1.) The OLS estimate of β is simply the sample mean β̂OLS =
Ȳn = −4.035. Under the assumption that {Wt} is iid noise, the estimated variance
of the OLS estimator of β is γ̂Y (0)/57 = 59.92. However, since this estimate of the
variance fails to take dependence into account, it is not reliable.

To find maximum Gaussian likelihood estimates of β and the parame-
ters of {Wt} using ITSM, open the file OSHORTS.TSM, select the option
Regression>Specify and check the box marked Include intercept
term only. Then press the blue GLS button and you will see the estimated value
of β. (This is in fact the same as the OLS estimator since the default model in ITSM
is WN(0,1).) Then select Model>Estimation>Autofit and press Start. The
autofit option selects the minimum AICC model for the residuals,

Wt = Zt − 0.818Zt−1, {Zt} ∼ WN(0, 2041), (6.6.13)

and displays the estimated MA coefficient θ̂ (0)1 = −0.818 and the corresponding GLS
estimate β̂(1)GLS = −4.745, with a standard error of 1.188, in the Regression
estimates window. (If we reestimate the variance of the OLS estimator, using
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(6.6.5) with�57 computed from themodel (6.6.13), we obtain the value 2.214, a drastic
reduction from the value 59.92 obtained when dependence is ignored. For a positively
correlated time series, ignoring the dependence would lead to underestimation of the
variance.)

Pressing the blue MLE button will reestimate the MA parameters using the
residuals from the updated regression and at the same time reestimate the regression
coefficient, printing the new parameters in the Regression estimateswindow.
After this operation has been repeated several times, the parameters will stabilize, as
shown in Table 6.2. Estimated 95% confidence bounds for β using the GLS estimate
are −4.75 ± 1.96(1.408)1/2 = (−7.07,−2.43), strongly suggesting that the storage
tank has a leak. Such a conclusion would not have been reached without taking into
account the dependence in the data.

�

Table 6.2 Estimates of β and θ1
for the overshort data of
Example 6.6.1

Iteration i θ̂ (i) β̂
(i)
1

0 0 −4.035
1 −0.818 −4.745
2 −0.848 −4.780
3 −0.848 −4.780

Example 6.6.2 The Lake Data

In Examples 5.2.4 and 5.5.2 we found maximum likelihood ARMA(1,1) and AR(2)
models for the mean-corrected lake data. Now let us consider fitting a linear trend to
the data with AR(2) noise. The choice of an AR(2) model was suggested by an analysis
of the residuals obtained after removing a linear trend from the data using OLS. Our
model now takes the form

Yt = β0 + β1t + Wt,

where {Wt} is the AR(2) process satisfying
Wt = φ1Wt−1 + φ2Wt−2 + Zt, {Zt} ∼ WN

(
0, σ 2

)
.

From Example 1.3.5, we find that the OLS estimate ofβ is β̂OLS=(10.202,−0.0242)′ .
If we ignore the correlation structure of the noise, the estimated covariance matrix �n

ofW is γ̂ (0)I (where I is the identity matrix). The corresponding estimated covariance
matrix of β̂OLS is (from (6.6.5))

γ̂Y(0)
(
X′X

)−1 = γ̂Y(0)

[
n

∑n
t=1 t

∑n
t=1 t

∑n
t=1 t

2

]−1

=
[

0.07203 −0.00110
−0.00110 0.00002

]

.

(6.6.14)

However, the estimated model for the noise process, found by fitting an AR(2) model
to the residuals Yt − β̂′

OLSxt, is

Wt = 1.008Wt−1 − 0.295Wt−2 + Zt, {Zt} ∼ WN(0, 0.4571).
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Table 6.3 Estimates of β and φ for the lake data
after 3 iterations

Iteration i φ̂
(i)
1 φ̂

(i)
2 β̂

(i)
1 β̂

(i)
2

0 0 0 10.20 −0.0242

1 1.008 −0.295 10.09 −0.0216

2 1.005 −0.291 10.09 −0.0216

Assuming that this is the true model for {Wt}, the GLS estimate is found to be
(10.091,−0.0216)′ , in close agreement with the OLS estimate. The estimated covari-
ance matrices for the OLS and GLS estimates are given by

Cov
(
β̂OLS

)
=
[

0.22177 −0.00335
−0.00335 0.00007

]

and

Cov
(
β̂GLS

)
=
[

0.21392 −0.00321
−0.00321 0.00006

]

.

Notice how the estimated variances of the OLS and GLS estimators are nearly three
times the magnitude of the corresponding variance estimates of the OLS calculated
under the independence assumption [see (6.6.14)]. Estimated 95% confidence bounds
for the slope β1 using the GLS estimate are−0.0216±1.96(0.00006)1/2 = −0.0216±
.0048, indicating a significant decreasing trend in the level of Lake Huron during the
years 1875–1972.

The iterative procedure described above was used to produce maximum likelihood
estimates of the parameters. The calculations using ITSM are analogous to those
in Example 6.6.1. The results from each iteration are summarized in Table 6.3.
As in Example 6.6.1, the convergence of the estimates is very rapid.

�

Example 6.6.3 Seat-Belt Legislation; SBL.TSM

Figure 6-18 shows the numbers of monthly deaths and serious injuries Yt, t =
1, . . . , 120, on UK roads for 10 years beginning in January 1975. They are filed
as SBL.TSM. Seat-belt legislation was introduced in February 1983 in the hope of
reducing the mean number of monthly “deaths and serious injuries,” (from t = 99
onwards). In order to study whether or not there was a drop in mean from that time
onwards, we consider the regression,

Yt = a + bf (t)+ Wt, t = 1, . . . , 120, (6.6.15)

where ft = 0 for 1 ≤ t ≤ 98, and ft = 1 for t ≥ 99. The seat-belt legislation
will be considered effective if the estimated value of the regression coefficient b
is significantly negative. This problem also falls under the heading of intervention
analysis (see Section 11.2).

OLS regression based on the model (6.6.15) suggests that the error sequence {Wt}
is highly correlated with a strong seasonal component of period 12. (To do the regres-
sion using ITSM open the file SBL.TSM, select Regression>Specify, check
only Include intercept term and Include auxiliary variables,
press the Browse button, and select the file SBLIN.TSM, which contains the
function ft of (6.6.15) and enter 1 for the number of columns. Then select the
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Figure 6-18
Monthly deaths and serious
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option Regression>Estimation>Generalized LS. The estimates of the
coefficients a and b are displayed in the Regression estimates window, and
the data become the estimates of the residuals {Wt}.) The graphs of the data and
sample ACF clearly suggest a strong seasonal component with period 12. In order to
transform the model (6.6.15) into one with stationary residuals, we therefore consider
the differenced data Xt = Yt − Yt−12, which satisfy

Xt = bgt + Nt, t = 13, . . . , 120, (6.6.16)

where gt = 1 for 98 ≤ t ≤ 110, gt = 0 otherwise, and {Nt = Wt − Wt−12} is a
stationary sequence to be represented by a suitably chosen ARMA model. The series
{Xt} is contained in the file SBLD.TSM, and the function gt is contained in the file
SBLDIN.TSM.

The next step is to perform ordinary least squares regression of Xt on gt following
steps analogous to those of the previous paragraph (but this time checking only the
box marked Include auxiliary variables in the Regression Trend
Function dialog box) and again using the option Regression>Estimation>
Generalized LS or pressing the blue GLS button. The model

Xt = −346.92gt + Nt, (6.6.17)

is then displayed in the Regression estimates window together with the
assumed noise model (white noise in this case). Inspection of the sample ACF
of the residuals suggests an MA(13) or AR(13) model for {Nt}. Fitting AR
and MA models of order up to 13 (with no mean-correction) using the option
Model>Estimation>Autofit gives an MA(12) model as the minimum AICC
fit for the residuals. Once this model has been fitted, the model in the Regression
estimateswindow is automatically updated to

Xt = −328.45gt + Nt, (6.6.18)

with the fitted MA(12) model for the residuals also displayed. After several iterations
(each iteration is performed by pressing the MLE button) we arrive at the model

Xt = −328.45gt + Nt, (6.6.19)
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Figure 6-19
The differenced deaths and
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with

Nt = Zt+0.219Zt−1+0.098Zt−2+0.031Zt−3+0.064Zt−4+0.069Zt−5+0.111Zt−6

+0.081Zt−7 + 0.057Zt−8+0.092Zt−9 − 0.028Zt−10+0.183Zt−11−0.627Zt−12,

where {Zt} ∼ WN(0, 12, 581). The estimated standard deviation of the regression
coefficient estimator is 49.41, so the estimated coefficient, −328.45, is very signifi-
cantly negative, indicating the effectiveness of the legislation. The differenced data are
shown in Figure 6-19 with the fitted regression function.

�
Problems

6.1 Suppose that {Xt} is an ARIMA(p, d, q) process satisfying the difference
equations

φ(B)(1 − B)dXt = θ(B)Zt, {Zt} ∼ WN
(
0, σ 2

)
.

Show that these difference equations are also satisfied by the process Wt = Xt +
A0 + A1t + · · · + Ad−1td−1, where A0, . . . ,Ad−1 are arbitrary random variables.

6.2 Verify the representation given in (6.3.4).

6.3 Test the data in Example 6.3.1 for the presence of a unit root in an AR(2) model
using the augmented Dickey–Fuller test.

6.4 Apply the augmented Dickey–Fuller test to the levels of Lake Huron data
(LAKE.TSM). Perform two analyses assuming AR(1) and AR(2) models.

6.5 If {Yt} is a causal ARMA process (with zero mean) and if X0 is a random
variable with finite second moment such that X0 is uncorrelated with Yt for each
t = 1, 2, . . ., show that the best linear predictor of Yn+1in terms of 1,
X0,Y1, . . . ,Yn is the same as the best linear predictor of Yn+1 in terms of
1,Y1, . . . ,Yn.
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6.6 Let {Xt} be the ARIMA(2,1,0) process satisfying
(
1 − 0.8B + 0.25B2

)∇Xt = Zt, {Zt} ∼ WN(0, 1).

(a) Determine the forecast function g(h) = PnXn+h for h > 0.
(b) Assuming that n is large, compute σ 2

n (h) for h = 1, . . . , 5.

6.7 Use a text editor to create a new data set ASHORT.TSM that consists of the data
in AIRPASS.TSMwith the last 12 values deleted. Use ITSM to find an ARIMA
model for the logarithms of the data in ASHORT.TSM. Your analysis should
include
(a) a logical explanation of the steps taken to find the chosen model,
(b) approximate 95% bounds for the components of φ and θ,
(c) an examination of the residuals to check for whiteness as described in

Section 1.6,
(d) a graph of the series ASHORT.TSM showing forecasts of the next 12 values

and 95% prediction bounds for the forecasts,
(e) numerical values for the 12-step ahead forecast and the corresponding 95%

prediction bounds,
(f) a table of the actual forecast errors, i.e.„ the true value (deleted from

AIRPASS.TSM) minus the forecast value, for each of the 12 forecasts.
Does the last value of AIRPASS.TSM lie within the corresponding 95% pre-
diction bounds?

6.8 Repeat Problem 6.7, but instead of differencing, apply the classical decomposi-
tion method to the logarithms of the data in ASHORT.TSM by deseasonalizing,
subtracting a quadratic trend, and then finding an appropriate ARMA model
for the residuals. Compare the 12 forecast errors found from this approach with
those found in Problem 6.7.

6.9 Repeat Problem 6.7 for the series BEER.TSM, deleting the last 12 values
to create a file named BSHORT.TSM.

6.10 Repeat Problem 6.8 for the series BEER.TSM and the shortened series
BSHORT.TSM.

6.11 A time series {Xt} is differenced at lag 12, then at lag 1 to produce a zero-mean
series {Yt} with the following sample ACF:

ρ̂(12j) ≈ (0.8) j, j = 0,±1,±2, . . . ,

ρ̂(12j ± 1) ≈ (0.4)(0.8) j, j = 0,±1,±2, . . . ,

ρ̂(h) ≈ 0, otherwise,

and γ̂ (0) = 25.
(a) Suggest a SARIMA model for {Xt} specifying all parameters.
(b) For large n, express the one- and twelve-step linear predictors PnXn+1 and

PnXn+12 in terms of Xt, t = −12,−11, . . . , n, and Yt − Ŷt, t = 1, . . . , n.
(c) Find the mean squared errors of the predictors in (b).

6.12 Use ITSM to verify the calculations of Examples 6.6.1–6.6.3.

6.13 The file TUNDRA.TSM contains the average maximum temperature over the
month of February for the years 1895-1993 in an area of the USA whose
vegetation is characterized as tundra.
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(a) Fit a straight line to the data using OLS. Is the slope of the line significantly
different from zero?

(b) Find an appropriate ARMA model to the residuals from the OLS fit in (a).
(c) Calculate the MLE estimates of the intercept and the slope of the line and

the ARMA parameters in (a). Is the slope of the line significantly different
from zero?

(d) Use your model to forecast the average maximum temperature for the years
1994–2004.



7 Time Series Models
for Financial Data

7.1 Historical Overview
7.2 GARCH Models
7.3 Modified GARCH Processes
7.4 Stochastic Volatility Models
7.5 Continuous-Time Models
7.6 An Introduction to Option Pricing

In this chapter we discuss some of the time series models which have been found useful
in the analysis of financial data. These include both discrete-time and continuous-
time models, the latter being used widely, following the celebrated work of Black,
Merton and Scholes, for the pricing of stock options. The closing price on trading
day t, say Pt, of a particular stock or stock-price index, typically appears to be non-
stationary while the log asset price, Xt := log(Pt), has observed sample-paths like
those of a random walk with stationary uncorrelated increments, i.e., the differenced
log asset price, Zt := Xt − Xt−1, known as the log return (or simply return) for
day t, has sample-paths resembling those of white noise. Although the sequence Zt

appears to be white noise, there is strong evidence to suggest that it is not independent
white noise. Much of the analysis of financial time series is devoted to representing
and exploiting this dependence, which is not visible in the sample autocorrelation
function of {Zt}. The continuous time analogue of a random walk with independent
and identically distributed increments is known as a Lévy process, the most familiar
examples of which are the Poisson process and Brownian motion. Lévy processes
play a key role in the continuous-time modeling of financial data, both as models
for the log asset price itself and as building blocks for more complex models. We
give a brief introduction to these processes and some of the continuous-time models
constructed from them. Finally we consider the pricing of European stock options
using the geometric Brownian motion model for stock prices, a model which, in spite
of its limitations, has been found useful in practice.
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7.1 Historical Overview

For more than 30 years now, discrete-time models (including stochastic volatility,
ARCH, GARCH and their many generalizations) have been developed to reflect the
so-called stylized features of financial time series. These properties, which include tail
heaviness, asymmetry, volatility clustering and serial dependence without correlation,
cannot be captured with traditional linear time series models such as the ARMA
models considered earlier in this book. If Pt denotes the price of a stock or other
financial asset at time t, t ∈ Z, then the series of log returns, {Zt := logPt − logPt−1},
is typically modeled as a stationary time series. An ARMA model for the series {Zt}
would have the property that the conditional variance ht of Zt given {Zs, s < t} is
independent of t and of {Zs, s < t}. However even a cursory inspection of most
empirical log return series (see e.g., Figure 7-4) strongly suggests that this is not
the case in practice. The fundamental idea of the ARCH (autoregressive conditional
heteroscedasticity) model (Engle 1982) is to incorporate the sequence {ht} into the
model by postulating that

Zt = √
htet, where {et} ∼ IID N(0, 1)

and ht (known as the volatility) is related to the past values of Z2
t via a relation of the

form,

ht = α0 +
p∑

i=1

αiZ
2
t−i,

for some positive integer p, where α0 > 0 and αi ≥ 0, i = 1, . . . , p. The GARCH
(generalized ARCH) model of Bollerslev (1986) postulates a more general relation,

ht = α0 +
p∑

i=1

αiZ
2
t−i +

q∑

i=1

βiht−i,

with α0 > 0, αi ≥ 0, i = 1, . . . , p, and βi ≥ 0, i = 1, . . . , q. These models have
been studied intensively since their introduction and a variety of parameter estimation
techniques have been developed. They will be discussed in Section 7.2 and some of
their extensions in Section 7.3.

An alternative approach to modeling the changing variability of log returns, due
to Taylor (1982), is to suppose that Zt = √

htet, where {et} ∼ IID(0, 1) and the
volatility sequence {ht} is independent of {et}. (Taylor originally allowed {et} to be
an autoregression, but it is now customary to use the more restrictive definition just
given.) A critical difference from the ARCH and GARCH models is the fact that the
conditional distribution of ht given {hs, s < t} is independent of {es, s < t}. A widely
used special case of this model is the so-called log-normal stochastic volatility (SV)
model in which {et} ∼ IID N(0, 1), ln ht = γ0 + γ1 ln ht−1 + ηt, {ηt} ∼ IID N(0, σ 2)

and {ηt} and {et} are independent. We shall discuss this model in Section 7.4.
Continuous-time models for financial time series have a long history, going back

at least to Bachelier (1900), who used Brownian motion to represent the prices
{P(t), t ≥ 0} of a stock in the Paris stock exchange. This model had the unfortunate
feature of permitting negative stock prices, a shortcoming which was eliminated in
the geometric Brownian motion model of Samuelson (1965), according to which P(t)
satisfies an Itô stochastic differential equation of the form,

dP(t) = μP(t) dt + σP(t) dB(t),
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where μ ∈ R, σ > 0 and B is standard Brownian motion. For any fixed positive value
of P(0) the solution (see Section 7.5.2 and Appendix D.4) is

P(t) = P(0) exp
[
(μ− σ 2/2)t + σB(t)] , t ≥ 0,

so that the log asset price, X(t) := logP(t), is Brownian motion and the log return over
the time-interval (t, t +Δ) is

X(t +Δ)− X(t) = (μ− 1

2
σ 2)Δ+ σ (B(t +Δ)− B(t)).

For disjoint intervals of length Δ the log returns are therefore independent normally
distributed random variables with mean (μ−σ 2/2)Δ and variance σ 2Δ. The normality
is a conclusion which can easily be checked against observed log returns, and it is
found that although the observed values are approximately normally distributed for
intervalsΔ greater than 1 day, the deviations from normality are substantial for shorter
time intervals. This is one of the reasons for developing the more realistic models
described in Section 7.5. The parameter σ 2 is called the volatility parameter of the
geometric Brownianmotion model and plays a key role in the celebrated option pricing
results (see Section 7.6) developed for this model by Black, Scholes and Merton,
earning the Nobel Economics Prize for Merton and Scholes in 1997 (unfortunately
Black died before the award wasmade). These results inspired an explosion of interest,
not only in the pricing of more complicated financial derivatives, but also in the
development of new continuous-time models which, like the discrete-time ARCH,
GARCH and stochastic volatility models, better reflect the observed properties of
financial time series.

7.2 GARCH Models

For modeling changing volatility as discussed above, Engle (1982) introduced the
ARCH(p) process {Zt} as a stationary solution of the equations

Zt = √
htet, {et} ∼ IID N(0, 1), (7.2.1)

where ht is the (positive) function of {Zs, s < t}, defined by

ht = α0 +
p∑

i=1

αiZ
2
t−i, (7.2.2)

with α0 > 0 and αj ≥ 0, j = 1, . . . , p. The name ARCH signifies autoregressive
conditional heteroscedasticity and ht is the conditional variance of Zt given {Zs, s < t}.

The simplest such process is the ARCH(1) process. In this case the recursions
(7.2.1) and (7.2.2) give

Z2
t = α0e

2
t + α1Z

2
t−1e

2
t

= α0e
2
t + α1α0e

2
t e

2
t−1 + α2

1Z
2
t−2e

2
t e

2
t−1

= · · ·

= α0

n∑

j=0

α
j
1e

2
t e

2
t−1 · · · e2

t−j + αn+1
1 Z2

t−n−1e
2
t e

2
t−1 · · · e2

t−n.
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If α1 < 1 and {Zt} is stationary and causal (i.e., Zt is a function of {es, s ≤ t}), then
the last term has expectation αn+1EZ2

t and converges to zero as n → ∞. The first term
converges as n → ∞ since it is non-decreasing in n and its expected value is bounded
above by α0/(1 − α1). Hence

Z2
t = α0

∞∑

j=0

α
j
1e

2
t e

2
t−1 · · · e2

t−j (7.2.3)

and

EZ2
t = α0/(1 − α1). (7.2.4)

Since

Zt = et

√
√
√
√
√α1

⎛

⎝1 +
∞∑

j=1

α
j
1e

2
t−1 · · · e2

t−j

⎞

⎠, (7.2.5)

it is clear that {Zt} is strictly stationary and hence, since EZ2
t < ∞, also stationary

in the weak sense. We have now established the following result.

Solution of the ARCH(1) Equations:
If α1 < 1, the unique causal stationary solution of the ARCH(1) equations is given
by (7.2.5). It has the properties

E(Zt) = E(E(Zt|es, s < t)) = 0,

Var(Zt) = α0/(1 − α1),

and

E(Zt+hZt) = E(E(Zt+hZt|es, s < t + h)) = 0 for h > 0.

Thus theARCH(1) process with α1 < 1 is strictly stationary white noise. However,
it is not an iid sequence, since from (7.2.1) and (7.2.2),

E(Z2
t |Zt−1) = (α0 + α1Z

2
t−1)E(e

2
t |Zt−1) = α0 + α1Z

2
t−1.

This also shows that {Zt} is not Gaussian, since strictly stationary Gaussian white noise
is necessarily iid. From (7.2.5) it is clear that the distribution of Zt is symmetric, i.e.,
that Zt and −Zt have the same distribution. From (7.2.3) it is easy to calculate E

(
Z4
t

)

(Problem 7.1) and hence to show that E
(
Z4
t

)
is finite if and only if 3α2

1 < 1. More
generally (see Engle 1982), it can be shown that for every α1 in the interval (0, 1),
E
(
Z2k

) = ∞ for some positive integer k. This indicates the “heavy-tailed” nature of
the marginal distribution of Zt. If EZ4

t < ∞, the squared process Yt = Z2
t has the same

ACF as the AR(1) process Wt = α1Wt−1 + et, a result that extends also to ARCH(p)
processes (see Problem 7.3).

The ARCH(p) process is conditionally Gaussian, in the sense that for given values
of {Zs, s = t − 1, t − 2, . . . , t − p}, Zt is Gaussian with known distribution. This
makes it easy to write down the likelihood of Zp+1, . . . ,Zn conditional on {Z1, . . . ,Zp}
and hence, by numerical maximization, to compute conditional maximum likelihood
estimates of the parameters. For example, the conditional likelihood of observations
{z2, . . . , zn} of the ARCH(1) process given Z1 = z1 is
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Figure 7-1
A realization of the process
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Example 7.2.1 An ARCH(1) Series

Figure 7-1 shows a realization of the ARCH(1) process with α0 = 1 and α1 = 0.5. The
graph of the realization and the sample autocorrelation function shown in Figure 7-2
suggest that the process is white noise. This conclusion is correct from a second-order
point of view.

However, the fact that the series is not a realization of iid noise is very strongly
indicated by Figure 7-3, which shows the sample autocorrelation function of the series{
Z2
t

}
. (The sample ACF of {|Zt|} and that of {Z2

t } can be plotted in ITSM by selecting
Statistics>Residual Analysis>ACF abs values/Squares.)
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Figure 7-3
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It is instructive to apply the Ljung–Box and McLeod–Li portmanteau tests for
white noise to this series (see Section 1.6). To do this using ITSM, open the file
ARCH.TSM, and then select Statistics>Residual Analysis>Tests of
Randomness. We find (with h = 20) that the Ljung–Box test (and all the others
except for the McLeod–Li test) are passed comfortably at level 0.05. However,
the McLeod–Li test gives a p-value of 0 to five decimal places, clearly reject-
ing the hypothesis that the series is iid.

�
The GARCH(p, q) process (see Bollerslev 1986) is a generalization of the

ARCH(p) process in which the variance equation (7.2.2) is replaced by

ht = α0 +
p∑

i=1

αiZ
2
t−i +

q∑

j=1

βjht−j, (7.2.6)

with α0 > 0 and αj, βj ≥ 0, j = 1, 2, . . . .
In the analysis of empirical financial data such as percentage daily stock returns

(defined as 100 ln(Pt/Pt−1), where Pt is the closing price on trading day t), it is usually
found that better fits to the data are obtained by relaxing the Gaussian assumption in
(7.2.1) and supposing instead that the distribution of Zt given {Zs, s < t} has a heavier-
tailed zero-mean distribution such as Student’s t-distribution. To incorporate such
distributions we can define a general GARCH(p, q) process as a stationary process
{Zt} satisfying (7.2.6) and the generalized form of (7.2.1),

Zt = √
htet, {et} ∼ IID(0, 1). (7.2.7)

For modeling purposes it is usually assumed in addition that either

et ∼ N(0, 1), (7.2.8)

(as in (7.2.1)) or that
√

ν

ν − 2
et ∼ tν, ν > 2, (7.2.9)
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Figure 7-4
The daily percentage returns
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where tν denotes Student’s t-distribution with ν degrees of freedom. (The scale factor
on the left of (7.2.9) is introduced to make the variance of et equal to 1.) Other
distributions for et can also be used.

One of the striking features of stock return data that is reflected byGARCHmodels
is the “persistence of volatility,” or the phenomenon that large (small) fluctuations in
the data tend to be followed by fluctuations of comparable magnitude. GARCHmodels
reflect this by incorporating correlation in the sequence {ht} of conditional variances.

Example 7.2.2 Fitting GARCHModels to Stock Data

The top graph in Figure 7-4 shows the percentage daily returns of the Dow Jones
Industrial Index for the period July 1st, 1997, through April 9th, 1999, contained
in the file E1032.TSM. The graph suggests that there are sustained periods of both
high volatility (in October, 1997, and August, 1998) and of low volatility. The sample
autocorrelation function of this series, like that in Example 7.2.1, has very small values,
however the sample autocorrelations of the absolute values and squares of the data (like
those in Example 7.2.1) are significantly different from zero, indicating dependence in
spite of the lack of autocorrelation. (The sample autocorrelations of the absolute values
and squares of the residuals (or of the data if no transformations have been made and
no model fitted) can be seen by clicking on the third green button at the top of the
ITSM window.) These properties suggest that an ARCH or GARCH model might be
appropriate for this series.

�
The model

Yt = a + Zt, (7.2.10)

where {Zt} is the GARCH(p, q) process defined by (7.2.6)–(7.2.8), can be fitted using
ITSM as follows. Open the project E1032.TSM and click on the red button labeled
GAR at the top of the ITSM screen. In the resulting dialog box enter the desired values
of p and q, e.g., 1 and 1 if you wish to fit a GARCH(1,1) model. You may also enter
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initial values for the coefficients α0, . . . , αp, and β1, . . . , βq, or alternatively use the
default values specified by the program. Make sure that Use normal noise is
selected, click on OK and then click on the red MLE button. You will be advised to
subtract the sample mean (unless you wish to assume that the parameter a in (7.2.10)
is zero). If you subtract the sample mean it will be used as the estimate of a in
the model (7.2.10). The GARCH Maximum Likelihood Estimation box will
then open. When you click on OK the optimization will proceed. Denoting by {Z̃t}
the (possibly) mean-corrected observations, the GARCH coefficients are estimated
by numerically maximizing the likelihood of Z̃p+1, . . . , Z̃n conditional on the known
values Z̃1, . . . , Z̃p, and with assumed values 0 for each Z̃t, t ≤ 0, and σ̂ 2 for each ht,
t ≤ 0, where σ̂ 2 is the sample variance of {Z̃1, . . . , Z̃n}. In other words the program
maximizes

L(α0, . . . , αp, β1, . . . , βq) =
n∏

t=p+1

1

σt
φ

(
Z̃t

σt

)

, (7.2.11)

with respect to the coefficients α0, . . . , αp and β1, . . . , βq, where φ denotes the stan-
dard normal density, and the standard deviations σt = √

ht, t ≥ 1, are computed
recursively from (7.2.6) with Zt replaced by Z̃t, and with Z̃t = 0 and ht = σ̂ 2 for
t ≤ 0. To find the minimum of −2ln(L) it is advisable to repeat the optimization by
clicking on the red MLE button and then on OK several times until the result stabilizes.
It is also useful to try other initial values for α0, . . . , αp, and β1, . . . , βq, to minimize
the chance of finding only a local minimum of −2ln(L). Note that the optimization
is constrained so that the estimated parameters are all non-negative with

α̂1 + · · · + α̂p + β̂1 + · · · + β̂q < 1, (7.2.12)

and α̂0 > 0. Condition (7.2.12) is necessary and sufficient for the corresponding
GARCH equations to have a causal weakly stationary solution.

Comparison of models with different orders p and q can be made with the aid of
the AICC, which is defined in terms of the conditional likelihood L as

AICC := −2
n

n − p
lnL + 2(p + q + 2)n/(n − p − q − 3). (7.2.13)

The factor n/(n − p) multiplying the first term on the right has been introduced to
correct for the fact that the number of factors in (7.2.11) is only n− p. Notice also that
the GARCH(p, q) model has p + q + 1 coefficients.

The estimated mean is â = 0.0608 and the minimum-AICC GARCHmodel (with
Gaussian noise) for the residuals, Z̃t = Yt − â, is found to be the GARCH(1,1) with
estimated parameter values

α̂0 = 0.1300, α̂1 = 0.1266, β̂1 = 0.7922,

and an AICC value [defined by (7.2.13)] of 1469.02. The bottom graph in Figure 7-4
shows the corresponding estimated conditional standard deviations, σ̂t, which clearly
reflect the changing volatility of the series {Yt}. This graph is obtained from ITSM
by clicking on the red SV (stochastic volatility) button. Under the model defined by
(7.2.6)–(7.2.8) and (7.2.10), the GARCH residuals,

{
Z̃t/σ̂t

}
, should be approximately

IID N(0,1). A check on the independence is provided by the sample ACF of the
absolute values and squares of the residuals, which is obtained by clicking on
the fifth red button at the top of the ITSM window. These are found to be not
significantly different from zero. To check for normality, select Garch>Garch
residuals>QQ-Plot(normal). If the model is appropriate the resulting graph
should approximate a straight line through the origin with slope 1. It is found that the
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deviations from the expected line are quite large for large values of
∣
∣Z̃t

∣
∣, suggesting the

need for a heavier-tailed model, e.g., a model with conditional t-distribution as defined
by (7.2.9).

To fit the GARCH model defined by (7.2.6), (7.2.7), (7.2.9) and (7.2.10) (i.e.,
with conditional t-distribution), we proceed in the same way, but with the conditional
likelihood replaced by

L(α0, . . . , αp, β1, . . . , βq, ν) =
n∏

t=p+1

√
ν

σt
√
ν − 2

tν

(
Z̃t

√
ν

σt
√
ν − 2

)

.

(7.2.14)

Maximization is now carried out with respect to the coefficients, α0,. . . ,αp, β1,. . . ,βq
and the degrees of freedom ν of the t-density, tν . The optimization can be performed
using ITSM in exactly the sameway as described for theGARCHmodel withGaussian
noise, except that the option Use t-distribution for noise should be
checked in each of the dialog boxes where it appears. In order to locate the minimum
of −2ln(L) it is often useful to initialize the coefficients of the model by first fitting
a GARCH model with Gaussian noise and then carrying out the optimization using
t-distributed noise.

The estimated mean is â = 0.0608 as before and the minimum-AICC GARCH
model for the residuals, Z̃t = Yt − â, is the GARCH(1,1) with estimated parameter
values

α̂0 = 0.1324, α̂1 = 0.0672, β̂1 = 0.8400, ν̂ = 5.714,

and an AICC value (as in (7.2.13) with q replaced by q + 1) of 1437.89. Thus from
the point of view of AICC, the model with conditional t-distribution is substantially
better than the conditional Gaussian model. The sample ACF of the absolute values
and squares of the GARCH residuals are much the same as those found using Gaussian
noise, but the qq plot (obtained by clicking on the red QQ button and based on the t-
distribution with 5.714 degrees of freedom) is closer to the expected line than was the
case for the model with Gaussian noise.

There are many important and interesting theoretical questions associated with
the existence and properties of stationary solutions of the GARCH equations and their
moments and of the sampling properties of these processes. As indicated above, in
maximizing the conditional likelihood, ITSM constrains the GARCH coefficients to
be non-negative and to satisfy the condition (7.2.12) with α̂0 > 0. These conditions
are sufficient for the process defined by the GARCH equations to be stationary. It is
frequently found in practice that the estimated values of α1, . . . , αp and β1, . . . , βq
have a sum which is very close to 1. A GARCH(p,q) model with α1 + · · · + αp +
β1 + · · · βq = 1 is called I-GARCH (or integrated GARCH). Many generalizations
of GARCH processes (ARCH-M, E-GARCH, I-GARCH, T-GARCH, FI-GARCH,
etc., as well as ARMA models driven by GARCH noise, and regression models with
GARCH errors) can now be found in the econometrics literature see Andersen et al.
(2009).

ITSM can be used to fit ARMA and regression models with GARCH noise by
using the procedures described in Example 7.2.2 to fit a GARCHmodel to the residuals
{Z̃t} from the ARMA (or regression) fit.

Example 7.2.3 Fitting ARMA Models Driven by GARCH Noise

If we open the data file SUNSPOTS.TSM, subtract the mean and use the option
Model>Estimation>Autofitwith the default ranges for p and q, we obtain an
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ARMA(3,4) model for the mean-corrected data. Clicking on the second green button
at the top of the ITSM window, we see that the sample ACF of the ARMA residuals
is compatible with iid noise. However the sample autocorrelation functions of the
absolute values and squares of the residuals (obtained by clicking on the third green
button) indicate that they are not independent. To fit a Gaussian GARCH(1,1) model
to the ARMA residuals click on the red GAR button, enter the value 1 for both p and
q and click OK. Then click on the red MLE button, click OK in the dialog box, and
the GARCH ML Estimates window will open, showing the estimated parameter
values. Repeat the steps in the previous sentence two more times and the window will
display the following ARMA(3,4) model for the mean-corrected sunspot data and the
fitted GARCH model for the ARMA noise process {Zt},

Xt = 2.463Xt−1 − 2.248Xt−2 + 0.757Xt−3 + Zt − 0.948Zt−1

− 0.296Zt−2 + 0.313Zt−3 + 0.136Zt−4,

where

Zt = √
htet

and

ht = 31.152 + 0.223Z2
t−1 + 0.596ht−1.

The AICC value for the GARCH fit (805.12) should be used for comparing alternative
GARCH models for the ARMA residuals. The AICC value adjusted for the ARMA
fit (821.70) should be used for comparison with alternative ARMA models (with
or without GARCH noise). Standard errors of the estimated coefficients are also
displayed.

Simulation using the fitted ARMA(3,4) model with GARCH (1,1) noise can
be carried out by selecting Garch>Simulate Garch process. If you retain
the settings in the ARMA Simulation dialog box and click OK you will see a simulated
realization of the model for the original data in SUNSPOTS.TSM.

�Some useful references for extensions and further properties of GARCH models are
Weiss (1986), Engle (1995), Shephard (1996), Gourieroux (1997), Lindner (2009) and
Francq and Zakoian (2010).

7.3 Modified GARCH Processes

The following are so-called “stylized features” associated with observed time series
of financial returns:

(i) the marginal distributions have heavy tails,
(ii) there is persistence of volatility,
(iii) the returns exhibit aggregational Gaussianity,
(iv) there is asymmetry with respect to negative and positive disturbances and
(v) the volatility frequently exhibits long-range dependence.

The properties (i), (ii) and (iii) are well accounted for by the GARCH models of
Section 7.2. Property (iii) means that the sum, Sn = ∑n

t=1 Zt, of the daily returns,
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Zt = lnPt−lnPt−1, is approximately normally distributed if n is large. For the GARCH
model with EZ2

t = σ 2 < ∞ it follows from the martingale central limit theorem (see
e.g. Billingsley (1995)) that n−1/2(lnPn − lnP0) = n−1/2 ∑n

t=1 Zt is asymptotically
N(0, σ 2), in accordance with (iii).

To account for properties (iv) and (v) the EGARCH and FIGARCH models were
devised.

7.3.1 EGARCH Models

To allow negative and positive values of et in the definition of the GARCH process
to have different impacts on the subsequent volatilities, hs, (s > t), Nelson (1991)
introduced EGARCH models, illustrated in the following simple example.

Example 7.3.1 EGARCH(1,1)

Consider the process {Zt} defined by the equations,

Zt = √
htet, {et} ∼ IID(0, 1), (7.3.1)

where {�t := ln ht} is the weakly and strictly stationary solution of

�t = c + α1g(et−1)+ γ1�t−1, (7.3.2)

c ∈ R, α1 ∈ R, |γ1| < 1,

g(et) = et + λ(|et| − E|et|), (7.3.3)

and et has a distribution symmetric about zero, i.e., et =d −et.
The process is defined in terms of �t to ensure that ht(= e�t) > 0. Equation (7.3.3)

can be rewritten as

g(et) =
{
(1 + λ)et − λE|et| if et ≥ 0,

(1 − λ)et − λE|et| if et < 0.

showing that the function g is piecewise linear with slope (1 +λ) on (0,∞) and slope
(1 − λ) on (−∞, 0). This asymmetry in g allows �t, to respond differently to positive
and negative shocks et−1 of the same magnitude. If λ = 0 there is no asymmetry.

When fitting EGARCHmodels to stock prices it is usually found that the estimated
value of λ is negative, corresponding to large negative shocks having greater impact
on volatility than positive ones of the same magnitude.

Properties of {g(et)}: (i) {g(et)} is iid.
(ii) Eg(et) = 0.

(iii) Var(g(et)) = 1 + λ2Var(|et|).
(The symmetry of et implies that et and |et| − E|et| are uncorrelated.)

�
More generally, the EGARCH(p, q) process is obtained by replacing the equation
(7.3.2) for lt := ln ht by

�t = c + α(B)g(et)+ γ (B)�t, (7.3.4)
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where

α(B) =
p∑

i=1

αiB
i, γ (B) =

q∑

i=1

γiB
i.

Clearly {�t}, {ht} and {Zt} are all strictly stationary and causal if 1 − γ (z) is non-zero
for all complex z such that |z| ≤ 1.

Nelson also proposed the use of the generalized error distribution (GED) for et,
with density

f (x) = ν exp[(−1/2)|x/ξ |ν]
ξ · 21+1/ν�(1/ν)

,

where

ξ =
{

2(−2/ν)�(1/ν)

�(3/ν)

}1/2

and ν > 0. The value of ξ ensures that Var(et) = 1 and the parameter ν determines
the tail heaviness. For ν = 2, et ∼N(0, 1). Tail heaviness increases as ν decreases.

Properties of the GED: (i) f is symmetric and 1
2 |et/ξ |ν has the gamma distribution

with parameters 1/ν and 1 (see Appendix A.1, Example (d)).

(ii) The specified value of ξ ensures that Var(et) = 1.

(iii) E|et|k = �((k+1)/ν)
�(1/ν) ·

[
�(1/ν)
�(3/ν)

]k/2
.

Inference via Conditional Maximum Likelihood
As in Section 7.2 we initialize the recursions (7.3.1) and (7.3.4) by supposing that

(i) ht = σ̂ 2, t ≤ 0.
(ii) et = 0, t ≤ 0.

Then h1, e1 (= Z1/
√
h1), h2, e2, . . . , can be computed recursively from the

observations Z1,Z2, . . ., and the recursions defining the process.
The conditional likelihood is then computed as

L =
n∏

t=1

1√
ht
f

(
Zt√
ht

)

.

We therefore need to minimize

−2 ln L =
n∑

t=1

ln ht +
n∑

t=1

∣
∣
∣
∣

Zt

ξ
√
ht

∣
∣
∣
∣

ν

+ 2n ln

(
2ξ

ν
· 21/ν�(1/ν)

)

with respect to

c, λ, ν, α1, . . . , αp, γ1, . . . , γq.

Since ht is automatically positive, the only constraints in this optimization are the
conditions

ν > 0
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and

1 − γ (z) �= 0 for all complex z such that |z| ≤ 1.

7.3.2 FIGARCH and IGARCH Models

To allow for the very slow decay of the sample ACF frequently observed in long daily
squared return series, the FIGARCH (fractionally integrated GARCH) models were
developed. Before introducing them we first give a very brief account of fractionally
integrated ARMA processes. (For more details see Section 11.4 and Brockwell and
Davis (1991), Section 13.2.)

Fractionally Integrated ARMA Processes and “Long Memory”

The autocorrelation function ρ(·) of an ARMA process at lag h converges rapidly
to zero as h → ∞ in the sense that there exists r > 1 such that

rhρ(h) → 0, as h → ∞.
The fractionally integrated ARMA (or ARFIMA) process of order (p, d, q), where

p and q are non-negative integers and 0 < d < 0.5, is a stationary time series with an
autocorrelation function which for large lags decays at a much slower rate. It is defined
to be the zero-mean stationary solution {Xt} of the difference equations

(1 − B)dφ(B)Xt = θ(B)Zt, (7.3.5)

where φ(z) and θ(z) are polynomials of degrees p and q respectively, with no common
zeroes, satisfying

φ(z) �= 0 and θ(z) �= 0 for all complex z such that |z| ≤ 1,

{Zt} ∼ WN(0, σ 2), B is the backward shift operator, and (1 − B)r, is defined via the
power series expansion,

(1 − z)r := 1 +
∞∑

j=1

r(r − 1) . . . (r − j + 1)

j! (−z)j, |z| < 1, r ∈ R.

The zero-mean stationary process {Xt} defined by (7.3.5) has the mean-square conver-
gent MA(∞) representation,

Xt =
∞∑

j=0

ψjZt−j,

where ψj is the coefficient of zj in the power series expansion,

ψ(z) = (1 − z)−dθ(z)/φ(z), |z| < 1.

The autocorrelations ρ(j) of {Xt} at lag j and the coefficients ψj both converge to zero
at hyperbolic rates as j → ∞; specifically, there exist non-zero constants γ and δ such
that

j1−dψj → γ and j1−2dρ(j) → δ.

Thus ψj and ρ(j) converge to zero as j → ∞ at much slower rates than the
corresponding coefficients and autocorrelations of an ARMA process. Consequently
fractionally integrated ARMA processes are said to have “long memory". The spectral
density of {Xt} is given by
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f (λ) = σ 2

2π

|θ(e−iλ)|2
|φ(e−iλ)|2 |1 − e−iλ|−2d.

The exact Gaussian likelihood L of observations xn = (x1, . . . , xn)′ of a fraction-
ally integrated ARMA process is given by

−2 ln(L) = n ln(2π)+ ln det�n + x′
n�

−1
n xn,

where �n = E(XnX′
n). Calculation and maximization with respect to the parameters

d, φ1, . . . , φp, θ1, . . . , θq and σ 2 is difficult. It is much easier to maximize theWhittle
approximation LW (see (11.4.10)), i.e. to minimize

−2 ln(LW) = n ln(2π)+
∑

j

ln(2π f (ωj))+
∑

j

In(ωj)

2π f (ωj)
,

where In is the periodogram, and
∑

j denotes the sum over all nonzero Fourier
frequencies, ωj = 2π j/n ∈ (−π, π ]. The program ITSM allows estimation of
parameters for ARIMA(p, d, q) models either by minimizing −2 ln(LW), or by the
slower and more computationally intensive process of minimizing −2 ln(L).

Fractionally Integrated GARCH Processes

In order to incorporate long memory into the family of GARCH models, (Baillie
et al. 1996) defined a fractionally integrated GARCH (FIGARCH) process as a causal
strictly stationary solution of the difference equations (7.3.9) and (7.3.10) specified
below.

To motivate the definition, we recall that the GARCH(p, q) process is the causal
stationary solution of the equations,

Zt = √
htet, ht = α0 +

p∑

i=1

αiZ
2
t−i +

q∑

i=1

βiht−i, (7.3.6)

where α0 > 0, α1, . . . , αp ≥ 0 and β1, . . . , βq ≥ 0. It follows (Problem 7.5) that

(1 − α(B)− β(B))Z2
t = α0 + (1 − β(B))Wt, (7.3.7)

where {Wt := Z2
t −ht} is white noise, α(B) = ∑p

i=1 αiB
i and β(B) = ∑q

i=1 βiB
i. There

is a causal weakly stationary solution for {Zt} if and only if the zeroes of 1 − α(z) −
β(z) have absolute value greater than 1 and there is then exactly one such solution
(Bollerslev 1986).

In order to define the IGARCH(p, q) (integrated GARCH(p, q)) process, Engle
and Bollerslev (1986) supposed that the polynomial (1 − α(z) − β(z)) has a simple
zero at z = 1, and that the other zeroes all fall outside the closed unit disc as in (7.3.6).
Under these assumptions we can write

(1 − β(z) − α(z)) = (1 − z)φ(z),

where φ(z) is a polynomial with all of its zeroes outside the unit circle. We then say
[cf. (7.3.6)] that {Zt} is an IGARCH(p, q) process if it satisfies

φ(B)(1 − B)Z2
t = α0 + (1 − β(B))Wt, (7.3.8)

with Zt = √
htet, Wt = Z2

t − ht and {et} ∼ IID(0, 1). Bougerol and Picard (1992)
showed that if the distribution of et has unbounded support and no atom at zero then
there is a unique strictly stationary causal solution of these equations for {Zt}. The
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solution has the property that EZ2
t = ∞. In practice, for GARCH models fitted to

empirical data, it is often found that α(1)+β(1) ≈ 1, supporting the practical relevance
of the IGARCH model even though EZ2

t = ∞.

Baillie et al. (1996) defined the FIGARCH(p, d, q) process {Zt} to be a causal
strictly stationary solution of the equations,

Zt = √
htet, (7.3.9)

and [cf. (7.3.8)]

φ(B)(1 − B)dZ2
t = α0 + (1 − β(B))Wt, 0 < d < 1, (7.3.10)

where Wt = Z2
t − ht, {et} ∼ IID(0, 1) and the polynomials φ(z) and 1 − β(z) are

non-zero for all complex z such that |z| ≤ 1. Substituting Wt = Z2
t − ht in (7.3.10) we

see that (7.3.10) is equivalent to the equation,

ht = α0

1 − β(1) + [
1 − (1 − β(B))−1φ(B)(1 − B)d

]
Z2
t , (7.3.11)

which means that the FIGARCH(p, q) process can be regarded as a special case of the
IARCH(∞) process defined by (7.3.9) and

ht = a0 +
∞∑

j=1

ajZ
2
t−j, (7.3.12)

with a0 > 0 and
∑∞

j=1 aj = 1. The questions of existence and uniqueness of causal
strictly stationary solutions of the IARCH(∞) (including FIGARCH) equations have
not yet been fully resolved. Any strictly stationary solution must have infinite variance
since if σ 2 := EZ2

t = Eht < ∞ then, since
∑∞

j=1 aj = 1, it follows from (7.3.12)
that σ 2 = a0 + σ 2, contradicting the finiteness of σ 2. Sufficient conditions for the
existence of causal strictly stationary solution of the IARCH)(∞), and in particular of
the FIGARCH equations, have been given by Douc et al. (2008).

Other models, based on changing volatility levels, have been proposed to explain
the “long-memory” effect in stock and exchange rate returns. Fractionally integrated E-
GARCH models have also been introduced (Bollerslev and Mikkelsen 1996) in order
to account for both long memory and asymmetry of the effects of positive and negative
shocks et .

7.4 Stochastic Volatility Models

The general discrete-time stochastic volatility (SV) model for the log return sequence
{Zt} defined in Section 7.1 is [cf. (7.2.1)]

Zt = √
htet, t ∈ Z, (7.4.1)

where {et} ∼ IID(0, 1), {ht} is a strictly stationary sequence of non-negative random
variables, independent of {et}, and ht is known, like the corresponding quantity in the
GARCHmodels, as the volatility at time t. Note however that in the GARCHmodels,
the sequences {ht} and {et} are not independent since ht depends on es, s < t through
the defining equation (7.2.6).

The independence of {ht} and {et} in the SV model (7.4.1) allows us to model the
volatility process with any non-negative strictly stationary sequence we may wish to
choose. This contrasts with the GARCH models in which the processes {Zt} and {ht}
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are inextricably linked. Inference for the GARCH models, based on observations of
Z1, . . . ,Zn, can be carried out using the conditional likelihood, which is easily written
down, as in (7.2.14), in terms of the marginal probability density of the sequence {et}.
Inference for an SVmodel based on observations of {Zt} however is considerably more
difficult since the process is driven by two independent random sequences rather than
one and only {Zt} is observed. The unobserved sequence {ht} is said to be latent.

A general account of the probabilistic properties of SV models can be found in
Davis andMikosch (2009) and an extensive history and overview of both discrete-time
and continuous-time SV models in Shephard and Andersen (2009). In this section we
shall focus attention on an early, but still widely used, special case of the SV model
due to Taylor (1982, 1986) known as the lognormal SV model.

The lognormal SV process {Zt} is defined as,

Zt = √
htet, {et} ∼ IID N(0, 1), (7.4.2)

where ht = e�t , {�t} is a (strictly and weakly) stationary solution of the equations

�t = γ0 + γ1�t−1 + ηt, {ηt} ∼ IID N(0, σ 2), (7.4.3)

|γ1| < 1 and the sequences {et} and {ηt} are independent. The sequence {�t} is clearly
a Gaussian AR(1) process with mean

μ� := E�t = γ0

1 − γ1
(7.4.4)

and variance

v� := Var(�t) = σ 2

1 − γ 2
1

. (7.4.5)

Properties of {Zt}.

(i) {Zt} is strictly stationary.

(ii) Moments:

EZr
t = E(ert )E exp(r�t/2)

=
⎧
⎨

⎩

0, if r is odd,

[∏m
i=1(2i − 1)] exp

(
mγ0

1−γ1
+ m2σ 2

2(1−γ 2
1 )

)
, if r = 2m.

(iii) Kurtosis:

EZ4
t

(EZ2
t )

2
= 3 exp

(
σ 2

1 − γ 2
1

)

≥ 3.

Kurtosis (defined by the ratio on the left) is a standard measure of tail heaviness.
For a normally distributed random variable it has the value 3, so, as measured by
kurtosis, the tails of the marginal distribution of the lognormal SV process are
heavier than those of a normally distributed random variable.

(iv) The autocovariance function of {Z2
t }:

We first observe that if t > s,

E(Z2
t Z

2
s |eu, ηu, u < t) = hshte

2
sE(e

2
t |eu, ηu, u < t) = hshte

2
s ,

since hs, ht and e2
s are each functions of {eu, ηu, u < t} and e2

t is independent of{eu, ηu, u < t}. Taking expectations on both sides of the last equation and using
the independence of {ht} and {et} and the relation ht = exp(lt) gives

E(Z2
t Z

2
s ) = E exp(�t + �s).
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Hence, for h > 0,

Cov(Z2
t+h,Z

2
t ) = E exp(�t+h + �t)− E exp(�t+h)E exp(�t)

= exp[2μ� + v�(1 + γ 2
1 )] − exp[2μ� + v�].

Here we have used the facts that �t+h is normally distributed with mean and
variance which are easily computed from (7.2.17) and that for a normally
distributed random variable X with mean μ and variance v, E exp(X) = exp(μ+
v/2). From (ii) we also have

Var(Z2
t ) = EZ4

t − (EZ2
t )

2 = 3 exp(2μ� + 2vl)− exp(2μ� + vl).

Hence, for h > 0,

ρZ2
t
(h) = Cov(Z2

t+h,Z
2
t )

Var(Z2
t )

= exp(v�γ h
1 )− 1

3 exp(v�)− 1
∼ v�

3 exp(v�)− 1
γ h

1 , as γ1 → 0,

suggesting the approximation of the autocorrelation function of {Z2
t } by that of

an ARMA(1,1) process. (Recall from Example 3.2.1 that the autocorrelation
function of an ARMA(1,1) process has the form ρ(h) = cφh, h ≥ 1, with
ρ(0) = 1.) There is a similarity here to the autocovariance function of the squared
GARCH(1,1) process which (see Problem 7.3) has the autocovariance function
of an ARMA(1,1) process.

(v) The process {ln Z2
t }:

lnZ2
t = �t + ln e2

t . (7.4.6)

If et ∼ N(0, 1) then E ln e2
t = −1.27 and Var(ln e2

t ) = 4.93. From (7.4.6) we find
at once that Var(ln Z2

t ) = vl + 4.93 and Cov(Z2
t+h,Zt) = vlγ

|h|
1 for h �= 0. Hence

the process {ln Z2
t } has the autocovariance function of an ARMA(1,1) process

with autocorrelation function

ρlnZ2
t
(h) = vlγ

|h|
1

vl + 4.93
, h �= 0.

Estimation for the lognormal SV model

The parameters to be estimated in the defining equations (7.4.2) and (7.4.3) are σ 2, γ0

and γ1. They can be estimated by maximization of the Gaussian likelihood which can
be calculated, for any specified values of the parameters, as follows.

By property (v) above, the process {Yt := ln Z2
t −E ln Z2

t } satisfies the ARMA(1,1)
equations,

Yt − φYt−1 = Zt + θZt−1, {Zt} ∼ WN(0, σ 2
Z ), (7.4.7)

for some coefficients φ and θ in the interval (−1, 1) and white-noise variance σ 2
Z .

Comparing the autocorrelation function of (7.4.7) with the autocorrelation function of
{lnZ2

t } given above in Property (v), we find that

γ1 = φ (7.4.8)

and

v�
v� + 4.93

= (θ + φ)(1 + θφ)
1 + 2θφ + θ2

. (7.4.9)

To ensure that the right-hand side falls in the interval (0, 1) it is necessary and sufficient
(assuming that φ ∈ (−1.1) and θ ∈ (−1, 1)) that φ + θ > 0. The maximum
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Gaussian likelihood estimators φ̂ and θ̂ can be found using the program ITSM and
the corresponding estimators γ̂1 and v̂� on replacing φ and θ by their estimators in
(7.4.8) and (7.4.9) respectively. From (7.4.5) the corresponding estimator of σ 2 is

σ̂ 2 = (1 − γ̂1
2
)v̂�,

where γ̂1 = φ̂ and, from (7.4.4) and (7.4.6), the corresponding estimator of γ0 is

γ̂0 = (1 − γ̂1)(lnZ2
t + 1.27),

where ln Z2
t denotes the sample mean of the observations of ln Z2

t . If it turns out that
the estimators φ̂ and θ̂ satisfy φ̂ + θ̂ ≤ 0 then, from (7.4.9), v̂� ≤ 0, suggesting that
the lognormal SV model is not appropriate in this case.

Forecasting the log volatility

The minimum mean-squared error predictor of �t+h conditional on {�s, s ≤ t} is
easily found from (7.4.3) to be

Pt�t+h = γ h
1 �t + γ0

1 − γ h
1

1 − γ1
, (7.4.10)

with mean-squared error,

E(�t+h − Pt�t+h)
2 = σ 2 1 − γ 2h

1

1 − γ 2
1

. (7.4.11)

We have seen how to estimate γ0, γ1 and σ 2, but unfortunately �t is not observed.
In order to forecast �t+h using the observations {Zs, s ≤ t}, we can however use the
Kalman recursions as described in Section 9.4, Example 9.4.2

7.5 Continuous-Time Models

7.5.1 Lévy Processes

Continuous-time models for asset prices have a long history, going back to Bachelier
(1900) who used Brownian motion to represent the movement of asset prices in
the Paris stock exchange. Continuous-time models have since moved to a central
place in mathematical finance, largely because of their use in the field of option-
pricing, initiated by the Nobel-Prize-winning work of Black, Scholes and Merton, and
partly also because of the current availability of high-frequency and irregularly-spaced
transaction data which are represented most naturally by continuous-time models.

We earlier defined the daily return on day t of a stock whose closing price is Pt as

Zt = Xt − Xt−1, (7.5.1)

where

Xt = logPt (7.5.2)

is the log asset price at the close of day t. If the daily returns were iid this would mean
that the process {Xt} is a random walk (Example 1.4.3). This is an over-simplified
model for daily asset prices as there is very strong evidence suggesting that the daily
returns, although exhibiting little or no autocorrelation, are not independent.
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Nevertheless it will be a useful starting point, in the construction of continuous-
time models to introduce the continuous-time analogue of a random walk, known as a
Lévy process. Like iid noise in discrete time, it is the building block for the construction
of a large family of more complex models for financial data.

Definition 7.5.1 A Lévy process, {L(t), t ∈ R} is a process with the following properties:

(i) L(0) = 0.

(ii) L(t)−L(s) has the same distribution as L(t− s) for all s and t such that s ≤ t.

(iii) If (s, t) and (u, v) are disjoint intervals then L(t) − L(s) and L(v)− L(u) are
independent.

(v) {L(t)} is continuous in probability, i.e. for all ε > 0 and for all t ∈ R,

lim
s→t

P(|L(t)− L(s)| > ε) = 0.

The essential properties of Lévy processes are discussed in Appendix D. For thorough
accounts of Lévy processes and their properties see the books of Applebaum (2004),
Protter (2010) and Sato (1999) and for an extensive account of their applications to
finance see Schoutens (2003) and Andersen et al. (2009). For now we restrict attention
to two of the most familiar examples of Lévy processes, Brownian motion, whose
sample-paths are continuous, and the compound Poisson process, whose sample-paths
are constant except for jumps.

Example 7.5.1 Brownian Motion

This is a Lévy process for which L(t) ∼ N(μt, σ 2t), t ≥ 0, with parameters μ ∈ R

and σ > 0. The sample-paths are continuous and the characteristic function of L(t)
for t > 0 is

EeiθL(t) = etξ(θ), θ ∈ R, (7.5.3)

where

ξ(θ) = iθμ− θ2σ 2/2.

The defining properties (ii) and (iii) imply that for any finite collection of times t1 <
t2 < · · · < tn, the increments Δi := L(ti+1) − L(ti), i = 1, . . . , n, are independent
random variables satisfying Δi ∼ N(μ(ti+1 − ti), σ 2(ti+1 − ti)). Brownian motion
with μ = 0 and σ = 1 is known as standard Brownian motion. We shall denote it
henceforth as {B(t), t ∈ R}. A realization of B(t), 0 ≤ t ≤ 10, is shown in Figure 7-5.

�

Example 7.5.2 The Poisson Process

The Poisson process {N(t), t ∈ R}with intensity or jump-rate λ is a Lévy process such
that N(t), for t ≥ 0, has the Poisson distribution with mean λt. Its sample paths are
right-continuous functions which are constant except for jumps of size 1, the number
of jumps occurring in any time interval of length � having the Poisson distribution with
mean λ�. The characteristic function of N(t) for t > 0 is given by (7.5.3) with

ξ(θ) = eiθ − 1.
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Figure 7-5
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Figure 7-6
A realization of a Poisson
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A sample-path of a Poisson process with λ = 5 on the time-interval [0, 10] is shown
in Figure 7-6.

�
Example 7.5.3 The Compound Poisson Process

The compound Poisson process {X(t), t ∈ R} with jump-rate λ and jump-size
distribution function F is a Lévy process with sample-paths which are constant except
for jumps. The jump-times are those of a Poisson process {N(t)} with jump-rate λ and
the sizes of the jumps are independent random variables, independent of the process
{N(t)}, with a distribution function F assigning probability zero to the value zero. The
characteristic function of L(t) for t > 0 is again given by (7.5.3) but now with

ξ(θ) = iθc +
∫

R

(eiθx − 1 − iθxI(−1,1)(x))λdF(x), (7.5.4)

where c = λ
∫

|x|<1 xdF(x) and I(−1,1)(x) = 1 if |x| < 1 and zero otherwise.
A realization of a compound Poisson process on the interval [0,10] is shown in
Figure 7-7

�
The above examples give some idea of the immense variety in the class of Lévy

processes. The Lévy-Itô decomposition implies that every Lévy process L can be
expressed as the sum of a Brownian motion and an independent pure-jump process.
The marginal distribution of L(t) can be any distribution from the class of infinitely
divisible distributions (which includes the gamma, Gaussian, Student’s t, stable,
compound Poisson and many additional well-known distributions). See Appendix D
and the references given there for more details.
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Figure 7-7
A realization of a
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7.5.2 The Geometric Brownian Motion (GBM) Model for Asset Prices

In his pioneering mathematical analysis of stock prices, contained in his doctoral
thesis, Théorie de la speculation, Bachelier (1900) introduced a model in which
the price of an asset {P(t)} is Brownian motion with parameters μ and σ (see
Example 7.5.1). Measuring time in units of 1 day, this implies in particular that the
daily closing prices, P(t), t = 0, 1, 2, . . ., constitute a random walk with increments
P(t) − P(t − 1) which are independent and normally distributed with mean μ and
variance σ 2. The normality of these increments and the fact that P(t) takes negative
values with positive probability clearly limit the value of this model as a realistic
approximation to observed daily prices. However, interest in the work of Bachelier
and his use of the Brownian motion model to solve problems in mathematical finance
led (Samuelson 1965) to develop and apply the more realistic geometric Brownian
motion model for asset prices. A fascinating account of Bachelier’s work, including
an English translation of his thesis and comments on its place in the history of both
probability theory and mathematical finance is contained in the book of Davis and
Etheridge (2006). The geometric Brownian motion model is the one for which the
celebrated option-pricing formulae of Black, Scholes and Merton were first derived.

In the Brownian motion model the asset price {P(t), t ≥ 0} satisfies the stochastic
differential equation,

dP(t) = μdt + σdB(t), (7.5.5)

where {B(t)} is standard Brownian motion, i.e., Brownian motion with EB(t) = 0 and
VarB(t) = t, t ≥ 0. Equation (7.5.5) is shorthand for the integrated form,

P(t)− P(0) = μt + σB(t).
In addition to the obvious flaw that P(t) will take negative values for some values
of t, the increments P(t) − P(t − 1) are normally distributed, while in practice it is
observed that these increments have marginal distributions with heavier tails than the
normal distribution. The geometric Brownian motion model addresses both of these
shortcomings.

The geometric Brownian motion model for {P(t), t ≥ 0} is defined by the Itô
stochastic differential equation,

dP(t) = P(t)[μdt + σdB(t)], with P(0) > 0. (7.5.6)

Solution of this equation requires knowledge of Itô calculus, a brief introduction to
which is given in Appendix D. A more extensive and very readable account with
financial applications can be found in the book of Mikosch (1998). The solution of
(7.5.6) satisfies (see Appendix D)
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Figure 7-8
A realization of GBM,
P(t),0 ≤ t ≤ 10, with
P(0) = 1. μ = 0 and
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P(t) = P(0) exp

[

(μ− σ 2

2
)t + σB(t)

]

, (7.5.7)

from which it follows at once that the log asset price X(t) = logP(t) satisfies

X(t) = X(0)+ (μ− σ 2

2
)t + σB(t), (7.5.8)

or equivalently

dX(t) =
(

μ− σ 2

2

)

dt + σdB(t). (7.5.9)

A realization of the process P(t), 0 ≤ t ≤ 10, with P(0) = 1, μ = 0 and σ = 0.01 is
shown in Figure 7-8.

The return for the time interval (t −Δ, t) is

ZΔ(t) = X(t)− X(t −Δ) = (μ− σ 2

2
)Δ+ σ [B(t)− B(t −Δ)]. (7.5.10)

For disjoint intervals of length Δ the returns are therefore independent normally
distributed random variables with mean (μ−σ 2/2)Δ and variance σ 2Δ. The normality
of the returns implied by this model is a property which can easily be checked against
observed returns. It is found from empirically observed returns that the deviations from
normality are substantial for time intervals of the order of a day or less, becoming less
apparent as Δ increases. This is one of the reasons for developing the more complex
models described in later sections.

Remark 1. An asset-price model which overcomes the normality constraint is the so-
called Lévy market model (LMM), in which the log asset price X is assumed to be a
Lévy process, not necessarily Brownian motion as in the GBMmodel. For a discussion
of such models see Eberlein (2009).

The parameter σ 2 in the GBM model is called the volatility parameter. It plays
a key role in the option pricing analysis of Black and Scholes (1973) and Merton
(1973) to be discussed in Section 7.6. Although σ 2 cannot be determined from discrete
observations of a GBM process it can be estimated from closely-spaced discrete
observations X(i/N), i = 1, . . . ,N, with large N, as described in the following
paragraph.

From (7.5.8) we can write

(ΔiX)
2 := [X(i/N)− X((i − 1)/N)]2 = (c/N + σΔiB)

2, (7.5.11)
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where ΔiB = B(i/N) − B((i − 1)/N) and c = μ − σ 2/2. A simple calculation then
gives

E[(ΔiX)
2] = σ 2

N
+ c2

N2
,

and

Var[(ΔiX)
2] = 4σ 2c2

N3
+ 2σ 4

N2
.

By the independence of the summands,
∑N

i=1(ΔiX)2 has mean σ 2 +c2/N and variance
2σ 4/N + 4σ 2c2/N2, showing that, as N → ∞,

N∑

i=1

(ΔiX)
2 −→m.s. σ 2 =

∫ 1

0
σ 2dt. (7.5.12)

This calculation shows that, for the GBM process, the sum on the left is a consistent
estimator of σ 2 as N → ∞. The sum (for suitably large N) is known as the realized
volatility for the time interval [0, 1] and the integral on the right is known as the
integrated volatility for the same interval. σ 2 itself is known as the spot volatility.
The realized volatility is widely used as an estimator of the integrated volatility and
is consistent for a wide class of models in which the spot volatility is not necessarily
constant as it is in the GBM model. For a discussion of realized volatility in a more
general context see the article of Andersen and Benzoni (2009).

We shall denote the realized volatility, computed for day n, n = 1, 2, 3, . . ., by σ̂ 2
n .

It is found in practice to vary significantly from 1 day to the next. The sequence {σ̂ 2
n } of

realized volatilities exhibits clustering, i.e., periods of low values interrupted by bursts
of large values, and has the appearance of a positively correlated stationary sequence,
reinforcing the view that volatility is not constant as in the GBMmodel and suggesting
the need for a model in which volatility is stochastic. Such observations are precisely
those which led to the development in discrete time of stochastic volatility, ARCH,
and GARCHmodels, and suggest the need for analogous models with continuous time
parameter.

7.5.3 A Continuous-Time SV Model

In the discrete-time modeling of asset prices we have seen how both the GARCH
and SV models allow for the variation of the volatility with time by modeling {ht} as a
random process. A continuous-time analogue of this idea was introduced by Barndorff-
Niesen and Shephard (2001) in their celebrated continuous-time SV model for the log
asset price X(t) [cf. (7.5.9)],

dX(t) = [m + bh(t)]dt + √
h(t)dB(t), t ≥ 0, with X(0) = 0, (7.5.13)

where m ∈ R, b ∈ R, {B(t)} is standard Brownian motion and {h(t)} is a
stationary subordinator-driven Ornstein-Uhlenbeck process independent of {B(t)}.
The connection with discrete-time SV models is clear if we set m = b = 0 in (7.5.13)
and compare with (7.4.1). Notice also that (7.5.13) has the same form as the GBM
equation (7.5.9) except that the constant volatility parameter σ 2 has been replaced by
the random volatility h(t).

A subordinator is a Lévy process with non-decreasing sample paths. The simplest
example of a subordinator is the Poisson process of Example 7.5.2. If the compound
Poisson process in Example 7.5.3 has non-negative jumps, i.e., if the jump-size
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distribution function F satisfies F(0) = 0, then it too is a subordinator. Other examples
of subordinators are the gamma process (see Appendix D), whose increments on
disjoint intervals have a gamma distribution, and the stable subordinators, whose
increments on disjoint intervals are independent non-negative stable random variables.

An Ornstein-Uhlenbeck process driven by the subordinator L satisfies the stochas-
tic differential equation,

dh(t) = λh(t)dt + dL(t), t ∈ R, (7.5.14)

where λ < 0. If EL(1)r < ∞ for some r > 0 this equation has a unique strictly
stationary causal solution

h(t) =
∫ t

−∞
eλ(t−u)dL(u). (7.5.15)

(Causal here means that h(t) is independent of the increments {L(u)−L(t) : u > t} for
every t.) A crucial feature of (7.5.15) is the non-negativity of h(t) which follows from
the non-decreasing sample-paths of the subordinator {L(t)} and the non-negativity of
the integrand. Non-negativity is clearly a necessary property if h(t) is to represent
volatility. For a detailed account of Lévy-driven stochastic differential equations and
integrals with respect to Lévy processes, see Protter (2010). In the case when L is a
subordinator, (7.5.15) has the very simple interpretation as a pathwise integral with
respect to the non-decreasing sample-path of L.

Quantities associated with the model (7.5.13) which are of particular interest are
the returns over time intervals of length Δ > 0, i.e.

Yn := X(nΔ)− X((n − 1)Δ), n ∈ N,

and the integrated volatilities,

In =
∫ nΔ

(n−1)Δ
h(t)dt, n ∈ N.

The interval Δ is frequently one trading day. The return for the day is an observ-
able quantity and the integrated volatility, although not directly observable, can
be estimated from high-frequency within-day observations of X(t), as discussed in
Section 7.5.2 for the GBM model.

For the model (7.5.13) with any second-order stationary non-negative volatility
process h which is independent of B and has the properties,

Eh(t) = ξ, Var(h(t)) = ω2

and

Cov(h(t), h(t + s)) = ω2ρ(s), s ∈ R,

it can be shown (Problem 7.8) that the stationary sequence {In} has mean,

EIn = ξΔ. (7.5.16)

and autocovariance function,

γ I(k) =
⎧
⎨

⎩

2ω2r(Δ), if k = 0,

ω2 [r((k + 1)Δ)− 2r(kΔ)+ r((k − 1)Δ)] , if k ≥ 1.

(7.5.17)
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where

r(t) :=
∫ t

0

∫ y

0
ρ(u)du dy. (7.5.18)

The stationary sequence of log returns {Yn} has mean m + bξδ and autocovariance
function,

γY(k) =
⎧
⎨

⎩

b2γI(0)+ ξΔ, if k = 0,

b2γI(k), if k ≥ 1.
(7.5.19)

If in addition m = b = 0 then the log returns {Yn} are uncorrelated while the squared
sequence {Yn} (see Problem 7.11) has mean,

EY2
n = ξΔ (7.5.20)

and autocovariance function,

γY2(k) =
⎧
⎨

⎩

ω2
[
6r(Δ)+ 2Δ2ξ 2/ω2

]
, if k = 0,

ω2 [r((k + 1)Δ)− 2r(kΔ)+ r((k − 1)Δ)] , if k ≥ 1.

(7.5.21)

Thus, under these assumptions, the log returns, Yn, calculated from the model are
uncorrelated while the squares, Y2

n , are correlated, showing that the log returns are
uncorrelated but not independent, in keeping with the '“stylized facts” associated with
empirically observed log returns.

Example 7.5.4. The Ornstein-Uhlenbeck SV Model with m = b = 0

We can use the results (7.5.16)–(7.5.21) to determine properties of the sequences {Yn},
{Y2

n } and {In} associated with the Ornstein-Uhlenbeck SV model,

dX(t) = √
h(t)dB(t), t ≥ 0, with X(0) = 0, (7.5.22)

where

h(t) =
∫ t

−∞
eλ(t−u)dL(u), (7.5.23)

λ < 0 and EL(1)2 < ∞.
In order to apply (7.5.16)–(7.5.21) we need to determine ξ = Eh(t), ω2 =

Var(h(t)) and the autocorrelation function ρ of h. To this end we rewrite (7.5.23) as

h(t) =
∫ ∞

−∞
g(t − u)dL(u), (7.5.24)

where

g(x) :=
⎧
⎨

⎩

eλx, if x ≥ 0,

0, otherwise
(7.5.25)

The function g in the representation (7.5.24) is called a kernel function. If EL(1)2 <
∞, as we shall assume from now on, and if f and g are integrable and square-integrable
functions on R, we have (see Appendix D),

E
∫ ∞

−∞
f (t − u)dL(u) = μ

∫ ∞

−∞
f (u)du (7.5.26)
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and

Cov

(∫ ∞

−∞
f (t − u)dL(u),

∫ ∞

−∞
g(t − u)dL(u)

)

= σ 2
∫ ∞

−∞
f (u)g(u)du,

(7.5.27)

whereμ = EL(1) and σ 2 = Var(L(1)). Taking g as in (7.5.25) and f (x) = g(s+x), x ∈
R, we find from these equations that the mean and autocovariance function of the
volatility process {h(t)} defined by (7.5.23) are given by

ξ = Eh(t) = μ

|λ|
and

Cov(h(t + s), h(t)) = σ 2

2|λ|e
λs = ω2ρ(s), s ≥ 0,

where ω2 = Var(h(t)) = σ 2/(2|λ|) and ρ(s) = eλs, s ≥ 0. Substituting for ρ into
(7.5.17) gives

r(t) = 1

λ2

(
eλt − 1 − λt) .

We can now substitute for ξ , ω2, ρ and r in equations (7.5.16)–(7.5.21) to get the
second-order properties of the sequences {Yn}, {Y2

n } and {In}. In particular we find that
{Yn} ∼ WN(0, |λ|−1μΔ),

EY2
n = EIn = |λ|−1μΔ

and

γY2(k) = γ I(k) = 1

2
|λ|−3σ 2e(k−1)λΔ(1 − eλΔ)2, k ≥ 1.

The validity of the latter expressions for k ≥ 1 and not for k = 0 indicates that
both the squared return sequence {Y2

n } and the integrated volatility sequence {In} have
the autocovariances of ARMA(1, 1) processes. This demonstrates, for this particular
model, the covariance structure of the sequence {Y2

n } and the consequent dependence
of the white-noise returns sequence {Yn}.

�

Remark 2. Since equations (7.5.16)–(7.5.19) (derived by Barndorff-Niesen and
Shephard 2001) apply to any second-order stationary non-negative stochastic volatility
process, h, independent of B in (7.5.13), they can be used to calculate the second order
properties of {Yn} and {In} for more general models than the Ornstein-Uhlenbeck
model defined by (7.5.13) and (7.5.15). If m = b = 0 the second-order properties
of {Y2

n } can also be calculated using equations (7.5.20) and (7.5.21). In particular we
can replace the Ornstein-Uhlenbeck process, h, in Example 7.5.4 by a non-negative
CARMA process (see Section 11.5) to allow a more general class of autocovariance
functions for the sequences {In} and {Y2

n } in order to better represent empirically
observed financial data.

Remark 3. Continuous-time generalizations of the GARCH process have also been
developed (see Klüppelberg et al. (2004) and Brockwell et al. 2006). Details however
are beyond the scope of this book.
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7.6 An Introduction to Option Pricing

We saw in Section 7.5.2 that, under the geometric Brownian motion model, the asset
price P(t) satisfies the Itô equation,

dP(t) = P(t)[μdt + σdB(t)] with P(0) > 0, (7.6.1)

which leads to the relation,

P(t) = P(0) exp
[
(μ− σ 2/2)t + σB(t)] . (7.6.2)

In this section we shall determine the value of a European call option on an asset
whose price satisfies (7.6.2). The result, derived by Black and Scholes (1973) and
Merton (1973), clearly demonstrates the key role played by the volatility parameter σ 2.

A European call option, if sold at time 0, gives the buyer the right, but not the
obligation, to buy one unit of the stock at the strike time T for the strike price K. At
time T the option has the cash value h(P(t)) = max(P(T) − K, 0) since the option
will be exercised only if P(T) > K, in which case the holder of the option can buy the
stock at the price K and resell it instantly for P(T). However it is not clear at time 0,
since P(T) is random, what price the buyer should pay for this privilege. Assuming

(i) the existence of a risk-free asset with price process,

D(t) = D(0) exp(rt), r > 0, (7.6.3)

(ii) the ability to buy and sell arbitrary (positive or negative) amounts of the stock and
the risk-free asset continuously with no transaction costs, and

(iii) an arbitrage-free market ( i.e., a market in which it is impossible to make a profit
which is non-negative with probability one and strictly positive with probability
greater than zero).

Black, Scholes and Merton showed that there is a unique value for the option in the
sense that both higher and lower prices introduce demonstrable arbitrage opportunities.
Details of the derivation can be found in most books dealing with mathematical
finance (e.g., Campbell et al. 1996; Mikosch 1998; Klebaner 2005). In the following
paragraphs we give a sketch of two arguments, following Mikosch (1998), which
determine this value under the assumption that the asset price follows the GBMmodel.

In the first argument, we attempt to construct a self-financing portfolio, consisting
at time t of at shares of the stock and bt shares of the risk-free asset, where at and bt
are random variables which, for each t are functions of {B(s), s ≤ t}. We require the
value of this portfolio at time t, namely

V(t) = atP(t)+ btD(t), (7.6.4)

to satisfy the self-financing condition,

dV(t) = at dP(t)+ bt dD(t), (7.6.5)

and to match the value of the option at time T , i.e.,

V(T) = h(P(T)) = max(P(T)− K, 0). (7.6.6)

If such an investment strategy, {(at, bt), 0 ≤ t ≤ T} can be found, then V(0) must
be the value of the option at the purchase time t = 0. A higher price for the option
would allow the seller to pocket the difference δ and invest the amount V(0) in such
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a way as to match the value of the option at time T . Then at time T , if P(T) < K the
option will not be exercised and the portfolio and the option will both have value zero.
If P(T) > K the seller sells the portfolio for P(T)− K, then buys one stock for P(T)
and receives K for it from the holder of the option. Since there is no loss involved
in this transaction, the seller is left with a net profit of δ. The seller of the option
therefore makes a profit which is certainly non-negative and strictly positive with non-
zero probability, in violation of the no arbitrage assumption. Similarly a lower price
than V(0) would create an arbitrage opportunity for the buyer. In order to determine
V(t), at and bt we look for a smooth function v(t, x), t ∈ [0,T], x > 0, such that

V(t) = v(t,P(t)), t ∈ [0,T], (7.6.7)

satisfies the conditions (7.6.4)–(7.6.6).
Writing x for P(t) in v(t,P(t)) and applying Itô’s formula (see Appendix D) gives

dv = ∂v

∂t
dt + ∂v

∂x
dx + 1

2

∂2v

∂x2
(dx)2 (7.6.8)

where, from (7.6.1),

dx = x(μdt + σdB(t)) (7.6.9)

and

(dx)2 = x2σ 2dt. (7.6.10)

Applying Itô’s formula to (7.6.5) and using (7.6.3) and (7.6.4) gives

dv = at(μdt + σdB(t))+ r(v − atx)dt. (7.6.11)

Substituting (7.6.9) and (7.6.10) into (7.6.8) and comparing with (7.6.11), we find that

at = ∂v

∂x
(t,P(t)) (7.6.12)

and that v(t, x) satisfies the equation,

∂v

∂t
+ 1

2
σ 2x2 ∂

2v

∂x2
+ rx

∂v

∂x
= rv. (7.6.13)

The condition (7.6.6) yields the boundary condition,

v(T, x) = h(x) = max(x − K, 0), (7.6.14)

which, with (7.6.13), uniquely determines the function v and hence V(t), at and
bt = (V(t)− atP(t))/D(t) for each t ∈ [0,T]. The corresponding investment strategy
{(at, bt), 0 ≤ t ≤ T} satisfies (7.6.5) and (7.6.6) and can, under the assumed idealized
trading conditions, be implemented in practice. Since at time T this portfolio has the
same value as the option, V(0) must be the fair value of the option at time t = 0,
otherwise an arbitrage opportunity would arise. The option is said to be hedged by the
investment strategy {(at, bt)}. A key feature of this solution [apparent from (7.6.12)–
(7.6.14)] is that both the strategy and the fair price of the option are independent of μ,
depending on the price process P only through the volatility parameter σ 2.

Instead of attempting to solve (7.6.13) directly we now outline the martingale
argument which leads to the explicit solution for v(x, t), at and bt. It is based on the fact
that for the GBM model with B(t) defined on the probability space (�,F ,�), there
is a unique probability measure Q on (�,F ) which is equivalent to� (i.e., it has the
same null sets) and which, when substituted for�, causes the discounted price process
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P̃(t) := e−rtP(t), 0 ≤ t ≤ T , to be a B-martingale, i.e., to satisfy the conditions that
EQP̃(t) < ∞ and

EQ(P̃(t)|B(u), u ≤ s) = P̃(s) for all 0 ≤ s ≤ t ≤ T. (7.6.15)

The measure Q and the relation (7.6.15) can be derived as follows. Applying Itô’s
formula to the expression P̃(t) = e−rtP(t) and using (7.6.1) gives

dP̃(t)

P̃(t)
= (μ− r)dt + σdB(t) = σdB̃(t), (7.6.16)

where B̃(t) := (μ− r)t/σ + B(t). The solution of (7.6.16) satisfies

P̃(t) = P̃(0)eσ B̃(t)−σ
2t/2. (7.6.17)

By Girsanov’s theorem (see Mikosch 1998), if we define Q by

Q(A) =
∫

A
exp

(

−μ− r

σ
B(T)− (μ− r)2

2σ 2
T

)

d�, (7.6.18)

then, on the new probability space (�,F ,Q), B̃ is standard Brownian motion. A
simple calculation using (7.6.17) then shows that the discounted price process P̃ is
a B-martingale on (�,F ,Q), i.e. EQP̃(t) < ∞ and (7.6.15) holds.

Assuming the existence of a portfolio (7.6.4) which satisfies the self-financing
condition (7.6.5) and the boundary condition (7.6.6), the discounted portfolio value is

Ṽ(t) = e−rtV(t). (7.6.19)

Applying Itô’s formula to this expression we obtain

dṼ(t) = e−rt(−rV(t)dt + dV(t)) = ate
−rt(−rP(t)dt + dP(t)) = atdP̃(t),

and hence, from (7.6.16),

Ṽ(t) = Ṽ(0)+
∫ t

0
asdP̃(s) = V(0)+ σ

∫ t

0
asP̃(s)dB̃(s). (7.6.20)

Since atP̃(t) is a function of {B(s), s ≤ t} for each t ∈ [0,T] and since, under the
probability measure Q, B̃ is Brownian motion and B̃(t) is a function of {B(s), s ≤ t}
for each t ∈ [0,T], we conclude that Ṽ is a B-martingale. Hence

Ṽ(t) = EQ[Ṽ(T)|B(s), s ≤ t], t ∈ [0,T],
and

V(t) = ertṼ(t) = EQ[e−r(T−t)h(P(T))|B(s), s ≤ t], (7.6.21)

where h(P(T)) is the value of the option at time T . For the European call option
h(P(T)) = max(P(T)− K, 0).

It only remains to calculate v(t, x) from (7.6.21). To do this we define θ := T − t.
Then, expressing P(T) in terms of P(t),

V(t) = EQ[e−rθh(P(t)e(r−
σ2
2 )θ+σ(B̃(T)−B̃(t)))|B(s), s ≤ t] = v(t,P(t)),

where

v(t, x) = e−rθ
∫

h(xe(r−
σ2
2 )θ+σyθ1/2))φ(y)dy (7.6.22)

and φ is the standard normal density function,
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φ(y) = 1√
2π

exp(−y2/2).

Substituting max(x − K, 0) for h(x) in (7.6.22) gives

v(t, x) = x�(z1)− Ke−r(T−t)�(z2), (7.6.23)

where� is the standard normal cumulative distribution function,�(x) = ∫ x
−∞ φ(u)du,

z1 = log(x/K)+ (r + σ 2/2)(T − t)

σ
√
T − t

and z2 = z1 − σ√
T − t.

The value of the option at time 0 is V(0) = v(0,P(0)) and the investment strategy
{at, bt, 0 ≤ t ≤ T} required to hedge it is determined by the relations at = ∂v

∂x(t,P(t))
and bt = (v(t,P(t) − atP(t))/D(t). It can be verified by direct substitution (Problem
7.12) that the function v given by (7.6.23) satisfies the partial differential equation
(7.6.13) and the boundary condition (7.6.14).

The quantity m = (μ − r)/σ which appears in the integrand in (7.6.18) is called
the market price of risk and represents the excess, in units of σ , of the instantaneous
rate of return μ of the risky asset S over that of the risk-free asset D. If m = 0 then
Q = � and the model is said to be risk-neutral.

Although the model (7.6.1) has many shortcomings as a representation of asset
prices, the remarkable achievement of Black, Scholes and Merton in using it to derive
a unique arbitrage-free option price has inspired enormous interest and progress in
the field of financial mathematics. As a result of their pioneering work, research
in continuous-time financial models has blossomed, with much of it directed at
the construction, estimation and analysis of more realistic continuous-time models for
the evolution of stock prices, and the pricing of options based on such models. A nice
account of option-pricing for a broad class of Lévy-driven stock-price models can be
found in the book of Schoutens (2003).

Problems

7.1 Evaluate EZ4
t for the ARCH(1) process (7.2.5) with 0 < α1 < 1 and {et} ∼

IID N(0, 1). Deduce that EX4
t < ∞ if and only if 3α2

1 < 1.

7.2 Let {Zt} be a causal stationary solution of the ARCH(p) equations (7.2.1) and
(7.2.2) with EZ4

t < ∞. Assuming that such a process exists, show that Yt =
Z2
t /α0 satisfies the equations

Yt = e2
t

(

1 +
p∑

i=1

αiYt−i

)

and deduce that {Yt} has the same autocorrelation function as the AR(p) process

Wt =
p∑

i=1

αiWt−i + et, {et} ∼ WN(0, 1).

(In the case p = 1, a necessary and sufficient condition for existence of a causal
stationary solution of (7.2.1) and (7.2.2) with EZ4

t <∞ is 3α2
1 < 1, as shown

by the results of Section 7.2 and Problem 7.1.)



Problems 225

7.3 Suppose that {Zt} is a causal stationary GARCH(p, q) process Zt = √
htet, where

{et} ∼ IID(0,1),
∑p

i=1 ai +
∑q

j=1 Bj < 1 and

ht = α0 + α1Z
2
t−1 + · · · + αpZ2

t−p + β1ht−1 + · · · + βqht−q.

a. Show that E(Z2
t |Z2

t−1,Z
2
t−2, . . .) = ht.

b. Show that the squared process {Z2
t } is an ARMA(m, q) process satisfying the

equations

Z2
t = α0 + (α1 + β1)Z

2
t−1 + · · · + (αm + βm)Z2

t−m

+ Ut − β1Ut−1 − · · · − βqUt−q,

where m = max{p, q}, αj = 0 for j > p, βj = 0 for j > q, and Ut = Z2
t − ht

is white noise if EZ4
t < ∞.

c. For p ≥ 1, show that the conditional variance process {ht} is an
ARMA(m, p− 1) process satisfying the equations

ht = α0 +(α1 + β1)ht−1 + · · · + (αm + βm)ht−m

+Vt + α∗
1Vt−1 + · · · + α∗

pVt−p−1,

where Vt = α−1
1 Ut−1 and α∗

j = αj+1/α1 for j = 1, . . . , p − 1.

7.4 To each of the seven components of the multivariate time series filed as
STOCK7.TSM, fit an ARMA model driven by GARCH noise. Compare
the fitted models for the various series and comment on the differences.
(For exporting components of a multivariate time series to a univariate project,
see the topic Getting started in the PDF file ITSM_HELP which is included in
the ITSM software package.

7.5 Verify equation (7.3.7).

7.6 Show that the return, ZΔ(t) := logP(t) − logP(t − Δ), approximates the
fractional gain, FΔ(t) := (P(t)− P(t −Δ))/P(t −Δ), in the sense that

ZΔ(t)

FΔ(t)
→ 1 as FΔ(t) → 0.

7.7 For the GBM model (7.5.7) with P(0) = 1, evaluate the mean and variance of
P(t) and the mean and variance of the return, ZΔ(t).

7.8 If h is any second-order stationary non-negative volatility process with mean ξ ,
variance ω2 and autocorrelation function ρ, verify the relations (7.5.16)–(7.5.18).

7.9 Use (7.5.26) and (7.5.27) to evaluate the mean and autocovariance function of
the stationary Ornstein-Uhlenbeck process (7.5.23).

7.10 If h is the stationary Ornstein-Uhlenbeck process (7.5.23) and s is any fixed
value in [0,Δ], show that application of the operator φ(B) := (1 − eλΔB) to
the sequence {h(nΔ+ s), n ∈ Z} gives

φ(B)h(nΔ+ s) = Wn(s),

where {Wn(s), n ∈ Z} is the iid sequence,

Wn(s) =
∫ nΔ+s

(n−1)Δ+s
eλ(nΔ+s−u)dL(u).
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Deduce that the integrated volatility sequence, In = ∫ 0
−Δ h(nΔ+ s)ds, satisfies

(1 − eλΔB)In =
∫ 0

−Δ
Wn(s)ds.

Since the right-hand side is 1-correlated, it follows from Proposition 2.1.1 that
it is an MA(1) process and hence that the integrated volatility sequence is an
ARMA(1,1) process.

7.11 For the stochastic volatility model (7.5.13) with m = b = 0 and second-order
stationary volatility process h independent ofW , establish (7.5.20) and (7.5.21).

7.12 Verify that the expression (7.6.23) for v(t, s) satisfies (7.6.13) and (7.6.14) and
use it to write down the value of the option at time t = 0 and the corresponding
investment strategy {(at, bt), 0 ≤ t ≤ T}.



8 Multivariate Time Series

8.1 Examples
8.2 Second-Order Properties of Multivariate Time Series
8.3 Estimation of the Mean and Covariance Function
8.4 Multivariate ARMA Processes
8.5 Best Linear Predictors of Second-Order Random Vectors
8.6 Modeling and Forecasting with Multivariate AR Processes
8.7 Cointegration

Many time series arising in practice are best considered as components of some vector-
valued (multivariate) time series {Xt} having not only serial dependence within each
component series {Xti} but also interdependence between the different component
series {Xti} and {Xtj}, i �= j. Much of the theory of univariate time series extends in
a natural way to the multivariate case; however, new problems arise. In this chapter
we introduce the basic properties of multivariate series and consider the multivariate
extensions of some of the techniques developed earlier. In Section 8.1 we introduce
two sets of bivariate time series data for which we develop multivariate models later
in the chapter. In Section 8.2 we discuss the basic properties of stationary multivariate
time series, namely, the mean vector μ = EXt and the covariance matrices �(h) =
E(Xt+hX′

t) − μμ′, h = 0,±1,±2, . . ., with reference to some simple examples,
including multivariate white noise. Section 8.3 deals with estimation of μ and �(·)
and the question of testing for serial independence on the basis of observations of
X1, . . . ,Xn. In Section 8.4 we introduce multivariate ARMA processes and illustrate
the problem of multivariate model identification with an example of a multivariate
AR(1) process that also has an MA(1) representation. (Such examples do not exist
in the univariate case.) The identification problem can be avoided by confining
attention to multivariate autoregressive (or VAR) models. Forecasting multivariate
time series with known second-order properties is discussed in Section 8.5, and in
Section 8.6 we consider the modeling and forecasting of multivariate time series
using the multivariate Yule–Walker equations and Whittle’s generalization of the
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Durbin–Levinson algorithm. Section 8.7 contains a brief introduction to the notion
of cointegrated time series.

8.1 Examples
In this section we introduce two examples of bivariate time series. A bivariate time
series is a series of two-dimensional vectors (Xt1, Xt2)

′ observed at times t (usually
t = 1, 2, 3, . . .). The two component series {Xt1} and {Xt2} could be studied indepen-
dently as univariate time series, each characterized, from a second-order point of view,
by its own mean and autocovariance function. Such an approach, however, fails to take
into account possible dependence between the two component series, and such cross-
dependence may be of great importance, for example in predicting future values of the
two component series.

We therefore consider the series of random vectors Xt = (Xt1, Xt2)
′ and define

the mean vector

μt := EXt =
[
EXt1

EXt2

]

and covariance matrices

�(t + h, t) := Cov
(
Xt+h,Xt

) =
[
cov(Xt+h,1,Xt1) cov(Xt+h,1,Xt2)

cov(Xt+h,2,Xt1) cov(Xt+h,2,Xt2)

]

.

The bivariate series
{
Xt

}
is said to be (weakly) stationary if the moments μt and

�(t + h, t) are both independent of t, in which case we use the notation

μ = EXt =
[
EXt1

EXt2

]

and

�(h) = Cov
(
Xt+h,Xt

) =
[
γ11(h) γ12(h)
γ21(h) γ22(h)

]

.

The diagonal elements are the autocovariance functions of the univariate series {Xt1}
and {Xt2} as defined in Chapter 2, while the off-diagonal elements are the covariances
between Xt+h,i and Xtj, i �= j. Notice that γ12(h) = γ21(−h).

A natural estimator of the mean vector μ in terms of the observations X1, . . . ,Xn

is the vector of sample means

Xn = 1

n

n∑

t=1

Xt,

and a natural estimator of �(h) is

�̂(h) =

⎧
⎪⎨

⎪⎩

n−1
n−h∑

t=1

(
Xt+h − Xn

) (
Xt − Xn

)′
for 0 ≤ h ≤ n − 1,

�̂(−h)′ for − n + 1 ≤ h < 0.

The correlation ρij(h) between Xt+h,i and Xt,j is estimated by

ρ̂ij(h) = γ̂ij(h)(γ̂ii(0)γ̂jj(0))
−1/2.

If i = j, then ρ̂ij reduces to the sample autocorrelation function of the ith series.
These estimators will be discussed in more detail in Section 8.2.
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Figure 8-1
The Dow Jones Index
(top) and Australian
All Ordinaries Index

(bottom) at closing on
251 trading days ending
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Example 8.1.1 Dow Jones and All Ordinaries Indices; DJAO2.TSM

Figure 8-1 shows the closing values D0, . . . ,D250 of the Dow Jones Index of stocks on
the New York Stock Exchange and the closing values A0, . . . ,A250 of the Australian
All Ordinaries Index of Share Prices, recorded at the termination of trading on 251
successive trading days up to August 26th, 1994. (Because of the time difference
between Sydney and New York, the markets do not close simultaneously in both
places; however, in Sydney the closing price of the Dow Jones index for the previous
day is known before the opening of the market on any trading day.) The efficient
market hypothesis suggests that these processes should resemble random walks with
uncorrelated increments. In order to model the data as a stationary bivariate time series
we first reexpress them as percentage relative price changes or percentage returns
(filed as DJAOPC2.TSM)

Xt1 = 100
(Dt − Dt−1)

Dt−1
, t = 1, . . . , 250,

and

Xt2 = 100
(At − At−1)

At−1
, t = 1, . . . , 250.

The estimators ρ̂11(h) and ρ̂22(h) of the autocorrelations of the two univariate series
are shown in Figures 8-2 and 8-3. They are not significantly different from zero.

To compute the sample cross-correlations ρ̂12(h) and ρ̂21(h) using ITSM, select
File>Project>Open>Multivariate. Then click OK and double-click on
the file name DJAOPC2.TSM. You will see a dialog box in which Number of
columns should be set to 2 (the number of components of the observation vectors).
Then click OK, and the graphs of the two component series will appear. To see the
correlations, press the middle yellow button at the top of the ITSM window. The
correlation functions are plotted as a 2 × 2 array of graphs with ρ̂11(h), ρ̂12(h) in the
top row and ρ̂21(h), ρ̂22(h) in the second row. We see from these graphs (shown in
Figure 8-4) that although the autocorrelations ρ̂ii(h), i = 1, 2, are all small, there is
a much larger correlation between Xt−1,1 and Xt,2. This indicates the importance of
considering the two series jointly as components of a bivariate time series. It also
suggests that the value of Xt−1,1, i.e., the Dow Jones return on day t − 1, may be of
assistance in predicting the value of Xt,2, the All Ordinaries return on day t. This last
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Figure 8-2
The sample ACF ρ̂11 of the
observed values of {Xt1} in
Example 8.1.1, showing the

bounds ±1.96n−1/2 Lag
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Figure 8-3
The sample ACF ρ̂22 of the
observed values of {Xt2} in

Example 8.1.1, showing
the bounds ±1.96n−1/2 Lag
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observation is supported by the scatterplot of the points (xt−1,1, xt,2), t = 2, . . . , 250,
shown in Figure 8-5.

�

Example 8.1.2 Sales with a leading indicator; LS2.TSM

In this example we consider the sales data {Yt2, t = 1, . . . , 150} with leading indicator
{Yt1, t = 1, . . . , 150} given by Box and Jenkins (1976, p. 537). The two series are
stored in the ITSM data files SALES.TSM and LEAD.TSM, respectively, and in
bivariate format as LS2.TSM. The graphs of the two series and their sample autocorre-
lation functions strongly suggest that both series are nonstationary. Application of the
operator (1 − B) yields the two differenced series {Dt1} and {Dt2}, whose properties
are compatible with those of low-order ARMA processes. Using ITSM, we find that
the models
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Figure 8-4
The sample correlations

ρ̂ij(h) between Xt+h,i and Xt,j
for Example 8.1.1. (ρij(h) is
plotted as the jth graph in

the ith row, i, j = 1,2. Series
1 and 2 consist of the daily

Dow Jones and All
Ordinaries percentage
returns, respectively.)
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Figure 8-5
Scatterplot of (xt−1,1, xt,2),

t = 2, . . . ,250, for the
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Dt1 − 0.0228 = Zt1 − 0.474Zt−1,1, {Zt1} ∼ WN(0, 0.0779), (8.1.1)

Dt2 − 0.838Dt−1,2 − 0.0676 = Zt2 − 0.610Zt−1,2,

{Zt2} ∼ WN(0, 1.754), (8.1.2)

provide good fits to the series {Dt1} and {Dt2}.
The sample autocorrelations and cross-correlations of {Dt1} and {Dt2}, are com-

puted by opening the bivariate ITSM file LS2.TSM (as described in Example 8.1.1).
The option Transform>Difference, with differencing lag equal to 1, generates
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Figure 8-6
The sample correlations

ρ̂ij(h) of the series {Dt1} and
{Dt2} of Example 8.1.2,

showing the bounds
±1.96n−1/2. (ρ̂ij(h) is

plotted as the jth graph in
the ith row, i, j = 1,2.)
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the bivariate differenced series {(Dt1,Dt2)}, and the correlation functions are then
obtained as in Example 8.1.1 by clicking on the middle yellow button at the top of the
ITSM screen. The sample auto- and cross-correlations ρ̂ij(h), i, j = 1, 2, are shown
in Figure 8-6. As we shall see in Section 8.3, care must be taken in interpreting the
cross-correlations without first taking into account the autocorrelations of {Dt1} and
{Dt2}.

�
8.2 Second-Order Properties of Multivariate Time Series

Consider m time series {Xti, t = 0,±1, . . . , }, i = 1, . . . ,m, with EX2
ti < ∞ for all

t and i. If all the finite-dimensional distributions of the random variables {Xti} were
multivariate normal, then the distributional properties of {Xti} would be completely
determined by the means

μti := EXti (8.2.1)

and the covariances

γij(t + h, t) := E[(Xt+h,i − μti)(Xtj − μtj)]. (8.2.2)

Even when the observations {Xti} do not have joint normal distributions, the quantities
μti and γij(t + h, t) specify the second-order properties, the covariances providing us
with a measure of the dependence, not only between observations in the same series,
but also between the observations in different series.

It is more convenient in dealing with m interrelated series to use vector notation.
Thus we define



8.2 Second-Order Properties of Multivariate Time Series 233

Xt :=
⎡

⎢
⎣

Xt1
...

Xtm

⎤

⎥
⎦ , t = 0,±1, . . . . (8.2.3)

The second-order properties of the multivariate time series {Xt} are then specified by
the mean vectors

μt := EXt =
⎡

⎢
⎣

μt1
...

μtm

⎤

⎥
⎦ (8.2.4)

and covariance matrices

�(t + h, t) :=
⎡

⎢
⎣

γ11(t + h, t) · · · γ1m(t + h, t)
...

. . .
...

γm1(t + h, t) · · · γmm(t + h, t)

⎤

⎥
⎦ , (8.2.5)

where

γij(t + h, t) := Cov(Xt+h,i, Xt, j).

Remark 1. The matrix �(t + h, t) can also be expressed as

�(t + h, t) := E[(Xt+h − μt+h)(Xt − μt)
′],

where as usual, the expected value of a random matrix A is the matrix whose
components are the expected values of the components of A. �

As in the univariate case, a particularly important role is played by the class of
multivariate stationary time series, defined as follows.

Definition 8.2.1 The m-variate series {Xt} is (weakly) stationary if
(i) μX(t) is independent of t

and

(ii) �X(t + h, t) is independent of t for each h.

For a stationary time series we shall use the notation

μ := EXt =
⎡

⎢
⎣

μ1
...

μm

⎤

⎥
⎦ (8.2.6)

and

�(h) := E[(Xt+h − μ)(Xt − μ)′] =
⎡

⎢
⎣

γ11(h) · · · γ1m(h)
...

. . .
...

γm1(h) · · · γmm(h)

⎤

⎥
⎦ . (8.2.7)

We shall refer to μ as the mean of the series and to �(h) as the covariance matrix at
lag h. Notice that if {Xt} is stationary with covariance matrix function �(·), then for
each i, {Xti} is stationary with covariance function γii(·). The function γij(·), i �= j, is
called the cross-covariance function of the two series {Xti} and {Xtj}. It should be noted
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that γij(·) is not in general the same as γji(·). The correlation matrix function R(·) is
defined by

R(h) :=
⎡

⎢
⎣

ρ11(h) · · · ρ1m(h)
...

. . .
...

ρm1(h) · · · ρmm(h)

⎤

⎥
⎦ , (8.2.8)

where ρij(h) = γij(h)/[γii(0)γjj(0)]1/2. The function R(·) is the covariance matrix
function of the normalized series obtained by subtracting μ from Xt and then dividing
each component by its standard deviation.

Example 8.2.1 Consider the bivariate stationary process {Xt} defined by

Xt1 = Zt,

Xt2 = Zt + 0.75Zt−10,

where {Zt} ∼ WN(0, 1). Elementary calculations yield μ = 0,

�(−10) =
[

0 0.75

0 0.75

]

, �(0) =
[

1 1

1 1.5625

]

, �(10) =
[

0 0

0.75 0.75

]

,

and �( j) = 0 otherwise. The correlation matrix function is given by

R(−10) =
[

0 0.60
0 0.48

]

, R(0) =
[

1 0.8
0.8 1

]

, R(10) =
[

0 0
0.60 0.48

]

,

and R( j) = 0 otherwise.
�

Basic Properties of �(·):

1. �(h) = �′(−h),
2. |γij(h)| ≤ [γii(0)γjj(0)]1/2, i, j,= 1, . . . ,m,
3. γii(·) is an autocovariance function, i = 1, . . . ,m, and
4.

∑n
j,k=1 a

′
j�( j − k)ak ≥ 0 for all n ∈ {1, 2, . . .} and a1, . . . , an ∈ R

m.

Proof The first property follows at once from the definition, the second from the fact that
correlations cannot be greater than one in absolute value, and the third from the
observation that γii(·) is the autocovariance function of the stationary series {Xti, t =
0,±1, . . .}. Property 4 is a statement of the obvious fact that

E

( n∑

j=1

a′
j(Xj − μ)

)2

≥ 0. �

Remark 2. The basic properties of the matrices �(h) are shared also by the cor-
responding matrices of correlations R(h) = [ρij(h)]mi, j=1, which have the additional
property

ρii(0) = 1 for all i.

The correlation ρij(0) is the correlation between Xti and Xtj, which is generally not
equal to 1 if i �= j (see Example 8.2.1). It is also possible that |γij(h)| > |γij(0)| if i �= j
(see Problem 7.1). �
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The simplest multivariate time series is multivariate white noise, the definition of
which is quite analogous to that of univariate white noise.

Definition 8.2.2. The m-variate series {Zt} is called white noise with mean 0 and covariance
matrix �| , written

{Zt} ∼ WN(0,�| ), (8.2.9)

if {Zt} is stationary with mean vector 0 and covariance matrix function

�(h) =
{
�| , if h = 0,

0, otherwise.
(8.2.10)

Definition 8.2.3. The m-variate series {Zt} is called iid noise with mean 0 and covariance matrix
�| , written

{Zt} ∼ iid(0,�| ), (8.2.11)

if the random vectors {Zt} are independent and identically distributed with mean 0
and covariance matrix �| .

Multivariate white noise {Zt} is used as a building block from which can be
constructed an enormous variety of multivariate time series. The linear processes are
generated as follows.

Definition 8.2.4. The m-variate series {Xt} is a linear process if it has the representation

Xt =
∞∑

j=−∞
CjZt−j, {Zt} ∼ WN(0,�| ), (8.2.12)

where {Cj} is a sequence of m × m matrices whose components are absolutely
summable.

The linear process (8.2.12) is stationary (Problem 7.2) with mean 0 and covariance
function

�(h) =
∞∑

j=−∞
Cj+h�|Cj

′, h = 0,±1, . . . . (8.2.13)

An MA(∞) process is a linear process with Cj = 0 for j < 0. Thus {Xt} is an
MA(∞) process if and only if there exists a white noise sequence {Zt} and a sequence
of matrices Cj with absolutely summable components such that

Xt =
∞∑

j=0

CjZt−j.

Multivariate ARMA processes will be discussed in Section 8.4, where it will be shown
in particular that any causal ARMA(p, q) process can be expressed as an MA(∞)
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process, while any invertible ARMA( p, q) process can be expressed as an AR(∞)
process, i.e., a process satisfying equations of the form

Xt +
∞∑

j=1

AjXt−j = Zt,

in which the matrices Aj have absolutely summable components.

8.2.1 Second-Order Properties in the Frequency Domain

Provided that the components of the covariance matrix function �(·) have the property∑∞
h=−∞ |γij(h)| < ∞, i, j = 1, . . . ,m, then � has a matrix-valued spectral density

function

f (λ) = 1

2π

∞∑

h=−∞
e−iλh�(h), −π ≤ λ ≤ π,

and � can be expressed in terms of f as

�(h) =
∫ π

−π
eiλhf (λ)dλ.

The second-order properties of the stationary process {Xt} can therefore be described
equivalently in terms of f (·) rather than �(·). Similarly, {Xt} has a spectral represen-
tation

Xt =
∫ π

−π
eiλtdZ(λ),

where {Z(λ),−π ≤ λ ≤ π} is a process whose components are complex-valued
processes satisfying

E
(
dZj(λ)dZk(μ)

) =
{
fjk(λ)dλ if λ = μ,

0 if λ �= μ,

and Zk denotes the complex conjugate of Zk. We shall not go into the spectral
representation in this book. For details see Brockwell and Davis (1991).

8.3 Estimation of the Mean and Covariance Function

As in the univariate case, the estimation of the mean vector and covariances of a
stationary multivariate time series plays an important role in describing and model-
ing the dependence structure of the component series. In this section we introduce
estimators, for a stationarym-variate time series {Xt}, of the components μj, γij(h), and
ρij(h) of μ, �(h), and R(h), respectively. We also examine the large-sample properties
of these estimators.

8.3.1 Estimation of μ

A natural unbiased estimator of the mean vector μ based on the observations
X1, . . . ,Xn is the vector of sample means
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Xn = 1

n

n∑

t=1

Xt.

The resulting estimate of the mean of the jth time series is then the univariate sample
mean (1/n)

∑n
t=1 Xtj. If each of the univariate autocovariance functions γii(·), i =

1, . . . ,m, satisfies the conditions of Proposition 2.4.1, then the consistency of the
estimator Xn can be established by applying the proposition to each of the component
time series {Xti}. This immediately gives the following result.

Proposition 8.3.1. If {Xt} is a stationary multivariate time series with mean μ and covariance function
�(·), then as n → ∞,

E
(
Xn − μ

)′ (
Xn − μ

) → 0 if γii(n) → 0, 1 ≤ i ≤ m,

and

nE
(
Xn − μ

)′ (
Xn − μ

) →
m∑

i=1

∞∑

h=−∞
γii(h) if

∞∑

h=−∞
|γii(h)| < ∞, 1 ≤ i ≤ m.

Under more restrictive assumptions on the process {Xt} it can also be shown that
Xn is approximately normally distributed for large n. Determination of the covariance
matrix of this distribution would allow us to obtain confidence regions forμ. However,
this is quite complicated, and the following simple approximation is useful in practice.

For each i we construct a confidence interval for μi based on the sample mean Xi

of the univariate series X1i, . . . ,Xti and combine these to form a confidence region for
μ. If fi(ω) is the spectral density of the ith process {Xti} and if the sample size n is
large, then we know, under the same conditions as in Section 2.4, that

√
n
(
Xi − μi

)
is

approximately normally distributed with mean zero and variance

2π fi(0) =
∞∑

k=−∞
γii(k).

It can also be shown (see, e.g., Anderson 1971) that

2π f̂ i(0) :=
∑

|h|≤r

(

1 − |h|
r

)

γ̂ii(h)

is a consistent estimator of 2π fi(0), provided that r = rn is a sequence of numbers
depending on n in such a way that rn → ∞ and rn/n → 0 as n → ∞. Thus if Xi

denotes the sample mean of the ith process and Φα is the α-quantile of the standard
normal distribution, then the bounds

Xi ±Φ1−α/2
(

2π f̂ i(0)/n
)1/2

are asymptotic (1 − α) confidence bounds for μi. Hence

P

(

|μi − Xi| ≤ Φ1−α/2
(

2π f̂ i(0)/n
)1/2

, i = 1, . . . ,m

)

≥ 1 −
m∑

i=1

P

(
∣
∣μi − Xi

∣
∣ > Φ1−α/2

(
2π f̂ i(0)/n

)1/2
)

,
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where the right-hand side converges to 1 −mα as n → ∞. Consequently, as n → ∞,
the set of m-dimensional vectors bounded by

{

xi = Xi ±Φ1−(α/(2m))
(

2π f̂ i(0)/n
)1/2

, i = 1, . . . ,m

}

(8.3.1)

has a confidence coefficient that converges to a value greater than or equal to 1 − α
(and substantially greater if m is large). Nevertheless, the region defined by (8.3.1) is
easy to determine and is of reasonable size, provided that m is not too large.

8.3.2 Estimation of �(h)

As in the univariate case, a natural estimator of the covariance �(h) = E
[(
Xt+h −

μ
)(
Xt − μ

)′]
is

�̂(h) =

⎧
⎪⎪⎨

⎪⎪⎩

n−1
n−h∑

t=1

(
Xt+h − Xn

) (
Xt − Xn

)′
for 0 ≤ h ≤ −1,

�̂′(−h) for − n + 1 ≤ h < 0.

Writing γ̂ij(h) for the (i, j)-component of �̂(h), i, j = 1, 2, . . ., we estimate the cross-
correlations by

ρ̂ij(h) = γ̂ij(h)(γ̂ii(0)γ̂jj(0))
−1/2.

If i = j, then ρ̂ij reduces to the sample autocorrelation function of the ith series.
Derivation of the large-sample properties of γ̂ij and ρ̂ij is quite complicated in

general. Here we shall simply note one result that is of particular importance for testing
the independence of two component series. For details of the proof of this and related
results, see Brockwell and Davis (1991).

Theorem 8.3.1. Let {Xt} be the bivariate time series whose components are defined by

Xt1 =
∞∑

k=−∞
αkZt−k,1, {Zt1} ∼ IID

(
0, σ 2

1

)
,

and

Xt2 =
∞∑

k=−∞
βkZt−k,2, {Zt2} ∼ IID

(
0, σ 2

2

)
,

where the two sequences {Zt1} and {Zt2} are independent,
∑

k |αk| < ∞, and∑
k |βk| < ∞.

Then for all integers h and k with h �= k, the random variables n1/2ρ̂12(h)
and n1/2ρ̂12(k) are approximately bivariate normal with mean 0, variance∑∞

j=−∞ ρ11( j)ρ22( j), and covariance
∑∞

j=−∞ ρ11( j)ρ22( j + k − h), for n large.

[For a related result that does not require the independence of the two series {Xt1} and
{Xt2} see Bartlett’s Formula, Section 8.3.4 below.]

Theorem 8.3.1 is useful in testing for correlation between two time series. If one
of the two processes in the theorem is white noise, then it follows at once from the
theorem that ρ̂12(h) is approximately normally distributed with mean 0 and variance
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1/n, in which case it is straightforward to test the hypothesis that ρ12(h) = 0. However,
if neither process is white noise, then a value of ρ̂12(h) that is large relative to n−1/2 does
not necessarily indicate that ρ12(h) is different from zero. For example, suppose that
{Xt1} and {Xt2} are two independent AR(1) processes with ρ11(h) = ρ22(h) = 0.8|h|.
Then the large-sample variance of ρ̂12(h) is n−1

(
1 + 2

∑∞
k=1(0.64)k

) = 4.556n−1. It
would therefore not be surprising to observe a value of ρ̂12(h) as large as 3n−1/2 even
though {Xt1} and {Xt2} are independent. If on the other hand, ρ11(h) = 0.8|h| and
ρ22(h) = (−0.8)|h|, then the large-sample variance of ρ̂12(h) is 0.2195n−1, and an
observed value of 3n−1/2 for ρ̂12(h) would be very unlikely.

8.3.3 Testing for Independence of Two Stationary Time Series

Since by Theorem 8.3.1 the large-sample distribution of ρ̂12(h) depends on both ρ11(·)
and ρ22(·), any test for independence of the two component series cannot be based
solely on estimated values of ρ12(h), h = 0,±1, . . ., without taking into account the
nature of the two component series.

This difficulty can be circumvented by “prewhitening” the two series before
computing the cross-correlations ρ̂12(h), i.e., by transforming the two series to white
noise by application of suitable filters. If {Xt1} and {Xt2} are invertible ARMA ( p, q)
processes, this can be achieved by the transformations

Zti =
∞∑

j=0

π
(i)
j Xt−j,i,

where
∑∞

j=0 π
(i)
j z j = φ(i)(z)/θ(i)(z) and φ(i), θ(i) are the autoregressive and moving-

average polynomials of the ith series, i = 1, 2.
Since in practice the true model is nearly always unknown and since the data Xtj,

t ≤ 0, are not available, it is convenient to replace the sequences {Zti} by the residuals{
Ŵti

}
after fitting a maximum likelihood ARMA model to each of the component

series (see (5.3.1)). If the fitted ARMAmodels were in fact the true models, the series{
Ŵti

}
would be white noise sequences for i = 1, 2.

To test the hypothesis H0 that {Xt1} and {Xt2} are independent series, we observe
that under H0, the corresponding two prewhitened series {Zt1} and {Zt2} are also inde-
pendent. Theorem 8.3.1 then implies that the sample cross-correlations ρ̂12(h), ρ̂12(k),
h �= k, of {Zt1} and {Zt2} are for large n approximately independent and normally dis-
tributed with means 0 and variances n−1. An approximate test for independence can
therefore be obtained by comparing the values of |ρ̂12(h)| with 1.96n−1/2, exactly as
in Section 5.3.2. If we prewhiten only one of the two original series, say {Xt1}, then
under H0 Theorem 8.3.1 implies that the sample cross-correlations ρ̃12(h), ρ̃12(k),
h �= k, of {Zt1} and {Xt2} are for large n approximately normal with means 0, vari-
ances n−1 and covariance n−1ρ22(k − h), where ρ22(·) is the autocorrelation function
of {Xt2}. Hence, for any fixed h, ρ̃12(h) also falls (under H0) between the bounds
±1.96n−1/2 with a probability of approximately 0.95.

Example 8.3.1. The sample correlation functions ρ̂ij(·), i, j = 1, 2, of the bivariate time series
E731A.TSM (of length n = 200) are shown in Figure 8-7. Without taking into
account the autocorrelations ρ̂ii(·), i = 1, 2, it is impossible to decide on the basis of
the cross-correlations whether or not the two component processes are independent
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Figure 8-7
The sample correlations

of the bivariate series
E731A.TSM of

Example 8.3.1, showing the
bounds ±1.96n−1/2
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of each other. Notice that many of the sample cross-correlations ρ̂ij(h), i �= j, lie
outside the bounds ±1.96n−1/2 = ±0.139. However, these bounds are relevant
only if at least one of the component series is white noise. Since this is clearly
not the case, a whitening transformation must be applied to at least one of the
two component series. Analysis using ITSM leads to AR(1) models for each. The
residuals from these maximum likelihood models are stored as a bivariate series in
the file E731B.TSM, and their sample correlations, obtained from ITSM, are shown
in Figure 8-8. All but two of the cross-correlations are between the bounds ±0.139,
suggesting by Theorem 8.3.1 that the two residual series (and hence the two original
series) are uncorrelated. The data for this example were in fact generated as two
independent AR(1) series with φ = 0.8 and σ 2 = 1.

�

8.3.4 Bartlett’s Formula

In Section 2.4 we gave Bartlett’s formula for the large-sample distribution of the
sample autocorrelation vector ρ̂ = (

ρ̂(1), . . . , ρ̂(k)
)′

of a univariate time series.
The following theorem gives a large-sample approximation to the covariances of the
sample cross-correlations ρ̂12(h) and ρ̂12(k) of the bivariate time series {Xt} under the
assumption that {Xt} is Gaussian. However, it is not assumed (as in Theorem 8.3.1)
that {Xt1} is independent of {Xt2}.
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Figure 8-8
The sample correlations
of the bivariate series of
residuals E731B.TSM,

whose components are
the residuals from the AR(1)
models fitted to each of the

component series in
E731A.TSM
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Figure 8-9
The sample correlations
of the whitened series

Ŵt+h,1 and Ŵt2 of
Example 8.3.2, showing the

bounds ±1.96n−1/2
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Bartlett’s Formula:
If {Xt} is a bivariate Gaussian time series with covariances satisfying∑∞

h=−∞ |γij(h)| < ∞, i, j = 1, 2, then

lim
n→∞ nCov

(
ρ̂12(h), ρ̂12(k)

)=
∞∑

j=−∞

[

ρ11( j)ρ22( j + k − h)+ ρ12( j + k)ρ21( j − h)

−ρ12(h){ρ11( j)ρ12( j + k)+ ρ22( j)ρ21( j − k)}
−ρ12(k){ρ11( j)ρ12( j + h)+ ρ22( j)ρ21( j − h)}
+ρ12(h)ρ12(k)

{
1

2
ρ2

11( j)+ ρ2
12( j)+

1

2
ρ2

22( j)

}]

Corollary 8.3.1. If {Xt} satisfies the conditions for Bartlett’s formula, if either {Xt1} or {Xt2} is white
noise, and if

ρ12(h) = 0, h /∈ [a, b],
then

lim
n→∞ nVar

(
ρ̂12(h)

) = 1, h /∈ [a, b].

Example 8.3.2. Sales with a leading indicator

We consider again the differenced series {Dt1} and {Dt2} of Example 8.1.2, for which
we found the maximum likelihood models (8.1.1) and (8.1.2) using ITSM. The resid-
uals from the two models (which can be filed by ITSM) are the two “whitened” series{
Ŵt1

}
and

{
Ŵt2

}
with sample variances 0.0779 and 1.754, respectively. This bivariate

series is contained in the file E732.TSM.
The sample auto- and cross-correlations of {Dt1} and {Dt2} were shown in

Figure 8-6. Without taking into account the autocorrelations, it is not possible to
draw any conclusions about the dependence between the two component series from
the cross-correlations.

Examination of the sample cross-correlation function of the whitened series
{
Ŵt1

}

and
{
Ŵt2

}
, on the other hand, is much more informative. From Figure 8-9 it is apparent

that there is one large-sample cross-correlation (between Ŵt+3,2 and Ŵt,1), while the
others are all between ±1.96n−1/2.

�
If
{
Ŵt1

}
and

{
Ŵt2

}
are assumed to be jointly Gaussian, Corollary 8.3.1 indicates

the compatibility of the cross-correlations with a model for which

ρ12(−3) �= 0

and

ρ12(h) = 0, h �= −3.

The value ρ̂12(−3) = 0.969 suggests the model

Ŵt2 = 4.74Ŵt−3,1 + Nt, (8.3.2)

where the stationary noise {Nt} has small variance compared with
{
Ŵt2

}
and

{
Ŵt1

}
,

and the coefficient 4.74 is the square root of the ratio of sample variances of
{
Ŵt2

}
and
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{
Ŵt1

}
. A study of the sample values of

{
Ŵt2 − 4.74Ŵt−3,1

}
suggests the model

(1 + 0.345B)Nt = Ut, {Ut} ∼ WN(0, 0.0782) (8.3.3)

for {Nt}. Finally, replacing Ŵt2 and Ŵt−3,1 in (8.3.2) by Zt2 and Zt−3,1, respectively, and
then using (8.1.1) and (8.1.2) to express Zt2 and Zt−3,1 in terms of {Dt2} and {Dt1}, we
obtain a model relating {Dt1}, {Dt2}, and {Ut1}, namely,

Dt2 + 0.0773 = (1 − 0.610B)(1 − 0.838B)−1[4.74(1 − 0.474B)−1Dt−3,1

+ (1 + 0.345B)−1Ut].
This model should be compared with the one derived later in Section 11.1 by the more
systematic technique of transfer function modeling.

8.4 Multivariate ARMA Processes

As in the univariate case, we can define an extremely useful class of multivari-
ate stationary processes {Xt} by requiring that {Xt} should satisfy a set of linear
difference equations with constant coefficients. Multivariate white noise {Zt} (see
Definition 8.2.2) is a fundamental building block from which these ARMA processes
are constructed.

Definition 8.4.1. {Xt} is an ARMA( p, q) process if {Xt} is stationary and if for every t,
Xt −Φ1Xt−1 − · · · −ΦpXt−p = Zt +Θ1Zt−1 + · · · +ΘqZt−q, (8.4.1)

where {Zt} ∼ WN(0,�| ). ({Xt} is anARMA(p, q) processwithmeanμ if {Xt−μ}
is an ARMA( p, q) process.)

Equations (8.4.1) can be written in the more compact form

Φ(B)Xt = Θ(B)Zt, {Zt} ∼ WN(0, �| ), (8.4.2)

where Φ(z) := I − Φ1z − · · · − Φpzp and Θ(z) := I +Θ1z + · · · +Θqzq are matrix-
valued polynomials, I is them×m identity matrix, and B as usual denotes the backward
shift operator. (Each component of the matrices Φ(z), Θ(z) is a polynomial with real
coefficients and degree less than or equal to p, q, respectively.)

Example 8.4.1. The multivariate AR(1) process

Setting p = 1 and q = 0 in (8.4.1) gives the defining equations

Xt = ΦXt−1 + Zt, {Zt} ∼ WN(0, �| ), (8.4.3)

for the multivariate AR(1) series {Xt}. By exactly the same argument as used in
Example 2.2.1, we can express Xt as

Xt =
∞∑

j=0

Φ jZt−j, (8.4.4)

provided that all the eigenvalues of Φ are less than 1 in absolute value, i.e., provided
that
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det(I − zΦ) �= 0 for all z ∈ C such that |z| ≤ 1. (8.4.5)

If this condition is satisfied, then the coefficients Φ j are absolutely summable, and
hence the series in (8.4.4) converges; i.e., each component of the matrix

∑n
j=0Φ

jZt−j

converges (see Remark 1 of Section 2.2). The same argument as in Example 2.2.1 also
shows that (8.4.4) is the unique stationary solution of (8.4.3). The condition that all
the eigenvalues of Φ should be less than 1 in absolute value (or equivalently (8.4.5))
is just the multivariate analogue of the condition |φ| < 1 required for the existence of
a causal stationary solution of the univariate AR(1) equations (2.2.8).

�
Causality and invertibility of a multivariate ARMA( p, q) process are defined

precisely as in Section 3.1, except that the coefficients ψj, πj in the representations
Xt = ∑∞

j=0ψjZt−j and Zt = ∑∞
j=0 πjXt−j are replaced by m × m matrices Ψj

and �j whose components are required to be absolutely summable. The following
two theorems (proofs of which can be found in Brockwell and Davis (1991)) provide
us with criteria for causality and invertibility analogous to those of Section 3.1.

Causality:
An ARMA(p, q) process {Xt} is causal, or a causal function of {Zt}, if there
exist matrices {Ψj} with absolutely summable components such that

Xt =
∞∑

j=0

ΨjZt−j for all t. (8.4.6)

Causality is equivalent to the condition

detΦ(z) �= 0 for all z ∈ C such that |z| ≤ 1. (8.4.7)

The matrices Ψj are found recursively from the equations

Ψj = Θj +
∞∑

k=1

ΦkΨj−k, j = 0, 1, . . . , (8.4.8)

where we define Θ0 = I, Θj = 0 for j > q, Φj = 0 for j > p, and Ψj = 0 for
j < 0.

Invertibility:
An ARMA( p, q) process {Xt} is invertible if there exist matrices {�j} with
absolutely summable components such that

Zt =
∞∑

j=0

�jXt−j for all t. (8.4.9)

Invertibility is equivalent to the condition

detΘ(z) �= 0 for all z ∈ C such that |z| ≤ 1. (8.4.10)

The matrices �j are found recursively from the equations

�j = −Φj −
∞∑

k=1

Θk�j−k, j = 0, 1, . . . , (8.4.11)

where we define Φ0 = −I, Φj = 0 for j > p, Θj = 0 for j > q, and �j = 0 for
j < 0.
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Example 8.4.2. For the multivariate AR(1) process defined by (8.4.3), the recursions (8.4.8) give

Ψ0 = I,

Ψ1 = ΦΨ0 = Φ,

Ψ2 = ΦΨ1 = Φ2,

...

Ψj = ΦΨj−1 = Φ j, j ≥ 3,

as already found in Example 8.4.1.
�

Remark 3. For the bivariate AR(1) process (8.4.3) with

Φ =
[

0 0.5
0 0

]

it is easy to check that Ψj = Φ j = 0 for j > 1 and hence that {Xt} has the alternative
representation

Xt = Zt +ΦZt−1

as an MA(1) process. This example shows that it is not always possible to distinguish
between multivariate ARMA models of different orders without imposing further
restrictions. If, for example, attention is restricted to pure AR processes, the prob-
lem does not arise. For detailed accounts of the identification problem for general
ARMA( p, q) models see Hannan and Deistler (1988) and Lütkepohl (1993). �

8.4.1 The Covariance Matrix Function of a Causal ARMA Process

From (8.2.13) we can express the covariance matrix �(h) = E(Xt+hX′
t) of the causal

process (8.4.6) as

�(h) =
∞∑

j=0

Ψh+j�|Ψ ′
j , h = 0,±1, . . . , (8.4.12)

where the matrices Ψj are found from (8.4.8) and Ψj := 0 for j < 0.
The covariance matrices �(h), h = 0,±1, . . ., can also be found by solving the

Yule–Walker equations

�( j)−
p∑

r=1

Φr�( j − r) =
∑

j≤r≤q

Θr�|Ψr−j, j = 0, 1, 2, . . . ,

(8.4.13)

obtained by postmultiplying (8.4.1) by X′
t−j and taking expectations. The first p+1 of

the equation (8.4.13) can be solved for the components of �(0), . . . , �(p) using the
fact that �(−h) = �′(h). The remaining equations then give �(p + 1), �(p + 2), . . .
recursively. An explicit form of the solution of these equations can be written down
by making use of Kronecker products and the vec operator (see e.g., Lütkepohl 1993).

Remark 4. If z0 is the root of detΦ(z) = 0 with smallest absolute value, then it can
be shown from the recursions (8.4.8) that Ψj/r j → 0 as j → ∞ for all r such that
|z0|−1 < r < 1. Hence, there is a constant C such that each component of Ψj is smaller
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in absolute value than Cr j. This implies in turn that there is a constant K such that each
component of the matrixΨh+j�|Ψ ′

j on the right of (8.4.12) is bounded in absolute value
by Kr 2j. Provided that |z0| is not very close to 1, this means that the series (8.4.12) con-
verges rapidly, and the error incurred in each component by truncating the series after
the term with j = k− 1 is smaller in absolute value than

∑∞
j=k Kr

2j = Kr 2k/
(
1 − r 2

)
.

8.5 Best Linear Predictors of Second-Order Random Vectors

Let
{
Xt = (Xt1, . . . ,Xtm)

′} be an m-variate time series with means EXt = μt and
covariance function given by the m × m matrices

K(i, j) = E
(
XiX′

j

)− μiμ
′
j.

If Y = (Y1, . . . ,Ym)
′ is a random vector with finite second moments and EY = μ, we

define

Pn(Y) = (PnY1, . . . ,PnYm)
′, (8.5.1)

where PnYj is the best linear predictor of the component Yj of Y in terms of all
of the components of the vectors Xt, t = 1, . . . , n, and the constant 1. It follows
immediately from the properties of the prediction operator (Section 2.5) that

Pn(Y) = μ + A1(Xn − μn)+ · · · + An(X1 − μ1) (8.5.2)

for some matrices A1, . . . ,An, and that

Y − Pn(Y) ⊥ Xn+1−i, i = 1, . . . , n, (8.5.3)

where we say that twom-dimensional random vectorsX andY are orthogonal (written
X ⊥ Y) if E(XY′) is a matrix of zeros. The vector of best predictors (8.5.1) is uniquely
determined by (8.5.2) and (8.5.3), although it is possible that there may be more than
one possible choice for A1, . . . ,An.

As a special case of the above, if {Xt} is a zero-mean time series, the best linear
predictor X̂n+1 of Xn+1 in terms of X1, . . . ,Xn is obtained on replacing Y by Xn+1 in
(8.5.1). Thus

X̂n+1 =
⎧
⎨

⎩

0, if n = 0,

Pn(Xn+1), if n ≥ 1.

Hence, we can write

X̂n+1 = Φn1Xn + · · · +ΦnnX1, n = 1, 2, . . . , (8.5.4)

where, from (8.5.3), the coefficients Φnj, j = 1, . . . , n, are such that

E
(
X̂n+1X′

n+1−i

)
= E

(
Xn+1X′

n+1−i

)
, i = 1, . . . , n, (8.5.5)

i.e.,
n∑

j=1

ΦnjK(n + 1 − j, n + 1 − i) = K(n + 1, n + 1 − i), i = 1, . . . , n.

In the case where {Xt} is stationary with K(i, j) = �(i − j), the prediction equations
simplify to the m-dimensional analogues of (2.5.7), i.e.,

n∑

j=1

Φnj�(i − j) = �(i), i = 1, . . . , n. (8.5.6)
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Provided that the covariance matrix of the nm components of X1, . . . ,Xn is nonsin-
gular for every n ≥ 1, the coefficients {Φnj} can be determined recursively using
a multivariate version of the Durbin–Levinson algorithm given by Whittle (1963)
(for details see Brockwell and Davis (1991), Proposition 11.4.1). Whittle’s recursions
also determine the covariance matrices of the one-step prediction errors, namely,
V0 = �(0) and, for n ≥ 1,

Vn = E(Xn+1 − X̂n+1)(Xn+1 − X̂n+1)
′

= �(0)−Φn1�(−1)− · · · −Φnn�(−n). (8.5.7)

Remark 5. The innovations algorithm also has a multivariate version that can be used
for prediction inmuch the sameway as the univariate version described in Section 2.5.4
(for details see Brockwell and Davis (1991), Proposition 11.4.2). �

8.6 Modeling and Forecasting with Multivariate AR Processes

If {Xt} is any zero-mean second-order multivariate time series, it is easy to show from
the results of Section 8.5 (Problem 8.4) that the one-step prediction errors Xj − X̂j,
j = 1, . . . , n, have the property

E
(
Xj − X̂j

) (
Xk − X̂k

)′ = 0 for j �= k. (8.6.1)

Moreover, the matrix M such that
⎡

⎢
⎢
⎢
⎢
⎢
⎣

X1 − X̂1

X2 − X̂2

X3 − X̂3
...

Xn − X̂n

⎤

⎥
⎥
⎥
⎥
⎥
⎦

= M

⎡

⎢
⎢
⎢
⎢
⎢
⎣

X1

X2

X3
...

Xn

⎤

⎥
⎥
⎥
⎥
⎥
⎦

(8.6.2)

is lower triangular with ones on the diagonal and therefore has determinant equal to 1.
If the series {Xt} is also Gaussian, then (8.6.1) implies that the prediction errors

Uj = Xj − X̂j, j = 1, . . . , n, are independent with covariance matrices V0, . . . ,Vn−1,
respectively (as specified in (8.5.7)). Consequently, the joint density of the prediction
errors is the product

f (u1, . . . ,un) = (2π)−nm/2

⎛

⎝
n∏

j=1

detVj−1

⎞

⎠

−1/2

exp

⎡

⎣−1

2

n∑

j=1

u′
jV

−1
j−1uj

⎤

⎦ .

Since the determinant of the matrix M in (8.6.2) is equal to 1, the joint density of the
observations X1, . . . ,Xn at x1, . . . , xn is obtained on replacing u1, . . . ,un in the last
expression by the values of Xj − X̂j corresponding to the observations x1, . . . , xn.

If we suppose that {Xt} is a zero-mean m-variate AR( p) process with coefficient
matrices Φ = {Φ1, . . . , Φp} and white noise covariance matrix �| , we can therefore
express the likelihood of the observations X1, . . . ,Xn as

L(Φ, �| ) = (2π)−nm/2

⎛

⎝
n∏

j=1

detVj−1

⎞

⎠

−1/2

exp

⎡

⎣−1

2

n∑

j=1

U′
jV

−1
j−1Uj

⎤

⎦ ,
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where Uj = Xj − X̂j, j = 1, . . . , n, and X̂j and Vj are found from (8.5.4), (8.5.6),
and (8.5.7).

Maximization of the Gaussian likelihood is much more difficult in the multivariate
than in the univariate case because of the potentially large number of parameters
involved and the fact that it is not possible to compute the maximum likelihood
estimator of Φ independently of �| as in the univariate case. In principle, maximum
likelihood estimators can be computed with the aid of efficient nonlinear optimization
algorithms, but it is important to begin the search with preliminary estimates that are
reasonably close to the maximum. For pure AR processes good preliminary estimates
can be obtained usingWhittle’s algorithm or a multivariate version of Burg’s algorithm
given by Jones (1978). We shall restrict our discussion here to the use of Whit-
tle’s algorithm (the multivariate option AR-Model>Estimation>Yule-Walker
in ITSM), but Jones’s multivariate version of Burg’s algorithm is also available
(AR-Model>Estimation>Burg).Other useful algorithms can be found in Lütke-
pohl (1993), in particular the method of conditional least squares and the method of
Hannan and Rissanen (1982), the latter being useful also for preliminary estimation in
the more difficult problem of fitting ARMA( p, q) models with q > 0. Spectral meth-
ods of estimation for multivariate ARMA processes are also frequently used. A dis-
cussion of these (as well as some time-domain methods) is given in Anderson (1980).

Order selection for multivariate autoregressive models can be made byminimizing
a multivariate analogue of the univariate AICC statistic

AICC = −2 ln L(Φ1, . . . , Φp, �| )+ 2( pm2 + 1)nm

nm − pm2 − 2
. (8.6.3)

8.6.1 Estimation for Autoregressive Processes Using Whittle’s Algorithm

If {Xt} is the (causal) multivariate AR( p) process defined by the difference equations

Xt = Φ1Xt−1 + · · · +ΦpXt−p + Zt, {Zt} ∼ WN(0, �| ), (8.6.4)

then postmultiplying byX′
t−j, j = 0, . . . , p, and taking expectations gives the equations

�| = �(0)−
p∑

j=1

Φj�(−j) (8.6.5)

and

�(i) =
n∑

j=1

Φj�(i − j), i = 1, . . . , p. (8.6.6)

Given the matrices �(0), . . . , �(p), equation (8.6.6) can be used to determine the
coefficient matrices Φ1, . . . , Φp. The white noise covariance matrix �| can then
be found from (8.6.5). The solution of these equations for Φ1, . . . , Φp, and �| is
identical to the solution of (8.5.6) and (8.5.7) for the prediction coefficient matrices
Φp1, . . . , Φpp and the corresponding prediction error covariance matrix Vp. Conse-
quently, Whittle’s algorithm can be used to carry out the algebra.

The Yule–Walker estimators Φ̂1, . . . , Φ̂p, and �̂| for the model (8.6.4) fitted to
the data X1, . . . ,Xn are obtained by replacing �( j) in (8.6.5) and (8.6.6) by �̂( j),
j = 0, . . . , p, and solving the resulting equations for Φ1, . . . , Φp, and �| . The
solution of these equations is obtained from ITSM by selecting the multivariate
option AR-Model>Estimation>Yule-Walker. The mean vector of the fitted
model is the sample mean of the data, and Whittle’s algorithm is used to solve the
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equations (8.6.5) and (8.6.6) for the coefficient matrices and the white noise covariance
matrix. The fitted model is displayed by ITSM in the form

Xt = φ0 +Φ1Xt−1 + · · · +ΦpXt−p + Zt, {Zt} ∼ WN(0, �| ).
Note that the mean μ of this model is not the vector φ0, but

μ = (I −Φ1 − · · · −Φp)
−1φ0.

In fitting multivariate autoregressive models using ITSM, check the box Find
minimum AICC model to find the AR(p) model with 0 ≤ p ≤ 20 that mini-
mizes the AICC value as defined in (8.6.3).

Analogous calculations using Jones’s multivariate version of Burg’s algorithm can
be carried out by selecting AR-Model>Estimation>Burg.

Example 8.6.1 The Dow Jones and All Ordinaries Indices

To find the minimum AICC Yule–Walker model (of order less than or equal to 20) for
the bivariate series {(Xt1,Xt2)

′, t = 1, . . . , 250} of Example 8.1.1, proceed as follows.
Select File>Project>Open> Multivariate, click OK, and then double-click
on the file name, DJAOPC2.TSM. Check that Number of columns is set to 2,
the dimension of the observation vectors, and click OK again to see graphs of the two
component time series. No differencing is required (recalling from Example 8.1.1 that
{Xt1} and {Xt2} are the daily percentage price changes of the original Dow Jones and
All Ordinaries Indices). Select AR-Model>Estimation>Yule-Walker, check
the box Find minimum AICC Model, click OK, and you will obtain the model

[
Xt1

Xt2

]

=
[

0.0288
0.00836

]

+
[−0.0148 0.0357

0.6589 0.0998

] [
Xt−1,1

Xt−1,2

]

+
[
Zt1

Zt2

]

,

where
[
Zt1

Zt2

]

∼ WN

([
0
0

]

,

[
0.3653 0.0224
0.0224 0.6016

])

.

�

Example 8.6.2 Sales with a leading indicator

The series {Yt1} (leading indicator) and {Yt2} (sales) are stored in bivariate form
(Yt1 in column 1 and Yt2 in column 2) in the file LS2.TSM. On opening this file
in ITSM you will see the graphs of the two component time series. Inspection of
the graphs immediately suggests, as in Example 8.2.2, that the differencing operator
∇ = 1 −B should be applied to the data before a stationary AR model is fitted. Select
Transform>Difference and specify 1 for the differencing lag. Click OK and
you will see the graphs of the two differenced series. Inspection of the series and
their correlation functions (obtained by pressing the second yellow button at the top
of the ITSM window) suggests that no further differencing is necessary. The next
step is to select AR-model>Estimation>Yule-Walkerwith the option Find
minimum AICC model. The resulting model has order p = 5 and parameters
φ0 = (0.0328 0.0156)′ ,

Φ̂1 =
[−0.517 0.024
−0.019 −0.051

]

, Φ̂2 =
[−0.192 −0.018

0.047 0.250

]

, Φ̂3 =
[−0.073 0.010

4.678 0.207

]

,
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Φ̂4 =
[−0.032 −0.009

3.664 0.004

]

, Φ̂5 =
[

0.022 0.011
1.300 0.029

]

, �̂| =
[

0.076 −0.003
−0.003 0.095

]

,

with AICC=109.49. (Analogous calculations using Burg’s algorithm give an AR(8)
model for the differenced series.) The sample cross-correlations of the residual
vectors Ẑt can be plotted by clicking on the last blue button at the top of the ITSM
window. These are nearly all within the bounds ±1.96/

√
n, suggesting that the

model is a good fit. The components of the residual vectors themselves are plot-
ted by selecting AR Model>Residual Analysis>Plot Residuals. Sim-
ulated observations from the fitted model can be generated using the option AR
Model>Simulate.The fitted model has the interesting property that the upper right
component of each of the co- efficient matrices is close to zero. This suggests that {Xt1}
can be effectively modeled independently of {Xt2}. In fact, the MA(1) model

Xt1 = (1 − 0.474B)Ut, {Ut} ∼ WN(0, 0.0779), (8.6.7)

provides an adequate fit to the univariate series {Xt1}. Inspecting the bottom rows of
the coefficient matrices and deleting small entries, we find that the relation between
{Xt1} and {Xt2} can be expressed approximately as

Xt2 = 0.250Xt−2,2 + 0.207Xt−3,2 + 4.678Xt−3,1 + 3.664Xt−4,1 + 1.300Xt−5,1 +Wt,

or equivalently,

Xt2 = 4.678B3(1 + 0.783B + 0.278B2)

1 − 0.250B2 − 0.207B3
Xt1 + Wt

1 − 0.250B2 − 0.207B3
,

(8.6.8)

where {Wt} ∼ WN(0, 0.095). Moreover, since the estimated noise covariance matrix is
essentially diagonal, it follows that the two sequences {Xt1} and {Wt} are uncorrelated.
This reduced model defined by (8.6.7) and (8.6.8) is an example of a transfer function
model that expresses the “output” series {Xt2} as the output of a linear filter with “input”
{Xt1} plus added noise. Amore direct approach to the fitting of transfer function models
is given in Section 11.1 and applied to this same data set.

�

8.6.2 Forecasting Multivariate Autoregressive Processes

The technique developed in Section 8.5 allows us to compute the minimum mean
squared error one-step linear predictors X̂n+1 for anymultivariate stationary time series
from the mean μ and autocovariance matrices �(h) by recursively determining the
coefficients Φni, i = 1, . . . , n, and evaluating

X̂n+1 = μ +Φn1(Xn − μ)+ · · · +Φnn(X1 − μ). (8.6.9)

The situation is simplified when {Xt} is the causal AR(p) process defined by
(8.6.4), since for n ≥ p (as is almost always the case in practice)

X̂n+1 = Φ1Xn + · · · + ΦpXn+1−p. (8.6.10)

To verify (8.6.10) it suffices to observe that the right-hand side has the required form
(8.5.2) and that the prediction error

Xn+1 −Φ1Xn − · · · −ΦpXn+1−p = Zn+1
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is orthogonal to X1, . . . ,Xn in the sense of (8.5.3). (In fact, the prediction error is
orthogonal to all Xj,−∞ < j ≤ n, showing that if n ≥ p, then (8.6.10) is also the
best linear predictor of Xn+1 in terms of all components of Xj, −∞ < j ≤ n.) The
covariance matrix of the one-step prediction error is clearly E(Zn+1Z′

n+1) = �| .
To compute the best h-step linear predictor PnXn+h based on all the components

of X1, . . . ,Xn we apply the linear operator Pn to (8.6.4) to obtain the recursions

PnXn+h = Φ1PnXn+h−1 + · · · + ΦpPnXn+h−p. (8.6.11)

These equations are easily solved recursively, first for PnXn+1, then for PnXn+2,
PnXn+3, . . ., etc. If n ≥ p, then the h-step predictors based on all components of
Xj,−∞ < j ≤ n, also satisfy (8.6.11) and are therefore the same as the h-step
predictors based on X1, . . . ,Xn.

To compute the h-step error covariance matrices, recall from (8.4.6) that

Xn+h =
∞∑

j=0

ΨjZn+h−j, (8.6.12)

where the coefficient matrices Ψj are found from the recursions (8.4.8) with q = 0.
From (8.6.12) we find that for n ≥ p,

PnXn+h =
∞∑

j=h

ΨjZn+h−j. (8.6.13)

Subtracting (8.6.13) from (8.6.12) gives the h-step prediction error

Xn+h − PnXn+h =
h−1∑

j=0

ΨjZn+h−j, (8.6.14)

with covariance matrix

E
[
(Xn+h − PnXn+h)(Xn+h − PnXn+h)

′] =
h−1∑

j=0

Ψj�|Ψ ′
j , n ≥ p. (8.6.15)

For the (not necessarily zero-mean) causal AR(p) process defined by

Xt = φ0 +Φ1Xt−1 + · · · +ΦpXt−p + Zt, {Zt} ∼ WN(0, �| ),
Equations (8.6.10) and (8.6.11) remain valid, provided that φ0 is added to each of their
right-hand sides. The error covariance matrices are the same as in the case φ0 = 0.

The above calculations are all based on the assumption that the AR( p) model
for the series is known. However, in practice, the parameters of the model are usually
estimated from the data, and the uncertainty in the predicted values of the series will be
larger than indicated by (8.6.15) because of parameter estimation errors. See Lütkepohl
(1993).

Example 8.6.3 The Dow Jones and All Ordinaries Indices

The VAR(1) model fitted to the series {Xt, t = 1, . . . , 250} in Example 8.6.1 was
[
Xt1

Xt2

]

=
[

0.0288
0.00836

]

+
[−0.0148 0.0357

0.6589 0.0998

] [
Xt−1,1

Xt−1,2

]

+
[
Zt1

Zt2

]

,

where
[
Zt1

Zt2

]

∼ WN

([
0
0

]

,

[
0.3653 0.0224
0.0224 0.6016

])

.
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The one-step mean squared error for prediction of Xt2, assuming the validity of this
model, is thus 0.6016. This is a substantial reduction from the estimated mean squared
error γ̂22(0) = 0.7712 when the sample mean μ̂2 = 0.0309 is used as the one-step
predictor.

If we fit a univariate model to the series {Xt2} using ITSM, we find that the
autoregression with minimum AICC value (645.0) is

Xt2 = 0.0273 + 0.1180Xt−1,2 + Zt, {Zt} ∼ WN(0, 0.7604).

Assuming the validity of this model, we thus obtain a mean squared error for one-
step prediction of 0.7604, which is slightly less than the estimated mean squared error
(0.7712) incurred when the sample mean is used for one-step prediction.

The preceding calculations suggest that there is little to be gained from the
point of view of one-step prediction by fitting a univariate model to {Xt2}, while
there is a substantial reduction achieved by the bivariate AR(1) model for {Xt =
(Xt1,Xt2)

′}.
To test the models fitted above, we consider the next forty values {Xt, t =

251, . . . , 290}, which are stored in the file DJAOPCF.TSM. We can use these val-
ues, in conjunction with the bivariate and univariate models fitted to the data for
t = 1, . . . , 250, to compute one-step predictors of Xt2, t = 251, . . . , 290. The results
are as follows:

Predictor Average Squared Error
μ̂ = 0.0309 0.4706

AR(1) 0.4591
VAR(1) 0.3962

It is clear from these results that the sample variance of the series {Xt2, t = 251, . . . ,
290} is rather less than that of the series {Xt2, t = 1, . . . , 250}, and consequently,
the average squared errors of all three predictors are substantially less than expected
from the models fitted to the latter series. Both the AR(1) and VAR(1) models show
an improvement in one-step average squared error over the sample mean μ̂, but the
improvement shown by the bivariate model is much more pronounced.

�
The calculation of predictors and their error covariance matrices for multivari-

ate ARIMA and SARIMA processes is analogous to the corresponding univariate
calculation, so we shall simply state the pertinent results. Suppose that {Yt} is
a nonstationary process satisfying D(B)Yt = Ut where D(z) = 1 − d1z− · · · − drzr is
a polynomial with D(1) = 0 and {Ut} is a causal invertible ARMA process with mean
μ. Then Xt = Ut − μ satisfies

Φ(B)Xt = Θ(B)Zt, {Zt} ∼ WN(0, �| ). (8.6.16)

Under the assumption that the random vectors Y−r+1, . . . ,Y0 are uncorrelated with
the sequence {Zt}, the best linear predictors P̃nYj of Yj, j > n > 0, based on 1 and
the components of Yj,−r + 1,≤ j ≤ n, are found as follows. Compute the observed
values of Ut = D(B)Yt, t = 1, . . . , n, and use the ARMA model for Xt = Ut − μ to
compute predictors PnUn+h. Then use the recursions

P̃nYn+h = PnUn+h +
r∑

j=1

djP̃nYn+h−j (8.6.17)
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to compute successively P̃nYn+1, P̃nYn+2, P̃nYn+3, etc. The error covariance matrices
are approximately (for large n)

E
[
(Yn+h − P̃nYn+h)(Yn+h − P̃nYn+h)

′
]

=
h−1∑

j=0

Ψ ∗
j �|Ψ ∗

j
′, (8.6.18)

where Ψ ∗
j is the coefficient of z j in the power series expansion

∞∑

j=0

Ψ ∗
j z

j = D(z)−1Φ−1(z)Θ(z), |z| < 1.

The matrices Ψ ∗
j are most readily found from the recursions (8.4.8) after replacing

Φj, j = 1, . . . , p, by Φ∗
j , j = 1, . . . , p + r, where Φ∗

j is the coefficient of z j in
D(z)Φ(z).

Remark 6. In the special case where Θ(z) = I (i.e., in the purely autoregressive
case) the expression (8.6.18) for the h-step error covariance matrix is exact for all
n ≥ p (i.e., if there are at least p + r observed vectors). The program ITSM allows
differencing transformations and subtraction of the mean before fitting a multivariate
autoregression. Predicted values for the original series and the standard deviations of
the prediction errors can be determined using the multivariate option Forecast-
ing>AR Model. �

Remark 7. In the multivariate case, simple differencing of the type discussed in this
section where the same operator D(B) is applied to all components of the random
vectors is rather restrictive. It is useful to consider more general linear transformations
of the data for the purpose of generating a stationary series. Such considerations lead
to the class of cointegrated models discussed briefly in Section 8.7 below. �

Example 8.6.4 Sales with a leading indicator

Assume that the model fitted to the bivariate series {Yt, t = 0, . . . , 149} in Exam-
ple 8.6.2 is correct, i.e., that

Φ(B)Xt = Zt, {Zt} ∼ WN
(
0, �̂|

)
,

where

Xt = (1 − B)Yt − (0.0228, 0.420)′, t = 1, . . . , 149,

Φ(B) = I − Φ̂1B − · · · − Φ̂5B5, and Φ̂1, . . . , Φ̂5, �̂| are the matrices found
in Example 8.6.2. Then the one- and two-step predictors of X150 andX151 are obtained
from (8.6.11) as

P149X150 = Φ̂1X149 + · · · + Φ̂5X145 =
[

0.163
−0.217

]

and

P149X151 = Φ̂1P149X150 + Φ̂2X149 + · · · + Φ̂5X146 =
[−0.027

0.816

]

with error covariance matrices, from (8.6.15),

�| =
[

0.076 −0.003
−0.003 0.095

]
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and

�| + Φ̂1�| Φ̂ ′
1 =

[
0.096 −0.002

−0.002 0.095

]

,

respectively.
Similarly, the one- and two-step predictors of Y150 and Y151 are obtained from

(8.6.17) as

P̃149Y150 =
[

0.0228
0.420

]

+ P149X150 + Y149 =
[

13.59
262.90

]

and

P̃149Y151 =
[

0.0228
0.420

]

+ P149X151 + P̃149Y150 =
[

13.59
264.14

]

with error covariance matrices, from (8.6.18),

�| =
[

0.076 −0.003
−0.003 0.095

]

and

�| +
(
I + Φ̂1

)
�|
(
I + Φ̂1

)′ =
[

0.094 −0.003
−0.003 0.181

]

,

respectively. The predicted values and the standard deviations of the predictors can
easily be verified with the aid of the program ITSM. It is also of interest to compare the
results with those obtained by fitting a transfer function model to the data as described
in Section 11.1 below.

�

8.7 Cointegration

We have seen that nonstationary univariate time series can frequently be made
stationary by applying the differencing operator ∇ = 1 − B repeatedly. If

{∇dXt

}
is

stationary for some positive integer d but
{∇d−1Xt

}
is nonstationary, we say that {Xt}

is integrated of order d, or more concisely, {Xt} ∼ I(d). Many macroeconomic
time series are found to be integrated of order 1.

If {Xt} is a k-variate time series, we define
{∇dXt

}
to be the series whose jth

component is obtained by applying the operator (1−B)d to the jth component of {Xt},
j = 1, . . . , k. The idea of a cointegrated multivariate time series was introduced by
Granger (1981) and developed by Engle and Granger (1987). Here we use the slightly
different definition of Lütkepohl (1993). We say that the k-dimensional time series {Xt}
is integrated of order d (or {Xt} ∼ I(d)) if d is a positive integer,

{∇dXt

}
is stationary,

and
{∇d−1Xt

}
is nonstationary. The I(d) process {Xt} is said to be cointegrated with

cointegration vector α if α is a k × 1 vector such that {α′Xt} is of order less than d.

Example 8.7.1 A simple example is provided by the bivariate process whose first component is the
random walk

Xt =
t∑

j=1

Zj, t = 1, 2, . . . , {Zt} ∼ IID
(
0, σ 2) ,
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and whose second component consists of noisy observations of the same random walk,

Yt = Xt + Wt, t = 1, 2, . . . , {Wt} ∼ IID
(
0, τ 2) ,

where {Wt} is independent of {Zt}. Then {(Xt,Yt)
′} is integrated of order 1 and

cointegrated with cointegration vector α = (1,−1)′.
The notion of cointegration captures the idea of univariate nonstationary time

series “moving together.” Thus, even though {Xt} and {Yt} in Example 8.7.1 are both
nonstationary, they are linked in the sense that they differ only by the stationary
sequence {Wt}. Series that behave in a cointegrated manner are often encountered in
economics. Engle and Granger (1991) give as an illustrative example the prices of
tomatoes Ut and Vt in Northern and Southern California. These are linked by the fact
that if one were to increase sufficiently relative to the other, the profitability of buying
in one market and selling for a profit in the other would tend to push the prices (Ut,Vt)

′
toward the straight line v = u in R

2. This line is said to be an attractor for (Ut,Vt)
′,

since although Ut and Vt may both vary in a nonstationary manner as t increases, the
points (Ut,Vt)

′ will exhibit relatively small random deviations from the line v = u.
�

Example 8.7.2 If we apply the operator ∇ = 1 − B to the bivariate process defined in Example 8.7.1
in order to render it stationary, we obtain the series (Ut,Vt)

′, where

Ut = Zt

and

Vt = Zt + Wt − Wt−1.

The series {(Ut,Vt)
′} is clearly a stationary multivariate MA(1) process

[
Ut

Vt

]

=
[

1 0
0 1

] [
Zt

Zt + Wt

]

−
[

0 0
−1 1

] [
Zt−1

Zt−1 + Wt−1

]

.

However, the process {(Ut,Vt)
′} cannot be represented as an AR(∞) process, since

the matrix
[1 0

0 1

] − z
[ 0 0
−1 1

]
has zero determinant when z = 1, thus violating condition

(8.4.10). Care is therefore needed in the estimation of parameters for such models (and
the closely related error-correction models). We shall not go into the details here but
refer the reader to Engle and Granger (1987) and Lütkepohl (1993).

�

Problems

8.1 Let {Yt} be a stationary process and define the bivariate process Xt1 = Yt, Xt2 =
Yt−d, where d �= 0. Show that {(Xt1,Xt2)

′} is stationary and express its cross-
correlation function in terms of the autocorrelation function of {Yt}. If ρY(h) → 0
as h → ∞, show that there exists a lag k for which ρ12(k) > ρ12(0).

8.2 Show that the covariance matrix function of the multivariate linear process defined
by (8.2.12) is as specified in (8.2.13).

8.3 Let {Xt} be the bivariate time series whose components are the MA(1) processes
defined by

Xt1 = Zt,1 + 0.8Zt−1,1, {Zt1} ∼ IID
(
0, σ 2

1

)
,
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and

Xt2 = Zt,2 − 0.6Zt−1,2, {Zt2} ∼ IID
(
0, σ 2

2

)
,

where the two sequences {Zt1} and {Zt2} are independent.
a. Find a large-sample approximation to the variance of n1/2ρ̂12(h).
b. Find a large-sample approximation to the covariance of n1/2ρ̂12(h) and

n1/2ρ̂12(k) for h �= k.

8.4 Use the characterization (8.5.3) of the multivariate best linear predictor of Y in
terms of {X1, . . .Xn} to establish the orthogonality of the one-step prediction
errors Xj − X̂j and Xk − X̂k, j �= k, as asserted in (8.6.1).

8.5 Determine the covariance matrix function of the ARMA(1,1) process satisfying

Xt −ΦXt−1 = Zt +ΘZt−1, {Zt} ∼ WN(0, I2),

where I2 is the 2 × 2 identity matrix and Φ = Θ ′ = [0.5 0.5
0 0.5

]
.

8.6 a. Let {Xt} be a causal AR( p) process satisfying the recursions

Xt = Φ1Xt−1 + · · · +ΦpXt−p + Zt, {Zt} ∼ WN(0, �| ).
For n ≥ p write down recursions for the predictors PnXn+h, h ≥ 0, and
find explicit expressions for the error covariance matrices in terms of the AR
coefficients and �| when h = 1, 2, and 3.

b. Suppose now that {Yt} is the multivariate ARIMA( p, 1, 0) process satisfying
∇Yt = Xt, where {Xt} is the AR process in (a). Assuming that E(Y0X′

t) = 0,
for t ≥ 1, show (using (8.6.17) with r = 1 and d = 1) that

P̃n(Yn+h) = Yn +
h∑

j=1

PnXn+j,

and derive the error covariance matrices when h = 1, 2, and 3. Compare these
results with those obtained in Example 8.6.4.

8.7 Use the program ITSM to find the minimum AICC AR model of order less
than or equal to 20 for the bivariate series {(Xt1,Xt2)

′, t = 1, . . . , 200} with
components filed as APPJK2.TSM. Use the fitted model to predict (Xt1,Xt2)

′,
t = 201, 202, 203 and estimate the error covariance matrices of the predictors
(assuming that the fitted model is appropriate for the data).

8.8 Let {Xt1, t = 1, . . . , 63} and {Xt2, t = 1, . . . , 63} denote the differenced series
{∇ ln Yt1} and {∇ ln Yt2}, where {Yt1} and {Yt2} are the annual mink and muskrat
trappings filed as APPH.TSM and APPI.TSM, respectively).
a. Use ITSM to construct and save the series {Xt1} and {Xt2} as univariate

data files X1.TSM and X2.TSM, respectively. (After making the required
transformations press the red EXP button and save each transformed series to
a file with the appropriate name.) To enter X1 and X2 as a bivariate series in
ITSM, open X1 as a multivariate series with Number of columns equal
to 1. Then open X2 as a univariate series. Click the project editor button (at
the top left of the ITSM window), click on the plus signs next to the projects
X1.TSM and X2.TSM, then click on the series that appears just below X2.TSM
and drag it to the first line of the project X1.TSM. It will then be added as a
second component, making X1.TSM a bivariate project consisting of the two
component series X1 and X2. Click OK to close the project editor and close
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the ITSM window labeled X2.TSM. You will then see the graphs of X1 and
X2. Press the second yellow button to see the correlation functions of {Xt1} and
{Xt2}. For more information on the project editor in ITSM consult the Project
Editor section of the PDF file ITSM_HELP.

b. Conduct a test for independence of the two series {Xt1} and {Xt1}.
8.9 Use ITSM to open the data file STOCK7.TSM, which contains the daily returns

on seven different stock market indices from April 27th, 1998, through April
9th, 1999. (Consult the Data Sets section of the PDF file ITSM_HELP for more
information.) Fit a multivariate autoregression to the trivariate series consisting
of the returns on the Dow Jones Industrials, All Ordinaries, and Nikkei indices.
Check the model for goodness of fit and interpret the results.



9 State-Space Models

9.1 State-Space Representations
9.2 The Basic Structural Model
9.3 State-Space Representation of ARIMA Models
9.4 The Kalman Recursions
9.5 Estimation for State-Space Models
9.6 State-Space Models with Missing Observations
9.7 The EM Algorithm
9.8 Generalized State-Space Models

In recent years state-space representations and the associated Kalman recursions
have had a profound impact on time series analysis and many related areas. The
techniques were originally developed in connection with the control of linear systems
(for accounts of this subject see Davis and Vinter 1985; Hannan and Deistler 1988).
An extremely rich class of models for time series, including and going well beyond
the linear ARIMA and classical decomposition models considered so far in this book,
can be formulated as special cases of the general state-space model defined below in
Section 9.1. In econometrics the structural time series models developed by Harvey
(1990) are formulated (like the classical decomposition model) directly in terms of
components of interest such as trend, seasonal component, and noise. However, the
rigidity of the classical decomposition model is avoided by allowing the trend and
seasonal components to evolve randomly rather than deterministically. An introduction
to these structural models is given in Section 9.2, and a state-space representation is
developed for a general ARIMAprocess in Section 9.3. The Kalman recursions, which
play a key role in the analysis of state-space models, are derived in Section 9.4. These
recursions allow a unified approach to prediction and estimation for all processes
that can be given a state-space representation. Following the development of the
Kalman recursions we discuss estimation with structural models (Section 9.5) and
the formulation of state-space models to deal with missing values (Section 9.6). In
Section 9.7 we introduce the EM algorithm, an iterative procedure for maximizing the

© Springer International Publishing Switzerland 2016
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likelihood when only a subset of the complete data set is available. The EM algorithm
is particularly well suited for estimation problems in the state-space framework. Gen-
eralized state-space models are introduced in Section 9.8. These are Bayesian models
that can be used to represent time series of many different types, as demonstrated by
two applications to time series of count data. Throughout the chapter we shall use the
notation

{Wt} ∼ WN(0, {Rt})
to indicate that the random vectors Wt have mean 0 and that

E
(
WsW′

t

) =
{
Rt, if s = t,

0, otherwise.

9.1 State-Space Representations

A state-space model for a (possibly multivariate) time series {Yt, t = 1, 2, . . .}
consists of two equations. The first, known as the observation equation, expresses
the w-dimensional observation Yt as a linear function of a v-dimensional state variable
Xt plus noise. Thus

Yt = GtXt + Wt, t = 1, 2, . . . , (9.1.1)

where {Wt} ∼ WN(0, {Rt}) and {Gt} is a sequence of w × v matrices. The second
equation, called the state equation, determines the state Xt+1 at time t+ 1 in terms of
the previous state Xt and a noise term. The state equation is

Xt+1 = FtXt + Vt, t = 1, 2, . . . , (9.1.2)

where {Ft} is a sequence of v × v matrices, {Vt} ∼ WN(0, {Qt}), and {Vt} is
uncorrelated with {Wt} (i.e., E(WtV′

s) = 0 for all s and t). To complete the
specification, it is assumed that the initial state X1 is uncorrelated with all of the noise
terms {Vt} and {Wt}.

Remark 1. A more general form of the state-space model allows for correlation
between Vt andWt (see Brockwell and Davis (1991), Chapter 12) and for the addition
of a control termHtut in the state equation. In control theory, Htut represents the effect
of applying a “control” ut at time t for the purpose of influencing Xt+1. However, the
system defined by (9.1.1) and (9.1.2) withE

(
WtV′

s

) = 0 for all s and twill be adequate
for our purposes. �

Remark 2. In many important special cases, the matrices Ft,Gt,Qt, and Rt will
be independent of t, in which case the subscripts will be suppressed. �

Remark 3. It follows from the observation equation (9.1.1) and the state equation
(9.1.2) that Xt and Yt have the functional forms, for t = 2, 3, . . .,

Xt = Ft−1Xt−1 + Vt−1

= Ft−1(Ft−2Xt−2 + Vt−2)+ Vt−1

...

= (Ft−1 · · ·F1)X1 + (Ft−1 · · ·F2)V1 + · · · + Ft−1Vt−2 + Vt−1

= ft(X1,V1, . . . ,Vt−1) (9.1.3)
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and

Yt = gt(X1,V1, . . . ,Vt−1,Wt). � (9.1.4)

Remark 4. From Remark 3 and the assumptions on the noise terms, it is clear that

E
(
VtX′

s

) = 0, E
(
VtY′

s

) = 0, 1 ≤ s ≤ t,

and

E
(
WtX′

s

) = 0, 1 ≤ s ≤ t, E(WtY′
s) = 0, 1 ≤ s < t. �

Definition 9.1.1 A time series {Yt} has a state-space representation if there exists a state-space
model for {Yt} as specified by equations (9.1.1) and (9.1.2).

As already indicated, it is possible to find a state-space representation for a large
number of time-series (and other) models. It is clear also from the definition that
neither {Xt} nor {Yt} is necessarily stationary. The beauty of a state-space representa-
tion, when one can be found, lies in the simple structure of the state equation (9.1.2),
which permits relatively simple analysis of the process {Xt}. The behavior of {Yt}
is then easy to determine from that of {Xt} using the observation equation (9.1.1).
If the sequence {X1,V1,V2, . . .} is independent, then {Xt} has the Markov property;
i.e., the distribution of Xt+1 given Xt, . . . ,X1 is the same as the distribution of Xt+1

given Xt. This is a property possessed by many physical systems, provided that we
include sufficiently many components in the specification of the stateXt (for example,
we may choose the state vector in such a way that Xt includes components of Xt−1 for
each t).

Example 9.1.1 An AR(1) Process

Let {Yt} be the causal AR(1) process given by

Yt = φYt−1 + Zt, {Zt} ∼ WN
(
0, σ 2) . (9.1.5)

In this case, a state-space representation for {Yt} is easy to construct. We can, for
example, define a sequence of state variables Xt by

Xt+1 = φXt + Vt, t = 1, 2, . . . , (9.1.6)

where X1 = Y1 = ∑∞
j=0 φ

jZ1−j and Vt = Zt+1. The process {Yt} then satisfies the
observation equation

Yt = Xt,

which has the form (9.1.1) with Gt = 1 and Wt = 0.
�

Example 9.1.2 An ARMA(1,1) Process

Let {Yt} be the causal and invertible ARMA(1,1) process satisfying the equations

Yt = φYt−1 + Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2) . (9.1.7)

Although the existence of a state-space representation for {Yt} is not obvious, we can
find one by observing that

Yt = θ(B)Xt = [
θ 1

]
[
Xt−1

Xt

]

, (9.1.8)
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where {Xt} is the causal AR(1) process satisfying
φ(B)Xt = Zt,

or the equivalent equation
[
Xt

Xt+1

]

=
[

0 1
0 φ

] [
Xt−1

Xt

]

+
[

0
Zt+1.

]

. (9.1.9)

Noting that Xt = ∑∞
j=0 φ

jZt−j, we see that equations (9.1.8) and (9.1.9) for t = 1, 2, . . .
furnish a state-space representation of {Yt} with

Xt =
[
Xt−1

Xt

]

and X1 =

⎡

⎢
⎢
⎣

∞∑

j=0
φ jZ−j

∞∑

j=0
φ jZ1−j

⎤

⎥
⎥
⎦ .

The extension of this state-space representation to general ARMA and ARIMA pro-
cesses is given in Section 9.3.

�
In subsequent sections we shall give examples that illustrate the versatility of state-

space models. (More examples can be found in Aoki 1987; Hannan and Deistler 1988;
Harvey 1990; West and Harrison 1989.) Before considering these, we need a slight
modification of (9.1.1) and (9.1.2), which allows for series in which the time index
runs from −∞ to ∞. This is a more natural formulation for many time series models.

9.1.1 State-Space Models with t ∈ {0,±1, . . .}
Consider the observation and state equations

Yt = GXt + Wt, t = 0,±1, . . . , (9.1.10)

Xt+1 = FXt + Vt, t = 0,±1, . . . , (9.1.11)

where F and G are v× v and w× v matrices, respectively, {Vt} ∼ WN(0,Q), {Wt} ∼
WN(0,R), and E(VsW′

t) = 0 for all s, and t.
The state equation (9.1.11) is said to be stable if the matrix F has all its eigen-

values in the interior of the unit circle, or equivalently if det(I − Fz) �= 0 for all z
complex such that |z| ≤ 1. The matrix F is then also said to be stable.

In the stable case equation (9.1.11) has the unique stationary solution (Prob-
lem 9.1) given by

Xt =
∞∑

j=0

FjVt−j−1.

The corresponding sequence of observations

Yt = Wt +
∞∑

j=0

GFjVt−j−1

is also stationary.
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9.2 The Basic Structural Model

A structural time series model, like the classical decomposition model defined by
(1.5.1), is specified in terms of components such as trend, seasonality, and noise,
which are of direct interest in themselves. The deterministic nature of the trend
and seasonal components in the classical decomposition model, however, limits its
applicability. A natural way in which to overcome this deficiency is to permit random
variation in these components. This can be very conveniently done in the framework
of a state-space representation, and the resulting rather flexible model is called a
structural model. Estimation and forecasting with this model can be encompassed in
the general procedure for state-space models made possible by the Kalman recursions
of Section 9.4.

Example 9.2.1 The Random Walk Plus Noise Model

One of the simplest structural models is obtained by adding noise to a random walk.
It is suggested by the nonseasonal classical decomposition model

Yt = Mt + Wt, where {Wt} ∼ WN
(
0, σ 2

w

)
, (9.2.1)

and Mt = mt, the deterministic “level” or “signal” at time t. We now introduce
randomness into the level by supposing that Mt is a random walk satisfying

Mt+1 = Mt + Vt, and {Vt} ∼ WN
(
0, σ 2

v

)
, (9.2.2)

with initial valueM1 = m1. Equations (9.2.1) and (9.2.2) constitute the “local level” or
“random walk plus noise” model. Figure 9-1 shows a realization of length 100 of this
model withM1 = 0, σ 2

v = 4, and σ 2
w = 8. (The realized values mt of Mt are plotted as

a solid line, and the observed data are plotted as square boxes.) The differenced data

Dt := ∇Yt = Yt − Yt−1 = Vt−1 + Wt − Wt−1, t ≥ 2,

constitute a stationary time series with mean 0 and ACF

ρD(h) =

⎧
⎪⎨

⎪⎩

−σ 2
w

2σ 2
w + σ 2

v

, if |h| = 1,

0, if |h| > 1.

Figure 9-1
Realization from a random

walk plus noise model.
The random walk is

represented by the solid
line and the data are
represented by boxes 0 20 40 60 80 100

0
10

20
30
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Figure 9-2
Sample ACF of the series
obtained by differencing

the data in Figure 9-1 Lag
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Since {Dt} is 1-correlated, we conclude from Proposition 2.1.1 that {Dt} is an MA(1)
process and hence that {Yt} is an ARIMA(0,1,1) process. More specifically,

Dt = Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2) , (9.2.3)

where θ and σ 2 are found by solving the equations

θ

1 + θ2
= −σ 2

w

2σ 2
w + σ 2

v

and θσ 2 = −σ 2
w.

For the process {Yt} generating the data in Figure 9-1, the parameters θ and σ 2 of
the differenced series {Dt} satisfy θ/(1 + θ2) = −0.4 and θσ 2 = −8. Solving these
equations for θ and σ 2, we find that θ = −0.5 and σ 2 = 16 (or θ = −2 and σ 2 = 4).
The sample ACF of the observed differences Dt of the realization of {Yt} in Figure 9-1
is shown in Figure 9-2.

The local level model is often used to represent a measured characteristic of the
output of an industrial process for which the unobserved process level {Mt} is intended
to be within specified limits (to meet the design specifications of the manufactured
product). To decide whether or not the process requires corrective attention, it is
important to be able to test the hypothesis that the process level {Mt} is constant. From
the state equation, we see that {Mt} is constant (and equal to m1) when Vt = 0 or
equivalently when σ 2

v = 0. This in turn is equivalent to the moving-average model
(9.2.3) for {Dt} being noninvertible with θ = −1 (see Problem 8.2). Tests of the unit
root hypothesis θ = −1 were discussed in Section 6.3.2.

�
The local level model can easily be extended to incorporate a locally linear trend

with slope βt at time t. Equation (9.2.2) is replaced by

Mt = Mt−1 + Bt−1 + Vt−1, (9.2.4)

where Bt−1 = βt−1. Now if we introduce randomness into the slope by replacing it
with the random walk

Bt = Bt−1 + Ut−1, where {Ut} ∼ WN
(
0, σ 2

u

)
, (9.2.5)

we obtain the “local linear trend” model.
To express the local linear trend model in state-space form we introduce the state

vector
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Xt = (Mt,Bt)
′.

Then (9.2.4) and (9.2.5) can be written in the equivalent form

Xt+1 =
[

1 1
0 1

]

Xt + Vt, t = 1, 2, . . . , (9.2.6)

where Vt = (Vt,Ut)
′. The process {Yt} is then determined by the observation equation

Yt = [1 0] Xt + Wt. (9.2.7)

If {X1,U1,V1,W1,U2,V2,W2, . . .} is an uncorrelated sequence, then equations (9.2.6)
and (9.2.7) constitute a state-space representation of the process {Yt}, which is a model
for data with randomly varying trend and added noise. For this model we have v =
2, w = 1,

F =
[

1 1
0 1,

]

G = [1 0], Q =
[
σ 2
v 0

0 σ 2
u

]

, and R = σ 2
w.

Example 9.2.2 A Seasonal Series with Noise

The classical decomposition (1.5.11) expressed the time series {Xt} as a sum of trend,
seasonal, and noise components. The seasonal component (with period d ) was a
sequence {st} with the properties st+d = st and

∑d
t=1 st = 0. Such a sequence can

be generated, for any values of s1, s0, . . . , s−d+3, by means of the recursions

st+1 = −st − · · · − st−d+2, t = 1, 2, . . . . (9.2.8)

A somewhat more general seasonal component {Yt}, allowing for random deviations
from strict periodicity, is obtained by adding a term St to the right side of (9.2.8), where
{Vt} is white noise with mean zero. This leads to the recursion relations

Yt+1 = −Yt − · · · − Yt−d+2 + St, t = 1, 2, . . . . (9.2.9)

To find a state-space representation for {Yt}we introduce the (d−1)-dimensional state
vector

Xt = (Yt,Yt−1, . . . ,Yt−d+2)
′.

The series {Yt} is then given by the observation equation

Yt = [1 0 0 · · · 0] Xt, t = 1, 2, . . . , (9.2.10)

where {Xt} satisfies the state equation
Xt+1 = FXt + Vt, t = 1, 2 . . . , (9.2.11)

Vt = (St, 0, . . . , 0)′, and

F =

⎡

⎢
⎢
⎢
⎢
⎢
⎣

−1 −1 · · · −1 −1
1 0 · · · 0 0
0 1 · · · 0 0
...

...
. . .

...
...

0 0 · · · 1 0

⎤

⎥
⎥
⎥
⎥
⎥
⎦

. (9.2.12)

�

Example 9.2.3 A Randomly Varying Trend with Random Seasonality and Noise
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A series with randomly varying trend, random seasonality and noise can be constructed
by adding the two series in Examples 9.2.1 and 9.2.2. (Addition of series with state-
space representations is in fact always possible bymeans of the following construction.
See Problem 9.9.) We introduce the state vector

Xt =
[
X1

t

X2
t

]

,

where X1
t andX

2
t are the state vectors in (9.2.6) and (9.2.11). We then have the follow-

ing representation for {Yt}, the sum of the two series whose state-space representations
were given in (9.2.6)–(9.2.7) and (9.2.10)–(9.2.11). The state equation is

Xt+1 =
[
F1 0
0 F2

]

Xt +
[
V1

t

V2
t

]

, (9.2.13)

where F1, F2 are the coefficient matrices and {V1
t }, {V2

t } are the noise vectors in the
state equations (9.2.6) and (9.2.11), respectively. The observation equation is

Yt = [1 0 1 0 · · · 0]Xt + Wt, (9.2.14)

where {Wt} is the noise sequence in (9.2.7). If the sequence of random vectors
{X1,V1

1,V
2
1,W1,V1

2,V
2
2,W2, . . .} is uncorrelated, then equations (9.2.13) and (9.2.14)

constitute a state-space representation for {Yt}.
�

9.3 State-Space Representation of ARIMA Models

We begin by establishing a state-space representation for the causal AR(p) process and
then build on this example to find representations for the general ARMA and ARIMA
processes.

Example 9.3.1 State-Space Representation of a Causal AR(p) Process

Consider the AR(p) process defined by

Yt+1 = φ1Yt + φ2Yt−1 + · · · + φpYt−p+1 + Zt+1, t = 0,±1, . . . , (9.3.1)

where {Zt} ∼ WN
(
0, σ 2

)
, and φ(z) := 1 − φ1z− · · · − φpzp is nonzero for |z| ≤ 1. To

express {Yt} in state-space form we simply introduce the state vectors

Xt =

⎡

⎢
⎢
⎢
⎣

Yt−p+1

Yt−p+2
...

Yt,

⎤

⎥
⎥
⎥
⎦
, t = 0,±1, . . . . (9.3.2)

From (9.3.1) and (9.3.2) the observation equation is

Yt = [0 0 0 · · · 1]Xt, t = 0,±1, . . . , (9.3.3)
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while the state equation is given by

Xt+1 =

⎡

⎢
⎢
⎢
⎢
⎢
⎣

0 1 0 · · · 0
0 0 1 · · · 0
...

...
...

. . .
...

0 0 0 · · · 1
φp φp−1 φp−2 · · · φ1

⎤

⎥
⎥
⎥
⎥
⎥
⎦

Xt +

⎡

⎢
⎢
⎢
⎢
⎢
⎣

0
0
...

0
1

⎤

⎥
⎥
⎥
⎥
⎥
⎦

Zt+1, t = 0,±1, . . . .

(9.3.4)

These equations have the required forms (9.1.10) and (9.1.11) withWt = 0 and Vt =
(0, 0, . . . ,Zt+1)

′, t = 0,±1, . . . .
�

Remark 1. In Example 9.3.1 the causality condition φ(z) �= 0 for |z| ≤ 1 is equivalent
to the condition that the state equation (9.3.4) is stable, since the eigenvalues of
the coefficient matrix in (9.3.4) are simply the reciprocals of the zeros of φ(z)
(Problem 9.3). �

Remark 2. If equations (9.3.3) and (9.3.4) are postulated to hold only for t =
1, 2, . . . , and if X1 is a random vector such that {X1,Z1,Z2, . . .} is an uncorrelated
sequence, then we have a state-space representation for {Yt} of the type defined
earlier by (9.1.1) and (9.1.2). The resulting process {Yt} is well-defined, regardless
of whether or not the state equation is stable, but it will not in general be stationary.
It will be stationary if the state equation is stable and if X1 is defined by (9.3.2) with
Yt = ∑∞

j=0ψjZt−j, t = 1, 0, . . . , 2 − p, and ψ(z) = 1/φ(z), |z| ≤ 1. �

Example 9.3.2 State-Space Form of a Causal ARMA(p, q) Process

State-space representations are not unique. Here we shall give one of the (infinitely
many) possible representations of a causal ARMA(p,q) process that can easily be
derived from Example 9.3.1. Consider the ARMA(p,q) process defined by

φ(B)Yt = θ(B)Zt, t = 0,±1, . . . , (9.3.5)

where {Zt} ∼ WN
(
0, σ 2

)
and φ(z) �= 0 for |z| ≤ 1. Let

r = max(p, q + 1), φj = 0 for j > p, θj = 0 for j > q, and θ0 = 1.

If {Ut} is the causal AR( p) process satisfying
φ(B)Ut = Zt, (9.3.6)

then Yt = θ(B)Ut, since

φ(B)Yt = φ(B)θ(B)Ut = θ(B)φ(B)Ut = θ(B)Zt.

Consequently,

Yt = [θr−1 θr−2 · · · θ0]Xt, (9.3.7)

where

Xt =

⎡

⎢
⎢
⎢
⎣

Ut−r+1

Ut−r+2
...

Ut

⎤

⎥
⎥
⎥
⎦
. (9.3.8)
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But from Example 9.3.1 we can write

Xt+1 =

⎡

⎢
⎢
⎢
⎢
⎢
⎣

0 1 0 · · · 0
0 0 1 · · · 0
...

...
...

. . .
...

0 0 0 · · · 1
φr φr−1 φr−2 · · · φ1

⎤

⎥
⎥
⎥
⎥
⎥
⎦

Xt +

⎡

⎢
⎢
⎢
⎢
⎢
⎣

0
0
...

0
1

⎤

⎥
⎥
⎥
⎥
⎥
⎦

Zt+1, t = 0,±1, . . . .

(9.3.9)

Equations (9.3.7) and (9.3.9) are the required observation and state equations. As in
Example 9.3.1, the observation and state noise vectors are again Wt = 0 and Vt =
(0, 0, . . . ,Zt+1)

′, t = 0,±1, ….
�

Example 9.3.3 State-Space Representation of an ARIMA(p, d, q) Process

If
{
Yt

}
is an ARIMA(p, d, q) process with {∇dYt} satisfying (9.3.5), then by the

preceding example
{∇dYt

}
has the representation

∇dYt = GXt, t = 0,±1, . . . , (9.3.10)

where {Xt} is the unique stationary solution of the state equation

Xt+1 = FXt + Vt,

F and G are the coefficients of Xt in (9.3.9) and (9.3.7), respectively, and Vt =
(0, 0, . . . ,Zt+1)

′. Let A and B be the d × 1 and d × d matrices defined by A = B = 1
if d = 1 and

A =

⎡

⎢
⎢
⎢
⎢
⎢
⎣

0
0
...

0
1

⎤

⎥
⎥
⎥
⎥
⎥
⎦

, B =

⎡

⎢
⎢
⎢
⎢
⎢
⎣

0 1 0 · · · 0
0 0 1 · · · 0
...

...
...

. . .
...

0 0 0 · · · 1
(−1)d+1

(d
d

)
(−1)d

( d
d−1

)
(−1)d−1

( d
d−2

) · · · d

⎤

⎥
⎥
⎥
⎥
⎥
⎦

if d > 1. Then since

Yt = ∇dYt −
d∑

j=1

(
d

j

)

(−1)jYt−j, (9.3.11)

the vector

Yt−1 := (Yt−d, . . . ,Yt−1)
′

satisfies the equation

Yt = A∇dYt + BYt−1 = AGXt + BYt−1.

Defining a new state vector Tt by stacking Xt and Yt−1, we therefore obtain the state
equation

Tt+1 :=
[
Xt+1

Yt

]

=
[
F 0
AG B

]

Tt +
[
Vt

0

]

, t = 1, 2, . . . , (9.3.12)
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and the observation equation, from (9.3.10) and (9.3.11),

Yt=
[

G (−1)d+1

(
d

d

)

(−1)d
(

d

d − 1

)

(−1)d−1

(
d

d − 2

)

· · · d

] [
Xt

Yt−1

]

,

t = 1, 2, . . . ,
(9.3.13)

with initial condition

T1 =
[
X1

Y0

]

=
⎡

⎣

∞∑

j=0
F j V−j

Y0

⎤

⎦ , (9.3.14)

and the assumption

E(Y0Z
′
t) = 0, t = 0,±1, . . . , (9.3.15)

where Y0 = (Y1−d,Y2−d, . . . ,Y0)
′. The conditions (9.3.15), which are satisfied in

particular if Y0 is considered to be nonrandom and equal to the vector of observed
values (y1−d, y2−d, . . . , y0)

′, are imposed to ensure that the assumptions of a state-
space model given in Section 9.1 are satisfied. They also imply that E

(
X1Y′

0

) = 0 and
E(Y0∇dY ′

t ) = 0, t ≥ 1, as required earlier in Section 6.4 for prediction of ARIMA
processes.

State-space models for more general ARIMA processes (e.g., {Yt} such that
{∇∇12Yt} is an ARMA(p, q) process) can be constructed in the same way. See Problem
9.4.

�
For the ARIMA(1, 1, 1) process defined by

(1 − φB)(1 − B)Yt = (1 + θB)Zt, {Zt} ∼ WN
(
0, σ 2) ,

the vectors Xt and Yt−1 reduce to Xt = (Xt−1,Xt)
′ and Yt−1 = Yt−1. From (9.3.12)

and (9.3.13) the state-space representation is therefore (Problem 9.8)

Yt = [
θ 1 1

]

⎡

⎣
Xt−1

Xt

Yt−1

⎤

⎦ , (9.3.16)

where
⎡

⎣
Xt

Xt+1

Yt

⎤

⎦ =
⎡

⎣
0 1 0
0 φ 0
θ 1 1

⎤

⎦

⎡

⎣
Xt−1

Xt

Yt−1

⎤

⎦+
⎡

⎣
0

Zt+1

0

⎤

⎦ , t = 1, 2, . . . , (9.3.17)

and

⎡

⎣
X0

X1

Y0

⎤

⎦ =

⎡

⎢
⎢
⎢
⎢
⎢
⎣

∞∑

j=0
φjZ−j

∞∑

j=0
φjZ1−j

Y0

⎤

⎥
⎥
⎥
⎥
⎥
⎦

. (9.3.18)
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9.4 The Kalman Recursions

In this section we shall consider three fundamental problems associated with the state-
space model defined by (9.1.1) and (9.1.2) in Section 9.1. These are all concerned with
finding best (in the sense of minimum mean square error) linear estimates of the state-
vector Xt in terms of the observations Y1,Y2, . . . , and a random vector Y0 that is
orthogonal to Vt and Wt for all t ≥ 1. In many cases Y0 will be the constant vector
(1, 1, . . . , 1)′. Estimation of Xt in terms of:

a. Y0, . . . ,Yt−1 defines the prediction problem,
b. Y0, . . . ,Yt defines the filtering problem,
c. Y0, . . . ,Yn (n > t) defines the smoothing problem.

Each of these problems can be solved recursively using an appropriate set of Kalman
recursions, which will be established in this section.

In the following definition of best linear predictor (and throughout this chapter)
it should be noted that we do not automatically include the constant 1 among the
predictor variables as we did in Sections 2.5 and 8.5. (It can, however, be included
by choosing Y0 = (1, 1, . . . , 1)′.)

Definition 9.4.1 For the random vector X = (X1, . . . ,Xv)
′,

Pt(X) := (Pt(X1), . . . ,Pt(Xv))
′,

where Pt(Xi) := P(Xi|Y0,Y1, . . . ,Yt), is the best linear predictor of Xi in terms
of all components of Y0,Y1, . . . ,Yt.

Remark 1. By the definition of the best predictor of each component Xi of X,
Pt(X) is the unique random vector of the form

Pt(X) = A0Y0 + · · · + AtYt

with v × w matrices A0, . . . ,At such that

[X − Pt(X)] ⊥ Ys, s = 0, . . . , t

[cf. (8.5.2) and (8.5.3)]. Recall that two random vectors X and Y are orthogonal
(written X ⊥ Y) if E(XY′) is a matrix of zeros. �

Remark 2. If all the components of X,Y1, . . . ,Yt are jointly normally distributed
and Y0 = (1, . . . , 1)′, then

Pt(X) = E(X|Y1, . . . ,Yt), t ≥ 1. �

Remark 3. Pt is linear in the sense that if A is any k × v matrix and X,V are two
v-variate random vectors with finite second moments, then (Problem 9.10)

Pt(AX) = APt(X)
and

Pt(X + V) = Pt(X)+ Pt(V).

�
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Remark 4. If X and Y are random vectors with v and w components, respectively,
each with finite second moments, then

P(X|Y) = MY,

whereM is a v×w matrix,M=E(XY′)[E(YY′)]−1 with [E(YY′)]−1 any generalized
inverse of E(YY′). (A generalized inverse of a matrix S is a matrix S−1 such that
SS−1S = S. Every matrix has at least one. See Problem 9.11.)

In the notation just developed, the prediction, filtering, and smoothing problems
(a), (b), and (c) formulated above reduce to the determination of Pt−1(Xt), Pt(Xt), and
Pn(Xt) (n > t), respectively. We deal first with the prediction problem. �

Kalman Prediction:
For the state-space model (9.1.1)–(9.1.2), the one-step predictors X̂t := Pt−1(Xt)

and their error covariance matrices Ωt = E
[(
Xt − X̂t

)(
Xt − X̂t

)′]
are uniquely

determined by the initial conditions

X̂1 = P(X1|Y0), Ω1 = E
[(
X1 − X̂1

)(
X1 − X̂1

)′]

and the recursions, for t = 1, . . . ,

X̂t+1 = FtX̂t +�tΔ
−1
t

(
Yt − GtX̂t

)
, (9.4.1)

Ωt+1 = FtΩtF
′
t + Qt −�tΔ

−1
t �

′
t, (9.4.2)

where

Δt = GtΩtG
′
t + Rt,

�t = FtΩtG
′
t,

and Δ−1
t is any generalized inverse of Δt.

Proof. We shall make use of the innovations It defined by I0 = Y0 and

It = Yt − Pt−1Yt = Yt − GtX̂t = Gt

(
Xt − X̂t

)
+ Wt, t = 1, 2, . . . .

The sequence {It} is orthogonal by Remark 1. Using Remarks 3 and 4 and the relation

Pt(·) = Pt−1(·)+ P(·|It) (9.4.3)

(see Problem 9.12), we find that

X̂t+1 = Pt−1(Xt+1)+ P(Xt+1|It) = Pt−1(FtXt + Vt)+�tΔ
−1
t It

= FtX̂t +�tΔ
−1
t It, (9.4.4)

where

Δt = E(It I′t) = GtΩtG
′
t + Rt,

�t = E(Xt+1I′t) = E

[
(
FtXt + Vt

)
([

Xt − X̂t

]′
G′

t + W′
t

)]

= FtΩtG
′
t.

To verify (9.4.2), we observe from the definition of Ωt+1 that

Ωt+1 = E
(
Xt+1X′

t+1

) − E
(
X̂t+1X̂′

t+1

)
.



272 Chapter 9 State-Space Models

With (9.1.2) and (9.4.4) this gives

Ωt+1 = FtE(XtX′
t)F

′
t + Qt − FtE

(
X̂tX̂′

t

)
F′
t −�tΔ

−1
t �

′
t

= FtΩtF
′
t + Qt −�tΔ

−1
t �

′
t. �

9.4.1 h-Step Prediction of {Yt} Using the Kalman Recursions

The Kalman prediction equations lead to a very simple algorithm for recursive
calculation of the best linear mean square predictors PtYt+h, h = 1, 2, . . . . From
(9.4.4), (9.1.1), (9.1.2), and Remark 3 in Section 9.1, we find that

PtXt+1 = FtPt−1Xt +�tΔ
−1
t (Yt − Pt−1Yt), (9.4.5)

PtXt+h = Ft+h−1PtXt+h−1

...

= (Ft+h−1Ft+h−2 · · ·Ft+1)PtXt+1, h = 2, 3, . . . , (9.4.6)

and

PtYt+h = Gt+hPtXt+h, h = 1, 2, . . . . (9.4.7)

From the relation

Xt+h − PtXt+h = Ft+h−1(Xt+h−1 − PtXt+h−1)+ Vt+h−1, h = 2, 3, . . . ,

we find that Ω(h)
t := E[(Xt+h − PtXt+h)(Xt+h − PtXt+h)

′] satisfies the recursions
Ω(h)

t = Ft+h−1Ω
(h−1)
t F′

t+h−1 + Qt+h−1, h = 2, 3, . . . , (9.4.8)

with Ω(1)
t = Ωt+1. Then from (9.1.1) and (9.4.7), Δ(h)t := E[(Yt+h − PtYt+h)(Yt+h −

PtYt+h)
′] is given by

Δ(h)t = Gt+hΩ
(h)
t G′

t+h + Rt+h, h = 1, 2, . . . . (9.4.9)

Example 9.4.1. Consider the random walk plus noise model of Example 9.2.1 defined by

Yt = Xt + Wt, {Wt} ∼ WN
(
0, σ 2

w

)
,

where the local level Xt follows the random walk

Xt+1 = Xt + Vt, {Vt} ∼ WN
(
0, σ 2

v

)
.

Applying the Kalman prediction equations with Y0 := 1, R = σ 2
w, and Q = σ 2

v , we
obtain

Ŷt+1 = PtYt+1 = X̂t + �t

Δt

(
Yt − Ŷt

)

= (1 − at)Ŷt + atYt

where

at = �t

Δt
= Ωt

Ωt + σ 2
w

.
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For a state-space model (like this one) with time-independent parameters, the solution
of the Kalman recursions (9.4.2) is called a steady-state solution ifΩt is independent
of t. If Ωt = Ω for all t, then from (9.4.2)

Ωt+1 = Ω = Ω + σ 2
v − Ω2

Ω + σ 2
w

= Ωσ 2
w

Ω + σ 2
w

+ σ 2
v .

Solving this quadratic equation for Ω and noting that Ω ≥ 0, we find that

Ω = 1

2

(

σ 2
v +

√

σ 4
v + 4σ 2

v σ
2
w

)

Since Ωt+1 − Ωt is a continuous function of Ωt on Ωt ≥ 0, positive at Ωt = 0,
negative for large Ωt, and zero only at Ωt = Ω, it is clear that Ωt+1 −Ωt is negative
for Ωt > Ω and positive for Ωt < Ω. A similar argument shows (Problem 9.14) that
(Ωt+1 −Ω)(Ωt −Ω) ≥ 0 for all Ωt ≥ 0. These observations imply that Ωt+1 always
falls between Ω and Ωt. Consequently, regardless of the value of Ω1, Ωt converges
to Ω, the unique solution of Ωt+1 = Ωt. For any initial predictors Ŷ1 = X̂1 and any
initial mean squared error Ω1 = E

(
X1 − X̂1

)2
, the coefficients at := Ωt/

(
Ωt + σ 2

w

)

converge to

a = Ω

Ω + σ 2
w

,

and the mean squared errors of the predictors defined by

Ŷt+1 = (1 − at)Ŷt + atYt

converge to Ω + σ 2
w.

If, as is often the case, we do not knowΩ1, then we cannot determine the sequence
{at}. It is natural, therefore, to consider the behavior of the predictors defined by

Ŷt+1 = (1 − a)Ŷt + aYt

with a as above and arbitrary Ŷ1. It can be shown (Problem 9.16) that this sequence
of predictors is also asymptotically optimal in the sense that the mean squared error
converges toΩ + σ 2

w as t → ∞.
As shown in Example 9.2.1, the differenced process Dt = Yt − Yt−1 is the MA(1)

process

Dt = Zt + θZt−1,
{
Zt

} ∼ WN
(
0, σ 2) ,

where θ/
(
1 + θ2

) = −σ 2
w/

(
2σ 2

w + σ 2
v

)
. Solving this equation for θ (Problem 9.15),

we find that

θ = − 1

2σ 2
w

(

2σ 2
w + σ 2

v −
√

σ 4
v + 4σ 2

v σ
2
w

)

and that θ = a − 1.
It is instructive to derive the exponential smoothing formula for Ŷt directly from

the ARIMA(0,1,1) structure of {Yt}. For t ≥ 2, we have from Section 6.5 that

Ŷt+1 = Yt + θt1(Yt − Ŷt) = −θt1Ŷt + (1 + θt1)Yt

for t ≥ 2, where θt1 is found by application of the innovations algorithm to an MA(1)
process with coefficient θ . It follows that 1 − at = −θt1, and since θt1 → θ
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(see Remark 1 of Section 3.3) and at converges to the steady-state solution a, we
conclude that

1 − a = lim
t→∞(1 − at) = − lim

t→∞ θt1 = −θ.
�

Example 9.4.2. The lognormal stochastic volatility model

We can rewrite the defining equations (7.4.2) and (7.4.3) of the lognormal SV process
{Zt} in the following state-space form

Xt = γ1Xt−1 + ηt, (9.4.10)

and

Yt = Xt + εt, (9.4.11)

where the (one-dimensional) state and observation vectors are

Xt = �t − γ0

1 − γ1
, (9.4.12)

and

Yt = ln Z2
t + 1.27 − γ0

2(1 − γ1)
(9.4.13)

respectively. The independent white-noise sequences {ηt} and {εt} have zero means
and variances σ 2 and 4.93 respectively.

Taking

X̂0 = EX0 = 0 (9.4.14)

and

Ω̂0 = Var(X0) = σ 2/(1 − γ 2
1 ), (9.4.15)

and we can directly apply the Kalman prediction recursions (9.4.1), (9.4.2), (9.4.6) and
(9.4.8), to compute recursively the best linear predictor of Xt+h in terms of {Ys, s ≤ t},
or equivalently of the log volatility �t+h in terms of the observations {lnZ2

s , s ≤ t}.
�

Kalman Filtering:
The filtered estimates Xt|t = Pt(Xt) and their error covariance matrices Ωt|t =
E[(Xt − Xt|t)(Xt − Xt|t)′] are determined by the relations

PtXt = Pt−1Xt +ΩtG
′
tΔ

−1
t

(
Yt − GtX̂t

)
(9.4.16)

and

Ωt|t = Ωt −ΩtG
′
tΔ

−1
t GtΩ

′
t . (9.4.17)

Proof. From (9.4.3) it follows that

PtXt = Pt−1Xt + MIt,

where

M = E(Xt I′t)[E(It I′t)]−1 = E
[
Xt(Gt(Xt − X̂t)+ Wt)

′]Δ−1
t = ΩtG

′
tΔ

−1
t .

(9.4.18)
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To establish (9.4.17) we write

Xt − Pt−1Xt = Xt − PtXt + PtXt − Pt−1Xt = Xt − PtXt + MIt.

Using (9.4.18) and the orthogonality of Xt − PtXt and MIt, we find from the last
equation that

Ωt = Ωt|t +ΩtG
′
tΔ

−1
t GtΩ

′
t ,

as required. �

Kalman Fixed-Point Smoothing:
The smoothed estimates Xt|n = PnXt and the error covariance matrices Ωt|n =
E[(Xt − Xt|n)(Xt − Xt|n)′] are determined for fixed t by the following recursions,
which can be solved successively for n = t, t + 1, . . .:

PnXt = Pn−1Xt +Ωt,nG
′
nΔ

−1
n

(
Yn − GnX̂n

)
, (9.4.19)

Ωt,n+1 = Ωt,n[Fn −�nΔ
−1
n Gn]′, (9.4.20)

Ωt|n = Ωt|n−1 −Ωt,nG
′
nΔ

−1
n GnΩ

′
t,n, (9.4.21)

with initial conditions Pt−1Xt = X̂t and Ωt,t = Ωt|t−1 = Ωt (found from Kalman
prediction).

Proof. Using (9.4.3) we can write PnXt = Pn−1Xt + CIn, where In = Gn

(
Xn − X̂n

) + Wn.
By Remark 4 above,

C = E

[

Xt

(
Gn(Xn − X̂n)+ Wn

)′] [
E
(
InI′n

)]−1 = Ωt,nG
′
nΔ

−1
n , (9.4.22)

where Ωt,n := E
[(
Xt − X̂t

)(
Xn − X̂n

)′]
. It follows now from (9.1.2), (9.4.5), the

orthogonality of Vn and Wn with Xt − X̂t, and the definition of Ωt,n that

Ωt,n+1=E

[(
Xt − X̂t

) (
Xn − X̂n

)′ (
Fn −�nΔ

−1
n Gn

)′
]

=Ωt,n

[
Fn −�nΔ

−1
n Gn

]′
,

thus establishing (9.4.20). To establish (9.4.21) we write

Xt − PnXt = Xt − Pn−1Xt − CIn.

Using (9.4.22) and the orthogonality of Xt − PnXt and In, the last equation then gives

Ωt|n = Ωt|n−1 −Ωt,nG
′
nΔ

−1
n GnΩ

′
t,n, n = t, t + 1, . . . ,

as required. �

9.5 Estimation for State-Space Models
Consider the state-space model defined by equations (9.1.1) and (9.1.2) and suppose
that the model is completely parameterized by the components of the vector θ. The
maximum likelihood estimate of θ is found by maximizing the likelihood of the obser-
vations Y1, . . . ,Yn with respect to the components of the vector θ. If the conditional
probability density of Yt given Yt−1 = yt−1, . . . ,Y0 = y0 is ft(·|yt−1, . . . , y0), then
the likelihood of Yt, t = 1, . . . , n (conditional on Y0), can immediately be written as

L(θ;Y1, . . . ,Yn) =
n∏

t=1

ft(Yt|Yt−1, . . . ,Y0). (9.5.1)
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The calculation of the likelihood for any fixed numerical value of θ is extremely
complicated in general, but is greatly simplified if Y0,X1 and Wt,Vt, t = 1, 2, . . .,
are assumed to be jointly Gaussian. The resulting likelihood is called the Gaussian
likelihood and is widely used in time series analysis (cf. Section 5.2) whether the time
series is truly Gaussian or not. As before, we shall continue to use the term likelihood
to mean Gaussian likelihood.

If Y0,X1 and Wt,Vt, t = 1, 2, . . . , are jointly Gaussian, then the conditional
densities in (9.5.1) are given by

ft(Yt|Yt−1, . . . ,Y0) = (2π)−w/2 (detΔt)
−1/2 exp

[

−1

2
I′tΔ

−1
t It

]

,

where It =Yt − Pt−1Yt =Yt − GX̂t, Pt−1Yt, and Δt, t ≥ 1, are the one-step pre-
dictors and error covariance matrices found from the Kalman prediction recursions.
The likelihood of the observations Y1, . . . ,Yn (conditional on Y0) can therefore be
expressed as

L(θ;Y1, . . . ,Yn) = (2π)−nw/2

⎛

⎝
n∏

j=1

detΔj

⎞

⎠

−1/2

exp

⎡

⎣−1

2

n∑

j=1

I′jΔ
−1
j Ij

⎤

⎦ .

(9.5.2)

Given the observations Y1, . . . ,Yn, the distribution of Y0 (see Section 9.4), and a
particular parameter value θ, the numerical value of the likelihood L can be computed
from the previous equation with the aid of the Kalman recursions of Section 9.4. To
find maximum likelihood estimates of the components of θ, a nonlinear optimization
algorithm must be used to search for the value of θ that maximizes the value of L.

Having estimated the parameter vector θ, we can compute forecasts based on the
fitted state-space model and estimated mean squared errors by direct application of
equations (9.4.7) and (9.4.9).

9.5.1 Application to Structural Models

The general structural model for a univariate time series {Yt} of which we gave
examples in Section 9.2 has the form

Yt = GXt + Wt, {Wt} ∼ WN
(
0, σ 2

w

)
, (9.5.3)

Xt+1 = FXt + Vt, {Vt} ∼ WN(0,Q), (9.5.4)

for t = 1, 2, . . . , where F and G are assumed known. We set Y0 = 1 in order to
include constant terms in our predictors and complete the specification of the model
by prescribing the mean and covariance matrix of the initial state X1. A simple and
convenient assumption is that X1 is equal to a deterministic but unknown parameter
μ and that X̂1 = μ, so that Ω1 = 0. The parameters of the model are then μ, Q,
and σ 2

w.
Direct maximization of the likelihood (9.5.2) is difficult if the dimension of the

state vector is large. The maximization can, however, be simplified by the following
stepwise procedure. For fixedQwe find μ̂(Q) and σ 2

w(Q) that maximize the likelihood
L
(
μ,Q, σ 2

w

)
. We then maximize the “reduced likelihood” L

(
μ̂(Q),Q, σ̂ 2

w(Q)
)
with

respect to Q.
To achieve this we define the mean-corrected state vectors, X∗

t = Xt −Ft−1μ, and
apply the Kalman prediction recursions to {X∗

t } with initial condition X∗
1 = 0. This

gives, from (9.4.1),
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X̂∗
t+1 = FX̂∗

t +�tΔ
−1
t

(
Yt − GX̂∗

t

)
, t = 1, 2, . . . , (9.5.5)

with X̂∗
1 = 0. Since X̂t also satisfies (9.5.5), but with initial condition X̂t = μ, it

follows that

X̂t = X̂∗
t + Ctμ (9.5.6)

for some v×vmatrices Ct. (Note that although X̂t = P(Xt|Y0,Y1, . . . ,Yt), the quantity
X̂∗

t is not the corresponding predictor of X∗
t .) The matrices Ct can be determined

recursively from (9.5.5), (9.5.6), and (9.4.1). Substituting (9.5.6) into (9.5.5) and using
(9.4.1), we have

X̂∗
t+1 = F

(
X̂t − Ctμ

)
+�tΔ

−1
t

(
Yt − G

(
X̂t − Ctμ

))

= FX̂t +�tΔ
−1
t

(
Yt − GX̂t

)
− (

F −�tΔ
−1
t G

)
Ctμ

= X̂t+1 − (
F −�tΔ

−1
t G

)
Ctμ,

so that

Ct+1 = (
F −�tΔ

−1
t G

)
Ct (9.5.7)

with C1 equal to the identity matrix. The quadratic form in the likelihood (9.5.2) is
therefore

S(μ,Q, σ 2
w) =

n∑

t=1

(
Yt − GX̂t

)2

Δt
(9.5.8)

=
n∑

t=1

(
Yt − GX̂∗

t − GCtμ
)2

Δt
. (9.5.9)

Now let Q∗ := σ−2
w Q and define L∗ to be the likelihood function with this new

parameterization, i.e., L∗ (μ,Q∗, σ 2
w

) = L
(
μ, σ 2

wQ
∗, σ 2

w

)
. Writing Δ∗

t = σ−2
w Δt and

Ω∗
t = σ−2

w Ωt, we see that the predictors X̂∗
t and the matrices Ct in (9.5.7) depend on

the parameters only through Q∗. Thus,

S
(
μ,Q, σ 2

w

) = σ−2
w S

(
μ,Q∗, 1

)
,

so that

−2 ln L∗ (μ,Q∗, σ 2
w

) = n ln(2π)+
n∑

t=1

lnΔt + σ−2
w S

(
μ,Q∗, 1

)

= n ln(2π)+
n∑

t=1

lnΔ∗
t + n ln σ 2

w + σ−2
w S

(
μ,Q∗, 1

)
.

For Q∗ fixed, it is easy to show (see Problem 9.18) that this function is minimized
when

μ̂ = μ̂
(
Q∗) =

[
n∑

t=1

C′
tG

′GCt

Δ∗
t

]−1 n∑

t=1

C′
tG

′
(
Yt − GX̂∗

t

)

Δ∗
t

(9.5.10)
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and

σ̂ 2
w = σ̂ 2

w

(
Q∗) = n−1

n∑

t=1

(
Yt − GX̂∗

t − GCtμ̂
)2

Δ∗
t

. (9.5.11)

Replacing μ and σ 2
w by these values in −2 ln L∗ and ignoring constants, the reduced

likelihood becomes

�
(
Q∗) = ln

(

n−1
n∑

t=1

(
Yt − GX̂∗

t − GCtμ̂
)2

Δ∗
t

)

+ n−1
n∑

t=1

ln
(
detΔ∗

t

)
.

(9.5.12)

If Q̂∗ denotes the minimizer of (9.5.12), then the maximum likelihood estimator of the
parameters μ,Q, σ 2

w are μ̂, σ̂ 2
wQ̂

∗, σ̂ 2
w, where μ̂ and σ̂ 2

w are computed from (9.5.10) and
(9.5.11) with Q∗ replaced by Q̂∗.

We can now summarize the steps required for computing the maximum likelihood
estimators of μ, Q, and σ 2

w for the model (9.5.3)–(9.5.4).

1. For a fixed Q∗, apply the Kalman prediction recursions with X̂∗
1 = 0, Ω1 = 0,

Q = Q∗, and σ 2
w = 1 to obtain the predictors X̂∗

t . Let Δ
∗
t denote the one-step

prediction error produced by these recursions.
2. Set μ̂ = μ̂(Q∗) = [∑n

t=1 C
′
tG

′GCt/Δt

]−1 ∑n
t=1 C

′
tG

′(Yt − GX̂∗
t )/Δ

∗
t .

3. Let Q̂∗ be the minimizer of (9.5.12).
4. The maximum likelihood estimators of μ, Q, and σ 2

w are then given by μ̂, σ̂ 2
wQ̂

∗,
and σ̂ 2

w, respectively, where μ̂ and σ̂ 2
w are found from (9.5.10) and (9.5.11)

evaluated at Q̂∗.

Example 9.5.1. Random Walk Plus Noise Model

In Example 9.2.1, 100 observations were generated from the structural model

Yt = Mt + Wt, {Wt} ∼ WN
(
0, σ 2

w

)
,

Mt+1 = Mt + Vt, {Vt} ∼ WN
(
0, σ 2

v

)
,

with initial values μ = M1 = 0, σ 2
w = 8, and σ 2

v = 4. The maximum likelihood
estimates of the parameters are found by first minimizing (9.5.12) with μ̂ given by
(9.5.10). Substituting these values into (9.5.11) gives σ̂ 2

w. The resulting estimates are
μ̂ = 0.906, σ̂ 2

v = 5.351, and σ̂ 2
w = 8.233, which are in reasonably close agreement

with the true values.
�

Example 9.5.2. International Airline Passengers, 1949–1960; AIRPASS.TSM

The monthly totals of international airline passengers from January 1949 to December
1960 (Box and Jenkins 1976) are displayed in Figure 9-3. The data exhibit both a
strong seasonal pattern and a nearly linear trend. Since the variability of the data
Y1, . . . ,Y144 increases for larger values of Yt, it may be appropriate to consider a
logarithmic transformation of the data. For the purpose of this illustration, however,
we will fit a structural model incorporating a randomly varying trend and seasonal and
noise components (see Example 9.2.3) to the raw data. This model has the form
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Figure 9-3
International airline
passengers; monthly

totals from January 1949
to December 1960
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Yt = GXt + Wt, {Wt} ∼ WN
(
0, σ 2

w

)
,

Xt+1 = FXt + Vt, {Vt} ∼ WN(0, Q),

where Xt is a 13-dimensional state-vector,

F =

⎡

⎢
⎢
⎢
⎢
⎢
⎢
⎢
⎢
⎢
⎣

1 1 0 0 · · · 0 0
0 1 0 0 · · · 0 0
0 0 −1 −1 · · · −1 −1
0 0 1 0 · · · 0 0
0 0 0 1 · · · 0 0
...

...
...

...
. . .

...
...

0 0 0 0 · · · 1 0

⎤

⎥
⎥
⎥
⎥
⎥
⎥
⎥
⎥
⎥
⎦

,

G = [
1 0 1 0 · · · 0

]
,

and

Q =

⎡

⎢
⎢
⎢
⎢
⎢
⎢
⎢
⎣

σ 2
1 0 0 0 · · · 0

0 σ 2
2 0 0 · · · 0

0 0 σ 2
3 0 · · · 0

0 0 0 0 · · · 0
...

...
...

...
. . .

...

0 0 0 0 · · · 0

⎤

⎥
⎥
⎥
⎥
⎥
⎥
⎥
⎦

.

The parameters of the model are μ, σ 2
1 , σ

2
2 , σ

2
3 , and σ

2
w, where μ = X1. Minimizing

(9.5.12) with respect to Q∗ we find from (9.5.11) and (9.5.12) that
(
σ̂ 2

1 , σ̂
2
2 , σ̂

2
3 , σ̂

2
w

) = (170.63, .00000, 11.338, .014179)

and from (9.5.10) that μ̂ = (146.9, 2.171, −34.92, −34.12, −47.00, −16.98, 22.99,
53.99, 58.34, 33.65, 2.204, −4.053, −6.894)′. The first component, Xt1, of the state
vector corresponds to the local linear trend with slope Xt2. Since σ̂ 2

2 = 0, the slope at
time t, which satisfies

Xt2 = Xt−1,2 + Vt2,
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Figure 9-4
The one-step predictors
(
X̂t1, X̂t2, X̂t3

)′
for the

airline passenger data
in Example 9.5.2
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Figure 9-5
The one-step predictors Ŷt
for the airline passenger
data (solid line) and the

actual data (square boxes)
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must be nearly constant and equal to X̂12 = 2.171. The first three components of the
predictors X̂t are plotted in Figure 9-4. Notice that the first component varies like a
random walk around a straight line, while the second component is nearly constant as
a result of σ̂ 2

2 ≈ 0. The third component, corresponding to the seasonal component,
exhibits a clear seasonal cycle that repeats roughly the same pattern throughout the 12
years of data. The one-step predictors X̂t1 + X̂t3 of Yt are plotted in Figure 9-5 (solid
line) together with the actual data (square boxes). For this model the predictors follow
the movement of the data quite well.

�

9.6 State-Space Models with Missing Observations

State-space representations and the associated Kalman recursions are ideally suited to
the analysis of data with missing values, as was pointed out by Jones (1980) in the
context of maximum likelihood estimation for ARMA processes. In this section we
shall deal with two missing-value problems for state-space models. The first is the
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evaluation of the (Gaussian) likelihood based on {Yi1, . . . ,Yir}, where i1, i2, . . . , ir
are positive integers such that 1 ≤ i1 < i2 < · · · < ir ≤ n. (This allows for
observation of the process {Yt} at irregular intervals, or equivalently for the possibility
that (n−r) observations are missing from the sequence {Y1, . . . ,Yn}.) The solution of
this problem will, in particular, enable us to carry out maximum likelihood estimation
for ARMA and ARIMA processes with missing values. The second problem to be
considered is the minimum mean squared error estimation of the missing values
themselves.

9.6.1 The Gaussian Likelihood of {Yi1, . . . ,Yir }, 1 ≤ i1 < i2 < ··· < ir ≤ n

Consider the state-space model defined by equations (9.1.1) and (9.1.2) and suppose
that the model is completely parameterized by the components of the vector θ. If there
are no missing observations, i.e., if r = n and ij = j, j = 1, . . . , n, then the likelihood
of the observations {Y1, . . . ,Yn} is easily found as in Section 9.5 to be

L(θ;Y1, . . . ,Yn) = (2π)−nw/2

⎛

⎝
n∏

j=1

detΔj

⎞

⎠

−1/2

exp

⎡

⎣−1

2

n∑

j=1

I′jΔ
−1
j Ij

⎤

⎦ ,

where Ij = Yj − Pj−1Yj and Δj, j ≥ 1, are the one-step predictors and error
covariance matrices found from (9.4.7) and (9.4.9) with Y0 = 1.

To deal with the more general case of possibly irregularly spaced observations
{Yi1, . . . ,Yir}, we introduce a new series {Y∗

t }, related to the process {Xt} by the
modified observation equation

Y∗
t = G∗

t Xt + W∗
t , t = 1, 2, . . . , (9.6.1)

where

G∗
t =

{
Gt if t ∈ {i1, . . . , ir},
0 otherwise,

W∗
t =

{
Wt if t ∈ {i1, . . . , ir},
Nt otherwise,

(9.6.2)

and {Nt} is iid with

Nt ∼ N(0, Iw×w), Ns ⊥ X1, Ns ⊥
[
Vt

Wt

]

, s, t = 0,±1, . . . .

(9.6.3)

Equations (9.6.1) and (9.1.2) constitute a state-space representation for the new series
{Y∗

t }, which coincides with {Yt} at each t ∈ {i1, i2, . . . , ir}, and at other times takes
random values that are independent of {Yt} with a distribution independent of θ.

Let L1
(
θ; yi1, . . . , yir

)
be the Gaussian likelihood based on the observed

values yi1, . . . , yir of Yi1, . . . ,Yir under the model defined by (9.1.1) and (9.1.2).
Corresponding to these observed values, we define a new sequence, y∗

1, . . . , y
∗
n, by

y∗
t =

{
yt if t ∈ {i1, . . . , ir},
0 otherwise.

(9.6.4)

Then it is clear from the preceding paragraph that

L1
(
θ; yi1 , . . . , yir

) = (2π)(n−r)w/2L2
(
θ; y∗

1, . . . , y
∗
n

)
, (9.6.5)

where L2 denotes the Gaussian likelihood under the model defined by (9.6.1) and
(9.1.2).
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In view of (9.6.5) we can now compute the required likelihood L1 of the realized
values {yt, t = i1, . . . , ir} as follows:

i. Define the sequence {y∗
t , t = 1, . . . , n} as in (9.6.4).

ii. Find the one-step predictors Ŷ∗
t of Y∗

t , and their error covariance matrices Δ∗
t ,

using Kalman prediction and equations (9.4.7) and (9.4.9) applied to the state-
space representation (9.6.1) and (9.1.2) of {Y∗

t }. Denote the realized values of the
predictors, based on the observation sequence

{
y∗
t

}
, by

{
ŷ∗
t

}
.

iii. The required Gaussian likelihood of the irregularly spaced observations {yi1, . . . ,
yir} is then, by (9.6.5),

L1(θ; yi1 , . . . , yir) = (2π)−rw/2

⎛

⎝
n∏

j=1

detΔ∗
j

⎞

⎠

−1/2

exp

⎧
⎨

⎩
−1

2

n∑

j=1

i∗j
′Δ∗−1

j i∗j

⎫
⎬

⎭
,

where i∗j denotes the observed innovation y∗
j − ŷ∗

j , j = 1, . . . , n.

Example 9.6.1. An AR(1) Series with One Missing Observation

Let {Yt} be the causal AR(1) process defined by

Yt − φYt−1 = Zt, {Zt} ∼ WN
(
0, σ 2

)
.

To find the Gaussian likelihood of the observations y1, y3, y4, and y5 of Y1,Y3,Y4, and
Y5 we follow the steps outlined above.

i. Set y∗
i = yi, i = 1, 3, 4, 5 and y∗

2 = 0.
ii. We start with the state-space model for {Yt} from Example 9.1.1, i.e., Yt =

Xt, Xt+1 = φXt + Zt+1. The corresponding model for {Y∗
t } is then, from (9.6.1),

Y∗
t = G∗

t Xt + W∗
t , t = 1, 2, . . . ,

where

Xt+1 = FtXt + Vt, t = 1, 2, . . . ,

Ft = φ, G∗
t =

⎧
⎨

⎩

1 if t �= 2,

0 if t = 2,
Vt = Zt+1, W∗

t =
⎧
⎨

⎩

0 if t �= 2,

Nt if t = 2,

Qt = σ 2, R∗
t =

⎧
⎨

⎩

0 if t �= 2,

1 if t = 2,
S∗
t = 0,

and X1 = ∑∞
j=0 φ

jZ1−j. Starting from the initial conditions

X̂1 = 0, Ω1 = σ 2/
(
1 − φ2) ,

and applying the recursions (9.4.1) and (9.4.2), we find (Problem 9.19) that

�tΔ
−1
t =

{
φ if t = 1, 3, 4, 5,

0 if t = 2,
Ωt =

⎧
⎪⎨

⎪⎩

σ 2/
(
1 − φ2

)
if t = 1,

σ 2
(
1 + φ2

)
if t = 3,

σ 2 if t = 2, 4, 5,

and

X̂1 = 0, X̂2 = φY1, X̂3 = φ2Y1, X̂4 = φY3, X̂5 = φY4.
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From (9.4.7) and (9.4.9) with h = 1, we find that

Ŷ∗
1 = 0, Ŷ∗

2 = 0, Ŷ∗
3 = φ2Y1, Ŷ∗

4 = φY3, Ŷ∗
5 = φY4,

with corresponding mean squared errors

Δ∗
1 = σ 2/

(
1 − φ2) , Δ∗

2 = 1, Δ∗
3 = σ 2 (1 + φ2) , Δ∗

4 = σ 2, Δ∗
5 = σ 2.

iii. From the preceding calculations we can now write the likelihood of the original
data as

L1(φ, σ
2; y1, y3, y4, y5)=σ−4(2π)−2 [(1−φ2) /

(
1+φ2)]1/2

× exp

{

− 1

2σ 2

[

y2
1

(
1−φ2

)+(y3−φ2y1)
2

1+φ2
+(y4−φy3)

2+(y5−φy4)
2

]}

.

�

Remark 1. If we are given observations y1−d, y2−d, . . . , y0, yi1, yi2, . . . , yir of an
ARIMA( p, d, q) process at times 1 − d, 2 − d, . . . , 0, i1, . . . , ir, where 1 ≤ i1 <
i2 < · · · < ir ≤ n, a similar argument can be used to find the Gaussian likelihood of
yi1, . . . , yir conditional on Y1−d = y1−d,Y2−d = y2−d, . . . ,Y0 = y0. Missing values
among the first d observations y1−d, y2−d, . . . , y0 can be handled by treating them as
unknown parameters for likelihood maximization. For more on ARIMA series with
missing values see Brockwell and Davis (1991) and Ansley and Kohn (1985). �

9.6.2 Estimation of Missing Values for State-Space Models

Given that we observe only Yi1,Yi2, . . . ,Yir, 1 ≤ i1 < i2 < · · · < ir ≤ n, where {Yt}
has the state-space representation (9.1.1) and (9.1.2), we now consider the problem
of finding the minimum mean squared error estimators P

(
Yt|Y0,Yi1, . . . ,Yir

)
of Yt,

1 ≤ t ≤ n, where Y0 = 1. To handle this problem we again use the modified process
{Y∗

t } defined by (9.6.1) and (9.1.2) with Y∗
0 = 1. Since Y∗

s = Ys for s ∈ {i1, . . . , ir}
and Y∗

s ⊥ Xt, Y0 for 1 ≤ t ≤ n and s /∈ {0, i1, . . . , ir}, we immediately obtain the
minimum mean squared error state estimators

P
(
Xt|Y0,Yi1, . . . ,Yir

) = P
(
Xt|Y∗

0,Y
∗
1, . . . ,Y

∗
n

)
, 1 ≤ t ≤ n. (9.6.6)

The right-hand side can be evaluated by application of the Kalman fixed-point
smoothing algorithm to the state-space model (9.6.1) and (9.1.2). For computational
purposes the observed values of Y∗

t , t /∈ {0, i1, . . . , ir}, are quite immaterial. They
may, for example, all be set equal to zero, giving the sequence of observations of Y∗

t
defined in (9.6.4).

To evaluate P
(
Yt|Y0,Yi1, . . . ,Yir

)
, 1 ≤ t ≤ n, we use (9.6.6) and the relation

Yt = GtXt + Wt. (9.6.7)

Since E
(
VtW′

t

) = St = 0, t = 1, . . . , n, we find from (9.6.7) that

P
(
Yt|Y0,Yi1, . . . ,Yir

) = GtP
(
Xt|Y∗

0,Y
∗
1, . . . ,Y

∗
n

)
. (9.6.8)

Example 9.6.2. An AR(1) Series with One Missing Observation

Consider the problem of estimating the missing value Y2 in Example 9.6.1 in terms of
Y0 = 1,Y1,Y3,Y4, and Y5. We start from the state-space model Xt+1 = φXt + Zt+1,
Yt = Xt, for {Yt}. The corresponding model for {Y∗

t } is the one used in Example 9.6.1.
Applying the Kalman smoothing equations to the latter model, we find that
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P1X2 = φY1, P2X2 = φY1, P3X2 = φ(Y1 + Y3)

(1 + φ2)
,

P4X2 = P3X2, P5X2 = P3X2,

Ω2,2 = σ 2, Ω2,3 = φσ 2, Ω2,t = 0, t ≥ 4,

and

Ω2|1 = σ 2, Ω2|2 = σ 2, Ω2|t = σ 2

(1 + φ2)
, t ≥ 3,

where Pt(·) here denotes P
(·|Y∗

0 , . . . ,Y
∗
t

)
and Ωt,n,Ωt|n are defined correspondingly.

We deduce from (9.6.8) that the minimummean squared error estimator of the missing
value Y2 is

P5Y2 = P5X2 = φ(Y1 + Y3)
(
1 + φ2

) ,

with mean squared error

Ω2|5 = σ 2

(
1 + φ2

) . �

Remark 2. Suppose we have observations Y1−d,Y2−d, . . . ,Y0,Yi1, . . . ,Yir (1 ≤ i1 <
i2 · · · < ir ≤ n) of an ARIMA(p, d, q) process. Determination of the best linear
estimates of the missing values Yt, t /∈ {i1, . . . , ir}, in terms of Yt, t ∈ {i1, . . . , ir},
and the components of Y0 := (Y1−d,Y2−d, . . . ,Y0)

′ can be carried out as in
Example 9.6.2 using the state-space representation of the ARIMA series {Yt} from
Example 9.3.3 and the Kalman recursions for the corresponding state-space model
for {Y∗

t } defined by (9.6.1) and (9.1.2). See Brockwell and Davis (1991) for further
details. �

We close this section with a brief discussion of a direct approach to estimating
missing observations. This approach is often more efficient than the methods just
described, especially if the number of missing observations is small and we have
a simple (e.g., autoregressive) model. Consider the general problem of computing
E(X|Y) when the random vector (X′,Y′)′ has a multivariate normal distribution with
mean 0 and covariance matrix �. (In the missing observation problem, think of X as
the vector of the missing observations and Y as the vector of observed values.) Then
the joint probability density function of X and Y can be written as

fX,Y(x, y) = fX|Y(x|y)fY(y), (9.6.9)

where fX|Y(x|y) is a multivariate normal density with mean E(X|Y) and covariance
matrix �X|Y (see Proposition A.3.1). In particular,

fX|Y(x|y) = 1
√
(2π)q det�X|Y

exp

{

−1

2
(x − E(X|y))′�−1

X|Y(x − E(X|y))
}

,

(9.6.10)

where q = dim(X). It is clear from (9.6.10) that fX|Y(x|y) (and also fX,Y(x, y))
is maximum when x = E(X|y). Thus, the best estimator of X in terms of Y can be
found by maximizing the joint density ofX andYwith respect to x. For autoregressive
processes it is relatively straightforward to carry out this optimization, as shown in the
following example.
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Example 9.6.3. Estimating Missing Observations in an AR Process

Suppose {Yt} is the AR( p) process defined by

Yt = φ1Yt−1 + · · · + φpYt−p + Zt, {Zt} ∼ WN
(
0, σ 2

)
,

and Y = (Yi1, . . . ,Yir)
′, with 1 ≤ i1 < · · · < ir ≤ n, are the observed values. If there

are no missing observations in the first p observations, then the best estimates of the
missing values are found by minimizing

n∑

t=p+1

(Yt − φ1Yt−1 − · · · − φpYt−p)
2 (9.6.11)

with respect to the missing values (see Problem 9.20). For the AR(1) model in
Example 9.6.2, minimization of (9.6.11) is equivalent to minimizing

(Y2 − φY1)
2 + (Y3 − φY2)

2

with respect to Y2. Setting the derivative of this expression with respect to Y2 equal to
0 and solving for Y2 we obtain E(Y2|Y1,Y3,Y4,Y5) = φ(Y1 + Y3)/

(
1 + φ2

)
.

�

9.7 The EM Algorithm

The expectation-maximization (EM) algorithm is an iterative procedure for computing
the maximum likelihood estimator when only a subset of the complete data set is
available. Dempster et al. (1977) demonstrated the wide applicability of the EM
algorithm and are largely responsible for popularizing this method in statistics. Details
regarding the convergence and performance of the EM algorithm can be found in Wu
(1983).

In the usual formulation of the EM algorithm, the “complete” data vector W is
made up of “observed” data Y (sometimes called incomplete data) and “unobserved”
data X. In many applications, X consists of values of a “latent” or unobserved process
occurring in the specification of the model. For example, in the state-space model of
Section 9.1, Y could consist of the observed vectors Y1, . . . ,Yn and X of the unob-
served state vectors X1, . . . ,Xn. The EM algorithm provides an iterative procedure
for computing the maximum likelihood estimator based only on the observed data Y.
Each iteration of the EM algorithm consists of two steps. If θ(i) denotes the estimated
value of the parameter θ after i iterations, then the two steps in the (i + 1)th iteration
are

E-step. Calculate Q(θ |θ(i)) = Eθ(i) [�(θ;X,Y)|Y]

and

M-step. Maximize Q(θ |θ(i)) with respect to θ.
Then θ(i+1) is set equal to the maximizer ofQ in the M-step. In the E-step, �(θ; x, y) =
ln f (x, y; θ), and Eθ(i)(·|Y) denotes the conditional expectation relative to the condi-
tional density f

(
x|y; θ(i)) = f

(
x, y; θ(i))/f (y; θ(i)).

It can be shown that �
(
θ(i);Y) is nondecreasing in i, and a simple heuristic

argument shows that if θ(i) has a limit θ̂ then θ̂ must be a solution of the likelihood
equations �′

(
θ̂;Y) = 0. To see this, observe that ln f (x, y; θ) = ln f (x|y; θ)+ �(θ; y),

from which we obtain

Q
(
θ |θ(i)) =

∫

(ln f (x|Y; θ)) f (x|Y; θ(i)) dx + �(θ;Y)
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and

Q′(θ |θ(i)) =
∫ [

∂

∂θ
f (x|Y; θ)

]

/f (x|Y; θ)f (x|Y; θ(i)) dx + �′(θ;Y).

Now replacing θ with θ(i+1), noticing that Q′(θ(i+1)|θ(i)) = 0, and letting i → ∞, we
find that

0 =
∫

∂

∂θ

[
f (x|Y; θ)]

θ=θ̂ dx + �′
(
θ̂;Y

)
= �′

(
θ̂;Y

)
.

The last equality follows from the fact that

0 = ∂

∂θ
(1) = ∂

∂θ

[∫

( f (x|Y; θ) dx
]

θ=θ̂
=
∫ [

∂

∂θ
f (x|Y; θ)

]

θ=θ̂
dx.

The computational advantage of the EM algorithm over direct maximization of the
likelihood is most pronounced when the calculation and maximization of the exact
likelihood is difficult as compared with the maximization ofQ in theM-step. (There are
some applications in which the maximization ofQ can easily be carried out explicitly.)

9.7.1 Missing Data

The EM algorithm is particularly useful for estimation problems in which there are
missing observations. Suppose the complete data set consists of Y1, . . . ,Yn of which
r are observed and n − r are missing. Denote the observed and missing data by Y =
(Yi1, . . . ,Yir)

′ and X = (Yj1, . . . ,Yjn−r)
′, respectively. Assuming that W = (X′,Y′)′

has a multivariate normal distribution with mean 0 and covariance matrix �, which
depends on the parameter θ, the log-likelihood of the complete data is given by

�(θ;W) = −n

2
ln(2π)− 1

2
ln det(�)− 1

2
W′�W.

The E-step requires that we compute the expectation of �(θ;W) with respect to the
conditional distribution ofW given Y with θ=θ(i). Writing �(θ) as the block matrix

� =
[
�11 �12

�21 �22

]

,

which is conformable with X and Y, the conditional distribution of W given Y is

multivariate normal with mean
[X̂
Y

]
and covariance matrix

[
�11|2(θ) 0

0 0

]
, where X̂ =

Eθ(X|Y) = �12�
−1
22 Y and �11|2(θ) = �11 − �12�

−1
22 �21 (see Proposition A.3.1).

Using Problem A.8, we have

Eθ(i)
[
(X′,Y′)�−1(θ)(X′,Y′)′|Y] = trace

(
�11|2(θ(i))�−1

11|2(θ)
)

+ Ŵ′�−1(θ)Ŵ,

where Ŵ =
(
X̂′,Y′

)′
. It follows that

Q
(
θ|θ(i)) = �

(
θ, Ŵ

)
− 1

2
trace

(
�11|2

(
θ(i)

)
�−1

11|2(θ)
)
.

The first term on the right is the log-likelihood based on the complete data, but with
X replaced by its “best estimate” X̂ calculated from the previous iteration. If the
increments θ(i+1)− θ(i) are small, then the second term on the right is nearly constant
(≈ n− r) and can be ignored. For ease of computation in this application we shall use
the modified version

Q̃
(
θ|θ(i)) = �

(
θ; Ŵ

)
.
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With this adjustment, the steps in the EM algorithm are as follows:

E-step. Calculate Eθ(i) (X|Y) (e.g., with the Kalman fixed-point smoother) and form
�
(
θ; Ŵ)

.
M-step. Find the maximum likelihood estimator for the “complete” data problem,

i.e., maximize �
(
θ : Ŵ)

. For ARMA processes, ITSM can be used directly, with
the missing values replaced with their best estimates computed in the E-step.

Example 9.7.1. The Lake Data

It was found in Example 5.2.5 that the AR(2) model

Wt − 1.0415Wt−1 + 0.2494Wt−2 = Zt, {Zt} ∼ WN(0, .4790)

was a good fit to the mean-corrected lake data {Wt}. To illustrate the use of the EM
algorithm for missing data, consider fitting an AR(2) model to the mean-corrected
data assuming that there are 10 missing values at times t = 17, 24, 31, 38, 45, 52, 59,
66, 73, and 80. We start the algorithm at iteration 0 with φ̂(0)1 = φ̂

(0)
2 = 0. Since this

initial model represents white noise, the first E-step gives, in the notation used above,
Ŵ17 = · · · = Ŵ80 = 0. Replacing the “missing” values of the mean-corrected lake data
with 0 and fitting a mean-zero AR(2) model to the resulting complete data set using
the maximum likelihood option in ITSM, we find that φ̂(1)1 = 0.7252, φ̂(1)2 = 0.0236.
(Examination of the plots of the ACF and PACF of this new data set suggests an AR(1)
as a better model. This is also borne out by the small estimated value of φ2.) The
updated missing values at times t = 17, 24, . . . , 80 are found (see Section 9.6 and
Problem 9.21) by minimizing

2∑

j=0

(
Wt+j − φ̂(1)1 Wt+j−1 − φ̂(1)2 Wt+j−2

)2

with respect to Wt. The solution is given by

Ŵt =
φ̂
(1)
2 (Wt−2 + Wt+2)+

(
φ̂
(1)
1 − φ̂(1)1 φ̂

(1)
2

)
(Wt−1 + Wt+1)

1 +
(
φ̂
(1)
1

)2 +
(
φ̂
(1)
2

)2 .

The M-step of iteration 1 is then carried out by fitting an AR(2) model using
ITSM applied to the updated data set. As seen in the summary of the results reported
in Table 9.1, the EM algorithm converges in four iterations with the final parameter
estimates reasonably close to the fitted model based on the complete data set. (In
Table 9.1, estimates of the missing values are recorded only for the first three.)
Also notice how −2�

(
θ(i),W

)
decreases at every iteration. The standard errors of

the parameter estimates produced from the last iteration of ITSM are based on a
“complete” data set and, as such, underestimate the true sampling errors. Formulae for
adjusting the standard errors to reflect the true sampling error based on the observed
data can be found in Dempster et al. (1977).

�

9.8 Generalized State-Space Models

As in Section 9.1, we consider a sequence of state variables {Xt, t ≥ 1} and a sequence
of observations {Yt, t ≥ 1}. For simplicity, we consider only one-dimensional state and
observation variables, since extensions to higher dimensions can be carried out with
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Table 9.1 Estimates of the missing observations at times t = 17,
24, 31 and the AR estimates using the EM algorithm in
Example 9.7.1

Iteration i Ŵ17 Ŵ24 Ŵ31 φ̂
(i)
1 φ̂

(i)
2 −2�

(
θ (i),W

)

0 0 0 322.60

1 0 0 0 0.7252 0.0236 244.76

2 0.534 0.205 0.746 1.0729 −0.2838 203.57

3 0.458 0.393 0.821 1.0999 −0.3128 202.25

4 0.454 0.405 0.826 1.0999 −0.3128 202.25

little change. Throughout this section it will be convenient to writeY(t) andX(t) for the
t dimensional column vectors Y(t) = (Y1,Y2, . . . ,Yt)

′ and X(t) = (X1,X2, . . . ,Xt)
′.

There are two important types of state-space models, “parameter driven” and
“observation driven,” both of which are frequently used in time series analysis. The
observation equation is the same for both, but the state vectors of a parameter-driven
model evolve independently of the past history of the observation process, while the
state vectors of an observation-driven model depend on past observations.

9.8.1 Parameter-Driven Models

In place of the observation and state equations (9.1.1) and (9.1.2), we now make the
assumptions that Yt given

(
Xt,X(t−1),Y(t−1)

)
is independent of

(
X(t−1),Y(t−1)

)
with

conditional probability density

p( yt|xt) := p
(
yt|xt, x(t−1), y(t−1)

)
, t = 1, 2, . . . , (9.8.1)

and that Xt+1 given
(
Xt,X(t−1),Y(t)

)
is independent of

(
X(t−1),Y(t)

)
with conditional

density function

p(xt+1|xt) := p
(
xt+1|xt, x(t−1), y(t)

)
t = 1, 2, . . . . (9.8.2)

We shall also assume that the initial state X1 has probability density p1. The joint
density of the observation and state variables can be computed directly from (9.8.1)–
(9.8.2) as

p( y1, . . . , yn, x1, . . . , xn) = p
(
yn|xn, x(n−1), y(n−1)) p

(
xn, x(n−1), y(n−1))

= p( yn|xn)p
(
xn|x(n−1), y(n−1)

)
p
(
y(n−1), x(n−1)

)

= p( yn|xn)p(xn|xn−1)p
(
y(n−1), x(n−1)

)

= · · ·

=
⎛

⎝
n∏

j=1

p( yj|xj)
⎞

⎠

⎛

⎝
n∏

j=2

p(xj|xj−1)

⎞

⎠ p1(x1),

and since (9.8.2) implies that {Xt} is Markov (see Problem 9.22),

p(y1, . . . , yn|x1, . . . , xn) =
⎛

⎝
n∏

j=1

p( yj|xj)
⎞

⎠ . (9.8.3)
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We conclude that Y1, . . . ,Yn are conditionally independent given the state variables
X1, . . . ,Xn, so that the dependence structure of {Yt} is inherited from that of the state
process {Xt}. The sequence of state variables {Xt} is often referred to as the hidden or
latent generating process associated with the observed process.

In order to solve the filtering and prediction problems in this setting, we shall
determine the conditional densities p

(
xt|y(t)

)
of Xt given Y(t), and p

(
xt|y(t−1)

)
of Xt

given Y(t−1), respectively. The minimum mean squared error estimates of Xt based on
Y(t) and Y(t−1) can then be computed as the conditional expectations, E

(
Xt|Y(t)

)
and

E
(
Xt|Y(t−1)

)
.

An application of Bayes’s theorem, using the assumption that the distribution of
Yt given

(
Xt,X(t−1),Y(t−1)

)
does not depend on

(
X(t−1),Y(t−1)

)
, yields

p
(
xt|y(t)

) = p(yt|xt)p
(
xt|y(t−1)) /p

(
yt|y(t−1)) (9.8.4)

and

p
(
xt+1|y(t)

) =
∫

p
(
xt|y(t)

)
p(xt+1|xt) dμ(xt). (9.8.5)

(The integral relative to dμ(xt) in (9.8.4) is interpreted as the integral relative to dxt
in the continuous case and as the sum over all values of xt in the discrete case.) The
initial condition needed to solve these recursions is

p
(
x1|y(0)

) := p1(x1). (9.8.6)

The factor p
(
yt|y(t−1)

)
appearing in the denominator of (9.8.4) is just a scale factor,

determined by the condition
∫
p
(
xt|y(t)

)
dμ(xt) = 1. In the generalized state-

space setup, prediction of a future state variable is less important than forecasting a
future value of the observations. The relevant forecast density can be computed from
(9.8.5) as

p
(
yt+1|y(t)

) =
∫

p( yt+1|xt+1)p
(
xt+1|y(t)

)
dμ(xt+1). (9.8.7)

Equations (9.8.1)–(9.8.2) can be regarded as a Bayesian model specification. A
classical Bayesian model has two key assumptions. The first is that the data Y1, . . . ,Yt,
given an unobservable parameter (X(t) in our case), are independent with specified
conditional distribution. This corresponds to (9.8.3). The second specifies a prior
distribution for the parameter value. This corresponds to (9.8.2). The posterior
distribution is then the conditional distribution of the parameter given the data. In
the present setting the posterior distribution of the component Xt of X(t) is determined
by the solution (9.8.4) of the filtering problem.

Example 9.8.1. Consider the simplified version of the linear state-space model of Section 9.1,

Yt = GXt + Wt, {Wt} ∼ iid N(0,R), (9.8.8)

Xt+1 = FXt + Vt, {Vt} ∼ iid N(0,Q), (9.8.9)

where the noise sequences {Wt} and {Vt} are independent of each other. For this model
the probability densities in (9.8.1)–(9.8.2) become

p1(x1) = n(x1;EX1,Var(X1)), (9.8.10)

p(yt|xt) = n( yt;Gxt,R), (9.8.11)

p(xt+1|xt) = n(xt+1;Fxt,Q), (9.8.12)

where n
(
x;μ, σ 2

)
is the normal density with mean μ and variance σ 2 defined in

Example (a) of Section A.1.
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To solve the filtering and prediction problems in this new framework, we first
observe that the filtering and prediction densities in (9.8.4) and (9.8.5) are both normal.
We shall write them, using the notation of Section 9.4, as

p
(
xt|Y(t)

) = n(xt;Xt|t,Ωt|t) (9.8.13)

and

p
(
xt+1|Y(t)

) = n
(
xt+1; X̂t+1,Ωt+1

)
. (9.8.14)

From (9.8.5), (9.8.12), (9.8.13), and (9.8.14), we find that

X̂t+1 =
∫ ∞

−∞
xt+1p(xt+1|Y(t))dxt+1

=
∫ ∞

−∞
xt+1

∫ ∞

−∞
p(xt|Y(t))p(xt+1|xt) dxt dxt+1

=
∫ ∞

−∞
p(xt|Y(t))

[∫ ∞

−∞
xt+1p(xt+1|xt) dxt+1

]

dxt

=
∫ ∞

−∞
Fxtp(xt|Y(t)) dxt

= FXt|t

and (see Problem 9.23)

Ωt+1 = F2Ωt|t + Q.

Substituting the corresponding densities (9.8.11) and (9.8.14) into (9.8.4), we find by
equating the coefficient of x2

t on both sides of (9.8.4) that

Ω−1
t|t = G2R−1 +Ω−1

t = G2R−1 + (F2Ωt−1|t−1 + Q)−1

and

Xt|t = X̂t +Ωt|tGR−1
(
Yt − GX̂t

)
.

Also, from (9.8.4) with p
(
x1|y(0)

) = n(x1;EX1,Ω1) we obtain the initial conditions

X1|1 = EX1 +Ω1|1GR−1(Y1 − GEX1)

and

Ω−1
1|1 = G2R−1 +Ω−1

1 .

The Kalman prediction and filtering recursions of Section 9.4 give the same results for
X̂t and Xt|t, since for Gaussian systems best linear mean square estimation is equivalent
to best mean square estimation.

�

Example 9.8.2. A non-Gaussian Example

In general, the solution of the recursions (9.8.4) and (9.8.5) presents substantial
computational problems. Numerical methods for dealing with non-Gaussian models
are discussed by Sorenson and Alspach (1971) and Kitagawa (1987). Here we shall
illustrate the recursions (9.8.4) and (9.8.5) in a very simple special case. Consider the
state equation

Xt = aXt−1, (9.8.15)
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with observation density

p(yt|xt) = (πxt) yte−πxt

yt! , yt = 0, 1, . . . , (9.8.16)

where π is a constant between 0 and 1. The relationship in (9.8.15) implies that the
transition density [in the discrete sense—see the comment after (9.8.5)] for the state
variables is

p(xt+1|xt) =
{

1, if xt+1 = axt,

0, otherwise.

We shall assume that X1 has the gamma density function

p1(x1) = g(x1;α, λ) = λαx α−1
1 e−λx1

Γ (α)
, x1 > 0.

(This is a simplified model for the evolution of the number Xt of individuals at time
t infected with a rare disease, in which Xt is treated as a continuous rather than an
integer-valued random variable. The observation Yt represents the number of infected
individuals observed in a random sample consisting of a small fraction π of the
population at time t.) Because the transition distribution of {Xt} is not continuous,
we use the integrated version of (9.8.5) to compute the prediction density. Thus,

P
(
Xt ≤ x|y(t−1)) =

∫ ∞

0
P(Xt ≤ x|xt−1)p

(
xt−1|y(t−1)) dxt−1

=
∫ x/a

0
p
(
xt−1|y(t−1)

)
dxt−1.

Differentiation with respect to x gives

p
(
xt|y(t−1)

) = a−1pXt−1|Y(t−1)

(
a−1xt|y(t−1)

)
. (9.8.17)

Now applying (9.8.4), we find that

p(x1|y1) = p( y1|x1)p1(x1)/p( y1)

=
(
(πx1)

y1e−πx1

y1!
)(

λαxα−1
1 e−λx1

Γ (α)

)(
1

p( y1)

)

= c( y1)x
α+y1−1
1 e−(π+λ)x1, x1 > 0,

where c(y1) is an integration factor ensuring that p(·|y1) integrates to 1. Since p(·|y1)

has the form of a gamma density, we deduce (see Example (d) of Section A.1) that

p(x1|y1) = g(x1;α1, λ1), (9.8.18)

where α1 = α + y1 and λ1 = λ + π . The prediction density, calculated from (9.8.5)
and (9.8.18), is

p
(
x2|y(1)

) = a−1pX1|Y(1)
(
a−1x2|y(1)

)

= a−1g
(
a−1x2;α1, λ1

)

= g(x2;α1, λ1/a).

Iterating the recursions (9.8.4) and (9.8.5) and using (9.8.17), we find that for t ≥ 1,

p
(
xt|y(t)

) = g(xt;αt, λt) (9.8.19)
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and

p
(
xt+1|y(t)

) = a−1g
(
a−1xt+1;αt, λt

)

= g(xt+1;αt, λt/a), (9.8.20)

where αt = αt−1 + yt = α + y1 + · · · + yt and λt = λt−1/a + π = λa1−t +
π
(
1 − a−t

)
/(1 − a−1). In particular, the minimum mean squared error estimate of

xt based on y(t) is the conditional expectation αt/λt with conditional variance αt/λ2
t .

From (9.8.7) the probability density of Yt+1 given Y(t) is

p( yt+1|y(t)) =
∫ ∞

0

(
(πxt+1)

yt+1e−πxt+1

yt+1!
)

g(xt+1;αt, λt/a) dxt+1

= Γ (αt + yt+1)

Γ (αt)Γ (yt+1 + 1)

(

1 − π

λt+1

)αt ( π

λt+1

)yt+1

= nb(yt+1;αt, 1 − π/λt+1), yt+1 = 0, 1, . . . ,

where nb(y;α, p) is the negative binomial density defined in example (i) of Sec-
tion A.1. Conditional on Y(t), the best one-step predictor of Yt+1 is therefore the mean,
αtπ/(λt+1 − π), of this negative binomial distribution. The conditional mean squared
error of the predictor is Var

(
Yt+1|Y(t)

) = αtπλt+1/(λt+1 − π)2 (see Problem 9.25).
�

Example 9.8.3. A Model for Time Series of Counts

We often encounter time series in which the observations represent count data. One
such example is the monthly number of newly recorded cases of poliomyelitis in the
U.S. for the years 1970–1983 plotted in Figure 9-6. Unless the actual counts are large
and can be approximated by continuous variables, Gaussian and linear time series
models are generally inappropriate for analyzing such data. The parameter-driven
specification provides a flexible class of models for modeling count data. We now
discuss a specific model based on a Poisson observation density. This model is similar
to the one presented by Zeger (1988) for analyzing the polio data. The observation
density is assumed to be Poisson with mean exp{xt}, i.e.,

p( yt|xt) = e xtyt e−e xt

yt! , yt = 0, 1, . . . , (9.8.21)

while the state variables are assumed to follow a regression model with Gaussian
AR(1) noise. If ut = (ut1, . . . , utk)′ are the regression variables, then

Xt = β′ut + Wt, (9.8.22)

where β is a k-dimensional regression parameter and

Wt = φWt−1 + Zt, {Zt} ∼ IID N
(
0, σ 2

)
.

The transition density function for the state variables is then

p(xt+1|xt) = n(xt+1;β′ut+1 + φ (xt − β′ut), σ
2) . (9.8.23)

The case σ 2 = 0 corresponds to a log-linear model with Poisson noise.
Estimation of the parameters θ = (

β′, φ, σ 2
)′
in the model by direct numerical

maximization of the likelihood function is difficult, since the likelihood cannot be
written down in closed form. (From (9.8.3) the likelihood is the n-fold integral,

∫ ∞

−∞
· · ·

∫ ∞

−∞
exp

{
n∑

t=1

(
xtyt − e xt

)
}

L
(
θ; x(n)) (dx1 · · · dxn)

/ n∏

i=1

(yi!),
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Figure 9-6
Monthly number of U.S.
cases of polio, January
1970–December 1983
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where L(θ; x) is the likelihood based on X1, . . . ,Xn.) To overcome this difficulty,
Chan and Ledolter (1995) proposed an algorithm, called Monte Carlo EM (MCEM),
whose iterates θ(i) converge to the maximum likelihood estimate. To apply this
algorithm, first note that the conditional distribution ofY(n) givenX(n) does not depend
on θ, so that the likelihood based on the complete data

(
X(n)′,Y(n)′

)′
is given by

L
(
θ;X(n),Y(n)) = f

(
Y(n)|X(n)) L (θ;X(n)) .

The E-step of the algorithm (see Section 9.7) requires calculation of

Q(θ|θ(i)) = Eθ(i)
(
lnL(θ;X(n),Y(n))|Y(n))

= Eθ(i)
(
ln f (Y(n)|X(n))|Y(n)) + Eθ(i)

(
ln L(θ;X(n))|Y(n)) .

We delete the first term from the definition ofQ, since it is independent of θ and hence
plays no role in the M-step of the EM algorithm. The new Q is redefined as

Q(θ|θ(i)) = Eθ(i)
(
lnL(θ;X(n))|Y(n)) . (9.8.24)

Even with this simplification, direct calculation of Q is still intractable. Suppose
for the moment that it is possible to generate replicates of X(n) from the conditional
distribution ofX(n) givenY(n) when θ = θ(i). If we denote m independent replicates of
X(n) by X(n)1 , . . . ,X

(n)
m , then a Monte Carlo approximation to Q in (9.8.24) is given by

Qm

(
θ|θ(i)) = 1

m

m∑

j=1

ln L
(
θ;X(n)j

)
.

The M-step is easy to carry out using Qm in place of Q (especially if we condition on
X1 = 0 in all the simulated replicates), since L is just the Gaussian likelihood of the
regression model with AR(1) noise treated in Section 6.6. The difficult steps in the
algorithm are the generation of replicates of X(n) given Y(n) and the choice of m. Chan
and Ledolter (1995) discuss the use of the Gibb’s sampler for generating the desired
replicates and give some guidelines on the choice of m.

In their analyses of the polio data, Zeger (1988) and Chan and Ledolter (1995)
included as regression components an intercept, a slope, and harmonics at periods of
6 and 12 months. Specifically, they took

ut = (1, t/1000, cos(2π t/12), sin(2π t/12), cos(2π t/6), sin(2π t/6))′.
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Figure 9-7
Trend estimate for the

monthly number of
U.S. cases of polio,

January 1970–December
1983
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The implementation of Chan and Ledolter’s MCEMmethod by Kuk and Cheng (1994)
gave estimates β̂ = (0.247, −3.871, 0.162, −0.482, 0.414, −0.011)′, φ̂ = 0.648, and
σ̂ 2 = 0.281. The estimated trend function β̂′ut is displayed in Figure 9-7. The negative
coefficient of t/1000 indicates a slight downward trend in the monthly number of polio
cases.

�

9.8.2 Observation-Driven Models

Again we assume that Yt, conditional on
(
Xt,X(t−1),Y(t−1)

)
, is independent of

(
X(t−1),Y(t−1)

)
. These models are specified by the conditional densities

p( yt|xt) = p
(
yt|x(t), y(t−1)

)
, t = 1, 2, . . . , (9.8.25)

p
(
xt+1|y(t)

) = pXt+1|Y(t)
(
xt+1|y(t)

)
, t = 0, 1, . . . , (9.8.26)

where p
(
x1|y(0)

) := p1(x1) for some prespecified initial density p1(x1). The advantage
of the observation-driven state equation (9.8.26) is that the posterior distribution of
Xt given Y(t) can be computed directly from (9.8.4) without the use of the updating
formula (9.8.5). This then allows for easy computation of the forecast function
in (9.8.7) and hence of the joint density function of (Y1, . . . ,Yn)

′,

p( y1, . . . , yn) =
n∏

t=1

p
(
yt|y(t−1)

)
. (9.8.27)

On the other hand, the mechanism by which the state Xt−1 makes the transition to
Xt is not explicitly defined. In fact, without further assumptions there may be state
sequences {Xt} and {X∗

t } with different distributions for which both (9.8.25) and
(9.8.26) hold (see Example 9.8.6). Both sequences, however, lead to the same joint
distribution, given by (9.8.27), for Y1, . . . ,Yn. The ambiguity in the specification of
the distribution of the state variables can be removed by assuming that Xt+1 given(
X(t),Y(t)

)
is independent of X(t), with conditional distribution (9.8.26), i.e.,

p
(
xt+1|x(t), y(t)

) = p
Xt+1 |Y(t)

(
xt+1|y(t)

)
. (9.8.28)
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With this modification, the joint density of Y(n) and X(n) is given by (cf. (9.8.3))

p
(
y(n), x(n)

) = p( yn|xn)p
(
xn|y(n−1)) p

(
y(n−1), x(n−1))

= · · ·

=
n∏

t=1

(
p( yt|xt)p

(
xt|y(t−1)

))
.

Example 9.8.4. An AR(1) Process

An AR(1) process with iid noise can be expressed as an observation driven model.
Suppose {Yt} is the AR(1) process

Yt = φYt−1 + Zt,

where {Zt} is an iid sequence of random variables with mean 0 and some probability
density function f (x). Then with Xt := Yt−1 we have

p( yt|xt) = f ( yt − φxt)
and

p
(
xt+1|y(t)

) =
{

1, if xt+1 = yt,

0, otherwise.
�

Example 9.8.5. Suppose the observation-equation density is given by

p( yt|xt) = x yt
t e−xt

yt! , yt = 0, 1, . . . , (9.8.29)

and the state equation (9.8.26) is

p
(
xt+1|y(t)

) = g(xt;αt, λt), (9.8.30)

where αt = α + y1 + · · · + yt and λt = λ + t. It is possible to give a parameter-
driven specification that gives rise to the same state equation (9.8.30). Let {X∗

t } be the
parameter-driven state variables, where X∗

t = X∗
t−1 and X∗

1 has a gamma distribution
with parameters α and λ. (This corresponds to the model in Example 9.8.2 with π =
a = 1.) Then from (9.8.19) we see that p

(
x∗
t |y(t)

) = g(x∗
t ;αt, λt), which coincides

with the state equation (9.8.30). If {Xt} are the state variables whose joint distribution is
specified through (9.8.28), then {Xt} and {X∗

t } cannot have the same joint distributions.
To see this, note that

p
(
x∗
t+1|x∗

t

) =
{

1, if x∗
t+1 = x∗

t ,

0, otherwise,

while

p
(
xt+1|x(t), y(t)

) = p
(
xt+1|y(t)

) = g(xt;αt, λt).
If the two sequences had the same joint distribution, then the latter density could take
only the values 0 and 1, which contradicts the continuity (as a function of xt) of this
density.

�
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9.8.3 Exponential Family Models

The exponential family of distributions provides a large and flexible class of distribu-
tions for use in the observation equation. The density in the observation equation is
said to belong to an exponential family (in natural parameterization) if

p( yt|xt) = exp{ytxt − b(xt)+ c(yt)}, (9.8.31)

where b(·) is a twice continuously differentiable function and c(yt) does not depend
on xt. This family includes the normal, exponential, gamma, Poisson, binomial, and
many other distributions frequently encountered in statistics. Detailed properties of
the exponential family can be found in Barndorff-Nielsen (1978), and an excellent
treatment of its use in the analysis of linear models is given by McCullagh and Nelder
(1989). We shall need only the following important facts:

eb(xt) =
∫

exp{ytxt + c(yt)} ν(dyt), (9.8.32)

b′(xt) = E(Yt|xt), (9.8.33)

b′′(xt) = Var(Yt|xt) :=
∫

y2
t p(yt|xt) ν(dyt)−

[
b′(xt)

]2
, (9.8.34)

where integration with respect to ν(dyt) means integration with respect to dyt in the
continuous case and summation over all values of yt in the discrete case.

Proof. The first relation is simply the statement that p(yt|xt) integrates to 1. The second rela-
tion is established by differentiating both sides of (9.8.32) with respect to xt and then
multiplying through by e−b(xt) (for justification of the differentiation under the integral
sign see Barndorff-Nielsen 1978). The last relation is obtained by differentiating
(9.8.32) twice with respect to xt and simplifying. �

Example 9.8.6. The Poisson Case

If the observation Yt, given Xt = xt, has a Poisson distribution of the form (9.8.21),
then

p(yt|xt) = exp
{
ytxt − ext − ln yt!

}
, yt = 0, 1, . . . , (9.8.35)

which has the form (9.8.31) with b(xt) = ext and c(yt) = − ln yt!. From (9.8.33)
we easily find that E(Yt|xt) = b′(xt) = ext . This parameterization is slightly different
from the one used in Examples 9.8.2 and 9.8.5, where the conditional mean of Yt given
xt was πxt and not e xt . For this observation equation, define the family of densities

f (x;α, λ) = exp{αx − λb(x)+ A(α, λ)}, −∞ < x < ∞, (9.8.36)

where α > 0 and λ > 0 are parameters and A(α, λ) = − lnΓ (α) + α ln λ. Now
consider state densities of the form

p(xt+1|y(t)) = f (xt+1;αt+1|t, λt+1|t), (9.8.37)

where αt+1|t and λt+1|t are, for the moment, unspecified functions of y(t). (The subscript
t+1|t on the parameters is a shorthand way to indicate dependence on the conditional
distribution of Xt+1 given Y(t).) With this specification of the state densities, the
parameters αt+1|t are related to the best one-step predictor of Yt through the formula

αt+1|t/λt+1|t = Ŷt+1 := E
(
Yt+1|y(t)

)
. (9.8.38)
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Proof. We have from (9.8.7) and (9.8.33) that

E(Yt+1|y(t)) =
∞∑

yt+1=0

∫ ∞

−∞
yt+1p(yt+1|xt+1)p

(
xt+1|y(t)

)
dxt+1

=
∫ ∞

−∞
b′(xt+1)p

(
xt+1|y(t)

)
dxt+1.

Addition and subtraction of αt+1|t/λt+1|t then gives

E(Yt+1|y(t)) =
∫ ∞

−∞

(

b′(xt+1)− αt+1|t
λt+1|t

)

p
(
xt+1|y(t)

)
dxt+1 + αt+1|t

λt+1|t

=
∫ ∞

−∞
−λ−1

t+1|t p
′ (xt+1|y(t)

)
dxt+1 + αt+1|t

λt+1|t

=
[
−λ−1

t+1|t p
(
xt+1|y(t)

)]xt+1=∞
xt+1=−∞

+ αt+1|t
λt+1|t

= αt+1|t
λt+1|t

.

�

Letting At|t−1 = A(αt|t−1, λt|t−1), we can write the posterior density of Xt given
Y(t) as

p
(
xt|y(t)

) = exp{ytxt − b(xt)+ c(yt)} exp{αt|t−1xt − λt|t−1b(xt)

+ At|t−1}/p
(
yt|y(t−1)

)

= exp{λt|t
(
αt|txt − b(xt)

) − At|t},
= f (xt;αt, λt),

where we find, by equating coefficients of xt and b(xt), that the coefficients λt and αt
are determined by

λt = 1 + λt|t−1, (9.8.39)

αt = yt + αt|t−1. (9.8.40)

The family of prior densities in (9.8.37) is called a conjugate family of priors for
the observation equation (9.8.35), since the resulting posterior densities are again
members of the same family.

As mentioned earlier, the parameters αt|t−1 and λt|t−1 can be quite arbitrary: Any
nonnegative functions of y(t−1) will lead to a consistent specification of the state
densities. One convenient choice is to link these parameters with the corresponding
parameters of the posterior distribution at time t − 1 through the relations

λt+1|t = δλt
(= δ(1 + λt|t−1)

)
, (9.8.41)

αt+1|t = δαt
(= δ(yt + αt|t−1)

)
, (9.8.42)

where 0 < δ < 1 (see Remark 4 below). Iterating the relation (9.8.41), we see that

λt+1|t = δ(1 + λt|t−1) = δ + δλt|t−1

= δ + δ(δ + δλt−2|t−2)

= · · ·
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= δ + δ2 + · · · + δt + δtλ1|0 (9.8.43)

→ δ/(1 − δ)
as t → ∞. Similarly,

αt+1|t = δyt + δαt|t−1

= · · ·
= δyt + δ2yt−1 + · · · + δty1 + δtα1|0. (9.8.44)

For large t, we have the approximations

λt+1|t = δ/(1 − δ) (9.8.45)

and

αt+1|t = δ

t−1∑

j=0

δ jyt−j, (9.8.46)

which are exact if λ1|0 = δ/(1−δ) and α1|0 = 0. From (9.8.38) the one-step predictors
are linear and given by

Ŷt+1 = αt+1|t
λt+1|t

=
∑t−1

j=0 δ
jyt−j + δt−1α1|0

∑t−1
j=0 δ

j + δt−1λ1|0
. (9.8.47)

Replacing the denominator with its limiting value, or starting with λ1|0 = δ/(1 − δ),
we find that Ŷt+1 is the solution of the recursions

Ŷt+1 = (1 − δ)yt + δŶt, t = 1, 2, . . . , (9.8.48)

with initial condition Ŷ1 = (1 − δ)δ−1α1|0. In other words, under the restrictions
of (9.8.41) and (9.8.42), the best one-step predictors can be found by exponential
smoothing.

�

Remark 1. The preceding analysis for the Poisson-distributed observation equation
holds, almost verbatim, for the general family of exponential densities (9.8.31). (One
only needs to take care in specifying the correct range for x and the allowable
parameter space for α and λ in (9.8.37).) The relations (9.8.43)–(9.8.44), as well as
the exponential smoothing formula (9.8.48), continue to hold even in the more general
setting, provided that the parameters αt|t−1 and λt|t−1 satisfy the relations (9.8.41)–
(9.8.42). �

Remark 2. Equations (9.8.41)–(9.8.42) are equivalent to the assumption that the prior
density of Xt given y(t−1) is proportional to the δ-power of the posterior distribution of
Xt−1 given Y(t−1), or more succinctly that

f (xt;αt|t−1, λt|t−1) = f (xt; δαt−1|t−1, δλt−1|t−1)

∝ f δ(xt;αt−1|t−1, λt−1|t−1).

This power relationship is sometimes referred to as the power steady model (Grun-
wald et al. 1993; Smith 1979). �

Remark 3. The transformed state variables Wt = eXt have a gamma state density
given by

p
(
wt+1|y(t)

) = g(wt+1;αt+1|t, λt+1|t)
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(see Problem 9.26). The mean and variance of this conditional density are

E
(
Wt+1|y(t)

) = αt+1|t and Var
(
Wt+1|y(t)

) = αt+1|t/λ2
t+1|t. �

Remark 4. If we regard the random walk plus noise model of Example 9.2.1 as the
prototypical state-space model, then from the calculations in Example 9.8.1 with G =
F = 1, we have

E
(
Xt+1|Y(t)

) = E
(
Xt|Y(t)

)

and

Var
(
Xt+1|Y(t)

) = Var
(
Xt|Y(t)

) + Q > Var
(
Xt|Y(t)

)
.

The first of these equations implies that the best estimate of the next state is the same
as the best estimate of the current state, while the second implies that the variance
increases. Under the conditions (9.8.41), and (9.8.42), the same is also true for the
state variables in the above model (see Problem 9.26). This was, in part, the rationale
behind these conditions given in Harvey and Fernandes (1989). �

Remark 5. While the calculations work out neatly for the power steady model,
Grunwald et al. (1994) have shown that such processes have degenerate sample paths
for large t. In the Poisson example above, they argue that the observations Yt converge
to 0 as t → ∞ (see Figure 9-12). Although such models may still be useful in
practice for modeling series of moderate length, the efficacy of using such models
for describing long-term behavior is doubtful. �

Example 9.8.7. Goals Scored by England Against Scotland

The time series of the number of goals scored by England against Scotland in soccer
matches played at Hampden Park in Glasgow is graphed in Figure 9-8. The matches
have been played nearly every second year, with interruptions during the war years. We
will treat the data y1, . . . , y52 as coming from an equally spaced time series model {Yt}.
Since the number of goals scored is small (see the frequency histogram in Figure 9-9),
a model based on the Poisson distribution might be deemed appropriate. The observed
relative frequencies and those based on a Poisson distribution with mean equal to
ȳ52 = 1.269 are contained in Table 9.2. The standard chi-squared goodness of fit test,
comparing the observed frequencies with expected frequencies based on a Poisson
model, has a p-value of 0.02. The lack of fit with a Poisson distribution is hardly
unexpected, since the sample variance (1.652) is much larger than the sample mean,
while the mean and variance of the Poisson distribution are equal. In this case the
data are said to be overdispersed in the sense that there is more variability in the data
than one would expect from a sample of independent Poisson-distributed variables.
Overdispersion can sometimes be explained by serial dependence in the data.

Dependence in count data can often be revealed by estimating the probabilities of
transition from one state to another. Table 9.3 contains estimates of these probabilities,
computed as the average number of one-step transitions from state yt to state yt+1. If
the data were independent, then in each column the entries should be nearly the same.
This is certainly not the case in Table 9.3. For example, England is very unlikely to be
shut out or score 3 or more goals in the next match after scoring at least three goals in
the previous encounter.
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Figure 9-8
Goals scored by England

against Scotland
at Hampden Park,

Glasgow, 1872–1987
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Figure 9-9
Histogram of the
data in Figure 9-8
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Table 9.2 Relative frequency and fitted Poisson distribution of goals scored
by England against Scotland

Number of goals

0 1 2 3 4 5

Relative frequency 0.288 0.423 0.154 0.019 0.096 0.019

Poisson distribution 0.281 0.356 0.226 0.096 0.030 0.008

Harvey and Fernandes (1989) model the dependence in this data using an
observation-driven model of the type described in Example 9.8.6. Their model assumes
a Poisson observation equation and a log-gamma state equation:

p( yt|xt) = exp{ ytxt − ext }
yt! , yt = 0, 1, . . . ,

p
(
xt|y(t−1)) = f (xt;αt|t−1, λt|t−1), −∞ < x < ∞,
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Table 9.3 Transition probabilities for the number of goals
scored by England against Scotland

yt+1

p(yt+1|yt) 0 1 2 ≥ 3

0 0.214 0.500 0.214 0.072

yt 1 0.409 0.272 0.136 0.182

2 0.250 0.375 0.125 0.250

≥ 3 0 0.857 0.143 0

Table 9.4 Prediction density of Y53 given Y(52) for data in Figure 9-7

Number of goals

0 1 2 3 4 5

p(y53|y(52)) 0.472 0.326 0.138 0.046 0.013 0.004

for t = 1, 2, . . . , where f is given by (9.8.36) and α1|0 = 0, λ1|0 = 0. The power
steady conditions (9.8.41)–(9.8.42) are assumed to hold for αt|t−1 and λt|t−1. The only
unknown parameter in the model is δ. The log-likelihood function for δ based on the
conditional distribution of y1, . . . , y52 given y1 is given by [see (9.8.27)]

�
(
δ, y(n)

) =
n−1∑

t=1

ln p
(
yt+1|y(t)

)
, (9.8.49)

where p
(
yt+1|y(t))

)
is the negative binomial density [see Problem 9.25(c)]

p
(
yt+1|y(t)

) = nb
(
yt+1;αt+1|t, (1 + λt+1|t)−1) ,

with αt+1|t and λt+1|t as defined in (9.8.44) and (9.8.43). (For the goal data, y1 = 0,
which implies α2|1 = 0 and hence that p

(
y2|y(1)

)
is a degenerate density with unit

mass at y2 = 0. Harvey and Fernandes avoid this complication by conditioning the
likelihood on y(τ ), where τ is the time of the first nonzero data value.)

Maximizing this likelihood with respect to δ, we obtain δ̂ = 0.844. (Starting
equations (9.8.43)–(9.8.44) with α1|0 = 0 and λ1|0 = δ/(1 − δ), we obtain
δ̂ = 0.732.) With 0.844 as our estimate of δ, the prediction density of the next
observation Y53 given y(52) is nb(y53;α53|52, (1+λ53|52)

−1. The first five values of this
distribution are given in Table 9.4. Under this model, the probability that England
will be held scoreless in the next match is 0.471. The one-step predictors, Ŷ1 =
0, Ŷ2, . . . , Ŷ52 are graphed in Figure 9-10. (This graph can be obtained by using the
ITSM option Smooth>Exponentialwith α = 0.154.)

Figures 9-11 and 9-12 contain two realizations from the fitted model for the goal
data. The general appearance of the first realization is somewhat compatible with the
goal data, while the second realization illustrates the convergence of the sample path
to 0 in accordance with the result of Grunwald et al. (1994).

�
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Figure 9-10
One-step predictors

of the goal data
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Figure 9-11
A simulated time

series from the fitted
model to the goal data
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Example 9.8.8. The Exponential Case

Suppose Yt given Xt has an exponential density with mean −1/Xt (Xt < 0). The
observation density is given by

p(yt|xt) = exp{ytxt + ln(−xt)}, yt > 0,

which has the form (9.8.31) with b(x) = − ln(−x) and c(y) = 0. The state densities
corresponding to the family of conjugate priors (see (9.8.37)) are given by

p
(
xt+1|y(t)

) = exp{αt+1|t xt+1 − λt+1|t b(xt+1)+ At+1|t}, −∞ < x < 0.

(Here p(xt+1|y(t)) is a probability density when αt+1|t > 0 and λt+1|t > −1.) The
one-step prediction density is
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Figure 9-12
A second simulated time

series from the fitted
model to the goal data
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p
(
yt+1|y(t

) =
∫ 0

−∞
ext+1yt+1+ln(−xt+1)+αt+1|tx−λt+1|tb(x)+At+1|t dxt+1

= (λt+1|t + 1)α
λt+1|t+1
t+1|t (yt+1 + αt+1|t)−λt+1|t−2, yt+1 > 0

(see Problem 9.28).WhileE(Yt+1|y(t)) = αt+1|t/λt+1|t, the conditional variance is finite
if and only if λt+1|t > 1. Under assumptions (9.8.41)–(9.8.42), and starting with λ1|0 =
δ/(1 − δ), the exponential smoothing formula (9.8.48) remains valid.

�

Problems

9.1 Show that if all the eigenvalues of F are less than 1 in absolute value (or
equivalently that Fk →0 as k→∞), the unique stationary solution of equation
(9.1.11) is given by the infinite series

Xt =
∞∑

j=0

F jVt−j−1

and that the corresponding observation vectors are

Yt = Wt +
∞∑

j=0

GF jVt−j−1.

Deduce that {(X′
t,Y

′
t)

′} is a multivariate stationary process. (Hint: Use a vector
analogue of the argument in Example 2.2.1.)

9.2 In Example 9.2.1, show that θ = −1 if and only if σ 2
v = 0, which in turn is

equivalent to the signal Mt being constant.

9.3 Let F be the coefficient of Xt in the state equation (9.3.4) for the causal AR(p)
process

Xt − φ1Xt−1 − · · · − φpXt−p = Zt, {Zt} ∼ WN
(
0, σ 2

)
.
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Establish the stability of (9.3.4) by showing that

det(zI − F) = zpφ
(
z−1) ,

and hence that the eigenvalues of F are the reciprocals of the zeros of the
autoregressive polynomial φ(z) = 1 − φ1z − · · · − φpzp.

9.4 By following the argument in Example 9.3.3, find a state-space model for {Yt}
when {∇∇12Yt} is an ARMA(p, q) process.

9.5 For the local linear trend model defined by equations (9.2.6)–(9.2.7), show that
∇2Yt = (1 − B)2Yt is a 2-correlated sequence and hence, by Proposition 2.1.1,
is an MA(2) process. Show that this MA(2) process is noninvertible if σ 2

u = 0.
9.6 a. For the seasonal model of Example 9.2.2, show that ∇dYt = Yt − Yt−d is an

MA(1) process.
b. Show that ∇∇dYt is an MA(d + 1) process where {Yt} follows the seasonal
model with a local linear trend as described in Example 9.2.3.

9.7 Let {Yt} be the MA(1) process

Yt = Zt + θZt−1, {Zt} ∼ WN
(
0, σ 2) .

Show that {Yt} has the state-space representation
Yt = [1 0]Xt,

where {Xt} is the unique stationary solution of

Xt+1 =
[

0 1
0 0

]

Xt +
[

1
θ

]

Zt+1.

In particular, show that the state vector Xt can written as

Xt =
[

1 θ
θ 0

][
Zt

Zt−1

]

.

9.8 Verify equations (9.3.16)–(9.3.18) for an ARIMA(1,1,1) process.

9.9 Consider the two state-space models
{
Xt+1,1= F1Xt1 + Vt1,

Yt1 = G1Xt1 + Wt1,

and
{
Xt+1,2= F2Xt2 + Vt2,

Yt2 = G2Xt2 + Wt2,

where {(V′
t1,W

′
t1,V

′
t2,W

′
t2)

′} is white noise. Derive a state-space representation
for {(Y′

t1,Y
′
t2)

′}.
9.10 Use Remark 1 of Section 9.4 to establish the linearity properties of the operator

Pt stated in Remark 3.

9.11 a. Show that if the matrix equation XS=B can be solved for X, then X=BS−1

is a solution for any generalized inverse S−1 of S.

b. Use the result of (a) to derive the expression for P(X|Y) in Remark 4 of
Section 9.4.
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9.12 In the notation of the Kalman prediction equations, show that every vector of
the form

Y = A1X1 + · · · + AtXt

can be expressed as

Y = B1X1 + · · · + Bt−1Xt−1 + CtIt,

where B1, . . . ,Bt−1 and Ct are matrices that depend on the matrices A1, . . . ,At.
Show also that the converse is true. Use these results and the fact that E(XsIt)=
0 for all s < t to establish (9.4.3).

9.13 In Example 9.4.1, verify that the steady-state solution of the Kalman recursions

(9.1.2) is given byΩt =
(
σ 2
v + √

σ 4
v + 4σ 2

v σ
2
w

)
/2.

9.14 Show from the difference equations for Ωt in Example 9.4.1 that (Ωt+1 −
Ω)(ΩtΩ) ≥ 0 for allΩt ≥ 0, whereΩ is the steady-state solution forΩt given in
Problem 9.13.

9.15 Show directly that for the MA(1) model (9.2.3), the parameter θ is equal to

−
(

2σ 2
w + σ 2

v − √
σ 4
v + 4σ 2

v σ
2
w

)
/
(
2σ 2

w

)
, which in turn is equal to −σ 2

w/(Ω +
σ 2
w), where Ω is the steady-state solution for Ωt given in Problem 9.13.

9.16 Use the ARMA(0,1,1) representation of the series {Yt} in Example 9.4.1 to show
that the predictors defined by

Ŷn+1 = aYn + (1 − a)Ŷn, n = 1, 2, . . . ,

where a = Ω/(Ω + σ 2
w), satisfy

Yn+1 − Ŷn+1 = Zn+1 + (1 − a)n
(
Y0 − Z0 − Ŷ1

)
.

Deduce that if 0 < a < 1, the mean squared error of Ŷn+1 converges toΩ + σ 2
w

for any initial predictor Ŷ1 with finite mean squared error.

9.17 a. Using equations (9.4.1) and (9.4.16), show that X̂t+1 = FtXt|t.
b. From (a) and (9.4.16) show that Xt|t satisfies the recursions

Xt|t = Ft−1Xt−1|t−1 +ΩtG
′
tΔ

−1
t (Yt − GtFt−1Xt−1|t−1)

for t = 2, 3, . . . , with X1|1 = X̂1 +Ω1G′
1Δ

−1
1

(
Y1 − G1X̂1

)
.

9.18 In Section 9.5, show that for fixed Q∗, −2 ln L
(
μ,Q∗, σ 2

w

)
is minimized when

μ and σ 2
w are given by (9.5.10) and (9.5.11), respectively.

9.19 Verify the calculation of �tΔ
−1
t and Ωt in Example 9.6.1.

9.20 Verify that the best estimates of missing values in an AR(p) process are found
by minimizing (9.6.11) with respect to the missing values.

9.21 Suppose that {Yt} is the AR(2) process
Yt = φ1Yt−1 + φ2Yt−2 + Zt, {Zt} ∼ WN

(
0, σ 2) ,

and that we observe Y1,Y2,Y4,Y5,Y6,Y7. Show that the best estimator of Y3 is

(φ2(Y1 + Y5)+ (φ1 − φ1φ2)(Y2 + Y4)) /
(
1 + φ2

1 + φ2
2

)
.
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9.22 Let Xt be the state at time t of a parameter-driven model (see (9.8.2)). Show that
{Xt} is a Markov chain and that (9.8.3) holds.

9.23 For the generalized state-space model of Example 9.8.1, show that Ωt+1 =
F2Ωt|t + Q.

9.24 If Y and X are random variables, show that

Var(Y) = E(Var(Y|X))+ Var(E(Y|X)).
9.25 Suppose that Y and X are two random variables such that the distribution of Y

given X is Poisson with mean πX, 0 < π ≤ 1, and X has the gamma density
g(x;α, λ).
a. Show that the posterior distribution of X given Y also has a gamma density

and determine its parameters.

b. Compute E(X|Y) and Var(X|Y).
c. Show that Y has a negative binomial density and determine its parameters.

d. Use (c) to compute E(Y) and Var(Y).

e. Verify in Example 9.8.2 that E
(
Yt+1|Y(t)

) = αtπ/(λt+1 − π) and
Var

(
Yt+1|Y(t)

) = αtπλt+1/(λt+1 − π)2.
9.26 For the model of Example 9.8.6, show that

a. E
(
Xt+1|Y(t)

) = E
(
Xt|Y(t)

)
, Var

(
Xt+1|Y(t)

)
>Var

(
Xt|Y(t)

)
, and

b. the transformed sequence Wt = eXt has a gamma state density.

9.27 Let {Vt} be a sequence of independent exponential random variables with EVt =
t−1 and suppose that {Xt, t ≥ 1} and {Yt, t ≥ 1} are the state and observation
random variables, respectively, of the parameter-driven state-space system

X1 = V1,

Xt = Xt−1 + Vt, t = 2, 3, . . . ,

where the distribution of the observation Yt, conditional on the random variables
Y1,Y2, . . . ,Yt−1,Xt, is Poisson with mean Xt.
a. Determine the observation and state transition density functions p(yt|xt) and

p(xt+1|xt) in the parameter-driven model for {Yt}.
b. Show, using (9.8.4)–(9.8.6), that

p(x1|y1) = g(x1; y1 + 1, 2)

and

p(x2|y1) = g(x2; y1 + 2, 2),

where g(x;α, λ) is the gamma density function (see Example (d) of Sec-
tion A.1).

c. Show that

p
(
xt|y(t)

) = g(xt;αt + t, t + 1)

and

p
(
xt+1|y(t)

) = g(xt+1;αt + t + 1, t + 1),

where αt = y1 + · · · + yt.
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d. Conclude from (c) that the minimum mean squared error estimates of Xt and
Xt+1 based on Y1, . . . ,Yt are

Xt|t = t + Y1 + · · · + Yt

t + 1

and

X̂t+1 = t + 1 + Y1 + · · · + Yt

t + 1
,

respectively.

9.28 Let Y and X be two random variables such that Y given X is exponential with
mean 1/X, and X has the gamma density function with

g(x;λ + 1, α) = αλ+1xλ exp{−αx}
Γ (λ+ 1)

, x > 0,

where λ > −1 and α > 0.
a. Determine the posterior distribution of X given Y .

b. Show that Y has a Pareto distribution

p(y) = (λ+ 1)αλ+1(y + α)−λ−2, y > 0.

c. Find the mean and variance of Y . Under what conditions on α and λ does the
latter exist?

d. Verify the calculation of p
(
yt+1|y(t)

)
and E

(
Yt+1|y(t)

)
for the model in

Example 9.8.8.

9.29 Consider an observation-driven model in which Yt given Xt is binomial with
parameters n and Xt, i.e.,

p(yt|xt) =
(
n

yt

)

xytt (1 − xt)
n−yt, yt = 0, 1, . . . , n.

a. Show that the observation equation with state variable transformed by the
logit transformation Wt = ln(Xt/(1 − Xt)) follows an exponential family

p(yt|wt) = exp{ytwt − b(wt)+ c(yt)}.
Determine the functions b(·) and c(·).

b. Suppose that the state Xt has the beta density

p(xt+1|y(t)) = f (xt+1;αt+1|t, λt+1|t),
where

f (x;α, λ) = [B(α, λ)]−1xα−1(1 − x)λ−1, 0 < x < 1,

B(α, λ) := Γ (α)Γ (λ)/Γ (α + λ) is the beta function, and α, λ > 0. Show that
the posterior distribution of Xt given Yt is also beta and express its parameters in
terms of yt and αt|t−1, λt|t−1.

c. Under the assumptions made in (b), show that E
(
Xt|Y(t)

) = E
(
Xt+1|Y(t)

)

and Var
(
Xt|Y(t)

)
<Var

(
Xt+1|Y(t)

)
.

d. Assuming that the parameters in (b) satisfy (9.8.41)–(9.8.42), show that the one-
step prediction density p

(
yt+1|y(t)

)
is beta-binomial,

p(yt+1|y(t)) = B(αt+1|t + yt+1, λt+1|t + n − yt+1)

(n + 1)B(yt+1 + 1, n − yt+1 + 1)B(αt+1|t, λt+1|t)
,

and verify that Ŷt+1 is given by (9.8.47).



10 Forecasting Techniques

10.1 The ARAR Algorithm
10.2 The Holt–Winters Algorithm
10.3 The Holt–Winters Seasonal Algorithm
10.4 Choosing a Forecasting Algorithm

We have focused until now on the construction of time series models for stationary
and nonstationary series and the determination, assuming the appropriateness of these
models, of minimum mean squared error predictors. If the observed series had in
fact been generated by the fitted model, this procedure would give minimum mean
squared error forecasts. In this chapter we discuss three forecasting techniques that
have less emphasis on the explicit construction of a model for the data. Each of the
three selects, from a limited class of algorithms, the one that is optimal according to
specified criteria.

The three techniques have been found in practice to be effective on wide ranges
of real data sets (for example, the economic time series used in the forecasting com-
petition described by Makridakis et al. 1984).

The ARAR algorithm described in Section 10.1 is an adaptation of the ARARMA
algorithm (Newton and Parzen 1984; Parzen 1982) in which the idea is to apply auto-
matically selected “memory-shortening” transformations (if necessary) to the data
and then to fit an ARMA model to the transformed series. The ARAR algorithm we
describe is a version of this in which the ARMA fitting step is replaced by the fitting
of a subset AR model to the transformed data.

The Holt–Winters (HW) algorithm described in Section 10.2 uses a set of simple
recursions that generalize the exponential smoothing recursions of Section 1.5.1 to
generate forecasts of series containing a locally linear trend.

© Springer International Publishing Switzerland 2016
P.J. Brockwell, R.A. Davis, Introduction to Time Series and Forecasting,
Springer Texts in Statistics, DOI 10.1007/978-3-319-29854-2_10
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The Holt–Winters seasonal (HWS) algorithm extends the HW algorithm to handle
data in which there are both trend and seasonal variation of known period. It is
described in Section 10.3.

Each of these three algorithms can be applied to specific data sets with the aid of
the ITSM options Forecasting>ARAR, Forecasting>Holt-Winters and
Forecasting>Seasonal Holt-Winters.

10.1 The ARAR Algorithm

10.1.1 Memory Shortening

Given a data set {Yt, t = 1, 2, . . . , n}, the first step is to decide whether the underlying
process is “long-memory,” and if so to apply a memory-shortening transformation be-
fore attempting to fit an autoregressive model. The differencing operations permit-
ted under the option Transform of ITSM are examples of memory-shortening
transformations; however, the ones used by the option Forecasting>ARAR selects
are members of a more general class. There are two types allowed:

Ỹt = Yt − φ̂
(
τ̂
)
Yt−τ̂ (10.1.1)

and

Ỹt = Yt − φ̂1Yt−1 − φ̂2Yt−2. (10.1.2)

With the aid of the five-step algorithm described below, we classify {Yt} and take
one of the following three courses of action:

• L. Declare {Yt} to be long-memory and form
{
Ỹt

}
using (10.1.1).

• M. Declare {Yt} to be moderately long-memory and form
{
Ỹt

}
using (10.1.2).

• S. Declare {Yt} to be short-memory.

If the alternative L or M is chosen, then the transformed series
{
Ỹt

}
is again

checked. If it is found to be long-memory or moderately long-memory, then a further
transformation is performed. The process continues until the transformed series is
classified as short-memory. At most three memory-shortening transformations are
performed, but it is very rare to require more than two. The algorithm for deciding
among L, M, and S can be described as follows:

1. For each τ = 1, 2, . . . , 15, we find the value φ̂(τ ) of φ that minimizes

ERR(φ, τ) =
∑n

t=τ+1[Yt − φYt−τ ]2

∑n
t=τ+1 Y

2
t

.

We then define

Err(τ ) = ERR
(
φ̂(τ ), τ

)

and choose the lag τ̂ to be the value of τ that minimizes Err(τ ).
2. If Err

(
τ̂
) ≤ 8/n, go to L.

3. If φ̂
(
τ̂
) ≥ 0.93 and τ̂ > 2, go to L.

4. If φ̂
(
τ̂
) ≥ 0.93 and τ̂ = 1 or 2, determine the values φ̂1 and φ̂2 of φ1 and φ2 that

minimize
∑n

t=3[Yt − φ1Yt−1 − φ2Yt−2]2; then go to M.
5. If φ̂

(
τ̂
)
< 0.93, go to S.
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10.1.2 Fitting a Subset Autoregression

Let {St, t = k + 1, . . . , n} denote the memory-shortened series derived from {Yt} by
the algorithm of the previous section and let S denote the sample mean of Sk+1, . . . , Sn.

The next step in the modeling procedure is to fit an autoregressive process to the
mean-corrected series

Xt = St − S, t = k + 1, . . . , n.

The fitted model has the form

Xt = φ1Xt−1 + φl1Xt−l1 + φl2Xt−l2 + φl3Xt−l3 + Zt,

where {Zt} ∼ WN
(
0, σ 2

)
, and for given lags, l1, l2, and l3, the coefficients φj and the

white noise variance σ 2 are found from the Yule–Walker equations
⎡

⎢
⎢
⎣

1 ρ̂(l1 − 1) ρ̂(l2 − 1) ρ̂(l3 − 1)
ρ̂(l1 − 1) 1 ρ̂(l2 − l1) ρ̂(l3 − l1)
ρ̂(l2 − 1) ρ̂(l2 − l1) 1 ρ̂(l3 − l2)
ρ̂(l3 − 1) ρ̂(l3 − l1) ρ̂(l3 − l2) 1

⎤

⎥
⎥
⎦

⎡

⎢
⎢
⎣

φ1

φl1
φl2
φl3

⎤

⎥
⎥
⎦ =

⎡

⎢
⎢
⎣

ρ̂(1)
ρ̂(l1)
ρ̂(l2)
ρ̂(l3)

⎤

⎥
⎥
⎦

and

σ 2 = γ̂ (0)
[
1 − φ1ρ̂(1)− φl1 ρ̂(l1)− φl2 ρ̂(l2)− φl3 ρ̂(l3)

]
,

where γ̂ (j) and ρ̂(j), j = 0, 1, 2, . . . , are the sample autocovariances and autocor-
relations of the series {Xt}.

The program computes the coefficients φj for each set of lags such that

1 < l1 < l2 < l3 ≤ m,

where m can be chosen to be either 13 or 26. It then selects the model for which the
Yule–Walker estimate σ 2 is minimal and prints out the lags, coefficients, and white
noise variance for the fitted model.

A slower procedure chooses the lags and coefficients (computed from the Yule–
Walker equations as above) that maximize the Gaussian likelihood of the observations.
For this option the maximum lag m is 13.

The options are displayed in the ARAR Forecasting dialog box, which
appears on the screen when the option Forecasting>ARAR is selected. It allows
you also to bypass memory shortening and fit a subset AR to the original (mean-
corrected) data.

10.1.3 Forecasting

If the memory-shortening filter found in the first step has coefficients ψ0(= 1),
ψ1, . . . , ψk (k ≥ 0), then the memory-shortened series can be expressed as

St = ψ(B)Yt = Yt + ψ1Yt−1 + · · · + ψkYt−k, (10.1.3)

where ψ(B) is the polynomial in the backward shift operator,

ψ(B) = 1 + ψ1B + · · · + ψkB
k.

Similarly, if the coefficients of the subset autoregression found in the second step are
φ1, φl1 , φl2 , and φl3 , then the subset AR model for the mean-corrected series

{
Xt =

St − S
}
is

φ(B)Xt = Zt, (10.1.4)
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where {Zt} ∼ WN
(
0, σ 2

)
and

φ(B) = 1 − φ1B − φl1Bl1 − φl2Bl2 − φl3Bl3.

From (10.1.3) and (10.1.4) we obtain the equations

ξ(B)Yt = φ(1)S + Zt, (10.1.5)

where

ξ(B) = ψ(B)φ(B) = 1 + ξ1B + · · · + ξk+l3B
k+l3 .

Assuming that the fitted model (10.1.5) is appropriate and that the white noise
term Zt is uncorrelated with {Yj, j < t} for each t, we can determine the minimum
mean squared error linear predictors PnYn+h of Yn+h in terms of {1,Y1, . . . ,Yn}, for
n > k + l3, from the recursions

PnYn+h = −
k+l3∑

j=1

ξjPnYn+h−j + φ(1)S, h ≥ 1, (10.1.6)

with the initial conditions

PnYn+h = Yn+h, for h ≤ 0. (10.1.7)

The mean squared error of the predictor PnYn+h is found to be (Problem 10.1)

E
[
(Yn+h − PnYn+h)

2
] =

h−1∑

j=0

τ 2
j σ

2, (10.1.8)

where
∑∞

j=0 τjz
j is the Taylor expansion of 1/ξ(z) in a neighborhood of z = 0.

Equivalently the sequence {τj} can be found from the recursion

τ0 = 1,
n∑

j=0

τjξn−j = 0, n = 1, 2, . . . . (10.1.9)

10.1.4 Application of the ARAR Algorithm

To determine an ARAR model for a given data set {Yt} using ITSM, select Fore-
casting>ARAR and choose the appropriate options in the resulting dialog
box. These include specification of the number of forecasts required, whether or
not you wish to include the memory-shortening step, whether you require prediction
bounds, and which of the optimality criteria is to be used. Once you have made
these selections, click OK, and the forecasts will be plotted with the original data.
Right-click on the graph and then Info to see the coefficients 1, ψ1, . . . , ψk of the
memory-shortening filter ψ(B), the lags and coefficients of the subset autoregression

Xt − φ1Xt−1 − φl1Xt−l1 − φl2Xt−l2 − φl3Xt−l3 = Zt,

and the coefficients ξj of Bj in the overall whitening filter

ξ(B) = (
1 + ψ1B + · · · + ψkB

k
) (

1 − φ1B − φl1Bl1 − φl2Bl2 − φl3Bl3
)
.

The numerical values of the predictors, their root mean squared errors, and the pre-
diction bounds are also printed.

Example 10.1.1 To use the ARAR algorithm to predict 24 values of the accidental deaths
data, open the file DEATHS.TSM and proceed as described above. Selecting
Minimize WN variance [max lag=26] gives the graph of the data and
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Figure 10-1
The data set DEATHS.TSM

with 24 values predicted by
the ARAR algorithm
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predictors shown in Figure 10-1. Right-clicking on the graph and then Info, we
find that the selected memory-shortening filter is

(
1 − 0.9779B12

)
. The fitted subset

autoregression and the coefficients ξj of the overall whitening filter ξ(B) are shown
below: �

Optimal lags 1 3 12 13
Optimal coeffs 0.5915 −0.3822 −0.3022 0.2970
WN Variance: 0.12314E+06
COEFFICIENTS OF OVERALL WHITENING FILTER:
1.0000 −0.5915 0.0000 −0.2093 0.0000
0.0000 0.0000 0.0000 0.0000 0.0000
0.0000 0.0000 −0.6757 0.2814 0.0000
0.2047 0.0000 0.0000 0.0000 0.0000
0.0000 0.0000 0.0000 0.0000 −0.2955
0.2904

�
In Table 10.1 we compare the predictors of the next six values of the accidental

deaths series with the actual observed values. The predicted values obtained from
ARAR as described in the example are shown together with the predictors obtained
by fitting ARIMA models as described in Chapter 6 (see Table 10.1). The observed

root mean squared errors (i.e.,
√
∑6

h=1(Y72+h−P72Y72+h)
2/6 ) for the three prediction

methods are easily calculated to be 253 for ARAR, 583 for the ARIMAmodel (6.5.8),
and 501 for the ARIMA model (6.5.9). The ARAR algorithm thus performs very
well here. Notice that in this particular example the ARAR algorithm effectively fits
a causal AR model to the data, but this is not always the case.
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10.2 The Holt–Winters Algorithm

10.2.1 The Algorithm

Given observations Y1,Y2, . . . ,Yn from the “trend plus noise” model (1.5.2), the
exponential smoothing recursions (1.5.7) allowed us to compute estimates m̂t of
the trend at times t = 1, 2, . . . , n. If the series is stationary, then mt is constant and the
exponential smoothing forecast of Yn+h based on the observations Y1, . . . ,Yn is

PnYn+h = m̂n, h = 1, 2, . . . . (10.2.1)

If the data have a (nonconstant) trend, then a natural generalization of the forecast
function (10.2.1) that takes this into account is

PnYn+h = ân + b̂nh, h = 1, 2, . . . , (10.2.2)

where ân and b̂n can be thought of as estimates of the “level” an and “slope” bn of
the trend function at time n. Holt (1957) suggested a recursive scheme for computing
the quantities ân and b̂n in (10.2.2). Denoting by Ŷn+1 the one-step forecast PnYn+1, we
have from (10.2.2)

Ŷn+1 = ân + b̂n.

Now, as in exponential smoothing, we suppose that the estimated level at time n + 1
is a linear combination of the observed value at time n + 1 and the forecast value at
time n + 1. Thus,

ân+1 = αYn+1 + (1 − α)(ân + b̂n
)
. (10.2.3)

We can then estimate the slope at time n+ 1 as a linear combination of ân+1 − ân and
the estimated slope b̂n at time n. Thus,

b̂n+1 = β
(
ân+1 − ân

) + (1 − β)b̂n. (10.2.4)

In order to solve the recursions (10.2.3) and (10.2.4) we need initial conditions.
A natural choice is to set

â2 = Y2 (10.2.5)

and

b̂2 = Y2 − Y1. (10.2.6)

Then (10.2.3) and (10.2.4) can be solved successively for âi and b̂i, i = 3, . . . , n, and
the predictors PnYn+h found from (10.2.2).

The forecasts depend on the “smoothing parameters” α and β. These can either
be prescribed arbitrarily (with values between 0 and 1) or chosen in a more systematic
way tominimize the sum of squares of the one-step errors

∑n
i=3(Yi−Pi−1Yi)

2, obtained

Table 10.1 Predicted and observed values of the accidental deaths series for t = 73, . . . ,78

t 73 74 75 76 77 78

Observed Yt 7798 7406 8363 8460 9217 9316
Predicted by ARAR 8168 7196 7982 8284 9144 9465
Predicted by (6.5.8) 8441 7704 8549 8885 9843 10,279
Predicted by (6.5.9) 8345 7619 8356 8742 9795 10,179
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when the algorithm is applied to the already observed data. Both choices are available
in the ITSM option Forecasting>Holt-Winters.

Before illustrating the use of the Holt–Winters forecasting procedure, we discuss
the connection between the recursions (10.2.3) and (10.2.4) and the steady-state
solution of the Kalman filtering equations for a local linear trend model. Suppose {Yt}
follows the local linear structural model with observation equation

Yt = Mt + Wt

and state equation
[
Mt+1

Bt+1

]

=
[

1 1
0 1

] [
Mt

Bt

]

+
[
Vt

Ut

]

[see (9.2.4)–(9.2.7)]. Now define ân and b̂n to be the filtered estimates of Mn and Bn,
respectively, i.e.,

ân = Mn|n := PnMn,

b̂n = Bn|n := PnBn.

Using Problem 9.17 and the Kalman recursion (9.4.16), we find that
[
ân+1

b̂n+1

]

=
[
ân + b̂n

b̂n

]

+Δ−1
n ΩnG

′
(
Yn − ân − b̂n

)
, (10.2.7)

where G = [
1 0

]
. Assuming that Ωn=Ω1=[Ωij]2

i, j=1 is the steady-state solution
of (9.4.2) for this model, then Δn=Ω11 + σ 2

w for all n, so that (10.2.7) simplifies to
the equations

ân+1 = ân + b̂n + Ω11

Ω11 + σ 2
w

(
Yn − ân − b̂n

)
(10.2.8)

and

b̂n+1 = b̂n + Ω12

Ω11 + σ 2
w

(
Yn − ân − b̂n

)
. (10.2.9)

Solving (10.2.8) for
(
Yn − ân − b̂n

)
and substituting into (10.2.9), we find that

ân+1 = αYn+1 + (1 − α)
(
ân + b̂n

)
, (10.2.10)

b̂n+1 = β
(
ân+1 − ân

) + (1 − β)b̂n (10.2.11)

with α = Ω11/
(
Ω11 + σ 2

w

)
and β = Ω21/Ω11. These equations coincide with the

Holt–Winters recursions (10.2.3) and (10.2.4). Equations relating α and β to the
variances σ 2

u , σ
2
v , and σ

2
w can be found in Harvey (1990).

Example 10.2.1 To predict 24 values of the accidental deaths series using the Holt–Winters algorithm,
open the file DEATHS.TSM and select Forecasting>Holt-Winters. In the
resulting dialog box specify 24 for the number of predictors and check the box marked
Optimize coefficients for automatic selection of the smoothing coefficients
α and β. Click OK, and the forecasts will be plotted with the original data as shown in
Figure 10-2. Right-click on the graph and then Info to see the numerical values of
the predictors, their root mean squared errors, and the optimal values of α and β. The
predicted and observed values are shown in Table 10.2.

�
The root mean squared error

(√∑6
h=1(Y72+h−P72Y72+h)

2/6
)
for the nonseasonal

Holt–Winters forecasts is found to be 1143. Not surprisingly, since we have not taken
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seasonality into account, this is a much larger value than for the three sets of forecasts
shown in Table 10.1. In the next section we show how to modify the Holt–Winters
algorithm to allow for seasonality.

10.2.2 Holt–Winters and ARIMA Forecasting

The one-step forecasts obtained by exponential smoothing with parameter α (defined
by (1.5.7) and (10.2.1)) satisfy the relations

PnYn+1 = Yn − (1 − α)(Yn − Pn−1Yn), n ≥ 2. (10.2.12)

But these are the same relations satisfied by the large-sample minimum mean squared
error forecasts of the invertible ARIMA(0,1,1) process

Yt = Yt−1 + Zt − (1 − α)Zt−1, {Zt} ∼ WN
(
0, σ 2) . (10.2.13)

Forecasting by exponential smoothing with optimal α can therefore be viewed as fitting
a member of the two-parameter family of ARIMA processes (10.2.13) to the data and
using the corresponding large-sample forecast recursions initialized by P0Y1 = Y1. In
ITSM, the optimal α is found by minimizing the average squared error of the one-step
forecasts of the observed data Y2, . . . ,Yn, and the parameter σ 2 is estimated by this
average squared error. This algorithm could easily be modified to minimize other error
measures such as average absolute one-step error and average 12-step squared error.

In the same way it can be shown that Holt–Winters forecasting can be viewed as
fitting a member of the three-parameter family of ARIMA processes,

(1 − B)2Yt = Zt − (2 − α − αβ)Zt−1 + (1 − α)Zt−2, (10.2.14)

where
{
Zt

} ∼ WN(0, σ 2). The coefficients α and β are selected as described after
(10.2.6), and the estimate of σ 2 is the average squared error of the one-step forecasts
of Y3, . . . ,Yn obtained from the large-sample forecast recursions corresponding to
(10.2.14).

Figure 10-2
The data set DEATHS.TSM

with 24 values predicted by
the nonseasonal

Holt–Winters algorithm
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Table 10.2 Predicted and observed values of the accidental deaths series
for t = 73, . . . ,78 from the (nonseasonal) Holt–Winters algo-
rithm

t 73 74 75 76 77 78

Observed Yt 7798 7406 8363 8460 9217 9316
Predicted by HW 9281 9322 9363 9404 9445 9486

10.3 The Holt–Winters Seasonal Algorithm

10.3.1 The Algorithm

If the series Y1,Y2, . . . ,Yn contains not only trend, but also seasonality with period d
[as in the model (1.5.11)], then a further generalization of the forecast function (10.2.2)
that takes this into account is

PnYn+h = ân + b̂nh + ĉn+h, h = 1, 2, . . . , (10.3.1)

where ân, b̂n, and ĉn can be thought of as estimates of the “trend level” an, “trend
slope” bn, and “seasonal component” cn at time n. If k is the smallest integer such that
n + h − kd ≤ n, then we set

ĉn+h = ĉn+h−kd, h = 1, 2, . . . , (10.3.2)

while the values of âi, b̂i, and ĉi, i = d+2, . . . , n, are found from recursions analogous
to (10.2.3) and (10.2.4), namely,

ân+1 = α
(
Yn+1 − ĉn+1−d

) + (1 − α)(ân + b̂n
)
, (10.3.3)

b̂n+1 = β
(
ân+1 − ân

) + (1 − β)b̂n, (10.3.4)

and

ĉn+1 = γ (Yn+1 − ân+1)+ (1 − γ )ĉn+1−d, (10.3.5)

with initial conditions

âd+1 = Yd+1, (10.3.6)

b̂d+1 = (Yd+1 − Y1)/d, (10.3.7)

and

ĉi = Yi −
(
Y1 + b̂d+1(i − 1)

)
, i = 1, . . . , d + 1. (10.3.8)

Then (10.3.3)–(10.3.5) can be solved successively for âi, b̂i, and ĉi, i = d + 1, . . . , n,
and the predictors PnYn+h found from (10.3.1).

As in the nonseasonal case of Section 10.2, the forecasts depend on the parameters
α, β, and γ . These can either be prescribed arbitrarily (with values between 0 and 1) or
chosen in a more systematic way to minimize the sum of squares of the one-step errors∑n

i=d+2(Yi −Pi−1Yi)
2, obtained when the algorithm is applied to the already observed

data. Seasonal Holt–Winters forecasts can be computed by selecting the ITSM option
Forecasting>Seasonal Holt-Winters.

Example 10.3.1 As in Example 10.2.1, open the file DEATHS.TSM, but this time select Forecast-
ing>Seasonal Holt-Winters. Specify 24 for the number of predicted
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values required, 12 for the period of the seasonality, and check the box marked
Optimize Coefficients. Click OK, and the graph of the data and predicted
values shown in Figure 10-3 will appear. Right-click on the graph and then on Info
and you will see the numerical values of the predictors and the optimal values of the
coefficients α, β, and γ (minimizing the observed one-step average squared error∑72

i=14(Yi −Pi−1Yi)
2/59). Table 10.3 compares the predictors of Y73, . . . ,Y78 with the

corresponding observed values.
�

The root mean squared error (
√
∑6

h=1(Y72+h − P72Y72+h)2/6 ) for the seasonal
Holt–Winters forecasts is found to be 401. This is not as good as the value 253
achieved by the ARAR model for this example but is substantially better than the
values achieved by the nonseasonal Holt–Winters algorithm (1143) and the ARIMA
models (6.5.8) and (6.5.9) (583 and 501, respectively).

10.3.2 Holt–Winters Seasonal and ARIMA Forecasting

As in Section 10.2.2, the Holt–Winters seasonal recursions with seasonal period d
correspond to the large-sample forecast recursions of an ARIMA process, in this
case defined by

(1 − B)(1 − Bd)Yt = Zt + · · · + Zt−d+1 + γ (1 − α)(Zt−d − Zt−d−1)

−(2 − α − αβ)(Zt−1 + · · · + Zt−d)

+(1 − α)(Zt−2 + · · · + Zt−d−1),

where {Zt} ∼WN
(
0, σ 2

)
. Holt–Winters seasonal forecasting with optimal α, β, and γ

can therefore be viewed as fitting a member of this four-parameter family of ARIMA
models and using the corresponding large-sample forecast recursions.

Table 10.3 Predicted and observed values of the accidental deaths series for
t = 73, . . . ,78 from the seasonal Holt–Winters algorithm

t 73 74 75 76 77 78

Observed Yt 7798 7406 8363 8460 9217 9316
Predicted by HWS 8039 7077 7750 7941 8824 9329

10.4 Choosing a Forecasting Algorithm

Real data are rarely if ever generated by a simple mathematical model such as an
ARIMA process. Forecasting methods that are predicated on the assumption of such a
model are therefore not necessarily the best, even in the mean squared error sense. Nor
is the measurement of error in terms of mean squared error necessarily always the most
appropriate one in spite of its mathematical convenience. Even within the framework
of minimum mean squared-error forecasting, we may ask (for example) whether we
wish to minimize the one-step, two-step, or twelve-step mean squared error.
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Figure 10-3
The data set DEATHS.TSM

with 24 values predicted by
the seasonal Holt–Winters

algorithm
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The use of more heuristic algorithms such as those discussed in this chapter
is therefore well worth serious consideration in practical forecasting problems. But
how do we decide which method to use? A relatively simple solution to this problem,
given the availability of a substantial historical record, is to choose among competing
algorithms by comparing the relevant errors when the algorithms are applied to the
data already observed (e.g., by comparing the mean absolute percentage errors of the
12-step predictors of the historical data if 12-step prediction is of primary concern).

It is extremely difficult to make general theoretical statements about the relative
merits of the various techniques we have discussed (ARIMA modeling, exponential
smoothing, ARAR, and HW methods). For the series DEATHS.TSM we found on
the basis of average mean squared error for predicting the series at times 73–78
that the ARAR method was best, followed by the seasonal Holt–Winters algorithm,
and then the ARIMA models fitted in Chapter 6. This ordering is by no means
universal. For example, if we consider the natural logarithms {Yt} of the first 130
observations in the series WINE.TSM (Figure 1-1) and compare the average mean
squared errors of the forecasts of Y131, . . . ,Y142, we find (Problem 10.2 that anMA(12)
model fitted to the mean corrected differenced series {Yt − Yt−12} does better than
seasonal Holt–Winters (with period 12), which in turn does better than ARAR and
(not surprisingly) dramatically better than nonseasonal Holt–Winters. An interesting
empirical comparison of these and other methods applied to a variety of economic time
series is contained in Makridakis et al. (1984).

The versions of the Holt–Winters algorithms we have discussed in Sections 10.2
and 10.3 are referred to as “additive,” since the seasonal and trend components enter the
forecasting function in an additive manner. “Multiplicative” versions of the algorithms
can also be constructed to deal directly with processes of the form

Yt = mtstZt, (10.4.1)

where mt, st, and Zt are trend, seasonal, and noise factors, respectively (see, e.g.,
Makridakis et al. 1997). An alternative approach (provided that Yt > 0 for all t) is
to apply the linear Holt–Winters algorithms to {lnYt} (as in the case of WINE.TSM in
the preceding paragraph). Because of the rather general memory shortening permitted
by the ARAR algorithm, it gives reasonable results when applied directly to series
of the form (10.4.1), even without preliminary transformations. In particular, if we
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Figure 10-4
The first 132 values of the

data set AIRPASS.TSM
and predictors of the last

12 values obtained by direct
application of the ARAR

algorithm
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consider the first 132 observations in the series AIRPASS.TSM and apply the ARAR
algorithm to predict the last 12 values in the series, we obtain (Problem 10.4) an
observed root mean squared error of 18.22. On the other hand if we use the same
data take logarithms, difference at lag 12, subtract the mean and then fit an AR(13)
model by maximum likelihood using ITSM and use it to predict the last 12 values, we
obtain an observed root mean squared error of 21.17. The data and predicted values
from the ARAR algorithm are shown in Figure 10-4.

Problems

10.1 Establish the formula (10.1.8) for the mean squared error of the h-step forecast
based on the ARAR algorithm.

10.2 Let {X1, . . . ,X142} denote the data in the file WINE.TSM and let {Y1, . . . ,Y142}
denote their natural logarithms. Denote by m the sample mean of the differenced
series {Yt − Yt−12, t = 13, . . . , 130}.
(a) Use the program ITSM to find the maximum likelihood MA(12) model for

the differenced and mean-corrected series {Yt −Yt−12 −m, t = 13, . . . , 130}.
(b) Use the model in (a) to compute forecasts of {X131, . . . ,X142}.
(c) Tabulate the forecast errors {Xt − P130 Xt, t = 131, . . . , 142}.
(d) Compute the average squared error for the 12 forecasts.
(e) Repeat steps (b), (c), and (d) for the corresponding forecasts obtained by

applying the ARAR algorithm to the series {Xt, t = 1, . . . , 130}.
(f) Repeat steps (b), (c), and (d) for the corresponding forecasts obtained by

applying the seasonal Holt–Winters algorithm (with period 12) to the
logged data {Yt, t = 1,. . . ,130}. (Open the file WINE.TSM, select
Transform>Box-Coxwith parameter λ = 0, then select Forecasting>
Seasonal Holt-Winters, and check Apply to original data
in the dialog box.)
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(g) Repeat steps (b), (c), and (d) for the corresponding forecasts obtained by
applying the nonseasonal Holt–Winters algorithm to the logged data {Yt, t =
1, . . . , 130}. (The procedure is analogous to that described in part (f).)

(h) Compare the average squared errors obtained by the four methods.

10.3 In equations (10.2.10) and (10.2.11), show that α=Ω11/
(
Ω11 + σ 2

w

)
and

β=Ω21/Ω11.

10.4 Verify the assertions made in the last paragraph of Section 10.4, comparing the
forecasts of the last 12 values of the series AIRPASS.TSM obtained from the
ARAR algorithm (with no log transformation) and the corresponding forecasts
obtained by taking logarithms of the original series, then differencing at lag 12,
mean-correcting, and fitting an AR(13) model to the transformed series.
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11.1 Transfer Function Models
11.2 Intervention Analysis
11.3 Nonlinear Models
11.4 Long-Memory Models
11.5 Continuous-Time ARMA Processes

In this chapter we touch on a variety of topics of special interest. In Section 11.1
we consider transfer function models, designed to exploit for predictive purposes the
relationship between two time series when one acts as a leading indicator for the other.
Section 11.2 deals with intervention analysis, which allows for possible changes in
the mechanism generating a time series, causing it to have different properties over
different time intervals. In Section 11.3 we introduce the very fast growing area of
nonlinear time series analysis, and in Section 11.4 we discuss fractionally integrated
ARMA processes, sometimes called “long-memory” processes on account of the slow
rate of convergence of their autocorrelation functions to zero as the lag increases. In
Section 11.5 we discuss continuous-time ARMA processes which, for continuously
evolving processes, play a role analogous to that of ARMA processes in discrete time.
Besides being of interest in their own right, they have proved a useful class of models
in the representation of financial time series and in the modeling of irregularly spaced
data.

11.1 Transfer Function Models

In this section we consider the problem of estimating the transfer function of a linear
filter when the output includes added uncorrelated noise. Suppose that {Xt1} and {Xt2}
are, respectively, the input and output of the transfer function model

Xt2 =
∞∑

j=0

τj Xt−j, 1 + Nt, (11.1.1)
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where T = {τj, j = 0, 1, . . .} is a causal time-invariant linear filter and {Nt} is a
zero-mean stationary process, uncorrelated with the input process {Xt1}. We further
assume that {Xt1} is a zero-mean stationary time series. Then the bivariate process
{(Xt1,Xt2)

′} is also stationary. Multiplying each side of (11.1.1) by Xt−k,1 and then
taking expectations gives the equation

γ21(k) =
∞∑

j=0

τjγ11(k − j). (11.1.2)

Equation (11.1.2) simplifies a great deal if the input process happens to be white
noise. For example, if {Xt1} ∼ WN(0, σ 2

1 ), then we can immediately identify tk from
(11.1.2) as

τk = γ21(k)/σ
2
1 . (11.1.3)

This observation suggests that “prewhitening” of the input process might simplify the
identification of an appropriate transfer function model and at the same time provide
simple preliminary estimates of the coefficients tk.

If {Xt1} can be represented as an invertible ARMA(p, q) process

φ(B)Xt1 = θ(B)Zt, {Zt} ∼ WN
(
0, σ 2

Z

)
, (11.1.4)

then application of the filter π(B) = φ(B)θ−1(B) to {Xt1} will produce the whitened
series {Zt}. Now applying the operator π(B) to each side of (11.1.1) and letting Yt =
π(B)Xt2, we obtain the relation

Yt =
∞∑

j=0

τjZt−j + N ′
t,

where

N ′
t = π(B)Nt,

and {N ′
t} is a zero-mean stationary process, uncorrelated with {Zt}. The same arguments

that led to (11.1.3) therefore yield the equation

τj = ρYZ(j)σY/σZ, (11.1.5)

where ρYZ is the cross-correlation function of {Yt} and {Zt}, σ 2
Z =Var(Zt), and

σ 2
Y =Var(Yt).

Given the observations {(Xt1,Xt2)
′, t = 1, . . . , n}, the results of the previous

paragraph suggest the following procedure for estimating {τj} and analyzing the noise
{Nt} in the model (11.1.1):

1. Fit an ARMAmodel to {Xt1} and file the residuals (Ẑ1, . . . , Ẑn) (using the Export
button in ITSM to copy them to the clipboard and then pasting them into the first
column of an Excel file). Let φ̂ and θ̂ denote the maximum likelihood estimates
of the autoregressive and moving-average parameters and let σ̂ 2

Z
be the maximum

likelihood estimate of the variance of {Zt}.
2. Apply the operator π̂(B) = φ̂(B)θ̂−1(B) to {Xt2} to obtain the series

(
Ŷ1, . . . , Ŷn

)
.

(After fitting the ARMA model as in Step 1 above, highlight the window contain-
ing the graph of {Xt} and replace {Xt} by {Yt} using the option File>Import.The
residuals are then automatically replaced by the residuals of {Yt} under the model
already fitted to {Xt}.) Export the new residuals to the clipboard, paste them into
the second column of the Excel file created in Step 1, and save this as a text file,
FNAME.TSM. The file FNAME.TSM then contains the bivariate series {(Zt,Yt)}.
Let σ̂ 2

Y
denote the sample variance of Ŷt.
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3. Compute the sample auto- and cross-correlation functions of {Zt} and {Yt} by
opening the bivariate project FNAME.TSM in ITSM and clicking on the second
yellow button at the top of the ITSM window. Comparison of ρ̂YZ (h) with the
bounds ± 1.96n−1/2 gives a preliminary indication of the lags h at which ρYZ (h)
is significantly different from zero. A more refined check can be carried out by
using Bartlett’s formula in Section 8.3.4 for the asymptotic variance of ρ̂YZ(h).
Under the assumptions that

{
Ẑt

} ∼ WN
(
0, σ̂2

Z

)
and

{(
Ŷt, Ẑt

)′}
is a stationary

Gaussian process,

nVar(ρ̂YZ(h)) ∼ 1 − ρ2
YZ(h)

[

1.5 −
∞∑

k=−∞
(ρ2

YZ(k)+ ρ2
YY(k)/2)

]

+
∞∑

k=−∞

[
ρYZ(h + k)ρYZ(h − k)− 2ρYZ(h)ρYZ(k + h)ρ2

YY(k)
]
.

In order to check the hypothesis H0 that ρYZ(h) = 0, h /∈ [a, b], where a and b
are integers, we note from Corollary 8.3.1 that under H0,

Var
(
ρ̂YZ(h)

) ∼ n−1 for h /∈ [a, b].
We can therefore check the hypothesis H0 by comparing ρ̂YZ, h /∈ [a, b], with the
bounds ± 1.96n−1/2. Observe that ρZY(h) should be zero for h > 0 if the model
(11.1.1) is valid.

4. Preliminary estimates of τh for the lags h at which ρ̂YZ(h) is significantly different
from zero are

τ̂h = ρ̂YZ(h)σ̂Y/σ̂Z.

For other values of h the preliminary estimates are τ̂h = 0. The numerical values
of the cross-correlations ρ̂YZ(h) are found by right-clicking on the graphs of the
sample correlations plotted in Step 3 and then on Info. The values of σ̂Z and σ̂Y
are found by doing the same with the graphs of the series themselves. Let m ≥ 0
be the largest value of j such that τ̂j is nonzero and let b ≥ 0 be the smallest such
value. Then b is known as the delay parameter of the filter {τ̂j}. If m is very large
and if the coefficients

{
τ̂j
}
are approximately related by difference equations of the

form

τ̂j − v1τ̂j−1 − · · · − vpτ̂j−p = 0, j ≥ b + p,

then T̂(B) = ∑m
j=b τ̂jB

j can be represented approximately, using fewer parame-
ters, as

T̂(B) = w0(1 − v1B − · · · − vpBp)
−1Bb.

In particular, if τ̂j = 0, j < b, and τ̂j = w0v
j−b
1 , j ≥ b, then

T̂(B) = w0(1 − v1B)
−1Bb. (11.1.6)

Box and Jenkins (1976) recommend choosing T̂(B) to be a ratio of two poly-
nomials. However, the degrees of the polynomials are often difficult to estimate
from

{
τ̂j
}
. The primary objective at this stage is to find a parametric function

that provides an adequate approximation to T̂(B) without introducing too large
a number of parameters. If T̂(B) is represented as T̂(B) = Bbw(B)v−1(B) =
Bb

(
w0 + w1B + · · · + wqBq

) (
1 − v1B − · · · − vpBp

)−1
with v(z) �= 0 for |z| ≤ 1,

then we define m = max(q + b, p).
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5. The noise sequence {Nt, t = m + 1, . . . , n} is estimated as

N̂t = Xt2 − T̂(B)Xt1.

(We set N̂t = 0, t ≤ m, in order to compute N̂t, t > m = max(b + q, p)). The cal-
culations are done in ITSM by opening the bivariate file containing {(Xt1,Xt2)},
selecting Transfer>Specify Model, and entering the preliminary model
found in Step 4. Click on the fourth green button to see a graph of the residuals
{Nt}. These should then be filed as, say, NOISE.TSM.

6. Preliminary identification of a suitable model for the noise sequence is carried
out by fitting a causal invertible ARMA model

φ(N)(B)Nt = θ(N)(B)Wt, {Wt} ∼ WN
(
0, σ 2

W

)
, (11.1.7)

to the estimated noise N̂m+1, . . . , N̂n filed as NOISE.TSM in Step 5.
7. At this stage we have the preliminary model

φ(N)(B)v(B)Xt2 = Bbφ(N)(B)w(B)Xt1 + θ(N)(B)v(B)Wt,

where T̂(B) = Bbw(B)v−1(B) as in step (4). For this model we can compute
Ŵt

(
w, v,φ(N),θ(N)

)
, t > m∗ = max(p2 + p, b + p2 + q), by setting Ŵt = 0

for t ≤ m∗. The parameters w, v,φ(N), and θ(N) can then be reestimated (more
efficiently) by minimizing the sum of squares

n∑

t=m∗+1

Ŵ2
t

(
w, v,φ(N),θ(N)

)
.

(The calculations are performed in ITSM by opening the bivariate project {(Xt1,

Xt2)}, selecting Transfer>Specify model, entering the preliminary model,
and clicking OK. Then choose Transfer>Estimation, click OK, and the least
squares estimates of the parameters will be computed. Pressing the fourth green
button at the top of the screen will give a graph of the estimated residuals Ŵt.)

8. To test for goodness of fit, the estimated residuals
{
Ŵt, t > m∗} and

{
Ẑt.t > m∗}

should be filed as a bivariate series and the auto- and cross correlations compared
with the bounds ±1.96/

√
n in order to check the hypothesis that the two series

are uncorrelated white noise sequences. Alternative models can be compared
using the AICC value that is printed with the estimated parameters in Step 7.
It is computed from the exact Gaussian likelihood, which is computed using a
state-space representation of the model, described in Brockwell and Davis (1991),
Section 13.1.

Example 11.1.1 Sales with a Leading Indicator

In this example we fit a transfer function model to the bivariate time series of
Example 8.1.2. Let

Xt1 = (1 − B)Yt1 − 0.0228, t = 2, . . . , 150,

Xt2 = (1 − B)Yt2 − 0.420, t = 2, . . . , 150,

where {Yt1} and {Yt2}, t = 1, . . . , 150, are the leading indicator and sales data,
respectively. It was found in Example 8.1.2 that {Xt1} and {Xt2} can be modeled as
low-order zero-mean ARMA processes. In particular, we fitted the model

Xt1 = (1 − 0.474B)Zt, {Zt} ∼ WN(0, 0.0779),

to the series {Xt1}. We can therefore whiten the series by application of the filter
π̂ (B) = (1 − 0.474B)−1. Applying π̂(B) to both {Xt1} and {Xt2} we obtain
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Ẑt = (1 − 0.474B)−1Xt1, σ̂ 2
Z = 0.0779,

Ŷt = (1 − 0.474B)−1Xt2, σ̂ 2
Y = 4.0217.

These calculations and the filing of the series
{
Ẑt

}
and

{
Ŷt

}
were carried out using

ITSM as described in steps (1) and (2). Their sample auto- and cross-correlations,
found as described in step (3), are shown in Figure 11-1. The cross-correlations
ρ̂ZY(h) (top right) and ρ̂YZ(h) (bottom left), when compared with the upper and lower
bounds ±1.96(149)−1/2 = ±0.161, strongly suggest a transfer function model for
{Xt2} in terms of {Xt1} with delay parameter 3. Since τ̂j = ρ̂YZ(j)σ̂Y/σ̂Z is decreasing
approximately geometrically for j ≥ 3, we take T(B) to have the form (11.1.6), i.e.,

T(B) = w0(1 − v1B)
−1B3.

The preliminary estimates of w0 and v1 are ŵ0 = τ̂3 = 4.86 and v̂1 = τ̂4/τ̂3 = 0.698, the
coefficients τj being estimated as described in step (4). The estimated noise sequence
is determined and filed using ITSM as described in step (5). It satisfies the equations

N̂t = Xt2 − 4.86B3(1 − 0.698B)−1Xt1, t = 5, 6, . . . , 150.

Analysis of this univariate series with ITSM gives the MA(1) model

Nt = (1 − 0.364B)Wt, {Wt} ∼ WN(0, 0.0590).

Substituting these preliminary noise and transfer function models into equa-
tion (11.1.1) then gives

Xt2 = 4.86B3(1−0.698B)−1Xt1+(1−0.364B)Wt, {Wt} ∼ WN(0, 0.0590).

Now minimizing the sum of squares (11.1.7) with respect to the parameters
(
w0, v1,

θ
(N)
1

)
as described in step (7), we obtain the least squares model

Xt2 = 4.717B3(1 − 0.724B)−1Xt1 + (1 − 0.582B)Wt, (11.1.8)

where {Wt} ∼ WN(0, 0.0486) and

Xt1 = (1 − 0.474B)Zt, {Zt} ∼ WN(0, 0.0779).

Notice the reduced white noise variance of {Wt} in the least squares model as compared
with the preliminary model.

The sample auto- and cross-correlation functions of the series Ẑt and Ŵt,
t = 5, . . . , 150, are shown in Figure 11-2. All of the correlations lie between the
bounds
±1.96/

√
144, supporting the assumption underlying the fitted model that the residuals

are uncorrelated white noise sequences.
�

11.1.1 Prediction Based on a Transfer Function Model

When predicting Xn+h,2 on the basis of the transfer function model defined by (11.1.1),
(11.1.4), and (11.1.7), with observations of Xt1 and Xt2, t = 1, . . . , n, our aim is to
find the linear combination of 1,X11, . . . ,Xn1,X12, . . . ,Xn2 that predicts Xn+h,2 with
minimum mean squared error. The exact solution of this problem can be found with
the help of the Kalman recursions (see Brockwell and Davis (1991), Section 13.1 for
details). The program ITSM uses these recursions to compute the predictors and their
mean squared errors.

In order to provide a little more insight, we give here the predictors P̃nXn+h

and mean squared errors based on infinitely many past observations Xt1 and Xt2,
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−∞ < t ≤ n. These predictors and their mean squared errors will be close to those
based on Xt1 and Xt2, 1 ≤ t ≤ n, if n is sufficiently large.

The transfer function model defined by (11.1.1), (11.1.4), and (11.1.7) can be
rewritten as

Xt2 = T(B)Xt1 + β(B)Wt, (11.1.9)

Xt1 = θ(B)φ−1(B)Zt, (11.1.10)

where β(B) = θ(N)(B)/φ(N)(B). Eliminating Xt1 gives

Xt2 =
∞∑

j=0

αjZt−j +
∞∑

j=0

βjWt−j, (11.1.11)

where α(B) = T(B)θ(B)/φ(B).
Noting that each limit of linear combinations of {Xt1,Xt2,−∞ < t ≤ n} is a

limit of linear combinations of {Zt,Wt,−∞ < t ≤ n} and conversely and that {Zt} and
{Wt} are uncorrelated, we see at once from (11.1.11) that

P̃nXn+h,2 =
∞∑

j=h

αjZn+h−j +
∞∑

j=h

βjWn+h−j. (11.1.12)

Setting t = n + h in (11.1.11) and subtracting (11.1.12) gives the mean squared error

E
(
Xn+h,2 − P̃nXn+h,2

)2 = σ 2
Z

h−1∑

j=0

α2
j + σ 2

W

h−1∑

j=0

β2
j . (11.1.13)

To compute the predictors P̃nXn+h,2 we proceed as follows. Rewrite (11.1.9) as

A(B)Xt2 = BbU(B)Xt1 + V(B)Wt, (11.1.14)

Figure 11-1
The sample correlation

functions ρ̂ij(h), of Example

11.1.1. Series 1 is {Ẑt} and
Series 2 is {Ŷt}
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Figure 11-2
The sample correlation

functions of the estimated
residuals from the

model fitted in
Example 11.1.1. Series 1 is

{Ẑt} and Series 2 is {Ŵt}

0
−1.00

1.00
Series 1

−.80

.80

−.60

.60

−.40

.40

−.20

.20

.00

2 4 6 8 10 12 14 16 18 20 0
−1.00

1.00
Series 1 × Series 2

Series 2 × Series 1

−.80

.80

−.60

.60

−.40

.40

−.20

.20

.00

2 4 6 8 10 12 14 16 18 20

0
−1.00

1.00
Series 2

−.80

.80

−.60

.60

−.40

.40

−.20

.20

.00

2 4 6 8 10 12 14 16 18 200
−1.00

1.00

−.80

.80

−.60

.60

−.40

.40

−.20

.20

.00

2 4 6 8 10 12 14 16 18 20

where A, U, and V are polynomials of the form

A(B) = 1 − A1B − · · · − AaB
a,

U(B) = U0 + U1B + · · · + UuB
u,

V(B) = 1 + V1B + · · · + VvB
v.

Applying the operator P̃n to equation (11.1.14) with t = n + h, we obtain

P̃nXn+h,2 =
a∑

j=1

AjP̃nXn+h−j,2 +
u∑

j=0

UjP̃nXn+h−b−j,1 +
v∑

j=h

VjWn+h−j, (11.1.15)

where the last sum is zero if h > v.
Since {Xt1} is uncorrelated with {Wt}, the predictors appearing in the second sum in

(11.1.15) are therefore obtained by predicting the univariate series {Xt1} as described in
Section 3.3 using the model (11.1.10). In keeping with our assumption that n is large,
we can replace P̃nXj1 for each j by the finite-past predictor obtained from the program
ITSM. The values Wj, j ≤ n, are replaced by their estimated values Ŵj from the least
squares estimation in step (7) of the modeling procedure.

Equation (11.1.15) can now be solved recursively for the predictors P̃nXn+1,2,
P̃nXn+2,2, P̃nXn+3,2, . . . .

Example 11.1.2 Sales with a Leading Indicator

Applying the preceding results to the series {Xt1,Xt2, 2 ≤ t ≤ 150} of Example 11.1.1,
and using the values X148,1 = −0.093,X150,2 = 0.08, Ŵ150 = −0.0706, Ŵ149 =
0.1449, we find from (11.1.8) and (11.1.15) that

P̃150X151,2 = 0.724X150,2 + 4.717X148,1 − 1.306W150 + 0.421W149 = −0.228
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and, using the value X149,1 = 0.237, that

P̃150X152,2 = 0.724P̃150X151,2 + 4.717X149,1 + 0.421W150 = 0.923.

In terms of the original sales data {Yt2} we have Y149,2 = 262.7 and

Yt2 = Yt−1,2 + Xt2 + 0.420.

Hence the predictors of actual sales are

P∗
150Y151, 2 = 262.70 − 0.228 + 0.420 = 262.89,

P∗
150Y152, 2 = 262.89 + 0.923 + 0.420 = 264.23,

where P∗
149 is based on {1,Y11,Y12,Xs1,Xs2,−∞ < s ≤ 150}, and it is assumed that

Y11 and Y12 are uncorrelated with {Xs1} and with {Xs2}. The predicted values are in
close agreement with those based on the finite number of available observations that
are computed by ITSM. Since our model for the sales data is

(1−B)Yt2 = 0.420+4.717B3(1−0.474B)(1−0.724B)−1Zt+(1−0.582B)Wt,

it can be shown, using an argument analogous to that which gave (11.1.13), that the
mean squared errors are given by

E(Y150+h,2 − P150Y150+h,2)
2 = σ 2

Z

h−1∑

j=0

α∗2
j + σ 2

W

h−1∑

j=0

β∗2
j ,

where
∞∑

j=0

α∗
j z

j = 4.717z3(1 − 0.474z)(1 − 0.724z)−1(1 − z)−1

and
∞∑

j=0

β∗
j z

j = (1 − 0.582z)(1 − z)−1.

For h = 1 and 2 we obtain

E(Y151, 2 − P∗
150Y151, 2)

2 = 0.0486,

E(Y152, 2 − P∗
150Y152, 2)

2 = 0.0570,

in close agreement with the finite-past mean squared errors obtained by ITSM.
It is interesting to examine the improvement obtained by using the transfer

function model rather than fitting a univariate model to the sales data alone. If we adopt
the latter course, we obtain the model

Xt2 − 0.249Xt−1, 2 − 0.199Xt−2,2 = Ut,

where {Ut} ∼ WN(0, 1.794) and Xt2 = Yt2 − Yt−1,2 − 0.420. The corresponding
predictors of Y151, 2 and Y152, 2 are easily found from the program ITSM to be 263.14
and 263.58 with mean squared errors 1.794 and 4.593, respectively. These mean
squared errors are much worse than those obtained using the transfer function model.

�
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11.2 Intervention Analysis

During the period for which a time series is observed, it is sometimes the case that a
change occurs that affects the level of the series. A change in the tax laws may, for
example, have a continuing effect on the daily closing prices of shares on the stock
market. In the same way construction of a dam on a river may have a dramatic effect
on the time series of streamflows below the dam. In the following we shall assume that
the time T at which the change (or “intervention”) occurs is known.

To account for such changes, Box and Tiao (1975) introduced a model for
intervention analysis that has the same form as the transfer function model

Yt =
∞∑

j=0

τjXt−j + Nt, (11.2.1)

except that the input series {Xt} is not a random series but a deterministic function of t.
It is clear from (11.2.1) that

∑∞
j=0 τjXt−j is then the mean of Yt. The function {Xt} and

the coefficients {τj} are therefore chosen in such a way that the changing level of the
observations of {Yt} is well represented by the sequence

∑∞
j=0 τjXt−j. For a series {Yt}

with EYt = 0 for t ≤ T and EYt → 0 as t → ∞, a suitable input series is

Xt = It(T) =
{

1 if t = T,

0 if t �= T.
(11.2.2)

For a series {Yt} with EYt = 0 for t ≤ T and EYt → a �= 0 as t → ∞, a suitable input
series is

Xt = Ht(T) =
∞∑

k=T

It(k) =
{

1 if t ≥ T,

0 if t < T.
(11.2.3)

(Other deterministic input functions {Xt} can also be used, for example when inter-
ventions occur at more than one time.) The function

{
Xt

}
having been selected by

inspection of the data, the determination of the coefficients {τj} in (11.2.1) then reduces
to a regression problem in which the errors {Nt} constitute an ARMA process. This
problem can be solved using the program ITSM as described below.

The goal of intervention analysis is to estimate the effect of the intervention
as indicated by the term

∑∞
j=0 τjXt−j and to use the resulting model (11.2.1) for

forecasting. For example, Wichern and Jones (1978) used intervention analysis to
investigate the effect of the American Dental Association’s endorsement of Crest
toothpaste on Crest’s market share. Other applications of intervention analysis can be
found in Box and Tiao (1975), Atkins (1979), and Bhattacharyya and Layton (1979). A
more general approach can also be found in West and Harrison (1989), Harvey (1990),
and Pole et al. (1994).

As in the case of transfer function modeling, once {Xt} has been chosen (usually as
either (11.2.2) or (11.2.3)), estimation of the linear filter {τj} in (11.2.1) is simplified
by approximating the operator T(B) = ∑∞

j=0 τjB
j with a rational operator of the

form

T(B) = BbW(B)

V(B)
, (11.2.4)

where b is the delay parameter and W(B) and V(B) are polynomials of the form

W(B) = w0 + w1B + · · · + wqB
q
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and

V(B) = 1 − v1B − · · · − vpB
p.

By suitable choice of the parameters b, q, p and the coefficients wi and vj, the
intervention term T(B)Xt can made to take a great variety of functional forms.

For example, if T(B) = wB2/(1 − vB) and Xt = It(T) as in (11.2.2), the
resulting intervention term is

wB2

(1 − vB)
It(T) =

∞∑

j=0

vjwIt−j−2(T) =
∞∑

j=0

vjwIt(T + 2 + j),

a series of pulses of sizes vjw at times T + 2 + j, j = 0, 1, 2, . . . . If |v| < 1, the effect
of the intervention is to add a series of pulses with size w at time T + 2, decreasing to
zero at a geometric rate depending on v as t → ∞. Similarly, with Xt = Ht(T) as in
(11.2.3),

wB2

(1 − vB)
Ht(T) =

∞∑

j=0

vjwHt−j−2(T) =
∞∑

j=0

(1 + v + · · · + vj)wIt(T + 2 + j),

a series of pulses of sizes (1 + v + · · · + vj)w at times T + 2 + j, j = 0, 1, 2, . . . .
If |v| < 1, the effect of the intervention is to bring about a shift in level of the series
Xt, the size of the shift converging to w/(1 − v) as t → ∞.

An appropriate form for Xt and possible values of b, q, and p having been chosen
by inspection of the data, the estimation of the parameters in (11.2.4) and the fitting
of the model for {Nt} can be carried out using steps (6)–(8) of the transfer function
modeling procedure described in Section 11.1. Start with step (7) and assume that
{Nt} is white noise to get preliminary estimates of the coefficients wi and vj by least
squares. The residuals are filed and used as estimates of {Nt}. Then go to step (6) and
continue exactly as for transfer function modeling with input series {Xt} and output
series {Yt}.

Figure 11-3
The differenced series

of Example 11.2.1
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Example 11.2.1 Seat-Belt Legislation

In this example we reanalyze the seat-belt legislation data, SBL.TSMof Example 6.6.3
from the point of view of intervention analysis. For this purpose the bivariate series
{(ft,Yt)} consisting of the series filed as SBLIN.TSM and SBL.TSM respectively
has been saved in the file SBL2.TSM. The input series {ft} is the deterministic step-
function defined in Example 6.6.3 and Yt is the number of deaths and serious injuries
on UK roads in month t, t = 1, . . . , 120, corresponding to the 10 years beginning with
January 1975.

To account for the seat-belt legislation, we use the same model (6.6.15) as in
Example 6.6.3 and, because of the apparent non-stationarity of the residuals, we
again difference both {ft} and {Yt} at lag 12 to obtain the model (6.6.15), i.e.,

Xt = bgt + Nt, (11.2.4)

where Xt = ∇12Yt, gt = ∇12ft, and {Nt} is a zero-mean stationary time series. This is
a particularly simple example of the general intervention model (11.2.1) for the series
{Xt} with intervention {bgt}. Our aim is to find a suitable model for {Nt} and at the
same time to estimate b, taking into account the autocorrelation function of the model
for {Nt}. To apply intervention analysis to this problem using ITSM, we proceed as
follows:

(1) Open the bivariate project SBL2.TSM and difference the series at lag 12.
(2) Select Transfer>Specify model and you will see that the default input

and noise are white noise, while the default transfer model relating the input gt
to the output Xt is Xt = bgt with b = 1. Click OK, leaving these settings as
they are. The input model is irrelevant for intervention analysis and estimation of
the transfer function with the default noise model will give us the ordinary least
squares estimate of b in the model (10.2.4), with the residuals providing estimates
of Nt. Now select Transfer>Estimation and click OK. You will then see the
estimated value −346.9 for b. Finally, press the red Export button (top right in the
ITSM window) to export the residuals (estimated values of Nt) to a file and call
it, say, NOISE.TSM.

(3) Without closing the bivariate project, open the univariate project NOISE.TSM.
The sample ACF and PACF of the series suggests either an MA(13) or AR(13)
model. Fitting AR and MA models of order up to 13 (with no mean-correction)
using the option Model>Estimation>Autofit gives an MA(12) model as
the minimum AICC fit.

(4) Return to the bivariate project by highlighting the window labeled SBL2.TSM
and select Transfer>Specify model. The transfer model will now show
the estimated value −346.9 for b. Click on the Residual Model tab, enter 12
for theMAorder and click OK. Select Transfer>Estimationand again click
OK. The parameters in both the noise and transfer models will then be estimated
and printed on the screen. Repeating the minimization with decreasing step-sizes,
0.1, 0.01 and then 0.001, gives the model,

Xt = −362.5gt + Nt,

where Nt = Wt+0.207Wt−1+0.311Wt−2+0.105Wt−3+0.040Wt−4+0.194Wt−5+
0.100Wt−6 + 0.299Wt−7+0.080Wt−8 + 0.125Wt−9 + 0.210Wt−10+0.109Wt−11+
0.501Wt−12, and {Wt} ∼ WN(0,17289). File the residuals (which are now esti-
mates of {Wt}) as RES.TSM.The differenced series {Xt} and the fitted intervention
term, −362.5gt , are shown in Figure 11-3.
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Figure 11-4
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(5) Open the univariate project RES.TSM and apply the usual tests for ran-
domness by selecting Statistics>Residual Analysis. The tests are
all passed at level 0.05, leading us to conclude that the model found in step (4) is
satisfactory. The sample ACF of the residuals is shown in Figure 11-4.

�

11.3 Nonlinear Models

A time series of the form

Xt =
∞∑

j=0

ψjZt−j, {Zt} ∼ IID
(
0, σ 2

)
, (11.3.1)

where Zt is expressible as a mean square limit of linear combinations of {Xs,∞ < s ≤
t}, has the property that the best mean square predictor E(Xt+h|Xs,−∞ < s ≤ t) and
the best linear predictor P̃tXt+h in terms of {Xs,−∞ < s ≤ t} are identical. It can be
shown that if iid is replaced by WN in (11.3.1), then the two predictors are identical if
and only if {Zt} is a martingale difference sequence relative to {Xt}, i.e., if and only
if E(Zt|Xs,−∞ < s < t) = 0 for all t.

The Wold decomposition (Section 2.6) ensures that every purely nondeterministic
stationary process can be expressed in the form (11.3.1) with {Zt} ∼ WN

(
0, σ 2

)
. The

process {Zt} in the Wold decomposition, however, is generally not an iid sequence,
and the best mean square predictor of Xt+ h may be quite different from the best linear
predictor.

In the case where {Xt} is a purely nondeterministic Gaussian stationary process,
the sequence {Zt} in the Wold decomposition is Gaussian and therefore iid. Every
stationary purely nondeterministic Gaussian process can therefore be generated by
applying a causal linear filter to an iid Gaussian sequence. We shall therefore refer to
such a process as a Gaussian linear process.
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In this section we shall use the term linear process to mean a process {Xt} of the
form (11.3.1). This is a more restrictive use of the term than in Definition 2.2.1.

11.3.1 Deviations from Linearity

Many of the time series encountered in practice exhibit characteristics not shown by
linear processes, and so to obtain good models and predictors it is necessary to look to
models more general than those satisfying (11.3.1) with iid noise. As indicated above,
this will mean that the minimum mean squared error predictors are not, in general,
linear functions of the past observations.

Gaussian linear processes have a number of properties that are often found to
be violated by observed time series. The former are reversible in the sense that(
Xt1, · · · ,Xtn

)′
has the same distribution as

(
Xtn, · · · ,Xt1

)′
. (Except in a few special

cases, ARMA processes are reversible if and only if they are Gaussian (Breidt and
Davis 1992).) Deviations from this property by observed time series are suggested by
sample paths that rise to their maxima and fall away at different rates (see, for exam-
ple, the sunspot numbers filed as SUNSPOTS.TSM). Bursts of outlying values are
frequently observed in practical time series and are seen also in the sample paths of
nonlinear (and infinite-variance) models. They are rarely seen, however, in the sample
paths of Gaussian linear processes. Other characteristics suggesting deviation from
a Gaussian linear model are discussed by Tong (1990).

Many observed time series, particularly financial time series, exhibit periods
during which they are “less predictable” (or “more volatile”), depending on the past
history of the series. This dependence of the predictability (i.e., the size of the predic-
tion mean squared error) on the past of the series cannot be modeled with a linear time
series, since for a linear process theminimum h-stepmean squared error is independent
of the past history. Linear models thus fail to take account of the possibility that
certain past histories may permit more accurate forecasting than others, and cannot
identify the circumstances under which more accurate forecasts can be expected.
Nonlinear models, on the other hand, do allow for this. The ARCH and GARCH
models considered in Section 7.2 are in fact constructed around the dependence of
the conditional variance of the process on its past history.

11.3.2 Chaotic Deterministic Sequences

To distinguish between linear and nonlinear processes, we need to be able to decide in
particular when a white noise sequence is also iid. Sequences generated by nonlinear
deterministic difference equations can exhibit sample correlation functions that are
very close to those of samples from awhite noise sequence. However, the deterministic
nature of the recursions implies the strongest possible dependence between successive
observations. For example, the celebrated logistic equation (see May, 1976, and Tong
1990) defines a sequence {xn}, for any given x0, via the equations

xn = 4xn−1(1 − xn−1), 0 < x0 < 1.

The values of xn are, for even moderately large values of n, extremely sensitive
to small changes in x0. This is clear from the fact that the sequence can be expressed
explicitly as

xn = sin2 (2narcsin
(√

x0
))
, n = 0, 1, 2, . . . .

A very small change δ in arcsin
(√

x0
)
leads to a change 2nδ in the argument of the sine

function defining xn. If we generate a sequence numerically, the generated sequence
will, for most values of x0 in the interval (0,1), be random in appearance, with a
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Figure 11-5
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Figure 11-6
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sample autocorrelation function similar to that of a sample from white noise. The
data file CHAOS.TSM contains the sequence x1, . . . , x200 (correct to nine decimal
places) generated by the logistic equation with x0 = π/10. The calculation requires
specification of x0 to at least 70 decimal places and the use of correspondingly high
precision arithmetic. The series and its sample autocorrelation function are shown in
Figures 11-5 and 11-6. The sample ACF and the AICC criterion both suggest white
noise with mean 0.4954 as a model for the series. Under this model the best linear
predictor of X201 would be 0.4954. However, the best predictor of X201 to nine decimal
places is, in fact, 4x200(1 − x200) = 0.016286669, with zero mean squared error.

Distinguishing between iid and non-iid white noise is clearly not possible on the
basis of second-order properties. For insight into the dependence structure we can
examine sample moments of order higher than two. For example, the dependence in the
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data in CHAOS.TSM is reflected by a significantly nonzero sample autocorrelation at
lag 1 of the squared data. In the following paragraphs we consider several approaches
to this problem.

11.3.3 Distinguishing Between White Noise and iid Sequences

If {Xt} ∼ WN
(
0, σ 2

)
and E|Xt|4 < ∞, a useful tool for deciding whether or not

{Xt} is iid is the ACF ρX2(h) of the process
{
X2
t

}
. If {Xt} is iid, then ρX2(h) = 0 for

all h �= 0, whereas this is not necessarily the case otherwise. This is the basis for the
test of McLeod and Li described in Section 1.6.

Now suppose that {Xt} is a strictly stationary time series such thatE|Xt|k ≤ K < ∞
for some integer k ≥ 3. The kth-order cumulant Ck(r1, . . . , rk−1) of {Xt} is then
defined as the joint cumulant of the random variables, Xt,Xt+r1, . . . ,Xt+rk−1 , i.e., as
the coefficient of ikz1z2 · · · zk in the Taylor expansion about (0, . . . , 0) of

χ(z1, . . . , zk) := lnE[exp(iz1Xt + iz2Xt+r1 + · · · + izkXt+rk−1)]. (11.3.2)

(Since {Xt} is strictly stationary, this quantity does not depend on t.) In particular, the
third-order cumulant function C3 of {Xt} coincides with the third-order central moment
function, i.e.,

C3(r, s) = E[(Xt − μ)(Xt+r − μ)(Xt+s − μ)], r, s ∈ {0,±1, . . .},
where μ = EXt. If

∑
r

∑
s |C3(r, s)| < ∞, we define the third-order polyspectral

density (or bispectral density) of {Xt} to be the Fourier transform

f3(ω1, ω2) = 1

(2π)2

∞∑

r=−∞

∞∑

s=−∞
C3(r, s)e

−irω1−isω2, −π ≤ ω1, ω2 ≤ π,

in which case

C3(r, s) =
∫ π

−π

∫ π

−π
eirω1+isω2 f3(ω1, ω2)dω1 dω2.

[More generally, if the kth order cumulants Ck(r1, · · · , rk−1), of {Xt} are absolutely
summable, we define the kth order polyspectral density as the Fourier transform of
Ck. For details see Rosenblatt (1985) and Priestley (1988).]

If {Xt} is a Gaussian linear process, it follows from Problem 10.3 that the cumulant
function C3 of {Xt} is identically zero. (The same is also true of all the cumulant
functions Ck with k > 3.) Consequently, f3(ω1, ω2) = 0 for all ω1, ω2 ∈ [−π, π ].
Appropriateness of a Gaussian linear model for a given data set can therefore be
checked by using the data to test the null hypothesis f3 = 0. For details of such a
test, see Subba-Rao and Gabr (1984).

If {Xt} is a linear process of the form (11.3.1) with E|Zt|3 < ∞, EZ3
t = η, and∑∞

j=0 |ψj| < ∞, it can be shown from (11.3.2) (see Problem 11.3) that the third-order
cumulant function of {Xt} is given by

C3(r, s) = η

∞∑

i=−∞
ψiψi+ rψi+s (11.3.3)

(with ψj = 0 for j < 0), and hence that {Xt} has bispectral density
f3(ω1, ω2) = η

4π2
ψ
(
ei(ω1+ω2)

)
ψ
(
e−iω1

)
ψ
(
e−iω2

)
, (11.3.4)
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where ψ(z) := ∑∞
j=0ψjzj. By Proposition 4.3.1, the spectral density of {Xt} is

f (ω) = σ 2

2π

∣
∣ψ

(
e−iω

)∣
∣2 .

Hence,

φ(ω1, ω2) := |f3(ω1, ω2)|2
f (ω1)f (ω2)f (ω1 + ω2)

= η2

2πσ 6
.

Appropriateness of the linear process (11.3.1) for modeling a given data set can
therefore be checked by using the data to test for constancy of φ(ω1, ω2) (Subba-Rao
and Gabr 1984).

11.3.4 Three Useful Classes of Nonlinear Models

If it is decided that a linear Gaussian model is not appropriate, there is a choice of sev-
eral families of nonlinear processes that have been found useful for modeling purposes.
These include bilinear models, autoregressive models with random coefficients, and
threshold models. Excellent accounts of these are available in Subba-Rao and Gabr
(1984), Nicholls and Quinn (1982), and Tong (1990), respectively.

The bilinear model of order (p, q, r, s) is defined by the equations

Xt = Zt +
p∑

i=1

aiXt−i +
q∑

j=1

bjZt−j +
r∑

i=1

s∑

j=1

cijXt−iZt−j, (11.3.5)

where {Zt} ∼ iid
(
0, σ 2

)
. A sufficient condition for the existence of a strictly stationary

solution of these equations is given by Liu and Brockwell (1988).
A random coefficient autoregressive process {Xt} of order p satisfies an equation

of the form

Xt =
p∑

i=1

(
φi + U(i)t

)
Xt−i + Zt,

where {Zt} ∼ IID
(
0, σ 2

)
,
{
U(i)t

} ∼ IID
(
0, ν2

)
, {Zt} is independent of

{
Ut

}
, and

φ1, . . . , φp ∈ R.
Threshold models can be regarded as piecewise linear models in which the linear

relationship varies with the values of the process. For example, if R(i), i = 1, . . . , k, is
a partition of Rp, and {Zt} ∼ IID(0, 1), then the k difference equations

Xt = σ (i)Zt +
p∑

j=1

φ
(i)
j Xt−j, (Xt−1, · · · ,Xt−p) ∈ R(i), i = 1, · · · , k, (11.3.6)

define a threshold AR(p) model. Model identification and parameter estimation for
threshold models can be carried out in a manner similar to that for linear models using
maximum likelihood and the AIC criterion.

11.4 Long-Memory Models

The autocorrelation function ρ(·) of an ARMA process at lag h converges rapidly to
zero as h → ∞ in the sense that there exists r > 1 such that

r hρ(h) → 0 as h → ∞. (11.4.1)
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Stationary processes with much more slowly decreasing autocorrelation function,
known as fractionally integrated ARMA processes, or more precisely as ARIMA
(p, d, q) processes with 0 < |d| < 0.5, satisfy difference equations of the form

(1 − B)dφ(B)Xt = θ(B)Zt, (11.4.2)

where φ(z) and θ(z) are polynomials of degrees p and q, respectively, satisfying

φ(z) �= 0 and θ(z) �= 0 for all z such that |z| ≤ 1,

B is the backward shift operator, and {Zt} is a white noise sequence with mean 0 and
variance σ 2. The operator (1 − B)d is defined by the binomial expansion

(1 − B)d =
∞∑

j=0

πjB
j,

where n0 = 1 and

πj =
∏

0<k≤ j

k − 1 − d

k
, j = 1, 2, . . . .

The autocorrelation ρ(h) at lag h of an ARIMA(p, d, q) process with 0 < |d| < 0.5
has the property

ρ(h)h1−2d → c �= 0 as h → ∞. (11.4.3)

This implies (see (11.4.1)) that ρ(h) converges to zero as h → ∞ at a much slower
rate than ρ(h) for an ARMA process. Consequently, fractionally integrated ARMA
processes are said to have “long memory.” In contrast, stationary processes whose ACF
converges to 0 rapidly, such as ARMA processes, are said to have “short memory.”

A fractionally integrated ARIMA( p, d, q) process can be regarded as an ARMA
( p, q) process driven by fractionally integrated noise; i.e., we can replace equa-
tion (11.4.2) by the two equations

φ(B)Xt = θ(B)Wt (11.4.4)

and

(1 − B)dWt = Zt. (11.4.5)

The process {Wt} is called fractionally integrated white noise and can be shown (see,
e.g., Brockwell and Davis (1991), Section 13.2) to have variance and autocorrelations
given by

γW(0) = σ 2�(1 − 2d)

�2(1 − d)
(11.4.6)

and

ρW(h) = �(h + d)�(1 − d)

�(h − d + 1)�(d)
=

∏

0<k≤h

k − 1 + d

k − d
, h = 1, 2, . . . ,

(11.4.7)

where �(·) is the gamma function (see Example (d) of Section A.1). The exact
autocovariance function of the ARIMA(p, d, q) process {Xt} defined by (11.4.2) can
therefore be expressed, by Proposition 2.2.1, as

γX(h) =
∞∑

j=0

∞∑

k=0

ψjψkγW(h + j − k), (11.4.8)
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where
∑∞

i=0ψizi = θ(z)/φ(z), |z| ≤ 1, and γW(·) is the autocovariance function of
fractionally integrated white noise with parameters d and σ 2, i.e.,

γW(h) = γW(0)ρW(h),

with γW(0) and ρW(h) as in (11.4.6) and (11.4.7). The series (11.4.8) converges rapidly
as long as φ(z) does not have zeros with absolute value close to 1.

The spectral density of {Xt} is given by

f (λ) = σ 2

2π

∣
∣θ(e−iλ)

∣
∣2

∣
∣φ(e−iλ)

∣
∣2

∣
∣1 − e−iλ

∣
∣−2d

. (11.4.9)

Calculation of the exact Gaussian likelihood of observations {x1, . . . , xn} of a frac-
tionally integrated ARMA process is very slow and demanding in terms of computer
memory. Instead of estimating the parameters d, φ1, . . . , φp, θ1, . . . , θq, and σ 2 by
maximizing the exact Gaussian likelihood, it is much simpler to maximize the Whittle
approximation LW , defined by

− 2 ln(LW) = n ln(2π)+ 2n ln σ + σ−2
∑

j

In(ωj)

g(ωj)
+
∑

j

ln g(ωj), (11.4.10)

where In is the periodogram, σ 2g/(2π)(= f ) is the model spectral density, and
∑

j
denotes the sum over all nonzero Fourier frequencies ωj = 2π j/n ∈ (−π, π ]. The
program ITSM estimates parameters for ARIMA(p, d, q) models in this way. It can
also be used to predict and simulate fractionally integrated ARMA series and to
compute the autocovariance function of any specified fractionally integrated ARMA
model.

Example 11.4.1 Annual Minimum Water Levels; NILE.TSM

The data file NILE.TSM consists of the annual minimum water levels of the Nile
river as measured at the Roda gauge near Cairo for the years 622–871. These values
are plotted in Figure 11-7 with the corresponding sample autocorrelations shown in
Figure 11-8. The rather slow decay of the sample autocorrelation function suggests
the possibility of a fractionally intergrated model for the mean-corrected series Yt =
Xt − 1119.

Figure 11-7
Annual minimum water
levels of the Nile river
for the years 622–871
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Figure 11-8
The sample correlation
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in Figure 11-7 Lag
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The ARMA model with minimum (exact) AICC value for the mean-corrected
series {Yt} is found, using Model>Estimation>Autofit, to be

Yt = − 0.323Yt−1 − 0.060Yt−2 + 0.633Yt−3 + 0.069Yt−4 + 0.248Yt−5

+ Zt + 0.702Zt−1 + 0.350Zt−2 − 0.419Zt−3, (11.4.11)

with {Zt} ∼ WN(0, 5663.6) and AICC= 2889.9.
To fit a fractionally integrated ARMA model to this series, select the option

Model>Specify, check the box marked Fractionally integrated
model, and click on OK. Then select Model>Estimation>Autofit, and click
on Start. This estimation procedure is relatively slow so the specified ranges for p
and q should be small (the default is from 0 to 2). When models have been fitted for
each value of (p, q), the fractionally integrated model with the smallest modified AIC
value is found to be

(1 − B)0.3830(1 − 0.1694B + 0.9704B2)Yt = (1 − 0.1800B + 0.9278B2)Zt,

(11.4.12)

with {Zt} ∼ WN(0, 5827.4) and modified AIC= 2884.94. (The modified AIC statis-
tic for estimating the parameters of a fractionally integrated ARMA(p, q) process is
defined in terms of the Whittle likelihood LW as −2ln LW + 2(p + q + 2) if d is
estimated, and −2lnLW + 2(p+ q+ 1) otherwise. The Whittle likelihood was defined
in (11.4.10).)

In order to compare the models (11.4.11) and (11.4.12), the modified AIC
value for (11.4.11) is found as follows. After fitting the model as described above,
select Model>Specify, check the box marked Fractionally integrated
model, set d = 0 and click on OK. Next choose Model>Estimation>Max
likelihood, check No optimization and click on OK. You will then see the
modified AIC value, 2884.58, displayed in the ML estimates window together
with the value 2866.58 of −2lnLW .

The ARMA(5,3) model is slightly better in terms of modified AIC than the
fractionally integrated model and its ACF is closer to the sample ACF of the data than
is the ACF of the fractionally integrated model. (The sample and model autocorrelation
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functions can be compared by clicking on the third yellow button at the top of the ITSM
window.) The residuals from both models pass all of the ITSM tests for randomness.

Figure 11-9 shows the graph of {x200, . . . , x250} with predictors of the next 20
values obtained from the model (11.4.12) for the mean-corrected series.

�

11.5 Continuous-Time ARMA Processes

Time series frequently consist of observations of a continuous-time process {Y(t), t ≥
0} or {Y(t), t ∈ R} at a discrete sequence of observation times. It is then natural, even
though the observations are made at discrete times, to model the data by fitting the
underlying continuous-time process.

Even if there is no underlying continuous-time process, it may still be advan-
tageous to model the data as observations of a continuous-time process sampled at
discrete times. For example, the analysis of time series data observed at irregularly
spaced times can be handled very conveniently by regarding the data as sampled values
of a continuous-time process (see Jones 1980 and equation (11.5.6) below).

Continuous-time models also provide a unifying framework for data collected
when a time series is observed at different frequencies, i.e., with different spacings
between the observation times. Instead of requiring different discrete-time models to
represent observations collected at different frequencies, continuous-time modelling
provides a single model which can be sampled at any frequency whatsoever.

When very high-frequency observations are available (as in many financial and
turbulence studies), the relation between the high-frequency sequence and the under-
lying continuous-time process is also of interest since the high-frequency observations
provide a natural source of information regarding the continuous-time process of
which the discrete observations are a sample.

Stationarity of a continuous-time process {Y(t)} (cf. Definition 1.4.2) means that
EY(t) and Cov(Y(t + h),Y(t)) are defined and independent of t for all h ≥ 0. Strict
stationarity means that (Y(t1), . . . ,Y(tn)) and (Y(t1 +h), . . . ,Y(tn+h)) have the same
joint distributions for all t1, . . . , tn, all h ≥ 0 and all positive integers n.

Figure 11-9
The minimum annual

Nile river levels for the
years 821–871, with

20 forecasts based on
the model (11.4.12)
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Continuous-time ARMA (or CARMA) processes are defined as stationary solu-
tions of stochastic differential equations analogous to the difference equations that are
used to define discrete-time ARMA processes. They play a role in continuous-time
modelling analogous to that of ARMA processes in discrete time.

We shall begin with the Gaussian continuous-time AR(1) process, also known as
the stationary Gaussian Ornstein-Uhlenbeck process.

11.5.1 The Gaussian CAR(1) Process, {Y(t), t ≥ 0}
The Gaussian CAR(1) process {Y(t), t ≥ 0} is defined as a strictly stationary solution
of the first-order stochastic differential equation,

DY(t)+ aY(t) = σDB(t)+ c, t > 0, (11.5.1)

where the operator D denotes differentiation with respect to t, {B(t), t ∈ R} is
standard Brownian motion (see Example 7.5.1), a, c, and σ are parameters and Y(0)
is a normally distributed random variable independent of {B(t) − B(s), 0 ≤ s ≤ t <
∞}. The derivative DB(t) does not exist in the usual sense, so equation (11.5.1) is
interpreted as the Itô differential equation (see Appendix D.4),

dY(t)+ aY(t)dt = σdB(t)+ c dt, t > 0, (11.5.2)

with dY(t) and dB(t) denoting the increments of Y and B in the time interval (t, t+dt).
Standard theory of deterministic linear differential equations suggests multiplying

this equation by eat in which case the left-hand side would become d(eatY(t)). We
therefore apply Itô’s formula (Appendix, equation (D.3.7)) to d(eatY(t))with g(t, x) :=
eatx and we obtain exactly the same result since the second partial derivative gxx is zero.
Hence we can rewrite (11.5.2) as

d(eatY(t)) = σ eatdB(t)+ ceatdt,

or equivalently,

eatY(t)− Y(0) = σ

∫ t

0
eaudB(u)+ c

∫ t

0
eaudu.

Thus

Y(t) = e−atY(0)+ σ
∫ t

0
e−a(t−u)dB(u)+ c

∫ t

0
e−a(t−u) du. (11.5.3)

Remark 1. The Itô integral
∫ t

0 e
−a(t−u)dB(u) in (11.5.3) is of a special type in which

the integrand is deterministic. This permits the application of integration by parts to
obtain a pathwise representation of Y as

Y(t) = e−atY(0)+ σB(t)− σ
∫ t

0
ae−a(t−u)B(u)du + c

∫ t

0
e−a(t−u)du. �

If a > 0 and Y(0) has mean c/a and variance σ 2/(2a), it is easy to check,
using the properties of I0,t(f ) = ∫ t

0 f (u)dB(u) in Remark 3 of Appendix D.3 and the
independence of Y(0) and {B(t)− B(s), 0 ≤ s ≤ t < ∞} (Problem 11.4), that {Y(t)}
as defined by (11.5.3) is stationary with

E(Y(t)) = c

a
and Cov(Y(t + h),Y(t)) = σ 2

2a
e−ah, t, h ≥ 0. (11.5.4)
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Since {Y(t)} is Gaussian it is also strictly stationary. Conversely, if {Y(t)} is strictly
stationary, then by equating the variances of both sides of (11.5.3), we find that(
1 − e−2at

)
Var(Y(0)) = σ 2

∫ t
0 e

−2au du for all t ≥ 0, and hence that a > 0 and
Var(Y(0)) = σ 2/(2a). Equating the means of both sides of (11.5.3) then gives
E(Y(0)) = c/a. Necessary and sufficient conditions for {Y(t)} to be strictly stationary
are therefore a > 0, E(Y(0)) = c/a, and Var(Y(0)) = σ 2/(2a).

If a > 0 and 0 ≤ s ≤ t, it follows from (11.5.3) that Y(t) satisfies the relation

Y(t) = e−a(t−s)Y(s)+ c

a

(
1 − e−a(t−s)

) + σ
∫ t

s
e−a(t−u)dB(u), t ≥ s ≥ 0.

(11.5.5)

This shows that the process is Markovian, i.e., that the distribution of Y(t) given
Y(u), u ≤ s, is the same as the distribution of Y(t) given Y(s). It also shows that
the conditional mean and variance of Y(t) given Y(s) are

E(Y(t)|Y(s)) = e−a(t−s)Y(s)+ c/a
(
1 − e−a(t−s)

)

and

Var(Y(t)|Y(s)) = σ 2

2a

[
1 − e−2a(t−s)

]
.

We can now use the Markov property and the moments of the stationary distri-
bution to write down the likelihood of observations y(t1), . . . , y(tn) at times t1, . . . , tn
of the Gaussian CAR(1) process. This is just the joint density of (Y(t1), . . . ,Y(tn))′ at
(y(t1), . . . , y(tn))′, which can be expressed as the product of the stationary density at
y(t1) and the transition densities of Y(ti) given Y(ti−1) = y(ti−1), i = 2, . . . , n. The
joint density g is therefore given by

g
(
y(t1), . . . , y(tn); a, c, σ 2

) =
n∏

i=1

1√
vi
f

(
y(ti)− mi√

vi

)

, (11.5.6)

where f (y) = n(y; 0, 1) is the standard normal density, m1 = c/a, v1 = σ 2/(2a), and
for i > 1,

mi = e−a(ti−ti−1)y(ti−1)+ c

a

(
1 − e−a(ti−ti−1)

)

and

vi = σ 2

2a

[
1 − e−2a(ti−ti−1)

]
.

The maximum likelihood estimators of a, c, and σ 2 are the values that maximize
g
(
y(t1), . . . , y(tn); a, c, σ 2

)
. These can be found with the aid of a nonlinear maximiza-

tion algorithm. Notice that the times ti appearing in (11.5.6) are quite arbitrarily spaced.
It is this feature that makes the CAR(1) process so useful for modeling irregularly
spaced data.

If the observations are regularly spaced, say ti = i, i = 1, . . . , n, then the joint
density g is exactly the same as the joint density of observations of the discrete-time
Gaussian AR(1) process

Yn − c

a
= e−a

(
Yn−1 − c

a

)
+ Zn, {Zt} ∼ IIDN

(

0,
σ 2

(
1 − e−2a

)

2a

)

.

This shows that the “embedded” (or sampled) discrete-time process {Y(i), i =
1, 2, . . .} of the CAR(1) process is a discrete-time AR(1) process with coefficient e−a.
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This coefficient is clearly positive, immediately raising the question of whether there is
a continuous-time ARMA process for which the embedded process is a discrete-time
AR(1) process with negative coefficient. It can be shown (Chan and Tong 1987) that the
answer is yes and that given a discrete-time AR(1) process with negative coefficient,
it can always be embedded in a suitably chosen continuous-time ARMA(2,1) process.

11.5.2 The Gaussian CARMA(p,q) Process, {Y(t), t ∈ R}
We define a zero-mean Gaussian CARMA(p, q) process {Y(t), t ∈ R} (with 0 ≤ q <
p) to be a strictly stationary Gaussian process satisfying the pth-order linear differential
equation,

DpY(t)+ a1D
p−1Y(t)+ · · · + apY(t)

= b0DB(t)+ b1D
2B(t)+ · · · + bqD

q+1B(t), (11.5.7)

where Dj denotes j-fold differentiation with respect to t, {B(t), t ∈ R} is standard
Brownian motion, and a1, . . . , ap and b0, . . . , bq are constants. We assume that bq �= 0
and define bj := 0 for j > q. We shall also assume that the polynomials, a(z) :=
zp + a1zp−1 + · · · + ap and b(z) := b0 + b1z + · · · + bqzq, have no common zeroes.
Since the derivativesD jB(t), j > 0, do not exist in the usual sense, we interpret (11.5.7)
as being equivalent (see Remark 2 below) to the observation and state equations

Y(t) = b′X(t), (11.5.8)

and

dX(t) = AX(t) dt + e dB(t), (11.5.9)

where

A =

⎡

⎢
⎢
⎢
⎢
⎢
⎣

0 1 0 · · · 0
0 0 1 · · · 0
...

...
...

. . .
...

0 0 0 · · · 1
−ap −ap−1 −ap−2 · · · −a1,

⎤

⎥
⎥
⎥
⎥
⎥
⎦

,

e =
[
0 0 · · · 0 1

]′
, b =

[
b0 b1 · · · bp−2 bp−1

]′
, and (11.5.9) is an Itô

differential equation for the state vector X(t) (see Appendix D.4).

Remark 2. Denoting the components ofX(t) by Xj(t), j = 0, . . . , p−1, the first p−1
component equations of (11.5.9) are

dXj(t) = Xj+1(t)dt, j = 0, . . . , p − 2,

showing that Xj(t) is just the jth derivative of X0(t), j = 1, . . . , p − 1. The last
component equation of (11.5.9) is

dXp−1(t) = −(a1Xp−1 + a2Xp−2 + · · · + apX0(t))dt + dB(t),

which is the Itô form of the stochastic differential equation,

DpX0(t)+ a1D
p−1X0(t)+ · · · + apX0(t) = DB(t). (11.5.10)

The state equation (11.5.9) is thus the Itô equation for the vector whose first component
X0(t) satisfies the CARMA(p, 0) (or CAR(p)) equation (11.5.10) and whose remaining
components are successively higher derivatives, up to order p − 1, of X0(t). It is clear
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from the linearity of equation (11.5.7) that if X(t) satisfies (11.5.9) then X0(t) satisfies
(11.5.10) and the linear combination,

Y(t) = b0X0(t)+ b1X1(t)+ · · · + bp−1Xp−1(t) = b′X(t),

of X0(t) and its derivatives satisfies (11.5.7). This explains the replacement of (11.5.7)
by the observation and state equations (11.5.8) and (11.5.9). �

If X(0) is a normally distributed random vector independent of {B(t)− B(s), 0 ≤
s ≤ t < ∞}, then equation (11.5.9) is simply a vector form of equation (11.5.2) and
its unique solution for t ≥ 0, as specified in Appendix D.4, Theorem D.4.1, satisfies

X(t) = eAtX(0)+
∫ t

0
eA(t−u)e dB(u), 0 ≤ t < ∞,

where the matrix eAt is defined in the usual way as eAt := ∑∞
j=0

Aj

j! t
j.

More generally (see Appendix D, equation (D.4.6)), if for each S ∈ R, X(S) has
finite second moments and is independent of {B(t)− B(s), S ≤ s ≤ t < ∞}, then the
unique solution of (11.5.9) specified by Theorem D.4.1 satisfies

X(t) = eA(t−S)X(S)+
∫ t

S
eA(t−u)e dB(u), t ≥ S, for all S ∈ R. (11.5.11)

If the real parts of the eigenvalues λ1, . . . , λp of A (which are also the zeroes of
the autoregressive polynomial a(z)) satisfy

Re(λr) < 0, r = 1, . . . , p, (11.5.12)

and if {X(t)} is a stationary solution of (11.5.11) then, taking mean square limits as
S → −∞ in (11.5.11), we see that it must satisfy

X(t) =
∫ t

−∞
eA(t−u)e dB(u), t ∈ R. (11.5.13)

Conversely, if {X(t)} is given by (11.5.13) then it is a stationary solution of (11.5.11)
and for each S ∈ R, X(S) has finite second moments and is independent of
{B(t) − B(s), S ≤ s ≤ t < ∞}. Hence it is the unique solution of the type
specified in Theorem D.4.1 with these properties. The property that, for each S, X(S)
is independent of {B(t) − B(s), S ≤ s ≤ t < ∞}, corresponds to the discrete-time
concept of causality introduced in Section 3.1.

Assuming that condition (11.5.12) is satisfied, we define the zero-mean causal
Gaussian CARMA(p, q) process {Y(t), t ∈ R}, with parameters (a1, . . . , ap, b0,

. . . , bq), by

Y(t) = b′X(t), (11.5.14)

where {X(t)} is given by (11.5.13). A Gaussian CARMA process with mean m is
obtained by simply adding the constant value m to Y .

Remark 3. For the zero-mean causal Gaussian CAR(1) process defined by (11.5.1),
with c = 0 and with index set R instead of [0,∞) as in Section 11.5.1, we have b = σ

and A = −a, so that
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Y(t) = σ

∫ t

−∞
e−a(t−u)dB(u), t ∈ R. �

The autocovariance function of the process X(t) at lag h is easily found from
(11.5.13) to be

Cov(X(t + h),X(t)) = eA|h|�,

where

� :=
∫ ∞

0
eAye e′eA′ydy.

The mean and autocovariance function of the CARMA(p, q) process {Y(t)} are there-
fore given by

EY(t) = 0
and

Cov(Y(t + h),Y(t)) = b′eA|h|�b.

Inference for a CARMA(p, q) process with p > 1 is more complicated than for a
CAR(1) process because the former is not Markovian, so the simple argument that led
to (11.5.6) no longer holds. However, the Gaussian likelihood of observations at times
t1, . . . , tn can still easily be computed using the discrete-time Kalman recursions as
pointed out by Jones (1980).

Simulation and estimation, not only for Gaussian, but also for Lévy-driven
CARMA processes (as introduced in the following subsection) can be carried out
using the Yuima package, a package for use in the R environment, which can be
downloaded from https://cran.r-project.org/web/packages/yuima. A detailed account
of its application to CARMA processes is contained in the paper of Iacus and Mercuri
(2015). A simulated Gaussian (3,2) process and the components of its state-vector,
generated in R by the Yuima package, is shown in Figure 11-10.

Rather than examining Gaussian CARMA processes in more detail, we next
introduce the more general class of Lévy-driven CARMA(p, q) processes, whose
marginal distributions can be both heavy-tailed and asymmetric and whose sample-
paths are continuous if q < p−1 and have the same jumps as the driving Lévy process
if q = p − 1.

11.5.3 Lévy-driven CARMA Processes, {Y(t), t ∈ R}
In Section 11.5.2, under the assumption (11.5.12), we defined the zero-mean causal
Gaussian CARMA process {Y(t), t ∈ R} as the strictly stationary linear combination
(11.5.14) of components of the state-vector X(t) given by (11.5.13). In this section we
wish to extend the definition by replacing the driving process B by a Lévy process L
in order to allow a much broader class of possible marginal distributions for Y(t). As
in Section 11.5.2 we shall assume that the polynomials a(z) and b(z) in the defining
stochastic differential equation,

a(D)Y(t) = b(D)DL(t),

have no common zeroes. We use the same state-space representation of the process as
in Section 11.5.2 to obtain a rigorous interpretation of this equation.

https://cran.r-project.org/web/packages/yuima
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Figure 11-10
Simulated CARMA(3,2)

process y and state-vector X
driven by standard

Brownian motion with
a1 = 4, a2 = 4.5, a3 = 1.5,
b0 = 1, b1 = .23, b2 = .35
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Replacing the Brownian motion {B(t)} in (11.5.11) by the Lévy process {L(t)}
gives

X(t) = eA(t−S)X(S)+
∫

(S,t]
eA(t−S)dL(u), t ≥ S, for all S ∈ R. (11.5.15)

where the integral is now interpreted in the sense of Protter (2010). We then define the
CARMA(p, q) process driven by L, with coefficients (a1, . . . , ap, b1, . . . , bq), to be
a strictly stationary solution {Y(t)} of the equation (11.5.15) and

Y(t) = b′X(t). (11.5.16)

The matrix A and the vector b are defined as in Section 11.5.2, except that we now
define bq := 1 since there is no variance constraint on L(1) as there was on B(1) in
the definition of the Gaussian special cases in Sections 11.5.1 and 11.5.2. In the case
when L is a subordinator (i.e., a Lévy process with non-decreasing sample paths), the
integral in (11.5.15) can also be interpreted as a pathwise Stieltjes integral with respect
to L.

Brockwell and Lindner (2009) have established necessary and sufficient condi-
tions for the existence of a strictly stationary solution {Y(t), t ∈ R} of (11.5.15)
and (11.5.16). If we assume that a(z) and b(z) have no common zeroes and L is not
deterministic, then the necessary and sufficient conditions are

E max(0. log |L(1)|) < ∞ (11.5.17)

and

Re(λr) �= 0, r = 1, . . . , p, (11.5.18)

where λ1, . . . , λp are the eigenvalues of A (which are also the zeroes of the autoregres-
sive polynomial a(z)).

The strictly stationary solution is unique, and under the stronger conditions,

Re(λr) < 0, r = 1, . . . , p, (11.5.19)
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it is causal, i.e., for every s, t and u such that s ≤ t ≤ u, Y(s) is independent of
L(u)− L(t) and can be expressed as

Y(t) =
∫

(−∞,t]
b′eA(t−u)edL(u). (11.5.20)

(The representation (11.5.20) is easily obtained formally by letting S → −∞ in
(11.5.15) and substituting the resulting expression for X(t) in (11.5.16).) Thus, under
the causality condition (11.5.19), equations (11.5.15) and (11.5.16) have the unique
strictly stationary solution (11.5.20). This solution is the causal CARMA(p, q) process
with parameters (a1, . . . , ap, b1, . . . , bq := 1) driven by the Lévy process L.

From equation (11.5.20) we find that, if E(L(1)2) < ∞, EY(t) = μb0/ap, where
μ = EL(1), and

γY(h) := Cov[Y(t + h),Y(t)] = σ 2b′eA|h|�b, (11.5.21)

where σ 2 = Var(L(1)) and � = ∫ ∞
0 eAyee′eA′ydy.

Remark 4. A result of Eller (1987) was used by Brockwell and Lindner (2009) to
rewrite (11.5.20) as

Y(t) =
∫

(−∞,t]

∑

λ

m(λ)−1∑

k=0

cλk(t − u)keλ(t−u)dL(u), (11.5.22)

where �λ denotes summation over the zeroes λ of a(z), m(λ) is the multiplicity of the
zero λ and

∑m(λ)−1
k=0 cλktkeλt is the residue at λ of the mapping z �→ eztb(z)/a(z). If the

zeroes, λ1, . . . , λp, of a(z) each have multiplicity one, then the expression (11.5.22)
simplifies to

Y(t) =
∫

(−∞,t]

p∑

r=1

αre
λr(t−u)dL(u), (11.5.23)

where αr = b(λr)/a′(λr). Hence {Y(t)} has a corresponding canonical representation
as a linear combination of (possibly complex-valued) CAR(1) processes,

Y(t) =
p∑

r=1

αrYr(t), (11.5.24)

where Yr(t) = ∫

(−∞,t] e
λr(t−u)dL(u). Notice that the driving process L is the same for

each of the component processes {Yr(t)}, so they are not independent. Corresponding
to the canonical decomposition (11.5.24), if E(L(1)2) < ∞, there is an analogous
representation of the autocovariance function when E(L(1)2) < ∞, namely

γ (h) =
p∑

r=1

βre
λr|h|, (11.5.25)

where βr = σ 2b(λr)b(−λr)/[a(−λr)a′(λr)]. �

Example 11.5.1. Stochastic Volatility

The stochastic volatility process, h, appearing in Example 7.5.4 was defined as

h(t) =
∫

(−∞.t]
eλ(t−u) dL(u), where λ < 0, (11.5.26)
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i.e., as a Lévy-driven CARMA(1, 0) process with a(z) = z − λ and b(z) = 1. For
non-negativity of h, the Lévy process L is required to be a subordinator, for example,
a gamma process with characteristic function EeiθL(t) = (1 − iθ/β)−α t, EL(t) =
αt/β and Var(L(1)) = αt/β2. Then Eh(t) = αt/(β|λ|) and the autocovariance
function of h is, from (11.5.27), γh(s) = eλ|s|α/(2β2|λ|). For any finite-variance Lévy-
driven CARMA(1,0) model for stochastic volatility, the autocorrelation function is
necessarily of the form ρ(s) = eλ|s| for some negative λ. In order to relax this constraint
a non-negative CARMA(p, q) model for h can be employed (see e.g., Brockwell and
Lindner 2012).

�

Remark 5. Marginal distributions. The condition (11.5.17) clearly does not
require L(1) (and consequently Y(t)) to have finite variance. In fact the condition
E|L(1)|r < ∞ for some r > 0 is sufficient to ensure that (11.5.17) holds. Given
a CARMA(p, q) process Y driven by a Lévy process L with characteristic function
E(eiθL(t)) = exp(tξ(θ)), θ ∈ R, (see Appendix D.1), the joint characteristic function
of Y(t1), . . . ,Y(tn) can be expressed in terms of the coefficients of the polynomials a
and b and the characteristic exponent ξ(·) of L (see Brockwell (2014)). In particular
the logarithm of the marginal characteristic function of Y(t) is

1nEeiθY(t) =
∫ ∞

0
ξ(θb′eAue)du, θ ∈ R. (11.5.27)

For the CAR(1) process h defined by (11.5.26) this simplifies to

1nEeiθh(t) =
∫ ∞

0
ξ(θeλu)du = |λ|−1

∫ θ

0
y−1ξ(y)dy, (11.5.28)

(where
∫ θ

0 := − ∫ 0
θ
if θ < 0). If, for example, L(1) has a symmetric stable distribution

with 1nEeiθL(1) = −c|θ |α, c > 0, 0 < α ≤ 2, then E|L(1)|r < ∞ for all r ∈ (0, α)
and from (11.5.28) we find at once (Problem 11.8) that,

1nEeiθh(t) = − c

α|λ| |θ |
α, (11.5.29)

in other words h(t) has a symmetric stable distribution with the same exponent α as
L(1) but with the parameter c replaced by c/(α|λ|).

Problems

11.1 Find a transfer function model relating the input and output series Xt1 and Xt2,
t = 1, . . . , 200, contained in the ITSM data files APPJ.TSM and APPK.TSM,
respectively. Use the fitted model to predict X201,2, X202,2, and X203,2. Compare
the predictors and their mean squared errors with the corresponding predictors
and mean squared errors obtained by modeling {Xt2} as a univariate ARMA
process and with the results of Problem 8.7.

11.2 Verify the calculations of Example 11.2.1 to fit an intervention model to the
series SB.TSM.

11.3 If {Xt} is the linear process (11.3.1) with {Zt} ∼ IID
(
0, σ 2

)
and η = EZ3

t , show
that the third-order cumulant function of {Xt} is given by

C3(r, s) = η

∞∑

i=−∞
ψiψi+rψi+s.
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Use this result to establish equation (11.3.4). Conclude that if {Xt} is a Gaussian
linear process, then C3(r, s) ≡ 0 and f3(ω1, ω2) ≡ 0.

11.4 If a > 0 and Y(0) has mean b/a and variance σ 2/(2a), show that the pro-
cess defined by (11.5.3) is stationary and evaluate its mean and autocovariance
function.

11.5 The file TRINGS.TSM contains normalized tree-ring widths of a Colorado pine
for the years 525–774 (Donald Graybill 1984) from the file CO522.DAT at http://
www-personal.buseco.monash.edu.au/hyndman/TSDL/.
a. Use exact maximum likelihood estimation to fit a fractionally integrated

ARMA model to the first 230 tree-ring widths and use the model to generate
forecasts and 95% prediction bounds for the last 20 observations (correspond-
ing to t = 231, . . . , 250). Plot the entire data set with the forecasts and
prediction bounds superposed on the graph of the data.

b. Repeat part (a), but this time fitting an appropriate ARMA model. Compare
the performance of the two sets of predictors.

11.6 The tent map with parameter s ∈ (1,∞) is the function
g(x) = sxI[0,1/s)(x)+ s

s − 1
(1 − x)I[1/s,1](x), x ∈ [0, 1],

where IA denotes the indicator function of the set A. If X0 has the uniform
distribution on [0, 1] (written more concisely as X0 ∼ U) and if {Xn} is the
sequence defined by Xn = g(Xn−1), n = 1, 2, . . . , then {Xn} is a Markov chain
and Xn ∼ U for all n ∈ {0, 1, 2, . . .}, so that {Xn} is strictly (and weakly)
stationary.
a. Show that in the symmetric case (s = 2), {Xn} ∼ WN(0, 1/12).
b. In the general case, Xn − 0.5 = φ(Xn−1 − 0.5) + Zn, n = 1, 2, . . . , where
φ = (2/s)− 1 and {Zn} is an uncorrelated (but strongly dependent) sequence
of random variables with mean zero and variance (1−φ2)/12. (See Sakai and
Tokumaru 1980.)

11.7 A Lévy-driven CARMA(2,1) process is defined by the stochastic differential
equation,

(D2 + 1.5D + .5)Y(t) = (D + .2)DL(t), t ∈ R,

where L is a Poisson process with jump-rate ρ.
a. Calculate EY(t).
b. Use (11.5.23) to determine the canonical decomposition of {Y(t)}.
c. Use (11.5.25) to determine the autocovariance function of {Y(t)}.

11.8 Use (11.5.27) to verify (11.5.28) and (11.5.29). If L(1) ∼ N(0, σ 2), use (11.5.29)
to determine the distribution of h(t), as defined by (11.5.26).

http://www-personal.buseco.monash.edu.au/hyndman/TSDL/
http://www-personal.buseco.monash.edu.au/hyndman/TSDL/
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A.1 Distribution Functions and Expectation
A.2 Random Vectors
A.3 The Multivariate Normal Distribution

A.1 Distribution Functions and Expectation

The distribution function F of a random variable X is defined by

F(x) = P[X ≤ x] (A.1.1)

for all real x. The following properties are direct consequences of (A.1.1):

1. F is nondecreasing, i.e., F(x) ≤ F(y) if x ≤ y.
2. F is right continuous, i.e., F(y) ↓ F(x) as y ↓ x.
3. F(x) → 1 and F(y) → 0 as x → ∞ and y → −∞, respectively.

Conversely, any function that satisfies properties 1–3 is the distribution function of
some random variable.

Most of the commonly encountered distribution functions F can be expressed
either as

F(x) =
∫ x

−∞
f (y)dy (A.1.2)

or

F(x) =
∑

j:xj≤x

p(xj), (A.1.3)

where {x0, x1, x2, . . .} is a finite or countably infinite set. In the case (A.1.2) we shall
say that the random variable X is continuous. The function f is called the probability
density function (pdf) of X and can be found from the relation

f (x) = F′(x).
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P.J. Brockwell, R.A. Davis, Introduction to Time Series and Forecasting,
Springer Texts in Statistics, DOI 10.1007/978-3-319-29854-2

353



354 Appendix A Random Variables and Probability Distributions

In case (A.1.3), the possible values of X are restricted to the set {x0, x1, . . .}, and we
shall say that the random variable X is discrete. The function p is called the probability
mass function (pmf) of X, and F is constant except for upward jumps of size p(xj) at
the points xj. Thus p(xj) is the size of the jump in F at xj, i.e.,

p(xj) = F(xj)− F(x−
j ) = P[X = xj],

where F(x−
j ) = limy↑xj F(y).

A.1.1 Examples of Continuous Distributions

(a) The normal distribution with mean μ and variance σ 2. We say that a random
variable X has the normal distribution with mean μ and variance σ 2

(
written more

concisely as X ∼ N
(
μ, σ 2

))
if X has the pdf given by

n
(
x;μ, σ 2) = (2π)−1/2σ−1e−(x−μ)2/(2σ 2) − ∞ < x < ∞.

It follows then that Z = (X − μ)/σ ∼ N(0, 1) and that

P[X ≤ x] = P

[

Z ≤ x − μ
σ

]

= �

(
x − μ
σ

)

,

where �(x)= ∫ x
−∞(2π)

−1/2e− 1
2 z

2
dz is known as the standard normal distribu-

tion function. The significance of the termsmean and variance for the parameters
μ and σ 2 is explained below (see Example A.1.1).

(b) The uniform distribution on [a, b]. The pdf of a random variable uniformly dis-
tributed on the interval [a, b] is given by

u(x; a, b) =

⎧
⎪⎨

⎪⎩

1

b − a
, if a ≤ x ≤ b,

0, otherwise.

(c) The exponential distribution with parameter λ. The pdf of an exponentially dis-
tributed random variable with parameter λ > 0 is

e(x;λ) =
⎧
⎨

⎩

0, if x < 0,

λe−λx, if x ≥ 0.

The corresponding distribution function is

F(x) =
{

0, if x < 0,

1 − e−λx, if x ≥ 0.

(d) The gamma distribution with parameters α and λ. The pdf of a gamma-distributed
random variable is

g(x;α, λ) =
⎧
⎨

⎩

0, if x < 0,

xα−1λαe−λx/�(α), if x ≥ 0,

where the parameters α and λ are both positive and � is the gamma function
defined as

�(α) =
∫ ∞

0
xα−1e−x dx.
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Note that f is the exponential pdf when α = 1 and that when α is a positive integer

�(α) = (α − 1)! with 0! defined to be 1.

(e) The chi-squared distribution with ν degrees of freedom. For each positive integer
ν, the chi-squared distribution with ν degrees of freedom is defined to be the
distribution of the sum

X = Z2
1 + · · · + Z2

ν ,

where Z1, . . . ,Zν are independent normally distributed random variables with
mean 0 and variance 1. This distribution is the same as the gamma distribution
with parameters α = ν/2 and λ = 1

2 .

A.1.2 Examples of Discrete Distributions

(f) The binomial distribution with parameters n and p. The pmf of a binomially
distributed random variable X with parameters n and p is

b( j; n, p) = P[X = j ] =
(
n

j

)

p j(1 − p)n−j, j = 0, 1, . . . , n,

where n is a positive integer and 0 ≤ p ≤ 1.
(g) The uniform distribution on {1, 2, . . . , k}. The pmf of a random variable X uni-

formly distributed on {1, 2, . . . , k} is
p( j ) = P[X = j ] = 1

k
, j = 1, 2 . . . , k,

where k is a positive integer.
(h) The Poisson distribution with parameter λ. A random variable X is said to have a

Poisson distribution with parameter λ > 0 if

p( j;λ) = P[X = j ] = λj

j! e
−λ, j = 0, 1, . . . .

We shall see in Example A.1.2 below that λ is the mean of X.
(i) The negative binomial distribution with parameters α and p. The random variable

X is said to have a negative binomial distribution with parameters α > 0 and
p ∈ [0, 1] if it has pmf

nb( j;α, p) =
(

j∏

k=1

k − 1 + α
k

)

(1 − p) jpα, j = 0, 1, . . . ,

where the product is defined to be 1 if j = 0.

Not all random variables can be neatly categorized as either continuous or discrete.
For example, consider the time you spend waiting to be served at a checkout counter
and suppose that the probability of finding no customers ahead of you is 1

2 . Then the
time you spend waiting for service can be expressed as

W =

⎧
⎪⎪⎨

⎪⎪⎩

0, with probability
1

2
,

W1, with probability
1

2
,
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whereW1 is a continuous random variable. If the distribution ofW1 is exponential with
parameter 1, then the distribution function of W is

F(x) =
⎧
⎨

⎩

0, if x < 0,

1

2
+ 1

2

(
1 − e−x

) = 1 − 1

2
e−x, if x ≥ 0.

This distribution function is neither continuous (since it has a discontinuity at x = 0)
nor discrete (since it increases continuously for x > 0). It is expressible as a mixture,

F = pFd + (1 − p)Fc,

with p = 1
2 , of a discrete distribution function

Fd =
⎧
⎨

⎩

0, x < 0,

1, x ≥ 0,

and a continuous distribution function

Fc =
⎧
⎨

⎩

0, x < 0,

1 − e−x, x ≥ 0.

Every distribution function can in fact be expressed in the form

F = p1Fd + p2Fc + p3Fsc,

where 0 ≤ p1, p2, p3 ≤ 1, p1 + p2 + p3 = 1, Fd is discrete, Fc is continuous, and Fsc

is singular continuous (continuous but not of the form A.1.2). Distribution functions
with a singular continuous component are rarely encountered.

A.1.3 Expectation, Mean, and Variance

The expectation of a function g of a random variable X is defined by

E (g(X)) =
∫

g(x) dF(x),

where

∫

g(x) dF(x) :=

⎧
⎪⎪⎪⎪⎪⎨

⎪⎪⎪⎪⎪⎩

∫ ∞

−∞
g(x)f (x) dx in the continuous case,

∞∑

j=0

g(xj)p(xj) in the discrete case,

and g is any function such that E|g(x)| < ∞. (If F is the mixture F = pFc+(1−p)Fd,
then E(g(X)) = p

∫
g(x) dFc(x)+ (1 − p)

∫
g(x) dFd(x).) The mean and variance of

X are defined as μ = EX and σ 2 = E(X − μ)2, respectively. They are evaluated by
setting g(x) = x and g(x) = (x − μ)2 in the definition of E(g(X)).

It is clear from the definition that expectation has the linearity property

E(aX + b) = aE(X)+ b

for any real constants a and b (provided that E|X| < ∞).
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Example A.1.1 The Normal Distribution

If X has the normal distribution with pdf n
(
x;μ, σ 2

)
as defined in Example (a) above,

then

E(X − μ) =
∫ ∞

−∞
(x − μ)n(x;μ, σ 2

)
dx = −σ 2

∫ ∞

−∞
n′(x : μ, σ 2

)
dx = 0.

This shows, with the help of the linearity property of E, that

E(X) = μ,

i.e., that the parameter μ is in fact the mean of the normal distribution defined in
Example (a). Similarly,

E(X−μ)2 =
∫ ∞

−∞
(x−μ)2n(x;μ, σ 2) dx = −σ 2

∫ ∞

−∞
(x−μ)n′(x;μ, σ 2) dx.

Integrating by parts and using the fact that f is a pdf, we find that the variance of X is

E(X − μ)2 = σ 2
∫ ∞

−∞
n
(
x;μ, σ 2) dx = σ 2.

�

Example A.1.2 The Poisson Distribution

The mean of the Poisson distribution with parameter λ (see Example (h) above) is
given by

μ =
∞∑

j=0

jλj

j! e
−λ =

∞∑

j=1

λλj−1

(j − 1)!e
−λ = λeλe−λ = λ.

A similar calculation shows that the variance is also equal to λ (see Problem A.2).
�

Remark. Functions and parameters associated with a random variable X will be
labeled with the subscript X whenever it is necessary to identify the particular random
variable to which they refer. For example, the distribution function, pdf, mean, and
variance of X will be written as FX, fX , μX , and σ 2

X , respectively, whenever it is
necessary to distinguish them from the corresponding quantities FY , fY , μY , and σ 2

Y
associated with a different random variable Y .

A.2 Random Vectors

An n-dimensional random vector is a column vector X = (X1, . . . ,Xn)
′ each of whose

components is a random variable. The distribution function F of X, also called the
joint distribution of X1, . . . ,Xn, is defined by

F(x1, . . . , xn) = P[X1,≤ x1, . . . ,Xn ≤ xn] (A.2.1)

for all real numbers x1, . . . , xn. This can be expressed in a more compact form as

F(x) = P[X ≤ x], x = (x1, . . . , xn)
′,

for all real vectors x = (x1, . . . , xn)′. The joint distribution of any subcollection
Xi1, . . . ,Xik of these random variables can be obtained from F by setting xj = ∞
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in (A.2.1) for all j /∈ {i1, . . . , ik}. In particular, the distributions of X1 and (X1,Xn)
′ are

given by

FX1(x1) = P[X1 ≤ x1] = F(x1,∞, . . . ,∞)
and

FX1,Xn(x1, xn) = P[X1 ≤ x1,Xn ≤ xn] = F(x1,∞, . . . ,∞, xn).
As in the univariate case, a random vector with distribution function F is said to be
continuous if F has a density function, i.e., if

F(x1, . . . , xn) =
∫ xn

−∞
· · ·

∫ x2

−∞

∫ x1

−∞
f (y1, . . . , yn) dy1 dy2 · · · dyn.

The probability density of X is then found from

f (x1, . . . , xn) = ∂nF(x1, . . . , xn)

∂x1 · · · ∂xn .

The random vector X is said to be discrete if there exist real-valued vectors x0, x1, . . .

and a probability mass function p(xj) = P[X = xj] such that

∞∑

j=0

p(xj) = 1.

The expectation of a function g of a random vector X is defined by

E (g(X)) =
∫

g(x) dF(x) =
∫

g(x1, . . . , xn) dF(x1, . . . , xn),

where
∫

g(x1, . . . , xn) dF(x1, . . . , xn)

=

⎧
⎪⎪⎪⎨

⎪⎪⎪⎩

∫

· · ·
∫

g(x1, . . . , xn) f (x1, . . . , xn) dx1 · · · dxn, in the continuous case,

∑

j1

· · ·
∑

jn

g(xj1 , . . . , xjn)p(xj1, . . . , xjn), in the discrete case,

and g is any function such that E|g(X)| < ∞.
The random variables X1, . . . ,Xn are said to be independent if

P[X1 ≤ x1, . . . ,Xn ≤ xn] = P[X1 ≤ x1] · · · P[Xn ≤ xn],
i.e.,

F(x1, . . . , xn) = FX1(x1) · · ·FXn(xn)

for all real numbers x1, . . . , xn. In the continuous and discrete cases, independence is
equivalent to the factorization of the joint density function or probability mass function
into the product of the respective marginal densities or mass functions, i.e.,

f (x1, . . . , xn) = fX1(x1) · · · fXn(xn) (A.2.2)

or

p(x1, . . . , xn) = pX1(x1) · · · pXn(xn). (A.2.3)

For two random vectors X = (X1, . . . ,Xn)
′ and Y = (Y1, . . . ,Ym)

′ with joint
density function fX,Y, the conditional density of Y given X = x is
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fY|X(y|x) =

⎧
⎪⎨

⎪⎩

fX,Y(x, y)
fX(x)

, if fX(x) > 0,

fY(y), if fX(x) = 0.

The conditional expectation of g (Y) given X = x is then

E(g(Y)|X = x) =
∫ ∞

−∞
g(y) fY|X(y|x) dy.

If X and Y are independent, then fY|X(y|x) = fY(y) by (A.2.2), and so the conditional
expectation of g(Y) given X = x is

E(g(Y)|X = x) = E( g(Y)),

which, as expected, does not depend on x. The same ideas hold in the discrete case
with the probability mass function assuming the role of the density function.

A.2.1 Means and Covariances

If E|Xi| < ∞ for each i, then we define the mean or expected value of X =
(X1, . . . ,Xn)

′ to be the column vector

μX = EX = (EX1, . . . ,EXn)
′.

In the same way we define the expected value of any array whose elements are random
variables (e.g., a matrix of random variables) to be the same array with each random
variable replaced by its expected value (if the expectation exists).

If X = (X1, . . . ,Xn)
′ and Y = (Y1, . . . ,Ym)

′ are random vectors such that each Xi

and Yj has a finite variance, then the covariance matrix of X and Y is defined to be
the matrix

�XY = Cov(X,Y) = E[(X − EX)(Y − EY)′]
= E(XY′)− (EX)(EY)′.

The (i, j) element of�XY is the covariance Cov(Xi,Yj) = E(XiYj)−E(Xi)E(Yj). In the
special case where Y = X, Cov(X,Y) reduces to the covariance matrix of the random
vector X.

Now suppose that Y and X are linearly related through the equation

Y = a + BX,

where a is an m-dimensional column vector and B is an m × n matrix. Then Y has
mean

EY = a + BEX (A.2.4)

and covariance matrix

�YY = B�XXB
′ (A.2.5)

(see Problem A.3).

Proposition A.2.1 The covariance matrix �XX of a random vector X is symmetric and nonnegative
definite, i.e., b′�XXb ≥ 0 for all vectors b = (b1, . . . , bn)′ with real components.

Proof Since the (i, j) element of �XX is Cov(Xi, Xj) =Cov(Xj, Xi), it is clear that �XX is
symmetric. To prove nonnegative definiteness, let b = (b1, . . . , bn)′ be an arbitrary
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vector. Then applying (A.2.5) with a = 0 and B = b, we have

b′�XXb = Var(b′X) = Var(b1X1 + · · · + bnXn) ≥ 0. �

Proposition A.2.2 Every n × n covariance matrix � can be factorized as

� = P&P′

where P is an orthogonal matrix (i.e., P′ = P−1) whose columns are an orthonormal
set of right eigenvectors corresponding to the (nonnegative) eigenvalues λ1, . . . , λn of
�, and & is the diagonal matrix

& =

⎡

⎢
⎢
⎢
⎣

λ1 0 · · · 0
0 λ2 · · · 0
...

...
. . .

...

0 0 · · · λn

⎤

⎥
⎥
⎥
⎦
.

In particular, � is nonsingular if and only if all the eigenvalues are strictly positive.

Proof Every covariance matrix is symmetric and nonnegative definite by Proposition A.2.1,
and for such matrices the specified factorization is a standard result (see Graybill 1983
for a proof). The determinant of an orthogonal matrix is 1 or −1, so that det(�) =
det(P) det(&) det(P) = λ1 · · · λn. It follows that � is nonsingular if and only if λi > 0
for all i. �

Remark 1. Given a covariance matrix �, it is sometimes useful to be able to find a
square root A = �1/2 with the property that AA′ = �. It is clear from Proposition
A.2.2 and the orthogonality of P that one such matrix is given by

A = �1/2 = P&1/2P′.

If � is nonsingular, then we can define

�s = P&sP′, −∞ < s < ∞.
The matrix �−1/2 defined in this way is then a square root of�−1 and also the inverse
of �1/2. �

A.3 The Multivariate Normal Distribution

The multivariate normal distribution is one of the most commonly encountered and
important distributions in statistics. It plays a key role in the modeling of time series
data. Let X = (X1, . . . ,Xn)

′ be a random vector.

Definition A.3.1 X has a multivariate normal distribution with mean μ and nonsingular covari-
ance matrix � = �XX, written as X ∼ N(μ,�), if

fX(x) = (2π)−n/2(det�)−1/2 exp

{

−1

2
(x − μ)′�−1(x − μ)

}

.
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If X ∼ N(μ, �), we can define a standardized random vector Z by applying the
linear transformation

Z = �−1/2(X − μ), (A.3.1)

where �−1/2 is defined as in the remark of Section A.2. Then by (A.2.4) and (A.2.5),
Z has mean 0 and covariance matrix �ZZ = �−1/2��−1/2 = In, where In is the n× n
identity matrix. Using the change of variables formula for probability densities (see
Mood et al. 1974), we find that the probability density of Z is

fZ(z) = (det�)1/2fX
(
�1/2z + μ

)

= (det�)1/2(2π)−n/2(det�)−1/2 exp

{

−1

2
(�−1/2z)′�−1�−1/2z

}

= (2π)−n/2 exp
{

− 1

2
z′z

}

=
(

(2π)−1/2 exp
{

− 1

2
z2

1

})

· · ·
(

(2π)−1/2 exp
{

− 1

2
z2
n

})

,

showing, by (A.2.2), that Z1, . . . ,Zn are independent N(0, 1) random variables. Thus
the standardized random vector Z defined by (A.3.1) has independent standard normal
random components. Conversely, given any n× 1 mean vector μ, a nonsingular n× n
covariance matrix�, and an n×1 vector of standard normal random variables, we can
construct a normally distributed random vector with mean μ and covariance matrix �
by defining

X = �1/2Z + μ. (A.3.2)

(See Problem A.4.)

Remark 1. The multivariate normal distribution with mean μ and covariance matrix
� can be defined, evenwhen� is singular, as the distribution of the vectorX in (A.3.2).
The singular multivariate normal distribution does not have a joint density, since
the possible values of X−μ are constrained to lie in a subspace of Rn with dimension
equal to rank(�). �

Remark 2. If X ∼N(μ, �), B is an m × n matrix, and a is a real m × 1 vector, then
the random vector

Y = a + BX

is also multivariate normal (see Problem A.5). Note that from (A.2.4) and (A.2.5), Y
has mean a + Bμ and covariance matrix B�B′. In particular, by taking B to be the
row vector b′ = (b1, . . . , bn), we see that any linear combination of the components
of a multivariate normal random vector is normal. Thus b′X = b1X1 + · · · + bnXn ∼
N(b′μX,b

′�XXb). �

Example A.3.1. The Bivariate Normal Distribution
Suppose that X = (X1,X2)

′ is a bivariate normal random vector with mean μ =
(μ1, μ2)

′ and covariance matrix

� =
[
σ 2

1 ρσ1σ2

ρσ1σ2 σ 2
2

]

, σ > 0, σ2 > 0, −1 < ρ < 1. (A.3.3)
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The parameters σ1, σ2, and ρ are the standard deviations and correlation of the compo-
nents X1 and X2. Every nonsingular 2-dimensional covariance matrix can be expressed
in the form (A.3.3). The inverse of � is

�−1 = (
1 − ρ2)−1

[
σ−2

1 −ρσ−1
1 σ−1

2

−ρσ−1
1 σ−1

2 σ−2
2

]

,

and so the pdf of X is given by

fX(x) =
(

2πσ1σ2
(
1 − ρ2

)1/2
)−1

× exp

{
−1

2
(
1 − ρ2

)

[(
x1 − μ1

σ1

)2

−2ρ

(
x1 − μ1

σ1

)(
x2 − μ2

σ2

)

+
(
x2 − μ2

σ2

)2
]}

.

�
Multivariate normal random vectors have the important property that the condi-

tional distribution of any set of components, given any other set, is again multivariate
normal. In the following proposition we shall suppose that the nonsingular normal
random vector X is partitioned into two subvectors

X =
[
X(1)

X(2)

]

.

Correspondingly, we shall write the mean and covariance matrix of X as

μ =
[
μ(1)

μ(2)

]

and � =
[
�11 �12

�21 �22

]

,

where μ(i) = EX(i) and �ij = E
(
X(i) − μ(i)

) (
X(j) − μ(i)

)′
.

Proposition A.3.1. i. X(1) and X(2) are independent if and only if �12 = 0.
ii. The conditional distribution of X(1) given X(2) = x(2) is N

(
μ(1) + �12�

−1
22

(
x(2) −

μ(2)
)
, �11 −�12�

−1
22 �21

)
. In particular,

E
(
X(1)|X(2) = x(2)

) = μ(1) + �12�
−1
22

(
x(2) − μ(2)

)
.

The proof of this proposition involves routine algebraic manipulations of the
multivariate normal density function and is left as an exercise (see Problem A.6).

Example A.3.2. For the bivariate normal random vector X in Example A.3.1, we immediately deduce
from Proposition A.3.1 that X1 and X2 are independent if and only if ρσ1σ2 = 0 (or
ρ = 0, since σ1 and σ2 are both positive). The conditional distribution of X1 given
X2 = x2 is normal with mean

E(X1|X2 = x2) = μ1 + ρσ1σ
−1
2 (x2 − μ2)

and variance

Var(X1|X2 = x2) = σ 2
1

(
1 − ρ2) .

�
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Definition A.3.2. {Xt} is aGaussian time series if all of its joint distributions aremultivariate normal,
i.e., if for any collection of integers i1, . . . , in, the random vector (Xi1, . . . ,Xin)

′ has
a multivariate normal distribution.

Remark 3. If {Xt} is a Gaussian time series, then all of its joint distributions are
completely determined by the mean function μ(t) = EXt and the autocovariance
function κ(s, t) = Cov(Xs,Xt). If the process also happens to be stationary, then
the mean function is constant (μt = μ for all t) and κ(t + h, t) = γ (h) for all t.
In this case, the joint distribution of X1, . . . ,Xn is the same as that of X1+h, . . . ,Xn+h

for all integers h and n > 0. Hence for a Gaussian time series strict stationarity is
equivalent to weak stationarity (see Section 2.1). �

Problems

A.1 Let X have a negative binomial distribution with parameters α and p, where α > 0
and 0 ≤ p < 1.
a. Show that the probability generating function of X

(
defined asM(s) = E

(
sX
))

is

M(s) = pα(1 − s + sp)−α, 0 ≤ s ≤ 1.

b. Using the property thatM′(1) = E(X) andM′′(1) = E(X2)−E(X), show that

E(X) = α(1 − p)/p and Var(X) = α(1 − p)/p2.

A.2 IfX has the Poisson distribution with mean λ, show that the variance of X is also λ.

A.3 Use the linearity of the expectation operator for real-valued random variables to
establish (A.2.4) and (A.2.5).

A.4 If � is an n × n covariance matrix, �1/2 is the square root of � defined in the
remark of Section A.2, and Z is an n-vector whose components are independent
normal random variables with mean 0 and variance 1, show that

X = �1/2Z + μ

is a normally distributed random vector with mean μ and covariance matrix �.

A.5 Show that if X is an n-dimensional random vector such that X ∼ N(μ, �), B is
a real m × n matrix, and a is a real-valued m-vector, then

Y = a + BX

is a multivariate normal random vector. Specify the mean and covariance matrix
of Y.

A.6 Prove Proposition A.3.1.

A.7 Suppose that X = (X1, . . . ,Xn)
′ ∼ N(0, �) with � nonsingular. Using the

fact that Z, as defined in (A.3.1), has independent standard normal components,
show that (X − μ)′�−1(X − μ) has the chi-squared distribution with n degrees
of freedom (Section A.1, Example (e)).
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A.8 Suppose that X = (X1, . . . ,Xn)
′ ∼ N(μ, �) with � nonsingular. If A is a

symmetric n × n matrix, show that E(X′AX) = trace(A�)+ μ′�μ.

A.9 Suppose that {Xt} is a stationary Gaussian time series with mean 0 and autoco-
variance function γ (h). Find E(Xt|Xs) and Var(Xt|Xs), s �= t.



B Statistical Complements

B.1 Least Squares Estimation
B.2 Maximum Likelihood Estimation
B.3 Confidence Intervals
B.4 Hypothesis Testing

B.1 Least Squares Estimation

Consider the problem of finding the “best” straight line

y = θ0 + θ1x

to approximate observations y1, . . . , yn of a dependent variable y taken at fixed values
x1, . . . , xn of the independent variable x. The (ordinary) least squares estimates θ̂0,
θ̂1 are defined to be values of θ0, θ1 that minimize the sum

S(θ0, θ1) =
n∑

i=1

(yi − θ0 − θ1xi)
2

of squared deviations of the observations yi from the fitted values θ0 + θ1xi. (The
“sum of squares” S(θ0, θ1) is identical to the Euclidean squared distance between y
and θ01 + θ1x, i.e.,

S(θ0, θ1) = ‖y − θ01 − θ1x‖2,

where x = (x1, . . . , xn)′, 1 = (1, . . . , 1)′, and y = (y1, . . . , yn)′.) Setting the partial
derivatives of S with respect to θ0 and θ1 both equal to zero shows that the vector
θ̂ = (θ̂0, θ̂1)

′ satisfies the “normal equations”

X′Xθ̂ = X′y,

© Springer International Publishing Switzerland 2016
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where X is the n× 2 matrix X = [1, x]. Since 0 ≤ S(θ) and S(θ) → ∞ as ‖θ‖ → ∞,

the normal equations have at least one solution. If θ̂
(1)

and θ̂
(2)

are two solutions of the
normal equations, then a simple calculation shows that

(
θ̂
(1) − θ̂

(2))′
X′X

(
θ̂
(1) − θ̂

(2)) = 0,

i.e., that Xθ̂
(1) = Xθ̂

(2)
. The solution of the normal equations is unique if and only if

the matrix X′X is nonsingular. But the preceding calculations show that even if X′X is
singular, the vector ŷ = Xθ̂ of fitted values is the same for any solution θ̂ of the normal
equations.

The argument just given applies equally well to least squares estimation for the
general linear model. Given a set of data points

(xi1, xi2, . . . , xim, yi), i = 1, . . . , n with m ≤ n,

the least squares estimate, θ̂ = (
θ̂1, . . . , θ̂m

)′
of θ = (θ1, . . . , θm)

′ minimizes

S(θ) =
n∑

i=1

(yi − θ1xi1 − · · · − θmxim)2 = ∥
∥y − θ1x(1) − · · · − θmx(m)

∥
∥2
,

where y = (y1, . . . , yn)′ and x( j ) = (x1j, . . . , xnj)′, j = 1, . . . ,m. As in the previous
special case, θ̂ satisfies the equations

X′Xθ̂ = X′y,

where X is the n × m matrix X = [
x(1), . . . , x(m)

]
. The solution of this equation is

unique if and only if X′X nonsingular, in which case

θ̂ = (X′X)−1X′y.

If X′X is singular, there are infinitely many solutions θ̂ , but the vector of fitted values
Xθ̂ is the same for all of them.

Example B.1.1. To illustrate the general case, let us fit a quadratic function

y = θ0 + θ1x + θ2x
2

to the data

x 0 1 2 3 4

y 1 0 3 5 8

The matrix X for this problem is

X =

⎡

⎢
⎢
⎢
⎢
⎣

1 0 0
1 1 1
1 2 4
1 3 9
1 4 16

⎤

⎥
⎥
⎥
⎥
⎦
, giving (X′X)−1 = 1

140

⎡

⎣
124 −108 20

−108 174 −40
20 −40 10

⎤

⎦ .

The least squares estimate θ̂ = (
θ̂0, θ̂1, θ̂2

)′
is therefore unique and given by

θ̂ = (X′X)−1X′y =
⎡

⎣
0.6

−0.1
0.5

⎤

⎦ .
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The vector of fitted values is given by

ŷ = Xθ̂ = (0.6, 1, 2.4, 4.8, 8.2)′

as compared with the observed values

y = (1, 0, 3, 5, 8)′.
�

B.1.1 The Gauss–Markov Theorem

Suppose now that the observations y1, . . . , yn are realized values of random variables
Y1, . . . ,Yn satisfying

Yi = θ1xi1 + · · · + θmxim + Zi,

where Zi ∼ WN
(
0, σ 2

)
. Letting Y = (Y1, . . . ,Yn)

′ and Z = (Z1, . . . ,Zn)
′, we can

write these equations as

Y = Xθ + Z.

Assume for simplicity that the matrix X′X is nonsingular (for the general case see, e.g.,
Silvey 1975). Then the least squares estimator of θ is, as above,

θ̂ = (X′X)−1X′Y,

and the least squares estimator of the parameter σ 2 is the unbiased estimator

σ̂ 2 = 1

n − m

∥
∥Y − Xθ̂

∥
∥2
.

It is easy to see that θ̂ is also unbiased, i.e., that

E
(
θ̂
) = θ .

It follows at once that if c′θ is any linear combination of the parameters θi, i =
1, . . . ,m, then c′θ̂ is an unbiased estimator of c′θ . The Gauss–Markov theorem says
that of all unbiased estimators of c′θ of the form

∑n
i=1 aiYi, the estimator c′θ̂ has the

smallest variance.
In the special case where Z1, . . . ,Zn are IID N

(
0, σ 2

)
, the least squares estimator θ̂

has the distribution N
(
θ, σ 2(X′X)−1

)
, and (n − m)σ̂ 2/σ 2 has the χ2 distribution with

n − m degrees of freedom.

B.1.2 Generalized Least Squares

The Gauss–Markov theorem depends on the assumption that the errors Z1, . . . ,Zn are
uncorrelated with constant variance. If, on the other hand, Z = (Z1, . . . ,Zn)

′ has mean
0 and nonsingular covariance matrix σ 2� where � �= I, we consider the transformed
observation vector U = R−1Y, where R is a nonsingular matrix such that RR′ = �.
Then

U = R−1Xθ + W = Mθ + W,

where M = R−1X and W has mean 0 and covariance matrix σ 2I. The Gauss–Markov
theorem now implies that the best linear estimate of any linear combination c′θ is c′θ̂ ,
where θ̂ is the generalized least squares estimator, which minimizes

‖U − Mθ‖2.
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In the special case where Z1, . . . ,Zn are uncorrelated and Zi has mean 0 and variance
σ 2r2

i , the generalized least squares estimator minimizes the weighted sum of squares

n∑

i=1

1

r2
i

(Yi − θ1xi1 − · · · − θmxim)2.

In the general case, if X′X and � are both nonsingular, the generalized least squares
estimator is given by

θ̂ = (M′M)−1M′U.

Although the least squares estimator (X′X)−1X′Y is unbiased if E(Z) = 0, even when
the covariance matrix of Z is not equal to σ 2I, the variance of the corresponding
estimate of any linear combination of θ1, . . . , θm is greater than or equal to the
estimator based on the generalized least squares estimator.

B.2 Maximum Likelihood Estimation

The method of least squares has an appealing intuitive interpretation. Its application
depends on knowledge only of the means and covariances of the observations. Maxi-
mum likelihood estimation depends on the assumption of a particular distributional
form for the observations, known apart from the values of parameters θ1, . . . , θm.
We can regard the estimation problem as that of selecting the most appropriate
value of a parameter vector θ , taking values in a subset Θ of Rm. We suppose that
these distributions have probability densities p(x; θ), θ ∈ Θ . For a fixed vector of
observations x, the function L(θ) = p(x; θ ) on Θ is called the likelihood function. A
maximum likelihood estimate θ̂(x) of θ is a value of θ ∈ Θ that maximizes the value
of L(θ) for the given observed value x, i.e.,

L
(
θ̂
) = p

(
x; θ̂(x)

) = max
θ∈Θ

p(x; θ).

Example B.2.1. If x = (x1, . . . , xn)′ is a vector of observations of independent N(μ, σ 2) random
variables, the likelihood function is

L
(
μ, σ 2

) = 1
(
2πσ 2

)n/2 exp

[

− 1

2σ 2

n∑

i=1

(xi − μ)2
]

, −∞ < μ < ∞, σ > 0.

Maximization of L with respect to μ and σ is equivalent to minimization of

−2 ln L
(
μ, σ 2) = n ln(2π)+ 2n ln(σ )+ 1

σ 2

n∑

i=1

(xi − μ)2.

Setting the partial derivatives of −2 ln L with respect to μ and σ both equal to zero
gives the maximum likelihood estimates

μ̂ = x = 1

n

n∑

i=1

xi and σ̂ 2 = 1

n

n∑

i=1

(xi − x)2.

�
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B.2.1 Properties of Maximum Likelihood Estimators

The Gauss–Markov theorem lent support to the use of least squares estimation by
showing its property of minimum variance among unbiased linear estimators. Maxi-
mum likelihood estimators are not generally unbiased, but in particular cases they can
be shown to have small mean squared error relative to other competing estimators.
Their main justification, however, lies in their good large-sample behavior.

For independent and identically distributed observations with true probability
density p(·; θ 0) satisfying certain regularity conditions, it can be shown that the
maximum likelihood estimator θ̂ of θ 0 converges in probability to θ 0 and that the
distribution of

√
n
(
θ̂−θ0

)
is approximately normal with mean 0 and covariance matrix

I(θ0)
−1, where I(θ) is Fisher’s information matrix with (i, j) component

Eθ

[
∂ ln p(X; θ)

∂θi

∂ ln p(X; θ)

∂θj

]

.

In time series analysis the situation is rather more complicated than in the case
of iid observations. “Likelihood” in the time series context is almost always used in
the sense of Gaussian likelihood, i.e., the likelihood computed under the (possibly
false) assumption that the series is Gaussian. Nevertheless, estimators of ARMA
coefficients computed by maximization of the Gaussian likelihood have good large-
sample properties analogous to those described in the preceding paragraph. For details
see Brockwell and Davis (1991), Section 10.8.

B.3 Confidence Intervals

Estimation of a parameter or parameter vector by least squares or maximum likelihood
leads to a particular value, often referred to as a point estimate. It is clear that this
will rarely be exactly equal to the true value, and so it is important to convey some
idea of the probable accuracy of the estimator. This can be done using the notion of
confidence interval, which specifies a random set covering the true parameter value
with some specified (high) probability.

Example B.3.1. If X = (X1, . . . ,Xn)
′ is a vector of independent N

(
μ, σ 2

)
random variables, we saw

in Section B.2 that the random variable Xn = 1
n

∑n
i=1 Xi is the maximum likelihood

estimator of μ. This is a point estimator of μ. To construct a confidence interval for μ
from Xn, we observe that the random variable

Xn − μ
S/

√
n

has Student’s t-distribution with n − 1 degrees of freedom, where S is the sample

standard deviation, i.e., S2 = 1
n−1

∑n
i=1

(
Xi − Xn

)2
. Hence,

P

[

−t1−α/2 <
Xn − μ
S/

√
n
< t1−α/2

]

= 1 − α,

where t1−α/2 denotes the (1 − α/2) quantile of the t-distribution with n− 1 degrees of
freedom. This probability statement can be expressed in the form
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P
[
Xn − t1−α/2S/

√
n < μ < Xn + t1−α/2S/

√
n
] = 1 − α,

which shows that the random interval bounded by Xn ± t1−α/2S/
√
n includes the true

value μ with probability 1 − α. This interval is called a (1 − α) confidence interval
for the mean μ.

�

B.3.1 Large-Sample Confidence Regions

Many estimators of a vector-valued parameter θ are approximately normally dis-
tributed when the sample size n is large. For example, under mild regularity conditions,
the maximum likelihood estimator θ̂(X) of θ = (θ1, . . . , θm)

′ is approximately
N
(
0, 1

n I(θ̂)
−1
)
, where I(θ) is the Fisher information defined in Section B.2. Conse-

quently,

n
(
θ̂ − θ

)′
I
(
θ̂
)(

θ̂ − θ
)

is approximately distributed as χ2 with m degrees of freedom, and the random set of
θ-values defined by

n
(
θ − θ̂

)′
I
(
θ̂
)(

θ − θ̂
) ≤ χ2

1−α(m)

covers the true value of θ with probability approximately equal to 1 − α.

Example B.3.2. For iid observations X1, . . . ,Xn from N
(
μ, σ 2

)
, a straightforward calculation gives,

for θ = (
μ, σ 2

)′
,

I(θ) =
[
σ−2 0

0 σ−4/2

]

.

Thus we obtain the large-sample confidence region for
(
μ, σ 2

)′
,

n
(
μ− Xn

)2
/σ̂ 2 + n(σ 2 − σ̂ 2)2/

(
2σ̂ 4) ≤ χ2

1−α(2),

which covers the true value of θ with probability approximately equal to 1 − α. This
region is an ellipse centered at

(
Xn, σ̂

2
)
.

�

B.4 Hypothesis Testing

Parameter estimation can be regarded as choosing one from infinitely many possible
decisions regarding the value of a parameter vector θ . Hypothesis testing, on the other
hand, involves a choice between two alternative hypotheses, a “null” hypothesis H0

and an “alternative” hypothesis H1, regarding the parameter vector θ . The hypotheses
H0 and H1 correspond to subsets Θ0 and Θ1 of the parameter set Θ . The problem
is to decide, on the basis of an observed data vector X, whether or not we should
reject the null hypothesis H0. A statistical test of H0 can therefore be regarded as a
partition of the sample space into one set of values of X for which we reject H0 and
another for which we do not. The problem is to specify a test (i.e., a subset of the
sample space called the “rejection region”) for which the corresponding decision rule
performs well in practice.
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Example B.4.1. If X = (X1, . . . ,Xn)
′ is a vector of independent N(μ, 1) random variables, we may

wish to test the null hypothesis H0: μ = 0 against the alternative H1: μ �= 0. A
plausible choice of rejection region in this case is the set of all samples X for which∣
∣Xn

∣
∣ > c for some suitably chosen constant c. We shall return to this example after

considering those factors that should be taken into account in the systematic selection
of a “good” rejection region.

�

B.4.1 Error Probabilities

There are two types of error that may be incurred in the application of a statistical
test:

• type I error is the rejection of H0 when it is true.

• type II error is the acceptance of H0 when it is false.

For a given test (i.e., for a given rejection region R), the probabilities of error can both
be found from the power function of the test, defined as

Pθ (R), θ ∈ Θ,
where Pθ is the distribution of X when the true parameter value is θ . The probabilities
of a type I error are

α(θ) = Pθ(R), θ ∈ Θ0,

and the probabilities of a type II error are

β(θ) = 1 − Pθ(R), θ ∈ Θ1.

It is not generally possible to find a test that simultaneously minimizes α(θ) and β(θ)
for all values of their arguments. Instead, therefore, we seek to limit the probability of
type I error and then, subject to this constraint, to minimize the probability of type II
error uniformly on Θ1. Given a significance level α, an optimum level-α test is a test
satisfying

α(θ) ≤ α, for all θ ∈ Θ0,

that minimizes β(θ) for every θ ∈ Θ1. Such a test is called a uniformlymost powerful
(U.M.P.) test of level α. The quantity supθ∈Θ0

α(θ) is called the size of the test.
In the special case of a simple hypothesis vs. a simple hypothesis, e.g., H0: θ = θ0

vs. H1: θ=θ1, an optimal test based on the likelihood ratio statistic can be constructed
(see Silvey 1975). Unfortunately, it is usually not possible to find a uniformly most
powerful test of a simple hypothesis against a composite (more than one value of θ)
alternative. This problem can sometimes be solved by searching for uniformly most
powerful tests within the smaller classes of unbiased or invariant tests. For further
information see Lehmann (1986).

B.4.2 Large-Sample Tests Based on Confidence Regions

There is a natural link between the testing of a simple hypothesis H0: θ = θ0

vs. H1: θ �= θ0 and the construction of confidence regions. To illustrate this
connection, suppose that θ̂ is an estimator of θ whose distribution is approximately
N
(
θ, n−1I−1(θ)

)
, where I(θ) is a positive definite matrix. This is usually the case, for

example, when θ̂ is a maximum likelihood estimator and I(θ) is the Fisher information.
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As in Section B.3.1, we have

Pθ

(
n
(
θ − θ̂

)′
I
(
θ̂
)(

θ − θ̂
) ≤ χ2

1−α(m)
) ≈ 1 − α.

Consequently, an approximate α-level test is to reject H0 if

n
(
θ0 − θ̂

)′
I
(
θ̂
)(

θ0 − θ̂
)
> χ2

1−α(m),

or equivalently, if the confidence region determined by those θ’s satisfying

n
(
θ − θ̂

)′
I
(
θ̂
)(

θ − θ̂
) ≤ χ2

1−α(m)

does not include θ0.

Example B.4.2. Consider again the problem described in Example B.4.1. Since Xn ∼N
(
μ, n−1

)
, the

hypothesis H0: μ = 0 is rejected at level α if

n
(
Xn

)2
> χ2

1−α,1,

or equivalently, if

∣
∣Xn

∣
∣ >

�1−α/2
n1/2

.

�



C Mean Square Convergence

C.1 The Cauchy Criterion

The sequence Sn of random variables is said to converge in mean square to the random
variable S if

E(Sn − S)2 → 0 as n → ∞.
In particular, we say that the sum

∑n
k=1 Xk converges (in mean square) if there exists

a random variable S such that E
(∑n

k=1 Xk − S
)2 → 0 as n → ∞. If this is the case,

then we use the notation S = ∑∞
k=1 Xk.

C.1 The Cauchy Criterion

For a given sequence Sn of random variables to converge in mean square to some
random variable, it is necessary and sufficient that

E(Sm − Sn)
2 → 0 as m, n → ∞

(for a proof of this see Brockwell and Davis (1991), Chapter 2). The point of the
criterion is that it permits checking for mean square convergence without having to
identify the limit of the sequence.

Example C.1.1. Consider the sequence of partial sums Sn = ∑n
t=−n atZt, n = 1, 2, . . ., where {Zt} ∼

WN
(
0, σ 2

)
. Under what conditions on the coefficients ai does this sequence converge

in mean square? To answer this question we apply the Cauchy criterion as follows. For
n > m > 0,
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E(Sn − Sm)
2 = E

⎛

⎝
∑

m<|i|≤n

aiZi

⎞

⎠

2

= σ 2
∑

m<|i|≤n

a2
i .

Consequently, E(Sn − Sm)2 → 0 if and only if
∑

m<|i|≤n a
2
i → 0. Since the Cauchy

criterion applies also to real-valued sequences, this last condition is equivalent to
convergence of the sequence

∑n
i=−n a

2
i , or equivalently to the condition

∞∑

i=−∞
a2
i < ∞. (C.1.1)

�

Properties of Mean Square Convergence:
If Xn → X and Yn → Y , in mean square as n → ∞, then

(a) E
(
X2
n

) → E
(
X2
)

,

(b) E(Xn) → E(X),

and

(c) E(XnYn) → E(XY).

Proof. See Brockwell and Davis (1991), Proposition 2.1.2. �



D Lévy Processes, Brownian
Motion and Itô Calculus

D.1 Lévy Processes
D.2 Brownian Motion and the Itô Integral
D.3 Itô Processes and Itô’s Formula
D.4 Itô Stochastic Differential Equations

D.1 Lévy Processes

Just as ARMA processes were defined as stationary solutions of stochastic difference
equations driven by white noise, the so-called CARMA (continuous-time ARMA)
models arise as stationary solutions of stochastic differential equations driven by Lévy
processes. In order to discuss these equations in more detail we first present a few
essential facts concerning Lévy processes. (For detailed accounts see Protter 2010;
Applebaum 2004; Bertoin 1996; Sato 1999.) They have already been introduced in
Definition 7.5.1, but for ease of reference we repeat the definition here.

Definition D.1.1. A Lévy process, {L(t), t ∈ R} is a process with the following properties:

(i) L(0) = 0.

(ii) L(t)− L(s) has the same distribution as L(t− s) for all s and t such that s ≤ t.

(iii) If (s, t) and (u, v) are disjoint intervals then L(t) − L(s) and L(v)− L(u) are
independent.

(iv) {L(t)} is continuous in probability, i.e. for all ε > 0 and for all t ∈ R,

lim
s→t

P(|L(t)− L(s)| > ε) = 0.
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It is known that every Lévy process has a version with sample-paths which are right
continuous with left limits (càdlàg for short). We shall therefore assume that our Lévy
processes have this property.

The characteristic function of L(t), φt(θ) := E(exp(iθL(t))), has the celebrated
Lévy-Khinchin representation, for t ≥ 0,

φt(θ) = exp(tξ(θ)), θ ∈ R,

where

ξ(θ) = iθμ− 1

2
θ2σ 2 +

∫

R

(eiθx − 1 − iθxI(−1,1)(x))ν(dx),

for some μ ∈ R, σ ≥ 0, and measure ν. I(−1,1) is the indicator function of the set
(−1, 1). The measure ν is known as the Lévy measure of the process L and satisfies
the conditions

ν({0}) = 0

and
∫

R

min(1, |u|2)ν(du) < ∞.

The triplet (σ 2, ν, μ) is often referred to as the characteristic triplet of the Lévy process
and completely determines all of its finite-dimensional distributions.

The measure ν characterizes the distribution of the jumps of the process. If, in
particular, ν is the zero measure then the characteristic function of L(t) for t ≥ 0, is
that of a normal random variable with E(L(t)) = μt and Var(L(t)) = σ 2t and the
process {L(t), t ∈ R} is Brownian motion (Example 7.5.1) with sample-paths which
are continuous (but nowhere differentiable).

If λ := ν(R) < ∞ then the expected number of jumps in any time-interval of
length t is λt and the expected number of jumps with size in (−∞, x] in the same
time interval is tν((−∞, x]) = λtF(x) where F is a probability distribution function.
The distribution function F is known as the jump-size distribution and λ is known as
the mean jump-rate. If σ 2 = 0 and m = λ

∫

(−1,1) xdF(x), then {L(t)} is a compound
Poisson process with parameters λ andF (Example 7.5.2) and with sample paths which
are constant except for jumps.

If λ = ∞ then the expected number of jumps in every interval of positive length
is infinite and the process {L(t)} is said to have infinite activity. The gamma process
of Example 11.5.1 is such a process with characteristic triplet (0, ν, α(1 − e−β)/β),
where ν is the measure defined on subsets of (0,∞) by,

ν(dx) = αx−1e−βxI(0,∞)(x)dx.

The Lévy-Khinchin representation of the characteristic function of L(t) shows that
the distribution of L(t) can, by appropriate choice of the characteristic triplet, be any
infinitely divisible distribution. This family includes a vast array of distributions such
as the normal distributions, compound Poisson distributions, Student’s t-distributions,
the stable distributions and many others. In particular it includes distributions which
have heavy tails and which are not necessarily symmetric. These features allow for
great flexibility when modelling observed phenomena in both financial and physical
contexts.

In this appendix we shall restrict attention to Lévy processes for which
EL(1)2 < ∞. This constraint is not serious for most applications in finance where
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it is generally believed that second moments exist while higher moments (those of
order four or more) may not. For Lévy processes with EL(1)2 < ∞ it follows from
the definition that there are finite constants m and s ≥ 0 such that

EL(t) = mt and Var(L(t)) = s2t for all t ≥ 0.

In the following sections we shall focus on Brownian motion and stochastic
differential equations driven by Brownian motion.

In order to develop the necessary tools we introduce the Itô stochastic integral, Itô
processes and Itô’s formula. Following this we shall outline some results concerning
the solution of stochastic differential equations and use them to expand on the
treatment of Gaussian CARMA processes and their Lévy-driven generalizations in
Section 11.5.

D.2 Brownian Motion and the Itô Integral

Robert Brown (1828) observed the erratic motion of pollen particles in a liquid which
was later explained by the irregular bombardment of the particles by the molecules of
the liquid. In order to provide amathematical model for the one-dimensional version of
this process, Einstein (1905) postulated the existence of a process satisfying conditions
(i)–(iii) of Definition D.1.1 with L(t) normally distributed for every t. Bachelier (1900)
had in fact already proposed such a model for the prices of stocks on the Paris stock
exchange. It was later shown byWiener that there is a process with continuous sample-
paths satisfying these conditions, a process which has come to be known as a Brownian
motion or Wiener process. It is in fact the only Lévy process with continuous sample-
paths, a feature which adds to its plausibility as a model for the physical process
originally observed by Brown. Although the sample-paths are continuous they are far
from smooth in the sense that they are nowhere differentiable. We shall not attempt to
prove these properties here but refer to the books of Mikosch (1998), Klebaner (2005)
and Oksendal (2013) for further details. In the following sections we shall give an
outline of the essentials of Itô calculus adapted from the more extensive treatment of
Øksendal.

For modelling more complex physical phenomena it is often appropriate to
suppose that the increment dX(t) of the observed process {X(t)} in the infinitesimally
small time interval (t, t + dt) satisfies an equation of the form

dX(t) = b(t,X(t))dt + σ (t,X(t))dB(t), S ≤ t ≤ T, (D.2.1)

where dB(t) denotes the increment of a standard Brownian motion in the same time
interval. In order to attach a precise meaning to (D.2.1) we first consider the following
discrete approximation. For any fixed positive integer n, consider the grid of time
points {2−nk, k ∈ Z} and define

tk =

⎧
⎪⎨

⎪⎩

2−nk, if S ≤ 2−nk ≤ T,

S, if 2−nk < S,

T, if 2−nk > T.

(D.2.2)

A discrete approximation to (D.2.1) is then

Xn
j+1 = Xn

j + b(tj,X
n
j )�tj + σ (tj,Xn

j )�Bj, [2nS] ≤ j ≤ [2nT], (D.2.3)
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where Xn
j := X(tj), �tj := tj+1 − tj, and �Bj := B(tj+1) − B(tj). For given functions

b and σ and for any given initial condition, Xn
[2nS] = X(S), and values of B(tj), j ≤ k,

equation (D.2.3) can be solved recursively for Xn
j , j ≤ k. The solution satisfies

Xn
j+1 = X(S)+

∑

k≤j

b(tk,X
n
k )�tk +

∑

k≤j

σ (tk,X
n
k )�Bk, [2nS] ≤ j ≤ [2nT].

(D.2.4)

This suggests that, under suitable conditions, as n → ∞, the random variables
Xn
j , [2nS] ≤ j ≤ [2nT] + 1, approximate (in a sense to be specified) a random process

{X(t), S ≤ t ≤ T} satisfying

X(t) = X(S)+
∫ t

S
b(u,X(u))du+

∫ t

S
σ (u,X(u))dB(u), S ≤ t ≤ T, (D.2.5)

In order to make sense of these statements, and to solve equations of the form
(D.2.5) we must first define what is meant by the integrals on the right-hand side. We
shall do this for non-anticipating integrands. The random process {X(t)} is said to be
a non-anticipating function of {B(t)} if, for each t, X(t) is a function of {B(s), s ≤ t}.
This property is the continuous-time analogue of causality, which we introduced in
connection with ARMAprocesses in Chapter 3. We shall use the notationFt to denote
the class of random variables on (�,F ,P) (the probability space on which {B(t)} is
defined) which are functions of {B(s), s ≤ t}. In this terminology {X(t)} is a non-
anticipating function of {B(t)} if X(t) ∈ Ft for all t.

To deal with the first integral in (D.2.5) we consider integrals of the form
∫ T

S
m(u)du, S < T, (D.2.6)

for functions m on R ×� belonging to the family M (S,T) defined by the properties
(i)–(iii) below. For clarity we have suppressed the dependence on ω ∈ � in (D.2.5)
and (D.2.6), but in fact X and m are both functions on R×� with values X(u, ω) and
m(u, ω) respectively.

Defining properties of m ∈ M (S,T):

(i) m(·, ·) is a measurable function on R ×�.
(ii) m(t, ·) ∈ Ft for each t ∈ R.

(iii) P
[∫ T

S |m(u, ω)|du < ∞
]

= 1.

For m ∈ M (S,T) the integrals
∫ t
S m(u)du, t ∈ [S,T], can be defined for all ω

outside a set of probability zero as straightforward Lebesgue integrals, continuous
in t. Specifying them to be zero on the exceptional subset of � defines

∫ t
S m(u)du, t ∈

[S,T], as a continuous function of t for each ω.
In order to attach a meaning to the second integral in (D.2.5) we need to define

integrals of the form
∫ T

S
f (u)dB(u), S < T, (D.2.7)

where the random variables f (u), defined on the same probability space (�,F ,P) as
{B(t)}, satisfy the properties (i)–(iii) specified below. We shall denote the class of such
functions asN (S,T) and an integral of the form (D.2.7) as an Itô integral.
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Defining properties of f ∈ N (S,T):

(i) f (·, ·) is a measurable function on R ×�.
(ii) f (t, ·) ∈ Ft for each t ∈ R.

(iii) E
[∫ T

S f (t, ω)2dt
]
< ∞.

The construction of the integral (D.2.7) is achieved by defining it for elementary
functions and then extending the definition to all functions f ∈ N (S,T). The function
e is an elementary function if for some positive integer n,

e(u, ω) =
∞∑

j=−∞
ej(ω)I(2−nj,2−n(j+1)](u), u ∈ R, ω ∈ �, (D.2.8)

where the random variables ej belong to Ftj for all j and the times tj are defined as in
(D.2.2). Since the function e(u, ω) is independent of u on the interval (2−nj, 2−n(j+1)],
and since B increases on that interval by �Bj := B(tj+1)− B(tj), it is natural to define
(suppressing ω as in (D.2.7)),

IS,T(e) =
∫ T

S
e(u)dB(u) :=

∞∑

j=−∞
ej�Bj, S < T. (D.2.9)

Proposition D.2.1. If e is bounded and elementary then

E

(∫ T

S
e(u)dB(u)

)2

= E

(∫ T

S
e(u)2du

)

, S < T. (D.2.10)

Proof. Observing that E(eiej�Bi�Bj) = δijE(e2
j )�tj, where δij = 1 if i = j and 0 otherwise,

we can rewrite the left-hand side of (D.2.10) as

E
∞∑

i=−∞

∞∑

j=−∞
(eiej�Bi�Bj) =

∞∑

j=−∞
E(e2

j )�tj = E
∞∑

j=−∞
e2
j�tj = E

∫ T

S
e(t)2 dt.

�

Remark 1. The left-hand side of (D.2.10) is the squared norm of the random variable
IS,T(e) defined on (�,F ,P). The right-hand side is the squared norm of the function

e∗(u, ω) :=
{
e(u, ω), if (u, ω) ∈ [S,T] ×�,
0, otherwise,

a square integrable function on the product space [S,T]×�with respect to the product
measure � × P, where � denotes Lebesgue measure. The mapping e �→ IS,T(e) thus
determines an isometry from the restrictions e∗ of the bounded elementary functions
e to [S,T] ×� into the space of square integrable random variables on (�,F ,P).

It can be shown (see e.g., Oksendal 2013) that for every function f ∈ N (S,T)
there is a sequence of bounded elementary functions {en} such that

E
∫ T

S
(en(u)− f (u))2du → 0 as n → ∞. (D.2.11)
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This implies that E
∫ T
S (en(u) − em(u))2du → 0 as m and n both go to ∞ and, by the

isometry, that

E(IS,T(en − em))
2 = E

(
IS,T(en)− IS,T(em)

)2 → 0.

By the Cauchy property of mean square convergence (Appendix C.1) it follows that
{IS,T(en)} has a mean square limit.

If {gn} is another sequence of bounded elementary functions with the property
(D.2.11) then E

∫ T
S (en(u)− gn(u))2du → 0 as n → ∞ so that

E(IS,T((en − gn))
2 = E(IS,T(en)− IS,T(gn))

2 → 0.

Hence the mean square limit of IS,T(en) is the same for all sequences of bounded
elementary functions satisfying (D.2.11) and the common limit is defined to be IS,T(f ).
Thus IS,T(f ) can be defined unambiguously as

IS,T(f ) := lim
m.s.

IS,T(en), (D.2.12)

where {en} is any sequence of bounded elementary functions satisfying (D.2.11).
Moreover if f ∈ N (S,T) and {en} satisfies (D.2.11), then

E
(
IS,T(f )

2
) = lim

n→∞E
(
IS,T(en)

2
) = lim

n→∞E
∫ T

S
e2
n(u)du = E

∫ T

S
f 2(u)du,

showing that the isometry of the restrictions e∗ of bounded elementary functions
extends to the corresponding restrictions f ∗ of all functions in N (S,T).

This means that, in principle, IS,T(f ) can be evaluated as the mean-square limit
of
∫ T
S xn(u)dB(u) where {xn} is any (not necessarily bounded) sequence of elementary

functions such that E
∫ T
S (xn(u) − f (u))2du → 0 as n → ∞. In particular it can be

shown in this way that
∫ T

S
B(u)dB(u) = 1

2
(B2(T)− B2(S))− 1

2
(T − S).

We shall not go into the details as we shall derive this result in a much simpler way
using the tools of Itô calculus to be discussed in the following section. �

Remark 2. If f ∈ N (S,T) then for each t ∈ [S,T] so also is the function,
{f (ω, u)1[S,t](u), ω ∈ �, u ∈ R}, where 1[S,t] is the indicator function of the set [S, t].
This enables us to define

∫ t

S
f (u)dB(u) :=

∫ T

S
f (u)1[S, t](u)du

for each t ∈ [S,T] and each f ∈ N (S,T). �

Remark 3. If f ∈ N := ∩N (S,T), where ∩ denotes the intersection over all S ∈ R

and T ∈ R such that S ≤ T , then Is,t(f ) is defined for all real-valued s and t such that
s ≤ t and the integral has the properties,

(i) EIs,t(f ) = 0.
(ii) Is,u(f ) = Is,t(f )+ It,u(f ), s ≤ t ≤ u.
(iii) Is,t(af + bg) = aIs,t(f )+ bIs,t(g) for all a, b ∈ R and g ∈ N .
(iv) E

[
Is,t(f )Is,t(g)

] = E
∫ t
s f (u)g(u)du for all g ∈ N .
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(v) For each fixed s ∈ R, {Is,t(f ), t ≥ s} is an Ft-martingale, i.e. E|Is,t(f )| < ∞ and

E(Is,u(f )|B(y), y ≤ t) = Is,t(f ), u ≥ t ≥ s.

(vi) For each fixed s ∈ R and for each fixed T ≥ s there is a version of {Is,t(f ), s ≤
t ≤ T} which is continuous in t. In other words there is a process {Xt, s ≤ t ≤ T}
with continuous sample-paths such that

P(Xt =
∫ t

s
f (u)dB(u)) = 1 for all t ∈ [s,T].

Properties (i)–(iv) are clearly true for bounded elementary functions f and g. Their
validity for functions in N can be established by taking limits. Property (v) follows
from (ii) and the independence of the increments of {B(t)}. The proof of property (vi)
is beyond the scope of this book [see, e.g., Oksendal (2013) for details]. �

D.3 Itô Processes and Itô’s Formula

Direct evaluation of Itô stochastic integrals from the definition (D.2.12) is very messy.
For example, it can be shown by a lengthy calculation from the definition that

∫ t

0
B(u)dB(u) = 1

2
B(t)2 − 1

2
t.

Itô’s formula provides a chain rule for evaluating such integrals. It is clear from this
example that the classic rule for Riemann integration does not apply. If, for example,
we apply it in this particular case we find, from the rule d(x2) = 2xdx, that the integral
is 1

2B(t)
2 instead of the correct expression above. Before we can derive the appropriate

rule however we first need to define what is meant by an Itô process.

Itô Process

This is a process which satisfies (suppressing the argument ω as before)

X(t) = X(s)+
∫ t

s
m(u)du +

∫ t

s
f (u)dB(u), s ≤ t ∈ R, (D.3.1)

where

X(t) ∈ Ft for all t ∈ R, (D.3.2)

m ∈ M (S,T) for all S ≤ T ∈ R (D.3.3)

and

f ∈ N ∗(S,T) for all S ≤ T ∈ R, (D.3.4)

with M (S,T) defined as in Section E.2 and N ∗(S,T) defined like N (S,T) in

Section E.2 except for the replacement of property (iii), E
[∫ T

S f (u)2du
]
< ∞, by

the weaker condition,
(iii)∗ P

[∫ T
S f (u)2du < ∞

]
= 1.

It can be shown that, under this weaker condition, the integrals Is,t(f ), s ≤ t ∈ R,
can still be defined, retaining all of the properties in Remark 3 of Section E.2 with the
exception of the martingale property (v).
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Definition (D.3.1) is often written in the shorthand notation,

dX(t) = m(t) dt + f (t) dB(t). (D.3.5)

Both of the integrals in (D.3.1) are assumed to be continuous versions so that the Itô
process {X(t)} is also continuous. The first integral is usually referred to as the drift
component of {X(t)} and the second as the Brownian component.

Itô’s Formula
Itô’s formula is concerned with smooth functions of Itô processes. Specifically it

states that if {X(t)} is an Itô process satisfying (D.3.5) and {g(t, x)} is a function on
R × R with continuous partial derivatives ∂g/∂t and ∂2g/∂x2 then

(i) Y(t) := g(t,X(t)) is an Itô process and

(ii)

dY(t) = ∂g

∂t
(t,X(t)) dt + ∂g

∂x
(t,X(t)) dX(t)+ 1

2

∂2g

∂x2
(t,X(t)) (dX(t))2,

(D.3.6)

where dX(t) = m dt + f dB(t) and (dX(t))2 = f 2 dt.

Writing gt, gx and gxx for the corresponding partial derivatives of g evaluated at
(t,X(t)), and substituting for dX(t) and dX(t)2 as indicated in (ii), we can write the
increment of Y(t) explicitly in the form (D.3.5) as

dY(t) = (gt + mgx + 1

2
v2gxx) dt + fgx dB(t). (D.3.7)

Example D.3.1.
∫ t

0 B(u)dB(u)

Inspection of (D.3.7) suggests that in order to find a process with increments B(u)dB(u)
we should start with the Itô process X(t) = B(t), for whichm = 0 and f = 1, and define
Y(t) = g(t,X(t)) where gx(t, x) = x. Taking g(t, x) = x2/2 we obtain, from (D.3.7),

dY(t) = 1

2
dt + B(t)dB(t),

which gives
∫ t

0
B(u)dB(u) = Y(t)− Y(0)− 1

2
t = 1

2
B(t)2 − 1

2
t.

�
Multivariate Itô Processes
An n-dimensional Itô process {X(t)} is defined to be an n-dimensional vector-valued
process satisfying an equation (cf. (D.3.5),

dX(t) = m(t) dt + F(t) dB(t), (D.3.8)

where {B(t)} is m-dimensional standard Brownian motion, i.e. an m-dimensional
random process with components which are independent one-dimensional standard
Brownian motions, the components of the n-vectors X(t) andm(t) satisfy (D.3.2) and
(D.3.3) respectively, and each component fij of the n×mmatrix F(t) satisfies (D.3.4).
The more explicit form of (D.3.8), corresponding to (D.3.1), is

X(t) = X(s)+
∫ t

s
m(u) du +

∫ t

s
F(u) dB(u), s ≤ t ∈ R. (D.3.9)
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The Multidimensional Itô Formula
The multidimensional version of Itô’s formula states that if {X(t)} is an n-dimensional
Itô process satisfying (D.3.9) and {g(t, x)} is a function on R × R

n with values in R
p

and with continuous second partial derivatives, then

(i) {Y(t) := g(t,X(t)) is a p-dimensional Itô process and

(ii)

dYi(t) = ∂gi
∂t

dt +
n∑

j=1

∂gi
∂xj

dXj(t)+ 1

2

n∑

j=1

n∑

k=1

∂2gi
∂xj∂xk

dXj(t)dXk(t),

(D.3.10)

where Xi, Yi and gi are the components of X, Y and g respectively, and the partial
derivatives of g are all evaluated at (t,X(t)). The increments dXj satisfy the relations
dXj(t) = mj dt+∑n

r=1 fjr dBr(t) and dXj(t)dXk(t) = ∑n
r=1 fjrfkr dt, where mj and fij

are the components of m(t) and F(t) respectively.

In the following section we shall consider solutions of stochastic differential
equations of the form

dX(t) = b(t,X(t)) dt + σ (t,X(t)) dB(t), S < t < T, XS = Z, (D.3.11)

where {B(t)} ism-dimensional standard Brownian motion. Conditions on the functions
b and σ and the initial random variable Z which guarantee existence and uniqueness
of solutions will be specified in Theorem D.4.1, a proof of which can be found in
Oksendal (2013).

D.4 Itô Stochastic Differential Equations

The equation (D.3.11) is known as an Itô stochastic differential equation for the Rn-
valued random process {X(t)}. Equations (7.5.6), for geometric Brownian motion,
(11.5.2), for the CAR(1) process, and (11.5.9), for the state vector of a CARMA
process, are special cases. It is trivial to check, in each of these cases, that the conditions
on b and σ given in the following theorem are satisfied for all S and T ∈ Rwith T > S.
Provided the conditions on the initial random vector Z are satisfied, these guarantee
the existence and uniqueness of a continuous solution of (D.3.11). After stating the
theorem we shall use Itô’s formula to derive solutions of the particular Itô equations
(7.5.6) and (11.5.9). The solution of (11.5.2) was discussed in Section 11.5.1.

Theorem D.4.1. Suppose that S < T ∈ R and that the measurable functions b :
[S,T] × R

n �→ R
n and σ : [S,T] × R

n �→ R
n × R

m in (D.3.11) have the properties

|b(t, x)| + |σ (t, x)| < C(1 + |x|), x ∈ R
n, t ∈ [S,T]

and

|b(t, x − b(t, y)| + |σ (t, x − σ (t, y)| < D|x − y|,
where C and D are finite positive constants and |M| denotes the (positive) square root
of the sum of squares of the components of the matrix or vector M. If Z is a random
variable independent of {B(t)− B(s), S ≤ s < t ≤ T} such that E|Z|2 < ∞, then the
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stochastic differential equation (D.3.11) has a unique continuous (in t) solution, each
component of which belongs to N ∗[S,T] as defined in (D.3.4).

Geometric Brownian Motion
Geometric Brownian motion was introduced in Section 7.5.2 as a continuous-time
model for asset prices and was the basis for the derivations by Black and Scholes
(1973) andMerton (1973) of the option-pricing formula discussed in Section 7.6. Here
we shall use Itô’s formula to find the solution {P(t), t ≥ 0} of the defining differential
equation,

dP(t) = P(t)[μdt + σdB(t)], t ≥ 0, (D.4.1)

where P(0) is a strictly positive random variable, independent of {B(t) − B(s), 0 ≤
s ≤ t < ∞}. The standard calculus identity, d(log(y)) = dy/y, suggests that we try
applying Itô’s formula with X(t) = P(t) and g(x, t) = log(x). The function g has
continuous partial derivatives, ∂g/∂t = 0, ∂g/∂x = 1/x and ∂2g/∂x2 = −1/x2 on the
set where x > 0. Substituting in (D.3.6) and using (D.4.1) we obtain �

d(logP(t)) = 1

P(t)
dP(t)− 1

2P(t)2
(dP(t))2 = μdt + σdB(t)− σ 2

2
dt,

(D.4.2)

whence

log(P(t))− log(P(0)) = (μ− σ 2

2
)t + σB(t).

This is equivalent to the solution (7.5.7) given earlier.

Gaussian CARMA Processes
The state equation (11.5.9) for the Gaussian CARMA(p, q) process, i.e.

dX(t) = AX(t)dt + edB(t), (D.4.3)

whereX(0) is independent of {B(t)−B(s), 0 ≤ s ≤ t ≤ T} and E|X(0)|2 < ∞, clearly
satisfies the conditions of Theorem D.4.1 and therefore has a unique solution which is
continuous in t. In order to find the solution we multiply both sides by the integrating
factor e−At, as we would if {B(t)} were deterministic. Since e−At is non-singular the
state equation is equivalent to the equation

e−AtdX(t)− e−AtAX(t)dt = e−AtedB(t). (D.4.4)

This form of the equation suggests applying the multivariate Itô formula with g(t, x) =
e−Atx. The second derivatives of g are all continuous and satisfy

∂2gi
∂xj∂xk

= 0 for all i, j and k,

∂gi
∂xj

= e′
ie

−Atej,

and
∂g
∂t

= −e′
iAe

−Atx.
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where er, r ∈ {1, . . . , p}, denotes a p-component column vector, all of whose
components are zero except for the rth, which is one. Substituting these derivatives
into (D.3.10) and writing the resulting equations in vector form we obtain

d(e−AtX(t)) = −Ae−AtX(t)dt + e−AtdX(t).

Substituting this expression in (D.4.4) gives

d(e−AtX(t)) = e−AtdB(t),

which implies that

e−AtX(t)− X(0) =
∫ t

0
e−AuedB(u),

or equivalently

X(t) = eAtX(0)+
∫ t

0
eA(t−u)edB(u), 0 ≤ t ≤ T. (D.4.5)

Since equation (D.4.1), with X(S) independent of {B(t) − B(s), S ≤ s ≤ t ≤ T}
and E|X(S)|2 < ∞, satisfies the conditions of Theorem D.4.1 for all S ∈ R and T ∈ R

such that S < T , exactly the same arguments give the more general relation,

X(t) = eA(t−S)X(S)+
∫ t

S
eA(t−u)e dB(u), t ≥ S, for all S ∈ R. (D.4.6)

This is equation (11.5.11) for which we showed (in Section 11.5.2) that the unique
causal stationary solution is

X(t) =
∫ t

−∞
eA(t−u)e dB(u), t ∈ R.

This led, with (11.5.8), to the definition of the zero-mean causal CARMA(p, q) process
{Y(t), t ∈ R} as

Y(t) =
∫ t

−∞
b′eA(t−u)e dB(u)

and, more generally in Section 11.5.3, to the second-order Lévy-driven CARMA(p, q)
process,

Y(t) =
∫

(−∞,t]
b′eA(t−u)e dL(u).
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The package ITSM2000 requires an IBM-compatible PC operating under Windows
XP or any subsequent Windows operating system. To install the package, go to http://
extras.springer.com and locate the extras for this book either by entering the ISBN
number or by choosing the year 2016. Choose the option Download Entire Contents
and you will receive a zip file containing ITSM.EXE, the data files, an introduction
called README.PDF and a searchable document of Help files, ITSM_HELP.PDF.
For a quick and easy introduction to the use of the package we recommend following
the instructions in README.PDF. For detailed help on each of the functions of the
program refer to ITSM_HELP.PDF.Under older Windows operating systems the Help
files can be accessed from the Help menu within ITSM itself, but this feature is not
yet supported by all versions of Windows so you may need to open ITSM_HELP.PDF
in a separate window while running the program.

When you unzip the downloaded zip file it will create a folder called ITSM2000
which contains all the necessary files for running the program. Double-click on the
ITSM icon or the ITSM-Shortcut icon to open the ITSM window. (You may wish
to copy and paste the ITSM-Shortcut icon to the desktop or some other convenient
location from which it can also be accessed.). The package ITSM2000 supersedes the
versions of the package ITSM2000 distributed with earlier editions of this book.

© Springer International Publishing Switzerland 2016
P.J. Brockwell, R.A. Davis, Introduction to Time Series and Forecasting,
Springer Texts in Statistics, DOI 10.1007/978-3-319-29854-2
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E.1 Getting Started

E.1.1 Running ITSM

Double-clicking on the ITSM or the ITSM-Shortcut icon will open the ITSMwindow.
To analyze one of the data sets provided, select File>Project>Open at the top
left corner of the ITSM window.

There are several distinct functions of the program ITSM. The first is to analyze
and display the properties of time series data, the second is to compute and display the
properties of time series models, and the third is to combine these functions in order to
fit models to data. The last of these includes checking that the properties of the fitted
model match those of the data in a suitable sense. Having found an appropriate model,
we can (for example) then use it in conjunction with the data to forecast future values
of the series. Sections E.2–E.5 of this appendix deal with the modeling and analysis of
data, while Section E.6 is concerned with model properties. Section E.7 explains how
to open multivariate projects in ITSM. Examples of the analysis of multivariate time
series are given in Chapter 8.

It is important to keep in mind the distinction between data and model properties
and not to confuse the data with the model. In any one project ITSM stores one data
set and one model (which can be identified by highlighting the project window and
pressing the red INFO button at the top of the ITSMwindow). Until a model is entered
by the user, ITSM stores the default model of white noise with variance 1. If the data are
transformed (e.g., differenced and mean-corrected), then the data are replaced in ITSM
by the transformed data. (The original data can, however, be restored by inverting the
transformations.) Rarely (if ever) is a real time series generated by a model as simple
as those used for fitting purposes. In model fitting the objective is to develop a model
that mimics important features of the data, but is still simple enough to be used with
relative ease.

The following sections constitute a tutorial that illustrates the use of some of the
features of ITSMby leading you through a complete analysis of the well-known airline
passenger series of Box and Jenkins (1976) filed as AIRPASS.TSM in the ITSM2000
folder.

E.2 Preparing Your Data for Modeling

The observed values of your time series should be available in a single-column ASCII
file (or two columns for a bivariate series). The file, like those provided with the
package, should be given a name with suffix .TSM. You can then begin model
fitting with ITSM. The program will read your data from the file, plot it on the
screen, compute sample statistics, and allow you to make a number of transformations
designed to make your transformed data representable as a realization of a zero-mean
stationary process.

Example E.2.1. To illustrate the analysis we shall use the file AIRPASS.TSM, which contains the
number of international airline passengers (in thousands) for each month from January,
1949, through December, 1960.

�
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E.2.1 Entering Data

Once you have opened the ITSM window as described above under Getting Started,
select the options File>Project>Open,and youwill see a dialog box inwhich you
can check either Univariate or Multivariate. Since the data set for this
example is univariate, make sure that the univariate option is checked and then click
OK. A window labeled Open File will then appear, in which you can either type
the name AIRPASS.TSM and click Open, or else locate the icon for AIRPASS.TSM
in the Open File window and double-click on it. You will then see a graph of the
monthly international airline passenger totals (measured in thousands) X1, . . . ,Xn,
with n = 144. Directly behind the graph is a window containing data summary
statistics.

An additional, second, project can be opened by repeating the procedure described
in the preceding paragraph. Alternatively, the data can be replaced in the cur-
rent project using the option File>Import File. This option is useful if you
wish to examine how well a fitted model represents a different data set. (See the
entry ProjectEditor in the ITSM_HELPFiles for information on multiple project
management. Each ITSM project has its own data set and model.) For the purpose of
this introduction we shall open only one project.

E.2.2 Information

If, with the window labeled AIRPASS.TSM highlighted, you press the red INFO
button at the top of the ITSMwindow, you will see the sample mean, sample variance,
estimated standard deviation of the sample mean, and the current model (white noise
with variance 1).

Example E.2.2. Go through the steps in Entering Data to open the project AIRPASS.TSM and use the
INFO button to determine the sample mean and variance of the series.

�

E.2.3 Filing Data

You may wish to transform your data using ITSM and then store it in another file. At
any time before or after transforming the data in ITSM, the data can be exported to
a file by clicking on the red Export button, selecting Time Series and File,
clicking OK, and specifying a new file name. The numerical values of the series can
also be pasted to the clipboard (and from there into another document) in the same way
by choosing Clipboard instead of File. Other quantities computed by the program
(e.g., the residuals from the current model) can be filed or pasted to the clipboard in
the same way by making the appropriate selection in the Export dialog box. Graphs
can also be pasted to the clipboard by right-clicking on them and selecting Copy to
Clipboard.

Example E.2.3. Copy the series AIRPASS.TSM to the clipboard, open Wordpad or some convenient
screen editor, and choose Edit>Paste to insert the series into your new document.
Then copy the graph of the series to the clipboard and insert it into your document in
the same way.

�
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E.2.4 Plotting Data

A time series graph is automatically plotted when you open a data file (with time
measured in units of the interval between observations, i.e., t = 1, 2, 3, . . .). To see
a histogram of the data press the rightmost yellow button at the top of the ITSM
screen. If you wish to adjust the number of bins in the histogram, select
Statistics>Histogram>Set Bin Count and specify the number of bins
required. The histogram will then be replotted accordingly.

To insert any of the ITSM graphs into a text document, right-click on the graph
concerned, select Copy to Clipboard, and the graph will be copied to the
clipboard. It can then be pasted into a document opened by any standard text editor
such asMS-Word orWordpad using theEdit>Pasteoption in the screen editor. The
graph can also be sent directly to a printer by right-clicking on the graph and selecting
Print. Another useful graphics feature is provided by the white Zoom buttons at the
top of the ITSM screen. The first and second of these enable you to enlarge a designated
segment or box, respectively, of any of the graphs. The third button restores the original
graph.

Example E.2.4. Continuing with our analysis of AIRPASS.TSM, press the yellow histogram button
to see a histogram of the data. Replot the histogram with 20 bins by selecting
Statistics>Histogram>Set Bin Count.

�

E.2.5 Transforming Data

Transformations are applied in order to produce data that can be successfully modeled
as “stationary time series.” In particular, they are used to eliminate trend and cyclic
components and to achieve approximate constancy of level and variability with time.

Example E.2.5. The airline passenger data (see Figure 10-4) are clearly not stationary. The level and
variability both increase with time, and there appears to be a large seasonal component
(with period 12). They must therefore be transformed in order to be represented as
a realization of a stationary time series using one or more of the transformations
available for this purpose in ITSM.

�

Box–Cox Transformations
Box–Cox transformations are performed by selecting Transform>Box-Cox and
specifying the value of the Box–Cox parameter λ. If the original observations are
Y1,Y2, . . . ,Yn, the Box–Cox transformation fλ converts them to fλ(Y1), fλ(Y2), . . . ,

fλ(Yn), where

fλ(y) =

⎧
⎪⎨

⎪⎩

yλ − 1

λ
, λ �= 0,

log(y), λ = 0.

These transformations are useful when the variability of the data increases or
decreases with the level. By suitable choice of λ, the variability can often be made
nearly constant. In particular, for positive data whose standard deviation increases
linearly with level, the variability can be stabilized by choosing λ = 0.

The choice of λ can be made visually by watching the graph of the data when
you click on the pointer in the Box–Cox dialog box and drag it back and forth along
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the scale, which runs from zero to 1.5. Very often it is found that no transformation is
needed or that the choice λ = 0 is satisfactory.

Example E.2.6. For the series AIRPASS.TSM, the variability increases with level, and the data are
strictly positive. Taking natural logarithms (i.e., choosing a Box–Cox transformation
with λ = 0) gives the transformed data shown in Figure E-1.

Notice how the amplitude of the fluctuations no longer increases with the level of
the data. However, the seasonal effect remains, as does the upward trend. These will
be removed shortly. The data stored in ITSM now consist of the natural logarithms of
the original data.

�

Classical Decomposition
There are two methods provided in ITSM for the elimination of trend and seasonality.
These are:

i. “classical decomposition” of the series into a trend component, a seasonal com-
ponent, and a random residual component, and

ii. differencing.

Classical decomposition of the series {Xt} is based on the model

Figure E-1
The series AIRPASS.TSM
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Xt = mt + st + Yt,

where Xt is the observation at time t, mt is a “trend component,” st is a “seasonal
component,” and Yt is a “random noise component,” which is stationary with mean
zero. The objective is to estimate the components mt and st and subtract them from the
data to generate a sequence of residuals (or estimated noise) that can then be modeled
as a stationary time series.

To achieve this, select Transform>Classical and you will see the Classical
Decomposition dialog box. To remove a seasonal component and trend, check the
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Figure E-2
The logged AIRPASS.TSM
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Seasonal Fit and Polynomial Fit boxes, enter the period of the seasonal
component, and choose between the alternatives Quadratic Trend and Linear
Trend. Click OK, and the trend and seasonal components will be estimated and
removed from the data, leaving the estimated noise sequence stored as the current
data set.

The estimated noise sequence automatically replaces the previous data stored in
ITSM.

Example E.2.7. The logged airline passenger data have an apparent seasonal component of period
12 (corresponding to the month of the year) and an approximately quadratic trend.
Remove these using the option Transform>Classical as described above. (An
alternative approach is to use the option Regression,which allows the specification
and fitting of polynomials of degree up to 10 and a linear combination of up to 4 sine
waves.)

Figure E-2 shows the transformed data (or residuals) Yt, obtained by removal of
trend and seasonality from the logged AIRPASS.TSM series by classical decomposi-
tion. {Yt} shows no obvious deviations from stationarity, and it would now be reason-
able to attempt to fit a stationary time series model to this series. To see how well the
estimated seasonal and trend components fit the data, select Transform>Show
Classical Fit. We shall not pursue this approach any further here, but turn
instead to the differencing approach. (You should have no difficulty in later returning
to this point and completing the classical decomposition analysis by fitting a stationary
time series model to {Yt}.)

�

Differencing
Differencing is a technique that can also be used to remove seasonal components and
trends. The idea is simply to consider the differences between pairs of observations
with appropriate time separations. For example, to remove a seasonal component of
period 12 from the series {Xt}, we generate the transformed series
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Yt = Xt − Xt−12.

It is clear that all seasonal components of period 12 are eliminated by this trans-
formation, which is called differencing at lag 12. A linear trend can be eliminated
by differencing at lag 1, and a quadratic trend by differencing twice at lag 1 (i.e.,
differencing once to get a new series, then differencing the new series to get a second
new series). Higher-order polynomials can be eliminated analogously. It is worth
noting that differencing at lag 12 eliminates not only seasonal components with period
12 but also any linear trend.

Data are differenced in ITSM by selecting Transform>Difference
and entering the required lag in the resulting dialog box.

Example E.2.8. Restore the original airline passenger data using the option File>Import File
and selecting AIRPASS.TSM. We take natural logarithms as in Example E.2.6
by selecting Transform>Box-Cox and setting λ = 0. The transformed
series can now be deseasonalized by differencing at lag 12. To do this select
Transform>Difference, enter the lag 12 in the dialog box, and click OK.
Inspection of the graph of the deseasonalized series suggests a further differencing at
lag 1 to eliminate the remaining trend. To do this, repeat the previous step with lag
equal to 1 and you will see the transformed and twice-differenced series shown in
Figure E-3.

�

Subtracting the Mean
The term ARMA model is used in ITSM to denote a zero-mean ARMA process (see
Definition 3.1.1). To fit such a model to data, the sample mean of the data should
therefore be small. Once the apparent deviations from stationarity of the data have been
removed, we therefore (in most cases) subtract the sample mean of the transformed
data from each observation to generate a series to which we then fit a zero-mean
stationary model. Effectively we are estimating the mean of the model by the sample
mean, then fitting a (zero-mean) ARMA model to the “mean-corrected” transformed
data. If we know a priori that the observations are from a process with zero mean, then
this process of mean correction is omitted. ITSM keeps track of all the transformations

Figure E-3
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(including mean correction) that are made. When it comes time to predict the original
series, ITSM will invert all these transformations automatically.

Example E.2.9. Subtract the mean of the transformed and twice-differenced series AIRPASS.TSM by
selecting Transform>Subtract Mean. To check the current model status press
the red INFO button, and you will see that the current model is white noise with
variance 1, since no model has yet been entered.

�

E.3 Finding a Model for Your Data

After transforming the data (if necessary) as described above, we are now in a position
to fit an ARMA model. ITSM uses a variety of tools to guide us in the search
for an appropriate model. These include the sample ACF (autocorrelation function),
the sample PACF (partial autocorrelation function), and the AICC statistic, a bias-
corrected form of Akaike’s AIC statistic (see Section 5.5.2).

E.3.1 Autofit

Before discussing the considerations that go into the selection, fitting, and checking of
a stationary time series model, we first briefly describe an automatic feature of ITSM
that searches through ARMA(p, q) models with p and q between specified limits (less
than or equal to 27) and returns the model with smallest AICC value (see Sections 5.5.2
and E.3.5). Once the data set is judged to be representable by a stationary model,
select Model>Estimation>Autofit. A dialog box will appear in which you
must specify the upper and lower limits for p and q. Since the number of maximum
likelihood models to be fitted is the product of the number of p-values and the number
of q-values, these ranges should not be chosen to be larger than necessary. Once the
limits have been specified, press Start, and the search will begin. You can watch the
progress of the search in the dialog box that continually updates the values of p and
q and the best model found so far. This option does not consider models in which the
coefficients are required to satisfy constraints (other than causality) and consequently
does not always lead to the optimal representation of the data. However, like the tools
described below, it provides valuable information on which to base the selection of an
appropriate model.

E.3.2 The Sample ACF and PACF

Pressing the second yellow button at the top of the ITSM window will produce graphs
of the sample ACF and PACF for values of the lag h from 1 up to 40. For higher
lags choose Statistics>ACF/PACF>Specify Lag, enter the maximum lag
required, and click OK. Pressing the second yellow button repeatedly then rotates
the display through ACF, PACF, and side-by-side graphs of both. Values of the ACF
that decay rapidly as h increases indicate short-term dependency in the time series,
while slowly decaying values indicate long-term dependency. For ARMA fitting it
is desirable to have a sample ACF that decays fairly rapidly. A sample ACF that is
positive and very slowly decaying suggests that the data may have a trend. A sample
ACFwith very slowly damped periodicity suggests the presence of a periodic seasonal
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component. In either of these two cases you may need to transform your data before
continuing.

As a rule of thumb, the sample ACF and PACF are good estimates of the ACF and
PACF of a stationary process for lags up to about a third of the sample size. It is clear
from the definition of the sample ACF, ρ̂(h), that it will be a very poor estimator of
ρ(h) for h close to the sample size n.

The horizontal lines on the graphs of the sample ACF and PACF are the bounds
±1.96/

√
n. If the data constitute a large sample from an independent white noise

sequence, approximately 95% of the sample autocorrelations should lie between
these bounds. Large or frequent excursions from the bounds suggest that we need a
model to explain the dependence and sometimes to suggest the kind of model we need
(see below). To obtain numerical values of the sample ACF and PACF, right-click on
the graphs and select Info.

The graphs of the sample ACF and PACF sometimes suggest an appropriate
ARMA model for the data. As a rough guide, if the sample ACF falls between the
plotted bounds ±1.96/

√
n for lags h > q, then an MA(q) model is suggested, while if

the sample PACF falls between the plotted bounds ±1.96/
√
n for lags h > p, then an

AR(p) model is suggested.
If neither the sample ACF nor PACF “cuts off” as in the previous paragraph, a

more refined model selection technique is required (see the discussion of the AICC
statistic in Section 5.5.2). Even if the sample ACF or PACF does cut off at some lag,
it is still advisable to explore models other than those suggested by the sample ACF
and PACF values.

Example E.3.1. Figure E-4 shows the sample ACF of the AIRPASS.TSMseries after taking logarithms,
differencing at lags 12 and 1, and subtracting the mean. Figure E-5 shows the
corresponding sample PACF. These graphs suggest that we consider an MA model
of order 12 (or perhaps 23) with a large number of zero coefficients, or alternatively
an AR model of order 12.

�

Figure E-4
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Figure E-5
The sample PACF
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E.3.3 Entering a Model

A major function of ITSM is to find an ARMA model whose properties reflect to
a high degree those of an observed (and possibly transformed) time series. Any
particular causal ARMA(p, q) model with p ≤ 27 and q ≤ 27 can be entered
directly by choosing Model>Specify, entering the values of p, q, the coeffi-
cients, and the white noise variance, and clicking OK. If there is a data set already
open in ITSM, a quick way of entering a reasonably appropriate model is to use
the option Model>Estimation>Preliminary,which estimates the coefficients
and white noise variance of an ARMAmodel after you have specified the orders p and
q and selected one of the four preliminary estimation algorithms available. An optimal
preliminary ARmodel can also be fitted by checking Find AR model with min
AICC in the Preliminary Estimation dialog box. If no model is entered or
estimated, ITSM assumes the default ARMA(0,0), or white noise, model

Xt = Zt,

where {Zt} is an uncorrelated sequence of random variables with mean zero and
variance 1.

If you have data and no particular ARMA model in mind, it is advisable to use
the option Model>Estimation>Preliminary or equivalently to press the blue
PRE button at the top of the ITSM window.

Sometimes you may wish to try a model found in a previous session or a
model suggested by someone else. In that case choose Model>Specify and enter
the required model. You can save both the model and data from any project by selecting
File>Project>Save as and specifying the name for the new file. When the new
file is opened, both the model and the data will be imported. To create a project with
this model and a new data set select File>Import File and enter the name of
the file containing the new data. (This file must contain data only. If it also contains
a model, then the model will be imported with the data and the model previously in
ITSM will be overwritten.)
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E.3.4 Preliminary Estimation

The option Model>Estimation>Preliminary contains fast (but not the most
efficient) model-fitting algorithms. They are useful for suggesting the most promising
models for the data, but should be followed by maximum likelihood estimation
using Model>Estimation>Max likelihood. The fitted preliminary model is
generally used as an initial approximation with which to start the nonlinear optimiza-
tion carried out in the course of maximizing the (Gaussian) likelihood.

To fit an ARMAmodel of specified order, first enter the values of p and q (see Sec-
tion 2.6.1). For pure AR models q = 0, and the preliminary estimation option offers a
choice between the Burg and Yule–Walker estimates. (The Burg estimates frequently
give higher values of the Gaussian likelihood than the Yule–Walker estimates.) If q =
0, you can also check the box Find AR model with min AICC to allow the
program to fit ARmodels of orders 0, 1, . . . , 27 and select the one with smallest AICC
value (Section 5.5.2). For models with q > 0, ITSM provides a choice between two
preliminary estimation methods, one based on the Hannan–Rissanen procedure and
the other on the innovations algorithm. If you choose the innovations option, a default
value ofmwill be displayed on the screen. This parameter was defined in Section 5.1.3.
The standard choice is the default value computed by ITSM. The Hannan–Rissanen
algorithm is recommended when p and q are both greater than 0, since it tends
to give causal models more frequently than the innovations method. The latter is
recommended when p = 0.

Once the required entries in the Preliminary Estimation dialog box have been
completed, click OK, and ITSM will quickly estimate the parameters of the selected
model and display a number of diagnostic statistics. (If p and q are both greater than
0, it is possible that the fitted model may be noncausal, in which case ITSM sets
all the coefficients to .001 to ensure the causality required for subsequent maximum
likelihood estimation. It will also give you the option of fitting a model of different
order.)

Provided that the fitted model is causal, the estimated parameters are given with
the ratio of each estimate to 1.96 times its standard error. The denominator (1.96 ×
standard error) is the critical value (at level .05) for the coefficient. Thus, if the ratio is
greater than 1 in absolute value, we may conclude (at level .05) that the corresponding
coefficient is different from zero. On the other hand, a ratio less than 1 in absolute
value suggests the possibility that the corresponding coefficient in the model may be
zero. (If the innovations option is chosen, the ratios of estimates to 1.96 × standard
error are displayed only when p = q or p = 0.) In the Preliminary Estimates window
you will also see one or more estimates of the white noise variance (the residual
sum of squares divided by the sample size is the estimate retained by ITSM) and
some further diagnostic statistics. These are −2 ln L

(
φ̂, θ̂, σ̂ 2

)
, where L denotes the

Gaussian likelihood (5.2.9), and the AICC statistic

−2 ln L + 2(p + q + 1)n/(n − p − q − 2)

(see Section 5.5.2).
Our eventual aim is to find amodel with as small an AICCvalue as possible. Small-

ness of the AICC value computed in the preliminary estimation phase is indicative of a
good model, but should be used only as a rough guide. Final decisions between models
should be based on maximum likelihood estimation, carried out using the option
Model>Estimation>Max likelihood, since for fixed p and q, the values of
φ,θ, and σ 2 that minimize the AICC statistic are the maximum likelihood estimates,
not the preliminary estimates. After completing preliminary estimation, ITSM stores
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the estimated model coefficients and white noise variance. The stored estimate of the
white noise variance is the sum of squares of the residuals (or one-step prediction
errors) divided by the number of observations.

A variety of models should be explored using the preliminary estimation algo-
rithms, with a view to finding the most likely candidates for minimizing AICC when
the parameters are reestimated by maximum likelihood.

Example E.3.2. To find the minimum-AICC Burg AR model for the logged, differenced, and mean-
corrected series AIRPASS.TSM currently stored in ITSM, press the blue PRE button,
set the MA order equal to zero, select Burg and Find AR model with min
AICC, and then click OK. The minimum-AICC ARmodel is of order 12 with an AICC
value of −458.13. To fit a preliminary MA(25) model to the same data, press the blue
PRE button again, but this time set the AR order to 0, the MA order to 25, select
Innovations, and click OK.

The ratios (estimated coefficient)/(1.96× standard error) indicate that the coeffi-
cients at lags 1 and 12 are nonzero, as suggested by the sample ACF. The estimated
coefficients at lags 3 and 23 also look substantial even though the corresponding ratios
are less than 1 in absolute value. The displayed values are as follows:

MA COEFFICIENTS
−0.3568 0.0673 −0.1629 −0.0415 0.1268
0.0264 0.0283 −0.0648 0.1326 −0.0762

−0.0066 −0.4987 0.1789 −0.0318 0.1476
−0.1461 0.0440 −0.0226 −0.0749 −0.0456
−0.0204 −0.0085 0.2014 −0.0767 −0.0789

RATIO OF COEFFICIENTS TO (1.96*STANDARD ERROR)
−2.0833 0.3703 −0.8941 −0.2251 0.6875
0.1423 0.1522 −0.3487 0.7124 −0.4061

−0.0353 −2.6529 0.8623 −0.1522 0.7068
−0.6944 0.2076 −0.1065 −0.3532 −0.2147
−0.0960 −0.0402 0.9475 −0.3563 −0.3659

The estimated white noise variance is 0.00115 and the AICC value is −440.93, which
is not as good as that of the AR(12) model. Later we shall find a subset MA(25) model
that has a smaller AICC value than both of these models.

�

E.3.5 The AICC Statistic

The AICC statistic for the model with parameters p, q,φ, and θ is defined (see
Section 5.5.2) as

AICC(φ,θ) = −2 ln L(φ,θ, S(φ,θ)/n)+ 2(p + q + 1)n/(n − p − q − 2),

and a model chosen according to the AICC criterion minimizes this statistic.
Model-selection statistics other than AICC are also available in ITSM.A Bayesian

modification of the AIC statistic known as the BIC statistic is also computed in the
option Model>Estimation>Max likelihood. It is used in the same way as
the AICC.

An exhaustive search for a model with minimum AICC or BIC value can be
very slow. For this reason the sample ACF and PACF and the preliminary estimation
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techniques described above are useful in narrowing down the range of models to
be considered more carefully in the maximum likelihood estimation stage of model
fitting.

E.3.6 Changing Your Model

The model currently stored by the program can be checked at any time by selecting
Model>Specify. Any parameter can be changed in the resulting dialog box,
including the white noise variance. The model can be filed together with the data for
later use by selecting File>Project>Save as and specifying a file name with
suffix .TSM.

Example E.3.3. Weshall now set some of the coefficients in the current model to zero. To do this choose
Model>Specify and click on the box containing the value −0.35676 of Theta(1).
Press Enter, and the value of Theta(2) will appear in the box. Set this to zero. Press
Enter again, and the value of Theta(3) will appear. Continue to work through the
coefficients, setting all except Theta(1), Theta(3), Theta(12), and Theta(23) equal to
zero. When you have reset the parameters, click OK, and the newmodel stored in ITSM
will be the subset MA(23) model

Xt = Zt − 0.357Zt−1 − 0.163Zt−3 − 0.499Zt−12 + 0.201Zt−23,

where {Zt} ∼ WN(0, 0.00115).
�

E.3.7 Maximum Likelihood Estimation

Once you have specified values of p and q and possibly set some coefficients to zero,
you can carry out efficient parameter estimation by selecting Model>Estimation>
Max likelihood or equivalently by pressing the blue MLE button.

The resulting dialog box displays the default settings, which in most cases will not
need to be modified. However, if you wish to compute the likelihood without maxi-
mizing it, check the box labeled No optimization. The remaining information
concerns the optimization settings. (With the default settings, any coefficients that are
set to zero will be treated as fixed values and not as parameters. Coefficients to be
optimized must therefore not be set exactly to zero. If you wish to impose further
constraints on the optimization, press the Constrain optimization button.
This allows you to fix certain coefficients or to impose multiplicative relationships
on the coefficients during optimization.)

To find the maximum likelihood estimates of your parameters, click OK, and the
estimated parameters will be displayed. To refine the estimates, repeat the estimation,
specifying a smaller value of the accuracy parameter in the Maximum Likelihood
dialog box.

Example E.3.4. To find the maximum likelihood estimates of the parameters in the model for the
logged, differenced, and mean-corrected airline passenger data currently stored in
ITSM, press the blue MLE button and click OK. The following estimated parameters
and diagnostic statistics will then be displayed:
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ARMA MODEL:
X(t) = Z(t)+(−.355) ∗ Z(t − 1)+(−.201) ∗ Z(t − 3)+(−.523) ∗ Z(t − 12)

+(.242) ∗ Z(t − 23)
WN Variance = .001250

MA Coefficients
THETA( 1)= -.355078 THETA( 3)= -.201125
THETA(12)= -.523423 THETA(23)= .241527
Standard Error of MA Coefficients
THETA( 1): .059385 THETA( 3): .059297
THETA(12): .058011 THETA(23): .055828

(Residual SS)/N = .125024E−02
AICC = -.486037E+03
BIC = -.487622E+03

-2 Ln(Likelihood)= -.496517E+03

Accuracy parameter = .00205000

Number of iterations = 5

Number of function evaluations = 46

Optimization stopped within accuracy level.

The last message indicates that the minimum of −2 ln L has been located with the
specified accuracy. If you see the message

Iteration limit exceeded,
then the minimum of −2 ln L could not be located with the number of iterations (50)
allowed. You can continue the search (starting from the point at which the iterations
were interrupted) by pressing the MLE button to continue the minimization and
possibly increasing the maximum number of iterations from 50 to 100.

�

E.3.8 Optimization Results

After maximizing the Gaussian likelihood, ITSMdisplays the model parameters (coef-
ficients and white noise variance), the values of −2 ln L, AICC, BIC, and information
regarding the computations.

Example E.3.5. The next stage of the analysis is to consider a variety of competing models and to select
the most suitable. The following table shows the AICC statistics for a variety of subset
moving average models of order less than 24.

Lags AICC

1 3 12 23 −486.04
1 3 12 13 23 −485.78
1 3 5 12 23 −489.95
1 3 12 13 −482.62
1 12 −475.91

The best of these models from the point of view of AICC value is the one with
nonzero coefficients at lags 1, 3, 5, 12, and 23. To obtain this model from the one
currently stored in ITSM, select Model>Specify, change the value of THETA(5)
from zero to .001, and click OK. Then reoptimize by pressing the blue MLE button and
clicking OK. You should obtain the noninvertible model
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Xt = Zt − 0.434Zt−1 − 0.305Zt−3 + 0.238Zt−5 − 0.656Zt−12 + 0.351Zt−23,

where {Zt} ∼ WN(0, 0.00103). For future reference, file the model and data as AIR-
PASS2.TSM using the option File>Project>Save as.

�
The next step is to check our model for goodness of fit.

E.4 Testing Your Model

Once we have a model, it is important to check whether it is any good or not. Typically
this is judged by comparing observations with corresponding predicted values obtained
from the fitted model. If the fitted model is appropriate then the prediction errors should
behave in a manner that is consistent with the model. The residuals are the rescaled
one-step prediction errors,

Ŵt = (Xt − X̂t)/
√
rt−1,

where X̂t is the best linear mean-square predictor of Xt based on the observations up
to time t − 1, rt−1 = E(Xt − X̂t)

2/σ 2 and σ 2 is the white noise variance of the fitted
model.

If the data were truly generated by the fitted ARMA(p, q)model with white noise
sequence {Zt}, then for large samples the properties of {Ŵt} should reflect those of {Zt}.
To check the appropriateness of the model we therefore examine the residual series
{Ŵt}, and check that it resembles a realization of a white noise sequence.

ITSM provides a number of tests for doing this in the Residuals Menu, which
is obtained by selecting the option Statistics>Residual Analysis.Within
this option are the suboptions

Plot
QQ-Plot (normal)
QQ-Plot (t-distr)
Histogram
ACF/PACF
ACF Abs vals/Squares
Tests of randomness

E.4.1 Plotting the Residuals

Select Statistics>Residual Analysis>Histogram, and you will see
a histogram of the rescaled residuals, defined as

R̂t = Ŵt/σ̂ ,

where nσ̂ 2 is the sum of the squared residuals. If the fitted model is appropriate, the
histogram of the rescaled residuals should have mean close to zero. If in addition the
data are Gaussian, this will be reflected in the shape of the histogram, which should
then resemble a normal density with mean zero and variance 1.

Select Statistics>Residual Analysis>Plot and you will see a graph
of R̂t vs. t. If the fitted model is appropriate, this should resemble a realization of
a white noise sequence. Look for trends, cycles, and nonconstant variance, any of
which suggest that the fitted model is inappropriate. If substantially more than 5% of
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the rescaled residuals lie outside the bounds ±1.96 or if there are rescaled residuals
far outside these bounds, then the fitted model should not be regarded as Gaussian.

Compatibility of the distribution of the residuals with either the normal distribution
or the t-distribution can be checked by inspecting the corresponding qq plots and
checking for approximate linearity. To test for normality, the Jarque–Bera statistic is
also computed.

Example E.4.1. The histogram of the rescaled residuals from our model for the logged, differenced,
and mean-corrected airline passenger series is shown in Figure E-6. The mean is close
to zero, and the shape suggests that the assumption of Gaussian white noise is not
unreasonable in our proposed model.

The graph of R̂t vs. t is shown in Figure E-7. A few of the rescaled residuals
are greater in magnitude than 1.96 (as is to be expected), but there are no obvious
indications here that the model is inappropriate. The approximate linearity of the
normal qq plot and the Jarque–Bera test confirm the approximate normality of the
residuals.

�

E.4.2 ACF/PACF of the Residuals

If we were to assume that our fitted model is the true process generating the data, then
the observed residuals would be realized values of a white noise sequence.

In particular, the sample ACF and PACF of the observed residuals should lie within
the bounds ±1.96/

√
n roughly 95% of the time. These bounds are displayed on the

graphs of the ACF and PACF. If substantially more than 5% of the correlations are
outside these limits, or if there are a few very large values, then we should look for
a better-fitting model. (More precise bounds, due to Box and Pierce, can be found in
Brockwell and Davis (1991) Section 10.4.)

Example E.4.2. Choose Statistics>Residual Analysis>ACF/PACF, or equivalently press
the middle green button at the top of the ITSM window. The sample ACF and PACF
of the residuals will then appear as shown in Figures E-8 and E-9. No correlations
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Figure E-7
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are outside the bounds in this case. They appear to be compatible with the hypothesis
that the residuals are in fact observations of a white noise sequence. To check for
independence of the residuals, the sample autocorrelation functions of their absolute
values and squares can be plotted by clicking on the third green button.

�

E.4.3 Testing for Randomness of the Residuals

The option Statistics>Residual Analysis>Tests of Randomness
carries out the six tests for randomness of the residuals described in Section 5.3.3.

Example E.4.3. The residuals from our model for the logged, differenced, and mean-corrected series
AIRPASS.TSM are checked by selecting the option indicated above and selecting the
parameter h for the portmanteau tests. Adopting the value h = 25 suggested by ITSM,
we obtain the following results:
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Figure E-9
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RANDOMNESS TEST STATISTICS (see Section 5.3.3)

LJUNG-BOX PORTM.= 13.76 CHISQUR( 20), p-value = 0.843

MCLEOD-LI PORTM.= 17.39 CHISQUR( 25), p-value = 0.867

TURNING POINTS = 87. ANORMAL( 86.00, 4.79**2), p-value = 0.835

DIFFERENCE-SIGN = 65. ANORMAL( 65.00, 3.32**2), p-value = 1.000

RANK TEST = 3934. ANORMAL(4257.50, 251.3**2), p-value = 0.198

JARQUE–BERA = 4.33 CHISQUR(2) p-value = 0.115

ORDER OF MIN AICC YW MODEL FOR RESIDUALS = 0

Every test is easily passed by our fitted model (with significance level α = 0.05), and
the order of the minimum-AICCARmodel for the residuals supports the compatibility
of the residuals with white noise. For later use, file the residuals by pressing the red
EXP button and exporting the residuals to a file with the name AIRRES.TSM.

�
E.5 Prediction

One of the main purposes of time series modeling is the prediction of future observa-
tions. Once you have found a suitable model for your data, you can predict future
values using the option Forecasting>ARMA. (The other options listed under
Forecasting refer to the methods of Chapter 10.)

E.5.1 Forecast Criteria

Given observations X1, . . . ,Xn of a series that we assume to be appropriately modeled
as an ARMA(p, q) process, ITSM predicts future values of the series Xn+h from the
data and the model by computing the linear combination Pn(Xn+h) of X1, . . . ,Xn that
minimizes the mean squared error E(Xn+h − Pn(Xn+h))

2.
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E.5.2 Forecast Results

Assuming that the current data set has been adequately fitted by the current
ARMA(p, q) model, choose Forecasting>ARMA, and you will see the ARMA
Forecast dialog box.

You will be asked for the number of forecasts required, which of the transfor-
mations you wish to invert (the default settings are to invert all of them so as to
obtain forecasts of the original data), whether or not you wish to plot prediction
bounds (assuming normality), and if so, the confidence level required, e.g., 95%. After
providing this information, click OK, and the data will be plotted with the forecasts
(and possibly prediction bounds) appended. As is to be expected, the separation of the
prediction bounds increases with the lead time h of the forecast.

Right-click on the graph, select Info, and the numerical values of the predictors
and prediction bounds will be printed.

Example E.5.1. We left our logged, differenced, and mean-corrected airline passenger data stored in
ITSM with the subset MA(23) model found in Example D.3.5. To predict the next
24 values of the original series, select Forecasting>ARMA and accept the default
settings in the dialog box by clicking OK. You will then see the graph shown in
Figure E-10. Numerical values of the forecasts are obtained by right-clicking on the
graph and selecting Info. The ARMA Forecast dialog box also permits using a
model constructed from a subset of the data to obtain forecasts and prediction bounds
for the remaining observed values of the series.

�

E.6 Model Properties

ITSM can be used to analyze the properties of a specified ARMA process without
reference to any data set. This enables us to explore and compare the properties
of different ARMA models in order to gain insight into which models might best
represent particular features of a given data set.

Figure E-10
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For any ARMA(p, q) process or fractionally integrated ARMA(p, q) process
with p ≤ 27 and q ≤ 27, ITSM allows you to compute the autocorrelation and
partial autocorrelation functions, the spectral density and distribution functions, and
the MA(∞) and AR(∞) representations of the process. It also allows you to generate
simulated realizations of the process driven by either Gaussian or non-Gaussian noise.
The use of these options is described in this section.

Example E.6.1. We shall illustrate the use of ITSM for model analysis using the model for the trans-
formed series AIRPASS.TSM that is currently stored in the program.

�

E.6.1 ARMA Models

For modeling zero-mean stationary time series, ITSM uses the class of ARMA (and
fractionally integrated ARMA) processes. ITSM enables you to compute characteris-
tics of the causal ARMA model defined by

Xt = φ1Xt−1 + φ2Xt−2 + · · · + φpXt−p + Zt + θ1Zt−1 + θ2Zt−2 + · · · + θqZt−q,

or more concisely φ(B)Xt = θ(B)Zt, where {Zt} ∼ WN
(
0, σ 2

)
and the parameters are

all specified. (Characteristics of the fractionally integrated ARIMA(p, d, q) process
defined by

(1 − B)dφ(B)Xt = θ(B)Zt, |d| < 0.5,

can also be computed.)
ITSMworks exclusively with causal models. It will not permit you to enter amodel

for which 1−φ1z−· · ·−φpzp has a zero inside or on the unit circle, nor does it generate
fitted models with this property. From the point of view of second-order properties, this
represents no loss of generality (Section 3.1). If you are trying to enter an ARMA(p, q)
model manually, the simplest way to ensure that your model is causal is to set all the
autoregressive coefficients close to zero (e.g., .001). ITSMwill not accept a noncausal
model.

ITSM does not restrict models to be invertible. You can check whether or not the
current model is invertible by choosing Model>Specify and pressing the button
labeled Causal/Invertible in the resulting dialog box. If the model is noninvertible, i.e.,
if the moving-average polynomial 1 + θ1z+ · · · + θqzq has a zero inside or on the unit
circle, the message Non-invertible will appear beneath the box containing the
moving-average coefficients. (A noninvertible model can be converted to an invertible
model with the same autocovariance function by choosing Model>Switch to
invertible. If the model is already invertible, the program will tell you.)

E.6.2 Model ACF, PACF

ThemodelACF and PACF are plotted using Model>ACF/PACF>Model. If you wish
to change the maximum lag from the default value of 40, select Model>ACF/PACF>
Specify Lag and enter the required maximum lag. (It can be much larger than 40,
e.g., 10,000). The graph will then be modified, showing the correlations up to the
specified maximum lag.

If there is a data file open as well as a model in ITSM, the model ACF and PACF
can be compared with the sample ACF and PACF by pressing the third yellow button
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at the top of the ITSMwindow. The model correlations will then be plotted in red, with
the corresponding sample correlations shown in the same graph but plotted in green.

Figure E-11
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Figure E-12
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Example E.6.2. The sample and model ACF and PACF for the current model and transformed series
AIRPASS.TSM are shown in Figures E-11 and E-12. They are obtained by pressing
the third yellow button at the top of the ITSMwindow. The vertical lines represent the
model values, and the squares are the sample ACF/PACF. The graphs show that the
data and the model ACF both have large values at lag 12, while the sample and model
partial autocorrelation functions both tend to die away geometrically after the peak at
lag 12. The similarities between the graphs indicate that the model is capturing some
of the important features of the data.

�
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E.6.3 Model Representations

As indicated in Section 3.1, if {Xt} is a causal ARMA process, then it has an MA(∞)
representation

Xt =
∞∑

j=0

ψjZt−j, t = 0,±1,±2, . . . ,

where
∞∑

j=0
|ψj| < ∞ and ψ0 = 1.

Similarly, if {Xt} is an invertible ARMA process, then it has an AR(∞) represen-
tation

Zt =
∞∑

j=0

πjXt−j, t = 0,±1,±2, . . . ,

where
∑∞

j=0 |πj| < ∞ and π0 = 1.
For any specified causal ARMA model you can determine the coefficients in

these representations by selecting the option Model>AR/MA Infinity. (If the
model is not invertible, you will see only the MA(∞) coefficients, since the AR(∞)
representation does not exist in this case.)

Example E.6.3. The current subset MA(23) model for the transformed series AIRPASS.TSMdoes not
have an AR(∞) representation, since it is not invertible. However, we can replace the
model with an invertible one having the same autocovariance function by selecting
Model>Switch to Invertible. For this model we can then find an AR(∞)
representation by selecting Model>AR Infinity. This gives 50 coefficients,
the first 20 of which are shown below.

MA − Infinity AR − Infinity
j psi(j) pi(j)
0 1.00000 1.00000
1 −0.36251 0.36251
2 0.01163 0.11978
3 −0.26346 0.30267
4 −0.06924 0.27307
5 0.15484 −0.00272
6 −0.02380 0.05155
7 −0.06557 0.16727
8 −0.04487 0.10285
9 0.01921 0.01856
10 −0.00113 0.07947
11 0.01882 0.07000
12 −0.57008 0.58144
13 0.00617 0.41683
14 0.00695 0.23490
15 0.03188 0.37200
16 0.02778 0.38961
17 0.01417 0.10918
18 0.02502 0.08776
19 0.00958 0.22791

�
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E.6.4 Generating Realizations of a Random Series

ITSM can be used to generate realizations of a random time series defined by the
currently stored model.

To generate such a realization, select the option Model>Simulate, and you will
see the ARMA Simulation dialog box. You will be asked to specify the number of
observations required, the white noise variance (if you wish to change it from
the current value), and an integer-valued random number seed (by specifying and
recording this integer with up to nine digits you can reproduce the same realization
at a later date by reentering the same seed). You will also have the opportunity to add
a specified mean to the simulated ARMAvalues. If the current model has been fitted to
transformed data, then you can also choose to apply the inverse transformations to the
simulated ARMA to generate a simulated version of the original series. The default
distribution for the white noise is Gaussian. However, by pressing the button Change
noise distribution you can select from a variety of alternative distributions
or by checking the box Use Garch model for noise process you can
generate an ARMA process driven by GARCH noise. Finally, you can choose whether
the simulated data will overwrite the data set in the current project or whether they will
be used to create a new project. Once you are satisfied with your choices, click OK,
and the simulated series will be generated.

Example E.6.4. To generate a simulated realization of the series AIRPASS.TSM using the current
model and transformed data set, select the option Model>Simulate. The default
options in the dialog box are such as to generate a realization of the original series as
a new project, so it suffices to click OK. You will then see a graph of the simulated
series that should resemble the original series AIRPASS.TSM.

�

E.6.5 Spectral Properties

Spectral properties of both data and fitted ARMA models can also be computed and
plotted with the aid of ITSM. The spectral density of the model is determined
by selecting the option Spectrum>Model. Estimation of the spectral density
from observations of a stationary series can be carried out in two ways, either by
fitting an ARMA model as already described and computing the spectral density
of the fitted model (Section 4.4) or by computing the periodogram of the data
and smoothing (Section 4.2). The latter method is applied by selecting the option
Spectrum>Smoothed Periodogram. Examples of both approaches are given
in Chapter 4.

E.7 Multivariate Time Series

Observations {x1, . . . , xn} of an m-component time series must be stored as
an ASCII file with n rows and m columns, with at least one space between
entries in the same row. To open a multivariate series for analysis, select
File>Project>Open>Multivariate and click OK. Then double-click on
the file containing the data, and you will be asked to enter the number of columns (m)
in the data file. After doing this, click OK, and you will see graphs of each component
of the series, with the multivariate tool bar at the top of the ITSM screen. For examples
of the application of ITSM to the analysis of multivariate series, see Chapter 8.
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Accidental deaths (DEATHS.TSM), 2, 11, 27, 28,

96, 180, 183, 313, 315, 317
ACF. See Autocorrelation function (ACF)
AIC, 149, 152
AICC, 125, 134, 137, 142, 151, 153, 167, 248, 396
Airline passenger data (AIRPASS.TSM), 192, 278,

320, 386
All Ordinaries index, 228
All-star baseball games, 2, 7
Alternative hypothesis, 368
APPH.TSM, 256
APPI.TSM, 256
APPJ.TSM, 350
APPJK2.TSM, 256
APPK.TSM, 350
Arbitrage, 221, 222, 224
ARAR algorithm, 310–313

forecasting, 311–312
application of, 312–313

ARCH(1) process, 197–199
ARCH(p) process, 197, 224
ARCH.TSM, 200
AR(1) process, 15, 46, 54, 295

ACVF of, 46
causal, 47
confidence regions for coefficients, 142
estimation of mean, 51
estimation of missing value, 58, 282
observation driven model of, 295
plus noise, 69
prediction of, 57, 59
sample ACF of, 54
spectral density of, 103
state-space representation of, 261
with missing data, 58, 285, 287
with non-zero mean, 59–60

AR(2) process, 19, 76–77
ACVF of, 80–82

AR(p) process. See Autoregressive (AR(p)) process
ARIMA(1,1,0) process, 158

forecast of, 176–177
ARIMA process

definition, 158
forecasting, 173–177
seasonal (see Seasonal ARIMA models)

state-space representation of, 269
with missing observations, 280
with regression, 184, 203

ARIMA(p, d, q) process with (−.5 < d < .5). See
Fractionally integrated ARMA process

ARMA(1, 1) process, 48–50, 66, 76
ACVF of, 78
causal, 49, 66
invertible, 49, 76
noncausal, 49, 118
noninvertible, 49, 118
prediction of, 89
spectral density of, 116
state-space representation of, 261–262

ARMA(p, q) process
ACVF of, 78–82
coefficients in AR representation, 77
coefficients in MA representation, 76
causal, 75
definition, 74
estimation

Hannan-Rissanen, 137–139
innovations algorithm, 132–137
least squares, 141
maximum likelihood, 139–140

existence and uniqueness of, 75
invertible, 76
multivariate (see Multivariate ARMA processes)
order selection, 124–129, 151
prediction, 91–96
seasonal (see Seasonal ARIMA models)
spectral density of, 115
state-space representation of, 267–268
with mean μ, 74

Asymptotic relative efficiency, 129
Australian red wine sales (WINE.TSM), 2, 7, 18,

319, 320
Autocorrelation function (ACF)

definition, 16
sample ACF

of absolute values, 202–204, 396, 401
of squares, 200, 202–204, 401
approximate distribution of, 51

of MA(q), 79, 82
Autocovariance function (ACVF)

basic properties of, 39
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Autocovariance function (ACVF) (cont.)
characterization of, 41
definition, 13, 16, 45
nonnegative definite, 41
of ARMA processes, 78–87
of ARMA(1, 1) process, 80
of AR(2) process, 81
of MA(q) process, 79
of MA(1) process, 15, 42
sample, 59–60
spectral representation of, 101

Autofit
for ARMA fitting, 122, 142, 143, 167–169, 187,

203, 341, 392
for fractionally integrated ARMA, 341

Autoregressive integrated moving-average. See
ARIMA process

Autoregressive moving-average. See ARMA process
Autoregressive polynomial, 74–77, 143, 160, 162,

169, 170, 304, 346
Autoregressive (AR(p)) process, 74

estimation of parameters
Burg, 122
maximum likelihood, 142–143, 149
with missing observations, 284
Yule-Walker, 123–124
large-sample distributions, 124
confidence intervals, 131

one-step prediction of, 59
order selection, 134, 149, 150
minimum AICC model, 153
multivariate (see Multivariate AR models)
partial autocorrelation function of, 83
prediction of, 89
state-space representation, 266–267
subset models, 309, 311
unit roots in, 170
Yule-Walker equations, 124, 128

Autoregressive process of infinite order (AR(∞)),
236

B
Backward prediction errors, 130
Backward shift operator, 25, 44, 48, 74, 207, 311,

339
Bandwidth, 109
Bartlett’s formula, 53

AR(1), 54
independent white noise, 53
MA(1), 53
multivariate, 240

Bayesian state-space model, 289
BEER.TSM, 192
Best linear predictor, 40, 246–247
Beta function, 307
Beta-binomial distribution, 307
BIC criterion, 149, 152
Bilinear model, 338
Binary process, 7
Binomial distribution, 353
Bispectral density, 337
Bivariate normal distribution, 359–360
Bivariate time series

covariance matrix, 228

mean vector, 228
(weakly) stationary, 228

Box-Cox transformation, 165, 388, 389
Brownian motion, 213, 375–379
Burg’s algorithm, 129–132

C
CAR(1) process, 343–345

estimation of, 344
CARMA(p, q) process, 345

autocovariance function of, 347
mean of, 346, 347
with thresholds, 347

Cauchy criterion, 371–372
Causal

ARCH(1) process, 198, 199
ARMA process, 75
GARCH process, 208, 209
multivariate ARMA process, 244
time-invariant linear filter, 112

Chaotic deterministic sequence, 335–337
Checking for normality, 32
Chi-squared distribution, 31, 125, 353, 361
Classical decomposition, 20, 26, 29, 165, 389,

390
Cochran and Orcutt procedure, 186
Cointegration, 254–255
Cointegration vector, 254, 255
Compound Poisson process, 214–215
Conditional density, 289, 294, 299, 356
Conditional expectation, 40, 149, 285, 289, 357
Confidence interval, 367–368

large-sample confidence region, 368
Conjugate family of priors, 297
Consistent estimator, 108, 133, 237
Continuous distributions

chi-squared, 353
exponential, 352
gamma, 352–353
normal, 352
uniform, 352

Continuous spectrum, 101
Continuous-time ARMA process. See CARMA(p, q)

process
Continuous-time models, 212–220

CAR(1), 343
Covariance function, 13. See also Autocovariance

function (ACVF)
Covariance matrix, 376

factorization of, 358
properties of, 358
square root of, 358

Cumulant, 337, 350
kth-order, 337

D
Delay parameter, 325, 327, 331
Design matrix, 184–186
Deterministic, 67
Diagnostic checking, 144–147. See also Residuals
Difference operator

first-order, 25
with positive lag d, 28
with real lag d, 28, 343
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Differencing to generate stationary data, 12
at lag d, 28

Dirichlet kernel, 114
Discrete distributions

binomial, 353
negative binomial, 353–354, 361
Poisson, 353
uniform, 353

Discrete Fourier transform, 107
Discrete spectral average. See Spectral density

function
Distribution function, 351–355. See also Continuous

distributions; Discrete distributions
properties of, 351

Dow-Jones Utilities Index (DOWJ.TSM), 126–128,
131, 134–137, 143, 176, 177

Dow-Jones and All ordinaries Indices, (DJAO2.TSM,
DJAOPC2.TSM), 228–229, 249, 251–253

Durbin-Levinson algorithm, 60–62, 64, 65, 125, 126,
132, 133, 247

E
EGARCH (p, q) process, 205
Elementary function, 377–379
EM algorithm, 260, 285–288

Monte Carlo (MCEM), 293
Embedded discrete-time process, 344
Equivalent martingale measure, 223
Error probabilities, 389–390

type I, 369
type II, 369

Estimation of missing values
in an ARIMA process, 284
in an AR(p) process, 285
in a state-space model, 283

Estimation of the white noise variance
least squares, 140
maximum likelihood, 141
using Burg’s algorithm, 130
using the Hannan-Rissanen algorithm, 138
using the innovations algorithm, 136
using the Yule-Walker equations, 124

European call option, 221, 223
Expectation, 351–355
Exponential distribution, 352
Exponential family models, 296–303
Exponential smoothing, 21, 23, 316

F
FIGARCH (p, d, q) process, 209
Filter. See Linear filter
Financial data, 195–226
Fisher information matrix, 367
Forecasting, 12, 55–67, 147–148. See also Prediction
Forecasting ARIMA processes, 173–177

forecast function, 182–183
h-step predictor, 175

mean square error of, 174
forecast density, 289
forward prediction errors, 130

Fourier frequencies, 107, 109
Fourier indices, 11
Fractionally integrated ARMA process, 339

estimation of, 340

spectral density of, 340
Whittle likelihood approximation, 340

Fractionally integrated white noise, 339
autocovariance of, 339
variance of, 339

Frequency domain, 97, 236

G
Gamma distribution, 206, 218, 295, 352
Gamma function, 339, 352
GARCH(p, q) process, 200

ARMA model with GARCH noise, 203–204
fitting GARCH models, 201–203
Gaussian-driven, 203
generalizations, 203
regression with GARCH noise, 203
t−driven, 203

Gaussian likelihood
in time series context, 367
of a CAR(1) process, 343–344
of a multivariate AR process, 248
of an ARMA(p, q) process, 140

with missing observations, 281–283
of GARCH model, 340
of regression with ARMA errors, 186, 187

Gaussian linear process, 334, 335, 337
Gaussian time series, 40, 42, 139, 242, 361
Gauss-Markov theorem, 365, 367
Generalized distribution function, 101
Generalized error distribution (GED), 206
Generalized least squares (GLS) estimation, 184–186
Generalized inverse, 184, 271, 304
Generalized state-space models

Bayesian, 289
filtering, 289, 290
forecast density, 289
observation-driven, 294–295
parameter-driven, 288–294
prediction, 289, 290

Geometric Brownian motion (GBM), 195, 196,
215–217, 381, 382

Gibbs phenomenon, 114
Goals scored by England against Scotland, 299–302
Goodness of fit based on ACF, 18–19. See also Tests

of randomness

H
Hannan-Rissanen algorithm, 122, 136, 137–139
Harmonic regression, 10–12
Hessian matrix, 142, 187
Hidden process, 289
Holt-Winters algorithm, 314–317

seasonal, 317–318
Hypothesis testing, 368–370

large-sample tests based on confidence regions,
369–370

uniformly most powerful test, 369

I
IARCH(∞) process, 209
IGARCH(p, q) process, 208
Independent random variables, 30, 36, 214
Identification techniques, 163–169

for ARMA processes, 164
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Identification techniques (cont.)
for AR(p) processes, 142
for MA(q) processes, 153
for seasonal ARIMA processes, 177

IGARCH(p, q) process, 208, 209
iid noise, 6–7, 14

sample ACF of, 53
multivariate, 235

Innovations, 62, 271
Innovations algorithm, 62–65, 132–137

fitted innovations MA(m) model, 133
multivariate, 247

Input, 45, 112, 333
Integrated volatility, 217, 218, 220, 226
Intervention analysis, 331–334
Invertible

ARMA process, 76
multivariate ARMA process, 244

Investment strategy, 221, 222, 224
Itô calculus, 373

Itô integral, 343, 375–379
Itô process, 379–380
Itô’s formula, 380
Itô stochastic differential equation, 381–383

ITSM, 27–33, 37, 122, 125–127, 165, 327, 329,
385–407

J
Joint distributions of a time series, 6
Joint distribution of a random vector, 355

K
Kalman recursions

filtering, 271, 274
prediction, 271

h−step, 272–275
smoothing, 271, 275

Kullback-Leibler discrepancy, 151
Kullback-Leibler index, 151, 152

L
Lake Huron (LAKE.TSM), 9–10, 18–19, 54, 189,

191
Latent process, 289
Large-sample tests based on confidence regions,

369–370
Least squares estimation

for ARMA processes, 141
for regression model, 186
for transfer function models, 326
of trend, 8

Lévy process, 195, 212–218, 347–350, 375–377
Lévy-Itô decomposition, 214
Lévy-Khinchin representation, 374
Lévy market model (LMM), 216
Lévy measure, 374

Likelihood function, 277, 292, 366. See also
Gaussian likelihood

Linear combination of sinusoids, 101–103
Linear difference equations, 47, 175
Linear filter, 36, 45, 48, 74

input, 45
low-pass, 23, 114

moving-average, 22, 36
output, 45
simple moving-average, 112–114

Linear process, 44, 335
ACVF of, 46
Gaussian, 334
multivariate, 235

Linear regression. See Regression
Local level model, 264
Local linear trend model, 264, 265, 304, 315
Log asset price, 195, 197, 212, 216
Log return, 195–197, 209, 219
Logistic equation, 335, 336
Lognormal SV process, 210, 211–212, 274
Long memory, 207–209, 310, 323
Long-memory model, 338–342

M
MA(1) process

ACF of, 42
estimation of missing values, 71
moment estimation, 128–129
noninvertible, 85, 95
order selection, 128–129
PACF of, 84
sample ACF of, 53
spectral density of, 105–106
state-space representation of, 273

MA(q). See Moving average (MA(q)) process
MA(∞), 44

multivariate, 235
Market price of risk, 224
Martingale difference sequence, 334
Maximum likelihood estimation, 366–367

ARMA processes, 140
large-sample distribution of, 142
confidence regions for, 142–144

Mean
of a multivariate time series, 236

estimation of, 236–243
of a random variable, 352, 354
of a random vector, 357
estimation of, 50
sample, 50

large-sample properties of, 51, 236
Mean square convergence, 65, 371–372

properties of, 372, 378
Measurement error, 84–86, 172
Memory shortening, 309, 310
Method of moments estimation, 85, 129
Minimum AICC AR model, 147, 256, 396,

402
Mink trappings (APPH.TSM), 256
Missing values in ARMA processes

estimation of, 283–285
likelihood calculation with, 281–283

Mixture distribution, 354
Monte Carlo EM algorithm (MCEM), 293
Moving average (MA(q)) process, 43

ACF of, 79
sample, 82

ACVF of, 79
estimation

confidence intervals, 143
Hannan-Rissanen, 137
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innovations, 133
maximum likelihood, 140, 142

order selection, 133, 134
partial autocorrelation of, 83
unit roots in, 171–173

Multivariate AR process
estimation, 247–249

Burg’s algorithm, 248
maximum likelihood, 248
Whittle’s algorithm, 248

forecasting, 250–254
error covariance matrix of prediction, 251

Multivariate ARMA process, 243–246
causal, 244
covariance matrix function of, 245–246
estimation

maximum likelihood, 248
invertible, 244
prediction, 246–247

error covariance matrix of prediction, 252
Multivariate innovations algorithm, 247
Multivariate normal distribution

bivariate, 359–360
conditional distribution, 360
conditional expectation, 357
density function, 356
definition, 358
singular, 359
standardized, 359

Multivariate time series, 223
covariance matrices of, 228, 233, 235
mean vectors of, 228, 233, 235
second-order properties of, 232–236
stationary, 233

Multivariate white noise, 227, 235, 243
Muskrat trappings (APPI.TSM), 256

N
Negative binomial distribution, 292, 353, 361
NILE.TSM, 340–342
NOISE.TSM, 326, 333
Non-anticipating integrand, 376
Nonlinear models, 334–338
Nonnegative definite matrix, 357, 358
Nonnegative definite function, 41
Normal distribution, 352, 355
Normal equations, 363, 364
Null hypothesis, 34, 147, 170, 172, 337, 368,

369

O
Observation equation, 260

of CARMA(p, q) model, 345
Ordinary least squares (OLS) estimators, 170, 184,

185, 363
One-step predictors, 60, 63, 88, 136, 140, 149, 174,

252, 271, 280, 281, 302
Order selection, 124, 133, 137, 141, 149–153

AIC, 149, 152
AICC, 149, 151–153
BIC, 149, 152
consistent, 152
efficient, 152
FPE, 149–150

Ornstein-Uhlenbeck process, 217, 218, 220, 225, 343
Ornstein-Uhlenbeck SV model, 219

Orthogonal increment process, 103
Orthonormal set, 107
Overdifferencing, 169, 171
Overdispersed, 299
Overshorts (OSHORTS.TSM), 84–86, 128, 147, 148,

172, 187–188
structural model for, 85

P
Partial autocorrelation function (PACF), 62, 83–84

estimation of, 85
of an AR(p) process, 83
of an MA(1) process, 84
sample, 83, 84

Periodogram, 106–111, 208, 340
approximate distribution of, 108

Point estimate, 367
Poisson distribution, 296, 299, 300, 355

Poisson exponential family model, 296
Poisson process, 195, 213–215, 217, 351, 374
Polynomial fitting, 24–25
Population of USA (USPOP.TSM), 4, 8–9, 25–26
Portmanteau test for residuals. See Tests of

randomness
Posterior distribution, 289, 294, 297, 298, 306,

307
Power function, 369
Power steady model, 298, 299
Prediction of stationary processes. See also Recursive

prediction
AR(p) processes, 89
ARIMA processes, 173–177
ARMA processes, 87–94
based on infinite past, 65
best linear predictor, 40
Gaussian processes, 94

prediction bounds, 94
large-sample approximations, 93
MA(q) processes, 89
multivariate AR processes, 250–254
one-step predictors, 57

mean squared error of, 92
seasonal ARIMA processes, 182–183

Prediction operator, 58–60
properties of, 59

Preliminary transformations, 12, 20, 163
Prewhitening, 239, 324
Prior distribution, 289
Probability density function (pdf), 354
Probability generating function, 361
Probability mass function (pmf), 354
Purely nondeterministic, 67, 334

Q
q−dependent, 43
q-correlated, 43, 44
qq plot, 32, 147, 202–203, 401–402

R
R and S arrays, 157
Random noise component, 20, 389
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Random variable
continuous, 353, 354
discrete, 354, 355

Randomly varying trend and seasonality with noise,
266, 317

Random vector, 355–358
covariance matrix of, 357
joint distribution of, 355
mean of, 357
probability density of, 356

Random walk, 7, 14
simple symmetric, 7, 14
with noise, 263, 272, 278, 299

Rational spectral density. See Spectral density
function

Realization of a time series, 6, 409
Realized volatility, 217
Recursive prediction

Durbin-Levinson algorithm, 60, 247
Innovations algorithm, 64–65
Kalman prediction (see Kalman recursions)
multivariate processes

Durbin-Levinson algorithm, 247
innovations algorithm, 247

Regression
with ARMA errors, 184–191

best linear unbiased estimator, 185
Cochrane and Orcutt procedure, 185,

186
GLS estimation, 185
OLS estimation, 184

Rejection region, 368, 369
RES.TSM, 333, 334
Residuals, 30, 144

check for normality, 33, 147
graph of, 145
rescaled, 145
sample ACF of, 146
tests of randomness for, 146–147

Risk-neutral, 224

S
Sales with leading indicator (LS2.TSM,

SALES.TSM, LEAD.TSM), 230–
232, 242–243, 249–250, 253–254,
326–327, 329–330

Sample
autocorrelation function, 16–18

MA(q), 82
of residuals, 146

autocovariance function, 16
covariance matrix, 16
mean, 16

large-sample properties of, 50
multivariate, 228

partial autocorrelation, 83
SARIMA. See Seasonal ARIMA process
Seasonal adjustment, 5
Seasonal ARIMA process, 177–183

forecasting, 182–183
mean squared error of, 183

maximum likelihood estimation, 180, 181
Seasonal component, 20

estimation of, 21–25
method S1, 26–27

elimination of, 28
method S2, 28–30

Seat-belt legislation (SBL.TSM, SBL2.TSM),
189–191, 333–334

Second-order properties, 6
in frequency domain, 236

Self-financing condition, 221
Short memory, 313, 339
SIGNAL.TSM, 3, 33
Signal detection, 3
Significance level, 153, 369, 402
Size of a test, 369
Smoothing

by elimination of high-frequency components,
23–24

with a moving average filter, 21–23
exponential, 21, 23, 314, 316, 319
the periodogram (see Spectral density estimation)
using a simple moving average, 112

Spectral density estimation
discrete spectral average, 109

large-sample properties of, 110
rational, 117

Spectral density function, 98–106
characterization of, 99
of an ARMA(1, 1), 116
of an ARMA process, 115
of an AR(1), 103–105
of an AR(2), 116
of an MA(1), 105–106
of white noise, 103
properties of, 98
rational, 115

Spectral density matrix function, 236
Spectral distribution function, 101–103, 117
Spectral representation

of an autocovariance function, 101
of a covariance matrix function, 233
of a stationary multivariate time series, 233
of a stationary time series, 97

Spencer’s 15-point moving average, 22–23, 36
Spot volatility, 217
State equation, 260

of CARMA(p, q) model, 345
stable, 262, 267

State-space model, 259–307
estimation for, 275–280
stable, 262
stationary, 262
with missing observations, 280–285

State-space representation, 261
causal AR(p), 266–267
causal ARMA(p, q), 267–268
ARIMA(p, d, q), 268–269

Stationarity
multivariate, 227
strict, 13, 43, 361
weak, 13, 361

Steady-state solution, 273, 274, 305, 315
Stochastic differential equation, 196, 215, 218, 343,

345, 348, 383–385
first-order, 343
pth-order, 345

Stochastic volatility model, 197, 209–212, 217–220,
226, 274

Stock market indices (STOCK7.TSM), 225, 257
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Strictly stationary series, 13, 43
properties of, 43

Strike price, 221
Strike time, 221
Strikes in the U.S.A. (STRIKES.TSM), 4, 22, 36,

96
Structural time series models, 85, 263

level model, 263–265
local linear trend model, 264, 265, 315
randomly varying trend and seasonality

with noise, 266, 278
estimation of, 275–280

seasonal series with noise, 265
Stylized features, 196, 204
Subordinator, 217
Sunspot numbers (SUNSPOTS.TSM), 70, 86–87,

110–111, 117, 153, 203, 204, 335

T
Testing for the independence of two stationary time

series, 239–240
Test for normality, 33, 147, 400
Tests of randomness

based on sample ACF, 30
based on turning points, 31–33, 146
difference-sign test, 32, 146
Jarque-Bera normality test, 33, 146
minimum AICC AR model, 147
portmanteau tests

Ljung-Box, 31, 146, 402
McLeod-Li, 31, 146, 402

rank test, 32, 146
Third-order central moment, 337
Third-order cumulant function, 337, 350

of linear process, 337, 350
Threshold model, 338

AR(p), 338
Time domain, 97, 248
Time-invariant linear filter (TLF), 111–115

causal, 112
transfer function, 113

Time series, 6
continuous-time, 1
discrete-time, 1
Gaussian, 40, 42, 361

Time series model, 6
Time series of counts, 292–294
Transfer function, 113–115
Transfer function model, 323–330

estimation of, 324–326
prediction of, 327–330

Transformations, 20, 163–164, 388
variance-stabilizing, 165

Tree-ring widths (TRINGS.TSM), 351
Trend component, 7–10, 20

elimination of
in absence of seasonality, 21–25
by differencing, 25–26

estimation of
by elimination of high-frequency components,

23
by exponential smoothing, 23
by least squares, 10
by polynomial fitting, 24–25
by smoothing with a moving average, 21, 26

U
Uniform distribution, 352, 353

discrete, 353–354
Uniformly most powerful (UMP) test, 369
Unit roots

augmented Dickey-Fuller test, 170
Dickey-Fuller test, 170
in autoregression, 169–171
in moving-averages, 171–173
likelihood ratio test, 172
locally best invariant unbiased (LBIU) test, 173

V
Variance, 352, 354
Volatility, 196, 209, 216, 349

W
Weight function, 109, 110
White noise, 14

multivariate, 235
spectral density of, 103

Whittle approximation to likelihood, 340
Wold decomposition, 44, 67, 334

Y
Yule-Walker estimation, 86, 123–124. See also

Autoregressive process and multivariate
AR process

for q > 0, 128–129

Z
Zoom buttons, 388
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